# Table Of Contents

Getting Started................................................................................................................................. 1

Welcome to ePro Canvas Help. ........................................................................................................ 1
Project Explorer .................................................................................................................................1
Page Editor .................................................................................................................................... 1

Getting Started .............................................................................................................................. 1
Welcome to ePro Canvas Help. ........................................................................................................ 1
Terminology ....................................................................................................................................... 1
The Starting Window ....................................................................................................................... 3

Project Components .......................................................................................................................... 31
Projects ............................................................................................................................................ 31
Units ............................................................................................................................................... 32
Clients ............................................................................................................................................ 38
Configurations ................................................................................................................................. 41
Pages .............................................................................................................................................. 43
Libraries ........................................................................................................................................ 44

Component Templates ..................................................................................................................... 90
Canvas Assistance and Component Builder ..................................................................................... 95
Document Viewer .............................................................................................................................. 98
Event Banner and Manager ............................................................................................................... 99

Page Editor ...................................................................................................................................... 105
Navigation ...................................................................................................................................... 105
Pages .............................................................................................................................................. 115
Controls ....................................................................................................................................... 152
Properties ..................................................................................................................................... 184

Application Notes ............................................................................................................................ 238
Alarm and Event Banner .................................................................................................................. 238

Canvas Assistance and Component Builder .................................................................................... 251
Changing the Default Prepackaged Project ...................................................................................... 254
Changing Pages Online ..................................................................................................................... 255
Component Templates ....................................................................................................................... 261
Control Example: Readout Template ................................................................................................ 266
Creating a Multi-Language Project.................................................................................................... 271
Data Archiving ................................................................................................................................. 273
Table Of Contents

Explicit Library Referencing ........................................................................................................................................ 279
Expressions, Analog .................................................................................................................................................. 280
Expressions, Data Entry Target Expressions ........................................................................................................ 281
Expressions, Direct Assignment ......................................................................................................................... 283
Expressions, Discrete ............................................................................................................................................... 284
First Time User Tutorial ....................................................................................................................................... 285
Indexed Lists .......................................................................................................................................................... 288
Master Page ............................................................................................................................................................ 291
Media Library Import and Export ........................................................................................................................ 295
PanelMate PowerPro Import ................................................................................................................................ 297
Parameter Passing ..................................................................................................................................................... 305
Property Value Formats and Syntax (single, double, or no quotes) ........................................................................... 306
Recipe Development .............................................................................................................................................. 312
Referencing Media Library by ID Number ........................................................................................................... 321
Search and Replace ................................................................................................................................................ 322
Security .................................................................................................................................................................. 325
ePro Canvas Tips and Best Practices .................................................................................................................. 332
Transfer Issues ......................................................................................................................................................... 333
User Defined System Tags ................................................................................................................................... 335
Terminology ............................................................................................................................................................... 336
The Starting Window ................................................................................................................................................ 337
The Starting Window - Project Explorer ................................................................................................................ 337
Title Bar .................................................................................................................................................................. 338
Menu Bar ................................................................................................................................................................. 339
Toolbar ..................................................................................................................................................................... 339
Component Bar ........................................................................................................................................................ 339
Status Bar ................................................................................................................................................................. 340
Project Components .................................................................................................................................................. 341
Project Components ............................................................................................................................................... 341
Component Data ...................................................................................................................................................... 343
Component Data 2 ................................................................................................................................................... 345
Component Data 3 ................................................................................................................................................... 345
Component Property Editor .................................................................................................................................. 347
Component Property Editor .................................................................................................................................. 347
Component Property Editor, Lists ........................................................................................................................ 348
Component Property Editor, Groups .................................................................................................................... 349
Using Categories ...................................................................................................................................................... 350
Using Components .................................................................................................................................................... 351
First Time User Tutorial ......................................................................................................................................... 351
Component Templates ........................................................................................................................................... 354
Changing the Default Prepackaged Project .......................................................................................................... 359
Table Of Contents

Licensing .................................................................................................................................. 360
Canvas Editor Licensing .......................................................................................................... 360
Runtime Unit Licensing ........................................................................................................... 361
Additional Feature Runtime Licensing .................................................................................. 361
Eaton Electrical Support Services ............................................................................................ 362
Product Comparisons ............................................................................................................. 363
ePro Canvas Professional vs. ePro Canvas Components .......................................................... 363
ePro PS vs. ePro ES Components ............................................................................................ 364
Project Components ................................................................................................................ 365
Projects .................................................................................................................................... 365
Units ........................................................................................................................................ 366
Unit properties ........................................................................................................................ 366
Clients ...................................................................................................................................... 372
OPC client adapter component properties ................................................................................ 372
ConnectionSystem adapter component properties .................................................................. 374
OPC Tag Import ....................................................................................................................... 374
Vision Interface Clients ............................................................................................................ 375
Configurations ........................................................................................................................ 375
Configuration properties .......................................................................................................... 376
Pages ...................................................................................................................................... 377
Page component properties .................................................................................................... 377
Libraries ................................................................................................................................... 378
Tags ........................................................................................................................................ 378
Media Library .......................................................................................................................... 381
Color Libraries ........................................................................................................................ 389
Action Libraries ....................................................................................................................... 391
Indexed Lists ............................................................................................................................. 405
Security .................................................................................................................................... 408
Archive Library Entries ............................................................................................................ 415
Explicit Library Referencing ................................................................................................... 416
Property Value Formats and Syntax (single, double, or no quotes) ........................................... 417
User Defined System Tags ........................................................................................................ 422
Component Templates ............................................................................................................. 423
Canvas Assistance and Component Builder ............................................................................. 428
Canvas Assistance .................................................................................................................... 428
Component Builder .................................................................................................................. 428
Enabling and Disabling Canvas Assistance and Component Builder Features .......................... 429
Document Viewer ................................................................................................................... 431
Document Viewer .................................................................................................................... 431
Event Banner and Manager .................................................................................................... 432
Event Banner ............................................................................................................................ 432
## Table Of Contents

- **Event Manager** .................................................. 436
- **Events & Alarms - Big Picture** ........................... 437
- **Page Editor** ................................................. 439
- **Navigation** .................................................... 439
  - Customizing the Page Editor ................................. 439
  - Working with Controls ...................................... 441
  - Working with Properties .................................. 446
- **Pages** ......................................................... 448
  - The Page Editor ........................................... 448
  - What is a Page? ............................................. 450
  - Title Bar ..................................................... 450
  - Menu Bar .................................................... 451
  - Standard Toolbar ........................................... 454
  - Layout Toolbar ............................................. 456
  - Control Bar .................................................. 459
  - Page Frame .................................................. 460
  - Status Bar .................................................... 461
  - Customizing the Page Editor ......................... 462
  - Page Component Properties .............................. 464
  - Planning your Page ...................................... 465
  - Controls ....................................................... 466
  - Component Templates ..................................... 468
  - Master Page ................................................ 472
  - Indexed Lists ............................................... 476
  - Changing Pages Online .................................. 479
  - Controls ..................................................... 485
    - What are Controls? ..................................... 485
    - Controls .................................................. 487
    - Working with Controls ................................ 489
    - Control Example: Readout Template ............... 494
    - All Controls ............................................. 499
  - Properties ................................................... 518
    - The Property Editor ................................... 518
    - Working with Properties ............................... 520
    - Control Example: Readout Template ............... 522
    - Property Value Entry Types ........................... 522
    - Expressions, Discrete .................................. 527
    - Expressions, Analog .................................... 529
    - Expressions, Data Entry Target Expressions ........ 530
    - Expressions, Direct Assignment ..................... 532
    - Operators ............................................... 533
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Notes</td>
<td>571</td>
</tr>
<tr>
<td>Alarm and Event Banner</td>
<td>571</td>
</tr>
<tr>
<td>Changing the Default Prepackaged Project</td>
<td>583</td>
</tr>
<tr>
<td>Changing Pages Online</td>
<td>584</td>
</tr>
<tr>
<td>Page Changes Using Actions</td>
<td>584</td>
</tr>
<tr>
<td>User defined Goto Page Actions</td>
<td>586</td>
</tr>
<tr>
<td>Changing Pages by ID Number</td>
<td>586</td>
</tr>
<tr>
<td>Component Templates</td>
<td>590</td>
</tr>
<tr>
<td>Control Example: Readout Template</td>
<td>595</td>
</tr>
<tr>
<td>Creating a Multi-Language Project</td>
<td>600</td>
</tr>
<tr>
<td>Data Archiving</td>
<td>602</td>
</tr>
<tr>
<td>Archive Libraries</td>
<td>603</td>
</tr>
<tr>
<td>Alarms/Events Archiving</td>
<td>604</td>
</tr>
<tr>
<td>Data Archive Action</td>
<td>606</td>
</tr>
<tr>
<td>Explicit Library Referencing</td>
<td>608</td>
</tr>
<tr>
<td>Expressions, Analog</td>
<td>609</td>
</tr>
<tr>
<td>Expressions, Data Entry Target Expressions</td>
<td>610</td>
</tr>
<tr>
<td>Expressions, Direct Assignment</td>
<td>612</td>
</tr>
<tr>
<td>Expressions, Discrete</td>
<td>613</td>
</tr>
<tr>
<td>First Time User Tutorial</td>
<td>614</td>
</tr>
<tr>
<td>Project Requirements</td>
<td>614</td>
</tr>
<tr>
<td>Application Creation</td>
<td>614</td>
</tr>
<tr>
<td>Indexed Lists</td>
<td>617</td>
</tr>
<tr>
<td>Master Page</td>
<td>620</td>
</tr>
<tr>
<td>PanelMate PowerPro Import</td>
<td>624</td>
</tr>
<tr>
<td>How to Import a .PPS file</td>
<td>624</td>
</tr>
<tr>
<td>Supported Features</td>
<td>624</td>
</tr>
<tr>
<td>Import Suggestions and Workarounds</td>
<td>626</td>
</tr>
<tr>
<td>Image Directory</td>
<td>628</td>
</tr>
<tr>
<td>A new Message Pane</td>
<td>628</td>
</tr>
<tr>
<td>Parameter Passing</td>
<td>632</td>
</tr>
<tr>
<td>Property Value Formats and Syntax (single, double, or no quotes)</td>
<td>633</td>
</tr>
</tbody>
</table>
# Table Of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaluated Properties</td>
<td>633</td>
</tr>
<tr>
<td>Non-evaluated Properties</td>
<td>634</td>
</tr>
<tr>
<td>Evaluated Properties Syntax</td>
<td>635</td>
</tr>
<tr>
<td>Non-evaluated Properties Syntax</td>
<td>638</td>
</tr>
<tr>
<td>Recipe Development</td>
<td>639</td>
</tr>
<tr>
<td>The Recipe XML File</td>
<td>639</td>
</tr>
<tr>
<td>The Recipe Action</td>
<td>640</td>
</tr>
<tr>
<td>Recipe Runtime Licensing</td>
<td>643</td>
</tr>
<tr>
<td>The Recipe Menu Control</td>
<td>644</td>
</tr>
<tr>
<td>Referencing Media Library by ID Number</td>
<td>648</td>
</tr>
<tr>
<td>Search and Replace</td>
<td>649</td>
</tr>
<tr>
<td>Access</td>
<td>649</td>
</tr>
<tr>
<td>Dialog Box</td>
<td>650</td>
</tr>
<tr>
<td>Security</td>
<td>652</td>
</tr>
<tr>
<td>Security Devices</td>
<td>653</td>
</tr>
<tr>
<td>Security Groups</td>
<td>653</td>
</tr>
<tr>
<td>Secure Users</td>
<td>654</td>
</tr>
<tr>
<td>Security User and Security Group Automatic Actions</td>
<td>657</td>
</tr>
<tr>
<td>Runtime Security Functionality</td>
<td>658</td>
</tr>
<tr>
<td>Implementing Security on an ePro Configuration</td>
<td>658</td>
</tr>
<tr>
<td>ePro Canvas Tips and Best Practices</td>
<td>659</td>
</tr>
<tr>
<td>Preparation</td>
<td>659</td>
</tr>
<tr>
<td>Media Library</td>
<td>659</td>
</tr>
<tr>
<td>Re-use</td>
<td>659</td>
</tr>
<tr>
<td>Master Pages</td>
<td>659</td>
</tr>
<tr>
<td>Indexed Lists</td>
<td>660</td>
</tr>
<tr>
<td>Clients</td>
<td>660</td>
</tr>
<tr>
<td>Configuration</td>
<td>660</td>
</tr>
<tr>
<td>Unit</td>
<td>660</td>
</tr>
<tr>
<td>Color Blinks</td>
<td>660</td>
</tr>
<tr>
<td>Pages</td>
<td>660</td>
</tr>
<tr>
<td>Actions</td>
<td>660</td>
</tr>
<tr>
<td>User Defined System Tags</td>
<td>660</td>
</tr>
<tr>
<td>Index</td>
<td>663</td>
</tr>
</tbody>
</table>
Getting Started

Welcome to ePro Canvas Help.

ePro Canvas will make it easy for you to create and manage projects. The principle behind ePro Canvas is that you create a component of your project once and then re-use it wherever you need it again. With this approach, you’ll find that creating projects gets easier as you create more components. Components that make up a project are modular so that once a component is created, it can be used over and over again in different units.

You do not need to follow any predefined order when creating the components needed to build a project. Once a minimum set of components has been created, the components can be linked together to create a unit. The unit then will communicate with a destination device(s) to perform the desired application.

The Table of Contents of this help file is split into two parts. First is the Project Explorer book which provides general project development information. Next is the Page Editor book which includes the specifics of configuring a page.

Project Explorer
Start with the Project Explorer

Page Editor
Start with the Page Editor

Getting Started

Welcome to ePro Canvas Help.

ePro Canvas will make it easy for you to create and manage projects. The principle behind ePro Canvas is that you create a component of your project once and then re-use it wherever you need it again. With this approach, you’ll find that creating projects gets easier as you create more components. Components that make up a project are modular so that once a component is created, it can be used over and over again in different units.

You do not need to follow any predefined order when creating the components needed to build a project. Once a minimum set of components has been created, the components can be linked together to create a unit. The unit then will communicate with a destination device(s) to perform the desired application.

The Table of Contents of this help file is split into two parts. First is the Project Explorer book which provides general project development information. Next is the Page Editor book which includes the specifics of configuring a page.

Project Explorer
Start with the Project Explorer

Page Editor
Start with the Page Editor

Terminology
• **Actions** - functions that are executed when a condition is true. Actions can change pages, log events, close the application, set variables, send data to a server, etc.

• **Action Libraries** - a way to store actions for reuse by any configuration in the project. Actions can be organized into multiple Action Libraries.

• **Analog** - refers to a device, control or expression that will have a range of values (for example, a readout’s value from a PLC or server). See Expressions, Analog for more details on Analog expressions.

• **Clients** - provides a communication connection to a device. During Runtime, the ePro unit acts as a client to access data from the configured device. The most typical ePro client connection is to an OPC server.

• **Color Libraries** - contain sets of colors, or color palettes for given configurations. The Color Libraries are a way to store palettes for reuse by any configuration in the project. Colors can be organized into multiple Color Libraries.

• **Components** - Project Components are used to build a project. They include Units, Clients, Configurations, Pages, and Libraries (Action, Color, Media, etc). Components can be created separately and in any order, and can be assigned to multiple configurations.

• **Configurations** - ties desired pages, actions, libraries, and other settings into a single application. Multiple configurations are allowed in the project and are stored in the Configurations Folder.

• **Control** - a visual tool that is placed on a page with other controls to allow an operator to monitor and control a process. Examples of controls are Readouts, Bar Graphs, Buttons, Graphics, Indicators, etc. These are arranged on a page to allow an operator to monitor and/or control a specific function from the unit. Controls can have static and/or dynamic properties.

• **Data Entry** - the ability to send data to a client connection, such as an OPC server. Examples include setting a setpoint or activating a pump.

• **Discrete** - a device, control or expression that will have one of two states (for example, ON/OFF or True/False).

• **Dynamic** - a control and/or property that changes online. A numeric readout or status indication are examples of controls with Dynamic properties.

• **List Property** - a type of property generally attached to controls that have multiple occurrences with several characteristics each. For example, an indicator control can contain multiple states (On, Off, ...) with many characteristics for each (On FG Color, Off FG Color, On BG Color, Off BG color, ...). List Properties appear in a table.

• **Media Libraries** - store multilingual text, images, and sounds. (Text = Text words, Text messages, Multi-language words; Images = BMP, JPG, WMF, EMF files; Sounds = WAV files). Media can be organized into multiple Media Libraries.

• **Page** - a type of component which contains Controls (readouts, indicators, bar graphs, buttons, etc.). The Page and its visual controls serve as an operator’s control panel.

• **Page Editor** - allows creation of configuration Pages to be viewed on the Runtime unit. This editor provides the Controls that can be arranged on the page, and all necessary tools to create/edit/modify the page and its controls.

• **Primitive, Base Control** - ways of referring to the fundamental controls (with no sub-controls) such as ellipses, lines, rectangles, arcs, etc. These provide the base in which all controls are built.

• **Project** - contains all of the components that you create. These components include Units, Clients, Configuration, Pages, Libraries. Typically a project consists of associated components (for example, components for the same customer applications).

• **Property** - all of the parameters or characteristics associated with a control. Properties can be static, such as Background Color, Pen Width, Font, Alignment. Or they can be dynamic, such as the numeric value to display, or the color or image to display for a given state.

• **Property Editor** - allows adjustment of properties (Background Color, Pen Width, Font, Alignment, Numeric Value, State Colors). All controls are edited with the Property Editor.
• **Re-usability** - The Canvas software is set up to encourage re-use. Components can be configured once and used many times. Libraries allow components to be created and stored so they can be used in many places of a project without re-configuring them each place they are to be used. By adding entries to a library, you can reference that entry anywhere that type of reference is used. Any control can simply reference the entry - saving repeated development. Additional time saving is noted when an entry is modified – the change will automatically be made everywhere it is used, simplifying the editing process. Effective re-use results in project consistency and time savings.

For example: If you are using a warning color on multiple pages or in multiple controls... Define a color with tag name Warning in the color library. Then configure the color property of the desired controls with 'Warning'. If the warning property needs to be changed from yellow to orange or flashing yellow/orange, it can be changed in all locations by simply changing the color in the color library.

• **Runtime Unit** - runs a Canvas configuration and allows an operator to monitor and/or control a process. Using pages and controls, it replaces the functions of traditional hard-wired operator devices such as pushbuttons, lamps and message displays.

• **Static** - refers to a control and/or property that does not change online. A non-changing title string and border rectangle are examples of Static controls.

• **Tag Libraries** - store tags. A tag is a reference to OPC server data or internal variables. Tags are created manually in ePro Canvas or by importing a ".CSV" file. Tags can be organized into multiple Tag Libraries.

• **Units** - where all components required for Runtime are assembled. This unit data is transferred to a PanelMate ePro unit to run the application. Multiple Units can be created.

Learn more about the Project Explorer
Learn more about the Page Editor

**The Starting Window**

**The Starting Window - Project Explorer**

**Overview**

Below is the main ePro Canvas window used to manage a project. This is the main environment for creating project components and linking them together. Ultimately, the components to be used in Runtime are linked to a unit. A project can hold many project components, but only those assembled in the unit component are sent to the Runtime unit.

Whenever you start ePro Canvas or create a new project. ePro Canvas automatically creates the one component in each component folder, and links these components together for you. All you need to do is add page controls and a different connection if you need one.

**Tip:** Use Right-clicks to see a context menu (a list of options for the selected object). One of the options is usually Properties, which gives you access to settings and information.

**Tip:** Drag-and-Drop components where you want them, from pane to pane.

**Tip:** Many functions can be performed many different ways... the Menu bar, Tool bar, Right-clicking the mouse, or short cut keys.

ePro Canvas window elements

Click an area of the screen below or the text around the screen to learn more about it.
Tip: You can resize any of the windows in ePro Canvas with your mouse. Move the mouse cursor around the edges of the windows until one of these symbols appears; , , , , or , then left-click and hold the mouse button. Drag the window to the desired size and release the left mouse button.

Title Bar

The Title bar is located along the top of a window and contains the following items:

- **Project Name** - Easily view the name of the current project. Project names can be changed at any time. Your saved project name is also displayed here. If you have not yet saved your project “Project” will be displayed.
- **Software Name** - ePro Canvas is the application creating the project.
Menu Bar

The Menu bar located under the title bar contains the **File**, **Edit**, **View** and **Help** menus. Each menu item displays a list of commands. Depending on the component selected (unit 1 in the example above) in the views below the menu bar, some commands will be highlighted and others grayed out. Only the highlighted commands can be executed on the selected item.

Placing the mouse cursor over any of the commands will display information in the status bar at the bottom of the screen.

**Tip:** To the right of the commands are **keyboard short cut keys**. i.e. Ctrl+C = Copy

Toolbar

The Toolbar located under the menu bar contains buttons that provide you with easy access to the most common project commands. Depending on the component selected (unit 1 in the example above) in the views below the tool bar, some commands will be highlighted and others grayed out. Only the highlighted commands can be executed on the selected item.

**Tip:** Placing the mouse cursor over any of the buttons will display information in the form of a flyover tip and information will also be displayed in the status bar at the bottom of the screen.

**Tip:** To display or hide the tool bar, select the **View** menu and select **Toolbar**.

Component Bar

The Component Bar provides you with the ability to easily add components to a project. Each component is sorted according to the topic under which it would fall, such as units, clients, configurations, pages, etc, and is represented by a specific icon. To show the components for a specific topic simply left click on that topic and its components will be displayed. Whenever a component is added to a project it will always be displayed in the Project Components pane.
Components can be added to the project by either **double-clicking** the component or by "**drag-and-drop**". Double-clicking the component will generate a new component in the project components view and possibly in the component data view depending on what is already displayed there.

Drag-and-drop functionality provides shortcut methods for performing common tasks.

**To drag and drop:**
1. Select (highlight) the item that you want to drag and drop. (To select an item, point and click on it.)
2. Press and hold the left mouse button while you drag the item to its destination.
3. Release the mouse button to drop the item in place.

When you use "drag-and-drop" it is easy to know where a component can be dropped by viewing the mouse pointer. Components can only be placed in the "white space" below the existing components of the project components view, or dropped on the corresponding topic. In the example above, the Unit from the Component Bar can be "drag-and-drop" to the white space below the Graphical Component in the project components view or it can be dropped on top of the Units folder in the project components view.

When you drag a component around in an area of the window in which the component cannot be dropped, the mouse pointer looks like this 📦. Continue moving the mouse until the pointer changes to an arrow 🔄, which indicates the component is able to be dropped.

**Tip:** To display or hide the Component bar, select the **View** menu and select **Component bar**.

**Tip:** Change the Component bar icons from large to small by "right click" in the **Component bar**, select **Small Icons**

**Status Bar**
The Status bar is located at the bottom of the window and displays messages and information about the current status of the application.

The left side of the Status line will display specific information about each object as the mouse cursor is moved over them.

The right area of the status bar indicates when specific keyboard keys are latched down as shown below.

<table>
<thead>
<tr>
<th>Action Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAP</td>
<td>“CAP” is displayed on the right side of the status bar when the Caps Lock key is latched down.</td>
</tr>
<tr>
<td>NUM</td>
<td>“NUM” is displayed on the right side of the status bar when the Num Lock key is latched down.</td>
</tr>
<tr>
<td>SCRL</td>
<td>“SCRL” is displayed on the right side of the status bar when the Scroll Lock key is latched down.</td>
</tr>
</tbody>
</table>

**Tip:** To display or hide the status bar, select the View menu and select Status.

---

**Project Components**

**Project Components**

The Project Components pane is where components are stored and managed for your project. The folders within the Project Components pane are called component folders. i.e. Units Folder, Clients Folder, Configurations Folder, etc. These folders will help keep your components organized.

**Adding components**

Components can only be added to a component folder of the same association, i.e. Units can only be added to the units folder, clients can only be added to the clients folder, etc. There are five ways to add components to the component folders.

- Select the project folder where the component will be added, using the Menu Bar drop down list, select New (may not work for all components).
- Select the project folder where the component will be added, using the Toolbar, select ✡ (may not work for all components).
- Select the project folder where the component will be added, press Alt+N or Insert.
- Using the Component Bar.
- Select the project folder where the component will be added, right-click, select New.

**Deleting components**
Select the component to be deleted then:

- Using the **Menu** Bar drop down list, select **Delete**.
- From the **Toolbar**, select \(\times\).
- Press **Alt+D** or **Delete**.
- **Right-click**, select **Delete**.

### Renaming components

Select the component to be renamed then:

- Using the **Menu** Bar drop down list, select **Properties**, change the **Name** field.
- From the **Toolbar**, select \(\pm\), change the **Name** field, select **OK**.
- Press **Alt+R**, **Alt+Enter** or **F2**, change the **Name** field, select **OK**.
- **Right-click**, select **Properties**, change the **Name** field, select **OK**.
- **Double-click** on the component, change the **Name** field, select **OK**.

### Expanding / collapsing folders

- **Double-click** on a component folder or **left-click** the \(\pm\) sign next the component folder will expand to display any components added to that folder.
- Alternately, **double-click** on a the same component folder or **left-click** the \(\pm\) sign next the component folder will collapse the components to hide them from view.

**Note:** If a folder does not have a \(\pm\) or \(\pm\) symbol, there are no additional levels.
Component Data

The component data pane provides a graphical method to:

- View or edit components of a project folder
- View or edit the links between components

View or edit components of a project folder

Left click any of the project folders to display all the components of that folder in the component data pane. The figure below is a result of left clicking the pages component folder. Using the scroll bar at the bottom of the component data pane you will be able to scroll left or right to view additional properties of each of the components. For the following examples we will discuss pages since the figure below is displaying them. But the idea works with any of the components in any of the component folders.

Note: The Component Bar has been hidden for this example. Select the View menu and select Component bar.
Right-click any of the pages in either the component data or project components panes to display a menu of more options like cut, copy, paste, delete, properties, etc.

- Select Cut to remove the page and move it to the clipboard.
- Select Copy to create a copy of the page and move the copy to the clipboard.
- Select Paste to move the page from the clipboard and place it in the new position you have selected. When using the paste function the component is only allowed to be pasted into certain areas, you may need to experiment by moving the cursor to different areas of the screen, then right-click to see if the paste function is available. If the paste function is grayed-out try a different area.
  
  - Example 1 - Copy a page in the component data pane, move the cursor to the white space at the bottom of the same pane and you will be able to paste the copy of the page.
  
  - Example 2 - Copy a page in the component data pane, move the cursor to the pages folder in the project components pane and you will be able to paste the copy of the page.
  
  - Example 3 - Copy a page in the project component pane, move the cursor to the white space at the bottom of the components data pane and you will be able to paste the copy of the page.

- Select Properties to view or edit any of the properties unique for that component. Properties are discussed in greater detail in the help topics for each of the component folders.

Left-click and hold allows you to drag a copy of the page to where want to drop the copy. Move the cursor around the screen, as long as the cursor displays ✔ you may not the page, continue to move the cursor to the same places mentioned under Right-click above till the cursor displays ✗, then release the left mouse button. Use this method just as you would use copy and paste from the right-click above.

Left-click the Name field in the components data pane just above the pages, this will sort your pages in alphabetical order. Left-click to reverse the alphabetical order. Left-click any of the other field in the Components Data pane to sort based on that fields properties.

Place the cursor on the line that splits the Name and description fields until the cursor displays ✦. Left-click and hold, move the cursor left or right to expand or shrink any one of the fields.
When the field is the desired size release the mouse button. Any of the fields can be resized using this method.

**Component Data 2**

View or edit the links between components

To view, add, or edit links between components, left-click any component in one of these component folders:

- **Units** - Left-clicking a unit in the units folder displays all sub-components of the unit and its related links.
- **Clients** - Left-clicking a client in the clients folder displays all sub-components of the client and its related links.
- **Configurations** - Left-clicking a configuration in the configuration folder displays all sub-components of the configuration and its related links.

In the figure below, the unit defined as **Conveyor #1** is selected and the unit links are displayed in the component data pane area. This view displays the minimum components required to create a unit. As can be seen in the figure, clients and configurations are not defined by text and a red symbol. This means that these components are required to have a successful unit. As well, a server, displays text as not defined with a green symbol. This means that a server is not defined and is not required since it is green.

**Component Data 3**

View or edit the links between components continued
When a configuration and a client are linked to unit: **Conveyor #1** you can see the results below. The client name, configuration name, and each of the pages linked to the configuration are displayed for easy viewing and editing.

Adding components

- **Right-click** any of the components to see what editing options can be performed on the different components.
- **Drag** components from the various component folders or component bar and drop in the component data pane to add the component. Keep in mind that a component must be dropped onto the Parent Component. If you drop a component on a similar component (i.e. drop a page onto another page) then, the dropped component will replace the original and the original will no longer be linked.
- **Open** the property editor of the Parent Component and add the component from the property editor.
- **Right-click** select paste. This can only be done if you have already copied the component to the clipboard.
- **Add multiple components** by displaying the components in the component data pane, **select** the first component you want to add, **press and hold** the shift key down on the keyboard, **select** the last component. All the components between the first and last component will be selected. Make sure the cursor is over the selected components, **right-click**, select **copy**. Display the Parent Component in the component data pane, **right-click** on the parent component, select **paste**. Instead of holding down the shift key, try holding down the **Ctrl key**, then when you left-click with the mouse you will be able to components that are not in consecutive order.
- **CTRL-Right Click** to open the pulldown **Component Builder** menu any where in the Canvas Pro editor.

Removing components

- **Right-click** the component and select **Remove Link**. **Note: Do not select the delete key as it will delete the component from the entire project.**
  - **Open** the property editor of the Parent Component and remove the component from the property editor.
Component Property Editor

All components have properties that are edited by displaying the component's property editor. To open a component's property editor, select the component then choose one of the following methods to open the property editor:

- From the Toolbar, select 📐.
- Using the Menu Bar drop down list, select Properties.
- Press **Alt+Enter** or **F2**.
- Right-click, select Properties.
- Double-click on the component, it doesn't matter if the component is in the project components view or the component data pane.

Once the property editor is open you can modify any available properties for the selected component. All property editors will display the project name, component type, and component name in the title bar. The figure below displays a property editor for a configuration named Feature 2 that is a component of a project named project. Notice that a property editor may have more than one tab, in this figure there are six tabs: General, Pages, Libraries, Actions, Event Manager, and Event Banner. Left-click on any of the tabs to display the properties associated with that tab.

To modify any of the properties shown below, left-click on the field to the right of the property name will allow you to enter the data you want. For fields that have a 📐 button you can either enter the data manually by typing it into the field or you can left-click on the drop down list button and select from the list of choices that are displayed. You may not see any choices displayed if you select the drop down list. This will happen when none of drop down list components have been first created. *i.e. In the example*
below if you selected the drop down list for Home Page and nothing was displayed it would be because no pages exist in the pages folder. Double-clicking a field will highlight the contents of the field so they can be edited. Once highlighted you could delete the contents, overwrite them, or use the end or home keys to position the cursor to the front or end of the contents.

ePro Canvas provides the flexibility to create components in any order you would like. In this same example if a page did not display, you could enter a page name into the field anyway and then create that page at a later time. Keep in mind that the naming convention you use is case (upper and lower case) and space sensitive. The name typed in this field and the name given to the page will need to be identical and unique.

The box to the left side of the figure below displays the name of the component being edited. If this component had sub-components they would be displayed underneath the component. The sub-components can also be edited, select the sub-component and you notice the tabs will change to the specific properties for each of the sub-components selected.

![Component Property Editor, Lists](image.png)

**Component Property Editor, Lists**

The figure below displays the pages tab of the configuration named Feature 2. This example shows one way to add pages to a configuration. The first row already has a page assigned to it: Main Menu. To add another page you can **double-click** on the row (grayed out) underneath the first row, this will add another row so that another page can be added. You can continue the process for as many pages as you need.
Getting Started

Make sure you right-click on various places: the Name bar, the page bar, and on the rows themselves. Right-clicking on these areas will provide different options described below:

- **Left-click** on the **Name** bar to toggle between sorting the pages in ascending or descending order.
- **Right-click** the **Name** bar to select options of sort ascending, sort descending, find, or replace.
- **Right-click** on the **Page** bar to select options of find and replace.
- **Right-click** on any of the **rows** to select options of sort ascending, sort descending, find, replace, cut, copy, paste, insert before row, insert after row, insert rows, delete row, delete cell contents, default row contents, or default cell contents.

Since the figure above displays only a cell (of a row), selecting default row contents or default cell contents will perform the same action. If a selected a tab with multiple cells were displayed then selecting default row contents would return that entire row to its default state (usually blank). Selecting default cell contents would cause only the selected cell to return to its default condition (usually blank).

**Note:** When a column is smaller than the largest viewable text in that column, the text appears with "...." at the end.

**Component Property Editor, Groups**

Some tabs hold a lot of information. To organize how this information is displayed the properties may be placed into groupings. The figure below shows the banner group only has one property; font. The table grouping has 6 properties. Changing any of the properties of a group will only effect that particular group and will not effect any other group. Usually you will be able to see the change immediately. So experiment and look for the changes.
Using Categories

Since you can have as many components as you want in a project it may make sense to organize them by categories. By default all components are uncategorized. Categorized components will only display their categories in the component data pane, see the figure below. The pages in the figure below have been placed into three different categories; Common, Feature 1, and Feature 2. If you were to add pages to a configuration all you would need to do is select all the common pages and all of the pages from one of the feature categories to create a complete configuration.

To create a category, open the property editor of a component, select the **general tab**, select the **category** field. If the category has already been defined then you can select it by using the drop down list button. If the category has not been previously defined then just type in new the category name and it will become available for future use, select **OK**.

Category names are different for each project folder. A category for pages will not be available as a category for units. Although this would not prevent you from creating a category of the same name in the units directory.
Double-click on a category or left-click the ▲ sign next the category will expand to display any components added to that folder.

Alternately, double-click on a the same category or left-click the ▼ sign next the category will collapse the components to hide them from view.

### Using Components

#### First Time User Tutorial

**Project Requirements**

At minimum, these project components are required to create a Unit:

- A configuration with at least one page.
- A client OPC connection.

After assigning the configuration and client to the unit then:

- Check the unit for errors.
- Send the files to the unit.

**Application Creation**

Follow these steps to successfully create a unit.

Note: Creating a "Unit" means creating an application to run on a unit. It is referred to as a Unit because, for most flexibility, the ePro software combines the necessary Runtime parts in a Unit component. The Unit combines a Configuration (Pages and Libraries) and a Client (eg: PLC).
1. Set up the Kepware_ePro OPC server for the destination device. Create a KEPWare configuration file (.opf) to send to the unit.

   - Open the KEPServer_ePro software.
   - Select the New icon in the KEPServer Toolbar.
   - Click as directed to add a channel in the software; give the channel a name; and choose the "Allen-Bradley Ethernet" device driver. Leave the rest of the selections as default. (The final screen in configuring the channel will give you a summary of your choices.)
   - Click as directed to add a device in the software. Give the device a name. Select "SLC 5/05 Open" for device model; and enter the proper IP address. Leave the rest of the options at defaults. (The final screen in configuring the device will give you a summary of your choices.)
   - Save the configuration file on your PC and exit KepServer_ePro.

2. Create an OPC client for each device in the Kepware_ePro server to which you wish to communicate.

   - Open ePro Canvas.
   - Right click the Clients folder and create a new OPC Client Adapter. Give the client a name.
   - Use the pull down arrow at the end of the Server Name field to choose EatonElectrical.KEPServer_ePro.
   - In the Access Path field, use the pull down arrow to select Channel1.Device1 where "Channel1" is the name of the channel you configured in Step 1 and "Device1" is the name of the device you configured in Step 1.
   - Click on the field labelled "Click here to import items".
   - Click “OK”

3. Create pages using the tags you created.

   - Click the Page bar in the component bar pane and double click the ePro ES/PS Page icon.
   - Name the Page.
   - Click “OK” and then double click on the page in either the project components pane or the component data pane. This will open the OI Page Editor.
   - Put a Readout Template on the page by either double clicking on its icon in the control bar pane or by clicking and dragging the icon from the control bar pane to the page view pane.
   - Double click on the Readout Template and make the following changes:
     - General tab:
       - In the Value field, enter 'N7:0'.
       - Use the pull down arrow to change Operator Input Type to Data Entry.
     - Data Entry tab:
       - In the Target Expression field, enter 'N7:0'='ClientSystem,?'.
   - Click “OK” on the Readout Template Properties window and save the page.
   - Double click on the Rectangular Button and make the following changes:
     - General tab:
       - In the Break Label field, enter "Exit".
       - Use the pull down arrow to change the Break Action field to select the ActionExit action.
   - Click “OK” on the Readout Template Properties window and save the page. Exit the OI Page Editor (not the Project Explorer!).
4. Create your configuration by linking pages to it.
   • Create a new Configuration and give it a name.
   • In the Home Page field on the General tab, use the pull down arrow to select the page you created as your home page.
   • Save these changes. (Click OK)

5. Create your unit by linking your clients and configuration to it.
   • Create a new Unit and give it a name.
   • On the General tab, Default Client Name field, use the pull down arrow to select the Client created in Step 2.
   • On the Destination tab, set the fields in Line 1 as follows:
     • Transfer .ucf – Yes if you wish to send the file to an ePro hardware unit.
     • .ucf Name – Click the Ellipsis button at the end of the field and use the dialog window to select the location and name of your .ucf file. (Must be done even if you’re not saving the file to your PC.)
     • Transfer Runtime – Yes (if you have not loaded the runtime to this ePro.) You will normally only need to download the runtime to your ePro ONE time. If you have already done this step, you may leave the option set to No.
     • Runtime – Use the Pull down arrow at the end of the field to select the correct runtime for your hardware unit. (Currently, there is only one choice.)
     • Transfer Driver(s) – Yes if you have not yet downloaded the correct driver to this ePro. This will send not only the KepWare driver, but the .opf file as well. You will normally only need to perform this step ONE time. If you have already performed this step, you may leave the option set to No.
     • Driver – Use the Pull down arrow at the end of the field to select the correct driver for your hardware unit. (Currently, there is only one choice.)
     • .opf Name – Use the Ellipsis button to select the .opf file that you wish to use on your hardware unit.
   NOTE: in order to Transfer Driver(s) to the ePro unit successfully, you will need to select the correct KEPWare configuration file (.opf) to send to the unit. The correct file must be stored on the machine that you are using to send the files to the ePro. Additionally, the .opf file must have been saved on your PC from within your KEPServer_ePro software. When a save from within that software is done, a secondary file is created that has an extension of “.wcefiles”. This secondary file and the .opf file must be in the same directory for the ePro’s Send to file… function to work properly.
   • Destination Path or IP Address – Enter either the IP Address of the ePro unit to which you will send the files, or the Drive Letter of the compact flash reader on your system.

   • On the Destination tab, set the fields in Line 2 as follows:
     • Transfer .ucf – Yes if you wish to save the file to a location on your PC.
     • .ucf Name – click the Ellipsis button at the end of the field and use the dialog window to select the location and name of your .ucf file.
     • Click OK when you have completed data entry on these fields.
   NOTE: If you are only saving the file to your PC, you only need to set the properties for Line 2.
   • Be sure that the Unit you created is highlighted.
   • Drag ClientSystem from the project components pane to the component data pane and drop it on the icon of your unit.
     • Repeat for all OPC Clients.
• Drag your configuration to the component data pane and drop it on the icon of your unit.
  - The page you created has already taken its place as a subordinate to your configuration.
• Drag the ActionSystem Action Library to the component data pane and drop it on the icon of your configuration.
• Drag the MediaSystem Media Library to the component data pane and drop it on the icon of your configuration.
• When all components have been moved to the component data pane, right click on the icon of your unit and select Check for errors...
• Click the Check button and the Canvas software will scan your Unit Configuration File (.ucf) for errors. If errors are found, scroll to the highlighted error(s) and double-click on the error to bring you to the dialog box necessary to correct the error. Fix error and repeat until all errors are gone.

6. Once the errors are corrected, use the send to unit function to send the unit (compiled application) to the PanelMate ePro unit.
• Right click on the icon of the unit you created and select Send to file...
• Click the Send button at the bottom of the window.
• Canvas will automatically perform a check for errors on the application and – as long as that passes – will perform all selected options in the Destinations tab.

See Transfer Issues for help troubleshooting errors.

Notice that the media and action libraries are not involved because they are not necessary to create a unit. While these simple steps will create a functional unit. You’ll want to make sure you take advantage of creating components for the libraries so that future units will be even easier to create.

Component Templates

Component Templates are project components that have been saved as templates for reuse within the project. Component Templates may be created by the developer to reduce development time and provide a consistent look or style to a configuration. Any project component can be saved as a template by right-clicking on the component and selecting Create Component Template and any single page component can be saved as a template by right-clicking on it and selecting Create Template as illustrated below.
When a component is saved as a template all configured properties of that component are saved. To create a new project component from a saved template right-click on the component group, i.e. Unit, Client, Configuration, Page, etc., and highlighting Create From Template, then choosing the desired template from the resulting list of Component Templates as illustrated below.
In the Page Editor you can use saved page components by clicking on the Component Template category in the controls bar. New components created from a component template will have all initial properties set to that of the saved template. This can speed up development by allowing the user to establish the default settings of new components added to the project rather than accepting the editor defaults and having to change each new components properties to match the desired standards of the developer. Because page controls can also be saved as Component Templates the developer can take standard Canvas controls and customize them once and then use the customized controls to reduce development time and create a consistent look and feel to the project’s pages.

Some Component Templates are included in the default Project Profile to speed up initial development. They are shown below:
<table>
<thead>
<tr>
<th>Bar Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 inch Bar Template</td>
<td>12 inch Bar Template</td>
</tr>
<tr>
<td>12 inch Indicator Template</td>
<td>12 inch Indicator Template</td>
</tr>
<tr>
<td>2 inch Bar Template</td>
<td>2 inch Bar Template</td>
</tr>
<tr>
<td>2 inch Indicator Template</td>
<td>2 inch Indicator Template</td>
</tr>
<tr>
<td>3 inch Bar Template</td>
<td>3 inch Bar Template</td>
</tr>
<tr>
<td>3 inch Indicator Template</td>
<td>3 inch Indicator Template</td>
</tr>
<tr>
<td>4 inch Bar Template</td>
<td>4 inch Bar Template</td>
</tr>
<tr>
<td>4 inch Indicator Template</td>
<td>4 inch Indicator Template</td>
</tr>
<tr>
<td>6 inch Bar Template</td>
<td>6 inch Bar Template</td>
</tr>
<tr>
<td>6 inch Indicator Template</td>
<td>6 inch Indicator Template</td>
</tr>
<tr>
<td>10 inch Bar Template</td>
<td>10 inch Bar Template</td>
</tr>
<tr>
<td>10 inch Indicator Template</td>
<td>10 inch Indicator Template</td>
</tr>
<tr>
<td>12 inch Bar Template</td>
<td>12 inch Bar Template</td>
</tr>
<tr>
<td>12 inch Indicator Template</td>
<td>12 inch Indicator Template</td>
</tr>
</tbody>
</table>

**Library**

- Unit or Cognex Tag Library: Tag for display of Vision System Image
- ePro ES Unit: ePro ES Template
- ePro PS Unit: ePro PS Template
Because Component Templates are saved with a project just like any other project components they will not automatically be added with a New blank project or New prepackaged project. However, like all other project components they may be copied from an existing project to a new project by opening both projects in separate windows and using copy and paste, or drag and drop, to copy between the two projects.

Changing the Default Prepackaged Project

Changing the Default Prepackaged Project

The default prepackaged project that is created when the ePro Canvas editor is started from the start menu and which is also created when choosing New prepackaged project from the File menu or from the Project's toolbar icon, is an XML file named ProjectProfileCanvasPro.xml (for the ePro Canvas Professional Editor) and ProjectProfileCanvas.xml (for the ePro Canvas Editor). That file is located in the Configuration directory of the ePro Canvas installation directory (default location is C:\Program Files\Cutler-Hammer\ePro Software Suite\Configuration).

If you want to change the prepackaged project to include components and Component Templates that you have created or customized, simply export the desired project as an XML file, name it the same as the default prepackaged project XML file, and place it in the ePro Canvas installation's Configuration directory. You can export a project as an XML file with the File>Export selection from the ePro Canvas Project Explorer editor as shown below.
Licensing

Canvas Editor Licensing

The Version 2.XX install for the ePro Software Suite gives the user two selections, ePro Canvas and ePro Canvas Professional.

Note: Site licenses and Global licenses are also available.

ePro Canvas

The license activation dialog is generated by a utility that can be called from the Start menu or from the "Help > Registration ..." selection in the software. The license registration code is in the form of "ES-XXXXX". Go to the Eaton Electrical website and register or call/FAX Tech Support with the registration information and registration code. Tech Support will verify that the user supplies all required information, plus a valid serial number and that the serial number is for the correct version and that the serial number hasn't already been used for license activation.

ePro Canvas Professional

The license activation dialog is generated by a utility that can be called from the Start menu or from the "Help > Registration ..." selection in the software. The license registration code is in the form of "PRO-XXXXX". Go to the Eaton Electrical website and register or call/FAX Tech Support with the registration information and registration code. Tech Support will verify that the user supplies all required information, plus a valid serial number and that the serial number is for the correct version and that the serial number hasn't already been used for license activation.
Getting Started

After installation of ePro Canvas Professional, the software will behave exactly like ePro Canvas until the product is activated. This means that the registration reminder window will pop up at the launch of the software and all Professional features will be disabled until the registration is completed successfully.

Runtime Unit Licensing

Demo Mode

The ePro Canvas Professional Version 2.0 includes installation of the Runtime software on the development PC. This allows the user to run in "Demo Mode" on the development PC for testing of the runtime application and KEPServer_ePro (also in "Demo Mode"). Demo Mode for the runtime software will behave as follows:

1. When the runtime application (.UCF file) is launched, a dialog box will appear as it loads indicating that it is in Demo Mode and the software will stop running after 60 minutes. The "OK" button closes the dialog box. The dialog box will reappear every 15 minutes indicating the amount of time left for demo mode and again the "OK" button will closes the dialog box.
2. If the user closes the runtime application or if the demo period times out and the user re-launches the runtime application, it will start the in the same manner and the demo timer will be reset to 60 minutes.
3. If the 60-minute time runs out before the user closes the application, the application will stop updating and a dialog box will open indicating that the demo period has expired. When the user clicks the "OK" button of the dialog box the box will disappear and the application will close.

Activation

The Canvas Pro Runtime software may also be activated similarly to ePro Canvas and ePro Canvas Professional licensing. The same registration utility (used for all license activations when run from the Start menu) allows the user to register Canvas Pro runtime. If the user supplies the required information and valid serial number for Canvas Pro runtime then tech support will return an activation code that will allow the user to run in full runtime mode on the PC with no timeout counter.

Additional Feature Runtime Licensing

Recipes and DataArchive Features

The ePro PS license manager is loaded on each ePro PS machine. The runtime license for Recipe Management and the Data Archive functionality, are optional components which must be purchased in order to use these features on an ePro PS unit. The Registration process is identical to that of registering ePro Canvas or ePro Canvas Professional software. First the ePro License utility must be started on the ePro PS unit from the start menu. Using Recipes for an example, the ePro Recipes line must be selected from the Software Registration dialog as shown below. If the Recipe Management feature is already licensed it will show a state of "Registered-License Active", and the Activation key will show the key that was generated during the activation process. If unlicensed then only the Registration code field will show. To register and receive an Activation Key, follow the directions shown in the Software Registration dialog box. Be sure to have the serial number of the purchased Recipe Management license handy because that will be a required field in the online form. Once you receive the Activation Key following the online registration you may enter that key and click on the Apply Activation Key button. Once you have applied the activation key a dialog box will appear to indicate that the registration process was successful. If there was an error in entering the Activation Key you will be prompted to recheck the value and enter the key correctly.
Once successful, OK the success dialog box, Exit the Software Registration utility and perform a Protect Mode Save on the ePro PS to ensure that the registration is made permanent on the ePro unit.

Alternately, you may initiate the activation process before receiving the Activation Key by selecting the ePro Recipes line in the Software Registration dialog and hitting the Initiate License Activation key. Then exit the dialog box and run the Protect Mode Save function. This will give you a 10 day grace period during which you may run the Recipe Management features in full functional mode. Once you receive the Activation Key you will then need to re-open the ePro License utility to compete the activation process by entering the Activation Key and performing a Protect Mode Save function.

**Eaton Electrical Support Services**

The goal of Eaton Electrical is to ensure your greatest possible satisfaction with the operation of our products. We are dedicated to providing fast, friendly and accurate assistance. That is why we offer you so many ways to get the support you need. Whether it’s by phone, fax or email, you can access Eaton Electrical support information 24 hours a day, seven days a week. Our wide range of services are listed below.

You should contact your local distributor for product pricing, availability, ordering, expediting and repairs.

**Website Address**

www.eatonelectrical.com

Use the Eaton Electrical website to find product information. You can also find information on local distributors or Cutler-Hammer sales offices.

**e-COM Support Center**

VOICE: 800-356-1243 (8AM-6PM EST)
FAX: 800-752-8602
AFTER-HOURS EMERGENCY: 800-543-7038 (6PM-8AM EST)
Call the e-COM Support Center if you need assistance with placing an order, stock availability or proof of shipment, expediting an existing order, emergency shipments, product price information, returns other than warranty returns, and information on local distributors or sales offices.

<table>
<thead>
<tr>
<th>e-TRC Technical Resource Center (support for OI, PLC &amp; IPC)</th>
<th>VOICE:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>800-809-2772, selection 5 (8AM-5PM EST)</td>
</tr>
<tr>
<td></td>
<td>414-449-7100, selection 5 (8AM-5PM EST)</td>
</tr>
<tr>
<td></td>
<td>FAX: 614-882-0417</td>
</tr>
<tr>
<td></td>
<td>EMAIL: <a href="mailto:CHATechSupport@eaton.com">CHATechSupport@eaton.com</a></td>
</tr>
<tr>
<td></td>
<td>AFTER-HOURS EMERGENCY (PLANT DOWN ONLY):</td>
</tr>
<tr>
<td></td>
<td>800-809-2772, selection 5 (5PM-8AM EST)</td>
</tr>
<tr>
<td></td>
<td>414-449-7100, selection 5 (5PM-8AM EST)</td>
</tr>
</tbody>
</table>

If you are in the US or Canada, and have OI/PLC/IPC questions, you can take advantage of our toll-free line for technical assistance with hardware and software product selection, system design and installation, and system debugging and diagnostics. Technical support engineers are available for calls during regular business hours.

<table>
<thead>
<tr>
<th>European PanelMate Support Center</th>
<th>VOICE: +41 1 806 64 44 (9AM-5PM CET)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMAIL: <a href="mailto:CHSupport@bfa.ch">CHSupport@bfa.ch</a></td>
<td></td>
</tr>
</tbody>
</table>

This center, located in Zurich, Switzerland, provides high-level quality support and product repair services for your PanelMate products. You will receive real-time technical and application support.

<table>
<thead>
<tr>
<th>Repair and Upgrade Service (support for OI &amp; IPC)</th>
<th>VOICE:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>800-809-2772, selection 5, 4 (8AM-5PM EST)</td>
</tr>
<tr>
<td></td>
<td>414-449-7100, selection 5, 4 (8AM-5PM EST)</td>
</tr>
<tr>
<td></td>
<td>FAX: 614-882-3414</td>
</tr>
<tr>
<td></td>
<td>EMAIL: <a href="mailto:RepairCHA@eaton.com">RepairCHA@eaton.com</a></td>
</tr>
</tbody>
</table>

If you have questions regarding the repair or upgrade of an OI/IPC, contact your local distributor. Additional support is also available from our well-equipped Repair and Upgrade Service department.

**Product Comparisons**

**ePro Canvas Professional vs. ePro Canvas Components**

The following list describes the additional features that are only available in the ePro Canvas Professional development software.

1. Ethernet Transfer to PanelMate ePro PS
2. DVT vision system support (Client Adapter)
3. Cognex vision system support (Client Adapter)
4. Arc Control
5. PanelMate Power Pro Template support
   - Bar and Variable Size Bar
   - Indicator and Variable Size Indicator
   - Display and Variable Size Display
   - Readout and Variable Size Readout
   - Bar Trend and Line Trend
   - Table
   - Variable Size Graphic
   - Variable Size Control Button
6. PanelMate Power Pro .pps file import
7. Action List
8. Start Action
9. Recipes (Runtime requires catalog # 76RM)
10. Data Archiving (Runtime requires catalog # 76DA)
11. Email Action
12. Sound Action
13. PanelMate ES/PS Runtime demo mode on PC
14. Required registration for license activation

**ePro PS vs. ePro ES Components**

The following list describes the features that are supported by the PanelMate ePro PS and are not supported by the ePro ES.

1. DVT vision system support
2. Cognex vision system support
3. Arc Control
4. Support for screen resolutions greater than 320x240
5. Alphanumeric Entry – QWERTY pop-up
6. Alphanumeric Entry – cell phone keypad pop-up
7. .jpg, .wmf and .emf images
8. PanelMate Power Pro Template support
   - Bar and Variable Size Bar
   - Indicator and Variable Size Indicator
   - Display and Variable Size Display
   - Readout and Variable Size Readout
   - Bar Trend and Line Trend
   - Table
   - Variable Size Graphic
   - Variable Size Control Button
9. Action List
10. Start Action
11. Recipes (Runtime requires catalog # 76RM)
12. Data Archiving (Runtime requires catalog # 76DA)
13. Email Action
14. Sound Action
15. Document Viewer (.htm, .pdf, .txt files)
16. Advanced Event Banner functions such as color control of alarm state and alarm criticality, filtering functions, and navigation functions
17. Support for imported PanelMate Power Pro .pps files

When developing displays for the PanelMate ePro ES the use of Color Libraries and Media Libraries should be kept to a minimum in order to maintain reasonable responsiveness. Also, due to the lower resolution of the PanelMate ePro ES 6" display, the amount of data displayed in the Event Viewer should be kept to a minimum in order to keep the display meaningful and useful.
Project Components

Projects
A project is where you store and manage all of the components that you create. Project components are contained in any of the following component folders.

- Units
- Clients
- Configurations
- Pages
- Libraries

These are part of the project. Examples of project components which have similar associations include the following.

- The same customer's units
- All the presses in a press room
- An entire line in an assembly plant
- Facility Management
- All waste water pump stations

A project's name appears as the name of top folder in the project components view and also appears in the title bar of the software.

Importing a PanelMate PowerPro (.pps) configuration

Creating a new project

A new project is created every time ePro Canvas is started. Other ways to create a new project are:

- File menu, select New
- Left-click the New icon in the toolbar
- Use the short cut keys Ctrl+N

When a new project is created it's default name is Project. It can be renamed later. The project's saved name will change to untitled, and will appear in the title bar.

Naming a project

You can change the name of a project at any time, to do this;

- From the Toolbar, select.
- Using the Menu Bar drop down list, select Properties.
- Double-click the project name change the Name field, press OK.
- Right-click on the project name, select properties, change the Name field, press OK.
- Select the project name, press Alt+Enter or press F2, change the Name field, press OK.

Saving a project
Saving a project is just like saving a file from any other windows program. Save projects by:

- **File** menu, select **Save** or **Save As** (to change its current name)
- **Left-click** the **Save** icon in the toolbar
- Use the short cut keys **Ctrl+S** (save) or **Ctrl+A** (save as)

The project will be saved with the extension `.chp`. When a project is saved all of its current settings (window size, icon size, views) are saved as well.

**Opening a project**

To open an existing project (.chp file), choose one of the three methods below.

- **File** menu, select **Open**, navigate to the drive/folder where the .chp file is located.
- **Left-click** the **Open** icon in the toolbar
- Use the short cut keys **Ctrl+O**

**Tip:** The last ten opened projects are listed at the bottom of the File menu for quick access.

### Sharing components from multiple projects

ePro Canvas can edit one project at a time. If there is a need to share components between projects, start a second ePro Canvas program. Move components between the two projects using Cut, Copy, and Paste.

### Search and Replace

See [Search and Replace](#)

### Units

To add, delete, or rename units visit Project Components.

Creating a unit and linking components to it is the only way to send the components you create to a device like a PanelMate ePro product. Once the Minimum Required Components are linked to a unit, the unit can be checked for errors, and then sent to the destination unit.

### Alarm and Event Runtime Settings and Example

#### Unit properties

**General tab**

- **Name** property - When naming your unit, use a name that represents either the machine that the unit will go on or geographic area where the unit will be placed will help you organize your units by using meaningful names. Provide a unique name for your unit.
- **Description** property - Add a meaningful note about the unit.
- **Type** property - Select the type of hardware platform that the unit will send it file to. Select either:
  - **ePro ES Family** - If you are sending the unit to a PanelMate ePro ES hardware platform.
  - **ePro PS Family** - If you are sending the unit to a PanelMate ePro PS hardware platform.
• **DataBroker Family** - Not currently available.

• **Configuration Name** property - This is where a configuration is linked to a unit. You can either type the name of the configuration or select it using the drop down list. If the configuration doesn't exist yet, you can still enter the name of the configuration and add the configuration to configurations folder later, but make sure the names are identical.

• **Default Connection Name** property - Using a default connection name will make programming easier by not having to address a PLC name and register when the unit is connected to multiple PLCs. If you have multiple PLCs on your network, you will need to provide a PLC address and a register address in order to read or write data with the PLC. If you specify a default Connection name for the one device that you will communicate the most with then you only need to provide a register or tag reference to read or write data with the PLC because ePro Canvas will automatically place the default connection name in front of any register address it sees. When only one PLC is being communicated to, by setting the PLC as the default connection you would only need to read and write register or tag information with the PLC.

• **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**Clients tab**

This is where a client connection is linked to a unit. You can either type the name of the client or select it using the drop down list. If the client doesn't exist yet, you can still enter the name of the client and add the client to the clients folder later, but make sure the names are identical.

Learn more about editing rows

**Destinations tab**

You must establish how your unit files (ucf, opf, fonts, or executive) will be sent to a unit or units. Each row of this tab represents a single ePro hardware unit. Add more rows to send the same files to more units. There are several ways you can send files to units. You can send files to your ePro hardware platforms by sending the files over ethernet or by sending them to a compact flash drive, then placing the compact flash in the ePro unit.

• **Destination** column - This column is for reference only can not be edited.

• **Transfer .UCF** property - Select Yes or No. Yes will send the files. No will not send the files. Use this selection when you are sending files to multiple units and want some of the units to receive the files but others not to.

• **.UCF name** property - This field is required. Create the name of the UCF file here.

• **Transfer Runtime** property - Select Yes or No. The runtime could also be called the executive. Choose yes If you need to upgrade the runtime on your unit. Selecting no will not send the runtime files to the unit when the send to unit is executed.

  **Note**: If you are using your ePro hardware unit for the first time you should select yes to make sure a proper updated runtime is installed.

• **Runtime** property - This field is required if "Transfer Runtime" is set to YES. Use the drop down list button to select the runtime for the selected ePro ES or PS unit.

• **Transfer driver(s)** property - Select Yes or No. Select yes to send the driver files. Select no will not send the driver files to the unit when the send to file is executed. If you are changing drivers, have updated the one that is already installed on the unit, or setting up the unit for the first time you will need to select yes. If you have not made any changes to the driver but have updated something else then you can select no since the driver will not need to be transferred.

• **Driver** property - If you selected yes for transfer driver then you will need to select the driver here. Select KEPServer_ePro for the units processor type.

• **.opf name** property - If you selected yes for transfer driver then you will need to select the opf file name here. When using the KEPServer_ePro OPC server anytime you save
your work it will be saved as an opf file. Use the ellipsis button to select the opf file that will be transferred to the unit.

Note: When an opf was selected you will need to make sure that an associated file is in the same directory. When you save an opf file, KEPServer_ePro will also save an associated file of the same file name but with the extension .wcefiles. If you have not moved the opf file after KEPServer_ePro saved it then there is no need to do anything. If you have moved the opf file you should either also move the .wcefiles file to the same directory, or use KEPServer_ePro to save the opf to the new directory which will also automatically save the .wcefiles.

- **Destination Path or IP address** property - If your unit is connected to an Ethernet network you can enter the unit’s IP address in the form of xxx.xxx.xxx.xxx and all of the necessary files will be sent to over the network to the unit.
  - For ePro ES Units - When using Ethernet transfer, make sure the compact flash card is installed in the unit before sending to unit. If the unit is not on a network you can send all the required files to a compact flash card attached to your computer. Once the file are loaded onto the compact flash, place the compact flash into your ePro unit and it will run as if you loaded the files over a network. To send the files to a compact flash enter the destination path of the compact flash. i.e. x:\ in the field. Where x is the drive letter assigned to the compact flash by your computer. Make sure you deleted all files on the compact flash before you do this so there is enough room for the new files.

**Event manager tab**

This event manager performs the exact same function as setting up the event manager tab of a configuration except using this tab allows you to override the configurations event manager. You would probably want to do this when you have used the configuration in multiple units and each of those units must use the event manager the way it was set up in the configuration. Now, you may want to use the same configuration in a new unit but do not want the unit to use the event manager settings of the configuration. By using the override selection of this tab, this new unit will be able to create new event manager settings without affecting the configurations event manager settings.

See event manager properties

**Event banner tab**

This event banner performs the exact same function as setting up the event banner tab of a configuration except using this tab allows you to override the configurations event banner. You would probably want to do this when you have used the configuration in multiple units and each of those units must use the event banner the way it was set up in the configuration. Now, you may want to use the same configuration in a new unit but do not want the unit to use the event banner settings of the configuration. By using the override selection of this tab, this new unit will be able to create new event banner settings without affecting the configurations event banner settings.

See event banner properties

**Fonts to transfer tab**

Fonts used in the configuration are automatically sent to the hardware unit (unless it is a default font already on the unit). ePro Canvas places all the transferred fonts on this tab. This is for information only - the list should not be altered.

Notes:

Fonts consume memory on the hardware unit, which means less room to run a configuration... so use fonts wisely and sparingly.

If the **font on the Runtime unit is different** from the configuration: It is possible that the font was transferred to the unit, however there was not enough memory to load it, so a default font was used instead. Change the font in the configuration to match one already used.
When transferring a new configuration to a Runtime unit - all existing fonts are deleted from the unit before the new ones are transferred.

Check for errors

Check for errors is for when you are ready to test you work. Check for errors will test a unit and all of it’s links for any errors with out sending the files to a unit. This way you can work out any errors before sending the files to a unit. When you right-click on a unit, one option that will appear in the menu is Check for errors... Selecting check for errors... will display a window similar the one below.

Pressing the check button will start the check for errors process. Check for errors will go through the unit item by item and display the results of item being on a separate row in the right hand pane. If no errors are found the last row of the right hand pane will display the (0) errors message.

In the example, check for errors has found a missing reference. There is (1) Error, but 2 red messages are displayed since there are 2 locations in which the problem can be fixed. The missing reference could be missing because the wrong connection was defined in the unit, or the wrong value was placed in the control on the page. Double-clicking on the red error message will call the corresponding property dialog box to correct the problem, as shown below. In this case the wrong client, PLC2, was given before the tag. The client can be corrected and check for errors can be run again.
Note: Check for Errors is also done at the beginning of a Send to File as described in the next section.

Send to file

When you right-click on a unit, one option that will appear in the menu is Send to file... Selecting send to file... will display a window similar the one below.

Selecting the Send button will first perform a check for errors. Then if no errors were found, send to file will proceed to send the selected files (from the destinations tab) to their selected destinations (also from the destinations tab). Send to file will start with the top row of the destinations tab and perform the selected options for that specific row. When those files are sent, send to file will proceed to the next row and perform those selected option. This will continue until all of the rows how been processed. If an error occurs while processing a row. The current row and any rows below the current row will not be processed. Any rows that were processed prior to the error are not affected since the files have already been sent.

An error may occur if you selected to send the files via ethernet and did not provide a valid IP address for the hardware unit. Or the ethernet cable was not attached, etc.

After the send button is pressed, the right hand pane of the example below will display the status of the check for errors and the send to file status of each row of the destination tab. Looking at the example below, the right hand pane displays a status line for each item checked, then the result indicates any Errors. In this example, the send to file simply saved the file to the desktop. If the files are selected to be sent to the unit, there will be a continuation with status of the of the transfer activity. During check for errors and transferring the files, both the send and the Done button will be grayed out meaning they cannot be used at the moment. When they become usable again (not grayed out) the operation is complete. Press the done button to close the window or launch button to test the ucf file on the development PC. If there was an error during the transfer process an error message directing your attention the problem would be displayed.
Note: during the send to file, a Cancel button appears at the bottom of the window. The operation can be cancelled until the files start transferring to a Runtime unit. This is to ensure consistency of files on the Runtime unit.

Firewall Friendly option

If files cannot be transferred due to a firewall block, there is an option in the Canvas Tools Menu/Dialog to use a firewall friendly method when a Send To File is performed.
• Firewall Friendly changes the operation of the transfer so that all data connections are originated by Canvas. (This is required with some firewall software. Firewall software will often restrict incoming connections to a corporate computer, but will allow outgoing connections. By default, FTP clients contact the server to establish a "control" connection and the server calls the client back to establish the "data" connection. By selecting Firewall Friendly, the ftp client will originate both connections.)

**Clients**

To add, delete, or rename clients visit Project Components.

This is where you create client connections for your project. PanelMate ePro products are OPC clients and require a link to an OPC server in order to be able to send and receive data between PanelMate ePro and the device it is connected to. The client connection allows you to set up the required fields the server will need in order to properly communicate. The required properties are listed below and an identical field will also need to be set up in the OPC server. This is how the client and server know how to send and receive data with each other. The required properties are:

- **Server Name**
- **Access Path**
- **Tag Name** (you don't truly need a tag, you can provide a direct register address instead)

While this section details the link to the OPC server, you will need to set up the server separately by starting the OPC server and configuring the access path and tags. When configuring the OPC server the terms for the server may be different as in this example:

<table>
<thead>
<tr>
<th>Client Term</th>
<th>Server Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>Server Name</td>
</tr>
<tr>
<td>Access Path</td>
<td>Channel.Device</td>
</tr>
<tr>
<td>Tag Name</td>
<td>Tag Name</td>
</tr>
</tbody>
</table>

You can create as many client connections to the same OPC server as the server will allow.

**OPC client adapter component properties**

**General tab**

- **Name** property - Provide a unique name for your client. ePro Canvas will not allow you to have duplicate names. Names are case sensitive so the name "EthernetIP" and "ethernetIP" are two different names and ePro Canvas would accept them. Some suggestions are:

  - DH485 on Comm 1
  - DF1 on Comm 2
  - EthernetIP
  - SNP on Comm 3

- **Server Name** property - Select the name of the OPC server that you will be using in your project. If the server was installed on your PC when ePro Canvas was installed you will be able to use the drop down list button to select your server. Currently the only OPC server supported is KEPServer_ePro OPC/DDE Server.
**Access Path** property - An access path is a name that you define to help organize data inside the server. Each access path is set up inside the server software and could organized as all recipe data, alarm data, or broken into parts of machinery. You can have as many different access paths as you need to organize your project.

**See example**

The table below displays the how multiple access path can be set up for the same server.

Assume a server name is KEPServer_ePro. We will set up five access paths for five different PLCs we want to send and receive data with. In the table below we will only show one tag name for each access path but you can have as many tags as you want. Notice that under the server the channel and device are set up separately, but under the client set up the channel and device are combined to form a single text string in the access path. While the channel and device are combined in the access path they are still are separated by a . between them. When setting up the OPC server, the channel and device are set up separately. The channel usually defines the network you will be using while the device defines the type of device (typically a PLC) and device address.

<table>
<thead>
<tr>
<th>Client Set Up</th>
<th>Server Set Up</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server Name</strong></td>
<td><strong>Access Path</strong></td>
</tr>
<tr>
<td>KEPServer_ePro</td>
<td>EthernetIP.PLC1</td>
</tr>
<tr>
<td>KEPServer_ePro</td>
<td>EthernetIP.PLC2</td>
</tr>
<tr>
<td>KEPServer_ePro</td>
<td>EthernetIP.PLC3</td>
</tr>
<tr>
<td>KEPServer_ePro</td>
<td>EthernetIP.PLC4</td>
</tr>
<tr>
<td>KEPServer_ePro</td>
<td>EthernetIP.PLC5</td>
</tr>
</tbody>
</table>

**Import From Server** property - By clicking this property value area, the tags for the configured Server are obtained and populate the client tree. See OPC Tag Import below.

**Remove Imported Tags** property - This will remove the tags previously imported from the given Access Path. Tags should be removed before importing.

**Tag Library Name** property - This property is optional. If you would like to use a tag library, you can use the drop down list button to select your tag library if it was previously installed. If the tag library has not been installed you can still enter a tag library name and enter the tag library later but make sure the names are identical.

**Category** - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**Scans tab**

You can set a client for two different scan time modes. Continuous scans tell the runtime how often (in milliseconds) to scan conditional actions which are scanned continuously regardless of what page the unit is currently displayed. Page scan is separate from a continuous scan in that it is the scan time (in milliseconds) to update to controls of the currently displayed page.

**Continuous Scan (ms)** property - Set the time you want the runtime to continuously scan the conditional actions. A setting lower than 250ms may result in poor system performance.

**Page Scan (ms)** property - Set the time you want the runtime to update the controls on the currently displayed page. A setting lower than 250ms may result in poor system performance.

**Items tab**

This tab includes Item Number and Item Name headings. The items are blank unless "Import From Server" from the General Tab is used, which results in populating the items with imported tags.
ConnectionSystem adapter component properties

The ConnectionSystem client adapter is how your configuration will use the system functions like pop-up numeric keypad. If your configuration will be using the numeric keypad you must link this client to your unit.

General tab

- **Name** property - Provide a unique name for your client. ePro Canvas will not allow you to have duplicate names. Names are case sensitive so the name "System" and "system" are two different names and ePro Canvas would accept them.

- **Tag Library Name** property - This property is optional. If you would like to use a tag library, you can use the drop down list button to select your tag library if it was previously installed. If the tag library has not been installed you can still enter a tag library name and enter the tag library later but make sure the names are identical.

- **Category** - Create a new category by typing a new category name or use the drop down list button to select one already defined.

OPC Tag Import

A simple way of accessing OPC server data is to read the OPC data directly from the server, then later browse for tags as needed.

Import Tags

In the OPC Client properties dialog box, the Import From Server property provides a live connection to the OPC server allowing direct tag import from the configured server. All tags from the server are obtained and automatically added to the client connection. This is initiated in the Client Properties dialog box as follows.

- Enter Server Name
• Enter Access Path
• Click the Import from Server property

When importing from an OPC server, all Tag Group Levels are imported. This is also referred to as a Deep Import since all sublevels will be obtained (for instance Channel.Device.SubgroupLevel1.SubgroupLevel2.Item).

Note: _hints can be eliminated from imported client tags by editing Tools/Options in KEPServer_ePro and disabling the property as shown below, then importing the tags.

Use/Browse Tags

Once the tags are imported, they are added to the client tree, and can be browsed under the configured client adapter. In properties which use tags, a pull down list allows "drilling down" through the list of clients and tags. Thus, tag libraries are not necessary.

Vision Interface Clients

• Cognex Client
• DVT Client

Note: Changing a client adapter's name will automatically change the name of the client everywhere it is used in the project. This makes it easy to update all your units that might be using the client adapter. Any units where you do not want this change to happen will need to be edited manually.

Configurations

To add, delete, or rename configurations visit Project Components.

This is where you add pages, libraries, actions, and events to your configuration. To create a valid configuration, you must have at least one page linked to your the configuration.
**Configuration properties**

**General tab**

- **Name** property - When naming your configuration, use a name that represents the machine that the configuration will go on, geographic area where the unit will be placed will help you organize your configuration by using meaningful names. Provide a unique name for your configuration.

- **Description** property - Add a meaningful note about the configuration.

- **Home Page** property - This is the page that is displayed every time the unit starts. You can either type the name of the page or select it using the drop down list. If the page doesn’t exist yet, you can still enter the name of the page and add the page in the pages folder later, but make sure the names are identical. Adding a home page will also add the page to the pages tab. You should not use any visibility expressions on the page selected as a home page.

- **Active Language Expression** property - Used for multi-language configurations, blank otherwise. This property is used if you want the unit to determine which language should be switched to during runtime. All country languages have numeric values assigned them by the operating system, see the help files that came with the operating system you have for more information about operating system languages. If an expression is used for this property, whatever value the expression equate to will change the language setting to its numeric equivalent. *i.e.* If the expression equals 009 (decimal), then the active language would be English. If the expression equals 012 (decimal), then the active language would be French. If left blank then neutral (000 decimal) is assumed. Neutral can be used as a constant when using multi-language. More about this topic can be found under the media library help.

- **Category** property - Create a new category by typing the a new category name or use the drop down list button to select one already defined.

**Pages tab**

This is where pages are linked to a unit. You can either type the name of the page or select it using the drop down list. If the page doesn’t exist yet, you can still enter the name of the page and add the page to pages folder later, but make sure the names are identical. There are no limits to the number of pages that can be added to a configuration.

Learn more about editing rows

**Libraries tab**

If you created and used libraries in the making of pages then you will need to link those libraries to the configuration so that the configuration link the page controls to the libraries used. If you used libraries in the creation of a page and do not link the library to the configuration you will receive an error when you check for errors. To link a library, first select the drop down list button under the type column heading to select the type of library to link. Then you can either type the name of the library or select it using the drop down list. If the library doesn’t exist yet, you can still enter the name of the library and add the library later, but make sure the names are identical.

Learn more about editing rows

**Actions tab**

- Linking actions under the action tab is different then linking action libraries under the libraries tab. When placing an action under the action tab you are linking an action to the configuration which has no visual attributes. Let’s say you wanted to record an event every time the unit was started. First you would create the event using the event action, then you would link the action to the configuration here. Since this action is not tied to any page controls *i.e.* Buttons, graphs, etc. it must be added here. These actions will be continuously scanned so it is important to add an expression that will allow the action to perform when you want it to perform but not any other time.

- You can either type the name of the action or select it using the drop down list and drill down through the action libraries until you get to the desired action. If the action doesn’t exist yet, you
can still enter the name of the action and add the action to action libraries later, but make sure the names are identical. There are no limits to the number of actions that can be added to a configuration.

Learn more about editing rows

Event manager tab

Event banner tab

Document Viewer

Document Viewer Content

**Note**: Changing a configuration's name will automatically change the name of the configuration everywhere it is used in the project. This makes it easy to update all your units that might be using the configuration. Any units where you do not want this change to happen will need to be edited manually.

Pages

To add, delete, or rename pages visit Project Components.

Create and edit pages in the pages folder. Once you have added a page to the folder you can open the page editor to place controls on the page.

If any pages have controls placed on them you will be able to edit, add, or delete any of these controls without opening the page editor by double-clicking on the control while it is in the component data view.

Example

In the figure below page 1 is highlighted displaying the controls on the page. Assume the rectangular button has been configured as a goto main menu button and that we want the button on all of the pages. **Right-click** the rectangular button, select **copy**, then **right-click** each of the pages in the pages folder, **right-click** and select **paste**. The rectangular button will be copied to each of the pages that you selected. You could have copied multiple controls and performed the same operation.

The Page Editor

**Page component properties**

When the property editor opens, the window on the left will display a tree view of any controls that are on the page. The controls can be edited by drilling down to the one you want to edit. When the selected control is highlighted it properties will be displayed on the right side. Select which property you want to edit and proceed.

With the page selected you will be able to edit the properties below.
General tab

- **Name** property - Provide a unique name for your unit.
- **Description** property - Add a meaningful note about the unit.
- **Standard Navigation** property - Not available on PanelMate ePro ES models.
- **Page Enabled Expression** property - This is an expression that allows you to select when this page is visible or not. Any expression that evaluates to a 1 or true will allow the page to be visible. The default value is 1. You can create any expression to perform any function you need. *i.e.* create a visibility expression to make the page visible only when in maintenance mode. When a page is set as a home page, visibility expressions should not be used.
- **Screen Size** property - Use the drop down list button to select the screen resolution for the page you created. This can be changes at any time and it can also be changed while using the page editor.
- **Background Color** property - Use the ellipses to select an existing color or create a custom color.
- **Watermark** property - Choose an image to be a background image. The easiest way is to have the desired image in the image library then you would be able to select it by drilling down into the image library. You also can type the file name and path directly into the field. If you use this method make sure you place " before and after" the text.
- **Display** property - This property will only have any effect if you have chosen to use a watermark. Use the drop down list button to choose stretch or tile.
  - **Tile** - will repeat the watermark image both horizontally and vertically across the screen.
  - **Stretch** - will stretch the watermark image horizontally and vertically to fit the screen size.
- **Intensity** property - This property will only have any effect if you have chosen to use a watermark. Use the drop down list button to choose the desired background intensity level of light, normal, or dark.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

Master Page

Page editor reference libraries tab

Page editor reference libraries property - Set up these libraries in the same manner as you would under the configurations - libraries tab. The difference is that by placing libraries here you will be able to debug certain controls from within the page editor. Link the libraries that you will use to create the page you are working on. More is discussed under the page editor help. Linking a library here will not automatically link the library to a configuration, you will need to link them in the configuration.

**Note:** Changing a page's name will automatically change the name of the page everywhere it is used in the project. This makes it easy to update all your units that might be using the page. Any units where you do not want this change to happen will need to be edited manually.

Libraries

Tags

To add, delete, or rename tag libraries visit Project Components.
A tag is a way of assigning specific address within the destination device with a name that represents the function of the address. It is usually easier to program by using names than it is using direct addresses. ePro Canvas allows you to use either tag names or direct addressing. Local variables can be created for use within the configuration, using User Defined System Tags.

**Tag library properties**

**General tab**

- **Name** property - Provide a unique name for your library.
- **Description** property - Add a meaningful note about the library.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**Tags tab**

- **Name** property - Enter the name of the tag which must be unique.
- **Definition** property - Enter the definition of the tag here, Usually this is the register address you want the tag name assigned to. i.e. N7:0 or 401025, etc.
- **Data Type** property - Use the drop down list button to select the type data that will be received from the address.
  - **Interface Supplied** - type used when you imported a tag file. Some devices, when they create a csv for import also provide the data type. If you are using Kepware OPC server to create the csv file that you will import it does provide the interface type automatically.
  - **Logical** - provides a true/false condition to the project. False if the value is zero (0), true if the value is non-zero
  - **Signed 8 Bit** - valid range is -128 to 127 (decimal)
  - **Signed 16 Bit** - valid range is -32,768 to 32,767 (decimal)
  - **Signed 32 Bit** - valid range is -2,147,483,648 to 2,147,483,647 (decimal)
  - **Unsigned 8 Bit** - valid range is 0 to 255 (decimal)
  - **Unsigned 16 Bit** - valid range is 0 to 65,535 (decimal)
  - **Unsigned 32 Bit** - valid range is 0 to 4,294,967,295 (decimal)
  - **Floating Point 32 Bit** - valid range is ±~10⁻⁴⁴.⁸⁵ to ~10⁻³⁸.⁵³ (decimal)

Learn more about editing rows

**Importing tags**

ePro Canvas will import .CSV (comma separated variable) files to receive tags that might have been created for the destination device. Most destination devices can usually export their tags in a csv format. Once tags are in a csv format ePro Canvas can import them by:

- **File** menu, select **Import**, select **Tag Library**. This will create a new tag library each time you do this.

  You will see a window similar to the one displayed in the figure below. Use the to find your csv file, then select **Open**. The window will populate to look something like the figure below.

  Using the drop down list button under the **Tag Name Column**, select the which column holds the tag names. In the figure below it is column 1.
Then, using the drop down list button under the **Reference Column**, select the which column holds the device address. In the figure below it is column 2. If the csv file was generated by an OPC server then this column can also point to the tag name since the OPC server already has a tag name and reference definition completed inside the OPC server. In this case you would only need the tag name to communicate to the OPC server because the OPC server will translate the tag into a reference designation.

Next you must select which row to start importing tags. In the figure below there is a ✓ located on the first row of the bottom pane. This check mark indicates ePro Canvas will start importing with the first row. However the first row is only a title row. The check mark must be moved to the second row to properly import the tags and not the title row. Move the check mark by selecting the second row with your mouse.

Select **Import**, the tags will be imported and the newly created tag library will be displayed. All of the imported tags will display in the left window, At this point you can name the library or view or edit any of the tags by highlighting them and editing their properties. When finished, select **OK**.

---

**Create or add tags**

You do not need to import tags to have them available for you projects, you can create them whenever you need.

- **Open** the tag library property editor of the library which you want to add a tag to or create a new tag library.

- Select **tags tab**, **double-click** on the gray bar to add a line, Insert the tag name in the Name column, insert the definition of the tag in the Definition (address reference) column, and select the data type from the drop down list in the Data Type column. Repeat this process to keep adding tags.

Learn more about editing rows

**Deleting tags**

- **Open** the tag library property editor of the library which you want to delete a tag.

- Select **tags tab**, **right-click** on any field (name, definition, or data type) of the row you want to delete. Select **Delete Row(s)** to delete the tag.
Learn more about editing rows

Copy tags from one library to another

The tags that are displayed in the components data pane are from the tag library named Common Tags. Four of the tags are highlighted and have been dragged over the New Tags library, When the tags are dropped a copy of the highlighted tags will be placed in the New Tags library

- **Select the library** containing the source tags so the tags are displayed in the components data pane.
- **Highlight** the tags you want to copy (see selecting multiple components), with the cursor over one of the highlighted tags, **left-click and hold** the mouse, **move** the cursor over the destination tag library in the project components pane, **release** the button, the tags will be added.

![Project - ePro Canvas](image)

**Note:** Changing a tag library name will automatically change the name of the tag library everywhere it is used in the project. This makes it easy to update all your units that might be using the tag library. Any units where you do not want this change to happen will need to be edited manually.

**Media Library**

**Media Libraries**

To add, delete, or rename a media library visit Project Components.

Media libraries are where text, images, and sounds are stored so they can be used in many places of a project without retyping them in places they are to be used. Media libraries are not required to successfully create a unit. But if you find yourself typing the same text more than once, you'll want to use a media library. By storing media in these libraries you will be able to reference any of the media you place here by a tag that you create to represent a specific media entry. Any control can simply reference the tag to insert the desired media saving you from entering the same media in multiple places. If you
edit any of the media entries, the change will be accepted wherever the tag has been used simplifying any editing process. Only one media library can be linked to a unit.

To reference a media library entry by ID, visit Referencing Media Library by ID Number.

Adding media entries

Once a library has been created, media entries can be added in two ways.

- **Right-click** on the library where the new entry will be added, select **New**, click on the type of medium to add.
- **Open** the library property editor for the library where the new entry will be added, **select** the tab of the medium type to add, add rows if required to make room for the medium. Follow the instructions below for adding the various media types.

Media library properties

The Media Library properties are displayed below.

General tab

- **Name** property - Provide a unique name for your library.
- **Description** property - Add a meaningful note about the library.
- **Active Language** property - Select which language will be displayed when editing entries in the Text, Image, or Sounds tabs. If you are not using multi-language in your projects use neutral. For more detail see the multi-language help topic.
- **Add or Remove Language** - Click to add or remove a language. This selection tops the following window.

  ![AddRemove Language Window]

  - **Auto Add Language Enabled** - Add media library entries for languages as determined by the Auto Language Tab settings.
  
  **Note:** When Auto Add Language Enable is set to Yes, all existing Media Library entries will be scanned and entries will be added as needed for the appropriate languages. In addition, all new entries will have corresponding entries added.

  - **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

Text tab

- **Entry** Column - This column is for reference only can not be edited.
- **Name** column property - This is where you assign a tag name to the text string. The tag name is then inserted into any control field that accepts media. The text string will be displayed when the control is running. Using a tag will allow you to make changes to the text string in a single place without having to edit every control that would reference the text string.

- **Language** column property - By default this column will display the language that was selected on the general tab. Set the language to the desired language if it has not been done already. If not using multi-language then neutral should be used. Text for the selected language can be entered into the text column. After you have entered the text for the desired language you can change to a different language and add new text for the new language setting.

- **Text** column property - This is where you enter the text string that will be displayed in the desired controls. All text must start with " (double tick) and end with ". Surrounding the text by these marks informs the runtime system that the information should be handled as ASCII characters. Text strings can be as long as you desire. Make sure the any controls that use the text must be able to accommodate the length and font size of the text. If the control can't accommodate the amount of text, during runtime the control will display ![text](image) where you expect the text to be displayed.

**Image tab**

- **Entry** Column - This column is for reference only can not be edited.

- **Name** column property - This is where you assign a tag name to an image file. The tag name is then inserted into any control field that accepts media. The image will be displayed when the control is running. Using a tag will allow you to change the image file in a single place without having to edit every control that would reference the image.

- **Language** column property - By default this column will display the language that was selected on the general tab. Set the language to the desired language if it has not been done already. If not using multi-language then neutral should be used. An image file for the selected language can be entered into the image column. After you have entered the image file for the desired language you can change to a different language and add new image file for the new language setting.

- **Path** column property - Type in the path and file name of the image to be displayed for the selected language. Or press the ![select](select) to select the file by standard operating system navigation.

**Sound media**

- **Entry** Column - This column is for reference only can not be edited.

- **Name** column property - This is where you assign a tag name to a sound file. The tag name is then inserted into any control field that accepts media. The sound will be play when the control is running. Using a tag will allow you to change the sound file in a single place without having to edit every control that would reference the sound.

- **Language** column property - By default this column will display the language that was selected on the general tab. Set the language to the desired language if it has not been done already. If not using multi-language then neutral should be used. A sound file for the selected language can be entered into the sound column. After you have entered the sound file for the desired language you can change to a different language and add new sound file for the new language setting.

- **Path** column property - Type in the path and file name of the sound to be played for the selected language. Or press the ![select](select) to select the file by standard operating system navigation.

**Auto Language**

When a Media Library entry is created, a placeholder can be made for any number of languages. These settings are pre-determined in the Media Library properties Auto Language tab. As shown below, each type of media library entry (Text, Image, Sound) can be set to automatically create an entry in any language. As in the example below, when a text entry is created, there will be an additional entry created for French and German, however, there will not be image or sound entries created for those languages.
Note: When the appropriate language are selected as above, the **Auto Add Language Enable** must be set to Yes to enable the entries to be created.

Media Entry Properties...

General tab

When any media entry below the library name is highlighted in the left side box the following properties are displayed.

- **Name** property - Will display the name of the media entry selected. You can modify the name by providing a unique name for the media entry.
- **Active Language** property - Indicates the active language which was selected from the general tab when the media library name is highlighted. This field can be modified when the media library name is highlighted in the left side box.
- **Active Language Entry** property - Displays the current media entry assigned to the selected active language.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

Language List tab (if the media is text)

- **Entry** Column - This column is for reference only can not be edited.
- **Language** column property - This column will display the different languages that have been used in the current media library. The current active language may not be displayed if there have not been any entries for the active language.
- **Text** column property - This column will display all text entries for each of the languages used in the library.

Language List tab (if the media is an image)

- **Entry** Column - This column is for reference only can not be edited.
- **Language** column property - This column will display the different languages that have been used in the current media library. The current active language may not be displayed if there have not been any entries for the active language.
Getting Started

- **Image Path** column property - This column will display all image files for each of the languages used in the library.

Language List media (if the media is a sound)

- **Entry** Column - This column is for reference only and cannot be edited.
- **Language** column property - This column will display the different languages that have been used in the current media library. The current active language may not be displayed if there have not been any entries for the active language.
- **Sound Path** column property - This column will display all sound files for each of the languages used in the library.

Using neutral language

If you are not or do not plan to use multi-language then you should default to entering all your media (text, images, and sound) on the neutral language setting. If you develop your non multi-language projects using the neutral language, then your media will not change even if the language selection is changed.

If you plan on creating multi-language projects you can use the neutral language setting to act as a constant for media. If you have a media that is the same in more than one language you can enter the media into the neutral language and leave blank the media columns for the languages that are the same. For any media tag name there is an order in how the media will be displayed. During runtime, if there is media entered for the current language, then that media will be displayed. If media does not exist, then, if there is media entered into the neutral language for the same tag name, then that media will be displayed. If media for neutral language does not exist then nothing will be displayed.

Creating a Multi-Language Project

**Media Library Import and Export**

**Media Library Export**

A Media Library can be Exported to an XML file by right-clicking on the Media Library to call the menu as shown below. Select "Export Media Library..." and enter a name on the ensuing file dialog box then select Save. An XML file will be saved with the contents of the selected Media Library in the format shown below in the Media Library XML File section.
Media Library Import

A Media Library is Imported from an existing XML file by right-clicking on the Media Library to call the menu, and selecting "Import Media Library...". Select a name on the ensuing file dialog box, then select Open and the contents of the XML file will be saved into the selected Media Library.

Additionally, the Media Library import function is available from the File/Import menu.

When the XML file is imported, each row (entry) is handled as follows:

- all entries in the media library will remain
- if the name is identical in the XML file and media library but the language values have changed in the XML file, the media library entry will be updated
- if the XML name does not exist in the media library, the entry will be added to the media library

Media Library XML File

The XML file is configured as follows. Row 1 contains the items in which the entries will be imported. This row is reserved for titles and must appear as shown below with the exception of the languages. There will be one language title for each desired language.

**Note:** each Language must be spelled exactly as it appears in the Language List of the Media Library editor.

Column 1 contains the name (Name property) given to each entry.
Cautions:

When editing an XML file to be imported, be careful not to add items to the XML file in Excel that do not agree with the XML format of the Media Lib. **Below are examples which must be avoided:**

1) A carriage return within a cell will be interpreted as an end of a library entry.
2) Data outside of the number of columns set aside for the media library, i.e., data placed in a cell which does not have a column heading.

**WARNING 1** - simply clicking on a cell will create a value for that cell.

**WARNING 2** - deleting an unwanted row (Media Library Entry) by selecting "Cells" then pressing delete maintains values for those cells. An unwanted row must be removed by deleting the entire "Row" (i.e., not one cell at a time). For example, if a media library XML file has 20 entries (rows) and a user decides to remove the last 10 leaving only 10 in the file, the user must delete the rows that contain the data. Simply selecting the rows and deleting their contents using the delete key will result in the problem described above.

**WARNING 3** - If invalid characters or cells are part of the XML file, the import will appear successful, but property values in the media library will be incorrect.

Creating a Multi-Language Project

Switching between different languages is performed by placing a numeric value in a storage location specified by you, or by using an expression that you create. The unit will switch to a different language if the value in the specified location or the expression matches one of the language values listed in the language table below.

**Language table**

<table>
<thead>
<tr>
<th>LANGUAGE</th>
<th>LANGUAGE VALUE (Decimal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFRIKAANS</td>
<td>54</td>
</tr>
<tr>
<td>ALBANIAN</td>
<td>28</td>
</tr>
<tr>
<td>ARABIC</td>
<td>01</td>
</tr>
<tr>
<td>Language</td>
<td>Code</td>
</tr>
<tr>
<td>------------</td>
<td>------</td>
</tr>
<tr>
<td>ARMENIAN</td>
<td>43</td>
</tr>
<tr>
<td>ASSAMESE</td>
<td>77</td>
</tr>
<tr>
<td>AZERI</td>
<td>44</td>
</tr>
<tr>
<td>BASQUE</td>
<td>45</td>
</tr>
<tr>
<td>BELARUSIAN</td>
<td>35</td>
</tr>
<tr>
<td>BENGALI</td>
<td>69</td>
</tr>
<tr>
<td>BULGARIAN</td>
<td>02</td>
</tr>
<tr>
<td>CATALAN</td>
<td>03</td>
</tr>
<tr>
<td>CHINESE</td>
<td>04</td>
</tr>
<tr>
<td>CROATIAN</td>
<td>26</td>
</tr>
<tr>
<td>CZECH</td>
<td>05</td>
</tr>
<tr>
<td>DANISH</td>
<td>06</td>
</tr>
<tr>
<td>DIVEHI</td>
<td>101</td>
</tr>
<tr>
<td>DUTCH</td>
<td>19</td>
</tr>
<tr>
<td>ENGLISH</td>
<td>09</td>
</tr>
<tr>
<td>ESTONIAN</td>
<td>37</td>
</tr>
<tr>
<td>FAEROESE</td>
<td>56</td>
</tr>
<tr>
<td>Farsi</td>
<td>41</td>
</tr>
<tr>
<td>FINNISH</td>
<td>11</td>
</tr>
<tr>
<td>FRENCH</td>
<td>12</td>
</tr>
<tr>
<td>GALICIAN</td>
<td>86</td>
</tr>
<tr>
<td>GEORGIAN</td>
<td>55</td>
</tr>
<tr>
<td>GERMAN</td>
<td>07</td>
</tr>
<tr>
<td>GREEK</td>
<td>08</td>
</tr>
<tr>
<td>GUJARATI</td>
<td>71</td>
</tr>
<tr>
<td>HEBREW</td>
<td>13</td>
</tr>
<tr>
<td>HINDI</td>
<td>57</td>
</tr>
<tr>
<td>HUNGARIAN</td>
<td>14</td>
</tr>
<tr>
<td>ICELANDIC</td>
<td>15</td>
</tr>
<tr>
<td>INDONESIAN</td>
<td>33</td>
</tr>
<tr>
<td>ITALIAN</td>
<td>16</td>
</tr>
<tr>
<td>JAPANESE</td>
<td>17</td>
</tr>
<tr>
<td>KANNADA</td>
<td>75</td>
</tr>
<tr>
<td>KASHMIRI</td>
<td>96</td>
</tr>
<tr>
<td>KAZAK</td>
<td>63</td>
</tr>
<tr>
<td>KONKANI</td>
<td>87</td>
</tr>
<tr>
<td>KOREAN</td>
<td>18</td>
</tr>
<tr>
<td>Language</td>
<td>Code</td>
</tr>
<tr>
<td>-----------</td>
<td>------</td>
</tr>
<tr>
<td>KYRGYZ</td>
<td>64</td>
</tr>
<tr>
<td>LATVIAN</td>
<td>38</td>
</tr>
<tr>
<td>LITHUANIAN</td>
<td>39</td>
</tr>
<tr>
<td>MACEDONIAN</td>
<td>47</td>
</tr>
<tr>
<td>MALAY</td>
<td>62</td>
</tr>
<tr>
<td>MALAYALAM</td>
<td>76</td>
</tr>
<tr>
<td>MANIPURI</td>
<td>88</td>
</tr>
<tr>
<td>MARATHI</td>
<td>78</td>
</tr>
<tr>
<td>MONGOLIAN</td>
<td>80</td>
</tr>
<tr>
<td>NEPALI</td>
<td>97</td>
</tr>
<tr>
<td>NEUTRAL</td>
<td>00</td>
</tr>
<tr>
<td>NORWEGIAN</td>
<td>20</td>
</tr>
<tr>
<td>ORIYA</td>
<td>72</td>
</tr>
<tr>
<td>POLISH</td>
<td>21</td>
</tr>
<tr>
<td>PORTUGUESE</td>
<td>22</td>
</tr>
<tr>
<td>PUNJABI</td>
<td>70</td>
</tr>
<tr>
<td>ROMANIAN</td>
<td>24</td>
</tr>
<tr>
<td>RUSSIAN</td>
<td>25</td>
</tr>
<tr>
<td>SANSKRIT</td>
<td>79</td>
</tr>
<tr>
<td>SERBIAN</td>
<td>26</td>
</tr>
<tr>
<td>SINDHI</td>
<td>89</td>
</tr>
<tr>
<td>SLOVAK</td>
<td>27</td>
</tr>
<tr>
<td>SLOVENIAN</td>
<td>36</td>
</tr>
<tr>
<td>SPANISH</td>
<td>10</td>
</tr>
<tr>
<td>SWAHILI</td>
<td>65</td>
</tr>
<tr>
<td>SWEDISH</td>
<td>29</td>
</tr>
<tr>
<td>SYRIAC</td>
<td>90</td>
</tr>
<tr>
<td>TAMIL</td>
<td>73</td>
</tr>
<tr>
<td>TATAR</td>
<td>68</td>
</tr>
<tr>
<td>TELUGU</td>
<td>74</td>
</tr>
<tr>
<td>THAI</td>
<td>30</td>
</tr>
<tr>
<td>TURKISH</td>
<td>31</td>
</tr>
<tr>
<td>UKRAINIAN</td>
<td>34</td>
</tr>
<tr>
<td>URDU</td>
<td>32</td>
</tr>
<tr>
<td>UZBEK</td>
<td>67</td>
</tr>
<tr>
<td>VIETNAMESE</td>
<td>42</td>
</tr>
</tbody>
</table>

Multi-Language Example
The following steps describe the multi-language set up. These steps are only one example of how this can be accomplished.

**Set up media library**
Set up the library for each of the different language that will be used.

**Create a tag to store the language value**
The storage location of your choice, any device that has registers, *i.e.* PLC, Drive, etc.

**Set up the Active Language Expression**
The active language expression is found on the general tab of the configuration. This field must be filled in if you intend on using Multi-language. Place the tag (from above) in this field. Use the drop down button to select the tag.

**You're done**
The only thing left to do is determine how you will change the languages. You can change them manually by pressing buttons on the runtime screen. Or you can have the destination device change language using criteria set up on that device. Below are examples of notes about each method.

**Changing Language manually**
- Create an action assignment for each language. The assignment should place the language value in the tag, *i.e.* 'Tag' = 9 (9 is English language). Use the numeric value that corresponds to the language you want to change to.
- Place a button for each language on a screen. Label each button accordingly for the languages. Insert the appropriate action into one of the action filed of the button.

**Let the destination device change language**
- Using the logic of the destination device, place into the tag the numeric value that corresponds to the language you want to change to.

**Referencing Media Library by ID Number**
The Id Number of a media library entry can be used to reference that entry in a text field in the ePro Canvas editor. For example if the Id Number of a media library text entry was set to 47 as shown below:

![Image of Project - Media Library Entry - Media Library Entry 1]

- **Name**: Media Library Entry 1
- **Id Number**: 47
- **Active Language**: Neutral
- **Active Language Entry**: Uncategorized

---

56
And a text control was placed on a page with the id number expression attribute set to:

`clientname,tagname`

Where clientname represents the name of the OPC client adapter (PLC) and tagname is a tag or address in that client. When the value of tagname is equal to 47 then the contents of that media library entry will be displayed online. The text property box would look like the following:

![Text Property Box](image)

**Color Libraries**

Color libraries allow colors to be created and stored so they can be used in many places of a project without re-configuring them each place they are to be used.

*Note: Color libraries are not required to successfully create a unit or configuration. However, if you find yourself using a special color more than once, you'll want to use a color library.*

By adding color entries to the library (with a tag name), you can reference that color anywhere a color reference is used. Any control can simply reference the color's tag to insert the color - saving you from remembering the exact color in multiple places. If you edit any of the color entries, the change will be made everywhere the tag is used, simplifying the editing process.

*For example: If you are using a warning color on multiple pages or in multiple controls... Define a color with tag name Warning in the color library, then configure the color property of the desired controls with 'Warning'. If the warning property needs to be changed from yellow to orange or flashing yellow/orange, it can be changed in all locations by simply changing the color in the color library.*

**Adding color entries**

To add, delete, or rename a color library visit Project Components.

Once a library has been created, color entries can be added by **Right-clicking** on the library, then select **New Color Library Entry**.

**Color library entry properties**

Color properties are displayed and defined as follows.

**General tab**
• Name - Tag name to be used in component’s color properties
• Blink - No = color is solid; Yes = color will blink as defined on Blink States tab
• Static Color - Assigned color when No blink is assigned
• Blink Rate - How fast each color on the Blink States list appears
  • Slow - 2 seconds each, ie: 4 blink states has an 8 second cycle
  • Medium - 1 second each, ie: 4 blink states has a 4 second cycle
  • Fast - 1/2 second each, ie: 4 blink states has a 2 second cycle
• Category - How the colors are arranged

Blink States tab

• State - number assigned to the color, not used elsewhere
• Blink Color - Up to 16 colors can be defined, each takes up a time slice of the overall color. In the window above, the color library entry, Warning, is a single color which blinks yellow, orange, red, orange as indicated by the colors above (state 1, 2, 3, 4). If the Blink Rate was set at Slow, each state would appear for 2 seconds, and the overall color (Warning) would repeat it's cycle every 8 seconds.

Action Libraries

Action Library

To add, delete, or rename a action library visit Project Components.

Actions allow you to expand the abilities of your unit by incorporating special features called actions. Actions will perform functions like:

• Change pages
• Send data to another destination
• Exit the unit’s runtime
• Log events/alarms
• View events/alarm log
Getting Started

- View, acknowledge events and alarms
- Adding system security
- Start application programs
- View documents: pdf files, html pages, web pages, etc.
- Add multiple actions together to simplify tasks

To define and add action library entries to an action library, create an action library, right-click the action library and select New, select the desired action.

Actions can be executed two ways:

- **Unconditional** (Visual actions)
  Unconditional actions will execute when ever they are called. They can be called by placing them in make or break action fields (General tab) a buttons or touch areas. Actions can also be called by all other controls, but they would need to have their Operator Input Type (General tab of the control) set to Button. actions can then be inserted into the buttons of the buttons tabs.

- **Conditional** (Non-visual actions)
  Conditional actions use expressions to govern when they execute. The action will execute when the expression equates to a true condition. Conditional actions do not need to be placed in controls since they know when they will execute. Instead these actions are placed in the actions tab of the configuration property editor. These actions are continually monitored by the runtime and execute the action when it's expression equates to true. Unconditional actions should not be used here since they will execute indefinitely.

**Note: the table below explains when actions are started, based on the property settings**

<table>
<thead>
<tr>
<th>Trigger Type</th>
<th>Trigger Expression</th>
<th>Action in Configuration Properties/Actions tab (Activated by Trigger Expression)</th>
<th>Action NOT in Configuration Properties/Actions tab (Activated when Action executed, ie: by button)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditional</td>
<td>1</td>
<td>Action is executed ONCE at Runtime initialization</td>
<td>Action NOT started - to start the Action at Runtime, add it to the Configuration Properties/Actions tab</td>
</tr>
<tr>
<td>Conditional</td>
<td>'tag'</td>
<td>Action is executed ONCE when 'tag' is TRUE, 'tag' must be set to FALSE then TRUE to execute again</td>
<td>Action NOT started - to start the Action with a 'tag', add it to the Configuration Properties/Actions tab</td>
</tr>
<tr>
<td>Unconditional</td>
<td>N/A</td>
<td>Action NOT started - to start the Action at Runtime, use Conditional and Expression of 1, to start by button do not add it to Configuration Properties/Actions tab</td>
<td>Action executed when button executes action</td>
</tr>
</tbody>
</table>

**Action library property editor**

**General tab**

- Name property - Provide a unique name for your library.
- Description property - Add a meaningful note about the library.
System Actions

Several Actions are automatically provided to handle tasks such as changing pages. The following System Actions can be accessed by assigning them to buttons.

".ActionEventBanner:" - call the Alarm and Event window.
".ActionExit:" - Exit Runtime and return to windows operating system.
".ActionGetPage:" - Call a different page by name or using a menu with listed pages. Destination Page = ":ViewPageNames:".
".ActionHomePage:" - Go to Home page. Destination Page = ":HomePage:".
".ActionPageDown:" - Go down to next page in the list. The list is the same order as the menu shown in ActionGetPage. Destination Page = ":PageDown:".
".ActionPageUp:" - Go up to next page in the list. The list is the same order as the menu shown in ActionGetPage. Destination Page = ":PageUp:".
".ActionPreviousPage:" - Return to the last page that was called. Destination Page = ":LastPage:".

Action List

An action list is where you can combine multiple actions into a single action. i.e. You want to execute an assignment action to set a new recipe and at the same time you want to write an event to the event log to signal when the recipe was started. You can list as many actions in the action list as you would like but you should not use a page change actions in the same action list.

Action list properties

General tab

- **Name** property - Provide a unique name for your action list.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute the list of actions.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

List of actions tab

- **Action** Column - This column is for reference only can not be edited.
- **Action library entry name** property - Add in the actions you want in the list by selecting the action using the drop down list button.

Note: Parameters can be passed to an Action List similarly to Passing Parameters in a single action. Note that all parameters in each action in the list must be supplied in the order indicated in each individual action. For example, if the first action was an assignment action, that passed 2 parameters, #1,#2 and the second action was a goto page action, passing a single parameter - it would have to be labelled #3.

Assignment Action
Assignment actions are general purpose ways to write values to a location. They can be used to send setpoint or recipe values to a destination device. Transfer data from one destination device to another destination device.

**Assignment action properties**

**General tab**

- **Name** property - Provide a unique name for your assignment action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Condition Type** property - Only available if the trigger type is set to conditional. Select either:
  - **Pass Thru** - If you want to send data from one destination device to another. This selection does not require an expression since the runtime will continually send the data.
  - **Expression** - Use expression when you only want the action to execute when the expression is true.
- **Trigger Expression** property - Only available if condition type is set to expression. Place your expression here. When the expression equates to true the action will execute.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**Assignments tab**

- **Assignment** column - This column is for reference only can not be edited.
- **Expression** property - Add as many assignments as you want. Add more rows as needed.

**Close Action**

A close action will stop and exit the runtime. Displaying the desktop of the unit. Once at the desktop you calibrate the touchscreen, modify display setting, or anything else. To return to runtime reset the unit.

**Close action properties**

**General tab**

- **Name** property - Provide a unique name for your close action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**Data Archive Action**

The Data Archive Action allows configuration of a list of entries which can be archived when the action is executed.
Data Archive Properties

General tab

- **Name** property - Provide a unique name for your action.
- **Trigger Type** property - Select Conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.

Note: the table below explains when archiving is started, based on the property settings.

<table>
<thead>
<tr>
<th>Trigger Type</th>
<th>Trigger Expression</th>
<th>Action in Configuration Properties/Actions tab (Activated by Trigger Expression)</th>
<th>Action NOT in Configuration Properties/Actions tab (Activated when Action executed, ie: by button)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditional</td>
<td>1</td>
<td>Archiving starts with Runtime</td>
<td>Archive NOT started - to start the Archive at Runtime, add it to the Configuration Properties/Actions tab</td>
</tr>
<tr>
<td>Conditional</td>
<td>'tag'</td>
<td>Archiving starts when 'tag' is TRUE, stops when 'tag' is FALSE</td>
<td>Archive NOT started - to start the Archive with a 'tag', add it to the Configuration Properties/Actions tab</td>
</tr>
<tr>
<td>Unconditional</td>
<td>N/A</td>
<td>Archive NOT started - to start the Archive at Runtime, use Conditional and Expression of 1, to start by button do not add it to Configuration Properties/Actions tab</td>
<td>Archiving starts when button executes action</td>
</tr>
</tbody>
</table>

- **Archive** - Name of Archive Library Entry which defines time rates of the archive.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

Data tab

- **Item** column - This column is for reference only can not be edited.
- **Name** column - Strings to be associated with the expression in the archive file.
- **Expression** column - Expression to be evaluated and saved in the archive file.

See [Data Archive Notes](#) for more information.

Email Action

General tab

- **Name** property - Provide a unique name for your action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.
- **From** - Email address of sender.
To - Email address of receiver.

Subject - Subject to appear on email.

Message - Message, body of email. Note: CTRL-Enter allows multiple lines.

Category property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

---

**Goto Page Action**

Goto page actions allow you to change from one page to another.

See [Changing Pages Online](#) for additional Page change information.

**Goto page properties**

**General tab**

- **Name** property - Provide a unique name for your goto page action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.
- **Destination Page** property - Use the drop down list button to select the page to switch to.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**Built in page actions**

Use the drop down list button (Destination Page field) and select system pages to select one of the follow built in page actions.
- **Home page** - This action will switch to the home page specified in the configuration general tab.

- **Last page viewed** - This action will change to the last page that was viewed. i.e. If you just changed pages from page 2 to page 4, selecting this action will change to page 2, selecting this action again will change to page 4.

- **Previous page** - This action follows the page column of the pages tab of a configuration by cycling to the a lower row number. Using the example below, if your current page viewed is page 2, selecting this action will change to page 1, selecting the action again will change to page 5, repeating the process will continue to cycle through, page 4, page 3, etc.

- **Next page** - This action follows the page column of the pages tab of a configuration by cycling to the a higher row number. Using the example below, if your current page viewed is page 4, selecting this action will change to page 5, selecting the action again will change to page 1, repeating the process will continue to cycle through, page 2, page 3, etc.

- **Page Directory** - This action will display a list of pages for your configuration, see the figure below. From the figure, there are 5 pages in the configuration and you are current on page 1 (noted by the check mark). Touch which page you want to change to, completing the action.

![Project - Configuration - Configuration 1](image)

**Log Event Action**

Alarms are also events.

See events & alarms - big picture

An event is anything you want to record, a button depressed, a page changed, a start command, a stop command, etc. Many of these events only need to be recorded for viewing later. Some events however
need more immediate attention and may need to be acknowledged to assure that the event has been satisfied. Events and alarms are all set up the same way, so we will just call them all events. The only difference between them is if you decide that you want to acknowledge an event. To acknowledge an event, open the event viewer either manually or based on the trigger that created the event. You can then find the event, usually it will be the top event viewed unless another event has been recorded. When you locate the event, touch the record to acknowledge the event, close the event viewer and your done.

There are several ways to log events.

- **Unconditional** - Use this method if you want to add an event to page change action to monitor how many times pages are changed. If creating user IDs, record which is ID is logged in or when it is logged out. Do these by creating an unconditional action and place it in any control that calls actions.

- **Conditional**
  - **Bits** - Create an unconditional action to monitor a register of any length 1, 8, 16, 32, etc. Conditional actions should be placed in the actions tab of the configuration properties editor. This way the bits will be monitored constantly during runtime and add entries to the event log as needed.
  - **Expression** - Instead of using bits you can create any number of expressions to create a entry into the event log. Conditional actions should be placed in the actions tab of the configuration properties editor. This way the expression will be monitored constantly during runtime and add entries to the event log as needed.

There are two event logs.

- **Non-O/S event log** - Non-operating system event log. This log is always written to regardless of the hardware platform you choose as your unit. All log event actions will write to this log. This log will not save any events upon leaving the runtime.

- **O/S system event log** - Optionally you can save the events in the operating systems event log. This can only be done on Windows 2000 or Windows XP systems which have event logs. Windows CE systems do not have events logs. If you choose to save events in the O/S system they will still be saved in the non-O/S event log making a second copy. The big difference is if you exit the runtime any events that you saved to the O/S system log will be saved.

Log event action properties

**General tab**

- **Name** property - Provide a unique name for your log event action.

- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.

- **Condition Type** property - Only available if the trigger type is set to conditional. Select either:
  - **Bit** - If you want to log events based on bits. Enter the bit source in the bit source field and enter the description of each bit in the events tabs. When the bit is true (1) an entry will be placed in the event log. A second entry will be entered when the bit is cleared (0).
  - **Expression** - If you want to log events based on expressions. Switch to the events tab and you can start entering different expressions for each entry into the event log. When any of the expressions equate to true an entry will be written to the event log. When the expression returns to false a second entry will be written to show the event as cleared.

- **Bit Source** property - Only available if condition type is set to bit. This is where you place the address of the source of the bit information. Use the drop down list button to select the tag.

- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**Events tab**
- **Event** Column - This column is for reference only can not be edited.
- **Bit or Expression** property - Enter either the bit or the expression that will be monitored to write the events.
- **Type property** - Select one of the six types to help categorize your events. What you select for type will be written to the event log when the bit or expression is true.
- **Level** property - Select one of the five level to help categorize your events. Levels could be considered a sub-type providing you with 30 different ways to categorize your events. What you select for level will be written to the event log when the bit or expression is true.
- **Description** property - This is text you can enter to describe the event. If you have a lot of events that your recording you will want to use this field to help keep track of multiple events.

**Recipe Management Action**

The Recipe Management Action allows configuration of a recipe settings which are activated when the action is executed.

*Note: This action is only needed if it is desired to have customized recipe functions (for instance, a stand alone Load button). The functions necessary to operate and control a recipe are built into the Recipe control.*

---

**Recipe Action Properties**

**General tab**

- **Name** property - Provide a unique name for your action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.
- **Function** - The task that this action will perform
  - **Load** - Send recipe values of the highlighted Recipe Name to PLC.
  - **Compare** - Compare values of the highlighted Recipe Name to those currently in the PLC.

  **Note:** the Compare function takes longer than a Load function, and is more noticeable for larger recipes (i.e., a recipe with 1000 ingredients takes approximately 5 min to compare). The busy LED gives indication as the compare is taking place. Additionally, the Active Indication tag as defined below can be used to provide this busy feedback to the operator.

  - **Save** - Get the current PLC values for the last loaded recipe and save them to the same recipe that was last loaded.

  **Note:** the Save function is only available during Runtime if the last loaded recipe is highlighted.

- **File Name** - Name of the XML file which contains the recipe data. Note: when the XML file is opened in Excel (from Office XP, 2003 or newer) recipe names are synonymous with sheet names.

- **Recipe Name** - The name of the recipe (i.e., sheet) to Load/Save/Compare.

- **Active Indication** - (not required) Tag which is set to 1 when Load/Save/Compare operation is being carried out, set to 0 when complete. This can be used to provide indication to operators that the system is busy.

- **Ingredient Mismatch** - Tag for Compare function which is set to 0 if comparison (of PLC values and Recipe Name) is identical, or otherwise is set to the number of recipe items which have different values.

- **Log Event** -
  - **Yes** - Write a message to the Alarm/Event log to indicate the recipe action has occurred.
  - **No** - Do not write to the Alarm/Event log.

- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

See Recipe Development Notes for more information.

### Security Action

Security Action Properties
General tab

- **Name** property - Provide a unique name for your action.
- **Function** -
  - **Logon** - enable security clearance.
  - **Logoff** - disable security clearance.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

Sound Action

Sound Action Properties
General tab

- **Name** property - Provide a unique name for your action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.
- **Sound** - The name of the .wav file to play
- **Id Number Expression** - Id of the Sound in the Media Library.
- **Play** -
  - **Once** - Play the .wav file once.
  - **Continuous** - Play the .wav file over and over.
- **Stop Expression** - For continuous only - Expression which when evaluated to TRUE will stop the sound.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

View Action

A view action will display either the event viewer or an HTML file. ePro ES units will only display event viewer. In addition to reviewing the material below also see the event banner tab of the configuration and the event banner tab of the unit to configure what fields of the event viewer will be displayed.

See events & alarms - big picture

- **Event viewer** - The event viewer is a window that will appear on the page when it is initiated. The event viewer is where you can display any events that have been written to the event log or acknowledge events that have happened. The event viewer will display on any page you desire.
  - **Unconditional** - It can be initiated manually by placing the action in a button. Manually will allow you to control when you want the event viewer to appear.
- **Conditional** - The event viewer can be displayed based on an expression. Creating a conditional view action and placing the action in the actions tab of the configuration property editor will allow the runtime to monitor the action continually. If the expression is true the event viewer will display regardless of the page you are currently on. This method would be a good way to present an event to someone that you would like acknowledged. When the event viewer appears have the person touch event requiring acknowledgement, then the event viewer can be closed by pressing the close button at the bottom of the event viewer window, or by pressing the X button at the top right of the window.

- **HTML files** - Not available at this time.

View action properties

General tab

- **Name** property - Provide a unique name for your view event action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute and display the event viewer window.
- **View State** property - you can provide a visibility expression to also provide more flexibility when the event viewer can display. Say you are using user IDs and you only want certain ID types to be able to have access to the event viewer. This is where you would set up the expression for this kind of visibility. Property settings are:
  - Close - Get rid of window.
  - Open - Bring up the window.
  - Open Full Screen - Window will consume the whole screen.
  - Roll Up - Shrink the window.
  - Roll Down - Un-shrink the window.
- **Viewer type** property - Property settings are:
  - Event/Alarm Viewer - Select to show event viewer
  - Document Viewer - Select to show HTML file given in File property below.
- **File** property - Name of file to show. Only available when Viewer Type is set to Document Viewer.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

To control displayed documents and allowable files and web pages, see Configurations or Document Viewer and Document Viewer Content.

**Start Application Action**

A Start Application action allows running an executable file during Runtime.

Start Application Action properties

General tab

- **Name** property - Provide a unique name for your action.
- **Trigger Type** property - Select Conditional or Unconditional depending on the type of action you need.
Getting Started

- Conditional - will execute when Action is called and Trigger Expression assigned below is true.
- Unconditional - will execute when Action is called.

- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute the list of actions.
- **Start Application** – Name/Path of file to be executed
- **Auto Close**
  - Yes - Close when ePro closes.
  - No - Stay open when ePro closes.
- **Minimize Application Expression** - when true, minimizes window.
- **Maximize Application Expression** - when true, maximizes window.
- **Restore Application Expression** - when true, restores window size.
- **Top Application Expression** - when true, brings window to the top.
- **Bottom Application Expression** - when true, brings window to the bottom.
- **Close Application Expression** - when true, closes application.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

Parameter Passing

Parameters can be passed to Actions. This minimizes the number of Actions that are necessary by allowing re-use for similar instances. Two examples of this are shown below.

Page Change Example (Goto Page Action)

A good example of parameter passing is an Action file that is set up to call a page by passing a parameter (ie: the Page Name) from a Button on the page. Without parameter passing, an Action would need to be created for each page that will be called.

The following is an outline of how to create a re-usable GoToPage Action:

- Create 2 Pages, PageX and PageY.
- Create a **Goto Page Action** called GoToPage and set its **Destination Page** to #1. The #1 is a placeholder for the first parameter passed with this Action. The passed value (PageX or PageY) will replace the #1.
- Create a **Rectangular Button** on PageX and assign its Break Action ‘GoToPage(PageY)’. By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the GoToPage action.
- Create a **Rectangular Button** on PageY and assign its Break Action ‘GoToPage(PageX)’

The button on PageX will call PageY and vice-versa, with a single Action entry.

**Notes:**

- Page changes should be a result of the **Break Action** since that would be the last operation to be performed on the calling page. If the Make Action was used, then a new page would be called, and the Break Action from the calling page would be lost.
- #1 is used in the Action entry file as a placeholder for the first passed parameter.
- By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the GoToPage action.

Bit Write Example (Assignment Action)
Below is an example of a single Assignment Action entry used to turn a bit ON then OFF. This example allows sharing the BitChange Action for both writes.

- Create an Assignment Action called BitChange and set the first Assignment Expression to 'Bit'=#1. (Again, the #1 is where the first passed parameter will be placed.)
- Create a Page.
- Create a Rectangular Button on the Page and put 'BitChange(1)' in the Make Action field and put 'BitChange(0)' in the Break Action field. Again, the value in parentheses and within the single quotes is the parameter to be passed to the BitChange actions.

When this button is pressed, the command becomes 'Bit'=1. Similarly, when the button is released, the command becomes 'Bit'=0. This example is a momentary pushbutton.

Notes:

- This type of control should be used with caution. The response time (between the make/break and the corresponding bit writes) may not be accurate enough for time critical applications.
- #1 is used in the Action entry file as a placeholder for the first passed parameter.
- By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the BitChange action.

Indexed Lists

Indexed Lists allows you to substitute properties of a configuration component dynamically based on the value of an index expression. This means that a page control or action can change its indication or control function online. The purpose of index lists is to reduce the number of pages needed in a configuration by allowing a single page to represent multiple unit operations or multiple diagnostic screens without changing pages by simply changing a single value that provides an index into one or more tags or expressions in a series of Indexed Lists. Simply put, indexed lists allow page components to reference lists of addresses or tags based on the value of an Index. For example a readout value can show different PLC addresses based on a PLC register that acts as an index into a list of those PLC addresses, and an indicator template may show states of a series of devices based on that same register value. Non-dynamic properties such as template titles and text controls can also show lists of string values based on an index.

An example helps to illustrate the use of Indexed Lists. The following pictures show a process that has three different unit operations called AGI Mix tanks. All tanks are fundamentally similar in terms of process inputs, outputs, status, and control functions.
Using Indexed Lists a single page may be created in ePro Canvas that represents all three Mix Tanks. A total of 24 indexed lists supports the single page’s 10 dynamic status attributes 7 control functions (5 pushbuttons and 2 numeric entry fields) and seven text fields, including the page title and template legends. In addition, if the scales of the bar graphs needed to be dynamic because of different pressure or temperature ranges from tank to tank, they could also be changed by Indexed Lists. The two up/down pushbuttons next to the page title increment and decrement a register that goes from 0 to 1 to 2 and is the index value for all 24 indexed lists. That register is also displayed as a readout value (‘register’ + 1) in the title area of the page to indicate the Mix Tank currently being displayed and controlled.

Another example of the use of Indexed Lists is in conjunction with Master Pages. A Master Page may be created where some of the page properties, such as page title, are driven by Indexed Lists whose index is the page ID Number property, referenced online by the System Client tag CurrentPageId.

The benefits of Indexed Lists are a reduction in the number of pages, and number of objects in the configuration, which saves memory, improves performance, and simplifies configuration management by reducing the number of copies of pages and objects with different address/tag references and expressions.

Creating and Using Indexed Lists

Indexed List entries are stored in Indexed List libraries and the library needs to be linked to the Configuration like all other Canvas libraries such as Media, Color, and Action libraries. The properties of an Indexed List are shown below:
Each Indexed List has an Indexed Expression that controls the Index List Entry value online. In the above example the tag ‘Vessnum’ in device PLC1 will be used to determine which index entry on the List tab is displayed at runtime.

The items in the List tab need to define the complete property value to be evaluated at runtime. That means that if a tag is part of an expression property, such as a conditional expression in an indicator template (Eg. ‘tag1’ & !‘tag2’), or a scaled value in a readout (Eg. ‘N7:154’ * 9.5 + 32) the entire expression must be placed in the Index List.

To use an Indexed List when editing a page control’s property dialog, simply select the Indexed List entry from the Indexed List Library in the pulldown list or from the Expression Editor window. An example is shown below for the readout template showing V1FlowRate, V2FlowRate or V3FlowRate of the previous example:
Where the Legend Title also comes from an Indexed List of text strings showing "Vessel 1 Flow Rate", "Vessel 2 Flow Rate", and "Vessel 3 Flow Rate". Virtually any parameter may come from an Indexed List including Visibility Expressions, Decimal Places, Data Entry Target Expressions, Button Entry Labels and Actions, Trend Template and Bar Template Max Min Calibrations, Indicator State Expressions, Media, and Color, as well as Action properties. Properties that do not support Indexed Lists are those that are restricted to pre-populated lists in the editor, such as Operator Input Type, Indicator State Evaluation (type), and Font.

Security

Security of an ePro configuration is designed to be as simple or as comprehensive as the developer desires. By default, anybody who has access to the PanelMate ePro unit may change pages to any page in the configuration and perform pushbutton and data entry control functions on those pages. Prior to V2.10 of ePro Canvas the only mechanism for securing the application from unwanted page or control access was through the Page Enabled Expression property and the Visibility Expression property of a page control. Both local and remote tags could be used in expression to prevent access to a page or to hide a critical control from the user. These methods are still supported but starting in V2.10 additional security functionality has been added to allow a more comprehensive approach to securing the ePro configuration.

There are many ways of implementing security in industrial control. The first level of security is physical access control. Traditional plant security, guards, gates, door locks, etc., may prevent unauthorized users entry to the machine or process area. A second level of security is at the PanelMate ePro itself. Locking cabinets and enclosures will prevent an unauthorized user from plugging in a keyboard or other device that would allow access to programs and operating system commands hidden from the touchscreen of the ePro. The third level of security is the ePro touchscreen and application and this is where ePro Canvas tools can be used to prevent unwanted use. There are three security components that constitute the ePro Canvas security model, devices, users, and groups.
Security Devices

A password is considered a Security device, but security devices may also include hardware devices, such as keys, RFID cards, biometric thumb-drives, or any such device that connects through a USB, PCMCIA, or other connection to an ePro unit that has a corresponding ePro Runtime software driver. Security Devices are contained in a Security Device Library. A password device consists of two properties, Name and User Password. Passwords are case sensitive and may contain any combination of alpha characters, numbers, and the underscore character. There is a minimum password length of one character and no maximum length.

Security Groups

Security groups define which pages may be accessed by a user who is logged on and a member of that group and if a group member may execute data entry control (pop-up entry pad or button pad control) on accessible pages. Security Groups are contained in a Security Group Library. Security groups have names and may have the All Pages Access property set to yes or no. If yes, then members of that security group have access to all pages and all control functions. If no, then the Page Permissions tab of the security group lists all pages that are accessible to group members and indicates whether or not control (data and button entry) on those pages is accessible to logged on users who are group members.
Secure Users
Secure Users are contained in Secure User Libraries. The Default User property of the library defines the secure user account that is automatically logged in when a configuration starts up and when a Security LogOff Action executes (as shown below). The Logged User property is an optional User Defined System Variable or PLC tag of string data type that the system will automatically update with the name of the user who is currently logged on.

A Secure User’s properties are:
• **Name** of the user. This is different than the name used for log on purposes so that it may be more descriptive for documentation purposes.

• **User Name** to be entered during a **Security LogOn** Action.

• **Device Expression** that determines which passwords or other security devices are evaluated during the **LogOn** process.

• **Logoff After (Minutes)** time, in minutes after log on, after which the user will be logged off of the ePro unit. An entry of zero minutes never times out.

• **LogOn Action** to be executed upon successful user logon is completed.

• **LogOff Action** to be executed upon user logoff (manual or automatic).

• **Security Group List Tab** of which the user is a member.

• **Notification Tab** to determine if the user’s logon and logoff activity will be recorded in the ePro Event Banner and the Windows Event Viewer. Choices are **Log Events** or **None**.

Secure users are assigned one or more security devices in the Device Expression property. The device expression lets you logically "and" or "or" security devices. For example a user’s device expression could be set to Password 1 || Password 2 (or), or Password 3 && Key1 (and), or simply PWordA. The Security Group List tab is used for assigning the user to one or more security groups.

**Security User and Security Group Automatic Actions**

Both Secure Users and Secure Groups have LogOn and LogOff Action properties. When a user or group member logs on and logs off, these actions (if defined) execute automatically. An automatic action may be a simple direct assignment action or may call any action or action list from the Action Library. This gives you ultimate flexibility in designing any method necessary for indicating security status. It also gives you the ability to show or hide individual page objects and control objects, through the visibility expression property, based on which user or which groups are currently logged on. For example, if you wanted to keep track of the logon status of each security group you could create User Defined System
tags of Boolean data type and have each group’s LogOn and LogOff Actions write ones and zeroes to their corresponding tag. The same could be done for each user.

Runtime Security Functionality

If a configuration has security, runtime behavior consists of the following:

- At runtime bootup, the Home page is called and the Default User is automatically logged on. For this reason the configuration’s Home Page must be accessible to the Default User account.
- Only one Secure User may be logged on at a time.
- When a user logs on or logs off an event may be written to the ePro Event Banner or the Windows Event Viewer based on the notification settings for each user.
- The active secure user’s access will be limited to those pages and controls that are defined by the security group or groups of which the user is a member. This is independent of whatever page change mechanism is employed, including a Page Change initiated through an assignment action from a PLC tag writing to the CurrentPageID system tag. If the user attempts to select an inaccessible page nothing will happen, the page will not change and no automatic system indication will be given as to why page access was denied. If the developer chooses to keep track of which user or which groups are currently active through the user or group automatic logon and logoff actions, they can choose to use standard indicator controls or visibility expressions to give runtime indication of security access status.
- All visible one-touch page controls (such as Rectangular Button, Button Bar, and Touch Area) are accessible on each page to which the user has access. This allows the user to change pages normally using various page change actions, and it also gives the developer flexibility to allow certain control actions and disallow other control actions on an accessible page.
- All data entry controls (two-touch controls such as Bar, Bar Template, Indicator, Indicator Template, Legend, Readout, Readout Template, Trend, and Trend Template) will only be accessible if the current user is a member of a group that has control access enabled for that page. If the user attempts to select an inaccessible control object nothing will happen, the pop-up control device will not display and no automatic system indication will be given as to why control access was denied.
- There are two ways a user can be logged off. The first method is by executing a Security LogOff action. The second method is when the current user’s automatic timeout period expires. When the current user logs off the Default User is automatically logged back on and if the current page is not accessible to the Default User, the system will automatically change pages back to the Home Page.

Implementing Security on an ePro Configuration

To create a configuration utilizing the built-in security features in ePro Canvas you need to go through the following steps:

2. Create a Security Device – Select the desired device library and right-click on the device or the Component Data pane and choose New Password Device. Give the password device a name and assign a password to the device. Repeat for all required password devices.
4. Create a Security Group - Select the desired group library and right-click on the group or the Component Data pane and choose New Security Group Library Entry. Give the group a name and choose Yes or No for the property All Pages Access. If you choose No, go to the Pages tab and add entries for each page to which you want to grant group member access and set the control property for each page to be Yes or No. Repeat for all required security groups.
6. Create a Secure User - Select the desired user library and right-click on the library or the Component Data pane and choose **New Secure User Library Entry**. Give the secure user entry a name (description), a user name (to be entered when logging on), and a device expression that chooses the password or other security device associated with that secure user. Repeat for all required secure users.

7. Assign a Default User – Select the Secure User Library’s properties and pick the Default User from the secure user entries of the library.

8. Assign the three security libraries to the configuration – If you want to implement the security features of ePro Canvas you must assign all three security libraries (User, Device, and Group) to a configuration. You can do this one of two ways. Either drag and drop each library onto the Configuration in the component data pane of Project Explorer or open the Configuration’s properties and add the three security libraries to the **Libraries** tab.

9. Configure LogOn and LogOff Actions – In the Action Library add two new Security Actions, one for log on and one for log off.

10. Configure rectangular button controls to one or more pages that are accessible to the Default User and assign your log on action to the button. Do the same for creating manual log off functions.

11. Optionally, configure User Defined System tags or client tags that will be used for tracking security activity, and create actions that will execute automatically on user or group logon and logoff events.

**Archive Library Entries**

The Archive Library Entry holds the specific parameters for data to be archived, including data save frequency and file path (not name).

![Project - Archive Library Entry - ModArchiveEntry1](Image)

- **Sample Rate**
  - Time Based (seconds) - How often data is saved to memory. This is ignored for Alarm and Event archiving, since that rate is determined by new alarms and events.
  - Event Based (expression) - When any tag in the expression changes, and the expression is true, then the sample will be taken.

- **Archive Rate**
• Time Based (seconds) - How often sample data in memory is saved to XML file.
• Event Based (tag) - When any tag in the expression changes, and the expression is true, then the sample data in memory is saved to XML file.

• **Group Rollover Rate**
  • Time Based (seconds) - How often the existing sheet is closed and a new sheet is created in XML file.
  • Event Based (tag) - When any tag in the expression changes, and the expression is true, then the existing sheet is closed and a new sheet is created in XML file.

• **File Rollover Rate**
  • Time Based (seconds) - How often the existing XML file is closed and a new file created.
  • Event Based (tag) - When any tag in the expression changes, and the expression is true, then the existing XML file is closed and a new file created.

• **Archive Path** - The name of the folder (directory) where this data will be saved. File names are automatically generated:
  • General Data Archiving Name - DataArchiveAction_mmddyyyyy_hhmm.xml
  • Alarm and Event Archiving - AlarmEvent_mmddyyyyy_hhmm.xml
  • Trend Archiving - TrendPens_mmddyyyyy_hhmm.xml

**Explicit Library Referencing**

Active library names can be entered alternatively, using **Explicit** references to Library Entries. Generally, this method works with library types that allow only one library per configuration. However, multiple clients are allowable in a unit, and can be accessed as shown in the table below.

The reference 'MediaLib1,Ref' can be restated as
  • ':Media:,Ref'

And the reference 'ClientSystem,?' can be replaced with
  • ':System:,?'

Notice how this gives flexibility since there is no tie to a specific library name, and will work with whatever the library is named in the configuration. For example, explicit references to an action library on a page allow that page to be re-used in multiple configurations, each accessing a different action library.

Here are the explicit names of each library.

<table>
<thead>
<tr>
<th>Library Type</th>
<th>Explicit Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Client</td>
<td>:System:</td>
</tr>
<tr>
<td>Unit's 1st Client</td>
<td>:Client1:</td>
</tr>
<tr>
<td>Unit's 2nd Client</td>
<td>:Client2:</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>Unit's Nth Client</td>
<td>:ClientN:</td>
</tr>
<tr>
<td>Media</td>
<td>:Media:</td>
</tr>
<tr>
<td>Color</td>
<td>:Color:</td>
</tr>
<tr>
<td>Action</td>
<td>:Action:</td>
</tr>
</tbody>
</table>
Property Value Formats and Syntax (single, double, or no quotes)

Throughout the ePro Canvas editors and property windows, property values of various types are entered. Depending on whether the value is **Evaluated** or **Non-evaluated**, several rules must be followed to accurately enter these values. Before the rules are applied, it must be determined whether it is an evaluated property or not.

**Evaluated Properties**

Properties which can vary during Runtime, require a mathematical evaluation and parsing for proper syntax. These **Evaluated properties'** entries can be dynamic, thus having an undefined number of values. It is possible and common for an evaluated property to contain an entry or expression that is not dynamic, but the property is still evaluated. In the editor, there is a simple way of determining if a property is evaluated. **If a property has a pull-down arrow ( ) which leads to a pull-down library menu, the property is evaluated.** In the figure below, the Value property has a pull-down arrow, and when the arrow is selected, a library menu is presented as shown below. This gives access to various references from various locations, all of which can dynamically change during runtime. So, the Value property of a Readout Template is one example of an Evaluated Property.
Non-evaluated Properties

Properties which contain values which cannot vary during Runtime are NOT evaluated. **Non-evaluated properties** are static and have a finite set of values. These property types can be determined by the properties’ type of entry - when the library menu is not available, the property is non-evaluated. For instance, fields with no pull-down arrows, Yes/No selections, and short menus are all NOT evaluated.

Below, the Orientation property is non-evaluated because it’s pull-down arrow leads to a menu with only several options (not the entire library menu).

Evaluated Properties Syntax

Note: Using the pull-down menus to select the entry values is the easiest way to determine syntax, because quotes are automatically added when needed.

Text and Names

Double quotes are required around strings which include text and names.

- **Text Strings** that are entered directly in a Text property or a Media Library Entry will be displayed exactly as entered, and requires DOUBLE quotes
  - "Template Title"
  - "rpm"
  - "This text will appear"

Note: when referencing these media library entries, the strings are referenced with single quotes.

Note: Legal characters in text fields (i.e. characters within double quote marks, “abcedgg”) include all Alpha and Numeric characters, spaces and special characters except:
Backslash. To display a backslash within double quotes you need to place a second backslash in the string. Eg. "Start \ Stop" will display as Start \ Stop

Double Quote. To display a double quote within double quotes it needs to be preceded by a backslash and must be either the first or last character in the string. Eg. "\"To be or not to be\"" will display as "To be or not to be". To place double quotes in the middle of a text string you need to use text concatenation. Eg. "This is a \"\" + "Special\" + \"\"case\" will display as This is a "Special" case

Single Quote. To display a single quote within double quotes it needs to be preceded by a backslash. Eg. "This is a \'Special\' case" will display as This is a 'Special' case

Ampersand. To display an ampersand within double quotes you need to place a second ampersand in the string, otherwise the ampersand character serves to underline the following character within the string. Eg. "This && That" will display as This & That. Whereas the string "&T&N&T" will display as TNT

Images on a Page can be directly entered (ie: not using the media library) by browsing for the image name, which will add DOUBLE quotes and double the backslash characters

"c:\overview.bmp"

Images can also be manually entered with single forward slashes

"c:/overview.bmp"

Note: When Images are entered into the media library, quotes are not required.

Documents entered into a View Action, Document Viewer Type, require a name in DOUBLE quotes. Again, backslashes are doubled.

"d:\information.html"

Documents can also be manually entered with single forward slashes

"d:/information.html"

PLC or Library Entry Data can be embedded into text strings as described below under the Combinations/Expressions/Concatenations heading.

Library References

Generally, single quotes are required around library entries. A good way to enter these is by selecting the pull-down box, and drilling down through the libraries to find the entry. Single quotes will automatically be added when needed

Properties that contain Clients and Library Entries (Tag Library Entries, Action Library Entries, Media Library Entries, etc.) are entered with SINGLE quotes

'ClientPLC,400001'
'Tag'
'LibEntryName'
'Lib,LibEntryName'
• Active library names can be entered alternatively, using **Explicit** references to **Clients** and **Library Entries**. These are entered with SINGLE quotes. 'MediaLib1,Ref' can be replaced with
  
  • ':Media:,Ref'

• **Text** referenced in a text property, from **Media Library** entries will be enclosed in single quotes, even though the reference represents text strings ('StartText', 'TextLib,StartText').

  **Note:** when text strings are created in media library entries, remember to place the strings in double quotes.

  **Note:** Legal characters in tag names or Item Names (i.e. characters within single quote marks, ‘abcdefg’) include all Alpha and Numeric Characters, spaces and special characters **EXCEPT**:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>Casting operator</td>
</tr>
<tr>
<td>@</td>
<td>Internal Client separator</td>
</tr>
<tr>
<td>,</td>
<td>Comma</td>
</tr>
<tr>
<td>=</td>
<td>Equal Sign</td>
</tr>
<tr>
<td>\</td>
<td>Backslash (Escape Character)</td>
</tr>
<tr>
<td>'</td>
<td>Single Quote</td>
</tr>
<tr>
<td>&quot;</td>
<td>Double Quote</td>
</tr>
</tbody>
</table>

**Literal Numbers**

Literal or hard-coded numbers used within evaluated properties, require NO quotes. These are evaluated because of their property type, yet are static since the value will not change during Runtime.

• **Evaluated Numeric Values** have NO quotes
  
  • 1
  • 98765
  • 2005

**Combinations/Expressions/Concatenations**

Expression properties follow the same rules in that references (tags, client tags, media entries) require single quotes, but constants and operators do not have quotes.

• Writes
  
  • 'Client,Ref' = 1

• Comparisons
  
  • 'Client,Ref' == 1

• Scaling
  
  • 'Client,Ref' / 10

• To **embed data** from the PLC in a text string, ie: to mix text and data in a text control, you must use text **concatenation**.
  
  • "The tank level is " + $I4('client1,tag1') + " Gallons"

  If the value of tag1 is 1234, this will display ... The tank level is 1234 Gallons

  When using concatenation you may embed spaces either before or after the plus character to view the sting more clearly in the editor and the spaces outside single or double quotes will be discarded at runtime.
Anywhere you can place literal text (i.e. text within double quotes) you can also place media entries or tags with data type of string. Any tag references within the parentheses of the formatted data can use math or logic operators to create an expression. The following is the general formatted data syntax:

$$tw.d(expression)$$

where ...

$ = format indicator

$ = format indicator
t = type of numeric display

I - Integer
H - Hexadecimal
B - Binary
D - Floating decimal real value
O - Octal
F - Fixed decimal real value
A - Ascii

w = Total field width including decimal point, negative sign (-), and positive sign (+)

. = Separator between width of format and the number of decimal places (used with F format)
d = Number of decimal places (used with F format)

Format type D (floating decimal point) permits the decimal point to float in the display depending on the tag’s value. This contrasts with format type F (fixed decimal point) which formats a value with a fixed decimal location.

**Formatted Data Examples:**

If ‘client,tag1’ has a value of 54321, then:

<table>
<thead>
<tr>
<th>Formatted String</th>
<th>Value Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>$I5('client1,tag1')</td>
<td>54321</td>
</tr>
<tr>
<td>$F6.2('client1,tag1' / 100)</td>
<td>543.21</td>
</tr>
<tr>
<td>$D8('client1,tag1' /100)</td>
<td>543.2100</td>
</tr>
<tr>
<td>$H4('client1,tag1')</td>
<td>D431</td>
</tr>
<tr>
<td>$O6('client1,tag1')</td>
<td>152061</td>
</tr>
<tr>
<td>$B16('client1,tag1')</td>
<td>1101010000110001</td>
</tr>
</tbody>
</table>

If ‘client,tag1’ has a value of 16706, which is 4142 hex (A=41 hex, B=42 hex), then:

<table>
<thead>
<tr>
<th>Formatted String</th>
<th>Value Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A('client1,tag1')</td>
<td>AB</td>
</tr>
</tbody>
</table>

If there is no additional literal text, media library text or PLC String data types to appear in the text control and you only wish to display the value of the tag you don’t need to use the
formatted data syntax because the text control will automatically convert the value to a string. For example, if the text property is set to ‘client1,tag1’ and the value is 54321 then it will display as 54321

- ‘:Media:,Motor 1’ + “ “ + ‘:Media:,ON’ + “ “ + $15('client1,tag1') + “ amps”

Assuming the media library has two entries named ‘Motor 1’ and ‘ON’ containing their respective strings, and the tag ‘client1,tag1’ is a 16 bit integer (short) data type with a value of 54321, then the preceding text property value will be displayed online as ...

Motor1 ON 54321 amps

Non-evaluated Properties Syntax

If it is determine that a property is NOT Evaluated, then there are NO quotes required. The majority of these are numbers and pull-down menu entries (but not pull-down library entries).

Non-evaluated/No Quotes Examples

- Non-evaluated values with a YES or NO value require no quotes.
- Non-evaluated values selected from a pull-down menu with few choices will be selected from the menu and contain NO quotes.
  - HORIZONTAL
  - VERTICAL

  Note: this does not include the pull-down library box.

- Strings that are not evaluated, such as a page added to a configuration, do NOT require quotes.
  - Page 1

- Images that are entered into the media library by browsing for the image path, will add a path string with NO quotes
  - c:/overview.bmp

  This entry can also be entered as
  - c:\overview.bmp

- In the Document Viewer, Home Page and Document Viewer Content, Document Location properties, NO quotes are used
  - www.eaton.com
  - d:/information.html

- Non-evaluated Numeric Values have NO quotes

User Defined System Tags

User defined tags may be added manually to the System Client tag file TagSystem. These tags will all have an initial value of zero and the data type may be specified or you can select the type to be “Interface Supplied” which will default to unsigned 32-bit integer. You can add a tag to the TagSystem by opening the tag file properties dialog and selecting the “Tags” tab, and then double clicking on the line labeled “Double click here to append a row”. The Name is user specified as long as it is unique in the tag file, and the Definition field should be identical to the Name. The default Data Type of Interface Supplied may be changed to any of the types shown below:
You can also add a tag by selecting the TagSystem library in the Project Components pane of Project Explorer, then right-click in the Component Data pane and select New Tag Library Entry.

User defined system tags will not change value at runtime unless the user configures a function that writes to those tags. They may be written to from a pushbutton or button bar function, from a data entry function, or from an Assignment Action. If the user configures a Conditional Passthru Assignment Action a user defined system tag can be updated from the PLC through an OPC Server client connection.

User defined system tags may be useful for a number of purposes. Their value can be toggled by a pushbutton to control conditional visibility of page objects, or a system tag may be used in place of a PLC register for storage of the configuration’s Active Language ID. A system tag may also be used as an index to one or more Indexed Lists. There are many more uses of user defined system tags and in general they can be used for local functions that will reduce the requirement of Operator Interface specific registers in the PLC. Note however that unlike PLC registers, system tags are not persisted values, which means that system tags will be set back to their default value of zero at each reboot of the ePro. This may limit some of the uses to which you would apply user defined system tags.

**Component Templates**

Component Templates are project components that have been saved as templates for reuse within the project. Component Templates may be created by the developer to reduce development time and provide a consistent look or style to a configuration. Any project component can be saved as a template by right-clicking on the component and selecting Create Component Template and any single page component can be saved as a template by right-clicking on it and selecting Create Template as illustrated below.
When a component is saved as a template all configured properties of that component are saved. To create a new project component from a saved template right-click on the component group, i.e. Unit, Client, Configuration, Page, etc., and highlighting Create From Template, then choosing the desired template from the resulting list of Component Templates as illustrated below.
In the Page Editor you can use saved page components by clicking on the Component Template category in the controls bar. New components created from a component template will have all initial properties set to that of the saved template. This can speed up development by allowing the user to establish the default settings of new components added to the project rather than accepting the editor defaults and having to change each new components properties to match the desired standards of the developer. Because page controls can also be saved as Component Templates the developer can take standard Canvas controls and customize them once and then use the customized controls to reduce development time and create a consistent look and feel to the project’s pages.

Some Component Templates are included in the default Project Profile to speed up initial development. They are shown below:
Because Component Templates are saved with a project just like any other project components they will not automatically be added with a New blank project or New prepackaged project. However, like all other project components they may be copied from an existing project to a new project by opening both projects in separate windows and using copy and paste, or drag and drop, to copy between the two projects.

Changing the Default Prepackaged Project

**Canvas Assistance and Component Builder**

The Canvas Assistance and Component Builder features provide guidance throughout project development.

**Canvas Assistance**

Canvas Assistance parses all property value entries and checks for accuracy. The following operations are carried out on the entries.

- **Text** - Double Quotes added automatically to text entries if needed.
- **Tags** - If a tag is entered that does not exist, the Component Builder menu (as described below) will be shown to allow creating the tag immediately.

**Component Builder**

Component Builder allows components to be built anywhere in the Canvas Pro editor. This is helpful when editing a component and without leaving that component a completely different component can be added. The menu is called in the following ways.

- CTRL-Right Click opens the pulldown menu any where in the editor as shown below.
- When dynamic references are entered into an evaluated property and the dynamic reference does not exist, the menu is presented to allow adding a component.

**Note:** The dynamic reference is checked for existence against its expected library type first, then client/tags are checked next.

Enabling and Disabling Canvas Assistance and Component Builder Features

By default, all features are enabled. If desired they can be disabled from the Tools menu as follows.
Canvas Options

The following options allow enable/disable automatic string functions.

- Canvas Assist
  - Automatically apply string quotes when missing - add double quotes to text properties
  - Automatically apply string quotes to Media Library Text Entries - add double quotes to text entries within a Media Library

Component Builder Options

The following options enable/disable menu operations.
• Automatic
  • Show new component menu - tops the menu when adding a dynamic property reference that does not exist, so the component can be added.
  • Edit new component properties - tops property editor to edit new references (after adding from menu above).
  • Show Folders - select the items (Action Libraries, Archive Libraries...) to appear in the Component Builder menu.

Document Viewer

Document Viewer

The Document Viewer is a window which allows displaying HTML and PDF documents and addresses.

Document Viewer tab properties

• **Home Page** - Address/location of initial document or web page to be displayed. Can be a file like c:\home.pdf or a web site like www.eaton.com. No quotes are needed.
• **Title** - Name displayed at the top of the viewer.
• **Font** - sets the viewer font.
• **Roll Up/Down Operational** - enables minimizing and maximizing the document area.
• **Exit Operational** - enables/disables exit button.
• **Mobility** - enables/disables ability to move viewer.
• **Location** - viewer position (top, bottom, left, right or center).
• **Height** - Percent - height of viewer based on display size. Default is 50, which covers half the display height.
• **Width** - Percent - width of viewer based on display size.
• **Forward/Back Button Operational** - enables/disables buttons to navigate the pages.
• **Browse Address Operational** - allows/disallows ability to browse for files.
• **Home Page Button Operational** - enables/disables button to return to the initial document or web page.
• **Open File Operational** - allows/disallows local file search.
• **Refresh Button Operational** - enables/disables button to refresh document or web page.

• **Browser Stop Button Operational** - enables/disables button to close browser.

**Document Viewer Content tab properties**

• **Documentation Location** list - A list of pre-determined html and pdf file links and addresses. These appear in the address pull-down list during Runtime, for example: www.msn.com, www.eaton.com.

**Event Banner and Manager**

**Event Banner**

See *events & alarms - big picture*

The event banner property tab is where you set up an event log will appear in Runtime. These properties are only for the Non-O/S event log, they do not have affect on the system event log. Viewing the event log will also give you the option to acknowledge an event.

**Event Banner properties**

Override Configuration - use these Unit settings for the Event Banner instead of those assigned in the Configuration properties.

*Note: Override Configuration only appears on the Unit's Event Banner property tab. It allows Unit settings to override all the settings that were configured in the Configuration's Event Banner property tab.*

**Banner** - general settings for the Banner.

• Title - Name displayed at the top of the banner.

• Font - sets the event banner font.

• Roll Up/Down Operational - enables/disables scrolling.

• Mobility - enables/disables ability to move banner.

• Location - banner position (top, bottom, left, right or center)

• Height - Percent - height of banner based on display size

• Width - Percent - width of banner based on display size

**Acknowledge-Filters** - button settings for the Alarm/Event Window.

*Notes:*

Operational = function and corresponding button enabled for Runtime use

Visible = alarms currently in view on banner/window

... On = text name on button when filtering is on; ... Off = text name on button when filtering is off

Active = in alarm state; Inactive = not in alarm state

• Acknowledge All Alarms - name to display on the Ack All button during Runtime

• Acknowledge All Operational - Yes = allow the Ack All function (ie: show the button) during Runtime; No = remove Runtime function and button.

• Acknowledge Visible Alarms - name to display on the Ack Visible button during Runtime
• Acknowledge Visible Operational - Yes = allow the Ack Visible function (ie: show the button) during Runtime; No = remove Runtime function and button.

• Filter Active On - name to display on the Active filter's button (On state) during Runtime
• Filter Active Off - name to display on the Active filter's button (Off state) during Runtime
• Filter Active Operational - Yes = allow the Active On/Off filter (ie: show the button) during Runtime; No = remove Runtime function and button.

• Filter Inactive On - name to display on the Inactive filter's button (On state) during Runtime
• Filter Inactive Off - name to display on the Inactive filter's button (Off state) during Runtime
• Filter Inactive Operational - Yes = allow the Inactive On/Off filter (ie: show the button) during Runtime; No = remove Runtime function and button.

• Filter Acknowledged On - name to display on the Acknowledged filter's button (On state) during Runtime
• Filter Acknowledged Off - name to display on the Acknowledged filter's button (Off state) during Runtime
• Filter Acknowledged Operational - Yes = allow the Acknowledged On/Off filter (ie: show the button) during Runtime; No = remove Runtime function and button.

• Filter Unacknowledged On - name to display on the Unacknowledged filter's button (On state) during Runtime
• Filter Unacknowledged Off - name to display on the Unacknowledged filter's button (Off state) during Runtime
• Filter Unacknowledged Operational - Yes = allow the Unacknowledged On/Off filter (ie: show the button) during Runtime; No = remove Runtime function and button.

**Table** - settings that affect the presentation of the Alarm/Event table.
• Maximum Events - This is the maximum number of events to display.
• Grid Background - Select the default background color of the table.
• Active Acknowledged FG Color
• Active Acknowledged BG Color
• Inactive Acknowledged FG Color
• Inactive Acknowledged BG Color
• Active Unacknowledged FG Color
• Active Unacknowledged BG Color
• Inactive Unacknowledged FG Color
• Inactive Unacknowledged BG Color
• Header Height - This will adjust the table header height.
• Field Height - This will adjust the height of each row of the table.
• Selected Text Color - When you touch a row, the row becomes the selected row and you can have the text of that row change to a different color to help make the row more visible than other rows to draw better attention to the row.

• Selected Background Color - When you touch a row, the row becomes the selected row and you can have the background color of that row change to a different color to help make the row more visible than other rows to draw better attention to the row.

**Triggered Timestamp** - the time an event occurred and was written to the event log.

• Column - This will select which column you want this property to be displayed in.
• Column Width - This will adjust the column width.
• Text - This is the header text of the column.
• Header FG Color - Select the foreground color of the header field.
• Header BG Color - Select the background color of the header field.
• Header Font - Set the font to use when for the text in the header field.
• Header Alignment - Set the type of alignment to use for the header text.
• Field FG Color - Select the foreground color of the column under the header field.
• Field BG Color - Select the background color of the column under the header field.
• Field Font - Set the font to use when for the text under the header field.
• Field Alignment - Set the type of alignment to use for the text under the header field.

**Cleared Timestamp** - if the event cleared itself, this is the time it cleared.

• Column - This will select which column you want this property to be displayed in.
• Column Width - This will adjust the column width.
• Time Format - If the event clears itself this field will have the time the event cleared written to this field.
  - Absolute - This will write the current time the event cleared.
  - Elapsed - This will write the elapsed time from when the event occurred.
• Text - This is the header text of the column. The default text is "Cleared", you can change this text to any text string you want. Remember to place " before and after the text.
• Header FG Color - Select the foreground color of the header field.
• Header BG Color - Select the background color of the header field.
• Header Font - Set the font to use when for the text in the header field.
• Header Alignment - Set the type of alignment to use for the header text.
• Field FG Color - Select the foreground color of the column under the header field.
• Field BG Color - Select the background color of the column under the header field.
• Field Font - Set the font to use when for the text under the header field.
• Field Alignment - Set the type of alignment to use for the text under the header field.

**Acknowledged Timestamp** - if the event was acknowledged, this is the time it was acknowledged.
• Column - This will select which column you want this property to be displayed in.
• Column Width - This will adjust the column width.
• Time format - If the event clears itself this field will have the time the event cleared written to this field.
  • Absolute - This will write the current time the event cleared.
  • Elapsed - This will write the elapsed time from when the event occurred.
• Text - This is the header text of the column. The default text is "Acknowledged", you can change this text to any text string you want. Remember to place " before and after the text.
• Header FG Color - Select the foreground color of the header field.
• Header BG Color - Select the background color of the header field.
• Header Font - Set the font to use when for the text in the header field.
• Header Alignment - Set the type of alignment to use for the header text.
• Field FG Color - Select the foreground color of the column under the header field.
• Field BG Color - Select the background color of the column under the header field.
• Field Font - Set the font to use when for the text under the header field.
• Field Alignment - Set the type of alignment to use for the text under the header field.

**Description** - event description, when the event occurs, the description field from the log event action which created the event will be written here.

• Column - This will select which column you want this property to be displayed in.
• Column Width - This will adjust the column width.
• Text - This is the header text of the column. The default text is "Description", you can change this text to any text string you want. Remember to place " before and after the text.
• Header FG Color - Select the foreground color of the header field.
• Header BG Color - Select the background color of the header field.
• Header Font - Set the font to use when for the text in the header field.
• Header Alignment - Set the type of alignment to use for the header text.
• Field FG Color - Select the foreground color of the column under the header field.
• Field BG Color - Select the background color of the column under the header field.
• Field Font - Set the font to use when for the text under the header field.
• Field Alignment - Set the type of alignment to use for the text under the header field.

**Criticality** - when the event occurs, the criticality field from the log event action which created the event will be written here.

• Column - This will select which column you want this property to be displayed in.
• Column Width - This will adjust the column width.
• Text - This is the header text of the column. The default text is "Level", you can change this text to any text string you want. Remember to place " before and after the text.
• Header FG Color - Select the foreground color of the header field.
• Header BG Color - Select the background color of the header field.
• Header Font - Set the font to use when for the text in the header field.
• Header Alignment - Set the type of alignment to use for the header text.
• Field Critical Text - Name used to identify a critical alarm.
• Field Serious Text - Name used to identify a serious alarm.
• Field Warning Text - Name used to identify a warning alarm.
• Field Attention Text - Name used to identify an attention alarm.
• Field Informational Text - Name used to identify an informational alarm.
• Field Default FG Color - foreground Color for the "No Alarm" state.
• Field Default BG Color - background Color for the "No Alarm" state.
• Field Critical FG Color - foreground Color for the "Critical" state.
• Field Critical BG Color - background Color for the "Critical" state.
• Field Serious FG Color - foreground Color for the "Serious" state.
• Field Serious BG Color - background Color for the "Serious" state.
• Field Warning FG Color - foreground Color for the "Warning" state.
• Field Warning BG Color - background Color for the "Warning" state.
• Field Attention FG Color - foreground Color for the "Attention" state.
• Field Attention BG Color - background Color for the "Attention" state.
• Field Informational FG Color - foreground Color for the "Informational" state.
• Field Informational BG Color - background Color for the "Informational" state.
• Field Font - the font to use when for the text under the header field.
• Field Alignment - the type of alignment to use for the text under the header field.

**Group Column** - specifies the column you want this property to be displayed in.

**Group Name** - specifies the column you want this property to be displayed in.

**Source** - specifies the column you want this property to be displayed in.

**User** - specifies the column you want this property to be displayed in.

**Computer** - specifies the column you want this property to be displayed in.

**Event Manager**

See events & alarms - big picture

The event manager is used to select which types of events are logged to the operating system event log. ePro Runtime will write event to two event logs. ePro runtime will always write to its own event log, it will also write to the operating system event log.

**Two event logs**
If none of the default settings are changed in ePro Canvas, then the ePro runtime will write events to two event logs. These event logs are:

- **Non-O/S event log** - This is an event log that ePro runtime creates and is always written to. The only setting that affects this log is how many events it should save. Hardware platforms with CE operating systems will not save this log through a reset or power off condition. All other hardware platforms will save the contents of the log through a reset and power off condition.

- **System event log** - This is the standard operating system event log that you might be familiar with. CE operating systems do not have event logs. ePro runtime will only write to this log if you select it to.

### Event manager tab properties

- **Override Configuration** - On Unit's Event Banner property tab only, and allows these settings to override the same settings which were configured in the Configuration's Event Banner property tab.

- **Max Number of Events to Non-O/S Log** - This property sets the number of events to record in the runtime event log. The oldest event will be deleted as a new event occurs if the number of events have reached the maximum number set here. This number does not have an affect on a system event log because those parameters are established from within the system event log.

- **Save Critical Events to O/S Log** - Select yes or no to store this type of event in the system event log. A critical event type is a choice you make when creating a log event action. This event will always be written to the Non-O/S event log.

- **Save Serious Events to O/S Log** - Select yes or no to store this type of event in the system event log. A serious event type is a choice you make when creating a log event action. This event will always be written to the Non-O/S event log.

- **Save Warning Events to O/S Log** - Select yes or no to store this type of event in the system event log. A warning event type is a choice you make when creating a log event action. This event will always be written to the Non-O/S event log.

- **Save Attention Events to O/S Log** - Select yes or no to store this type of event in the system event log. A attention event type is a choice you make when creating a log event action. This event will always be written to the Non-O/S event log.

- **Save Informational Events to O/S Log** - Select yes or no to store this type of event in the system event log. A informational event type is a choice you make when creating a log event action. This event will always be written to the Non-O/S event log.

- **Archive** - Placing an Archive Library Entry reference (ie: ‘:Archive:,AlarmandEventEntry’) here, will result in Alarm and Event log archival based on the archive settings.

### Events & Alarms - Big Picture

Several separate features of ePro Canvas need to be configured together in order for successful events to be recorded and viewed. These are the separate features and their descriptions.

- **Event Manager** - The event manager establishes how many non-O/S events to record and whether events should be recorded to the standard O/S event log. The event manager is set up on the event manager tab of a configuration.

- **Log Event Action** - This is where events are established. Write an event by a conditional, unconditional, or bit log event action. When the expression is true or the bit transitions from zero to one the corresponding event will be written to the event log(s). Log events are set up in the action library.

- **Event Banner** - The event banner establishes what will be seen when the Non-O/S event log is viewed. This is where you establish the description of each column, the color of each column, which columns are visible and what order they are displayed. The exception is the CE platforms which has fixed columns. The event banner is set up on the event banner tab of a configuration.
- **View Action** - A view action when executed will display the Non-O/S event log. This can be triggered by conditional or unconditional methods. When the event log is displayed it will be displayed according to how the event banner was set up. View actions are set up in the action library.

- **Event Manager Override** - Since a configuration can be used in many different units, it might be desirable to have a different event manager set up than what the configuration has. If you were to change to event manager in the configuration (event manager tab of a configuration), then any units that are using the configuration will also change. Using this override method you do not need to change the configuration. If you select override event manager on the event manager tab of a unit you can change the event manager for the desired unit without changing the event manager for any other unit that would be using the same configuration.

- **Event Banner Override** - Since a configuration can be used in many different units, it might be desirable to have a different event banner set up than what the configuration has. If you were to change to event banner in the configuration (event banner tab of a configuration), then any units that are using the configuration will also change. Using this override method you do not need to change the configuration. If you select override event banner on the event banner tab of a unit you can change the event banner for the desired unit without changing the event banner for any other unit that would be using the same configuration.

- **Acknowledging Alarms** - An alarm is an event. Usually the only difference between them is alarms typically need to be acknowledged. To do this, set up the event. After the event occurs, open the event viewer and touch the row of the required event. This will write an Acknowledged timestamp on the same row as the event indicating the event has been acknowledged.

### Page Editor

#### Navigation

**Customizing the Page Editor**

The Page Editor is designed with some customization capabilities. The following are intended to simplify page editing.

**Move Menu Bars and Toolbars**

By default, all menu bars and toolbars are displayed across the top of the window. All menu bars and toolbars are dockable, which means that they can be moved to any location in the window.

**To move a menu bar or toolbar:**

1. Click the move handle located at the far left of the menu bar or toolbar.
2. Press and hold the mouse button while you drag the menu bar or toolbar to a suitable location in your window.
3. Release the mouse button to drop the menu bar or toolbar to its new location. It will remain in this new place until you move it again or close it.

**Customizing the Control Bar**

**Moving the Control Bar**

The Control bar's default location is the left-hand side of the Page Editor window. You can move the Control bar by clicking the move handle at the top of the bar and dragging it to a new location.

**Resizing the Control Bar**

You can resize the Control bar by positioning the mouse pointer over the Control bar border until the pointer changes to a double-headed arrow. Move the double-headed arrow to the left or right to resize the Control bar.
Creating a Floating Control Bar

You can create a floating Control bar by double-clicking the move handle at the top of the Control bar. Once you do this, the Control bar becomes detached from the Page Editor window and becomes it’s own independent window, complete with a title bar at the top.

Tip: To dock the Control bar, double-click the floating bar’s title bar.

Viewing Small/Large Control Icons in the Control Bar

You can view either large or small icons in the Control bar. To do this, right-click in the Control bar and select Large Icons or Small Icons.

Resizing a Floating Control Bar

When you select the floating Control bar, sizing handles appear at the corners and along the edges of the window. You can resize the window by dragging its sizing handles.

Modifying Grid and Snap Settings

When you are placing or arranging objects on a page, you can use the alignment grid for more precise positioning. When the grid is turned on, objects appear to "snap to" the dotted lines of the grid as if magnetized. You can turn this "snap to grid" feature on and off, as well as change the size of the grid cells.

In addition to defining a grid size, and whether to show or snap to the grid, a guidelines margin can be defined around the perimeter of the view, such that objects cannot be moved outside the guidelines margin.

The Grid Settings window allows you to configure grid snapping and margin/guidelines settings.

Turning the Snap to Grid On and Off

To turn the snap to grid on and off for the currently active view (in edit mode), complete one of the following actions:

- From the Layout toolbar, click the Toggle Grid button
- From the Layout menu, click the Grid Settings command

Result: The Grid Settings window appears.

Changing the Size of the Layout Grid

To change to size of the layout grid, complete the following steps:

1. From the Layout menu, click the Grid Settings command.  
   Result: The Grid Settings window appears.

2. In the Spacing box, type a different width and height (in pixels) for the cells in the grid.
   Note: The default spacing for the grid is 10 pixels.

3. Click OK.

Zooming In and Out of a Page

Using the Zoom In and Out Toolbar

To zoom in and out of a page, complete the following steps:

1. Right-click the down arrow next to the Zoom In and Out toolbar. 
   Result: A drop-down menu appears.

2. From the drop-down menu, click one of the following options:
   - Zoom In, to see a close-up view of the page
   - Zoom Out, to see more of the page at a reduced size
Using the Zoom Menu Command

To zoom in and out of a page, complete the following:

1. From the Draw menu, right-click the down arrow next to the Zoom command and click one of the following options:
   - Zoom In, to see a close-up view of the page
   - Zoom Out, to see more of the page at a reduced size
   - Zoom 1:1, to view the page at 100 percent.

Open/close Toolbars and Component Views

By default, all toolbars are open and displayed on the window. You can open and close these toolbars whenever necessary.

To open a toolbar:

From the View menu, select a specific toolbar to open (open toolbars display a check mark on the left).

To close a toolbar:

From the View menu, select a specific toolbar to close (closed toolbars do not display a check mark on the left).

Online functions, such as screen settings and referenced libraries can be modified using Page Component Properties.

The following links provide related assistance.

The Page Editor

Working with Controls

Working with Properties

Working with Controls

When working with controls, the following links may be helpful.

Which Control Do I use?

- To view Numeric data:
  - Readout Template (includes Title "Legend" and Units field)
  - Readout
  - Bar Template (includes Title "Legend", Readout, Scale and Units field)
  - Bar

- To view Status or States:
  - Indicator Template (includes Title "Legend" and Units field)
  - Indicator
• **Rectangular Button** and **Legend** allow images and/or text to be displayed dynamically.

• To **Write** or **Change "Bit" Values**:
  - **Rectangular Button**
  - Control **Button** - selected from the "Buttons" tab of any control.

• To **Write** or **Change "Word" Values**:
  - Control **Data Entry** - selected from the "Data Entry" tab of any control.

• To **Change Pages**:
  - **Rectangular Button**

• To **draw Custom Graphics**:
  - Arc
  - Ellipse
  - Image
  - Line
  - Polygon
  - Rectangle
  - Text

Adding a Control to a Page

To add a control to a page, drag the control from the **Control Bar** frame and drop it onto the **Editor** frame/page. The control can be edited/configured by either:
- Double-clicking it, and modifying its attributes in the **Property Editor** window
- Right-clicking it, selecting **Properties** and modifying its attributes in the **Property Editor** window

Note: Controls can be edited, added, or deleted to/from a page without opening the page editor by "right clicking" the page in Project Explorer. Then the page controls appear in the right pane.

Configuring/Editing a Control

Once a control has been dragged and dropped onto the page, you can configure and/or edit it. To do this, complete the following steps:

Perform one of the following actions:
- Double-click the control
- Right-click the control and select **Properties**
- Click the control and from the **Layout** menu, select **Properties**
- Click the control and from the **Layout** toolbar, select the **Property Sheet** icon

**Result:** The **Property Editor** window appears, so that you can modify the control’s properties.

Viewing a Control’s Properties

You can view the properties of any control on a page. To do this, complete the following steps:

Perform one of the following actions:
- Double-click the control
- Right-click the control and select **Properties**
- Click the control and from the **Layout** menu, select **Properties**
Getting Started

- Click the control and from the Layout toolbar, select the Property Sheet icon

**Result:** The Property Editor window appears, so that you can modify the control’s properties.

Deleting a Control

There are several ways in which you can delete a control from a page:
- Right-click the control and select Delete
- Click the control, and from the Standard toolbar, select Delete.
- Click the control, and from the Edit menu, select Delete.

Arranging Controls/Objects on a Page

**Aligning Controls/Objects**

You can align two or more controls/objects relative to each other by their left, right, top, or bottom edges or by their centers (vertically) or middles (horizontally).

**To align objects on a page:**

1. From the Editor frame, press the Shift button on the keyboard then select the controls that you want to align. **Note:** Make sure the dominant object is the last object that you select. The final position of the group of objects depends on the position of the dominant object.

2. Perform one of the following actions:
   - From the Layout toolbar, select the down arrow to the right of the Align Edges icon, and select a specific alignment button.
   - From the Layout menu, select Align Objects and then select a specific alignment menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Align Left" /></td>
<td>Align Left</td>
<td>This button/command aligns the selected objects along their left side. <strong>Note:</strong> You can also use the short cut keys Ctrl + Left Arrow.</td>
</tr>
<tr>
<td><img src="image" alt="Align Center" /></td>
<td>Align Center</td>
<td>This button/command aligns the selected objects along their horizontal center.</td>
</tr>
<tr>
<td><img src="image" alt="Align Right" /></td>
<td>Align Right</td>
<td>This button/command aligns the selected objects along their right side. <strong>Note:</strong> You can also use the short cut keys Ctrl + Right Arrow.</td>
</tr>
<tr>
<td><img src="image" alt="Align Top" /></td>
<td>Align Top</td>
<td>This button/command aligns the selected objects along their top edges. <strong>Note:</strong> You can also use the short cut keys Ctrl + Up Arrow.</td>
</tr>
<tr>
<td><img src="image" alt="Align Middle" /></td>
<td>Align Middle</td>
<td>This button/command aligns the selected objects along their vertical center.</td>
</tr>
<tr>
<td><img src="image" alt="Align Bottom" /></td>
<td>Align Bottom</td>
<td>This button/command aligns the selected objects along their bottom edges. <strong>Note:</strong> You can also use the short cut keys Ctrl + Down Arrow.</td>
</tr>
</tbody>
</table>
Spacing Controls/Objects Evenly

To space controls/objects evenly on a page:
1. From the Editor frame, press the Shift button on the keyboard then select the controls that you want to space evenly.
2. Perform one of the following actions:
   - From the Layout toolbar, select the down arrow to the right of the Space icon, and select a specific spacing button.
   - From the Layout menu, select Space Evenly and then select a specific spacing menu command.

Centering Controls/Objects

To center controls/objects on a page:
1. From the Editor frame, press the Shift button on the keyboard then select the controls that you want to space evenly.
2. Perform one of the following actions:
   - From the Layout toolbar, select the down arrow to the right of the Center in View icon, and select a specific centering button.
   - From the Layout menu, select Center in View and then select a specific centering menu item.

Making Controls/Objects the Same Size

To make controls/objects the same size:
1. From the Editor frame, press the Shift button on the keyboard then select the controls that you want to space evenly.
2. Perform one of the following actions:
   - From the Layout toolbar, select the down arrow to the right of the Make Same Size icon, and select a specific sizing button.
   - From the Layout menu, select Make Same Size and then select a specific sizing menu command.
Getting Started

<table>
<thead>
<tr>
<th>Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Make Same Height" /></td>
<td>This button/command sizes objects to be the same height.</td>
<td></td>
</tr>
<tr>
<td><img src="image2.png" alt="Make Same Size" /></td>
<td>This button/command sizes objects to be the same size.</td>
<td></td>
</tr>
</tbody>
</table>

Ordering Controls/Objects

To set the order of controls/objects on a page:
1. From the Editor frame, select the control that you want to order.
2. Perform one of the following actions:
   - From the Layout toolbar, select the down arrow to the right of the To Front or Back icon, and select a specific ordering button.
   - From the Draw menu, select Order and then select a specific ordering menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.png" alt="Bring to Front" /></td>
<td>Bring to Front</td>
<td>This button/command brings an object to the front of all other objects.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Send to Back" /></td>
<td>Send to Back</td>
<td>This button/command sends an object to the back of all other objects.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Bring Forward" /></td>
<td>Bring Forward</td>
<td>This button/command brings an object to the front of the object directly in front of it.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Send Backward" /></td>
<td>Send Backward</td>
<td>This button/command sends an object to the back of the object directly in back of it.</td>
</tr>
</tbody>
</table>

Grouping Controls/Objects

When you group controls/objects, you combine them so you can work with them as though they are a single object. You can rotate, resize, or scale all objects in a group as a single unit.

You can ungroup a group of objects at any time, and as long as the page is still active, you can easily regroup them by selecting any one of the objects that was previously grouped. If you move to another document or change views, you'll need to select each object and regroup them again.

Grouping functionality is intended to help you assemble a unique combination of controls/graphics for an application. That way, if you want to reuse the combination (either as-is or with minor modifications) in other configurations, you do not have to repeat your work.

To group controls/objects on a page:
1. From the Editor frame, select the Shift button on the keyboard and then click the controls that you want to group.
2. Perform one of the following actions:
   - From the Layout toolbar, select the Group, Ungroup, or Regroup icon.
   - From the Draw menu, select Group and then select a specific grouping menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
</table>
### Grouping Objects

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This button/command groups a set of selected</td>
</tr>
<tr>
<td></td>
<td>objects together.</td>
</tr>
<tr>
<td>Ungroup</td>
<td>This button/command ungroups a group of</td>
</tr>
<tr>
<td></td>
<td>objects.</td>
</tr>
<tr>
<td>Regroup</td>
<td>This button/command regroups a set of</td>
</tr>
<tr>
<td></td>
<td>objects that was previously grouped.</td>
</tr>
</tbody>
</table>

### Rotating Controls/Objects

To rotate controls/objects to the left or right on a page:

1. From the **Editor** frame, select the control that you want to rotate.
2. Perform one of the following actions:
   - From the **Layout** toolbar, select the **Rotate Left** or **Rotate Right** icon.
   - From the **Draw** menu, select **Rotate** and then select **Rotate Left** or **Rotate Right**.

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Free Rotate</td>
<td>This button/command rotates the object to the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>degree that you specify.</td>
</tr>
<tr>
<td></td>
<td>Rotate Left</td>
<td>This button/command rotates the object</td>
</tr>
<tr>
<td></td>
<td></td>
<td>counter-clockwise by 90 degrees.</td>
</tr>
<tr>
<td></td>
<td>Rotate Right</td>
<td>This button/command rotates the object</td>
</tr>
<tr>
<td></td>
<td></td>
<td>clockwise by 90 degrees.</td>
</tr>
</tbody>
</table>

To free rotate controls/objects on a page:

1. From the **Editor** frame, select the control that you want to rotate.
2. Perform one of the following actions:
   - From the **Layout** toolbar, select the **Free Rotate** icon.
   - From the **Draw** menu, select **Rotate** and then select **Free Rotate**.

**Note:** The drag handles of the selected object turn into circles, so that you can freely rotate the object.

3. Rotate the object about its center by dragging any one of these handles.

For more details on the composition of controls, refer to the **Control Example**.

The following links provide related assistance.

**The Page Editor**

**Customizing the Page Editor**

**Working with Properties**

**Working with Properties**

The **Property Editor** is designed with the following adjustment capabilities:
Resizing the Property Editor Window

Property Editor windows can be sized to any dimension by:

- Placing the pointer at the edge of the window (until the pointer turns into a line with arrows on each end), pressing the left mouse button and dragging up, down, left or right.
- Using the Maximize and Minimize buttons located at the upper right corner of the window
- Using the scroll bars along the right side and bottom of the window

Scrolling to Another Part of the Property Editor Window

To scroll to another part of the window, either:

- Drag the scroll bars back and forth or up and down
- Click the arrows next to the scroll bar

Resizing Columns in the Property Editor Window

In addition to sizing the window, you can size the columns by dragging the sides of each column. Place the pointer at the edge of the column (until the pointer turns into a line with arrows on each end), press the left mouse button and drag left or right.

Note: When a column is smaller than the largest viewable text in that column, the text appears with "...." at the end.

Moving Between Cells in the Value Column

To move between cells in the value column (the last column on the right) click any cell or use the up/down arrow keys. When you move to a cell, the cell is highlighted and becomes active.

<table>
<thead>
<tr>
<th>If you want to move...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>One row up or down</td>
<td>Click the arrows in the vertical scroll bar</td>
</tr>
<tr>
<td>Several values up or down</td>
<td>Click above or below the scroll box in the vertical scroll bar</td>
</tr>
<tr>
<td>A large distance</td>
<td>Drag the vertical scroll box to the approximate relative position</td>
</tr>
</tbody>
</table>

Note: The size of a vertical scroll box indicates the proportional amount of the used area of the dialog that is visible. The position of a scroll box indicates the relative location of the visible area within the dialog.

Right-Click Menu

When you right-click inside of a Property Editor window, a menu appears with some or all of the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Use this command to cut a selected object(s) from the window and place the object(s) on the Windows clipboard. <strong>Tip:</strong> You can also use the shortcut keys CTRL+X to perform the same operation.</td>
</tr>
<tr>
<td>Copy</td>
<td>Use this command to copy a selected object(s) to the Windows</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Paste</strong></td>
<td>Use this command to paste a selected object(s) from the Windows clipboard into the window. <strong>Tip:</strong> You can also use the shortcut keys <strong>CTRL+C</strong> to perform the same operation.</td>
</tr>
<tr>
<td><strong>Find</strong></td>
<td>Use this command to search for text, specific formatting, and values. <strong>Tip:</strong> You can also use <strong>CTRL+V</strong> to perform the same operation.</td>
</tr>
<tr>
<td><strong>Replace</strong></td>
<td>Use this command to search for and replace text, specific formatting, and values. You can also search for and replace all forms of a word (for example, you can replace &quot;make&quot; with &quot;build&quot; as well as &quot;made&quot; with &quot;built&quot;).</td>
</tr>
<tr>
<td><strong>Insert Before Row</strong></td>
<td>Use this command to insert a row before the row that you have highlighted.</td>
</tr>
<tr>
<td><strong>Insert After Row</strong></td>
<td>Use this command to insert a row after the row that you have highlighted.</td>
</tr>
<tr>
<td><strong>Insert Rows...</strong></td>
<td>Use this command to insert multiple rows after the row that you have highlighted.</td>
</tr>
<tr>
<td><strong>Delete Row</strong></td>
<td>Use this command to delete a selected row from the window.</td>
</tr>
<tr>
<td><strong>Default Row Contents</strong></td>
<td>Use this command to insert the default content values into the row, if applicable.</td>
</tr>
<tr>
<td><strong>Delete Cell Contents</strong></td>
<td>Use this command to delete the contents of the cell.</td>
</tr>
<tr>
<td><strong>Default Cell Contents</strong></td>
<td>Use this command to insert the default content values into the cell, if applicable.</td>
</tr>
<tr>
<td><strong>Sort Ascending</strong></td>
<td>Use this command to sort the rows in ascending order.</td>
</tr>
<tr>
<td><strong>Sort Descending</strong></td>
<td>Use this command to sort the rows in descending order.</td>
</tr>
</tbody>
</table>

Static properties, such as fonts and colors are selected from the property editor and are displayed immediately in the way they will appear during Runtime. Dynamic properties are entered via expressions which indicate how the data will appear during Runtime, see the following for details:

- **Expressions Discrete**
- **Expressions Analog**
- **Expressions Data Entry**
- **Expressions Direct Assignment**

For more details on the composition of controls, refer to the Control Example.

The following links provide related assistance.

**The Page Editor**
Customizing the Page Editor

Working with Controls

Pages

The Page Editor

Overview

The Page Editor allows you to create the configuration Pages to be viewed on the unit. Visual Controls can be added and property values modified to give the operator the appropriate tools to monitor and control a process.

What is a Page?

Page Editor Access

- **To edit an existing page** - the page is opened by double clicking on it in the Project Explorer.
- **To create and edit a new page** - right click on the Pages heading in Project Explorer, then select New Page. Provide a name for the page and click OK. Then double click the newly created page.

The Page Editor Window

The Page Editor window is the heart of the configuration software and is the primary window in which you will work. The Page Editor window provides you with access to the tools and operations used to add/edit/delete controls and graphics.

The Page Editor and its elements are shown below. Click an element title or area on the graphic to view its description.
Customizing the Page Editor

Online functions, such as screen settings and referenced libraries can be modified using Page Component Properties.

**Tip:** **Right-click on everything.** You can’t do any damage with the right mouse button because it’s designed only to show a context menu (a list of options appropriate for the selected object). One of the options is usually Properties, which gives you access to lots of settings and information.

**Tip:** **Your mouse tells you what’s happening.** Look closely at your mouse cursor while you’re moving it around - it’s not always an arrow. For example, when you’re dragging a component, ePro Canvas gives you a clue as to what’s going to happen when you drop it depending on what’s currently underneath the cursor.

**Tip:** **Double-click everywhere.** There are many functions or property windows that open to help you complete your goals. Experiment, you won’t damage anything.

**Tip:** **Drag-and-Drop items.** Try left-clicking a component, with the left button held down move the component to where you want it. The cursor will let you know if that function can be done.

**Tip:** Many of the functions can be performed many different ways. You can use the **Menu bar** or the **Tool bar**, or **Right-click** the mouse, or use **short cut keys**. Experiment to see which method will work best for you.

**Tip:** You can resize any of the windows in ePro Canvas with your mouse. Move the mouse cursor around the edges of the windows until one of these symbols appears; \[\text{\textrightarrow}, \text{\textleftarrow}, \text{\textuparrow}, \text{\textdownarrow}, \text{\textleftarrow}\text{\textrightarrow}, \text{\textuparrow}\text{\textdownarrow}\], or \[\text{\textleftarrow}\text{\textrightarrow}, \text{\textuparrow}\text{\textdownarrow}\], then **left-click and hold** the mouse button. Drag the window to the desired size and release the left mouse button.

Press the **Back** button (toolbar of your browser) to return to the previous page.

Learn more about the Title Bar
What is a Page?

A configuration page contains visual tools or "controls" which will serve as an operator's control panel. Below are a few aspects of a page.

- **Page Development** - The Page Editor window allows you to create pages, then add and configure controls and properties.
- **Online Page** - When transferred to an online unit, the page allows an operator to monitor and/or control a process from the unit.
- **Page Contents** - Below are examples of the page controls and the devices that they replace.

<table>
<thead>
<tr>
<th>Page Control Type</th>
<th>Conventional Devices Replaced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator/Buttons</td>
<td>Lamps, pushbuttons</td>
</tr>
<tr>
<td>Readout</td>
<td>Numeric displays, Led readouts, thumbwheels</td>
</tr>
<tr>
<td>Bar</td>
<td>Dial, faceplate</td>
</tr>
<tr>
<td>Text</td>
<td>Message display</td>
</tr>
</tbody>
</table>

Title Bar

The **Title Bar** is located along the top of a page window and contains the following items:

- **Application Name** - OIPageEditor.
- **Saved Page Name** - Your saved page name is displayed here. "Page 1" is the default name given to the first page created.
- **Window Control** - Minimize, Maximize/Restore Down, Close.

Customizing the Page Editor

**Note:** You can move the Page Editor window by dragging the Title bar.

Press the **Back** button (toolbar of your browser) to return to the previous page.

Menu Bar

The **Menu Bar** located under the title bar contains the **File, Edit, View, Layout, Draw** and **Help** menus. Each menu item displays a list of commands. Depending on the component selected in the views below the menu bar, some commands will be highlighted and others grayed out. Only highlighted commands can be executed for the selected item.
Placing the mouse cursor over any of the commands will display information in the status bar at the bottom of the screen.

**Tip:** To the right of the commands are **keyboard short cut keys.** i.e. Ctrl+C = Copy

**File**

- **Save** - save the active page to its current name and directory.
  - When you save a page for the first time, the Page Editor displays the Save As window so that you can name the page.
  - Other Access: CTRL+S; Save button on the Standard toolbar.
- **Exit** - end your Page Editor session.
  - The Page Editor prompts you to save pages with unsaved changes.
  - Other Access: ALT+F4; Close command on the application Control menu.

**Edit**

- **Undo** - reverse the last operation that you performed. For example, if you cut an object, Undo makes it re-appear.
  - There are several levels of undo (the exact number depends upon your memory resources).
  - Other Access: CTRL+Z; ALT-BACKSPACE; Undo button on the Standard toolbar.
- **Redo** - reverse the effect of the last Undo command.
  - There are several levels of redo (the exact number depends upon your memory resources).
  - Other Access: Redo button on the Standard toolbar.
- **Cut** - cut a selected object(s) from the window and place the object(s) on the Windows clipboard.
  - This command is unavailable if there is no item currently selected.
  - Cutting data to the clipboard replaces the contents previously stored there.
  - Other Access: CTRL+X; Cut button on the Standard toolbar.
- **Copy** - copy a selected object(s) to the Windows clipboard.
  - This command is unavailable if there is no item currently selected.
  - Cutting data to the clipboard replaces the contents previously stored there.
  - Other Access: CTRL+C; Copy button on the Standard toolbar.
- **Paste** - paste a selected object(s) from the Windows clipboard into the window.
  - This command is unavailable if the clipboard is empty.
  - Other Access: CTRL+V; Paste button on the Standard toolbar.
- **Delete** - delete a selected object(s) from the window.
  - This function does not place the selected object(s) in the Windows clipboard.
  - Other Access: Delete button on the Standard toolbar.

**View**

- **Toolbars** - show or hide the Standard and Layout toolbars.
• These toolbars include buttons for some of the most common commands found in the Page Editor, such as File/Save.

• When the Standard or Layout toolbars are visible, a check mark appears beside its menu command.

Status Bar - show or hide the Status bar.

• When the Status bar is visible, a check mark appears beside its menu command.

Grid - turn the grid on and off.

• The grid is the dotted and dashed lines which show the work area and help in aligning items on the page.

• Grid lines do not appear online.

• Upon entering a page, the grid is "on".

• Other Access: CTRL+G; Toggle Grid button on the Layout toolbar.

Snap Points - toggle snap points on and off.

• When "on", the snap points force the selected item to be placed in line with the grid lines.

• Upon entering the page, the snap points are "off".

• Other Access: View Snap Points button on the Layout toolbar.

Control Bar - show or hide the component toolbox.

• Other Access: Component Toolbox button on the Standard toolbar.

Size - view the page in different sizes.

• Available settings:
  • 320x240
  • 640x480
  • 800x600
  • 1024x768

Layout

Align Objects - align objects on a page in a specific fashion.

• Available options:
  • Align Left
  • Align Center
  • Align Right
  • Align Top
  • Align Middle
  • Align Bottom

• Other Access: Align Edges button on the Layout toolbar.

Space Evenly - choose spacing options for the objects on a page.

• Available options:
  • Space Across
  • Space Down
Center in View - choose centering options for the objects on a page.

Available options:
- Center Vertically
- Center Horizontally

Other Access: Center in View button on the Layout toolbar.

Make Same Size - make the objects on a page the same size.

You can select from the following options:
- Make Same Width
- Make Same Height
- Make Same Size

Other Access: Make Same Size button on the Layout toolbar.

Properties - view and edit an object’s properties, from the Property Editor window.

Other Access: Property Sheet button on the Layout toolbar.

Grid Settings - set the specifics of the grid size and location, and snap settings.

Draw

Order - arrange the objects on a page in a specific order.

Available options:
- Bring to Front
- Send to Back
- Bring Forward
- Send Backward

Other Access: To Front or Back button on the Layout toolbar.

Zoom - magnify, or de-magnify the view of a page.

Available options:
- Zoom In
- Zoom Out
- Zoom 1:1

Other Access: Zoom in or Out button.

Group - assemble objects and move them as a unit around a page, or disassemble them and move them individually around a page.

Available options:
- Group
- Ungroup
- Regroup

Other Access: Group, Ungroup, and Regroup buttons on the Layout toolbar.

Rotate - rotate the objects on a page.
Getting Started

- Available options:
  - Free Rotate
  - Rotate Left
  - Rotate Right
- Some objects such as lines, rectangles, ellipses, and polygons can be freely rotated. Other components, such as fixed readouts, cannot be rotated.
- Other Access: Rotation field in the Property Editor; Free Rotate, Rotate Left, and Rotate Right buttons on the Layout toolbar.

Help

Help Topics - view the Page Editor online Help.
About OI Page Editor - display the About Page Editor window and view system information.
- Other Access: About button on the Standard toolbar.

Customizing the Page Editor

NEXT> Proceed to the Standard Toolbar

Standard Toolbar

The Standard Toolbar located under the menu bar contains shortcuts to common page commands. Depending on the component selected in the views below the tool bar, some commands will be highlighted and others grayed out. Only the highlighted commands can be executed on the selected item.

Tip: Placing the mouse cursor over any of the buttons will display information in the form of a flyover tip and information will also be displayed in the status bar at the bottom of the screen.

Tip: To display or hide the tool bar, select the View menu and select Toolbar.

Save

- Save the active page to its current name and directory.
  - When you save a document for the first time, the Page Editor displays the Save As window so that you can name the page.
  - Other Access: CTRL+S; Save command under the File menu.

Delete

- Delete a selected object(s) from the window.
• This function does not place the selected object(s) in the Windows clipboard.
• Other Access: Delete command under the Edit menu.

Cut

• Cut a selected object(s) from the window and place the object(s) on the Windows clipboard.
  • This command is unavailable if there is no data currently selected.
  • Cutting data to the clipboard replaces the contents previously stored there.
  • Other Access: CTRL+X, or the Cut command under the Edit menu.

Copy

• Copy a selected object(s) to the Windows clipboard.
  • This command is unavailable if there is no data currently selected.
  • Cutting data to the clipboard replaces the contents previously stored there.
  • Other Access: CTRL+C, or the Copy command under the Edit menu.

Paste

• Paste a selected object(s) from the Windows clipboard into the window.
  • This command is unavailable if the clipboard is empty.
  • Other Access: CTRL+V or the Paste command under the Edit menu.

Undo

• Reverse the last operation that you performed. For example, if you cut an object, Undo makes it re-appear.
  • There are several levels of undo (the exact number depends upon your memory resources).
  • Other Access: CTRL+Z or ALT-BACKSPACE or the Undo command under the Edit menu.

Redo

• Reverse the effect of the last undo command.
  • There are several levels of redo (the exact number depends upon your memory resources).
  • Other Access: Redo command under the Edit menu.

Control Bar

• Show or hide the Component Toolbox.
  • Other Access: Component Toolbox command under the View menu to show or hide the Component Toolbox.

Help
Customizing the Page Editor

**NEXT> Proceed to the Layout Toolbar**

**Layout Toolbar**

The **Layout Toolbar** contains buttons that provide easy access (shortcuts) to the common layout specific commands. Depending on the component selected in the views below the tool bar, some commands will be highlighted and others grayed out. Only the highlighted commands can be executed on the selected item.

**Tip:** Placing the mouse cursor over any of the buttons will display information in the form of a flyover tip and information will also be displayed in the status bar at the bottom of the screen.

**Tip:** To display or hide the tool bar, select the **View** menu and select **Layout Bar**.

**Property Sheet**

- View and edit the properties for the component that you have selected.
  - Other Access: Properties command under the Layout menu.

**Toggle Grid**

- Turn the grid on and off.
  - Other Access: CTRL+G; Grid command under the View menu.

**View Snap Points**

- Toggle to snap points on and off.
  - Other Access: Snap Points command under the View menu.

**Zoom In or Out**

- Magnify, or de-magnify the view of a page.
  - Available options:
    - Zoom In
    - Zoom Out
    - Zoom 1:1
Free Rotate

- Rotate an object on a page to a degree of angle that you specify.
  - A popup box displays when you rotate an object, specifying the angle of the rotation.
  - Some objects such as lines, rectangles, ellipses, and polygons can be freely rotated. Other components, such as fixed readouts, cannot be rotated.
  - Other Access: Rotation field in the Property Editor; Rotate/Free Rotate command under the Draw menu.

Rotate Left

- Rotate an object counter-clockwise 90 degrees.
  - Other Access: Rotation field in the Property Editor; Rotate/Rotate Left command under the Draw menu.

Rotate Right

- Rotate an object clockwise 90 degrees.
  - Other Access: Rotation field in the Property Editor; Rotate/Rotate Right command under the Draw menu.

Group

- Assemble objects and move them as a unit around a page.
  - Other Access: Group/ Group command under the Draw menu.

Ungroup

- Disassemble objects and move them individually around a page.
  - Other Access: Group/Ungroup command under the Draw menu.

Regroup

- Reassemble objects and move them as a unit around a page.
  - Other Access: Group/Regroup command under the Draw menu.

Align Edges

- Align objects on a page in a specific fashion.
  - Available options:
    - Align Left
    - Align Center
    - Align Right
    - Align Top
    - Align Middle
• Align Bottom
• Other Access: Align Objects command under the Layout menu.

Center in View

• Choose centering options for the objects on a page.
  • Available options:
    • Center Vertically
    • Center Horizontally
  • Other Access: Center in View command under the Layout menu.

Space

• Choose spacing options for the objects on a page.
  • Available options:
    • Space Across
    • Space Down
  • Other Access: Space Evenly command under the Layout menu.

Make Same Size

• Make the objects on a page the same size.
  • Available options:
    • Make Same Width
    • Make Same Height
    • Make Same Size
  • Other Access: Make Same Size command under on the Layout menu.

To Front or Back

• Arrange the objects on a page in a specific order. You can select from the following options:
  • Available options:
    • Bring to Front
    • Send to Back
    • Bring Forward
    • Send Backward
  • Other Access: Order command on the Draw menu.

Customizing the Page Editor

NEXT> Proceed to the Control Bar
Control Bar

The Control Bar provides the ability to easily add controls to a page. The controls are sorted alphabetically and are represented by a specific icon.

Controls can be added to the project by either double-clicking the control's icon or by "drag-and-drop". Double-clicking the control will generate a new control in the upper left corner of the Page Frame. When you use "drag-and-drop" the control can be placed anywhere within the page frame boundaries.

Drag-and-drop functionality provides shortcut methods for performing common tasks.

**To drag and drop:**
1. Select (highlight) the item that you want to drag and drop. (To select an item, point and click on it.)
2. Press and hold the left mouse button while you drag the item to its destination.
3. Release the mouse button to drop the item in place.

Polygons: Adding a Polygon is an exception. A Polygon is placed on the page by using the drag-and-drop method only, and the position at which it is dropped becomes the first point. Successive points are placed by moving to another location and clicking. Double-clicking or placing a point exactly over the first point (i.e.: closing the polygon) will complete the polygon creation.

When you drag a control around in an area of the window in which the component cannot be dropped, the mouse pointer looks like this 🏗️. Continue moving the mouse until the pointer changes to an arrow 🛠️, which indicates the control is able to be dropped.

**Tip:** To display or hide the Control bar, select the View menu and select Control bar.

**Tip:** To change the Control bar icons from large to small by "right clicking" in the Control bar, and selecting Small Icons

**Note:** Depending on the software package that you have purchased, you may have all of the controls that appear above in the Control Bar, or a subset of those control styles.

More information on Controls
Customizing the Page Editor

NEXT> Proceed to the Page Frame view.

Page Frame

The Page Frame is the development area and contains the configuration's visual controls. In the Page frame, you can add, edit, and delete controls, as well as arrange the controls on the page.

While editing the page, the following may be useful.

What is a Page?

Planning your Page
Page Properties
Customizing the Page Editor
What are Controls?
Working with Controls
Control Example

More information on Controls

Creating a new page

A new page, "Page 1" is created for you when you start the Canvas software. Other ways to create a new page are:

- **File** menu, select **New**
- **Left-click** the New icon in the toolbar
- Use the short cut keys **Ctrl+N**

When a new page is created it's default name is Page X, where X is the next available page number. It can be renamed anytime later.

The page's saved name will appear in the title bar.

Renaming a page

You can change the name of a page at any time, to do this;

In the Page Editor:

- From the **Toolbar**, select `Name`, change the **Name field**, press **OK**.
- Using the **Layout Menu** drop down list, select **Properties**, change the **Name field**, press **OK**.
- **Right-click** on the Page Frame, select **Properties**, change the **Name field**, press **OK**.

In Project Explorer:

- **Right-click** on the Page Name, select **Properties**, change the **Name field**, press **OK**.
- **Select** the page name, press **Alt+Enter** or press **F2**, change the **Name field**, press **OK**.
Saving a page

Save a page by:

- **File** menu, select **Save**
- **Left-click** the ![Save icon](image) in the toolbar
- Use the short cut keys **Ctrl+S** (save)

The page will be saved to the project.

Note: There is not a "Save As" option for saving the page. To rename a page, follow the "Renaming a page" link.

Opening a page

To open an existing page:

- **Double-click** the page name in the Project Explorer window.

Managing multiple pages

ePro Canvas allows editing more than one page at a time. Two pages can be open so that controls can be cut, copied, and pasted between the two pages. As you move controls back and forth watch the title bar because it will help keep you on track since each title bar contains its own page name.

NEXT> Proceed to the Status Bar view.

**Status Bar**

The **Status Bar** is located at the bottom of the window and displays messages and information about the current status of the application.

![Status Bar](image)

The left area of the status bar displays useful actions of menu items when you use the arrow keys or mouse to navigate through menus and toolbars. The right area of the status bar indicates the zoom level currently selected for the page.

- **Progress information** - This information is displayed on the left side of the status bar when you are loading, saving, and pasting an item.
- **Zoom Level** - The zoom information for the window is displayed on the right side of the status bar. Possible settings are:
  - 50%
  - 100%
  - 200%
  - 300%
  - 400%
Getting Started

Tip: To zoom in or out, select Draw from the menu, then Zoom In (to increase the size of objects) or Zoom Out (to decrease the size of objects).

Note: To display or hide the status bar, click the View menu, then click Status bar.

Customizing the Page Editor

Customizing the Page Editor

The Page Editor is designed with some customization capabilities. The following are intended to simplify page editing.

Move Menu Bars and Toolbars

By default, all menu bars and toolbars are displayed across the top of the window. All menu bars and toolbars are dockable, which means that they can be moved to any location in the window.

To move a menu bar or toolbar:

1. Click the move handle located at the far left of the menu bar or toolbar.
2. Press and hold the mouse button while you drag the menu bar or toolbar to a suitable location in your window.
3. Release the mouse button to drop the menu bar or toolbar to its new location. It will remain in this new place until you move it again or close it.

Customizing the Control Bar

Moving the Control Bar

The Control bar’s default location is the left-hand side of the Page Editor window. You can move the Control bar by clicking the move handle at the top of the bar and dragging it to a new location.

Resizing the Control Bar

You can resize the Control bar by positioning the mouse pointer over the Control bar border until the pointer changes to a double-headed arrow. Move the double-headed arrow to the left or right to resize the Control bar.

Creating a Floating Control Bar

You can create a floating Control bar by double-clicking the move handle at the top of the Control bar. Once you do this, the Control bar becomes detached from the Page Editor window and becomes its own independent window, complete with a title bar at the top.

Tip: To dock the Control bar, double-click the floating bar’s title bar.

Viewing Small/Large Control Icons in the Control Bar

You can view either large or small icons in the Control bar. To do this, right-click in the Control bar and select Large Icons or Small Icons.

Resizing a Floating Control Bar

When you select the floating Control bar, sizing handles appear at the corners and along the edges of the window. You can resize the window by dragging its sizing handles.
Modifying Grid and Snap Settings

When you are placing or arranging objects on a page, you can use the alignment grid for more precise positioning. When the grid is turned on, objects appear to "snap to" the dotted lines of the grid as if magnetized. You can turn this "snap to grid" feature on and off, as well as change the size of the grid cells.

In addition to defining a grid size, and whether to show or snap to the grid, a guidelines margin can be defined around the perimeter of the view, such that objects cannot be moved outside the guidelines margin.

The Grid Settings window allows you to configure grid snapping and margin/guidelines settings.

Turning the Snap to Grid On and Off

To turn the snap to grid on and off for the currently active view (in edit mode), complete one of the following actions:

- From the Layout toolbar, click the Toggle Grid button
- From the Layout menu, click the Grid Settings command

Result: The Grid Settings window appears.

Changing the Size of the Layout Grid

To change to size of the layout grid, complete the following steps:

1. From the Layout menu, click the Grid Settings command.
   Result: The Grid Settings window appears.

2. In the Spacing box, type a different width and height (in pixels) for the cells in the grid.
   Note: The default spacing for the grid is 10 pixels.

3. Click OK.

Zooming In and Out of a Page

Using the Zoom In and Out Toolbar

To zoom in and out of a page, complete the following steps:

1. Right-click the down arrow next to the Zoom In and Out toolbar.
   Result: A drop-down menu appears.

2. From the drop-down menu, click one of the following options:
   - Zoom In, to see a close-up view of the page
   - Zoom Out, to see more of the page at a reduced size
   - Zoom 1:1, to view the page at 100 percent.

Using the Zoom Menu Command

To zoom in and out of a page, complete the following:

1. From the Draw menu, right-click the down arrow next to the Zoom command and click one of the following options:
   - Zoom In, to see a close-up view of the page
   - Zoom Out, to see more of the page at a reduced size
   - Zoom 1:1, to view the page at 100 percent.

Open/close Toolbars and Component Views

By default, all toolbars are open and displayed on the window. You can open and close these toolbars whenever necessary.

To open a toolbar:
From the View menu, select a specific toolbar to open (open toolbars display a check mark on the left).

**To close a toolbar:**
From the View menu, select a specific toolbar to close (closed toolbars do not display a check mark on the left).

Online functions, such as screen settings and referenced libraries can be modified using Page Component Properties.

The following links provide related assistance.

**The Page Editor**

**Working with Controls**

**Working with Properties**

**Page Component Properties**

Similar to all components, Pages contain properties. Page properties can be modified by:

- right-clicking the name of the page in the Project Explorer, then selecting Properties
- right-clicking the background of an open page, then selecting Properties.

When the property editor opens, the controls can be edited by selecting the Property from the Tab. Page properties are listed below.

**General tab**

- **Name** property - Provide a unique name for your page.
- **Description** property - Add a meaningful note about the page (optional).
- **Standard Navigation** property - Select a location for the page selection menu.
- **Page Enabled Expression** property - This is an expression that allows you to select when this page is visible or not. Any expression that evaluates to a 1 or true will allow the page to be visible. The default value is 1. You can create any expression to perform any function you need. *i.e.* create a visibility expression to make the page visible only when in maintenance mode.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.
- **Screen Size** property - Use the drop down list button to select the screen resolution for the page you created. This can be changes at any time and it can also be changed while using the page editor.
- **Background Color** property - Use the ellipses to select an existing color or create a custom color.
- **Watermark** property - Choose an image to be a background image. The easiest way is to have the desired image in the image library then you would be able to select it by drilling down into the image library. You also can type the file name and path directly into the field. If you use this method make sure you place " before and after" the text.
- **Display** property - This property will only have any effect if you have chosen to use a watermark. User the drop down list button to choose stretch or tile.
  - **Tile** - will repeat the watermark image both horizontally and vertically across the screen.
- Stretch - will stretch the watermark image horizontally and vertically to fit the screen size.

- **Intensity** property - This property will only have any effect if you have chosen to use a watermark. User the drop down list button to choose the desired background intensity level of light, normal, or dark.

**Master Pages Properties Tab**

**Note:** This tab contains a table which allows multiple entries

- **Page** property - The name of the Master page(s) to be displayed concurrently with the current page being edited.

- **Draw Order**
  - **Front** - will place the Master page on top of the current page.
  - **Back** - will place the Master page behind the current page.

For more details, see **Master Page**.

**Page editor reference libraries tab**

- Page editor reference libraries property - Set up these libraries in the same manner as you would under the configurations - libraries tab. The difference is that by placing libraries here you will be able to debug certain controls from within the page editor. Link the libraries that you will use to create the page you are working on. More is discussed under the page editor help.

**Note:** Changing a client adapter's name will automatically change the name of the client everywhere it is used in the project. This makes it easy to update all your units that might be using the client adapter. Any units where you do not want this change to happen will need to be edited manually.

**Planning your Page**

When creating a page and/or configuration, it will be helpful to keep the following in mind:

- What size of a unit display will the page and configuration be transferred to? The smaller unit, the fewer controls can be placed on each page, so a well planned page access scheme should be followed to reduce clutter.

- How should pages be accessed? Possible layouts:
  - Buttons on each page to access all other pages. This is most feasible when there are few pages, since there will need to be a button to access every page from each page.
  - A menu with buttons to access all pages, or groupings of pages. A button will be needed to access the menu page from each page. This may be convenient for configurations with many pages.
  - The control system can automatically call a page when the operator needs to act on that page's functions.

- Color schemes. The following should be considered when assigning colors.
  - Industry requirements for colors (ie: Red=Fault, Yellow=Caution)
  - Plant conventions (ie: Red=Off, Green=Running)
  - Color blind operators.

- Importance of page response time. The more controls that are on a page, the slower it will update. In speed critical applications it may be necessary to limit the controls on certain pages.

- Will multiple languages be utilized?
- Will the same configuration be used for different projects. If so, planning at the beginning will save future time, by considering "re-usability" of pages and libraries.
- If some of the pages have the same controls in the same locations (titles, buttons, etc.) a Master Page should be utilized.
- If the layout of some pages contain the same controls, but different data, Indexed Lists should be considered.

Online functions, such as screen settings and referenced libraries can be modified using **Page Component Properties**.
Controls

A configuration page contains visual tools or **Controls** that allow an operator to monitor and/or control a specific event or set of events from a unit. The page is defined by adding, modifying and deleting properties via its Property Editor window.

What are Controls?

Working With Controls

Control Example

A page will consist of controls from the list below.

**Note:** Depending on the software package that you have purchased, you may have all of the controls shown below, or a subset of those controls.

<table>
<thead>
<tr>
<th>Arc</th>
<th>Indicator Template</th>
<th>Readout Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar</td>
<td>Led</td>
<td>Rectangle</td>
</tr>
<tr>
<td>Bar Template</td>
<td>Legend</td>
<td>Rectangular Button</td>
</tr>
<tr>
<td>Clock</td>
<td>Line</td>
<td>Scale</td>
</tr>
<tr>
<td>Ellipse</td>
<td>Plate</td>
<td>Text</td>
</tr>
<tr>
<td>Image</td>
<td>Polygon</td>
<td>Touch Area</td>
</tr>
<tr>
<td>Indicator</td>
<td>Readout</td>
<td>Trend Template</td>
</tr>
</tbody>
</table>
The following "Classic" controls resemble functions/templates from earlier product versions.

<table>
<thead>
<tr>
<th>VS Bar</th>
<th>VS Control Button</th>
<th>VS Graphic</th>
</tr>
</thead>
<tbody>
<tr>
<td>VS Indicator</td>
<td>VS Message</td>
<td>VS Readout</td>
</tr>
<tr>
<td>Fixed Bar</td>
<td>Fixed Bar Trend</td>
<td>Fixed Indicator</td>
</tr>
<tr>
<td>Fixed Line</td>
<td>Fixed Message</td>
<td>Fixed Readout</td>
</tr>
<tr>
<td>Fixed Table</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: You can also edit Page Controls and Properties from the Project Explorer Window (ie: without opening the Page editor). See below.

In the figure below, Page 1 is highlighted, displaying the controls on that page. Assume the rectangular button has been configured as a goto main menu button and that we want the button on all of the pages. Right-click the rectangular button, select copy, then right-click each of the pages in the pages folder, right-click and select paste. The rectangular button will be copied to each of the pages that you selected. You could have copied multiple controls and performed the same operation.

Tip: To edit control properties from this view, right-click the control and select Properties.

Component Templates
Component Templates are project components that have been saved as templates for reuse within the project. Component Templates may be created by the developer to reduce development time and provide a consistent look or style to a configuration. Any project component can be saved as a template by right-clicking on the component and selecting Create Component Template and any single page component can be saved as a template by right-clicking on it and selecting Create Template as illustrated below.
When a component is saved as a template all configured properties of that component are saved. To create a new project component from a saved template right-click on the component group, i.e. Unit, Client, Configuration, Page, etc., and highlighting Create From Template, then choosing the desired template from the resulting list of Component Templates as illustrated below.
In the Page Editor you can use saved page components by clicking on the Component Template category in the controls bar. New components created from a component template will have all initial properties set to that of the saved template. This can speed up development by allowing the user to establish the default settings of new components added to the project rather than accepting the editor defaults and having to change each new components properties to match the desired standards of the developer. Because page controls can also be saved as Component Templates the developer can take standard Canvas controls and customize them once and then use the customized controls to reduce development time and create a consistent look and feel to the project’s pages.

Some Component Templates are included in the default Project Profile to speed up initial development. They are shown below:
Because Component Templates are saved with a project just like any other project components they will not automatically be added with a New blank project or New prepackaged project. However, like all other project components they may be copied from an existing project to a new project by opening both projects in separate windows and using copy and paste, or drag and drop, to copy between the two projects.

Changing the Default Prepackaged Project

Master Page

The purpose of Master Pages is to allow you to create one or more sets of objects that can be used on multiple pages of a configuration. This enables you to more easily develop a common look and feel to a configuration, create a consistent page change methodology, and manage information and control functions that are common to many, if not all pages. The result is that there are fewer total objects in a configuration since objects that appear on Master Pages are only defined once in the editor and online. This results in .UCF files that are smaller and utilize less system memory online. It also makes it simpler for you to make changes to common page controls, since you only need to change it once on a Master Page being utilized by other pages.

Master Pages are defined in the Page Properties of every page. You can designate either no Master Page or up to three Master Pages for each page. Since there is no difference between a Master Page and a normal page, any page can be used as a Master Page for any other page and a Master Page may contain any components that can be placed on any other page, both static and dynamic. Master Pages must be added to a Configuration’s “Pages” tab like any other page and they will be accessible just like any other page in a configuration. If you do not wish to allow an online user to be able to change pages to a Master Page you should set the Page Enabled Expression for a Master Page to zero (0).

When you assign Master Page(s) to a page you also choose the draw order of Master Page components relative to the page. Each Master page’s components can be set to draw in Front (on top) or in Back (behind) of the page objects as shown in the following example:
For example if the following page were used as a Master Page for other pages, online each page would look just like any other page but the shared components would be identical on each page. (Note: this example also uses an Indexed List to change the text in the Title bar at the top of each page based on the Page ID Number)
Master Page Example
Online Example 1
Online Example 2

Indexed Lists

Indexed Lists allow you to substitute properties of a configuration component dynamically based on the value of an index expression. This means that a page control or action can change its indication or control function online. The purpose of index lists is to reduce the number of pages needed in a configuration by allowing a single page to represent multiple unit operations or multiple diagnostic screens without changing pages by simply changing a single value that provides an index into one or more tags or expressions in a series of Indexed Lists. Simply put, indexed lists allow page components to reference lists of addresses or tags based on the value of an Index. For example, a readout value can show different PLC addresses based on a PLC register that acts as an index into a list of those PLC addresses, and an indicator template may show states of a series of devices based on that same register value. Non-dynamic properties such as template titles and text controls can also show lists of string values based on an index.

An example helps to illustrate the use of Indexed Lists. The following pictures show a process that has three different unit operations called AGI Mix tanks. All tanks are fundamentally similar in terms of process inputs, outputs, status, and control functions.
Using Indexed Lists a single page may be created in ePro Canvas that represents all three Mix Tanks. A total of 24 indexed lists supports the single page’s 10 dynamic status attributes 7 control functions (5 pushbuttons and 2 numeric entry fields) and seven text fields, including the page title and template legends. In addition, if the scales of the bar graphs needed to be dynamic because of different pressure or temperature ranges from tank to tank, they could also be changed by Indexed Lists. The two up/down pushbuttons next to the page title increment and decrement a register that goes from 0 to 1 to 2 and is the index value for all 24 indexed lists. That register is also displayed as a readout value (‘register’ + 1) in the title area of the page to indicate the Mix Tank currently being displayed and controlled.

Another example of the use of Indexed Lists is in conjunction with Master Pages. A Master Page may be created where some of the page properties, such as page title, are driven by Indexed Lists whose index is the page ID Number property, referenced online by the System Client tag CurrentPageId.

The benefits of Indexed Lists are a reduction in the number of pages, and number of objects in the configuration, which saves memory, improves performance, and simplifies configuration management by reducing the number of copies of pages and objects with different address/tag references and expressions.

Creating and Using Indexed Lists

Indexed List entries are stored in Indexed List libraries and the library needs to be linked to the Configuration like all other Canvas libraries such as Media, Color, and Action libraries. The properties of an Indexed List are shown below:
Each Indexed List has an Indexed Expression that controls the Index List Entry value online. In the above example the tag ‘Vessnum’ in device PLC1 will be used to determine which index entry on the List tab is displayed at runtime.

The items in the List tab need to define the complete property value to be evaluated at runtime. That means that if a tag is part of an expression property, such as a conditional expression in an indicator template (Eg. ‘tag1’ & ! ‘tag2’), or a scaled value in a readout (Eg. ‘N7:154’ * 9.5 + 32) the entire expression must be placed in the Index List.

To use an Indexed List when editing a page control’s property dialog, simply select the Indexed List entry from the Indexed List Library in the pulldown list or from the Expression Editor window. An example is shown below for the readout template showing V1FlowRate, V2FlowRate or V3FlowRate of the previous example:
Where the Legend Title also comes from an Indexed List of text strings showing “Vessel 1 Flow Rate”, “Vessel 2 Flow Rate”, and “Vessel 3 Flow Rate”. Virtually any parameter may come from an Indexed List including Visibility Expressions, Decimal Places, Data Entry Target Expressions, Button Entry Labels and Actions, Trend Template and Bar Template Max Min Calibrations, Indicator State Expressions, Media, and Color, as well as Action properties. Properties that do not support Indexed Lists are those that are restricted to pre-populated lists in the editor, such as Operator Input Type, Indicator State Evaluation (type), and Font.

**Changing Pages Online**

**Page Changes Using Actions**

The primary method for changing pages is through an Action. There are five Actions that are built into the default Action Library named ActionSystem that can be used to control page changes. Three of them are based on the page name and the row number as it appears in the Configuration Properties Page tab as shown below.
The action named ActionGetPage generates a selectable list of all configuration pages by name. The list appears online at the top of the current page when the action is initiated. When a user touches or clicks on a page name in the list, the system changes pages to that selected page on the release or break of the touchscreen.

The action named ActionPageUp will change pages to the page named in the next row from the current page. In the example above, if the current page is the Weld Robot Controls and the ActionPageUp executes, the system will go to the Inspection Results page. The action will wrap-around so that if the current page is the last page in the configuration, it will go to the first page.

The action named ActionPageDown will change pages to the page named in the previous row from the current page. In the example above, if the current page is the Weld Robot Controls and the ActionPageDown executes, the system will go to the Process Overview page. The action will wrap-around so that if the current page is the first page in the configuration, it will go to the last page.

The other two default page change Actions are ActionHomePage and ActionPreviousPage. The first will change pages to the page defined as the Home Page in the Configuration Properties General Tab as shown below:
In the above example the page named Menu is defined as the Home Page of the Welding Line 1 configuration. Any time ActionHomePage triggers in that configuration the system will change pages to Menu. The action named ActionPreviousPage will always change pages to the page that was displayed prior to the currently displayed page. If a button that calls the ActionPreviousPage is placed on all pages in a configuration, the user will be able to go back and forth between any two pages using that button.

User defined Goto Page Actions

In addition to the built-in system actions for page change, the user may create Goto Page actions that will change pages to a specific page by name when executed. The following is an example of a Goto Page action that when executed will change to the page name Process Faults:

Changing Pages by ID Number

Another method of changing pages online is through the Page ID Number. The page ID Number property on the Page Properties General tab allows the user to assign a number to a page as shown below:
By default all pages are assigned a Page ID number of zero. You can change this number to any number you wish. In the following example a configuration has six pages with the following Page ID number assignments:

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Id Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>0</td>
</tr>
<tr>
<td>Process Overview</td>
<td>10</td>
</tr>
<tr>
<td>Weld Robot Controls</td>
<td>15</td>
</tr>
<tr>
<td>Inspection Results</td>
<td>33</td>
</tr>
<tr>
<td>Machine Diagnostics</td>
<td>22</td>
</tr>
<tr>
<td>Process Faults</td>
<td>14</td>
</tr>
</tbody>
</table>

In the default tag library TagSystem there is a System tag CurrentPageID that is automatically updated by the online system with the ID Number of the currently displayed page. If no changes are made to the default ID Number of the pages in a configuration, it will always read zero. But in the example shown above, when the configuration is running online and the current page is Weld Robot Controls, then the value in CurrentPageID will be 15.

There are several ways to change pages by Page ID Number. The first way is by using a Rectangular Button control on a page where the Type property in the General tab is set to Page Change and the target address is either a constant or a tag containing the ID Number of the page you wish to go to. In the Rectangular Button properties example shown below, pressing the button online would change pages to the page with ID Number of 33, the Inspection Results page of our example.
Of course the same result could be obtained by creating a Goto Page action that specifies the Inspection Results page by name, and then changing the button’s Type property to Trigger Action and changing the Break Action to call the Goto Page action as shown below:

Another way to change pages by Page ID Number is to write to the system tag CurrentPageID. You could do this with a numeric entry from a page control or by creating an Assignment Action set to Conditional Passthru where a PLC tag change gets written directly to CurrentPageID. When CurrentPageID is written to the system will change pages to the page with the corresponding Page ID Number. To work properly it
is required that the user make sure that the Page ID Number is unique for all pages in a configuration. The following is an example of a numeric operator entry writing to CurrentPageID:

Next is an example of a PLC tag called ‘remote_page_change’ writing to the CurrentPageID through an assignment action with Trigger Type Conditional and Condition Type Passthru. It is important to note that in order to have this action execute online it needs to be added to the Configuration Properties Actions tab:
Warning: Do NOT use Remote Page Changes in safety critical applications. If the operator has touched a button when the remote page change occurs, the page will change, however the break action resulting from the operator's release of the button will NOT occur. To avoid this situation, an alternate method is to allow the PLC to propose a page for the operator to call. This can be done using visibility to show a flashing button when the proposed PLC page is different from the current page (eg. the Visibility Expression for the button would be RemotePageId != CurrentPageId). When the button is then visible and pressed, an action list can be executed to call the PLC page (RemotePageId) and update the CurrentPageId.

Controls

What are Controls?

The most basic job of an online ePro unit is to replace the functions of traditional hard-wired operator unit devices such as pushbuttons, lamps and message displays. Controls are visual tools, placed on a page, which replace these hard-wired devices.

These controls are developed on a configuration page, and ultimately will allow an operator to monitor and/or control a process from a unit.

Controls can have static and/or dynamic parts. A static property is one that does not change online. A non-changing title string and border rectangle are examples of static controls. Dynamic properties can change during Runtime. A numeric readout or status indication are examples of controls with dynamic properties.

Additional attributes and functionality can be assigned to a control using the various libraries within the software.

Control Composition

The controls on the Control Bar have been created with re-usability of components in mind. Complex controls are combinations of simpler controls. The characteristics of the simpler controls become part of the complex control.

For more details on the composition of controls, refer to the Control Example.
Base Controls

Starting at the fundamental level, some controls are basic building blocks, or primitives. These provide the base in which all controls are built. The following controls can be used as stand-alone objects on a page.

- **Arc**
- **Line**
- **Scale**
- **Ellipse**
- **Polygon**
- **Text**
- **Image**
- **Rectangle**
- **Touch Area**
- **Menu**

Controls within Controls

Base Controls can be combined together to form other controls. Combinations of primitives and other controls are part of more complex controls like the **plate** control which is built from a **rectangle**.

- **Plate**
- **Rectangle**

The **legend** control is built from the **plate** and the **text** and **image** controls.

**Legend...**

- **Plate**
  - **Rectangle**
- **Text**
- **Image**

The following are controls are made of sub-controls.

- **Bar**
- **Led**
- **Readout**
- **Clock**
- **Legend**
- **Rectangular Button**
- **Indicator**
- **Plate**
- **Recipe Menu**
Templates

All previous controls can be combined to form templates. For example, the **Readout Template** is built from **legend**, **plate**, **readout**, and **text** controls, and their sub-controls. See below.

**Readout Template...**

- Legend
  - Plate
  - Rectangle
  - Text
  - Image
- Plate
  - Rectangle
- Readout
  - Text Value
- Text (units)

Template controls are shown below.

[Trend Template]  [Bar Template]  [Indicator Template]  [Readout Template]

For more details on the composition of controls, refer to the Control Example.

**Controls**

A configuration page contains visual tools or **Controls** that allow an operator to monitor and/or control a specific event or set of events from a unit. The page is defined by adding, modifying and deleting properties via its Property Editor window.

What are Controls?

**Working With Controls**

**Control Example**

A page will consist of controls from the list below.

**Note:** Depending on the software package that you have purchased, you may have all of the controls shown below, or a subset of those controls.
The following "Classic" controls resemble functions/templates from earlier product versions.
Working with Controls

When working with controls, the following links may be helpful.

Which Control Do I use?

- To view **Numeric** data:
  - **Readout Template** (includes Title "Legend" and Units field)
  - **Readout**
  - **Bar Template** (includes Title "Legend", Readout, Scale and Units field)
  - **Bar**

- To view **Status** or **States**:
  - **Indicator Template** (includes Title "Legend" and Units field)
  - **Indicator**
  - **Rectangular Button** and **Legend** allow images and/or text to be displayed dynamically.

- To **Write** or **Change "Bit" Values**:
• **Rectangular Button**
• **Control Button** - selected from the "Buttons" tab of any control.

**To Write or Change "Word" Values:**
• **Control Data Entry** - selected from the "Data Entry" tab of any control.

**To Change Pages:**
  • **Rectangular Button**

**To draw Custom Graphics:**
  • Arc
  • Ellipse
  • Image
  • Line
  • Polygon
  • Rectangle
  • Text

**Adding a Control to a Page**

To add a control to a page, drag the control from the **Control Bar** frame and drop it onto the **Editor** frame/page. The control can be edited/configured by either:
- Double-clicking it, and modifying its attributes in the **Property Editor** window
- Right-clicking it, selecting **Properties** and modifying its attributes in the **Property Editor** window

Note: Controls can be edited, added, or deleted to/from a page without opening the page editor by "right clicking" the page in Project Explorer. Then the page controls appear in the right pane.

**Configuring/Editing a Control**

Once a control has been dragged and dropped onto the page, you can configure and/or edit it. To do this, complete the following steps:

Perform one of the following actions:
- Double-click the control
- Right-click the control and select **Properties**
- Click the control and from the **Layout** menu, select **Properties**
- Click the control and from the **Layout** toolbar, select the **Property Sheet** icon

**Result:** The **Property Editor** window appears, so that you can modify the control’s properties.

**Viewing a Control’s Properties**

You can view the properties of any control on a page. To do this, complete the following steps:

Perform one of the following actions:
- Double-click the control
- Right-click the control and select **Properties**
- Click the control and from the **Layout** menu, select **Properties**
- Click the control and from the **Layout** toolbar, select the **Property Sheet** icon

**Result:** The **Property Editor** window appears, so that you can modify the control’s properties.
Deleting a Control

There are several ways in which you can delete a control from a page:

- Right-click the control and select **Delete**
- Click the control, and from the **Standard** toolbar, select **Delete**.
- Click the control, and from the **Edit** menu, select **Delete**.

Arranging Controls/Objects on a Page

**Aligning Controls/Objects**

You can align two or more controls/objects relative to each other by their left, right, top, or bottom edges or by their centers (vertically) or middles (horizontally).

**To align objects on a page:**

1. From the **Editor** frame, press the **Shift** button on the keyboard then select the controls that you want to align.  
   **Note:** Make sure the dominant object is the last object that you select. The final position of the group of objects depends on the position of the dominant object.

2. Perform one of the following actions:
   - From the **Layout** toolbar, select the down arrow to the right of the **Align Edges** icon, and select a specific alignment button.
   - From the **Layout** menu, select **Align Objects** and then select a specific alignment menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Align Left](image) | Align Left | This button/command aligns the selected objects along their left side.  
**Note:** You can also use the short cut keys **Ctrl** + **Left Arrow**. |
| ![Align Center](image) | Align Center | This button/command aligns the selected objects along their horizontal center. |
| ![Align Right](image) | Align Right | This button/command aligns the selected objects along their right side.  
**Note:** You can also use the short cut keys **Ctrl** + **Right Arrow**. |
| ![Align Top](image) | Align Top | This button/command aligns the selected objects along their top edges.  
**Note:** You can also use the short cut keys **Ctrl** + **Up Arrow**. |
| ![Align Middle](image) | Align Middle | This button/command aligns the selected objects along their vertical center. |
| ![Align Bottom](image) | Align Bottom | This button/command aligns the selected objects along their bottom edges.  
**Note:** You can also use the short cut keys **Ctrl** + **Down Arrow**. |

Spacing Controls/Objects Evenly

**To space controls/objects evenly on a page:**
1. From the Editor frame, press the Shift button on the keyboard then select the controls that you want to space evenly.

2. Perform one of the following actions:
   - From the Layout toolbar, select the down arrow to the right of the Space icon, and select a specific spacing button.
   - From the Layout menu, select Space Evenly and then select a specific spacing menu command.

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Space Across</td>
<td>This button/command spaces objects horizontally on the page.</td>
</tr>
<tr>
<td></td>
<td>Space Down</td>
<td>This button/command spaces objects vertically on the page.</td>
</tr>
</tbody>
</table>

Centering Controls/Objects

To center controls/objects on a page:

1. From the Editor frame, press the Shift button on the keyboard then select the controls that you want to space evenly.

2. Perform one of the following actions:
   - From the Layout toolbar, select the down arrow to the right of the Center in View icon, and select a specific centering button.
   - From the Layout menu, select Center in View and then select a specific centering menu item.

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Center Vertically</td>
<td>This button/command centers objects vertically on a page.</td>
</tr>
<tr>
<td></td>
<td>Center Horizontally</td>
<td>This button/command centers objects horizontally on a page.</td>
</tr>
</tbody>
</table>

Making Controls/Objects the Same Size

To make controls/objects the same size:

1. From the Editor frame, press the Shift button on the keyboard then select the controls that you want to space evenly.

2. Perform one of the following actions:
   - From the Layout toolbar, select the down arrow to the right of the Make Same Size icon, and select a specific sizing button.
   - From the Layout menu, select Make Same Size and then select a specific sizing menu command.

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Make Same Width</td>
<td>This button/command sizes objects to be the same width.</td>
</tr>
<tr>
<td></td>
<td>Make Same</td>
<td>This button/command sizes objects to be the same height.</td>
</tr>
</tbody>
</table>
### Ordering Controls/Objects

**To set the order of controls/objects on a page:**

1. From the Editor frame, select the control that you want to order.
2. Perform one of the following actions:
   - From the Layout toolbar, select the down arrow to the right of the To Front or Back icon, and select a specific ordering button.
   - From the Draw menu, select Order and then select a specific ordering menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Bring to Front" /></td>
<td>Bring to Front</td>
<td>This button/command brings an object to the front of all other objects.</td>
</tr>
<tr>
<td><img src="image" alt="Send to Back" /></td>
<td>Send to Back</td>
<td>This button/command sends an object to the back of all other objects.</td>
</tr>
<tr>
<td><img src="image" alt="Bring Forward" /></td>
<td>Bring Forward</td>
<td>This button/command brings an object to the front of the object directly in front of it.</td>
</tr>
<tr>
<td><img src="image" alt="Send Backward" /></td>
<td>Send Backward</td>
<td>This button/command sends an object to the back of the object directly in back of it.</td>
</tr>
</tbody>
</table>

### Grouping Controls/Objects

When you group controls/objects, you combine them so you can work with them as though they are a single object. You can rotate, resize, or scale all objects in a group as a single unit.

You can ungroup a group of objects at any time, and as long as the page is still active, you can easily regroup them by selecting any one of the objects that was previously grouped. If you move to another document or change views, you'll need to select each object and regroup them again.

Grouping functionality is intended to help you assemble a unique combination of controls/graphics for an application. That way, if you want to reuse the combination (either as-is or with minor modifications) in other configurations, you do not have to repeat your work.

**To group controls/objects on a page:**

1. From the Editor frame, select the Shift button on the keyboard and then click the controls that you want to group.
2. Perform one of the following actions:
   - From the Layout toolbar, select the Group, Ungroup, or Regroup icon.
   - From the Draw menu, select Group and then select a specific grouping menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Group" /></td>
<td>Group</td>
<td>This button/command groups a set of selected objects together.</td>
</tr>
</tbody>
</table>
### Getting Started

<table>
<thead>
<tr>
<th>Ungroup</th>
<th>This button/command ungroups a group of objects.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regroup</td>
<td>This button/command regroups a set of objects that was previously grouped.</td>
</tr>
</tbody>
</table>

### Rotating Controls/Objects

**To rotate controls/objects to the left or right on a page:**
1. From the **Editor** frame, select the control that you want to rotate.
2. Perform one of the following actions:
   - From the **Layout** toolbar, select the **Rotate Left** or **Rotate Right** icon.
   - From the **Draw** menu, select **Rotate** and then select **Rotate Left** or **Rotate Right**.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Free Rotate" /></td>
<td><strong>Free Rotate</strong></td>
<td>This button/command rotates the object to the degree that you specify.</td>
</tr>
<tr>
<td><img src="image" alt="Rotate Left" /></td>
<td><strong>Rotate Left</strong></td>
<td>This button/command rotates the object counter-clockwise by 90 degrees.</td>
</tr>
<tr>
<td><img src="image" alt="Rotate Right" /></td>
<td><strong>Rotate Right</strong></td>
<td>This button/command rotates the object clockwise by 90 degrees.</td>
</tr>
</tbody>
</table>

**To free rotate controls/objects on a page:**
1. From the **Editor** frame, select the control that you want to rotate.
2. Perform one of the following actions:
   - From the **Layout** toolbar, select the **Free Rotate** icon.
   - From the **Draw** menu, select **Rotate** and then select **Free Rotate**.

**Note:** The drag handles of the selected object turn into circles, so that you can freely rotate the object.
3. Rotate the object about its center by dragging any one of these handles.

For more details on the composition of controls, refer to the **Control Example**.

The following links provide related assistance.

**The Page Editor**

**Customizing the Page Editor**

**Working with Properties**

**Control Example: Readout Template**

A **Readout** control displays numerical values similar to readout devices on a control panel. The following is a description of the **Readout Template**, but is described in terms that can be related to all controls. Due to similarity in each control's properties, this is the only detailed example given for a control as it describe how all controls function.
The Control

When a Readout Template is placed on a page, it will appear similar to below.

Note: Some properties have been adjusted as follows (details on making these changes will follow):

- Data Entry has been selected and is indicated by the miniature data entry keypad in the template’s upper left corner.
- A title “Speed” has been given to the template.
- The units “RPM” has been added.

The Property Editor

The Property Editor of this control can be called by double clicking the control (or right-clicking the control and selecting Properties). These properties are shown below:

The General Properties
When the properties are displayed for the control, the **General Properties** (i.e. the General Tab), are shown. The following is an example of a readout control's Property Editor, showing the general properties, with the most notable properties indicated.

The Property Editor Window contains the Control Outline and a list of properties and values for the Readout Template. In the graphic above:

- **Readout Template** is highlighted (shown with a blue background) in the Control Outline.
- The **General** Tab is selected on the right.
- So, the Readout Template's General properties are shown.
- And, this top level (Readout Template), **General** tab contains the most common properties.
- Note how the property values are reflected visually on the graphic (and the Data Entry indicator is displayed after selecting OK).

Values are changed in this or any property window by selecting and altering the value based on the type of value field.

In the above graphics, the altered property values were changed as follows:

- Data Entry was selected by the drop box arrow next to the Operator Input Type property.
- "Speed" was assigned to the Title property.
- "RPM" was assigned to the Units property.

Controls are designed with the most common properties under the General tab to minimize editing time. Below are more instructions on accessing the remainder of the properties.

**The Control Outline**

As in the graphic below, the **Control Outline** shows the composition of the selected control with all of its controls/sub-control constituents.
The outline (which was expanded by clicking on all "+" signs) shows the controls that make a Readout Template. The four sub-controls at the next level of the outline, under Readout Template, are indicated with lines on the graphic above.

- Readout Template
  - Legend
  - Plate
  - Readout
  - Units

Then to drill down further into the control, the Legend is made of (ie: the level of the outline under Legend):

- Legend
  - Plate
  - Text
  - Image

And, the plate is made of:

- Plate
  - Plate Rectangle

And, so on, until the outline is filled as in the property editor graphic above.

**Note:** items are expanded by clicking "+" signs; contracted with "-" signs.

**Note:** The item selected in the Control Outline pane has it's properties shown on the right.

**Editing Sub-Control Properties**

In the preceding Control Outline pane, Readout Template was selected. Since it is selected, it's properties are shown on the right. Similarly, if any item in the outline is selected, it's properties will be displayed.

In general, the most used properties have been moved to the General Tab. To change less common properties, select them at their base level. For instance, to change the border highlight color on the legend part of the control (which is the border of the rectangle sub-control of the plate sub-control of the legend
sub-control of the Readout control), select Plate Rectangle as shown below. Then select the Attributes tab to access the desired characteristics or property.

The control will change as follows...

Tip: The highest level "General" tab contains the most common properties.  
Tip: Lower level "Attributes" tab is necessary to change the less common properties.

The Rest of the Properties

The following properties under the **General** Tab are specific to the Readout Template control.

- **Title**
- **Value**
- **Decimal Places**
- **Units**

In addition to the above properties, there are **Common Properties** available for all controls.

Other Controls

Click **Controls** to look at the properties of all the controls.

**All Controls**
**Arc**

The Arc control allows you to draw an arc, chord, or pie-shaped object on the page.

*Tip: Press the Shift key while sizing to constrain the arc to a circular shape.*

**Arc properties**

The following properties are specific to the Arc control.

**Attributes tab**

- Arc Style
- Foreground Color
- Background Color
- Pen Width
- Pen Style

**Position/Size tab**

- Starting Angle
- Ending Angle

In addition to the above properties, there are **Common Properties** available for all controls.

**Bar**

**Bar properties**

The following properties are specific to the Bar control.

**General tab**

- Value
- Max Calibration
- Min Calibration
- Orientation

In addition to the above properties, there are **Common Properties** available for all controls.

**Bar Template**

Bar controls act as the analog meters or faceplates on a component panel and indicate a value in analog fashion, with a bar graph. The bar graph can show current value, setpoint, and high and low alarm levels. The current value is displayed as an analog bar-style meter and as a digital readout.

**Bar Template properties**

The following properties are specific to the Bar Template control.
General tab

- Value
- Max Cal.
- Min Cal.
- Decimal Places
- Units

In addition to the above properties, there are Common Properties available for all controls.

Ellipse

Ellipse components allow you to place an ellipse or circle on the page.

Ellipse properties

The following properties are specific to the Ellipse control.

Attributes tab

- Foreground Color
- Background Color
- Background Style
- Pen Width
- Pen Style
- Shadow Style

In addition to the above properties, there are Common Properties available for all controls.

Button Bar

A Button Bar control acts as a container for multiple button controls.

Button Bar properties

The following properties are specific to the Button Bar control.

General tab

- Orientation

Button tab

- Name

Button General tab (select the name of the bar sub-control in the control outline)

- Make Label
- Make Action
- Break Label
- Break Action
In addition to the above properties, there are Common Properties available for all controls.

Clock

This control displays date and time information on a page.

Clock properties

The following property is specific to the Clock control.

General tab

- **Display**

In addition to the above property, there are Common Properties available for all controls.

Fixed Bar

Fixed Bar controls act as the analog meters or faceplates on a component panel and indicate a value in analog fashion, with a bar graph. The bar graph can show current value, setpoint, and high and low alarm levels. The current value is displayed as an analog bar-style meter and as a digital readout.

Fixed Bar properties

The following properties are specific to the Fixed Bar control.

General tab

- **Value1**
- **Value2**
- **Units**
- **Decimal Places**
- **Max Cal.**
- **Min Cal.**
- **Decimal Places**
- **Units**
- **Cell Height**

In addition to the above properties, there are Common Properties available for all controls.

Fixed Line Trend

Fixed Line Trend controls act as multi-pen analog strip charts on a component panel and indicate one or more values, over time as an analog plot.

Fixed Line Trend properties
The following properties are specific to the Fixed Line control.

General tab

- Cell Height
- Cell Width

In addition to the above properties, there are **Common Properties** available for all controls.

---

**Fixed Indicator**

Fixed Indicator controls are designed to act as the lights and buttons of a control panel and are used to indicate the status of devices and to control them, for example, by turning them on or off. The status may be represented as alphanumeric, or a static or blinking color, and is obtained as a digital output from a remote device (such as a PLC) or local device (such as a local database or a local memory variable).

**Fixed Indicator properties**

The following properties are specific to the Fixed Indicator control.

General tab

- Title
- Cell Width

States tab (select the Indicator sub-control in the control outline)

**Note: This tab contains a table which allows multiple of the following entries**

- Expression
- Media
- Style
- BG Color
- FG Color
- Font

In addition to the above properties, there are **Common Properties** available for all controls.

---

**Fixed Line Trend**

Bar controls act as the analog meters or faceplates on a component panel and indicate a value in analog fashion, with a bar graph. The bar graph can show current value, setpoint, and high and low alarm levels. The current value is displayed as an analog bar-style meter and as a digital readout.

**Fixed Line Trend properties**

The following properties are specific to the Bar Template control.

General tab

- Cell Height
- Cell Width
In addition to the above properties, there are **Common Properties** available for all controls.

### Fixed Message

Fixed Message controls allow you to place text on the page. They are like LED or LCD message units or displays.

**Note:** The text string must be surrounded by quotes to show exact text entered. Otherwise, the entered value will be interpreted as a tag or library entry.

**Fixed Message properties**

The following properties are specific to the Fixed Message control.

**General tab**
- **Name**
- **Cell Width**

**Expressions tab**
- **Message 1 Expression**
- **Message 2 Expression**
- **Message 3 Expression**

In addition to the above properties, there are **Common Properties** available for all controls.

### Fixed Readout

Fixed Readout controls act as numerical readout devices and display a numeric value.

**Fixed Readout properties**

The following properties are specific to the Fixed Readout control.

**General tab**
- **Title**
- **Value1**
- **Value2**
- **Units**
- **Decimal Places**
- **Cell Width**

In addition to the above properties, there are **Common Properties** available for all controls.
Fixed Table controls allow you to place text on the page. They are like LED or LCD message units or displays.

Note: The text string must be surrounded by quotes to show exact text entered. Otherwise, the entered value will be interpreted as a tag or library entry.

Fixed Table properties

The following properties are specific to the Fixed Table control.

General tab

- Title
- Parameters Label
- Current Value Label
- Edit Value Label
- Unit Label
- Cell Height
- Cell Width

Entries tab

- Parameters
- Decimal Places
- Value Expression
- Input Value Expression
- Units

In addition to the above properties, there are Common Properties available for all controls.

Image

Image Controls allow you to place a bitmap object on the page.

Note: Bitmaps are permanently added to the page after selection from a disk file with a .bmp extension.

Image properties

The following properties are specific to the Image control.

General tab

- Image

Attributes tab

- Display
- Mirror
- Invert Colors
- Brightness
- Contrast

In addition to the above properties, there are Common Properties available for all controls.
Indicator

Indicator properties

The following properties are specific to the Indicator control.

General tab
- Title

States tab

Note: This tab contains a table which allows multiple of the following entries
- Expression
- Media
- Style
- BG Color
- FG Color
- Font

In addition to the above properties, there are Common Properties available for all controls.

Indicator Template

Indicator controls are designed to act as the lights and buttons of a control panel and are used to indicate the status of devices and to control them, for example, by turning them on or off. The status may be represented as alphanumeric, as a static or blinking color, or as a graphic, and is obtained as a digital output from a remote device (such as a PLC) or local device (such as a local database or a local memory variable).

Indicator Template properties

The following properties are specific to the Indicator Template control.

General tab
- Title

States tab (select the Indicator sub-control in the control outline)

Note: This tab contains a table which allows multiple of the following entries
- Expression
- Media
- Style
- BG Color
- FG Color
- Font

In addition to the above properties, there are Common Properties available for all controls.
Led

Led controls provide a circular representation of discrete data. Multiple states can be assigned for both the background color (the main color of the circle) and the foreground color (the reflection).

Led properties

The following properties are specific to the Ellipse control.

General tab

- **State Evaluation**
- **Foreground Color (the reflection color)**
- **Background Color**

States tab

*Note: This tab contains a table which allows multiple of the following entries*

- **Expression**
- **BG Color**
- **FG Color**

In addition to the above properties, there are **Common Properties** available for all controls.

Legend

Legend properties

The following properties are specific to the Legend control.

General tab

- **Title**

In addition to the above properties, there are **Common Properties** available for all controls.

Line

Line components allow you to place a line object on the page.

*Tip: While using this tool, press the Shift key on your keyboard to constrain the line to a 45° angle.*

Line properties

The following properties are specific to the Line control.

Attributes tab

- **Arrowhead**
- **Arrowhead Height**
In addition to the above properties, there are **Common Properties** available for all controls.

### Menu Device

**Menu properties**

The following properties are specific to the Menu control.

#### General tab

- **2 Touch Select**
- **Index Input Location**
- **Index Output Location**
- **Text Output Location**

#### Attributes

- **Alignment**
- **Font**
- **Normal Text Color** - text color of non selected items
- **Selected Text Color** - text color of selected item
- **Selected Text Highlight** - background color of activated item
- **Hover Text Highlight** - background color of item when using scroll up/down in 2 touch mode
- **Normal Outline Color** - border color of non selected item
- **Selected Outline Color** - border of activated item
- **Icon Size**

#### Menu Entries tab

This tab holds the pairs of image and text that appear in the menu. Note: the Recipe control uses the Menu control as a base, but does not use these entries.

**Note: This tab contains a table which allows multiple of the following entries**

- **Image**
- **Text**

In addition to the above properties, there are **Common Properties** available for all controls.
Plate

Plate properties

There are no specific properties for the Plate control. The Rectangle sub-control can be accessed to change plate properties.

In addition, there are Common Properties available for all controls.

Polygon

Polygon controls allow you to place a polyline (a jagged line) or a closed polygon (multi-sided figure) on the page.

Note: Drawing a polygon is accomplished by selecting the icon and dragging it to the page (while holding the left mouse button down). At release of the mouse button, the first point is positioned. Move the mouse and click to the next desired point. The polygon is complete when the polygon is closed (last point on top of first point) or by double clicking for the last point.

Polygon properties

The following properties are specific to the Polygon control.

Attributes tab

- Arrowhead
- Arrowhead Height
- Foreground Color
- Background Color
- Background Style
- Pen Width
- Pen Style
- Shadow Style

Polygon Points tab

Note: This tab contains a table which allows multiple of the following entries.

- X Points
- Y Points

In addition to the above properties, there are Common Properties available for all controls.

Readout

Readout properties

The following properties are specific to the Readout control.

General tab
Readout Template

Readout controls act as numerical readout devices and display a numeric value.

Readout Template properties

The following properties are specific to the Readout Template control.

General tab

- Title
- Value
- Decimal Places
- Units

In addition to the above properties, there are Common Properties available for all controls.

Recipe Menu

Below is an image of the Recipe Menu control which uses the Menu Device control as its base. This device is configured to hold a list of recipes which are extracted from an XML file, and contains functions which allow it to be controlled during Runtime. The following indicators provide recipe status.

- Busy LED - Dark green when idle, bright green when a recipe is being loaded, compared or saved.
- Error LED - Dark red when idle, bright red when a recipe is not loaded or a compare fails.
- Mismatch Number - The number of mismatches reported when a compare is done (0=Recipe Loaded is the same as that selected, Number=The number of differences between loaded and selected recipes).

See Recipe Development for more details.

Recipe properties

The following properties are specific to the Recipe control.

Note: The functions necessary to operate and control a recipe are built into the Recipe control, as described below in the Buttons tab. Recipe Actions are not needed unless it is desired to have customized recipe functions (for instance, a stand alone Load button).

General tab

- File Name

Note: The XML file contains the recipe data, to view XML files in Excel, Office XP, 2003 or newer is needed.

Menu Entries tab

This tab holds the pairs of image and text that appear in the menu. Note: the Recipe control uses the Menu control as a base, but does not use it's entries.
Note: This tab contains a table which allows multiple of the following entries

- Image
- Text

Buttons tab

If Operator Input Type of Button is selected, then six buttons will be pre-populated with the following built-in functions. Buttons can have titles and colors modified and can be removed, but remember that each value represents a function. So, for instance, if load is desired, make sure to keep the button with Break Action ':SYSTEM:,ButtonControlState' = 4.

<table>
<thead>
<tr>
<th>Button's Function</th>
<th>Value of ':SYSTEM:,ButtonControlState'</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>1</td>
</tr>
<tr>
<td>Scroll Up</td>
<td>2</td>
</tr>
<tr>
<td>Scroll Down</td>
<td>3</td>
</tr>
<tr>
<td>Load</td>
<td>4</td>
</tr>
<tr>
<td>Compare</td>
<td>5</td>
</tr>
<tr>
<td>Save</td>
<td>6</td>
</tr>
</tbody>
</table>

See Recipe Management Action properties, General tab for more information on the Load, Compare and Save functions.

In addition to the above properties, there are Common Properties available for all controls.

Rectangle

Rectangle controls allow you to place a rectangle object on the page.

Tip: While using this tool, press the Shift key on your keyboard to constrain the rectangle to a square.

Rectangle properties

The following properties are specific to the Rectangle control.

Attributes tab

- Foreground Color
- Background Color
- Background Style
- Pen Width
- Pen Style
- Highlight Color
- Shadow Style

In addition to the above properties, there are Common Properties available for all controls.
Rectangular Button

Rectangular Button components are touch screen buttons designed to be used for an operator's control. Common uses are:

- to set a bit (for example, in the PLC to start and stop machinery)
- to change pages

Notes:
Rectangular button controls can display either text or graphics.
Rectangular buttons can have actions associated with both the make (press) and break (release) of the button.

Page changes should be a result of the Break Action since that would be the last operation to be performed on the calling page. If the Make Action was used, then a new page would be called, and the Break Action from the calling page would be lost.

Rectangular Button properties

The following properties are specific to the Rectangular Button control.

General tab

- Make Label
- Make Action
- Break Label
- Break Action

In addition to the above properties, there are Common Properties available for all controls.

Scale

Scale properties

The following properties are specific to the Scale control.

Attributes tab

- Scale
  - Orientation
  - Placement
  - Scale Color
  - Pen Width

- Tick Marks
  - # of Major Divisions
  - # of Minor Divisions
  - Max Calibration
  - Min Calibration
  - Decimal Places
  - Tick Placement
• Tick Values
  • Major Tick Values
  • Value Color
  • Font

In addition to the above properties, there are Common Properties available for all controls.

Text

Text controls allow you to place text on the page. They are like LED or LCD message units or displays.

Note: The text string must be surrounded by quotes to show exact text entered. Otherwise, the entered value will be interpreted as a tag or library entry.

Text properties

The following properties are specific to the Text control.

General tab
  • Text

Attributes tab
  • Text
    • Alignment
    • Font
    • Foreground Color
    • Background Color, BG Color
    • Background Style
  • Text Frame
    • Pen Width
    • Frame Style
    • Foreground Color
    • Highlight Color
    • Shadow Style

In addition to the above properties, there are Common Properties available for all controls.

Touch Area

Touch Area properties

The following properties are specific to the Touch Area control.

General tab
  • Make Action
  • Break Action
In addition to the above properties, there are **Common Properties** available for all controls.

**Trend Pens and Trend Template**

The Trend Pens and Trend Template controls provide a plot of one or more tags, giving a short trend of past values. Up to 16 different values can be trended.

**Trend Template properties**

The following properties are specific to the Trend Template control.

**General tab**

- **Title**

**Attributes Tab** (select the Trend Pens sub-control in the control outline)

- **See properties below**

**Entries Tab** (select the Trend Pens sub-control in the control outline)

- **See properties below**

**Trend Pens properties**

**General Tab**

- **Trend Type** - Line or Bar

**Attributes Tab**

- **Min Calibration**
- **Max Calibration**
- **Outline Color**
- **Color**
- **Trigger Type**
  - "Interval" enables the following properties
    - **Trend Interval Units**
    - **Sample Interval**
    - **Max Trend Interval**
  - "Discrete" or "Change" enables the following properties
    - **Number of Samples**
    - **Target Expression**
- **Grid Axis Color**
- **Pen Width**
- **# of Horizontal Divisions**
- **# of Vertical Divisions**
- **Decimal Places**
- **Grid Values**
- **Time Values**
- Time Display
- Grid Values Color
- Grid Values Font

Entries Tab

**Note:** This tab contains a table which allows multiple (one per trended value) of the following entries

- Pen Color
- Value
- Pen Style
- Pen Width

In addition to the above properties, there are **Common Properties** available for all controls.

---

**VS Bar**

**VS Bar properties**

The following properties are specific to the VS Bar control.

**General tab**

- Value
- Max Calibration
- Min Calibration
- Orientation

In addition to the above properties, there are **Common Properties** available for all controls.

---

**VS Control Button**

**VS Control Button components** are touch screen buttons designed to be used for an operator's control. Common uses are:

- to set a bit (for example, in the PLC to start and stop machinery)
- to change pages

**Notes:**

Rectangular button controls can display either text or graphics.

Rectangular buttons can have actions associated with both the make (press) and break (release) of the button.

**Page changes** should be a result of the **Break Action** since that would be the last operation to be performed on the calling page. If the Make Action was used, then a new page would be called, and the Break Action from the calling page would be lost.

**VS Control Button properties**

The following properties are specific to the VS Control Button.
General tab

- Make Label
- Make Action
- Break Label
- Break Action

In addition to the above properties, there are **Common Properties** available for all controls.

**VS Graphic**

VS Graphic controls allow you to place a bitmap object on the page.

*Note: Bitmaps are permanently added to the page after selection from a disk file with a .bmp extension.*

**VS Graphic properties**

The following properties are specific to the VS Graphic control.

**General tab**

- Image

**Attributes tab**

- Display
- Mirror
- Invert Colors
- Brightness
- Contrast

In addition to the above properties, there are **Common Properties** available for all controls.

**VS Indicator**

**VS Indicator properties**

The following properties are specific to the VS Indicator control.

**General tab**

- Title

**States tab**

*Note: This tab contains a table which allows multiple of the following entries*

- Expression
- Media
- Style
- BG Color
- FG Color
Getting Started

- **Font**

In addition to the above properties, there are **Common Properties** available for all controls.

**VS Message**

VS Message controls allow you to place text on the page. They are like LED or LCD message units or displays.

**Note:** The text string must be surrounded by quotes to show exact text entered. Otherwise, the entered value will be interpreted as a tag or library entry.

**VS Message properties**

The following properties are specific to the VS Message control.

- **General tab**
  - Text

- **Attributes tab**
  - **Text**
    - Alignment
    - Font
    - Foreground Color
    - Background Color, BG Color
    - Background Style
  - **Text Frame**
    - Pen Width
    - Frame Style
    - Foreground Color
    - Highlight Color
    - Shadow Style

In addition to the above properties, there are **Common Properties** available for all controls.

**VS Readout**

**VS Readout properties**

The following properties are specific to the VS Readout control.

- **General tab**
  - Value
    - Decimal Places

In addition to the above properties, there are **Common Properties** available for all controls.
Properties

The Property Editor

The Property Editor window is accessed by double clicking a control in the Page Editor (or right clicking the control in the Project Explorer). An example of the Readout Template Property Editor is shown below.

Note: You can also Modify Page Controls and Properties without the Page Editor from the Project Explorer Window.

In the figure below, Page 1 is highlighted, displaying the controls on that page. Assume the rectangular button has been configured as a goto main menu button and that we want the button on all of the pages. Right-click the rectangular button, select copy, then right-click each of the pages in the pages folder, right-click and select paste. The rectangular button will be copied to each of the pages that you selected. You could have copied multiple controls and performed the same operation.

Tip: To edit control properties from this view, right-click the control and select Properties.

What is a Property?

All of the parameters or characteristics associated with a control. Properties can be static, such as Background Color, Pen Width, Font, Alignment. Or they can be dynamic, such as the numeric value to display, or the color or image to display for a given state.

Working with Properties

Control Example

Property Editor Window
The primary areas of information on each Property Editor window are described below:

- **Control Outline** - a hierarchy of controls and sub-controls that make up the control being edited.

  Note: items are expanded by clicking "+" signs; contracted with "-" signs.

- **Tabs** - one or more "Tabs" of information contain additional properties that define the control

- **Property** - a list of all of the property names associated with a control. Examples of properties are:
  - Background Color
  - Pen Width
  - Font
  - Alignment

  Note: An optional column with group names to further define properties may appear on the left of the Property column.

  Note: The item selected in the Control Outline pane has it's properties shown on the right.

  Note: The highest level "General" tab contains the most common properties.

  Note: Lower level "Attributes" tab is necessary to change the less common properties.

  Note: A "grayed" property is not available with current settings.

- **Property Value** - a column to define/assign values for each of the properties. Different types of values (text strings, library references, check boxes, etc.) results in various entry fields. See the types of value fields.

- **Property Editor Window Buttons** - the Property Editor window may have up to three buttons at the bottom of the window. Below are the possible buttons and functions:
- **OK** - save all of the changes that you have made and close the Property Editor window.
- **Cancel** - close the Property Editor window without saving changes that you have made.
- **Apply** - apply all of the changes that you have made to the Property Editor window and do not close the window. Appears when changes have been made.

**List Properties**

**Control Properties**

The relationship of Controls and Properties are the key to a page. Revisit Controls for another look at Control Properties.

Press the ✅ Back button (toolbar of your browser) to return to the previous page.

**Working with Properties**

The Property Editor is designed with the following adjustment capabilities:

**Resizing the Property Editor Window**

Property Editor windows can be sized to any dimension by:
- Placing the pointer at the edge of the window (until the pointer turns into a line with arrows on each end), pressing the left mouse button and dragging up, down, left or right.
- Using the Maximize and Minimize buttons located at the upper right corner of the window
- Using the scroll bars along the right side and bottom of the window

**Scrolling to Another Part of the Property Editor Window**

To scroll to another part of the window, either:
- Drag the scroll bars back and forth or up and down
- Click the arrows next to the scroll bar

**Resizing Columns in the Property Editor Window**

In addition to sizing the window, you can size the columns by dragging the sides of each column. Place the pointer at the edge of the column (until the pointer turns into a line with arrows on each end), press the left mouse button and drag left or right.

*Note: When a column is smaller than the largest viewable text in that column, the text appears with "..." at the end.*

**Moving Between Cells in the Value Column**

To move between cells in the value column (the last column on the right) click any cell or use the up/down arrow keys. When you move to a cell, the cell is highlighted and becomes active.
If you want to move...

<table>
<thead>
<tr>
<th>Move Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>One row up or down</td>
<td>Click the arrows in the vertical scroll bar</td>
</tr>
<tr>
<td>Several values up or down</td>
<td>Click above or below the scroll box in the vertical scroll bar</td>
</tr>
<tr>
<td>A large distance</td>
<td>Drag the vertical scroll box to the approximate relative position</td>
</tr>
</tbody>
</table>

**Note:** The size of a vertical scroll box indicates the proportional amount of the used area of the dialog that is visible. The position of a scroll box indicates the relative location of the visible area within the dialog.

**Right-Click Menu**

When you right-click inside of a **Property Editor** window, a menu appears with some or all of the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Use this command to cut a selected object(s) from the window and place the object(s) on the Windows clipboard.</td>
</tr>
<tr>
<td><strong>Tip:</strong> You can also use the shortcut keys <strong>CTRL+X</strong> to perform the same operation.</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Use this command to copy a selected object(s) to the Windows clipboard.</td>
</tr>
<tr>
<td><strong>Tip:</strong> You can also use the shortcut keys <strong>CTRL+C</strong> to perform the same operation.</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Use this command to paste a selected object(s) from the Windows clipboard into the window.</td>
</tr>
<tr>
<td><strong>Tip:</strong> You can also use <strong>CTRL+V</strong> to perform the same operation.</td>
<td></td>
</tr>
<tr>
<td>Find</td>
<td>Use this command to search for text, specific formatting, and values.</td>
</tr>
<tr>
<td>Replace</td>
<td>Use this command to search for and replace text, specific formatting, and values. You can also search for and replace all forms of a word (for example, you can replace &quot;make&quot; with &quot;build&quot; as well as &quot;made&quot; with &quot;built&quot;).</td>
</tr>
<tr>
<td>Insert Before Row</td>
<td>Use this command to insert a row before the row that you have highlighted.</td>
</tr>
<tr>
<td>Insert After Row</td>
<td>Use this command to insert a row after the row that you have highlighted.</td>
</tr>
<tr>
<td>Insert Rows...</td>
<td>Use this command to insert multiple rows after the row that you have highlighted.</td>
</tr>
<tr>
<td>Delete Row</td>
<td>Use this command to delete a selected row from the window.</td>
</tr>
<tr>
<td>Default Row Contents</td>
<td>Use this command to insert the default content values into the row, if applicable.</td>
</tr>
<tr>
<td>Delete Cell Contents</td>
<td>Use this command to delete the contents of the cell.</td>
</tr>
<tr>
<td>Default Cell Contents</td>
<td>Use this command to insert the default content values into the cell, if applicable.</td>
</tr>
<tr>
<td>Sort</td>
<td>Use this command to insert the default content values into the cell,</td>
</tr>
</tbody>
</table>
Static properties, such as fonts and colors are selected from the property editor and are displayed immediately in the way they will appear during Runtime. Dynamic properties are entered via expressions which indicate how the data will appear during Runtime, see the following for details:

Expressions Discrete
Expressions Analog
Expressions Data Entry
Expressions Direct Assignment

For more details on the composition of controls, refer to the Control Example.

The following links provide related assistance.

**The Page Editor**

**Customizing the Page Editor**

**Working with Controls**

**Control Example: Readout Template**

A Readout control displays numerical values similar to readout devices on a control panel. The following is a description of the Readout Template, but is described in terms that can be related to all controls. Due to similarity in each control's properties, this is the only detailed example given for a control as it describe how all controls function.

**The Control**

When a Readout Template is placed on a page, it will appear similar to below.

**Note:** Some properties have been adjusted as follows (details on making these changes will follow):

- Data Entry has been selected and is indicated by the miniature data entry keypad in the template's upper left corner.
- A title "Speed" has been given to the template.
- The units "RPM" has been added.
The Property Editor

The Property Editor of this control can be called by double clicking the control (or right-clicking the control and selecting Properties). These properties are shown below:

![Property Editor Interface]

The General Properties

When the properties are displayed for the control, the General Properties (ie: the General Tab), are shown. The following is an example of a readout control’s Property Editor, showing the general properties, with the most notable properties indicated.
The Property Editor Window contains the Control Outline and a list of properties and values for the Readout Template. In the graphic above:

- **Readout Template** is highlighted (shown with a blue background) in the Control Outline.
- The **General** Tab is selected on the right.
- So, the Readout Template’s General properties are shown.
- And, this top level (**Readout Template**), **General** tab contains the most common properties.
- Note how the property values are reflected visually on the graphic (and the Data Entry indicator is displayed after selecting OK).

Values are changed in this or any property window by selecting and altering the value based on the type of value field.

In the above graphics, the altered property values were changed as follows:

- Data Entry was selected by the drop box arrow next to the Operator Input Type property.
- "Speed" was assigned to the Title property.
- "RPM" was assigned to the Units property.

Controls are designed with the most common properties under the General tab to minimize editing time. Below are more instructions on accessing the remainder of the properties.

**The Control Outline**

As in the graphic below, the **Control Outline** shows the composition of the selected control with all of its controls/sub-control constituents.
The outline (which was expanded by clicking on all "+" signs) shows the controls that make a Readout Template. The four sub-controls at the next level of the outline, under Readout Template, are indicated with lines on the graphic above.

- Readout Template
  - Legend
  - Plate
  - Readout
  - Units

Then to drill down further into the control, the Legend is made of (ie: the level of the outline under Legend):

- Legend
  - Plate
  - Text
  - Image

And, the plate is made of:

- Plate
  - Plate Rectangle

And, so on, until the outline is filled as in the property editor graphic above.

Note: items are expanded by clicking "+" signs; contracted with "−" signs.

Note: The item selected in the Control Outline pane has its properties shown on the right.

**Editing Sub-Control Properties**

In the preceding Control Outline pane, Readout Template was selected. Since it is selected, its properties are shown on the right. Similarly, if any item in the outline is selected, its properties will be displayed.

In general, the most used properties have been moved to the General Tab. To change less common properties, select them at their base level. For instance, to change the border highlight color on the legend part of the control (which is the border of the rectangle sub-control of the plate sub-control of the legend...
sub-control of the Readout control), select Plate Rectangle as shown below. Then select the Attributes tab to access the desired characteristics or property.

![Rectangle - Plate Rectangle](image)

The control will change as follows...

![Modified Rectangle - Plate Rectangle](image)

Tip: The highest level "General" tab contains the most common properties.

Tip: Lower level "Attributes" tab is necessary to change the less common properties.

The Rest of the Properties

The following properties under the General Tab are specific to the Readout Template control.

- Title
- Value
- Decimal Places
- Units

In addition to the above properties, there are Common Properties available for all controls.

Other Controls

Click Controls to look at the properties of all the controls.

Property Value Entry Types
The following are graphics showing various ways in which property values are entered. See below for descriptions.

- **Check Box** - Clicking the box toggles between placing an "X" to select, or removing the "X" to deselect.

- **Ellipsis** - There are more options in another window, for example selecting colors from a color palette, or a font from a font properties window.

- **Up/Down Scroll** - UP arrow will increase the property value, DOWN arrow will decrease the value.

- **String Only** - Allows string entry only.

- **Drop List** - Provides a selection menu. Can be limited selections, such as Vertical or Horizontal. Or can provide access to other resources in the system, such as Configured Clients, Tag Libraries and Math Operators.

**Expressions, Discrete**

An expression that will evaluate to one of two states (for example, ON/OFF or True/False).

Examples of **Discrete Expressions** include:

- Indicator States - based on a machine's state, an indicator will show one status when a bit is ON, and another when the bit is OFF.

- Visibility Expression - based on the value of a bit, a control will be shown (or not shown) on a page.

- State/Style/Action - if the expression is true, a corresponding style will appear on the control.

**Discrete Expressions** will appear as in the following examples:

- 1
When the expression is set to a numeric value of 1 (no quotes), its evaluation is ALWAYS True. This is used in expressions in which a certain state is always desired. For example to always display a specific control, set its Visibility Expression to 1.

- \texttt{b3/0}'
  The above example will evaluate to True when bit b3/0 is ON.

\textbf{Note: If the Client Library is set as the Default in the Unit’s properties, then the library can be omitted from the reference. Otherwise, the reference must include the library, ie: 'Lib,LibEntry'.}

- \texttt{'Bit1}'
  The above example will evaluate to True when tag Bit1 is ON.

- \texttt{!'Bit1}'
  The above example will evaluate to True when Bit1 is OFF, and FALSE when Bit1 is ON.

- \texttt{'ClientLib,Bit1' == 1}
  The above example will evaluate to True when Bit1 in the ClientLib library has a value of 1. Note that the expression \texttt{'ClientLib,Bit1'}, without the \texttt{==1}, will have an identical result.

\textbf{Tip: All Client and Tag Libraries can be accessed from the drop down box to the right of the value field. For example, to select a library entry, select the type of library, then the Library Name, then the Library Entry, and 'Library Name, Library Entry' will be placed in the formula.}

- \texttt{40001' == 200}
  The above example (Equal to) will be True if register 40001 is equal to 200. This is a relational operator used for comparison purposes.

- \texttt{40001' = 200}
  The above example (Assign) will set the value of 40001 to 200. This is a arithmetic use for assignment purposes.

\textbf{Note: In the above examples, the == (double equal signs) is used to see if the values are equal. This is different than the = (single equal sign) which will assign the value on the right to the tag on the left. Be careful!}

- \texttt{40001' > 10}
  The above example will evaluate to True when register 40001 is greater than 10.

- \texttt{'Pressure' > 250 || 'MaintenanceMode'}
  The above example (|| is a logical OR) will evaluate to True when Pressure is greater than 250, or MaintenanceMode is True.

\textbf{Tip: All logical operators can be accessed from the drop down box to the right of the value field. For example, to select a logical "or" operator, select Operators, then Logical Operators, then Logical OR, and the "||" will be placed in the formula. Used these same steps for all operators.}

- \texttt{'ControlBits' & 128}
  The above example (& is a bitwise AND) will evaluate to True when the 8th bit in ControlBits is ON, regardless of the other bits.

\textbf{Notes:}

- Pay attention to Property Value Formats (single, double, or no quotes)

\textbf{Notes:}

- The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
- Click the Ellipsis button (…) to select a tag, operator, or function which is defined in a library.
- The Order of Precedence must be considered in formulas.
Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Note:

In state evaluations (i.e. Indicator and Led states), expressions are evaluated as specified by the State Evaluation property.

Expressions, Analog

An expression that can have many values. Examples of Analog Expressions include:

- Readout Values - temperature, pressure, speed, etc. can be shown numerically.
- Bar Values - temperature, pressure, speed, etc. can be shown in bar graph form.

Analog Expressions will appear as in the following examples:

- **100**
  A numeric expression can be set to a numeric value (no quotes). This type of entry is used in expressions in which the value will not dynamically change. For example, an Upper Limit might be set to 100, and a Lower Limit to 0. Note however, that all expressions, including limits, can be dynamic if desired.

- **'Pressure'**
  The above example will show the value of tag named Pressure.

  Note: If the Client Library is set as the Default in the Unit's properties, then the library can be omitted from the reference. Otherwise, the reference must include the library, i.e: 'Lib,LibEntry'.

- **$B8('Pressure')**
  The above example will show the formatted value of tag named Pressure. $B8('Pressure') formats the value as an 8 digit Binary number ($Bn shows n Binary digits, $Hn shows n Hex digits, $A shows an Ascii string, ... use the drop down box to get these values from the list).

  Tip: All format operators can be accessed from the drop down box to the right of the value field. For example, to select a Binary format, select Operators, then Format/Data/Time Operators, then Binary, and the $B will be placed in the formula. Use these same steps for all format operators.

- **'40001' % 100**
  The above example (Modulo) will divide 40001 by 100 and show the remainder. For example, if 40001 is 1234, then the expression will be 34 (i.e: the remainder of 1234/100 = 12 with Remainder 34).

  Tip: All operators can be accessed from the drop down box to the right of the value field. For example, to select Modulo, select Operators, then Arithmetic Operators, then Modulo, and the % will be placed in the formula.

- **'ClientLib, Pressure'**
  The above example shows the value of 'Pressure' from the library called ClientLib.

  Tip: All Client and Tag Libraries can be accessed from the drop down box to the right of the value field. For example, to select a library entry, select the type of library, then the Library Name, then the Library Entry, and 'Library Name, Library Entry' will be placed in the formula.

- **$(Time)**
  The above example will show the time formatted as hour:minute:sec.

  Tip: All Time and Date expressions can be accessed from the drop down box to the right of the value field. For example, to select a Time, select Operators, then Format/Data/Time Operators, then Time hour:minute:sec, and "$(Time)" will be placed in the formula. Use these same steps for all similar expressions.

- **'Tag1' ** 'Tag2'
The preceding example (Power) takes Tag1 to the power of Tag2. If Tag1 is 4 and Tag2 is 2, the result is 16.

- abs('Tag1')

The preceding example gives the absolute value of Tag1.

Notes:
- Pay attention to Property Value Formats (single, double, or no quotes)

Notes:
- The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
- Click the Ellipsis button (...) to select a tag, operator, or function which is defined in a library.
- The Order of Precedence must be considered in formulas.
- Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Press the Back button (toolbar of your browser) to return to the previous page.

Expressions, Data Entry Target Expressions

An expression that, when evaluated, will result in data being sent to a target location.

Examples of Data Entry Expressions include:
- Send a setpoint to the PLC - a number entered by the operator can be sent to a PLC location.
- Set a local value - a number can be sent to a library entry.

Data Entry Expressions are constructed as follows:

'DEST' = SOURCE

- 'DEST' is the destination or target location for data to be written, like 'n7:0' or 'TagName'.
- SOURCE represents an expression whose value is written to 'DEST', and can include any of the following:
  - '?' - a placeholder for the value entered by the operator. The entered value is inserted at all occurrences of '?' in the expression. The '?' will appear in all data entry expressions.
  - 'address' - a location in a PLC
  - 'tag' - a tagname from a Tag Library
  - constant - number used for scale or offset
  - operators - numeric (+,-,*,/) or binary (|,&,^,<,>,...)

The following equations are examples of target expressions:

- 'n7:0' = 'ClientSystem,?'

The above example will send the data entered by the user to n7:0.

Note: TagLibrary called 'TagSystem' was configured with a Tag named "?" (without quotes), then a Client called 'ClientSystem' was configured to refer to the 'TagSystem' Library.

Note: If the Client Library is set as the Default in the Unit's properties, then the library can be omitted from the reference. Otherwise, the reference must include the library, ie: 'Lib,LibEntry'.

196
Tip: All Client and Tag Libraries can be accessed from the drop down box to the right of the value field. For example, to select the operator's input value, select **Clients**, then **ClientSystem**, then `?`, and `ClientSystem,?` will be placed in the formula.

- '40001' = 'ClientSystem,?' * 10

The above example will multiply the data entered by the user by 10, then send the result to 40001.

- 'PressureSetting'='ClientSystem,?'

The above example will send the data entered by the user to the tag named PressureSetting.

- 'n7:0' = (`'ClientSystem,?` * 'n7:1') * 'b3/1' + ((`'ClientSystem,?` * 'n7:2') * (n7:2 > 10))

The above example is for explanation only, the table below shows some values entered by the operator (`?` is shown instead of 'ClientSystem,?' for simplicity), calculations, and resulting values sent to the destination ('n7:0'). Note that (n7:2 > 10) evaluates to 1 if n7:2 is greater than 10, otherwise evaluates to 0.

<table>
<thead>
<tr>
<th>operator input '?'</th>
<th>n7:1</th>
<th>b3/1</th>
<th>n7:2</th>
<th>value sent to destination 'n7:0'</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>1</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>1</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td>0</td>
<td>20</td>
<td>60</td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td>1</td>
<td>20</td>
<td>75</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>0</td>
<td>20</td>
<td>80</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>1</td>
<td>20</td>
<td>100</td>
</tr>
</tbody>
</table>

Notes:
- **Pay attention to Property Value Formats** (single, double, or no quotes)
The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.

Click the Ellipsis button (…) to select a tag, operator, or function which is defined in a library.

The Order of Precedence must be considered in formulas.

Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Press the Back button (toolbar of your browser) to return to the previous page.

**Expressions, Direct Assignment**

An expression that, when evaluated, will result in data being sent to a target location. This assignment can be placed in a Make Action or Break Action property.

Examples of Direct Assignment Expressions include:

- Send a discrete value to the PLC - a bit value can be sent to a PLC location.
- Send an analog value to the PLC - a number can be sent to a PLC location.
- Set a local value - a number can be sent to a library entry.

Direct Assignment Expressions are constructed as follows:

\[ 'LIB,DEST' = SOURCE \]

- 'LIB,DEST' is the destination or target location for data to be written, like 'client,n7_0' or 'plc1,TagName'. **Note: The Library name must precede the Tag.**
- SOURCE represents an expression whose value is written to 'DEST', and can include any of the following:
  - 'address' - a location in a PLC
  - 'tag' - a tagname from a Tag Library
  - constant - number used for scale or offset
  - operators - numeric (+,-,*,:) or binary (|,&,^,<,>,...)

The following equations are examples of target expressions:

- 'client1,b3_0' = 1
  The above example will send 1 to client1, b3_0.
- 'plc1,40001' = 'speed' * 10
  The above example will multiply the tag speed by 10, then send the result to 40001 in plc1.

Notes:

- Pay attention to Property Value Formats (single, double, or no quotes)

Notes:

- The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
- Click the Ellipsis button (…) to select a tag, operator, or function which is defined in a library.
- The Order of Precedence must be considered in formulas.
Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

**Operators**

Below is a list of available **Operators**, **Formats**, and **Functions** which can be used in property values. This is displayed when the drop box for a value field is selected.

**Notes:**

- The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
- Click the Ellipsis button (...) to select a tag, operator, or function which is defined in a library.
- The Order of Precedence must be considered in formulas.
- Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Note: In some cases, it is simpler to use the keyboard to enter a function or operator (instead of using the drop box). For example: *, +, ), etc. are readily accessible on the keyboard.
Order of Precedence

- Array Operators
  - Left array
  - Right array
- Format/Data/Time Operators
  - Format left group
  - Format right group
  - Month
  - Day
  - Year
  - Hour
  - Minute
  - Seconds
  - Time hour:minute:sec
  - Date month/day/year
  - Clock hour:minute:sec month/day/year
  - Integer
  - Hexadecimal
  - Octal
  - Binary
  - Exponential
  - Floating point
  - Fixed point
  - ASCII character
- Tag Symbols
  - Tag start
  - Tag stop
  - Logical (1 bit)
    - Signed 8 bit integer
    - Unsigned 8 bit integer
    - Signed 16 bit integer
    - Unsigned 16 bit integer
    - Signed 32 bit integer
    - Unsigned 32 bit integer
    - 3 digit binary coded decimal
    - 4 digit binary coded decimal
    - 6 digit binary coded decimal
    - 8 digit binary coded decimal
    - 3 digit decimal number
    - 4 digit decimal number
    - 6 digit decimal number
    - 8 digit decimal number
    - IEEE single precision real
    - IEEE double precision real
    - ASCII text
- Miscellaneous Symbols
  - Input value
  - Escape
  - String quote
  - Decimal point
The following table is the order in which operators are evaluated, in **Order of Precedence** from highest to lowest. Where several operators appear together, they have equal precedence and are evaluated according to their associativity.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Type of Operation</th>
<th>Associativity</th>
</tr>
</thead>
<tbody>
<tr>
<td>[] ()</td>
<td>Expression</td>
<td>Left to right</td>
</tr>
<tr>
<td>&amp; * + -</td>
<td>Unary</td>
<td>Right to left</td>
</tr>
<tr>
<td>~ !</td>
<td></td>
<td></td>
</tr>
<tr>
<td>* / %</td>
<td>Multiplicative</td>
<td>Left to right</td>
</tr>
<tr>
<td>+ -</td>
<td>Additive</td>
<td>Left to right</td>
</tr>
<tr>
<td>&lt;&lt; &gt;&gt;</td>
<td>Bitwise shift</td>
<td>Left to right</td>
</tr>
<tr>
<td>&lt; &gt; &lt;= &gt;=</td>
<td>Relational</td>
<td>Left to right</td>
</tr>
<tr>
<td>== !=</td>
<td>Equality</td>
<td>Left to right</td>
</tr>
<tr>
<td>&amp;</td>
<td>Bitwise-AND</td>
<td>Left to right</td>
</tr>
<tr>
<td>^</td>
<td>Bitwise-exclusive-OR</td>
<td>Left to right</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bitwise-inclusive-OR</td>
</tr>
<tr>
<td>&amp;&amp;</td>
<td>Logical-AND</td>
<td>Left to right</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>=</td>
<td>Assignment</td>
<td>Right to left</td>
</tr>
</tbody>
</table>

**Note:**
- The table applies to the order of evaluation within a single expression. In state evaluations (ie: Indicator and Led states), with a list of expressions, each expression is evaluated as in the table, while the order of evaluation of the state list is specified by the State Evaluation property.

**Parameter Passing**

Parameters can be passed to Actions. This minimizes the number of Actions that are necessary by allowing re-use for similar instances. Two examples of this are shown below.

**Page Change Example (Goto Page Action)**

A good example of parameter passing is an Action file that is set up to call a page by passing a parameter (ie: the Page Name) from a Button on the page. Without parameter passing, an Action would need to be created for each page that will be called.

The following is an outline of how to create a re-usable GoToPage Action:

- Create 2 Pages, PageX and PageY.
- Create a **Goto Page Action** called GoToPage and set its Destination Page to #1. The #1 is a placeholder for the first parameter passed with this Action. The passed value (PageX or PageY) will replace the #1.
• Create a **Rectangular Button** on PageX and assign its Break Action ‘GoToPage(PageY)’. By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the GoToPage action.

• Create a **Rectangular Button** on PageY and assign its Break Action ‘GoToPage(PageX)’

The button on PageX will call PageY and vice-versa, with a single Action entry.

**Notes:**

• Page changes should be a result of the **Break Action** since that would be the last operation to be performed on the calling page. If the Make Action was used, then a new page would be called, and the Break Action from the calling page would be lost.

• #1 is used in the Action entry file as a placeholder for the first passed parameter.

• By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the GoToPage action.

**Bit Write Example (Assignment Action)**

Below is an example of a single Assignment Action entry used to turn a bit ON then OFF. This example allows sharing the BitChange Action for both writes.

• Create an **Assignment Action** called BitChange and set the first **Assignment Expression** to ‘Bit’=#1. (Again, the #1 is where the first passed parameter will be placed.)

• Create a Page.

• Create a **Rectangular Button** on the Page and put ‘BitChange(1)’ in the Make Action field and put ‘BitChange(0)’ in the Break Action field. Again, the value in parentheses and within the single quotes is the parameter to be passed to the BitChange actions.

When this button is pressed, the command becomes ‘Bit’=1. Similarly, when the button is released, the command becomes ‘Bit’=0. This example is a momentary pushbutton.

**Notes:**

• This type of control should be used with caution. The response time (between the make/break and the corresponding bit writes) may not be accurate enough for time critical applications.

• #1 is used in the Action entry file as a placeholder for the first passed parameter.

• By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the BitChange action.

**List Properties**

**List Property Editor Window**

Controls with lists of properties appear with the List Property Editor Window as shown below.
Note: Control List properties are generally attached to controls that have multiple dynamic states with several characteristics each. The above example is an Indicator, which can contain multiple states (On, Off,...) with many characteristics each (On FG Color, Off FG Color, On BG Color, Off BG color, ...).

**Viewing List Properties**

Sometimes List Property entries can be obscured due to the limits of column widths and screen resolution. Note the ".ucf Name" column entry is not completely visible in the example below.

**Adjusting the Column Width**

Column width can be adjusted by placing the cursor over the column label dividers, then click and drag to the desired width. Below, the ".ucf Name" column was widened.
Viewing a Row as a Column

Alternatively, selecting the "Single Row" tab at the bottom of the window will display the currently selected row as a column.
Expression Editor

Note: This is only available in Canvas Professional.

In many cases throughout the Canvas Professional editor, complex expressions are desired, referencing tags and values from various sources. The Expression Editor provides assistance in the construction of these expressions. It is a single editor which can be used throughout the project, to enter values into any property field. See below. The editor is topped by selecting the Expression Editor button on any property window, and can remain throughout application development or can be closed or minimized. Additionally, all properties can be edited without this editor as well, by clicking in the cell or using the component tree.
To use the Expression Editor, first select the cell of a property to be changed. Then select the Expression Editor button (if the window is not currently displayed) to show the window. Now enter property values into the scratchpad area by drilling down through clients and libraries, as well as entering values manually. Once the desired string is complete, the Apply button will send the string to the selected property.

Note:

- Pay attention to Property Value Formats (single, double, or no quotes)

The following options can be enabled/disabled by selecting the options icon on the title bar.

**Auto-apply** - If enabled, generates an Apply, thus enters data into the selected property, when the Expression Editor loses focus (ie: another window is selected).

**Auto-roll** - If selected property is supported, show the entire window, otherwise roll up to only show the title bar.

**Connection and Tag Tree** - Client and Tag Library "pane"
Property Value Formats and Syntax (single, double, or no quotes)

Throughout the ePro Canvas editors and property windows, property values of various types are entered. Depending on whether the value is **Evaluated** or **Non-evaluated**, several rules must be followed to accurately enter these values. Before the rules are applied, it must be determined whether it is an evaluated property or not.

**Evaluated Properties**

Properties which can vary during Runtime, require a mathematical evaluation and parsing for proper syntax. These **Evaluated properties** entries can be dynamic, thus having an undefined number of values. It is possible and common for an evaluated property to contain an entry or expression that is not dynamic, but the property is still evaluated. In the editor, there is a simple way of determining if a property is evaluated. **If a property has a pull-down arrow (▼) which leads to a pull-down library menu, the property is evaluated.** In the figure below, the Value property has a pull-down arrow, and when the arrow is selected, a library menu is presented as shown below. This gives access to various references from various locations, all of which can dynamically change during runtime. So, the Value property of a Readout Template is one example of an Evaluated Property.

**Non-evaluated Properties**

Properties which contain values which cannot vary during Runtime are NOT evaluated. **Non-evaluated properties** are static and have a finite set of values. These property types can be determined by the properties' type of entry - **when the library menu is not available, the property is non-evaluated.** For instance, fields with no pull-down arrows, Yes/No selections, and short menus are all NOT evaluated.
Below, the Orientation property is non-evaluated because its pull-down arrow leads to a menu with only several options (not the entire library menu).

![Property Editor](image)

**Evaluated Properties Syntax**

Note: Using the pull-down menus to select the entry values is the easiest way to determine syntax, because quotes are automatically added when needed.

**Text and Names**

Double quotes are required around strings which include text and names.

- **Text Strings** that are entered directly in a **Text** property or a **Media Library Entry** will be displayed exactly as entered, and requires DOUBLE quotes
  
  - "Template Title"
  
  - "rpm"
  
  - "This text will appear"

Note: when referencing these media library entries, the strings are referenced with single quotes.

Note: Legal characters in text fields (i.e. characters within double quote marks, "abcedgg") include all Alpha and Numeric characters, spaces and special characters except:

- Backslash. To display a backslash within double quotes you need to place a second backslash in the string. Eg. "Start \ Stop" will display as Start \ Stop
- Double Quote. To display a double quote within double quotes it needs to be preceded by a backslash and must be either the first or last character in the string. Eg. "\"To be or not to be\"" will display as "To be or not to
be” . To place double quotes in the middle of a text string you need to use text concatenation. Eg. “This is a "Special" + "case" will display as This is a "Special" case

Single Quote. To display a single quote within double quotes it needs to be preceded by a backslash. Eg. “This is a "Special\" case” will display as This is a ‘Special’ case

&  Ampersand. To display an ampersand within double quotes you need to place a second ampersand in the string, otherwise the ampersand character serves to underline the following character within the string. Eg. “This && That” will display as This & That . Whereas the string ”&T&N&T” will display as TNT

• **Images on a Page** can be directly entered (ie: not using the media library) by browsing for the image name, which will add DOUBLE quotes and double the backslash characters
  
  • "c:\overview.bmp"

  **Note:** Backslashes (\) are used to identify control characters embedded in a string. If a \ is needed inside a string with double quotes, it must be duplicated for distinction (ie: "c:\path\filename"). However, / can also be used without doubling (ie: "c:/path/filename").

  Images can also be manually entered with single forward slashes

  • "c:/overview.bmp"

  **Note:** When Images are entered into the media library, quotes are not required.

• **Documents** entered into a **View Action, Document Viewer** Type, require a name in DOUBLE quotes. Again, backslashes are doubled.

  • "d:\\information.html"

  Documents can also be manually entered with single forward slashes

  • "d:/information.html"

• **PLC or Library Entry Data** can be embedded into text strings as described below under the **Combinations/Expressions/Concatenations** heading.

### Library References

Generally, single quotes are required around library entries. A good way to enter these is by selecting the pull-down box, and drilling down through the libraries to find the entry. Single quotes will automatically be added when needed

• Properties that contain **Clients** and **Library Entries** (Tag Library Entries, Action Library Entries, Media Library Entries, etc.) are entered with SINGLE quotes

  • ’ClientPLC,400001’
  
  • ’Tag’
  
  • ’LibEntryName’
  
  • ’Lib,LibEntryName’

• Active library names can be entered alternatively, using **Explicit** references to **Clients** and **Library Entries**. These are entered with SINGLE quotes. ’MediaLib1,Ref’ can be replaced with

  • ’:Media:,Ref’

• **Text** referenced in a text property, from **Media Library** entries will be enclosed in single quotes, even though the reference represents text strings (‘StartText’, 'TextLib,StartText').
Note: when text strings are created in media library entries, remember to place the strings in double quotes.

Note: Legal characters in tag names or Item Names (i.e. characters within single quote marks, ‘abcdefg’) include all Alpha and Numeric Characters, spaces and special characters EXCEPT:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>Casting operator</td>
</tr>
<tr>
<td>@</td>
<td>Internal Client separator</td>
</tr>
<tr>
<td>,</td>
<td>Comma</td>
</tr>
<tr>
<td>=</td>
<td>Equal Sign</td>
</tr>
<tr>
<td>\</td>
<td>Backslash (Escape Character)</td>
</tr>
<tr>
<td>'</td>
<td>Single Quote</td>
</tr>
<tr>
<td>&quot;</td>
<td>Double Quote</td>
</tr>
</tbody>
</table>

Literal Numbers

Literal or hard-coded numbers used within evaluated properties, require NO quotes. These are evaluated because of their property type, yet are static since the value will not change during Runtime.

- **Evaluated Numeric Values** have NO quotes
  - 1
  - 98765
  - 2005

Combinations/Expressions/Concatenations

Expression properties follow the same rules in that references (tags, client tags, media entries) require single quotes, but constants and operators do not have quotes.

- **Writes**
  - 'Client,Ref' = 1

- **Comparisons**
  - 'Client,Ref' == 1

- **Scaling**
  - 'Client,Ref' / 10

- To **embed data** from the PLC in a text string, ie: to mix text and data in a text control, you must use text **concatenation**.
  - "The tank level is " + $I4('client1,tag1') + " Gallons"

If the value of tag1 is 1234, this will display … The tank level is 1234 Gallons

When using concatenation you may embed spaces either before or after the plus character to view the string more clearly in the editor and the spaces outside single or double quotes will be discarded at runtime.

Anywhere you can place literal text (i.e. text within double quotes) you can also place media entries or tags with data type of string. Any tag references within the parentheses of the formatted data can use math or logic operators to create an expression. The following is the general formatted data syntax:

$$tw.d(expression)$$
where ...  
$ = \text{format indicator} \\
t = \text{type of numeric display} \\
\begin{align*} 
I & - \text{Integer} \\
H & - \text{Hexadecimal} \\
B & - \text{Binary} \\
D & - \text{Floating decimal real value} \\
O & - \text{Octal} \\
F & - \text{Fixed decimal real value} \\
A & - \text{Ascii} \\
\end{align*} \\
w = \text{Total field width including decimal point, negative sign (-), and positive sign (+)} \\
. = \text{Separator between width of format and the number of decimal places (used with F format)} \\
d = \text{Number of decimal places (used with F format)} \\

Format type D (floating decimal point) permits the decimal point to float in the display depending on the tag's value. This contrasts with format type F (fixed decimal point) which formats a value with a fixed decimal location.

**Formatted Data Examples:**

If ‘client,tag1’ has a value of 54321, then:

<table>
<thead>
<tr>
<th>Formatted String</th>
<th>Value Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>$I5('client1,tag1')</td>
<td>54321</td>
</tr>
<tr>
<td>$F6.2('client1,tag1' / 100)</td>
<td>543.21</td>
</tr>
<tr>
<td>$D8('client1,tag1' / 100)</td>
<td>543.2100</td>
</tr>
<tr>
<td>$H4('client1,tag1')</td>
<td>D431</td>
</tr>
<tr>
<td>$O6('client1,tag1')</td>
<td>152061</td>
</tr>
<tr>
<td>$B16('client1,tag1')</td>
<td>1101010000110001</td>
</tr>
</tbody>
</table>

If ‘client,tag1’ has a value of 16706, which is 4142 hex (A=41 hex, B=42 hex), then:

<table>
<thead>
<tr>
<th>Formatted String</th>
<th>Value Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A('client1,tag1')</td>
<td>AB</td>
</tr>
</tbody>
</table>

If there is no additional literal text, media library text or PLC String data types to appear in the text control and you only wish to display the value of the tag you don't need to use the formatted data syntax because the text control will automatically convert the value to a string. For example, if the text property is set to ‘client1,tag1’ and the value is 54321 then it will display as 54321.

- ':Media:,Motor 1’ + " " + ':Media:,ON’ + " " + $I5('client1,tag1') + " amps”

Assuming the media library has two entries named ‘Motor 1’ and ‘ON’ containing their respective strings, and the tag ‘client1,tag1’ is a 16 bit integer (short) data type with a
value of 54321, then the preceding text property value will be displayed online as ...
Motor1  ON  54321 amps

Non-evaluated Properties Syntax

If it is determine that a property is NOT Evaluated, then there are NO quotes required. The majority of these are numbers and pull-down menu entries (but not pull-down library entries).

Non-evaluated/No Quotes Examples

- Non-evaluated values with a YES or NO value require no quotes.
- Non-evaluated values selected from a pull-down menu with few choices will be selected from the menu and contain NO quotes.
  - HORIZONTAL
  - VERTICAL
  Note: this does not include the pull-down library box.
- Strings that are not evaluated, such as a page added to a configuration, do NOT require quotes.
  - Page 1
- Images that are entered into the media library by browsing for the image path, will add a path string with NO quotes
  - c:/overview.bmp
  This entry can also be entered as
  - c:\\overview.bmp
- In the Document Viewer, Home Page and Document Viewer Content, Document Location properties, NO quotes are used
  - www.eaton.com
  - d:/information.html
- Non-evaluated Numeric Values have NO quotes

Explicit Library Referencing

Active library names can be entered alternatively, using Explicit references to Library Entries. Generally, this method works with library types that allow only one library per configuration. However, multiple clients are allowable in a unit, and can be accessed as shown in the table below.

The reference 'MediaLib1,Ref' can be restated as
- ':Media:,Ref'
And the reference 'ClientSystem,?' can be replaced with
- ':System:,?'
Notice how this gives flexibility since there is no tie to a specific library name, and will work with whatever the library is named in the configuration. For example, explicit references to an action library on a page allow that page to be re-used in multiple configurations, each accessing a different action library.

Here are the explicit names of each library.

<table>
<thead>
<tr>
<th>Library Type</th>
<th>Explicit Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Client</td>
<td>:System:</td>
</tr>
<tr>
<td>Unit’s 1st</td>
<td>:Client1:</td>
</tr>
</tbody>
</table>
User defined tags may be added manually to the System Client tag file TagSystem. These tags will all have an initial value of zero and the data type may be specified or you can select the type to be “Interface Supplied” which will default to unsigned 32-bit integer. You can add a tag to the TagSystem by opening the tag file properties dialog and selecting the “Tags” tab, and then double clicking on the line labeled “Double click here to append a row”. The Name is user specified as long as it is unique in the tag file, and the Definition field should be identical to the Name. The default Data Type of Interface Supplied may be changed to any of the types shown below:
You can also add a tag by selecting the TagSystem library in the Project Components pane of Project Explorer, then right-click in the Component Data pane and select New Tag Library Entry.

User defined system tags will not change value at runtime unless the user configures a function that writes to those tags. They may be written to from a pushbutton or button bar function, from a data entry function, or from an Assignment Action. If the user configures a Conditional Passthru Assignment Action a user defined system tag can be updated from the PLC through an OPC Server client connection.

User defined system tags may be useful for a number of purposes. Their value can be toggled by a pushbutton to control conditional visibility of page objects, or a system tag may be used in place of a PLC register for storage of the configuration’s Active Language ID. A system tag may also be used as an index to one or more Indexed Lists. There are many more uses of user defined system tags and in general they can be used for local functions that will reduce the requirement of Operator Interface specific registers in the PLC. Note however that unlike PLC registers, system tags are not persisted values, which means that system tags will be set back to their default value of zero at each reboot of the ePro. This may limit some of the uses to which you would apply user defined system tags.

### All Properties

#### # of Horizontal Divisions

The number of horizontal lines displayed on the trend grid.
Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a library entry

# of Vertical Divisions

The number of vertical lines displayed on the trend grid.

Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a library entry

# of Minor Divisions

The number of minor scale tick marks on the scale. Minor divisions are indicated with shorter tick lines than major divisions, and no numeric scale value.

Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a library entry

# of Major Divisions

The number of major scale tick marks to appear between the max. and min. extremes on the scale. Major divisions are shown with longer tick lines (than minor divisions) and numeric scale values.

Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a combination of library entries and formulas

2 Touch Select

This setting allows the menu item to be activated by one or two touches.

Field Entries:
On - 2 touch mode - this allows the Scroll Up and Scroll Down functions to be used to move through the menu items without selecting the item until the item is touched. This is handy when there are more items in the menu than are visible.

Off - 1 touch mode - immediate activation of menu item when Scroll Up and Scroll Down or touching the item.

To change:
- Click on the On/Off value to toggle it.

**Alignment**

The horizontal text alignment for the control.

Field Entries:
- Left
- Center
- Right

To change:
- Use the drop down button and select from the drop list

**Arc Style**

The type of arc to be displayed.

Field Entries:
- Arc - part of circumference
- Chord - part of circumference, with a line connecting the start and end points
- Wedge - pie shape

To change:
- Use the drop down button and select from the drop list

**Arrowhead**

The type of line end.

Field Entries:
- {-----} None
- {-->}
- {<--}
- {<-->} Both

To change:
- Use the drop down button and select from the drop list

**Arrowhead Height**

Selects the height of the arrowhead.

Field Entries:
- Number
Getting Started

To change:

- Type a value
- Use the Up and Down arrow buttons to change the value by 1 point increments

**Background (BG) Color**

The background color for the control or sub-control.

Field Entries:
- Color

To change:
- Click the Ellipsis button (…) to call the Color window, then select a color (or define a custom color) for the background.

**Background Style**

The line pattern used in conjunction with the background color to fill a control or sub-control.

Field Entries:
- None
- Horizontal
- Vertical
- Forward Diagonal
- Backward Diagonal
- Cross
- Diagonal Cross

To change:
- Use the drop down button and select from the drop list

*Note: for Text controls, the line color of the style will be the same as the Text Frame's Foreground Color. However, for all other controls, the line color of the style will be the same as the Foreground Color, which is also the color of the control's border.*

**Break Action**

The text string to be displayed when the control button is released.

*Note: Identical Names are not allowed as text strings.*

Field Entries:
- Text string in double quotes (ie: "This text will appear").
- A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,TextEntry' will display the value of TextEntry from the library called MediaLibrary).

To change:
- Type an entry.
- Use the drop down button to select a library entry.

**Break Label**
The text string to be displayed when the control button is released.

**Note:** Identical Names are not allowed as text strings.

Field Entries:
- Text string in double quotes (ie: "This text will appear").
- A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,TextEntry' will display the value of TextEntry from the library called MediaLibrary).

To change:
- Type an entry.
- Use the drop down button to select a library entry.

**Brightness**

The value indicating how bright a control is. Primarily used in Image controls.

**Cancel On Entry**

This setting provides the status of the operator input device during Runtime.

Field Entries:
- Yes - Remove operator input device (numeric entry, button entry) when operator keys data and presses enter.
- No - Leave the operator input device after operator keys data and presses enter. It will be removed when somewhere on the page is touched.

To change:
- Click on the Yes/No value to toggle it.

**Cell Height**

The control's vertical size, based on the following:
- Cell Height = 1 ---> 96 pixels
- Cell Height = 2 ---> 208 pixels
- Cell Height = 3 ---> 320 pixels

Field Entries:
- Number

To change:
- Type a number
- Use the Up and Down arrow buttons to change the position by 1 point increments

**Cell Width**

The control's horizontal size, based on the following:
- Cell Width = 1 ---> 96 pixels
- Cell Width = 2 ---> 200 pixels
- Cell Width = 3 ---> 304 pixels
- Cell Width = 4 ---> 408 pixels
• Cell Width = 5 ----> 512 pixels

Field Entries:
• Number

To change:
• Type a number
• Use the Up and Down arrow buttons to change the position by 1 point increments

Common Properties

The following properties are available for all controls.

General tab
Note: In controls that are made of several base controls, the most used properties of the base controls are moved to the General tab.

- Name
- Description
- Visibility Expression
- State/Style/Action
- Operator Input Type
- Operator Input Indicator
- Entry
- Cancel On Entry

Data Entry tab
Note: The following properties are hidden unless Data Entry is selected as the Operator Input Type in the General Tab.

- Data Entry Type
- Target Expression
- Upper Limit
- Upper Limit Violation Action
- Log Upper Limit Violation
- Lower Limit
- Lower Limit Violation Action
- Log Lower Limit Violation

Buttons tab
Note: This tab contains a table which allows multiple of the following entries.
Note: The following properties are hidden unless Button is selected as the Operator Input Type in the General Tab.

- Make Label
- Make Action
- Break Label
- Break Action
- Make Font
- Make FG Color
- Make BG Color
- Make BG Style
- Break Font
- Break FG Color
- Break BG Color
- Break BG Style

**Position/Size tab**

*Note: Few controls have other positioning and sizing properties which are described with that control.*

- Position X
- Position Y
- Width
- Height
- Rotation

*Note: Rotation is ONLY available in base controls (lines, ellipses, rectangles, etc.)*

**Contrast**

The value indicating the control's contrast. Primarily used in Image controls.

**Data Entry Type**

The format of the entry which determines the type of entry method to be used for this control.

**Field Entries:**

- Alpha-Numeric - in runtime, a compact, on-screen keypad is topped, allowing entry of alpha and/or numeric values. Function keys provide access to all keys, as the keys are shared for multiple letters/numbers.
- QWERTY - in runtime, a full QWERTY style, on-screen keypad is topped, allowing a full entry of alpha and/or numeric values.
- Keyboard - in runtime, an entry field is displayed, allowing data entry from an external keyboard
- Numeric - in runtime, an on-screen keypad is topped, allowing entry of only numeric values
- Additional devices that are available will appear in the list also.

To change:

- Use the drop down button and select from the drop list

**Decimal Places**

The number of decimals to allocate and display in a numeric value.

**Field Entries:**

- Number

To change:
• Type a number
• Use the Up and Down arrow buttons to change the value by 1 decimal place increments

Description

A short (optional) description of the control.

Note: Identical Names are not allowed as text strings.

Display

The appearance of an image in an Image control.

Field Entries:
• Stretch - expand or shrink the image to fit the bounding rectangle
• Tile - show in actual size, but show multiple copies if the bounding rectangle is large enough

To change:
• Use the drop down button and select from the drop list

Display (Clock)

The information to appear in the Clock control.

Field Entries:
• Date Time - shows date to the left of time
• Time Date - shows time to the left of date
• Date - shows date only
• Time - shows time only

Note: Specific formats for the date and time display are taken from the unit running the online configuration.

To change:
• Use the drop down button and select from the drop list

End X

The horizontal (X coordinate) position of the endpoint of the line on the page, in pixels.

Note: X,Y coordinates 0,0 represent the upper left corner.

Field Entries:
• Number

To change:
• Type a number
• Use the Up and Down arrow buttons to change the position by 1 point increments

End Y

The vertical (Y coordinate) position of the endpoint of the line on the page, in pixels.

Note: X,Y coordinates 0,0 represent the upper left corner.
Field Entries:

- Number

To change:

- Type a number
- Use the Up and Down arrow buttons to change the position by 1 point increments

**Ending Angle**

The degree of an arc’s ending angle.

**Notes:**

- 0° is to the right, 90° is straight down, 180° to the left, 270° is straight up.
- Clockwise is the positive (+) direction.

To change the value in this field:

- Type a number
- Use the Up and Down arrow buttons to change the value in 1 degree increments

**Entry**

A library entry which will occur when the corresponding State/Style/Action is true.

**Note:** To enable this field, select Style Library Entry on the Operator Input Type field.

Field Entries:

- Library Entry

To change:

- Use the drop down button to select an entry from the library.

**Expression/Target Expression**

Indicates how the data will appear (or where data will be sent) online. Dynamic properties are entered via expressions - see the following for details.

Field Entries:

- Number or library entry as described in:
  - Expressions, Discrete
  - Expressions, Analog
  - Expressions, Data Entry
  - Operators

To change:

- Enter expression using single quotes around ?, tags, and library entries
- Use the drop down button to select and add a library entry

**File Name**

The name of the recipe xml file, which is used to populate the recipe menu control.

**Note:** Identical Names are not allowed as text strings.
Field Entries:

- Text string in double quotes (ie: "c:\\Recipe1.xml").
- A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,RecipeName' will get the recipe name from RecipeName in MediaLibrary).

To change:

- Type an entry.
- Use the drop down button to select a library entry.

**Font**

The font attributes for the control or sub-control.

Field Entries:

- Font Name

To change:

- Click the Ellipsis button (...) to call the Font window, then select and change attributes such as font type, font style, and font size.

**Foreground (FG) Color**

The foreground color for the control or sub-control.

Field Entries:

- Color

To change:

- Click the Ellipsis button (...) to call the Color window, then select a color (or define a custom color) for the foreground.

**Frame Style**

The frame style for the control or sub-control frame.

Field Entries:

- Normal
- 3D
- Highlight Bottom/Rt.
- Highlight Top/Left
- Rounded

To change:

- Use the drop down button and select from the drop list

**Grid Axis Color**

The color of the horizontal and vertical axes in the trend area.

Field Entries:

- Color

To change:
- Click the Ellipsis button (…) to call the Color window, then select a color (or define a custom color) for the background.

**Grid Color**

The background color of the trend area.

Field Entries:
- Color

To change:
- Click the Ellipsis button (…) to call the Color window, then select a color (or define a custom color) for the background.

**Grid Outline Color**

The color of the border of the trend area.

Field Entries:
- Color

To change:
- Click the Ellipsis button (…) to call the Color window, then select a color (or define a custom color) for the background.

**Grid Values**

The selection for showing or not showing the vertical grid labels (i.e., scale numbers).

Field Entries:
- Yes - show the labels
- No - do not show labels

To change:
- To toggle Yes/No, click the property entry area.

**Grid Values Color**

The color for text values (scale and time/date) around the trend area.

Field Entries:
- Color

To change:
- Click the Ellipsis button (…) to call the Color window, then select a color (or define a custom color) for the value.

**Grid Values Font**

The font attributes for text values (scale and time/date) around the trend area.

Field Entries:
- Font Name

To change:
• Click the Ellipsis button (…) to call the Font window, then select and change attributes such as font type, font style, and font size.

**Height**

The control's vertical (Y coordinate) size, in pixels.

Field Entries:
• Number

To change:
• Type a number
• Use the Up and Down arrow buttons to change the position by 1 point increments

**Highlight Color**

The highlight color for the control or sub-control.

*Note: the color is visible only when a Frame Style with a highlight is selected.*

Field Entries:
• Color

To change:
• Click the Ellipsis button (…) to call the Color window, then select a color (or define a custom color) for the highlight.

**Icon Size**

The size of the icon to be displayed in the control.

Field Entries:
• Small - 16X16 pixels
• Medium - 32X32 pixels
• Large - 48X48 pixels

To change:
• Use the drop down button and select from the drop list

**Image (Name)**

The name of the image to be displayed.

Field Entries:
• Media Library Entry
• Direct Entry (ex: "c:\images\image.bmp")

To change:
• Use the drop down button to select a library entry

**Index Input Location**
The index in the menu is selected by assigning a value to this reference. Setting this reference to 0 selects the top item, 1 selects the next and so forth.

Field Entries:
- Client or Tag Library entry

To change:
- Enter expression using single quotes around tags, and library entries
- Use the drop down button to select and add a library entry

**Index Output Location**

The index of the currently activated menu selection is sent to this reference. The top item is 0, the next is 1 and so forth.

Field Entries:
- Client or Tag Library entry

To change:
- Enter expression using single quotes around tags, and library entries
- Use the drop down button to select and add a library entry

**Invert Colors**

The selection for showing the reverse, or negative of the colors.

Field Entries:
- Checkbox selected - show the reverse
- Checkbox NOT selected - show the normal image

To change:
- To invert the colors, click the checkbox; To remove inversion, click checkbox again.

**Log Lower Limit Violation**

The setting which indicates whether to log the lower limit violations or not. Violations are logged in the System Event Viewer window.

Field Entries:
- Yes - Log violations
- No - Do Not log violations

To change:
- To toggle the setting, click the field; To toggle again, click field again.

**Log Upper Limit Violation**

The setting which indicates whether to log the upper limit violations or not. Violations are logged in the System Event Viewer window.

Field Entries:
- Yes - Log violations
- No - Do Not log violations
Getting Started

To change:

- To toggle the setting, click the field; To toggle again, click field again.

**Lower Limit**

The smallest value that can be entered by the operator (and sent to the target expression's location).

Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a combination of library entries and formulas

**Lower Limit Violation Action**

The action to be taken when data entered by the operator is lower than the Lower Limit.

Field Entries:

- Reenter - The user is prompted to reenter a value in the data entry area.
- Apply Lower Limit - The lower limit value is applied and written to the PLC.

To change:

- Use the drop down button and select from the drop list

**Major Tick Values**

The selection to show or hide scale values.

Field Entries:

- Enabled Checked - Show scale values.
- Enabled NOT Checked - Hide scale values.

To change:

- To toggle the property, click the checkbox; To toggle again, click checkbox again.

**Make Action**

The action to occur when the user presses the control's button.

Field Entries:

- Action Library Entry
- Entry as described in Expressions, Data Entry for direct assignment, ie: PLC writes

To change:

- Enter expression using single quotes around tags, and library entries
- Use the drop down button to select and add a library entry

**Make Label**

The text string to be displayed when the control button is pressed.
Note: Identical Names are not allowed as text strings.

Field Entries:

- Text string in double quotes (ie: "This text will appear").
- A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,TextEntry' will display the value of TextEntry from the library called MediaLibrary).

Max Calibration

The highest point displayed by the scale. This value displays on the top of the scale.

Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a library entry

Max Trend Interval

The number of points (or updates) shown on the trend. This is the quantity of data displayed for Interval triggered trends. For instance, if this value is set at 10, the last 10 updates will span the trend area.

Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a combination of library entries and formulas

Message Expression

An expression which points to a message in the PowerPro Media Library.

Min Calibration

The lowest point displayed by the scale. This value displays on the bottom of the scale.

Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a combination of library entries and formulas
**Mirror**

The selection for flipping the control along the vertical axis.

Field Entries:
- Checkbox selected - show the flipped image
- Checkbox NOT selected - show the normal image

To change:
- To mirror the image, click the checkbox; To remove mirroring, click checkbox again.

**Name**

The name of the control, which is generally used as a title.

*Note: Identical Names are not allowed as text strings.*

Field Entries:
- Text string in double quotes (ie: "This text will appear").
- A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,TextEntry' will display the value of TextEntry from the library called MediaLibrary).

To change:
- Type an entry.
- Use the drop down button to select a library entry.

**Name, Button Bar**

The list of Buttons to be placed on the bar.

*Note: Identical Names are not allowed as text strings.*

To add a new button, double-click at the bottom of the Name list (on the Button tab).

To edit the buttons,

**Number of Samples**

The number of points (or updates) shown on the trend. This is the quantity of data displayed for variable triggered (Discrete or Change) trends. For instance, if this value is set at 10, the last 10 updates will span the trend area. Note: this data may not give a desired historical perspective, ie: the triggering is not based on time.

Field Entries:
- Number
- Library entry as described in Expressions, Analog

To change:
- Type a value
- Use the drop down button to select a library entry

**Operator Input Indicator**

Selection for the position of the operator input type on the control.

Field Entries:
- Top – Left
- Top – Middle
- Top – Right
- Left – Middle
- Right – Middle
- Bottom – Left
- Bottom – Middle
- Bottom – Right

To change:
- Use the drop down button and select from the drop list

**Note:** to enable this property, an Operator Input Type must be selected.

### Operator Input Type

The operator input type for the control. Selecting an operator input type enables the fields for setting up operator input (such as, write’s to the PLC).

Field Entries:
- None - No operator input type is displayed on the component.
- Style Library Entry - Enables the Entry field on the General tab and allows selecting an Entry from the Style library.
- Data Entry - Allows setup of the Data Entry functions to allow operator input on this control. When selected, the fields on the Data Entry tab are enabled.
- Button - Allows setup of button control functions on this control. When selected, the fields on the Button Entry tab are enabled.

To change:
- Use the drop down button and select from the drop list

### Orientation

The direction of the control.

Field Entries:
- Vertical
- Horizontal

To change:
- Use the drop down button and select from the drop list

### Pen Style

The type of line used for the control.

Field Entries:
- Solid
- Dash
- Dot
• Dash-Dot
• Dash-Dot-Dot

To change:
• Use the drop down button and select from the drop list

**Pen Width**

The thickness of the line used for the control.

Field Entries:
• Number

To change:
• Type a value
• Use the Up and Down arrow buttons to change the value by 1 point increments

**Placement**

Tick mark’s location on the scale.

*Note: Placement depends on whether the scale is horizontal or vertical.*

Field Entries:
• Left/Top
• Right/Bottom

To change:
• Use the drop down button and select from the drop list

**Position X**

The control’s horizontal (X coordinate) position on the page, in pixels.

*Note: X,Y coordinates 0,0 represent the upper left corner.*

Field Entries:
• Number

To change:
• Type a number
• Use the Up and Down arrow buttons to change the position by 1 point increments

**Position Y**

The control’s vertical (Y coordinate) position on the page, in pixels.

*Note: X,Y coordinates 0,0 represent the upper left corner.*

Field Entries:
• Number

To change:
• Type a number
• Use the Up and Down arrow buttons to change the position by 1 point increments
Rotation

The rotation of the control, in degrees.

Notes:
- 0° is to the right, 90° is straight down, 180° to the left, 270° is straight up.
- Clockwise is the positive (+) direction.

To change the value in this field:
- Type a number
- Use the Up and Down arrow buttons to change the value in 1 degree increments

Sample Interval

The trend update rate. For instance, if this value is set at 3 and the Trend Interval Units is set to Hours, then the trend will update every 3 hours.

Field Entries:
- Number
- Library entry as described in Expressions, Analog

To change:
- Type a value
- Use the drop down button to select a library entry

Scale Color

The color of the scale tick marks.

Field Entries:
- Color

To change:
- Click the Ellipsis button (...) to call the Color window, then select a color (or define a custom color) for the scale.

Shadow Style

The shadow style for the control's frame.

Field Entries:
- None
- Top/Left
- Bottom/Right
- Bottom/Left
- Top/Right

To change:
- Use the drop down button and select from the drop list

Start X
The horizontal (X coordinate) starting position of a line on the page, in pixels.  
**Note:** X,Y coordinates 0,0 represent the upper left corner. 

**Field Entries:**
- Number

**To change:**
- Type a number
- Use the Up and Down arrow buttons to change the position by 1 point increments

**Start Y**

The vertical (Y coordinate) starting position of a line on the page, in pixels.  
**Note:** X,Y coordinates 0,0 represent the upper left corner. 

**Field Entries:**
- Number

**To change:**
- Type a number
- Use the Up and Down arrow buttons to change the position by 1 point increments

**Starting Angle**

The degree of an arc's starting angle.  

**Notes:**
- 0° is to the right, 90° is straight down, 180° to the left, 270° is straight up.
- Clockwise is the positive (+) direction.

**To change the value in this field:**
- Type a number
- Use the Up and Down arrow buttons to change the value in 1 degree increments

**State Evaluation**

Selection which chooses how logic will be evaluated for the given control. In cases where multiple states can be defined (ie: Indicator and Led states), the following setting determines the criteria used to determine the true state.

**Field Entries:**
- Mutual Exclusion – state is determined by the last updated value which is part of a true state expression. Values are constantly updated, thus state expressions are constantly evaluated. It is possible that more than one state is true at any time. This should be avoided by using plc or state logic to ensure only one state at a time is true (ie: this selection is intended for states that are mutually exclusive). Multiple states may be executed, however the state expression which contains the last triggered tag value will be visible.
- If..Then..ElseIf – state is determined by the first true expression, starting from the top. As soon as a state expression in the list is evaluated as true, the evaluation stops. Only the topmost true state will be shown. When any tag in any state expression changes, the list is re-evaluated from the top. States should be prioritized in the list accordingly.
Note: If there are no defined states and only a constant 1 for the last state of an IfThenElse indicator, the colors don't always initialize/draw correctly. A workaround is to create a tag in the PLC that is always set to a 0 with a tag name of undef, then create 3 states where state 1 is ‘Client,undef’, 2 is ‘!Client,undef’, and state 3 is 1 for bad data indication. Have the color of the first state set for the “On” color, the second the “Off” color and the third the “Bad PLC Data” color.

To change:
- Use the drop down button and select from the drop list

State/Style/Action

A conditional expression that, when evaluated to true, displays the characteristics (a style and/or action) as defined in the library.

Field Entries:
- Number or library entry as described in Expressions, Discrete.

To change:
- Enter expression using single quotes around tags, and library entries
- Use the drop down button to select and add a library entry

Style

An entry from the Style library. The selected style appears on the control when the associated State/Style/Action is true.

Field Entries:
- Action Library Entry

To change:
- Use the drop down button to select a library entry

Text Output Location

The name of the currently activated menu selection is sent to this reference.

Field Entries:
- Client or Tag Library entry

To change:
- Enter expression using single quotes around tags, and library entries
- Use the drop down button to select and add a library entry

Tick Placement

Use this field to mirror the scale ticks marks on the bar scale.

Field Entries:
- To mirror the tick marks - Click the box next to the Mirror value.
- To NOT mirror the tick marks - Do not click the box next to the Mirror value.

To change:
- To toggle the property, click the checkbox; To toggle again, click checkbox again.
**Time Values**

The selection for showing or not showing the horizontal grid labels (time and date information).

Field Entries:
- Yes - show the labels
- No - do not show labels

To change:
- To toggle Yes/No, click the property entry area.

**Title**

The name of the control, which is generally used as a title.

*Note: Identical Names are not allowed as text strings.*

Field Entries:
- Text string in double quotes (ie: "This text will appear").
- A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,TextEntry' will display the value of TextEntry from the library called MediaLibrary).

To change:
- Type an entry.
- Use the drop down button to select a library entry.

**Trend Interval Units**

The time interval used as a basis for trend updates. This is the minimum rate at which the trend will be updated. For instance, if this value is set to "Minutes", then a Sample Interval setting of 1 would result in an update every 1 minute.

Field Entries:
- Milliseconds
- Seconds
- Minutes
- Hours
- Days

To change:
- Use the drop down button and select from the drop list

**Trend Target Expression**

For "Discrete" triggers, this expression drives trend updates when the expression changes from FALSE to TRUE (no change occurs when it resets).

Field Entries:
- Discrete library entry as described in:
  - Expressions, Discrete
  - Operators
For "Change" triggers, this expression drives trend updates when the expression (or any variable within) is changed.

Field Entries:

- Expression library entry as described in:
  - Expressions, Discrete
  - Expressions, Analog
  - Operators

To change:

- Enter expression using single quotes around ?, tags, and library entries
- Use the drop down button to select and add a library entry

**Trigger Type**

The mechanism which causes the trend to update.

Field Entries:

- Interval - time interval for periodic updates
- Discrete - a binary variable transition to TRUE
- Change - a change to a variable in the Target Expression

To change:

- Use the drop down button and select from the drop list

**Units**

The units displayed on the control, such as "Deg F" or "rpm."

*Note: Identical Names are not allowed as text strings.*

Field Entries:

- Text string in double quotes (ie: "rpm").
- A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,TextEntry' will display the value of TextEntry from the library called MediaLibrary).

To change:

- Type an entry.
- Use the drop down button to select a library entry.

**Upper Limit**

The largest value that can be entered by the operator (and sent to the target expression’s location).

Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a combination of library entries and formulas
Upper Limit Violation Action

The action to be taken when data entered by the operator exceeds the Upper Limit.

Field Entries:
- Reenter - The user is prompted to reenter a value in the data entry area.
- Apply Upper Limit - The upper limit value is applied and written to the PLC.

To change:
- Use the drop down button and select from the drop list

Value

The value expression for the data. The result of this expression is a value/number (generally from the PLC) that is displayed on the control.

Field Entries:
- Number or library entry as described in:
  - Expressions, Discrete
  - Expressions, Analog
  - Operators

To change:
- Enter expression using single quotes around tags, and library entries
- Use the drop down button to select and add a library entry

Value Color and Pen Color

The color for data values.

Field Entries:
- Color

To change:
- Click the Ellipsis button (...) to call the Color window, then select a color (or define a custom color) for the value.

Visibility Expression

A conditional expression that, when evaluated to true, displays the control. When false, the control does not appear on the page.

Field Entries:
- Number or library entry as described in Expressions, Discrete.

To change:
- Enter expression using single quotes around tags, and library entries
- Use the drop down button to select and add a library entry

Width

The control's horizontal (X coordinate) size, in pixels.
Field Entries:
  • Number
To change:
  • Type a number
  • Use the Up and Down arrow buttons to change the position by 1 point increments

**X Points**

The horizontal (X coordinate) position of the polygon's vertex on the page, in pixels.

_Note: X,Y coordinates 0,0 represent the upper left corner._

Field Entries:
  • Number
To change:
  • Type a number
  • Use the Up and Down arrow buttons to change the position by 1 point increments

**Y Points**

The vertical (Y coordinate) position of the polygon's vertex on the page, in pixels. X,Y coordinates 0,0 represent the upper left corner.

_Note: X,Y coordinates 0,0 represent the upper left corner._

Field Entries:
  • Number
To change:
  • Type a number
  • Use the Up and Down arrow buttons to change the position by 1 point increments

**Application Notes**

**Alarm and Event Banner**

**Alarm and Event Viewer Components**

**Runtime View**
The ePro PS Alarm and Event feature is used to monitor all system and process events in a single FIFO stack of configurable size. Individual events or alarms may be acknowledged and may transition from alarm state to an acknowledged state and to a cleared state. Regardless of the state they remain in the stack until they are pushed out when the stack fills up.

The table is displayed with the Alarm/Event Viewer window and organized (by default) based on the time each event triggers with newest events at the top of the stack. The default view may be changed through a series of filters and can be sorted based on any visible attribute (column) such as alarm level/criticality, type, or group name. The filters allow the user to view or hide based on acknowledged/unacknowledged status, active/inactive status and origin (system events and process/user-configured events). Alarms may be acknowledged individually by touching the acknowledge column for a selected alarm or they can be acknowledged with the “Acknowledge All Alarms” or “Acknowledge Visible Alarms” buttons. The Window Banner contains controls for paging up and down, moving to the top or bottom of the alarm list, minimizing or maximizing the window, and displaying or hiding the Global-Acknowledge/Filter area.

**Event Manager Settings**

The following dialog box shows the various Configuration properties that control the event manager. These properties may be overridden by similar settings in the Unit properties if the unit is set to override the configuration properties for the Event Manager.
The first attribute sets the overall capacity of the Alarm/Event stack. While there is not a design limit to the size of the stack, memory and performance limitations suggest that it be set to no more than 3000 events for an ePro PS configuration. The next five attributes allow you to also write events to the Windows Application Event Viewer based on each event's level/criticality attribute. Because of the ePro PS's Protect Mode feature which prevents changes to the operating system drive (C: \) and because you cannot change the location of the Windows Event Viewer data, these events will be lost whenever the system is rebooted. In any case the Windows Event Viewer can be an auxiliary temporary storage place for alarms and events.

Banner Settings

The following dialog boxes show the various Configuration properties that control the Event Banner. These properties may also be overridden by similar settings in the Unit properties if the unit is set to override the configuration properties for the Event Banner.

The first set of parameters control the general behavior of the entire Alarm/Event window. "Title", and "Font", control the text that is displayed as the title in the Window's Banner section.
The “Roll Up/Down Operational” and "Exit Operational" parameters determine if these banner controls function normally or are disabled (shown below from the right side of the banner):

![Banner Controls]

The Roll Up (up arrow) shows when the Alarm Table section is currently rolled down and the Roll Down (down arrow) shows when the Alarm Table section is currently rolled up. This allows the user to leave the window open online with just the banner section displayed (rolled up) or to restore the rest of the window (roll down). Selecting the Exit button (X) closes the entire window.

The “Mobility” parameter can be Mobile or Immobile. This controls whether or not the Window may be repositioned online by dragging the Banner with a mouse or touchscreen.

The “Location”, “Height” and “Width” parameters control the position and size of the alarm/event window when it is opened with a View Action where the view state is set to “Open” instead of “Open Full Screen”.

**Acknowledgment – Filter Settings**

These parameters control the functionality of the Acknowledge buttons and Filter buttons located below the window Banner section.
The “Acknowledge All Alarms” parameter sets the text of the button that will acknowledge every unacknowledged alarm in the stack if the “Acknowledge All Operational” parameter is set to “Yes” (if set to “No” the text is grayed out and the button is inactive).

The “Filter Buttons” parameter allows the user to select if the Acknowledge-Filter part of the window is “Always Visible”, “Always Invisible”, “Initially Visible” or “Initially Invisible”. If set to Initially Visible or Invisible the filter button on the banner will toggle them from being visible (arrow up) or hidden (arrow down as shown below):

![Filter Visibility Toggles](image1)

The “Acknowledge Visible Alarms” parameter sets the text of the button that will acknowledge every unacknowledged alarm in the visible Alarm Table area if the “Acknowledge Visible Operational” parameter is set to “Yes” (if set to “No” the text is grayed out and the button is inactive).

The “Filter Active On” and “Filter Active Off” parameters set the text of the button that will toggle between showing or hiding alarms which are currently active. When the active alarm filter is ON only inactive
alarms will show in the Alarm Table area. The "Filter Active On" text label will appear when the filter is ON. If you wish to show the status of the filter you might set the text of the two buttons to "Active Alarm Filter ON" and "Active Alarm Filter OFF". If you want to describe what will occur when the button is pressed you might set the text of the two buttons to "View Active Alarms" and "Hide Active Alarms". The "Filter Active Operational" parameter determines whether or not the button works online. If the parameter is set to NO then the operator will not be able to filter out active alarms from the Alarm Table area and active alarms will always be displayed.

The remaining parameters in this section work the same as the "Filter Active On/Off/Operational" parameters described in the previous paragraph. They allow the user to filter out Inactive Alarms, Acknowledged Alarms, Unacknowledged Alarms, Process Alarms, and System Alarms. Inactive Alarms include all alarms that have cleared regardless of their acknowledged/unacknowledged state. Acknowledged Alarms include all alarms which have been acknowledged regardless of their active/inactive state. Unacknowledged Alarms include all alarms that have not been acknowledged regardless of their active/inactive state.

**Alarm Table Settings**

These parameters control the size of the viewable alarm stack and the foreground and background colors of the text fields in the Alarm Table area based on the state of the alarm (with the exception of the level/criticality field).

The first parameter in this field should be set to match the maximum number of events from the Event Manager tab in order to be able to see the entire alarm/event stack in the viewer window.

The "Grid Background" determines the color of each empty line in the Alarm Table area.

The next four pairs of foreground and background color parameters determine the color of each entry in the table based on its Active/Inactive and Acknowledged/Unacknowledged states.

The "Header Height" sets the pixel height of the Header above the Alarm Table that displays the text for the definition of each column.

The "Field Height" sets the pixel height of each line in the Alarm Table.

The Selected Text and Selected Background color parameters determine the color of the field that is selected (through a touch or mouse click). The only purpose of the concept of a selected field at present is so that an operator with just a keyboard could select an alarm using the up/down cursor controls and acknowledge the selected alarm line with the Enter key. In a touchscreen application the operator only needs to touch a line in the Acknowledge column to acknowledge an alarm or event.
Alarm Table Column Settings – Triggered Timestamp

These parameters set the attributes of the Triggered Timestamp column, by default the first, or leftmost column in the Alarm Table.

The Column parameter determines in which column the triggered timestamp is placed, indicating the onset of the alarm/event.

Column Width sets the width of the column in pixels.

The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The Field FG and BF colors determine the colors of the field in the Alarm Table only if the Table settings for indicating state colors (Active/Inactive or Acknowledged/Unacknowledged) are set to “none – transparent”. Otherwise they are ignored.

The last two parameters determine the font and alignment of the triggered timestamp value in the column for all lines in the Alarm Table.

Alarm Table Column Settings – Cleared Timestamp

These parameters set the attributes of the Cleared Timestamp column, by default the second column in the Alarm Table.
The Column parameter determines the placement of the column in which the cleared timestamp is placed, indicating the time, or elapsed time since onset, that the alarm/event transitioned to the inactive state (false).

Column Width sets the width of the column in pixels.

The Time Format parameter determines whether the cleared timestamp indicates the actual time it became inactive or the elapsed time that it was in the active state before transitioning to the inactive state.

The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The Field FG and BF colors determine the colors of the field in the Alarm Table only if the Table settings for indicating state colors (Active/Inactive or Acknowledged/Unacknowledged) are set to “none – transparent”. Otherwise they are ignored.

The last two parameters determine the font and alignment of the cleared timestamp value in the column for all lines in the Alarm Table.

**Alarm Table Column Settings – Acknowledged Timestamp**

These parameters set the attributes of the Acknowledged Timestamp column, by default the third column in the Alarm Table.
The Column parameter determines the placement of the column in which the acknowledged timestamp is placed, indicating the time, or elapsed time since onset, that the operator acknowledged the alarm/event.

Column Width sets the width of the column in pixels.

The Time Format parameter determines whether the acknowledged timestamp indicates the actual time it became acknowledged or the elapsed time that it was in the active state before the operator acknowledged the alarm/event.

The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The Field FG and BF colors determine the colors of the field in the Alarm Table only if the Table settings for indicating state colors (Active/Inactive or Acknowledged/Unacknowledged) are set to “none – transparent”. Otherwise they are ignored.

The last two parameters determine the font and alignment of the acknowledged timestamp value in the column for all lines in the Alarm Table.

**Alarm Table Column Settings – Description**

These parameters set the attributes of the Description column, by default the fourth column in the Alarm Table.
The Column parameter determines the placement of the column in which the description is placed, providing a detailed explanation of the nature of the alarm/event.

Column Width sets the width of the column in pixels.

The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The Field FG and BF colors determine the colors of the field in the Alarm Table only if the Table settings for indicating state colors (Active/Inactive or Acknowledged/Unacknowledged) are set to “none – transparent”. Otherwise they are ignored.

The last two parameters determine the font and alignment of the description in the column for all lines in the Alarm Table.

**Alarm Table Column Settings – Criticality**

These parameters set the attributes of the Criticality or Alarm Level column, by default the fifth column in the Alarm Table.
The Column parameter determines the placement of the column in which the Criticality attribute is placed, indicating the relative importance or urgency of the alarm/event.

Column Width sets the width of the column in pixels.

The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The next five parameters determine the text strings used to describe the five hierarchical alarm criticality levels, from highest to lowest.

The Field Default FG and BF colors determine the colors of the field in the Alarm Table only if the following criticality color settings for indicating the five urgency levels are set to “none – transparent”. Otherwise they are ignored.

The next five pairs of parameters provide the foreground and background colors of the text appearing in this column that indicate criticality or urgency level. This is the only column in the alarm table where the color or the text does not indicate the active/inactive state or acknowledged/unacknowledged state, but rather the criticality or urgency of the alarm/event.

The last two parameters determine the font and alignment of the criticality text in this column for all lines in the Alarm Table.
Alarm Table Column Settings – Group

These parameters set the attributes of the Group column, by default the sixth column in the Alarm Table.

- **Column**: Determines the placement of the column in which the Group or Type attribute is placed, providing an additional indication of the classification for the alarm/event.
- **Column Width**: Sets the width of the column in pixels.
- **Text**: Determines the column heading’s label.
- **Header FG Color**: Sets the foreground color of the column header.
- **Header BG Color**: Sets the background color of the column header.
- **Header Font**: Determines the font used in the column header.
- **Header Alignment**: Determines the alignment within the column header.
- **Field Undefined Error Text**: Describes the text used to describe the classification of alarms/events for the Undefined Error classification.
- **Field General Error Text**: Describes the text used to describe the classification of alarms/events for the General Error classification.
- **Field Alarm Text**: Describes the text used to describe the classification of alarms/events for the Alarm classification.
- **Field Alarm Clear Text**: Describes the text used to describe the classification of alarms/events for the Alarm Clear classification.
- **Field Communication Error Text**: Describes the text used to describe the classification of alarms/events for the Communication Error classification.
- **Field Configuration Error Text**: Describes the text used to describe the classification of alarms/events for the Configuration Error classification.
- **Field Parser Error Text**: Describes the text used to describe the classification of alarms/events for the Parser Error classification.
- **Field Evaluator Error Text**: Describes the text used to describe the classification of alarms/events for the Evaluator Error classification.
- **Field User Input Error Text**: Describes the text used to describe the classification of alarms/events for the User Input Error classification.
- **Field Insufficient Resource Text**: Describes the text used to describe the classification of alarms/events for the Insufficient Resource classification.
- **Field Valid Resource Text**: Describes the text used to describe the classification of alarms/events for the Invalid Resource classification.
- **Field Programmatic Error Text**: Describes the text used to describe the classification of alarms/events for the Programmatic Error classification.
- **Field Audit Text**: Describes the text used to describe the classification of alarms/events for the Audit classification.
- **Field Audit Fail Text**: Describes the text used to describe the classification of alarms/events for the Audit Fail classification.
- **Field Event Text**: Describes the text used to describe the classification of alarms/events for the Event classification.
- **Field User Defined Text**: Describes the text used to describe the classification of alarms/events for the User Defined classification.

The Column parameter determines the placement of the column in which the Group or Type attribute is placed, providing an additional indication of the classification for the alarm/event.

Column Width sets the width of the column in pixels.

The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The next sixteen parameters determine the text strings used to describe the classification of alarms/events. The following eleven classifications are used by system generated events such as communications errors and internal runtime events or alerts:

- Undefined Error
- Alarm Clear
- Communication Error
- Configuration Error
The following five classifications can be assigned by the user for each configured alarm or event:

- General Error
- Alarm
- Event
- Audit
- User Defined

The Field FG and BF colors determine the colors of the field in the Alarm Table only if the Table settings for indicating state colors (Active/Inactive or Acknowledged/Unacknowledged) are set to “none – transparent”. Otherwise they are ignored.

The last two parameters determine the font and alignment of the group or type text in this column for all lines in the Alarm Table.

**Alarm Table Column Settings – Group Name**

These parameters set the attributes of the Group Name column, by default the seventh column in the Alarm Table. The group name for each user configured alarm or event is defined by the user. This allows the user to add another field that can be sorted online by the operator to organize the information in the Alarm Table in a way that is meaningful for the application so that all alarms for a specific area or section of the process can be grouped together. Since the sorting is done alphabetically the user can control the order that each group name appears by naming each group with a preceding number such as “1 – Feeder Section”, “2 – Converting Section”, “3 – Packaging Section”, “4 – Auxiliary Controls”, etc.

The Column parameter determines the placement of the column in which the Group Name attribute is placed, providing an indication of the section of the process associated with the alarm/event.

Column Width sets the width of the column in pixels.
The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The Field FG and BF colors determine the colors of the field in the Alarm Table only if the Table settings for indicating state colors (Active/Inactive or Acknowledged/Unacknowledged) are set to “none - transparent”. Otherwise they are ignored.

The last two parameters determine the font and alignment of the group or type text in this column for all lines in the Alarm Table.

**Alarm Table Column Settings – Source, Use & Computer**

For future use, not currently supported. These fields are disabled by default by setting the Column parameter to zero.

![Image of a configuration interface](image)

**Canvas Assistance and Component Builder**

The Canvas Assistance and Component Builder features provide guidance throughout project development.

**Canvas Assistance**

Canvas Assistance parses all property value entries and checks for accuracy. The following operations are carried out on the entries.

- **Text** - Double Quotes added automatically to text entries if needed.
- **Tags** - If a tag is entered that does not exist, the Component Builder menu (as described below) will be shown to allow creating the tag immediately.

**Component Builder**

Component Builder allows components to be built anywhere in the Canvas Pro editor. This is helpful when editing a component and without leaving that component a completely different component can be added. The menu is called in the following ways.

- **CTRL-Right Click** opens the pulldown menu any where in the editor as shown below.
- When dynamic references are entered into an evaluated property and the dynamic reference does not exist, the menu is presented to allow adding a component.
Note: The dynamic reference is checked for existence against its expected library type first, then client/tags are checked next.

Enabling and Disabling Canvas Assistance and Component Builder Features

By default, all features are enabled. If desired they can be disabled from the Tools menu as follows.
Getting Started

Canvas Options

The following options allow enable/disable automatic string functions.

- **Canvas Assist**
  - Automatically apply string quotes when missing - add double quotes to text properties
  - Automatically apply string quotes to Media Library Text Entries - add double quotes to text entries within a Media Library

Component Builder Options

The following options enable/disable menu operations.

---

Canvas Options

The following options allow enable/disable automatic string functions.

- **Canvas Assist**
  - Automatically apply string quotes when missing - add double quotes to text properties
  - Automatically apply string quotes to Media Library Text Entries - add double quotes to text entries within a Media Library

Component Builder Options

The following options enable/disable menu operations.
Automatic

- Show new component menu - tops the menu when adding a dynamic property reference that does not exist, so the component can be added.
- Edit new component properties - tops property editor to edit new references (after adding from menu above).
- Show Folders - select the items (Action Libraries, Archive Libraries...) to appear in the Component Builder menu.

Changing the Default Prepackaged Project

The default prepackaged project that is created when the ePro Canvas editor is started from the start menu and which is also created when choosing New prepackaged project from the File menu or from the Project’s toolbar icon , is an XML file named ProjectProfileCanvasPro.xml (for the ePro Canvas Professional Editor) and ProjectProfileCanvas.xml (for the ePro Canvas Editor). That file is located in the Configuration directory of the ePro Canvas installation directory (default location is C:\Program Files\Cutler-Hammer\ePro Software Suite\Configuration).

If you want to change the prepackaged project to include components and Component Templates that you have created or customized, simply export the desired project as an XML file, name it the same as the default prepackaged project XML file, and place it in the ePro Canvas installation’s Configuration directory. You can export a project as an XML file with the File>Export selection from the ePro Canvas Project Explorer editor as shown below.
Changing Pages Online

Page Changes Using Actions

The primary method for changing pages is through an Action. There are five Actions that are built into the default Action Library named ActionSystem that can be used to control page changes. Three of them are based on the page name and the row number as it appears in the Configuration Properties Page tab as shown below.
The action named ActionGetPage generates a selectable list of all configuration pages by name. The list appears online at the top of the current page when the action is initiated. When a user touches or clicks on a page name in the list, the system changes pages to that selected page on the release or break of the touchscreen.

The action named ActionPageUp will change pages to the page named in the next row from the current page. In the example above, if the current page is the Weld Robot Controls and the ActionPageUp executes, the system will go to the Inspection Results page. The action will wrap-around so that if the current page is the last page in the configuration, it will go to the first page.

The action named ActionPageDown will change pages to the page named in the previous row from the current page. In the example above, if the current page is the Weld Robot Controls and the ActionPageDown executes, the system will go to the Process Overview page. The action will wrap-around so that if the current page is the first page in the configuration, it will go to the last page.

The other two default page change Actions are ActionHomePage and ActionPreviousPage. The first will change pages to the page defined as the Home Page in the Configuration Properties General Tab as shown below:
In the above example the page named Menu is defined as the Home Page of the Welding Line 1 configuration. Any time ActionHomePage triggers in that configuration the system will change pages to Menu. The action named ActionPreviousPage will always change pages to the page that was displayed prior to the currently displayed page. If a button that calls the ActionPreviousPage is placed on all pages in a configuration, the user will be able to go back and forth between any two pages using that button.

**User defined Goto Page Actions**

In addition to the built-in system actions for page change, the user may create Goto Page actions that will change pages to a specific page by name when executed. The following is an example of a Goto Page action that when executed will change to the page name Process Faults:

**Changing Pages by ID Number**

Another method of changing pages online is through the Page ID Number. The page ID Number property on the Page Properties General tab allows the user to assign a number to a page as shown below:
By default all pages are assigned a Page ID number of zero. You can change this number to any number you wish. In the following example a configuration has six pages with the following Page ID number assignments:

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Id Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>0</td>
</tr>
<tr>
<td>Process Overview</td>
<td>10</td>
</tr>
<tr>
<td>Weld Robot Controls</td>
<td>15</td>
</tr>
<tr>
<td>Inspection Results</td>
<td>33</td>
</tr>
<tr>
<td>Machine Diagnostics</td>
<td>22</td>
</tr>
<tr>
<td>Process Faults</td>
<td>14</td>
</tr>
</tbody>
</table>

In the default tag library TagSystem there is a System tag CurrentPageID that is automatically updated by the online system with the ID Number of the currently displayed page. If no changes are made to the default ID Number of the pages in a configuration, it will always read zero. But in the example shown above, when the configuration is running online and the current page is Weld Robot Controls, then the value in CurrentPageID will be 15.

There are several ways to change pages by Page ID Number. The first way is by using a Rectangular Button control on a page where the Type property in the General tab is set to Page Change and the target address is either a constant or a tag containing the ID Number of the page you wish to go to. In the Rectangular Button properties example shown below, pressing the button online would change pages to the page with ID Number of 33, the Inspection Results page of our example.
Of course the same result could be obtained by creating a Goto Page action that specifies the Inspection Results page by name, and then changing the button’s Type property to Trigger Action and changing the Break Action to call the Goto Page action as shown below:

Another way to change pages by Page ID Number is to write to the system tag CurrentPageID. You could do this with a numeric entry from a page control or by creating an Assignment Action set to Conditional Passthru where a PLC tag change gets written directly to CurrentPageID. When CurrentPageID is written to the system will change pages to the page with the corresponding Page ID Number. To work properly it
is required that the user make sure that the Page ID Number is unique for all pages in a configuration. The following is an example of a numeric operator entry writing to CurrentPageID:

![Legend - Legend](image1)

Next is an example of a PLC tag called 'remote_page_change' writing to the CurrentPageID through an assignment action with Trigger Type Conditional and Condition Type Passthru. It is important to note that in order to have this action execute online it needs to be added to the Configuration Properties Actions tab:

![Project - Action Library Entry - Remote Page Change](image2)
Warning: Do NOT use Remote Page Changes in safety critical applications. If the operator has touched a button when the remote page change occurs, the page will change, however the break action resulting from the operator's release of the button will NOT occur. To avoid this situation, an alternate method is to allow the PLC to propose a page for the operator to call. This can be done using visibility to show a flashing button when the proposed PLC page is different from the current page (eg. the Visibility Expression for the button would be RemotePageId != CurrentPageId). When the button is then visible and pressed, an action list can be executed to call the PLC page (RemotePageId) and update the CurrentPageId.

Component Templates

Component Templates are project components that have been saved as templates for reuse within the project. Component Templates may be created by the developer to reduce development time and provide a consistent look or style to a configuration. Any project component can be saved as a template by right-clicking on the component and selecting Create Component Template and any single page component can be saved as a template by right-clicking on it and selecting Create Template as illustrated below.
When a component is saved as a template all configured properties of that component are saved. To create a new project component from a saved template right-click on the component group, i.e. Unit, Client, Configuration, Page, etc., and highlighting Create From Template, then choosing the desired template from the resulting list of Component Templates as illustrated below.
In the Page Editor you can use saved page components by clicking on the Component Template category in the controls bar. New components created from a component template will have all initial properties set to that of the saved template. This can speed up development by allowing the user to establish the default settings of new components added to the project rather than accepting the editor defaults and having to change each new components properties to match the desired standards of the developer.

Because page controls can also be saved as Component Templates the developer can take standard Canvas controls and customize them once and then use the customized controls to reduce development time and create a consistent look and feel to the project’s pages.

Some Component Templates are included in the default Project Profile to speed up initial development. They are shown below:
Because Component Templates are saved with a project just like any other project components they will not automatically be added with a New blank project or New prepackaged project. However, like all other project components they may be copied from an existing project to a new project by opening both projects in separate windows and using copy and paste, or drag and drop, to copy between the two projects.

Changing the Default Prepackaged Project

Control Example: Readout Template

A Readout control displays numerical values similar to readout devices on a control panel. The following is a description of the Readout Template, but is described in terms that can be related to all controls. Due to similarity in each control's properties, this is the only detailed example given for a control as it describe how all controls function.

The Control

When a Readout Template is placed on a page, it will appear similar to below.

Note: Some properties have been adjusted as follows (details on making these changes will follow):

- Data Entry has been selected and is indicated by the miniature data entry keypad in the template's upper left corner.
- A title "Speed" has been given to the template.
- The units "RPM" has been added.
The Property Editor

The Property Editor of this control can be called by double clicking the control (or right-clicking the control and selecting Properties). These properties are shown below:

The General Properties

When the properties are displayed for the control, the General Properties (ie: the General Tab), are shown. The following is an example of a readout control's Property Editor, showing the general properties, with the most notable properties indicated.
The Property Editor Window contains the Control Outline and a list of properties and values for the Readout Template. In the graphic above:

- **Readout Template** is highlighted (shown with a blue background) in the Control Outline.
- The **General** Tab is selected on the right.
- So, the Readout Template’s General properties are shown.
- And, this top level (**Readout Template**), **General** tab contains the most common properties.
- Note how the property values are reflected visually on the graphic (and the Data Entry indicator is displayed after selecting OK).

Values are changed in this or any property window by selecting and altering the value based on the type of value field.

In the above graphics, the altered property values were changed as follows:

- Data Entry was selected by the drop box arrow next to the Operator Input Type property.
- "Speed" was assigned to the Title property.
- "RPM" was assigned to the Units property.

Controls are designed with the most common properties under the General tab to minimize editing time. Below are more instructions on accessing the remainder of the properties.

**The Control Outline**

As in the graphic below, the **Control Outline** shows the composition of the selected control with all of its controls/sub-control constituents.
The outline (which was expanded by clicking on all "+"
signs) shows the controls that make a Readout Template. The four sub-controls at the next level of the outline, under Readout Template, are indicated with lines on the graphic above.

- Readout Template
  - Legend
  - Plate
  - Readout
  - Units

Then to drill down further into the control, the Legend is made of (i.e.: the level of the outline under Legend):

- Legend
  - Plate
  - Text
  - Image

And, the plate is made of:

- Plate
  - Plate Rectangle

And, so on, until the outline is filled as in the property editor graphic above.

Note: Items are expanded by clicking "+" signs; contracted with "-" signs.

Note: The item selected in the Control Outline pane has its properties shown on the right.

**Editing Sub-Control Properties**

In the preceding Control Outline pane, Readout Template was selected. Since it is selected, its properties are shown on the right. Similarly, if any item in the outline is selected, its properties will be displayed.

In general, the most used properties have been moved to the General Tab. To change less common properties, select them at their base level. For instance, to change the border highlight color on the legend part of the control (which is the border of the rectangle sub-control of the plate sub-control of the legend...
sub-control of the Readout control), select Plate Rectangle as shown below. Then select the Attributes tab to access the desired characteristics or property.

The control will change as follows...

Tip: The highest level "General" tab contains the most common properties.
Tip: Lower level "Attributes" tab is necessary to change the less common properties.

The Rest of the Properties

The following properties under the General Tab are specific to the Readout Template control.

- Title
- Value
- Decimal Places
- Units

In addition to the above properties, there are Common Properties available for all controls.

Other Controls

Click Controls to look at the properties of all the controls.
Creating a Multi-Language Project

Switching between different languages is performed by placing the a numeric value in a storage location specified by you, or by using an expression that you create. The unit will switch to a different language if the value in the specified location or the expression matches one of the language values listed in the language table below.

Language table

<table>
<thead>
<tr>
<th>LANGUAGE</th>
<th>LANGUAGE VALUE (Decimal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFRIKAANS</td>
<td>54</td>
</tr>
<tr>
<td>ALBANIAN</td>
<td>28</td>
</tr>
<tr>
<td>ARABIC</td>
<td>01</td>
</tr>
<tr>
<td>ARMENIAN</td>
<td>43</td>
</tr>
<tr>
<td>ASSAMESE</td>
<td>77</td>
</tr>
<tr>
<td>AZERI</td>
<td>44</td>
</tr>
<tr>
<td>BASQUE</td>
<td>45</td>
</tr>
<tr>
<td>BELARUSIAN</td>
<td>35</td>
</tr>
<tr>
<td>BENGALI</td>
<td>69</td>
</tr>
<tr>
<td>BULGARIAN</td>
<td>02</td>
</tr>
<tr>
<td>CATALAN</td>
<td>03</td>
</tr>
<tr>
<td>CHINESE</td>
<td>04</td>
</tr>
<tr>
<td>CROATIAN</td>
<td>26</td>
</tr>
<tr>
<td>CZECH</td>
<td>05</td>
</tr>
<tr>
<td>DANISH</td>
<td>06</td>
</tr>
<tr>
<td>DIVEHI</td>
<td>101</td>
</tr>
<tr>
<td>DUTCH</td>
<td>19</td>
</tr>
<tr>
<td>ENGLISH</td>
<td>09</td>
</tr>
<tr>
<td>ESTONIAN</td>
<td>37</td>
</tr>
<tr>
<td>FAEROESE</td>
<td>56</td>
</tr>
<tr>
<td>Farsi</td>
<td>41</td>
</tr>
<tr>
<td>FINNISH</td>
<td>11</td>
</tr>
<tr>
<td>FRENCH</td>
<td>12</td>
</tr>
<tr>
<td>GALICIAN</td>
<td>86</td>
</tr>
<tr>
<td>GEORGIAN</td>
<td>55</td>
</tr>
<tr>
<td>GERMAN</td>
<td>07</td>
</tr>
<tr>
<td>GREEK</td>
<td>08</td>
</tr>
<tr>
<td>GUJARATI</td>
<td>71</td>
</tr>
<tr>
<td>HEBREW</td>
<td>13</td>
</tr>
<tr>
<td>HINDI</td>
<td>57</td>
</tr>
<tr>
<td>Language</td>
<td>Code</td>
</tr>
<tr>
<td>------------</td>
<td>------</td>
</tr>
<tr>
<td>HUNGARIAN</td>
<td>14</td>
</tr>
<tr>
<td>ICELANDIC</td>
<td>15</td>
</tr>
<tr>
<td>INDONESIAN</td>
<td>33</td>
</tr>
<tr>
<td>ITALIAN</td>
<td>16</td>
</tr>
<tr>
<td>JAPANESE</td>
<td>17</td>
</tr>
<tr>
<td>KANNADA</td>
<td>75</td>
</tr>
<tr>
<td>KASHMIRI</td>
<td>96</td>
</tr>
<tr>
<td>KAZAK</td>
<td>63</td>
</tr>
<tr>
<td>KONKANI</td>
<td>87</td>
</tr>
<tr>
<td>KOREAN</td>
<td>18</td>
</tr>
<tr>
<td>KYRGYZ</td>
<td>64</td>
</tr>
<tr>
<td>LATVIAN</td>
<td>38</td>
</tr>
<tr>
<td>LITHUANIAN</td>
<td>39</td>
</tr>
<tr>
<td>MACEDONIAN</td>
<td>47</td>
</tr>
<tr>
<td>MALAY</td>
<td>62</td>
</tr>
<tr>
<td>MALAYALAM</td>
<td>76</td>
</tr>
<tr>
<td>MANIPURI</td>
<td>88</td>
</tr>
<tr>
<td>MARATHI</td>
<td>78</td>
</tr>
<tr>
<td>MONGOLIAN</td>
<td>80</td>
</tr>
<tr>
<td>NEPALI</td>
<td>97</td>
</tr>
<tr>
<td>NEUTRAL</td>
<td>00</td>
</tr>
<tr>
<td>NORWEGIAN</td>
<td>20</td>
</tr>
<tr>
<td>ORIYA</td>
<td>72</td>
</tr>
<tr>
<td>POLISH</td>
<td>21</td>
</tr>
<tr>
<td>PORTUGUESE</td>
<td>22</td>
</tr>
<tr>
<td>PUNJABI</td>
<td>70</td>
</tr>
<tr>
<td>ROMANIAN</td>
<td>24</td>
</tr>
<tr>
<td>RUSSIAN</td>
<td>25</td>
</tr>
<tr>
<td>SANSKRIT</td>
<td>79</td>
</tr>
<tr>
<td>SERBIAN</td>
<td>26</td>
</tr>
<tr>
<td>SINDHI</td>
<td>89</td>
</tr>
<tr>
<td>SLOVAK</td>
<td>27</td>
</tr>
<tr>
<td>SLOVENIAN</td>
<td>36</td>
</tr>
<tr>
<td>SPANISH</td>
<td>10</td>
</tr>
<tr>
<td>SWAHILI</td>
<td>65</td>
</tr>
<tr>
<td>SWEDISH</td>
<td>29</td>
</tr>
<tr>
<td>SYRIAC</td>
<td>90</td>
</tr>
</tbody>
</table>
Multi-Language Example

The following steps describe the multi-language set up. These steps are only one example of how this can be accomplished.

**Set up media library**

Set up the library for each of the different language that will be used.

**Create a tag to store the language value**

The storage location of your choice, any device that has registers, i.e. PLC, Drive, etc.

**Set up the Active Language Expression**

The active language expression is found on the general tab of the configuration. This field must be filled in if you intend on using Multi-language. Place the tag (from above) in this field. Use the drop down button to select the tag.

**You’re done**

The only thing left to do is determine how you will change the languages. You can change them manually by pressing buttons on the runtime screen. Or you can have the destination device change language using criteria set up on that device. Below are examples of notes about each method.

**Changing Language manually**

- Create an action assignment for each language. The assignment should place the language value in the tag. i.e. ‘Tag’ = 9 (9 is English language). Use the numeric value that corresponds to the language you want to change to.
- Place a button for each language on a screen. Label each button accordingly for the languages. Insert the appropriate action into one of the action fields of the button.

**Let the destination device change language**

- Using the logic of the destination device, place into the tag the numeric value that corresponds to the language you want to change to.

**Data Archiving**

The ePro PS supports data archiving in two different ways. You can choose to archive alarms and events and archive data through Data Archive actions. In each case one or more Archive Library entries must be created that control the sample rate, the archive rate, the group rollover rate and the file rollover rate. All archived data is stored in XML file format to allow for compatibility with Microsoft Excel or Access applications or any other XML compliant display or analysis tool. If you use Excel to display the data you will find that an ePro’s data archive file typically has a number of sheets.

When a file is first created by a data archive action the first sheet is named by the data and time the sheet was first written to. For example, a sheet started on June 18th 2005 at 8:44:06 AM would be named “06-
Data will be sampled based on the Sample Rate defined in the Archive Library Entry and that sampled data will be written to the file at the Archive Rate.

**Archive Libraries**

Archive Libraries are used to store the data sampling and file settings for all system archive functions. The library entries may be shared by multiple archive functions.

In the Archive Library Entry example shown below, data is sampled every 30 seconds, and data is written to the archive every 2 minutes. This means that the ePro buffers up sampled data until it is time to open the archive file and write the data to the file. The Group Rollover Rate determines when to create a new sheet in the archive file and the File Rollover Rate determines when a new file will be created. In this example a new sheet is created every hour (3600 seconds) and a new file is created every 8 hours (480 minutes). The rates can be triggered from time or event, see Archive Library Entry for more details.

The Archive Path determines the path and directory where the archive files will be stored. In this example the data is stored on a removable drive on the ePro, drive letter "E" in the directory "\DataArch\Data Trends". Note the double backslash is required as a path separator because the backslash is a special character in the ePro syntax evaluator. An alternate way of showing the path would use a single forward slash character such as "E:/DataArch/Data Trends".

Note: when archiving data on any ePro PS hardware platform it is critically important to the operation of the ePro that all archived data paths be set to either a removable drive or mapped network drive. Data should never be archived to either the "C" or "D" drive of the ePro. Both these drives are located on an internal CompactFlash memory module which must be returned to the factory for service if the drive is damaged from perpetually writing to the "D" drive. The "C" drive is protected by the Windows XP Embedded operating system from change. This means that if you attempt to write archive files to that drive, Windows will intercept those attempts and place the files in volatile RAM memory. Over time those archived files will totally consume all the available RAM memory and crash the Windows OS. A system reboot will temporarily cure the problem by flushing out all the archived data files from RAM, but you will have lost all your data and eventually RAM will fill up once more requiring another reboot.

Another example of an Archive Library entry set up for the Alarms/Events archival is shown below:
Since alarms are not sampled, the Sample Rate property may be left blank. If a value is placed in the Sample Rate field and the Alarms/Events archive is assigned that Archive Entry then the property will be ignored. Otherwise, alarms and events are buffered up until the Archive Rate times out and the data is written to the archive file.

It is recommended that the Archive Rate be no less than a minute and that the Sample rate for Trend Templates or Data Archive actions be set to no less than five seconds on the ePro.

**Alarms/Events Archiving**

To set up Alarm and Event Archiving go to the Event Manager tab in the Configuration properties page and select an Archive Library Entry in the Archive Property of the dialog as shown below. Note: leaving the Archive property blank will disable the alarm/event archive function.
The name of the Archive files will follow the convention: AlarmEvent_mmddyyyy_hhmm.XML
Where the month day year hours and minutes indicated the time the file was first created. The file will be
created after the archive rate defined in the Archive Library entry has elapsed following ePro startup.
Following this initial file a new file will be created after the file rollover rate has elapsed, and so on until
the ePro configuration closes.
The format of the archive file when displayed in Microsoft Excel is:

See also Configuration Properties, Event Manager tab.
Data Archive Action

A Data Archive Expression may be created in the Action Library and then added to the Configuration property’s Actions tab to enable a general data archiving function. An example of a Data Archiving action is shown below:
In the above example five tags are being archived at the rates defined in the Archive Library entry name 'Sample 30 Seconds arch 2 minutes'.

The name of the Archive files will follow the convention: ActionName_mmddyyyy_hhmm.XML or in the example shown above the name would be Archive Sine Data_mmddyyyy_hhmm.XML.

Where the month day year hours and minutes indicated the time the file was first created. The file will be created after the archive rate defined in the Archive Library entry has elapsed following ePro startup or following the true state transition of the Trigger Expression occurs. Following this initial file a new file will be created after the file rollover rate has elapsed, and so on until the ePro configuration closes or until the Trigger Expression transitions to a false state.

The format of the archive file when displayed in Microsoft Excel is:

See also Data Archive Action.
Explicit Library Referencing

Active library names can be entered alternatively, using Explicit references to Library Entries. Generally, this method works with library types that allow only one library per configuration. However, multiple clients are allowable in a unit, and can be accessed as shown in the table below.

The reference 'MediaLib1,Ref' can be restated as

- ':Media:,Ref'

And the reference 'ClientSystem,?' can be replaced with

- ':System,?'

Notice how this gives flexibility since there is no tie to a specific library name, and will work with whatever the library is named in the configuration. For example, explicit references to an action library on a page allow that page to be re-used in multiple configurations, each accessing a different action library.

Here are the explicit names of each library.

<table>
<thead>
<tr>
<th>Library Type</th>
<th>Explicit Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Client</td>
<td>:System:</td>
</tr>
<tr>
<td>Unit's 1st Client</td>
<td>:Client1:</td>
</tr>
<tr>
<td>Unit's 2nd Client</td>
<td>:Client2:</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>Unit's Nth</td>
<td>:ClientN:</td>
</tr>
</tbody>
</table>
Expressions, Analog

An expression that can have many values. Examples of Analog Expressions include:

- Readout Values - temperature, pressure, speed, etc. can be shown numerically.
- Bar Values - temperature, pressure, speed, etc. can be shown in bar graph form.

Analog Expressions will appear as in the following examples:

- **100**
  
  A numeric expression can be set to a numeric value (no quotes). This type of entry is used in expressions in which the value will not dynamically change. For example, an Upper Limit might be set to 100, and a Lower Limit to 0. Note however, that all expressions, including limits, can be dynamic if desired.

- **'Pressure'**
  
  The above example will show the value of tag named Pressure.

  **Note:** If the Client Library is set as the Default in the Unit’s properties, then the library can be omitted from the reference. Otherwise, the reference must include the library, ie: 'Lib,LibEntry'.

- **$B8('Pressure')**
  
  The above example will show the formatted value of tag named Pressure. $B8('Pressure') formats the value as an 8 digit Binary number ($Bn shows n Binary digits, $Hn shows n Hex digits, $A shows an Ascii string, ... use the drop down box to get these values from the list).

  **Tip:** All format operators can be accessed from the drop down box to the right of the value field. For example, to select a Binary format, select Operators, then Format/Data/Time Operators, then Binary, and the $B will be placed in the formula. Use these same steps for all format operators.

- **'40001' % 100**
  
  The above example (Modulo) will divide 40001 by 100 and show the remainder. For example, if 40001 is 1234, then the expression will be 34 (ie: the remainder of 1234/100 = 12 with Remainder 34).

  **Tip:** All operators can be accessed from the drop down box to the right of the value field. For example, to select Modulo, select Operators, then Arithmetic Operators, then Modulo, and the % will be placed in the formula.

- **'ClientLib, Pressure'**
  
  The above example shows the value of 'Pressure' from the library called ClientLib.

  **Tip:** All Client and Tag Libraries can be accessed from the drop down box to the right of the value field. For example, to select a library entry, select the type of library, then the Library Name, then the Library Entry, and 'Library Name, Library Entry' will be placed in the formula.

- **$(Time)**
The above example will show the time formatted as hour:minute:sec.

**Tip:** All Time and Date expressions can be accessed from the drop down box to the right of the value field. For example, to select a Time, select **Operators**, then **Format/Data/Time Operators**, then **Time hour:minute:sec**, and "$(Time)" will be placed in the formula. Use these same steps for all similar expressions.

- `'Tag1' ** 'Tag2'`
  The preceding example (Power) takes Tag1 to the power of Tag2. If Tag1 is 4 and Tag2 is 2, the result is 16.
- `abs('Tag1')`
  The preceding example gives the absolute value of Tag1.

**Notes:**
- Pay attention to **Property Value Formats** (single, double, or no quotes)

**Notes:**
- The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
- Click the Ellipsis button (...) to select a tag, operator, or function which is defined in a library.
- The **Order of Precedence** must be considered in formulas.
- Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Press the **Back** button (toolbar of your browser) to return to the previous page.

### Expressions, Data Entry Target Expressions

An expression that, when evaluated, will result in data being sent to a target location.

**Examples** of **Data Entry Expressions** include:

- Send a setpoint to the PLC - a number entered by the operator can be sent to a PLC location.
- Set a local value - a number can be sent to a library entry.

**Data Entry Expressions** are constructed as follows:

**'DEST' = SOURCE**

- **'DEST'** is the destination or target location for data to be written, like 'n7:0' or 'TagName'.
- **SOURCE** represents an expression whose value is written to 'DEST', and can include any of the following:
  - '?' - a placeholder for the value entered by the operator. The entered value is inserted at all occurrences of '?' in the expression. **The '?' will appear in all data entry expressions.**
  - 'address' - a location in a PLC
  - 'tag' - a tagname from a Tag Library
  - constant - number used for scale or offset
  - operators - numeric (+,-,*,/) or binary (|,&,^,<,>,...)

The following equations are examples of target expressions:

- `'n7:0' = 'ClientSystem,'?`
The above example will send the data entered by the user to n7:0.

Note: TagLibrary called 'TagSystem' was configured with a Tag named "?" (without quotes), then a Client called 'ClientSystem' was configured to refer to the 'TagSystem' Library.

Note: If the Client Library is set as the Default in the Unit's properties, then the library can be omitted from the reference. Otherwise, the reference must include the library, ie: 'Lib,LibEntry'.

Tip: All Client and Tag Libraries can be accessed from the drop down box to the right of the value field. For example, to select the operator's input value, select Clients, then ClientSystem, then ?, and 'ClientSystem,?' will be placed in the formula.

- `40001' = 'ClientSystem,?' * 10

The above example will multiply the data entered by the user by 10, then send the result to 40001.

- 'PressureSetting'='ClientSystem,?'

The above example will send the data entered by the user to the tag named PressureSetting.

- `n7:0' = (('ClientSystem,?' * 'n7:1') * 'b3/1') + ('ClientSystem,?' * 'n7:2') * ('n7:2' > 10))

The above example is for explanation only, the table below shows some values entered by the operator ("?" is shown instead of 'ClientSystem,' for simplicity), calculations, and resulting values sent to the destination ('n7:0'). Note that ('n7:2' > 10) evaluates to 1 if 'n7:2' is greater than 10, otherwise evaluates to 0.

<table>
<thead>
<tr>
<th>operator input '?'</th>
<th>n7:1</th>
<th>b3/1</th>
<th>n7:2</th>
<th>value sent to destination 'n7:0'</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>1</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>1</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td>1</td>
<td>20</td>
<td>60</td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td>1</td>
<td>20</td>
<td>75</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>0</td>
<td>20</td>
<td>80</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>1</td>
<td>20</td>
<td>100</td>
</tr>
</tbody>
</table>
Expressions, Direct Assignment

An expression that, when evaluated, will result in data being sent to a target location. This assignment can be placed in a Make Action or Break Action property.

Examples of Direct Assignment Expressions include:

- Send a discrete value to the PLC - a bit value can be sent to a PLC location.
- Send an analog value to the PLC - a number can be sent to a PLC location.
- Set a local value - a number can be sent to a library entry.

Direct Assignment Expressions are constructed as follows:

'LIB,DEST' = SOURCE

- 'LIB,DEST' is the destination or target location for data to be written, like 'client,n7_0' or 'plc1,TagName'. Note: The Library name must precede the Tag.

- SOURCE represents an expression whose value is written to 'DEST', and can include any of the following:
  - 'address' - a location in a PLC
  - 'tag' - a tagname from a Tag Library
  - constant - number used for scale or offset
  - operators - numeric (+,-,*,/ or binary (|,&,^,<,>,...)

The following equations are examples of target expressions:

- 'client1,b3_0' = 1
  The above example will send 1 to client1, b3_0.
- 'plc1,40001' = 'speed' * 10
  The above example will multiply the tag speed by 10, then send the result to 40001 in plc1.

Notes:

- Pay attention to Property Value Formats (single, double, or no quotes)
• The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
• Click the Ellipsis button (...) to select a tag, operator, or function which is defined in a library.
• The Order of Precedence must be considered in formulas.
• Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Expressions, Discrete
An expression that will evaluate to one of two states (for example, ON/OFF or True/False).
Examples of Discrete Expressions include:

- Indicator States - based on a machine's state, an indicator will show one status when a bit is ON, and another when the bit is OFF.
- Visibility Expression - based on the value of a bit, a control will be shown (or not shown) on a page.
- State/Style/Action - if the expression is true, a corresponding style will appear on the control.

Discrete Expressions will appear as in the following examples:

- 1
  When the expression is set to a numeric value of 1 (no quotes), its evaluation is ALWAYS True. This is used in expressions in which a certain state is always desired. For example to always display a specific control, set its Visibility Expression to 1.
- ‘b3/0’
  The above example will evaluate to True when bit b3/0 is ON.

  Note: If the Client Library is set as the Default in the Unit’s properties, then the library can be omitted from the reference. Otherwise, the reference must include the library, ie: ‘Lib,LibEntry’.

- ‘Bit1’
  The above example will evaluate to True when tag Bit1 is ON.

- ‘!Bit1’
  The above example will evaluate to True when Bit1 is OFF, and FALSE when Bit1 is ON.

- ‘ClientLib,Bit1’ == 1
  The above example will evaluate to True when Bit1 in the ClientLib library has a value of 1. Note that the expression ‘ClientLib,Bit1’, without the ==1, will have an identical result.

  Tip: All Client and Tag Libraries can be accessed from the drop down box to the right of the value field. For example, to select a library entry, select the type of library, then the Library Name, then the Library Entry, and ‘Library Name, Library Entry’ will be placed in the formula.

- ‘40001’ == 200
  The above example (Equal to) will be True if register 40001 is equal to 200. This is a relational operator used for comparison purposes.

- ‘40001’ = 200
  The above example (Assign) will set the value of 40001 to 200. This is an arithmetic use for assignment purposes.

  Note: In the above examples, the == (double equal signs) is used to see if the values are equal. This is different than the = (single equal sign) which will assign the value on the right to the tag on the left. Be careful!

- ‘40001’ > 10
  The above example will evaluate to True when register 40001 is greater than 10.
• 'Pressure' > 250 || 'MaintenanceMode'
  The above example (|| is a logical OR) will evaluate to True when Pressure is greater than 250, or MaintenanceMode is True.

  Tip: All logical operators can be accessed from the drop down box to the right of the value field. For example, to select a logical "or" operator, select Operators, then Logical Operators, then Logical OR, and the "||" will be placed in the formula. Used these same steps for all operators.

• 'ControlBits' & 128
  The above example (& is a bitwise AND) will evaluate to True when the 8th bit in ControlBits is ON, regardless of the other bits.

Notes:
  • Pay attention to Property Value Formats (single, double, or no quotes)

Notes:
  • The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
  • Click the Ellipsis button (…) to select a tag, operator, or function which is defined in a library.
  • The Order of Precedence must be considered in formulas.
  • Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

  Note:
  • In state evaluations (ie: Indicator and Led states), expressions are evaluated as specified by the State Evaluation property.

First Time User Tutorial

Project Requirements

At minimum, these project components are required to create a Unit:
  • A configuration with at least one page.
  • A client OPC connection.

After assigning the configuration and client to the unit then:
  • Check the unit for errors.
  • Send the files to the unit.

Application Creation

Follow these steps to successfully create a unit.

Note: Creating a "Unit" means creating an application to run on a unit. It is referred to as a Unit because, for most flexibility, the ePro software combines the necessary Runtime parts in a Unit component. The Unit combines a Configuration (Pages and Libraries) and a Client (eg: PLC).

1. Set up the Kepware_ePro OPC server for the destination device. Create a KEPWare configuration file (.opf) to send to the unit.
  • Open the KEPServer_ePro software.
  • Select the New icon in the KEPServer toolbar.
• Click as directed to add a channel in the software; give the channel a name; and choose the "Allen-Bradley Ethernet" device driver. Leave the rest of the selections as default. (The final screen in configuring the channel will give you a summary of your choices.)

• Click as directed to add a device in the software. Give the device a name. Select "SLC 5/05 Open" for device model; and enter the proper IP address. Leave the rest of the options at defaults. (The final screen in configuring the device will give you a summary of your choices.)

• Save the configuration file on your PC and exit KepServer_ePro.

2. Create an OPC client for each device in the Kepware_ePro server to which you wish to communicate.
• Open ePro Canvas.
• Right click the Clients folder and create a new OPC Client Adapter. Give the client a name.
• Use the pull down arrow at the end of the Server Name field to choose EatonElectrical.KEPServer_ePro.
• In the Access Path field, use the pull down arrow to select Channel1.Device1 where “Channel1” is the name of the channel you configured in Step 1 and “Device1” is the name of the device you configured in Step 1.
• Click on the field labelled "Click here to import items".
• Click "OK"

3. Create pages using the tags you created.
• Click the Page bar in the component bar pane and double click the ePro ES/PS Page icon.
• Name the Page.
• Click "OK" and then double click on the page in either the project components pane or the component data pane. This will open the OI Page Editor.
• Put a Readout Template on the page by either double clicking on its icon in the control bar pane or by clicking and dragging the icon from the control bar pane to the page view pane.
• Double click on the Readout Template and make the following changes:
  General tab:
  • In the Value field, enter 'N7:0'.
  • Use the pull down arrow to change Operator Input Type to Data Entry.
  Data Entry tab:
  • In the Target Expression field, enter 'N7:0='ClientSystem,?'.
• Click "OK" on the Readout Template Properties window and save the page.
• Double click on the Rectangular Button and make the following changes:
  General tab:
  • In the Break Label field, enter "Exit".
  • Use the pull down arrow to change the Break Action field to select the ActionExit action.
• Click "OK" on the Readout Template Properties window and save the page. Exit the OI Page Editor (not the Project Explorer!).

4. Create your configuration by linking pages to it.
• Create a new Configuration and give it a name.
• In the Home Page field on the General tab, use the pull down arrow to select the page you created as your home page.
• Save these changes. (Click OK)
5. Create your unit by linking your clients and configuration to it.

- Create a new Unit and give it a name.
- On the General tab, Default Client Name field, use the pull down arrow to select the Client created in Step 2.
- On the Destination tab, set the fields in Line 1 as follows:
  - Transfer .ucf – Yes if you wish to send the file to an ePro hardware unit.
  - .ucf Name – Click the Ellipsis button at the end of the field and use the dialog window to select the location and name of your .ucf file. (Must be done even if you’re not saving the file to your PC.)
  - Transfer Runtime – Yes (if you have not loaded the runtime to this ePro.) You will normally only need to download the runtime to your ePro ONE time. If you have already done this step, you may leave the option set to No.
  - Runtime – Use the Pull down arrow at the end of the field to select the correct runtime for your hardware unit. (Currently, there is only one choice.)
  - Transfer Driver(s) – Yes if you have not yet downloaded the correct driver to this ePro. This will send not only the KepWare driver, but the .opf file as well. You will normally only need to perform this step ONE time. If you have already performed this step, you may leave the option set to No.
  - Driver – Use the Pull down arrow at the end of the field to select the correct driver for your hardware unit. (Currently, there is only one choice.)
  - .opf Name – Use the Ellipsis button to select the .opf file that you wish to use on your hardware unit.

NOTE: in order to Transfer Driver(s) to the ePro unit successfully, you will need to select the correct KEPWare configuration file (.opf) to send to the unit. The correct file must be stored on the machine that you are using to send the files to the ePro. Additionally, the .opf file must have been saved on your PC from within your KEPServer_ePro software. When a save from within that software is done, a secondary file is created that has an extension of “.wcefiles”. This secondary file and the .opf file must be in the same directory for the ePro’s Send to file… function to work properly.

- Destination Path or IP Address – Enter either the IP Address of the ePro unit to which you will send the files, or the Drive Letter of the compact flash reader on your system.

- On the Destination tab, set the fields in Line 2 as follows:
  - Transfer .ucf – Yes if you wish to save the file to a location on your PC.
  - .ucf Name – click the Ellipsis button at the end of the field and use the dialog window to select the location and name of your .ucf file.
  - Click OK when you have completed data entry on these fields.

NOTE: If you are only saving the file to your PC, you only need to set the properties for Line 2.
- Be sure that the Unit you created is highlighted.
- Drag ClientSystem from the project components pane to the component data pane and drop it on the icon of your unit.
  - Repeat for all OPC Clients.
- Drag your configuration to the component data pane and drop it on the icon of your unit.
  - The page you created has already taken its place as a subordinate to your configuration.
- Drag the ActionSystem Action Library to the component data pane and drop it on the icon of your configuration.
• Drag the MediaSystem Media Library to the component data pane and drop it on the icon of your configuration.

• When all components have been moved to the component data pane, right click on the icon of your unit and select Check for errors...

• Click the Check button and the Canvas software will scan your Unit Configuration File (.ucf) for errors. If errors are found, scroll to the highlighted error(s) and double-click on the error to bring you to the dialog box necessary to correct the error. Fix error and repeat until all errors are gone.

6. Once the errors are corrected, use the send to unit function to send the unit (compiled application) to the PanelMate ePro unit.

• Right click on the icon of the unit you created and select Send to file...

• Click the Send button at the bottom of the window.

• Canvas will automatically perform a check for errors on the application and – as long as that passes – will perform all selected options in the Destinations tab.

See Transfer Issues for help troubleshooting errors.

Notice that the media and action libraries are not involved because they are not necessary to create a unit. While these simple steps will create a functional unit. You'll want to make sure you take advantage of creating components for the libraries so that future units will be even easier to create.

Indexed Lists

Index Lists allows you to substitute properties of a configuration component dynamically based on the value of an index expression. This means that a page control or action can change its indication or control function online. The purpose of index lists is to reduce the number of pages needed in a configuration by allowing a single page to represent multiple unit operations or multiple diagnostic screens without changing pages by simply changing a single value that provides an index into one or more tags or expressions in a series of Indexed Lists. Simply put, indexed lists allow page components to reference lists of addresses or tags based on the value of an Index. For example a readout value can show different PLC addresses based on a PLC register that acts as an index into a list of those PLC addresses, and an indicator template may show states of a series of devices based on that same register value. Non-dynamic properties such as template titles and text controls can also show lists of string values based on an index.

An example helps to illustrate the use of Indexed Lists. The following pictures show a process that has three different unit operations called AGI Mix tanks. All tanks are fundamentally similar in terms of process inputs, outputs, status, and control functions.
Using Indexed Lists a single page may be created in ePro Canvas that represents all three Mix Tanks. A total of 24 indexed lists supports the single page’s 10 dynamic status attributes 7 control functions (5 pushbuttons and 2 numeric entry fields) and seven text fields, including the page title and template legends. In addition, if the scales of the bar graphs needed to be dynamic because of different pressure or temperature ranges from tank to tank, they could also be changed by Indexed Lists. The two up/down pushbuttons next to the page title increment and decrement a register that goes from 0 to 1 to 2 and is the index value for all 24 indexed lists. That register is also displayed as a readout value ('register' + 1) in the title area of the page to indicate the Mix Tank currently being displayed and controlled.

Another example of the use of Indexed Lists is in conjunction with Master Pages. A Master Page may be created where some of the page properties, such as page title, are driven by Indexed Lists whose index is the page ID Number property, referenced online by the System Client tag CurrentPageId.

The benefits of Indexed Lists are a reduction in the number of pages, and number of objects in the configuration, which saves memory, improves performance, and simplifies configuration management by reducing the number of copies of pages and objects with different address/tag references and expressions.

Creating and Using Indexed Lists

Indexed List entries are stored in Indexed List libraries and the library needs to be linked to the Configuration like all other Canvas libraries such as Media, Color, and Action libraries. The properties of an Indexed List are shown below:
Each Indexed List has an Indexed Expression that controls the Index List Entry value online. In the above example the tag ‘Vessnum’ in device PLC1 will be used to determine which index entry on the List tab is displayed at runtime.

The items in the List tab need to define the complete property value to be evaluated at runtime. That means that if a tag is part of an expression property, such as a conditional expression in an indicator template (Eg. ‘tag1’ & !‘tag2’), or a scaled value in a readout (Eg. ‘N7:154’ * 9.5 + 32) the entire expression must be placed in the Index List.

To use an Indexed List when editing a page control’s property dialog, simply select the Indexed List entry from the Indexed List Library in the pulldown list or from the Expression Editor window. An example is shown below for the readout template showing V1FlowRate, V2FlowRate or V3FlowRate of the previous example:
Where the Legend Title also comes from an Indexed List of text strings showing "Vessel 1 Flow Rate", "Vessel 2 Flow Rate", and "Vessel 3 Flow Rate". Virtually any parameter may come from an Indexed List including Visibility Expressions, Decimal Places, Data Entry Target Expressions, Button Entry Labels and Actions, Trend Template and Bar Template Max Min Calibrations, Indicator State Expressions, Media, and Color, as well as Action properties. Properties that do not support Indexed Lists are those that are restricted to pre-populated lists in the editor, such as Operator Input Type, Indicator State Evaluation (type), and Font.

**Master Page**

The purpose of Master Pages is to allow you to create one or more sets of objects that can be used on multiple pages of a configuration. This enables you to more easily develop a common look and feel to a configuration, create a consistent page change methodology, and manage information and control functions that are common to many, if not all pages. The result is that there are fewer total objects in a configuration since objects that appear on Master Pages are only defined once in the editor and online. This results in .UCF files that are smaller and utilize less system memory online. It also makes it simpler for you to make changes to common page controls, since you only need to change it once on a Master Page being utilized by other pages.

Master Pages are defined in the Page Properties of every page. You can designate either no Master Page or up to three Master Pages for each page. Since there is no difference between a Master Page and a normal page, any page can be used as a Master Page for any other page and a Master Page may contain any components that can be placed on any other page, both static and dynamic. Master Pages must be added to a Configuration's "Pages" tab like any other page and they will be accessible just like any other page in a configuration. If you do not wish to allow an online user to be able to change pages to a Master Page you should set the Page Enabled Expression for a Master Page to zero (0).
When you assign Master Page(s) to a page you also choose the draw order of Master Page components relative to the page. Each Master page’s components can be set to draw in Front (on top) or in Back (behind) of the page objects as shown in the following example:

For example if the following page were used as a Master Page for other pages, online each page would look just like any other page but the shared components would be identical on each page. (Note: this example also uses an Indexed List to change the text in the Title bar at the top of each page based on the Page ID Number)
Master Page Example
Online Example 1
Media Library Import and Export

Media Library Export

A Media Library can be Exported to an XML file by right-clicking on the Media Library to call the menu as shown below. Select "Export Media Library..." and enter a name on the ensuing file dialog box then select Save. An XML file will be saved with the contents of the selected Media Library in the format shown below in the Media Library XML File section.
Media Library Import

A Media Library is imported from an existing XML file by right-clicking on the Media Library to call the menu, and selecting “Import Media Library...”. Select a name on the ensuing file dialog box, then select Open and the contents of the XML file will be saved into the selected Media Library.

Additionally, the Media Library import function is available from the File/Import menu.

When the XML file is imported, each row (entry) is handled as follows:

- all entries in the media library will remain
- if the name is identical in the XML file and media library but the language values have changed in the XML file, the media library entry will be updated
- if the XML name does not exist in the media library, the entry will be added to the media library

Media Library XML File

The XML file is configured as follows. Row 1 contains the items in which the entries will be imported. This row is reserved for titles and must appear as shown below with the exception of the languages. There will be one language title for each desired language.

**Note:** each Language must be spelled exactly as it appears in the Language List of the Media Library editor.

Column 1 contains the name (Name property) given to each entry.

296
When editing an XML file to be imported, be careful not to add items to the XML file in Excel that do not agree with the XML format of the Media Lib. **Below are examples which must be avoided:**

1) A carriage return within a cell will be interpreted as an end of a library entry.
2) Data outside of the number of columns set aside for the media library, ie: data placed in a cell which does not have a column heading.

**WARNING 1** - simply clicking on a cell will create a value for that cell.

**WARNING 2** - deleting an unwanted row (Media Library Entry) by selecting “Cells” then pressing delete maintains values for those cells. An unwanted row must be removed by deleting the entire “Row” (ie: not one cell at a time). For example, if a media library XML file has 20 entries (rows) and a user decides to remove the last 10 leaving only 10 in the file, the user must delete the rows that contain the data. Simply selecting the rows and deleting their contents using the delete key will result in the problem described above.

**WARNING 3** - If invalid characters or cells are part of the XML file, the import will appear successful, but property values in the media library will be incorrect.

### PanelMate PowerPro Import

The PowerPro Import utility provides a means of upgrading prior product files to ePro Canvas. Specifically, a PanelMate .PPS configuration file can be imported.

**Note:** This function is only available with the ePro Canvas "Professional" version of software.

### How to Import a .PPS file

1. Copy the .PPS file to the ePro Development PC.
2. Run the ePro Canvas Professional software.
3. Select File/Import/PowerPro Configuration
4. Locate the .PPS file from step 1 above.
The Project Explorer tree will be populated with Configuration, Client, Messages, Pages and etc. from the .PPS file.

**Supported Features**

Support for importing of PanelMate Power Series/Pro application features in ePro Canvas Professional falls into three categories, Fully Supported, Partially Supported, and Unsupported. It is the user’s responsibility to determine what to do about unsupported features in the new ePro Canvas solution. The following describes in detail all of the Power Pro application features and in which category each feature falls.

**Fully Imported**

- All PPS files will be imported and converted to Canvas Units with the name of the PPC file.
- All page components will be imported and converted to their equivalent Canvas components including text, graphic primitives and bitmaps. Bitmaps will be created in the Image folder for the configuration (default: C:\Program Files\Cutler-Hammer\ePro Software Suite\Images\PPSFILENAME) under a folder named after the imported PPS file name.
- All PLC and OPC references, conditions and expressions will be converted to their equivalent Canvas syntax and operators.
- Symbol Library – All symbols are converted to enhanced metafile format, .EMF, and placed in the Image folder for the configuration (default: C:\Program Files\Cutler-Hammer\ePro Software Suite\Images\PPSFILENAME) under a folder named after the imported PPS file name. The symbols are all contained and referenced in the new Power Pro Media Library.
- PanelMate startup page number will become the Canvas Home page
- The Default PLC Name in the PLC Name & Port Table will be converted to a client connection with the device name preceded by the PPS file name and it will be set as the Default Client Connection of the Unit. Any non-default devices will have the converted Client name appended to the reference in ‘device,reference’ format.

**Partially Imported**

- All Devices in the PLC Name & Port will be converted to OPC client connections. If the device was attached to a Native PLC driver all driver setup information is included in the Import Warnings property to assist the user in setting up the equivalent Kepware OPC Server. Any OPC devices will have the same Server Name and Access Path as referenced in the PPS file.
- All Pages will be imported and the page names will be preceded by the PPS file name followed by an underscore. The PanelMate page number will be converted to the Page ID# in Canvas. Page Password protection is not supported and Maintenance Templates are not supported.
- Colors are converted to the Windows RGB color values for all colors except blinking colors. The ColorSystem Color Library contains blinking colors entries that match each of the possible blinking colors from PanelMate Power Pro. Any blinking colors will need to be mapped by the user to the corresponding blink entries of that library.
- Text with the vertical attribute selected will be imported but displayed as Horizontal Text.
- Variable-Sized Graphic objects will import and link their indicator states to the imported symbols in the Power Pro Media Library. Override colors for foreground or background color of those symbols are not supported.
- The Message Library will be imported as a new Canvas component called Power Pro Media Library. All message text, message numbers (ID’s), fonts, colors and any embedded data references will be imported with their format strings, but time/date format will not be supported. The destination field, screen/printer/both, is not supported since all messages will only be sent to the screen. Message Library Commands – any messages preceded by the @ sign used for Passthrough functionality, re-direction of the message library to a .CSV file, or initialization of internal scratchpad variables – are not supported.
Not Imported

- Default Page Components – The four page components that are built into each PanelMate Power Pro page (optional when using Flexible Page Layout) are not imported. These include the Page Status Banner, Cancel Key, Alarm Table, and Default Buttons.

- Default System Components – All System Parameters with the exception of the startup page number are not imported.

- Alarms are not imported or converted to ePro Canvas events

- System Online Labels are not imported.

- Internal Scratchpad Variables are not imported.

- Online Comm. Error line function is not imported.

- Enable Fault Relay/Comm. Error Reset function is not imported.

Import Suggestions and Workarounds

Un-imported Default Page Components

In general the Default Page Components are ideal candidates to go on a Master Page (new in V2.10) used by all pages. For the Page Name shown in the Page Status Banner an indexed list (also new in V2.10) containing page titles indexed by the system tag CurrentPageId would work in a Master Page.

- Page Status Banner – Provides the Page Name and shows any pages that contain active alarms with the page number with a blinking red background. Solution/Workaround: Place a text control at the top of the page showing the page name. Since alarms aren't associated with page components in ePro Canvas the page alarm feature does not translate into a Canvas feature. However, the internal system tag "EventsActiveUnacknowledge" can be used for indication of any active-unacknowledged alarms whenever its value is greater than zero and this indicator can be placed on top of the Page Name text field in the form of an LED control.

- Cancel Key – Provides an area labeled "Cancel" which can be touched to de-select any template and "cancel" the display of any two-touch control functions (pushbuttons & numeric entry). Also displays the real-time clock in HH:MM:SS format. Solution/Workaround: Add a text control labeled "Cancel" and a Clock control to the page where the Cancel key was.

- Alarm Table – Provides four lines of alarms under the Page Status Banner. Solution/Workaround: Open the alarm/event banner in the area where the Alarm Table was located.

- Default Buttons – Provides standard buttons to navigate page changes (by page number), view or acknowledge alarms, silence the alarm horn, and clear intermittent communications errors. Solution/Workaround: Create a vertical button bar with buttons to call the "Get Page" action, the Open Event Banner in full screen Action, and an assignment action to clear the system tag “CommErrorDetect” (for clearing communication error indication).

Default System Components

System parameters for the following features are not imported:

- All Password Functions – Includes Password A and Password B and changes or overwrites to those two passwords, Page Password Timeout, Password protection of Offline Mode or Set Date/Time. Solution/Workaround: Future releases of Canvas will include built-in password/security features. In the meantime passwords can be stored in the PLC and used to control page access through the Page Enabled expression of page properties, and object selection/control access through the template visibility attribute of individual page objects.

- Retry Delay – This function relates to PanelMate communications drivers (native, non-OPC drivers) and how you could configure those drivers to reduce their polling rates when
communications failures were detected. Implementation of this function is the responsibility of the OPC server provider.

- **Bit Zero after Comm. Fault.** – This feature was used to reset all momentary pushbutton bits in the PLC whenever the operator pushed the "Enable Fault Relay" button following a communication error. This was a safeguard to make sure that any missed momentary pushbutton writes to the PLC due to a communications error would place the bit back to a reset state. Solution/Workaround: Add a "heartbeat" function to the Canvas application. Set up an assignment action as a conditional-passthru assignment where the ePro would read a counter in the PLC and write the value to another register in the PLC. If the PLC increments the counter at a rate that insures the ePro should be able to read and write back the counter value in the time frame, logic in the PLC can detect this loss of communications and automatically reset any critical momentary control bits in the PLC.

- **Audio Output Parameters for Operator Input and Alarms** – The PanelMate Power Pro’s audio output port could be used to drive an 8 ohm speaker and it could be configured to sound the horn on alarm and when a user input function, like pushbutton make/break, occurred. Solution/Workaround: In the next ePro PS load (due in January 2005) certain USB audio devices will be supported. Using the new Actions, Start Application, and Action List, wave files can be run to produce audio feedback for new alarms and pushbuttons.

- **Inactivity Period Parameters for Screen Blanking and Automatic device Cancellation** – These features would put the display in a "screen saver" mode after a configured time of inactivity, and would cancel any operator control selection (two-touch control buttons or numeric entry) after a minute of inactivity. Solution/Workaround: Configure the backlight dimming feature of all integrated ePro PS units (not available on the blind node) to dim the screen to increase the life of the backlight after so many seconds of operator inactivity. There is no way at present to automatically "cancel" an operator’s selection of a control device.

- **Control Bit Reset Delay** – This was used for delaying the bit write (reset) on the "break" of a pushbutton for those cases where a long ladder scan time might cause the PLC to miss the momentary pushbutton of the operator. This function is rarely required and no simple workaround for this exists today.

- **Host Window Display Mode** – This rarely used feature allowed the user to open an area of the PanelMate screen to receive serial ASCII text from a host computer and emulate a dumb terminal. Solution/Workaround: Use Windows Hyperterminal for this function and launch it and control it using the Start Application Action.

- **Immediate Page Change** – This setting allowed the remote page change function to change PanelMate pages even when a two-touch control was "selected". Solution/Workaround: Using a conditional Goto Page Action based on a PLC register which ties to the Page Index will automatically work this way.

- **Extended Fonts and any changes to editable characters in any of the four fonts** – This feature was used because PanelMate’s limited character set make it difficult to do international applications. Solution/Workaround: Using Windows True Type fonts and Unicode support in ePro Canvas allows you to use any international characters including Hebrew, Greek, Cyrillic and the ideogram characters used in Chinese, Japanese, and Korean languages. This coupled with the multi-language support of the media library is a much more robust solution for international languages and fonts.

- **Redefined Double High or Quad Fonts, are not supported by PPS import**. This feature was a carryover from the DOS editor which didn’t support pixel based graphics and symbols were created by character graphics. Solution/Workaround: If an application was imported into PanelMate Power Pro from the DOS editor and these character based graphics were never converted into Power Pro’s pixel-based graphics you will now need to recreate those old symbols. With ePro Canvas support for BMP, JPG, EMF, WMF, and GIF graphics formats the user has a wide array of tools and images to create realistic pixel based graphics.

- **All Remote Functions** – Includes Silence Alarm Horn Bits, Alarm Acknowledge Bits, Enable Fault Relay Bits, Page Change Registers, Reset Clock Bit, Sending of Passwords to Registers, Sending of Hardware Selection Status. Solution/Workaround: Most remote functions can be accomplished in ePro Canvas using Actions. Some, like Enable Fault Relay Bits and Sending of Hardware Selection Status simply don’t apply to the new hardware. Remote Page Change to PLC can be accomplished using a Conditional Passthru Assignment action to write the system tag ‘CurrentPageNumber’ to a PLC register. A conditional Goto Page action can be used to go to the page whose index matches a PLC register value. Currently there is no provision to remotely
acknowledge alarms or to set a remote bit when the operator acknowledges alarms in ePro PS Runtime.

Alarms

Alarms are not imported or converted to ePro Canvas events. Alarms in PanelMate Power Pro were tied to visual page objects and which required the user to create a visual component to build any and all alarms. In ePro Canvas alarms and events are created in the Log Event Action. All system events and alarms can be configured either in a conditional Log Event Action, type->expression or type->bit if the alarms are being packed as individual bits within words. Solution/Workaround: The import operation identifies all page components that have alarms associated with them and embeds Import Warnings into the properties of each imported item. The operation also creates a single text file for each imported PPS that lists all import warnings for the entire configuration. The developer can then go through each page in the text file and copy and paste the alarm text as they configure the Log Event Actions for the configuration.

System Online Labels

PanelMate Power Pro System Online Labels gave the user the ability to modify all default system text for menus and buttons in the runtime application. It was mostly used for non-English language applications so that the user could provide translations for those default runtime functions. Solution/Workaround: All ePro Canvas runtime text is configurable by the user and these labels may reference Media Library text strings that contain multiple language translations and can change at runtime based on the Active Language Expression. Because the default text strings in the ePro PS Runtime don't match those from Power Pro there is no reason to import System Online Lables.

Internal Scratchpad Variables

PanelMate scratchpad variables were used to hold local operator selections and to control how certain runtime features operated. Solution/Workaround: With ePro PS’s built-in OPC server, KEPServer_ePro, the user has the ability to create a connection to local variables/tags stored in a 16-bit device attached to a channel using the Simulate driver. These variables can be of any data type and can be used to replicate any PanelMate Power Pro scratchpad functions needed by the application.

Online Comm. Error line function

The PanelMate Power Pro would always report PLC and OPC communication errors by displaying those errors in White on Red text at the bottom of the runtime page. Except in the PanelMate PC application these errors could not be stored for future review and in no case could they be displayed in any alternative format. Solution/Workaround: All communication errors reported by the OPC server as "bad" data quality are placed in the Alarm/Event log and the system variables 'CommErrorDetect' and 'CommErrorMsg' can be used to indicate communication errors status to the operator. The system writes a one to the 'CommErrorDetect' tag whenever the OPC server reports a new error. The application can use any indicator device to show the status of this tag and a button can be placed anywhere on a page to zero out the tag and clear the indication. The system also writes the text of the error into the tag 'CommErrorMsg' so that the user can display its contents with a standard Text object.

Enable Fault Relay/Comm. Error Reset

This feature in Power Pro reset the Fault Relay hardware component following a reported communication error and forced a redraw of the PanelMate page to clear the red communication error line. Since the Fault Relay function would be replaced by a PLC "heartbeat" function (described in item 2c above) the PLC will already detect when the communications is restored. And since the user controls the display of communications with the 'CommErrorDetect' and 'CommErrorMsg' tags, the pushbutton to reset these tags will clear the indication without requiring a screen redraw.
Image Directory

When a PPS file is imported a directory is created under “C:\Program Files\Cutler-Hammer\ePro Software Suite\Images” with the PPS file name as the directory name. In that directory a text file name ImportInfo.txt is created that summarizes all the steps taken during the import process. It encapsulates all warnings for each component viewable in the Message Pane and summarizes all object warnings per page which simplifies conversion of PanelMate Alarms to ePro Canvas Alarms/Events.

A new Message Pane

A new visual panel available in the Project Explorer of ePro Canvas Professional, the Message Viewer displays all Power Pro import information captured during the import step that can be used for completing the conversion of Power Pro applications into Canvas applications. It lists all features of the selected imported PPS component that were not converted by the import process. This information can then be used to determine what additional effort is required to incorporate those features into the Canvas application.

To enable the Message Viewer select "View > Message". This will add a pane at the bottom of Project Explorer as shown below:

When a component in the Component Data pane is selected, (Unit COLMAC3.PPS shown above), the Message Viewer shows the file name and date the PPS file was imported followed by any warnings of non-imported features or parameters. The scroll bar can be used to view all of the warnings or the pane may be resized as shown below to view all of the import information and warnings.
When viewing page components as shown below, any page objects that have alarms associated with them will show in the Component Data pane with warnings. Selecting those components will display the warning details in the message pane as shown below:
An alternative view of any import warnings is shown in the General Tab or any object’s properties. The following dialog box for the imported Unit Properties is shown below. The Import Warnings field can be resized vertically to show the entire text of the field:
Parameter Passing

Parameters can be passed to Actions. This minimizes the number of Actions that are necessary by allowing re-use for similar instances. Two examples of this are shown below.

Page Change Example (Goto Page Action)

A good example of parameter passing is an Action file that is set up to call a page by passing a parameter (i.e., the Page Name) from a Button on the page. Without parameter passing, an Action would need to be created for each page that will be called.

The following is an outline of how to create a re-usable GoToPage Action:

- Create 2 Pages, PageX and PageY.
• Create a **Goto Page Action** called GoToPage and set its **Destination Page** to \#1. The \#1 is a placeholder for the first parameter passed with this Action. The passed value (PageX or PageY) will replace the \#1.

• Create a **Rectangular Button** on PageX and assign its Break Action ‘GoToPage(PageY)’. By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the GoToPage action.

• Create a **Rectangular Button** on PageY and assign its Break Action ‘GoToPage(PageX)’

The button on PageX will call PageY and vice-versa, with a single Action entry.

**Notes:**

- Page changes should be a result of the Break Action since that would be the last operation to be performed on the calling page. If the Make Action was used, then a new page would be called, and the Break Action from the calling page would be lost.

- \#1 is used in the Action entry file as a placeholder for the first passed parameter.

- By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the GoToPage action.

**Bit Write Example (Assignment Action)**

Below is an example of a single Assignment Action entry used to turn a bit ON then OFF. This example allows sharing the BitChange Action for both writes.

• Create an **Assignment Action** called BitChange and set the first **Assignment Expression** to ’Bit’=\#1. (Again, the \#1 is where the first passed parameter will be placed.)

• Create a Page.

• Create a **Rectangular Button** on the Page and put ’BitChange(1)’ in the Make Action field and put ’BitChange(0)’ in the Break Action field. Again, the value in parentheses and within the single quotes is the parameter to be passed to the BitChange actions.

When this button is pressed, the command becomes ’Bit’=1. Similarly, when the button is released, the command becomes ’Bit’=0. This example is a momentary pushbutton.

**Notes:**

- This type of control should be used with caution. The response time (between the make/break and the corresponding bit writes) may not be accurate enough for time critical applications.

- \#1 is used in the Action entry file as a placeholder for the first passed parameter.

- By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the BitChange action.

**Property Value Formats and Syntax (single, double, or no quotes)**

Throughout the ePro Canvas editors and property windows, property values of various types are entered. Depending on whether the value is **Evaluated** or **Non-evaluated**, several rules must be followed to accurately enter these values. Before the rules are applied, it must be determined whether it is an evaluated property or not.

**Evaluated Properties**

Properties which can vary during Runtime, require a mathematical evaluation and parsing for proper syntax. These **Evaluated properties’ entries** can be dynamic, thus having an undefined number of values. It is possible and common for an evaluated property to contain an entry or expression that is not dynamic, but the property is still evaluated. In the editor, there is a simple way of determining if a property is evaluated. If a **property has a pull-down arrow (\(\downarrow\))** which leads to a pull-down library menu, **the property is evaluated**. In the figure below, the Value property has a pull-down arrow, and when the arrow is selected, a library menu is presented as shown below. This gives access to various references
from various locations, all of which can dynamically change during runtime. So, the Value property of a Readout Template is one example of an Evaluated Property.

**Non-evaluated Properties**

Properties which contain values which cannot vary during Runtime are NOT evaluated. Non-evaluated properties are static and have a finite set of values. These property types can be determined by the properties' type of entry - when the library menu is not available, the property is non-evaluated. For instance, fields with no pull-down arrows, Yes/No selections, and short menus are all NOT evaluated.

Below, the Orientation property is non-evaluated because it's pull-down arrow leads to a menu with only several options (not the entire library menu).
Evaluated Properties Syntax

Note: Using the pull-down menus to select the entry values is the easiest way to determine syntax, because quotes are automatically added when needed.

Text and Names

Double quotes are required around strings which include text and names.

- **Text Strings** that are entered directly in a **Text** property or a **Media Library Entry** will be displayed exactly as entered, and requires DOUBLE quotes
  - "Template Title"
  - "rpm"
  - "This text will appear"

Note: when referencing these media library entries, the strings are referenced with single quotes.

Note: Legal characters in text fields (i.e. characters within double quote marks, “abcdedg”) include all Alpha and Numeric characters, spaces and special characters except:

<table>
<thead>
<tr>
<th>Backslash</th>
<th>To display a backslash within double quotes you need to place a second backslash in the string. Eg. “Start \ Stop” will display as Start \ Stop</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double Quote</td>
<td>To display a double quote within double quotes it needs to be preceded by a backslash and must be either the first or last character in the string. Eg. &quot;&quot;\To be or not to be\”&quot; will display as “To be or not to be”. To place double quotes in the middle of a text string you need to use text concatenation. Eg. “This is a &quot;&quot;Special&quot;&quot; + “\case” will display as This is a</td>
</tr>
</tbody>
</table>
"Special" case

' Single Quote. To display a single quote within double quotes it needs to be preceded by a backslash. Eg. "This is a '\Special\' case" will display as This is a 'Special' case.

& Ampersand. To display an ampersand within double quotes you need to place a second ampersand in the string, otherwise the ampersand character serves to underline the following character within the string. Eg. "This && That" will display as This & That. Whereas the string "&T&N&T" will display as TNT.

- **Images** on a Page can be directly entered (ie: not using the media library) by browsing for the image name, which will add DOUBLE quotes and double the backslash characters
  - "c:\\overview.bmp"

  Note: Backslashes (\) are used to identify control characters embedded in a string. If a \ is needed inside a string with double quotes, it must be duplicated for distinction (ie: "c:\path\filename"). However, / can also be used without doubling (ie: "c:/path/filename").

Images can also be manually entered with single forward slashes
  - "c:/overview.bmp"

  Note: When Images are entered into the media library, quotes are not required.

- **Documents** entered into a View Action, Document Viewer Type, require a name in DOUBLE quotes. Again, backslashes are doubled.
  - "d:\\information.html"

Documents can also be manually entered with single forward slashes
  - "d:/information.html"

- **PLC or Library Entry Data** can be embedded into text strings as described below under the Combinations/Expressions/Concatenations heading.

Library References

Generally, single quotes are required around library entries. A good way to enter these is by selecting the pull-down box, and drilling down through the libraries to find the entry. Single quotes will automatically be added when needed.

- Properties that contain **Clients** and **Library Entries** (Tag Library Entries, Action Library Entries, Media Library Entries, etc.) are entered with SINGLE quotes
  - 'ClientPLC,400001'
  - 'Tag'
  - 'LibEntryName'
  - 'Lib,LibEntryName'

- Active library names can be entered alternatively, using Explicit references to **Clients** and **Library Entries**. These are entered with SINGLE quotes. 'MediaLib1,Ref' can be replaced with
  - ':Media:,Ref'

- **Text** referenced in a text property, from Media Library entries will be enclosed in single quotes, even though the reference represents text strings ('StartText', 'TextLib,StartText').

  Note: when text strings are created in media library entries, remember to place the strings in double quotes.
Note: Legal characters in tag names or Item Names (i.e. characters within single quote marks, ‘abcdefg’) include all Alpha and Numeric Characters, spaces and special characters **EXCEPT:**

<table>
<thead>
<tr>
<th>#</th>
<th>Casting operator</th>
</tr>
</thead>
<tbody>
<tr>
<td>@</td>
<td>Internal Client separator</td>
</tr>
<tr>
<td>,</td>
<td>Comma</td>
</tr>
<tr>
<td>=</td>
<td>Equal Sign</td>
</tr>
<tr>
<td>\</td>
<td>Backslash (Escape Character)</td>
</tr>
<tr>
<td>'</td>
<td>Single Quote</td>
</tr>
<tr>
<td>&quot;</td>
<td>Double Quote</td>
</tr>
</tbody>
</table>

**Literal Numbers**

Literal or hard-coded numbers used within evaluated properties, require NO quotes. These are evaluated because of their property type, yet are static since the value will not change during Runtime.

- **Evaluated Numeric Values** have NO quotes
  - 1
  - 98765
  - 2005

**Combinations/Expressions/Concatenations**

Expression properties follow the same rules in that references (tags, client tags, media entries) require single quotes, but constants and operators do not have quotes.

- **Writes**
  - 'Client,Ref' = 1

- **Comparisons**
  - 'Client,Ref' == 1

- **Scaling**
  - 'Client,Ref' / 10

- To **embed data** from the PLC in a text string, i.e: to mix text and data in a text control, you must use text **concatenation**.
  - "The tank level is " + $I4('client1,tag1') + " Gallons"

If the value of tag1 is 1234, this will display ... The tank level is 1234 Gallons

When using concatenation you may embed spaces either before or after the plus character to view the sting more clearly in the editor and the spaces outside single or double quotes will be discarded at runtime.

Anywhere you can place literal text (i.e. text within double quotes) you can also place media entries or tags with data type of string. Any tag references within the parentheses of the formatted data can use math or logic operators to create an expression. The following is the general formatted data syntax:

```
$tw.d(expression)
```

where ...
$ = format indicator

t = type of numeric display
   I - Integer
   H - Hexadecimal
   B - Binary
   D - Floating decimal real value
   O - Octal
   F - Fixed decimal real value
   A - Ascii

w = Total field width including decimal point, negative sign (-), and positive sign (+)
.
 = Separator between width of format and the number of decimal places (used with F format)
d = Number of decimal places (used with F format)

Format type D (floating decimal point) permits the decimal point to float in the display depending on the tag’s value. This contrasts with format type F (fixed decimal point) which formats a value with a fixed decimal location.

Formatted Data Examples:
If ‘client,tag1’ has a value of 54321, then:

<table>
<thead>
<tr>
<th>Formatted String</th>
<th>Value Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>$I5('client1,tag1')</td>
<td>54321</td>
</tr>
<tr>
<td>$F6.2('client1,tag1'/100)</td>
<td>543.21</td>
</tr>
<tr>
<td>$D8('client1,tag1'/100)</td>
<td>543.2100</td>
</tr>
<tr>
<td>$H4('client1,tag1')</td>
<td>D431</td>
</tr>
<tr>
<td>$O6('client1,tag1')</td>
<td>152061</td>
</tr>
<tr>
<td>$B16('client1,tag1')</td>
<td>1101010000110001</td>
</tr>
</tbody>
</table>

If ‘client,tag1’ has a value of 16706, which is 4142 hex (A=41 hex, B=42 hex), then:

<table>
<thead>
<tr>
<th>Formatted String</th>
<th>Value Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A('client1,tag1')</td>
<td>AB</td>
</tr>
</tbody>
</table>

If there is no additional literal text, media library text or PLC String data types to appear in the text control and you only wish to display the value of the tag you don’t need to use the formatted data syntax because the text control will automatically convert the value to a string. For example, if the text property is set to ‘client1,tag1’ and the value is 54321 then it will display as 54321

- ‘:Media:,Motor 1’ + " " + ‘:Media:,ON’ + " " + $I5('client1,tag1') + " amps"

Assuming the media library has two entries named ‘Motor 1’ and ‘ON’ containing their respective strings, and the tag ‘client1,tag1’ is a 16 bit integer (short) data type with a value of 54321, then the preceding text property value will be displayed online as ...
Motor1  ON  54321 amps
Non-evaluated Properties Syntax

If it is determined that a property is **NOT Evaluated**, then there are **NO quotes required**. The majority of these are numbers and pull-down menu entries (but not pull-down library entries).

**Non-evaluated/No Quotes Examples**

- Non-evaluated values with a YES or NO value require no quotes.
- Non-evaluated values selected from a **pull-down menu** with few choices will be selected from the menu and contain **NO quotes**.
  - HORIZONTAL
  - VERTICAL

**Note:** this does not include the pull-down library box.

- **Strings** that are not evaluated, such as a page added to a configuration, do NOT require quotes.
  - Page 1
- **Images** that are entered into the media library by browsing for the image path, will add a path string with NO quotes
  - c:/overview.bmp
  - This entry can also be entered as
  - c:\overview.bmp
- In the **Document Viewer, Home Page** and **Document Viewer Content, Document Location** properties, **NO quotes are used**
  - www.eaton.com
  - d:/information.html
- **Non-evaluated Numeric Values** have NO quotes

**Recipe Development**

The ePro Canvas Professional's Recipe Management functionality is comprised of four separate components:

1. Recipe XML file
2. Recipe Action
3. Recipe Runtime Licensing
4. Recipe Menu Control

All except for item 4, the Recipe Control, are required components for successful Recipe Management. It should be noted that a simple form of recipe management is possible using the Assignment Action to create lists of PLC register, or tag assignments which are build into the Runtime application. The downside of this simpler approach is that changes to the “recipes” contained in the application cannot be made without editing the Assignment actions in the ePro Canvas editor. The Recipe Management functionality allows the developer to create and maintain the recipes by editing an separate XML file using standard PC tools such as Microsoft Excel or Access. Note that support for editing XML files in Excel or Access requires either Excel or Access XP or 2003 versions at a minimum.

**The Recipe XML File**

A sample recipe XML file named “SampleRecipe.xml”is installed with ePro Canvas Professional V2.20 and is located in the base ePro Software Suite installation directory. The sample recipe file contains three sheets with each sheet representing a different recipe and where the sheet name is the recipe name of each (shown below):
The general format of a recipe in the Recipe XML file is:

Row 1: A header showing the definition of each of the four columns of recipe information.

Rows 2 through N: The recipe definitions of ingredient/step identifier, destination location, value and units.

Column 1: These are the names the user chooses to supply to identify the parameter name of each recipe ingredient or step. This column is used only for reference when editing the recipe and as a convenience to the developer to help identify the content of the destination address or tag shown in Column 2.

Column 2: This is the complete reference for each parameter of the recipe. The format of each cell is DeviceName,Tag (or address). The device name must match the name of an OPC Client connection configured in the ePro Canvas configuration which uses the XML file for Recipe Management and the Tag or Address must match a reference accessible to that OPC Client connection. The examples shown above represent an OPC Client named “PLC1” and the addresses represent standard Allen Bradley PLC5 or SLC 500 integer file registers. If the OPC Server contains tag names then those tag names may be substituted for the address references. Note that the device name is required even though the OPC Client named “PLC1” may be the default client connection defined in the unit properties general tab. Also note that the addresses/tags shown in one recipe may or may not be the same as addresses/tags in another recipe contained in the same XML file. Each recipe sheet within the recipe file is totally independent of all other recipe sheets in the file.

Column 3: This column represents the value of each parameter which will be written to the corresponding address or tag shown in Column 2 when a Recipe Download Action is initiated for that recipe.

Column 4: This column is used to identify to engineering units of each parameter in the recipe. Like column 1, the Units column is included as a convenience to the recipe developer to help identify the content of the destination address or tag shown in Column 2.

Note that each cell in the four columns must be filled in as no empty cells are permitted except after the last row defining each recipe. There are no imposed limits to either the number of ingredients in a single recipe or the number of recipe sheets in a single XML file. However, there are practical limits to the number of parameters contained in a single file which dictates how long it takes the ePro PS to read in a recipe file when a Recipe Management Action or Recipe Control needs to access the file. For example, a standard ePro PS will take up to a minute to read in a Recipe XML file containing 5000 parameters. If a single file is too large to hold all required recipes it is possible to use multiple Recipe XML files and multiple Recipe Actions and controls in a single ePro Canvas application.

The Recipe Action

The Recipe Action is only available in ePro Canvas Professional.
Note: This action is only needed if it is desired to have customized recipe functions (for instance, a stand-alone Load button). The functions necessary to operate and control a recipe are built into the Recipe control.

The Recipe Action has three modes, Load, Compare and Save. These three action types are detailed as follows:

See Recipe Management Action for additional information.

**Load Recipe Function** – If the Function property of a Recipe action is set to “Load”, the action, when executed at runtime, will load values to the OPC Client connection specified by the selected Recipe Name parameter from the selected recipe file specified in the File Name parameter. An optional field, Active Indication, allows you to specify a tag or address which will be written to in order to provide a mechanism to indicate that the recipe load function is in process via an Indicator or LED control. The recipe management load function will write a value of one to the Active Indication tag at the start of the load process and will write a value of zero to the same tag when complete.

The Log Event parameter can be set to Yes or No to enable or disable automatic logging of the Recipe Load event to the alarm and event log.

**Compare Recipe Function** – If the function property of a Recipe action is set to “Compare”, the action, when executed at runtime, will compare the values read by the OPC Client connection specified by the selected Recipe Name parameter to the values contained in the selected recipe file specified in the File
Name parameter. The numeric value of the number of comparison mismatches found will be written to the tag specified by the Ingredient Mismatch parameter. An optional field, Active Indication, allows you to specify a tag or address which will be written to in order to indicate that the recipe compare function is in process. The recipe management compare function will write a value of one to the Active Indication tag at the start of the compare process and will write a value of zero to the same tag when complete.

**Save Recipe Function** – If the function property of a Recipe action is set to “Save”, the action, when executed at runtime, will save the values read by the OPC Client connection for the last loaded recipe to the values contained in the selected recipe file specified in the Destination File Name parameter. **Note the Save function is only available if the last loaded recipe is highlighted.** The Destination File Name may be the same or different from the source file specified in the File Name parameter. If the two parameters are the same, then after saving the recipe file the recipe management function will re-read the Recipe XML file to in order to clear out the previous values from the selected recipe from ePro PS memory. This is done so that if that recipe is selected again for a Recipe Load function, the newly saved values will be loaded. An optional field, Active Indication, allows you to specify a tag or address which will be written to in order to indicate that the recipe save function is in process. The recipe management save function will write a value of one to the Active Indication tag at the start of the save process and will write a value of zero to the same tag when complete.
Recipe Runtime Licensing

The ePro PS license manager is loaded on each ePro PS machine. The runtime license for Recipe Management functionality, like the Data Archive functionality, is an optional component which must be purchased in order to use these features on an ePro PS unit. The Registration process is identical to that of registering ePro Canvas or ePro Canvas Professional software. First the ePro License utility must be started on the ePro PS unit from the start menu and the ePro Recipes line must be selected from the Software Registration dialog as shown below. If the Recipe Management feature is already licensed it will show a state of “Registered-License Active”, and the Activation key will show the key that was generated during the activation process. If unlicensed then only the Registration code field will show. To register and receive an Activation Key, follow the directions shown in the Software Registration dialog box. Be sure to have the serial number of the purchased Recipe Management license handy because that will be a required field in the online form. Once you receive the Activation Key following the online registration you may enter that key and click on the Apply Activation Key button. Once you have applied the activation key a dialog box will appear to indicate that the registration process was successful. If there was an error in entering the Activation Key you will be prompted to recheck the value and enter the key correctly.
Once successful, OK the success dialog box, Exit the Software Registration utility and perform a Protect Mode Save on the ePro PS to ensure that the registration is made permanent on the ePro unit.

Alternately, you may initiate the activation process before receiving the Activation Key by selecting the ePro Recipes line in the Software Registration dialog and hitting the Initiate License Activation key. Then exit the dialog box and run the Protect Mode Save function. This will give you a 10 day grace period during which you may run the Recipe Management features in full functional mode. Once you receive the Activation Key you will then need to re-open the ePro License utility to compete the activation process by entering the Activation Key and performing a Protect Mode Save function.

**The Recipe Menu Control**

The Recipe Menu Control is a page component that supports the Recipe Management functionality by providing an easy way to view a list of recipes and select a recipe for the Load, Compare, and Save functions. Since a Recipe Name property in a Recipe Action may be directly entered in the action, or it can be generated from other selection mechanisms that write a recipe name string value into the tag or address specified in the Recipe Name property, the Recipe Menu Control is not necessarily required to create a functioning Recipe Management application. However, you may find it a convenient way of providing easy recipe selection when online. The Recipe Menu control may be placed on any page using ePro Canvas Professional development software. The control’s default appearance is shown below:
Also see Recipe Menu Control for more details

When you go to the Recipe Menu control’s properties box, the top level properties are shown below:
The Title parameter defines the name shown in the Legend subcomponent and the File Name parameter defines the path where the ePro PS unit will find the Recipe XML file which you wish to associate with this Recipe Menu control for runtime recipe selection. If Operator Input Type of Button is selected as shown above, then six buttons will be pre-populated to for built in Home, Scroll Up, Scroll Down, Load, Compare, and Save button controls. This is one method by which you can allow the online operator to select recipes when there are more recipes in the Recipe XML file than can be shown at one time within the Recipe Menu control. Other standard ePro Canvas methods may be used to write to the Index Input Location parameter found on the "Menu Device" subcomponent (as shown below) which can serve to create a page up/down mechanism.
The Menu Device subcomponent provides four unique parameters for this control. The Index Input Location tag or address, when written to online, will automatically scroll and select the recipe sheet in the Recipe XML file corresponding to the number in the tag and will subsequently write to the next two parameters, Index Output Location and Text Output Location. The Index Output Location is used to show the selected recipe via highlight color (specified in the "Attributes" tab of the Menu Device subcomponent. The Text Output Location parameter contains the text string of the selected recipe (sheet name in the Recipe XML file). This may also be used in the Recipe Actions for loading, comparing or saving functions.

The 2 Touch Select parameter when set to "On" is used to allow the Home, Scroll Up and Scroll Down buttons to also select the highlighted recipe name so that the user doesn’t have to actually “touch” or click on the Recipe Menu control to select the highlighted recipe. If the parameter is set to “Off” then these buttons don’t automatically select the recipe, they just allow the user to view recipe names when the number of recipes exceed the display capacity of the control.

The Attributes tab allows you to customize the color choices for Recipe Name highlighting and selecting.
Referencing Media Library by ID Number

The Id Number of a media library entry can be used to reference that entry in a text field in the ePro Canvas editor. For example if the Id Number of a media library text entry was set to 47 as shown below:
And a text control was placed on a page with the id number expression attribute set to:
‘clientname,tagname’
Where clientname represents the name of the OPC client adapter (PLC) and tagname is a tag or address in that client. When the value of tagname is equal to 47 then the contents of that media library entry will be displayed online. The text property box would look like the following:

**Search and Replace**

This function allows string search and replacement within any component in the project or the entire project.
Getting Started

Search and Replace is accessed by right-clicking on the desired component (as shown below) or selecting the component and selecting the Edit pull-down menu.

**Dialog Box**

Upon selection, the following dialog is given.
As shown above, all items that are in the tree view below the component which originated the operation will have plc replaced with plc1.

Examples...

- Invoking from Project will replace all occurrences in the entire project.
- Invoking from Clients tree heading will replace all occurrences in all clients.
- Invoking from a client component will replace only items in that client.

Caution: if the page editor is open, and find/replace is invoked, only that page will be modified, and the changes are not saved until the page is saved.

Find Next

Selecting Find Next from the dialog box gives ability to OK each replacement as shown below.
Replacing text:

Replace

This button replaces only the currently found item.

Replace All

This button will replace ALL items in the current component and below.

Cancel

This will cancel the dialog box but maintain any replacements that have already been made.

Notes:

- The following property edit types are bypassed in the search: list side headers (i.e. row numbers), check boxes, radio buttons, and the non text editable versions of drop lists, spin buttons and colors.

- The search will only be performed on properties that are visible AND editable in the property editor. If you can’t see it or edit it (i.e. property is grayed), it will be bypassed.

- The following characters are used as word delimiters in match whole word finds. The word must be bracketed by one of these characters to qualify as a whole word: '#@,{=!<>|&!^+-*/%* - ()~[]$"'

Security

Security of an ePro configuration is designed to be as simple or as comprehensive as the developer desires. By default, anybody who has access to the PanelMate ePro unit may change pages to any page in the configuration and perform pushbutton and data entry control functions on those pages. Prior to V2.10 of ePro Canvas the only mechanism for securing the application from unwanted page or control access was through the Page Enabled Expression property and the Visibility Expression property of a page control. Both local and remote tags could be used in expression to prevent access to a page or to hide a critical control from the user. These methods are still supported but starting in V2.10 additional security functionality has been added to allow a more comprehensive approach to securing the ePro configuration.

There are many ways of implementing security in industrial control. The first level of security is physical access control. Traditional plant security, guards, gates, door locks, etc., may prevent unauthorized users entry to the machine or process area. A second level of security is at the PanelMate ePro itself. Locking cabinets and enclosures will prevent an unauthorized user from plugging in a keyboard or other device that would allow access to programs and operating system commands hidden from the touchscreen of the ePro. The third level of security is the ePro touchscreen and application and this is where ePro Canvas
tools can be used to prevent unwanted use. There are three security components that constitute the ePro Canvas security model, devices, users, and groups.

**Security Devices**

A password is considered a Security device, but security devices may also include hardware devices, such as keys, RFID cards, biometric thumb-drives, or any such device that connects through a USB, PCMCIA, or other connection to an ePro unit that has a corresponding ePro Runtime software driver. Security Devices are contained in a Security Device Library. A password device consists of two properties, Name and User Password. Passwords are case sensitive and may contain any combination of alpha characters, numbers, and the underscore character. There is a minimum password length of one character and no maximum length.

![Security Device Library Entry - Password 1](image)

**Security Groups**

Security groups define which pages may be accessed by a user who is logged on and a member of that group and if a group member may execute data entry control (pop-up entry pad or button pad control) on accessible pages. Security Groups are contained in a Security Group Library. Security groups have names and may have the All Pages Access property set to yes or no. If yes, then members of that security group have access to all pages and all control functions. If no, then the Page Permissions tab of the security group lists all pages that are accessible to group members and indicates whether or not control (data and button entry) on those pages is accessible to logged on users who are group members.
Getting Started

Secure Users
Secure Users are contained in Secure User Libraries. The Default User property of the library defines the secure user account that is automatically logged in when a configuration starts up and when a Security LogOff Action executes (as shown below). The Logged User property is an optional User Defined System Variable or PLC tag of string data type that the system will automatically update with the name of the user who is currently logged on.

A Secure User’s properties are:
• **Name** of the user. This is different than the name used for log on purposes so that it may be more descriptive for documentation purposes.

• **User Name** to be entered during a **Security LogOn** Action.

• **Device Expression** that determines which passwords or other security devices are evaluated during the **LogOn** process.

• **Logoff After (Minutes)** time, in minutes after log on, after which the user will be logged off of the ePro unit. An entry of zero minutes never times out.

• **LogOn Action** to be executed upon successful user logon is completed.

• **LogOff Action** to be executed upon user logoff (manual or automatic).

• **Security Group List Tab** of which the user is a member.

• **Notification Tab** to determine if the user’s logon and logoff activity will be recorded in the ePro Event Banner and the Windows Event Viewer. Choices are **Log Events** or **None**.

Secure users are assigned one or more security devices in the Device Expression property. The device expression lets you logically "and" or "or" security devices. For example a user’s device expression could be set to Password 1 || Password 2 (or), or Password 3 && Key1 (and), or simply PWordA. The Security Group List tab is used for assigning the user to one or more security groups.

**Security User and Security Group Automatic Actions**

Both Secure Users and Secure Groups have LogOn and LogOff Action properties. When a user or group member logs on and logs off, these actions (if defined) execute automatically. An automatic action may be a simple direct assignment action or may call any action or action list from the Action Library. This gives you ultimate flexibility in designing any method necessary for indicating security status. It also gives you the ability to show or hide individual page objects and control objects, through the visibility expression property, based on which user or which groups are currently logged on. For example, if you wanted to keep track of the logon status of each security group you could create User Defined System
tags of Boolean data type and have each group’s LogOn and LogOff Actions write ones and zeroes to their corresponding tag. The same could be done for each user.

**Runtime Security Functionality**

If a configuration has security, runtime behavior consists of the following:

- At runtime bootup, the Home page is called and the Default User is automatically logged on. For this reason the configuration’s Home Page must be accessible to the Default User account.
- Only one Secure User may be logged on at a time.
- When a user logs on or logs off an event may be written to the ePro Event Banner or the Windows Event Viewer based on the notification settings for each user.
- The active secure user’s access will be limited to those pages and controls that are defined by the security group or groups of which the user is a member. This is independent of whatever page change mechanism is employed, including a Page Change initiated through an assignment action from a PLC tag writing to the `CurrentPageID` system tag. If the user attempts to select an inaccessible page nothing will happen, the page will not change and no automatic system indication will be given as to why page access was denied. If the developer chooses to keep track of which user or which groups are currently active through the user or group automatic logon and logoff actions, they can choose to use standard indicator controls or visibility expressions to give runtime indication of security access status.
- All visible one-touch page controls (such as Rectangular Button, Button Bar, and Touch Area) are accessible on each page to which the user has access. This allows the user to change pages normally using various page change actions, and it also gives the developer flexibility to allow certain control actions and disallow other control actions on an accessible page.
- All data entry controls (two-touch controls such as Bar, Bar Template, Indicator, Indicator Template, Legend, Readout, Readout Template, Trend, and Trend Template) will only be accessible if the current user is a member of a group that has control access enabled for that page. If the user attempts to select an inaccessible control object nothing will happen, the pop-up control device will not display and no automatic system indication will be given as to why control access was denied.
- There are two ways a user can be logged off. The first method is by executing a Security LogOff action. The second method is when the current user’s automatic timeout period expires. When the current user logs off the Default User is automatically logged back on and if the current page is not accessible to the Default User, the system will automatically change pages back to the Home Page.

**Implementing Security on an ePro Configuration**

To create a configuration utilizing the built-in security features in ePro Canvas you need to go through the following steps:

2. Create a Security Device – Select the desired device library and right-click on the device or the Component Data pane and choose **New Password Device**. Give the password device a name and assign a password to the device. Repeat for all required password devices.
4. Create a Security Group - Select the desired group library and right-click on the group or the Component Data pane and choose **New Security Group Library Entry**. Give the group a name and choose Yes or No for the property **All Pages Access**. If you choose No, go to the Pages tab and add entries for each page to which you want to grant group member access and set the control property for each page to be Yes or No. Repeat for all required security groups.
5. Create a Security User Library - Right-click on the Security User Libraries icon in Project Explorer and select **New Secure User Library** and assign the library a Name.
6. Create a Secure User - Select the desired user library and right-click on the library or the Component Data pane and choose **New Secure User Library Entry**. Give the secure user entry a name (description), a user name (to be entered when logging on), and a device expression that chooses the password or other security device associated with that secure user. Repeat for all required secure users.

7. Assign a Default User – Select the Secure User Library’s properties and pick the Default User from the secure user entries of the library.

8. Assign the three security libraries to the configuration – If you want to implement the security features of ePro Canvas you must assign all three security libraries (User, Device, and Group) to a configuration. You can do this one of two ways. Either drag and drop each library onto the Configuration in the component data pane of Project Explorer or open the Configuration’s properties and add the three security libraries to the **Libraries** tab.

9. Configure LogOn and LogOff Actions – In the Action Library add two new Security Actions, one for log on and one for log off.

10. Configure rectangular button controls to one or more pages that are accessible to the Default User and assign your log on action to the button. Do the same for creating manual log off functions.

11. Optionally, configure User Defined System tags or client tags that will be used for tracking security activity, and create actions that will execute automatically on user or group logon and logoff events.

**ePro Canvas Tips and Best Practices**

**Preparation**

- Think how the application will work from operator and process perspective. What do you need to make available for the operator and how should it be grouped (design before you create)?

- When should pages be grouped visually by common elements of the process? When should pages be grouped visually by logical data grouping such as common PLC register ranges or meanings?

**Media Library**

- Are you going to use multi-language? If so, make sure all strings are entered and referenced in the media library so they can be translated later.

- You're native (or first) language should be neutral. By using this practice, if your language expression should evaluate to an unknown language, the application will default to the neutral language and will always show something to the operator.

- Note the media library doesn’t have to be used only in multi-language systems. Even if you are not using multi-language, if you find that you are using the same strings repeatedly in the application, consider creating it in the media library and referencing it. This can speed up application development and ensure application consistency.

- If you use images, consider putting them in the media library. This will embed them in your .ucf file, and ensure they are available in your runtime unit.

**Re-use**

- Look for common tasks/functions and use Libraries, Index Lists, and Master Pages to reduce application size and complexity as well as ensure consistency. Applying re-use when your application is initially created will not only save time during creation but will make it much easier to make modifications later since you will only need to change items once to apply them to many locations.

- Re-use is often discovered during the development process only after its first occurrence. Try to think about it up front but don’t be afraid to apply it later when you discover an area in your application that would benefit from it.
Master Pages

- Use Master Pages whenever possible to avoid duplication of common elements across pages. This saves memory and application development time as well as ensures consistency for the operator. Always try to have the same or similar actions located at the same location on pages. This can be easily accomplished using Master Pages. A classic example for use of Master Pages is for a navigation buttons (menus) for the operator as well as logos that need to be included on all pages.

Indexed Lists

- This feature is similar to indirect referencing, allowing controls to display different data based on an index into a list. Although this is a relatively advanced feature, when used properly it can be save memory and application development time. An example use would be in creating a page showing the status of a single PLC I/O card and allowing the operator to choose which card to look at by changing the index based on a user button selection.

Clients

- To minimize network bandwidth and maximize system performance, don’t make scan times any faster than they need to be.

Configuration

- Only add 1 reference per library type in your configuration.
- Select the configuration icon from the tree view to get a graphical overview of your current application content and status (note that unused libraries don’t appear.)

Unit

- On a send to unit, after the correct runtime and driver have been sent, uncheck them to minimize reload/restart time (only the .ucf will be transferred in successive transfers.)

Color Blinks

- Blink is performed by continuously redrawing the blinking image. The more blinking areas there are on a page, the more processor time is required for redrawing.
- To maximize application performance, remove blinking color entries from the color library if they are not actually being used in your application.

Pages

- For best performance, overlap dynamic elements sparingly and only when necessary. Also, avoid placing controls outside of the viewable area.
- Use component templates to standardize and simplify editing.

Actions

- Do not have a tag that triggers an action that also contains the tag as a destination of an assignment as a result of that action. This will cause an infinite loop, and make the runtime unit hang.

Transfer Issues
The following errors may appear during "Send to File" when downloading (FTP transfer) to an ePro PS Runtime unit.

**FTP: Restart Command Failed dwErrorCode = 0**

Reason/Symptom: Transfer was not complete, ePro PS does not reboot and does not receive an updated eProStart.cmd (ie: the line in this script file which runs OIEngine is REM’d out).

Solution: Problem is fixed in version 2.21 and newer, or load a recent version of ChAppScout.exe.

**FTP: Transfer Error 22**

Reason/Symptom: Transfer was aborted because the ePro rejected the put/send.

Solution: Find the reason why ePro disallowed transfer (eg, d: drive has insufficient space for the new file, file is in use, or file is write protected).

**FTP: Failed to copy file <c:\filename>. STOR command failed**

Reason/Symptom: Transfer was aborted because the ePro rejected storing the file.

Solution: Find the reason why ePro disallowed transfer (eg, KepServer is running as a service, the serverres.dll cannot overwrite the current file since it is in use).

**FTP: Failed to establish FTP connection with xxx.xxx.xxx.xxx**

Reason/Symptom: ePro PC cannot be reached.

Solution: Verify ePro PS is running, IP address matches, network connection is OK, and ePro is not busy (eg, rebooting or loading Runtime).

**Server configuration file <c:\filename>.files not found.**

Reason/Symptom: Filename.files does not exist on the development system. This file is created when filename.opf is opened in the KEPServer editor, and is required for the transfer.

Solution: Open filename.opf in KEPServer editor on the development PC, filename.files is automatically created.

**FTP: Server Failed to set Directory**

Reason/Symptom: May be a complication of another issue. ePro may not have correct file structure. Could be an old ePro unit, or FTP/DCOM configuration not correct or KEPServer not loaded.

Solution: Check directory structure and verify the directories exist for d:\cfg, c:\Program Files\Cutler-Hammer\ePro Software Suite\System, and c:\Program Files\KEPSErver_ePro (if not reload KEPServer).

**FTP: Cannot change dir to \**

Reason/Symptom: May be a complication of another issue. ePro may not have correct file structure. Could be an old ePro unit, or FTP/DCOM configuration not correct or KEPServer not loaded.

Solution: Check directory structure and verify the directories exist for d:\cfg, c:\Program Files\Cutler-Hammer\ePro Software Suite\System, and c:\Program Files\KEPSErver_ePro.

**Transferred to runcuf.bat**

**Transferred to runUCF.bat**

Reason/Symptom: Transfer appears complete, but ePro PS will not go into Runtime.
Solution: Unit’s destination Runtime must be set for ePro PS, not ePro ES.

**User Defined System Tags**

User defined tags may be added manually to the System Client tag file TagSystem. These tags will all have an initial value of zero and the data type may be specified or you can select the type to be “Interface Supplied” which will default to unsigned 32-bit integer. You can add a tag to the TagSystem by opening the tag file properties dialog and selecting the “Tags” tab, and then double clicking on the line labeled “Double click here to append a row”. The Name is user specified as long as it is unique in the tag file, and the Definition field should be identical to the Name. The default Data Type of Interface Supplied may be changed to any of the types shown below:

![User Tag Configuration Panel](image)

You can also add a tag by selecting the TagSystem library in the Project Components pane of Project Explorer, then right-click in the Component Data pane and select New Tag Library Entry.

User defined system tags will not change value at runtime unless the user configures a function that writes to those tags. They may be written to from a pushbutton or button bar function, from a data entry function, or from an Assignment Action. If the user configures a Conditional Passthru Assignment Action a user defined system tag can be updated from the PLC through an OPC Server client connection.

User defined system tags may be useful for a number of purposes. Their value can be toggled by a pushbutton to control conditional visibility of page objects, or a system tag may be used in place of a PLC...
register for storage of the configuration’s Active Language ID. A system tag may also be used as an index to one or more Indexed Lists. There are many more uses of user defined system tags and in general they can be used for local functions that will reduce the requirement of Operator Interface specific registers in the PLC. Note however that unlike PLC registers, system tags are not persisted values, which means that system tags will be set back to their default value of zero at each reboot of the ePro. This may limit some of the uses to which you would apply user defined system tags.

**Terminology**

- **Actions** - functions that are executed when a condition is true. Actions can change pages, log events, close the application, set variables, send data to a server, etc.

- **Action Libraries** - a way to store actions for reuse by any configuration in the project. Actions can be organized into multiple Action Libraries.

- **Analog** - refers to a device, control or expression that will have a range of values (for example, a readout’s value from a PLC or server). See Expressions, Analog for more details on Analog expressions.

- **Clients** - provides a communication connection to a device. During Runtime, the ePro unit acts as a client to access data from the configured device. The most typical ePro client connection is to an OPC server.

- **Color Libraries** - contain sets of colors, or color palettes for given configurations. The Color Libraries are a way to store palettes for reuse by any configuration in the project. Colors can be organized into multiple Color Libraries.

- **Components** - Project Components are used to build a project. They include Units, Clients, Configurations, Pages, and Libraries (Action, Color, Media, etc). Components can be created separately and in any order, and can be assigned to multiple configurations.

- **Configurations** - ties desired pages, actions, libraries, and other settings into a single application. Multiple configurations are allowed in the project and are stored in the Configurations Folder.

- **Control** - a visual tool that is placed on a page with other controls to allow an operator to monitor and control a process. Examples of controls are Readouts, Bar Graphs, Buttons, Graphics, Indicators, etc. These are arranged on a page to allow an operator to monitor and/or control a specific function from the unit. Controls can have static and/or dynamic properties.

- **Data Entry** - the ability to send data to a client connection, such as an OPC server. Examples include setting a setpoint or activating a pump.

- **Discrete** - a device, control or expression that will have one of two states (for example, ON/OFF or True/False).

- **Dynamic** - a control and/or property that changes online. A numeric readout or status indication are examples of controls with Dynamic properties.

- **List Property** - a type of property generally attached to controls that have multiple occurrences with several characteristics each. For example, an indicator control can contain multiple states (On, Off, ...) with many characteristics for each (On FG Color, Off FG Color, On BG Color, Off BG color, ...). List Properties appear in a table.

- **Media Libraries** - store multilingual text, images, and sounds. (Text = Text words, Text messages, Multi-language words; Images = BMP, JPG, WMF, EMF files; Sounds = WAV files). Media can be organized into multiple Media Libraries.

- **Page** - a type of component which contains Controls (readouts, indicators, bar graphs, buttons, etc.). The Page and its visual controls serve as an operator’s control panel.

- **Page Editor** - allows creation of configuration Pages to be viewed on the Runtime unit. This editor provides the Controls that can be arranged on the page, and all necessary tools to create/edit/modify the page and its controls.

- **Primitive, Base Control** - ways of referring to the fundamental controls (with no sub-controls) such as ellipses, lines, rectangles, arcs, etc. These provide the base in which all controls are built.
• **Project** - contains all of the components that you create. These components include Units, Clients, Configuration, Pages, Libraries. Typically a project consists of associated components (for example, components for the same customer applications).

• **Property** - all of the parameters or characteristics associated with a control. Properties can be static, such as Background Color, Pen Width, Font, Alignment. Or they can be dynamic, such as the numeric value to display, or the color or image to display for a given state.

• **Property Editor** - allows adjustment of properties (Background Color, Pen Width, Font, Alignment, Numeric Value, State Colors). All controls are edited with the Property Editor.

• **Re-usability** - The Canvas software is set up to encourage re-use. Components can be configured once and used many times. Libraries allow components to be created and stored so they can be used in many places of a project without re-configuring them each place they are to be used. By adding entries to a library, you can reference that entry anywhere that type of reference is used. Any control can simply reference the entry - saving repeated development. Additional time saving is noted when an entry is modified - the change will automatically be made everywhere it is used, simplifying the editing process. Effective re-use results in project consistency and time savings.

For example: If you are using a warning color on multiple pages or in multiple controls... Define a color with tag name Warning in the color library. Then configure the color property of the desired controls with 'Warning'. If the warning property needs to be changed from yellow to orange or flashing yellow/orange, it can be changed in all locations by simply changing the color in the color library.

• **Runtime Unit** - runs a Canvas configuration and allows an operator to monitor and/or control a process. Using pages and controls, it replaces the functions of traditional hard-wired operator devices such as pushbuttons, lamps and message displays.

• **Static** - refers to a control and/or property that does not change online. A non-changing title string and border rectangle are examples of Static controls.

• **Tag Libraries** - store tags. A tag is a reference to OPC server data or internal variables. Tags are created manually in ePro Canvas or by importing a "CSV" file. Tags can be organized into multiple Tag Libraries.

• **Units** - where all components required for Runtime are assembled. This unit data is transferred to a PanelMate ePro unit to run the application. Multiple Units can be created.

Learn more about the Project Explorer
Learn more about the Page Editor

**The Starting Window**

**The Starting Window - Project Explorer**

**Overview**

Below is the main ePro Canvas window used to manage a project. This is the main environment for creating project components and linking them together. Ultimately, the components to be used in Runtime are linked to a unit. A project can hold many project components, but only those assembled in the unit component are sent to the Runtime unit.

Whenever you start ePro Canvas or create a new project, ePro Canvas automatically creates the one component in each component folder, and links these components together for you. All you need to do is add page controls and a different connection if you need one.

**Tip:** Use Right-clicks to see a context menu (a list of options for the selected object). One of the options is usually Properties, which gives you access to settings and information.

**Tip:** Drag-and-Drop components where you want them, from pane to pane.

**Tip:** Many functions can be performed many different ways... the Menu bar, Tool bar, Right-clicking the mouse, or short cut keys.

**ePro Canvas window elements**
Click an area of the screen below or the text around the screen to learn more about it.

**Tip:** You can resize any of the windows in ePro Canvas with your mouse. Move the mouse cursor around the edges of the windows until one of these symbols appears; ⬅️, ➡️, ↑️, or ⬇️, then **left-click** and **hold** the mouse button. Drag the window to the desired size and release the left mouse button.

**Title Bar**

The Title bar is located along the top of a window and contains the following items:

- **Project Name** - Easily view the name of the current project. Project names can be changed at any time. Your saved project name is also displayed here. If you have not yet saved your project “Project” will be displayed.
- **Software Name** - ePro Canvas is the application creating the project.
**Menu Bar**

The Menu bar located under the title bar contains the **File**, **Edit**, **View** and **Help** menus. Each menu item displays a list of commands. Depending on the component selected (unit 1 in the example above) in the views below the menu bar, some commands will be highlighted and others grayed out. Only the highlighted commands can be executed on the selected item.

Placing the mouse cursor over any of the commands will display information in the status bar at the bottom of the screen.

**Tip:** To the right of the commands are keyboard short cut keys. *i.e. Ctrl+C = Copy*

---

**Toolbar**

The Toolbar located under the menu bar contains buttons that provide you with easy access to the most common project commands. Depending on the component selected (unit 1 in the example above) in the views below the tool bar, some commands will be highlighted and others grayed out. Only the highlighted commands can be executed on the selected item.

**Tip:** Placing the mouse cursor over any of the buttons will display information in the form of a flyover tip and information will also be displayed in the status bar at the bottom of the screen.

**Tip:** To display or hide the tool bar, select the **View** menu and select **Toolbar**.

---

**Component Bar**

The Component Bar provides you with the ability to easily add components to a project. Each component is sorted according to the topic under which it would fall, such as units, clients, configurations, pages, etc, and is represented by a specific icon. To show the components for a specific topic simply left click on that topic and its components will be displayed. Whenever a component is added to a project it will always be displayed in the Project Components pane.
Components can be added to the project by either double-clicking the component or by "drag-and-drop". Double-clicking the component will generate a new component in the project components view and possibly in the component data view depending on what is already displayed there.

Drag-and-drop functionality provides shortcut methods for performing common tasks.

**To drag and drop:**
1. Select (highlight) the item that you want to drag and drop. (To select an item, point and click on it.)
2. Press and hold the left mouse button while you drag the item to its destination.
3. Release the mouse button to drop the item in place.

When you use "drag-and-drop" it is easy to know where a component can be dropped by viewing the mouse pointer. Components can only be placed in the "white space" below the existing components of the project components view, or dropped on the corresponding topic. In the example above, the Unit from the Component Bar can be "drag-and-drop" to the white space below the Graphical Component in the project components view or it can be dropped on top of the Units folder in the project components view.

When you drag a component around in an area of the window in which the component cannot be dropped, the mouse pointer looks like this ☹. Continue moving the mouse until the pointer changes to an arrow ᴿ, which indicates the component is able to be dropped.

**Tip:** To display or hide the Component bar, select the View menu and select Component bar.

**Tip:** Change the Component bar icons from large to small by "right click" in the Component bar, select Small Icons

---

**Status Bar**
The Status bar is located at the bottom of the window and displays messages and information about the current status of the application.

The left side of the Status line will display specific information about each object as the mouse cursor is moved over them.

The right area of the status bar indicates when specific keyboard keys are latched down as shown below.

<table>
<thead>
<tr>
<th>Action Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAP</td>
<td>“CAP” is displayed on the right side of the status bar when the Caps Lock key is latched down.</td>
</tr>
<tr>
<td>NUM</td>
<td>“NUM” is displayed on the right side of the status bar when the Num Lock key is latched down.</td>
</tr>
<tr>
<td>SCRL</td>
<td>“SCRL” is displayed on the right side of the status bar when the Scroll Lock key is latched down.</td>
</tr>
</tbody>
</table>

**Tip:** To display or hide the status bar, select the **View** menu and select **Status**.

---

**Project Components**

**Project Components**

The Project Components pane is where components are stored and managed for your project. The folders within the Project Components pane are called component folders. *i.e.* Units Folder, Clients Folder, Configurations Folder, etc. These folders will help keep your components organized.

### Adding components

Components can only be added to a component folder of the same association, *i.e.* Units can only be added to the units folder, clients can only be added to the clients folder, etc. There are five ways to add components to the component folders.

- Select the project folder where the component will be added, using the **Menu** Bar drop down list, select **New** (may not work for all components).
- Select the project folder where the component will be added, using the **Toolbar**, select ![New](image) (may not work for all components).
- Select the project folder where the component will be added, press **Alt+N** or **Insert**
- Using the Component Bar.
- Select the project folder where the component will be added, **right-click**, select **New**.

### Deleting components

Select the component to be deleted then:
Using the **Menu Bar** drop down list, select **Delete**.

- From the **Toolbar**, select ✗.
- Press **Alt+D** or **Delete**.
- **Right-click**, select **Delete**.

### Renaming components

Select the component to be renamed then:

- Using the **Menu Bar** drop down list, select **Properties**, change the **Name** field.
- From the **Toolbar**, select ☑️, change the **Name** field, select **OK**.
- Press **Alt+R**, **Alt+Enter** or **F2**, change the **Name** field, select **OK**.
- **Right-click**, select **Properties**, change the **Name** field, select **OK**.
- **Double-click** on the component, change the **Name** field, select **OK**.

### Expanding / collapsing folders

- **Double-click** on a component folder or **left-click** the ☐️ sign next the component folder will expand to display any components added to that folder.
- Alternately, **double-click** on a the same component folder or **left-click** the ☑️ sign next the component folder will collapse the components to hide them from view.

#### Note: If a folder does not have a ☐️ or ☑️ symbol, there are no additional levels.
Component Data

The component data pane provides a graphical method to:

- View or edit components of a project folder
- View or edit the links between components

View or edit components of a project folder

Left click any of the project folders to display all the components of that folder in the component data pane. The figure below is a result of left clicking the pages component folder. Using the scroll bar at the bottom of the component data pane you will be able to scroll left or right to view additional properties of each of the components. For the following examples we will discuss pages since the figure below is displaying them. But the idea works with any of the components in any of the component folders.

**Note:** The Component Bar has been hidden for this example. Select the **View** menu and select **Component bar**.
Right-click any of the pages in either the component data or project components panes to display a menu of more options like cut, copy, paste, delete, properties, etc.

- Select **Cut** to remove the page and move it to the clipboard.
- Select **Copy** to create a copy of the page and move the copy to the clipboard.
- Select **Paste** to move the page from the clipboard and place it in the new position the you have selected. When using the paste function the component is only be allowed to be pasted into certain areas, you may need to experiment by moving the cursor to different areas of the screen, then right-click to see if the paste function is available. If the paste function is grayed-out try a different area.
  - Example 1 - Copy a page in the component data pane, move the cursor to the white space at the bottom of the same pane and you will be able to paste the copy of the page.
  - Example 2 - Copy a page in the component data pane, move the cursor to the pages folder in the project components pane and you will be able to paste the copy of the page.
  - Example 3 - Copy a page in the project component pane, move the cursor to the white space at the bottom of the components data pane and you will be able to paste the copy of the page.

- Select **Properties** to view or edit any of the properties unique for that component. Properties are discussed in greater detail in the help topics for each of the component folders.

Left-click and hold allows you to drag a copy of the page to where want to drop the copy. Move the cursor around the screen, as long as the cursor displays you may not the page, continue to move the cursor to the same places mentioned under Right-click above till the cursor displays 

- **Left-click** the **Name field** in the components data pane just above the pages, this will sort your pages in alphabetical order. **Left-click** to reverse the alphabetical order. **Left-click** any of the other field in the Components Data pane to sort based on that fields properties.

- **Place the cursor** on the line that splits the Name and description fields until the cursor displays . Left-click and hold, move the cursor left or right to expand or shrink any one of the fields.
When the field is the desired size release the mouse button. Any of the fields can be resized using this method.

Component Data 2

View or edit the links between components

To view, add, or edit links between components, left-click any component in one of these component folders:

- **Units** - Left-clicking a unit in the units folder displays all sub-components of the unit and its related links.
- **Clients** - Left-clicking a client in the clients folder displays all sub-components of the client and its related links.
- **Configurations** - Left-clicking a configuration in the configuration folder displays all sub-components of the configuration and its related links.

In the figure below, the unit defined as **Conveyor #1** is selected and the unit links are displayed in the component data pane area. This view displays the minimum components required to create a unit. As can be seen in the figure, clients and configurations are not defined by text and a red symbol. This means that these components are required to have a successful unit. As well, a server, displays text as not defined with a green symbol. This means that a server is not defined and is not required since it is green.
View or edit the links between components continued

When a configuration and a client are linked to unit-**Conveyor #1** you can see the results below. The client name, configuration name, and each of the pages linked to the configuration are displayed for easy viewing and editing.

Adding components

- **Right-click** any of the components to see what editing options can be performed on the different components.
- **Drag** components from the various component folders or component bar and drop in the component data pane to add the component. Keep in mind that a component must be dropped onto the Parent Component. If you drop a component on a similar component (i.e. drop a page onto another page) then, the dropped component will replace the original and the original will no longer be linked.
- **Open** the **property editor** of the Parent Component and add the component from the property editor.
- **Right-click** select **paste**. This can only be done if you have already copied the component to the clipboard.
- **Add multiple components** by displaying the components in the component data pane, **select** the first component you want to add, **press and hold** the shift key down on the keyboard, **select** the last component. All the components between the first and last component will be selected. Make sure the cursor is over the selected components, **right-click**, select **copy**. Display the Parent Component in the component data pane, **right-click** on the parent component, select **paste**. Instead of holding down the shift key, try holding down the **Ctrl key**, then when you left-click with the mouse you will be able to components that are not in consecutive order.
- **CTRL-Right Click** to open the pulldown **Component Builder** menu anywhere in the Canvas Pro editor.

Removing components

- **Right-click** the component and select **Remove Link**. **Note:** Do not select the delete key as it will delete the component from the entire project.
  - **Open** the **property editor** of the Parent Component and remove the component from the property editor.
Component Property Editor

Component Property Editor

All components have properties that are edited by displaying the component's property editor. To open a component's property editor, select the component then choose one of the following methods to open the property editor.

- From the Toolbar, select  
- Using the Menu Bar drop down list, select Properties.
- Press Alt+Enter or F2.
- Right-click, select Properties.
- Double-click on the component, it doesn't matter if the component is in the project components view or the component data pane.

Once the property editor is open you can modify any available properties for the selected component. All property editors will display the project name, component type, and component name in the title bar. The figure below displays a property editor for a configuration named Feature 2 that is a component of a project named project. Notice that a property editor may have more than one tab, in this figure there are six tabs: General, Pages, Libraries, Actions, Event Manager, and Event Banner. Left-click on any of the tabs to display the properties associated with that tab.

To modify any of the properties shown below, left-click on the field to the right of the property name will allow you to enter the data you want. For fields that have a button you can either enter the data manually by typing it into the field or you can left-click on the drop down list button and select from the list of choices that are displayed. You may not see any choices displayed if you select the drop down list. This will happen when none of drop down list components have been first created. i.e. In the example
below if you selected the drop down list for Home Page and nothing was displayed it would be because no pages exist in the pages folder. Double-clicking a field will highlight the contents of the field so they can be edited. Once highlighted you could delete the contents, overwrite them, or use the end or home keys to position the cursor to the front or end of the contents.

ePro Canvas provides the flexibility to create components in any order you would like. In this same example if a page did not display, you could enter a page name into the field anyway and then create that page at a later time. Keep in mind that the naming convention you use is case (upper and lower case) and space sensitive. The name typed in this field and the name given to the page will need to be identical and unique.

The box to the left side of the figure below displays the name of the component being edited. If this component had sub-components they would be displayed underneath the component. The sub-components can also be edited, select the sub-component and you notice the tabs will change to the specific properties for each of the sub-components selected.

![Project - Configurations - Feature 2](image_url)

**Component Property Editor, Lists**

The figure below displays the pages tab of the configuration named Feature 2. This example shows one way to add pages to a configuration. The first row already has a page assigned to it: Main Menu. To add another page you can **double-click** on the row (grayed out) underneath the first row, this will add another row so that another page can be added. You can continue the process for as many pages as you need.
Make sure you right-click on various places: the Name bar, the page bar, and on the rows themselves. Right-clicking on these areas will provide different options described below:

- **Left-click** on the Name bar to toggle between sorting the pages in ascending or descending order.
- **Right-click** the Name bar to select options of sort ascending, sort descending, find, or replace.
- **Right-click** on the Page bar to select options of find and replace.
- **Right-click** on any of the rows to select options of sort ascending, sort descending, find, replace, cut, copy, paste, insert before row, insert after row, insert rows, delete row, delete cell contents, default row contents, or default cell contents.

Since the figure above displays only a cell (of a row), selecting default row contents or default cell contents will perform the same action. If a selected a tab with multiple cells were displayed then selecting default row contents would return that entire row to its default state (usually blank). Selecting default cell contents would cause only the selected cell to return to its default condition (usually blank).

**Note:** When a column is smaller than the largest viewable text in that column, the text appears with "...." at the end.

**Component Property Editor, Groups**

Some tabs hold a lot of information. To organize how this information is displayed the properties may be placed into groupings. The figure below shows the banner group only has one property; font. The table grouping has 6 properties. Changing any of the properties of a group will only effect that particular group and will not effect any other group. Usually you will be able to see the change immediately. So experiment and look for the changes.
Using Categories

Since you can have as many components as you want in a project it may make sense to organize them by categories. By default all components are uncategorized. Categorized components will only display their categories in the component data pane, see the figure below. The pages in the figure below have been placed into three different categories; Common, Feature 1, and Feature 2. If you were to add pages to a configuration all you would need to do is select all the common pages and all of the pages from one of the feature categories to create a complete configuration.

To create a category, open the property editor of a component, select the **general tab**, select the **category** field. If the category has already been defined then you can select it by using the drop down list button. If the category has not been previously defined then just type in new the category name and it will become available for future use, select **OK**.

Category names are different for each project folder. A category for pages will not be available as a category for units. Although this would not prevent you from creating a category of the same name in the units directory.
Double-click on a category or left-click the ▲ sign next to the category will expand to display any components added to that folder.

Alternately, double-click on the same category or left-click the ▼ sign next to the category will collapse the components to hide them from view.

Using Components

First Time User Tutorial

Project Requirements

At minimum, these project components are required to create a Unit:

- A configuration with at least one page.
- A client OPC connection.

After assigning the configuration and client to the unit then:

- Check the unit for errors.
- Send the files to the unit.

Application Creation

Follow these steps to successfully create a unit.

Note: Creating a "Unit" means creating an application to run on a unit. It is referred to as a Unit because, for most flexibility, the ePro software combines the necessary Runtime parts in a Unit component. The Unit combines a Configuration (Pages and Libraries) and a Client (eg: PLC).
1. Set up the Kepware_ePro OPC server for the destination device. Create a KEPSWare configuration file (.opf) to send to the unit.

- Open the KEPServer_ePro software.
- Select the New icon in the KEPServer Toolbar.
- Click as directed to add a channel in the software; give the channel a name; and choose the “Allen-Bradley Ethernet” device driver. Leave the rest of the selections as default. (The final screen in configuring the channel will give you a summary of your choices.)
- Click as directed to add a device in the software. Give the device a name. Select “SLC 5/05 Open” for device model; and enter the proper IP address. Leave the rest of the options at defaults. (The final screen in configuring the device will give you a summary of your choices.)
- Save the configuration file on your PC and exit KepServer_ePro.

2. Create an OPC client for each device in the Kepware_ePro server to which you wish to communicate.

- Open ePro Canvas.
- Right click the Clients folder and create a new OPC Client Adapter. Give the client a name.
- Use the pull down arrow at the end of the Server Name field to choose EatonElectrical.KEPServer_ePro.
- In the Access Path field, use the pull down arrow to select Channel1.Device1 where “Channel1” is the name of the channel you configured in Step 1 and “Device1” is the name of the device you configured in Step 1.
- Click on the field labelled “Click here to import items”.
- Click “OK”

3. Create pages using the tags you created.

- Click the Page bar in the component bar pane and double click the ePro ES/PS Page icon.
- Name the Page.
- Click “OK” and then double click on the page in either the project components pane or the component data pane. This will open the OI Page Editor.
- Put a Readout Template on the page by either double clicking on its icon in the control bar pane or by clicking and dragging the icon from the control bar pane to the page view pane.
- Double click on the Readout Template and make the following changes:
  
  General tab:
  - In the Value field, enter ‘N7:0’.
  - Use the pull down arrow to change Operator Input Type to Data Entry.

  Data Entry tab:
  - In the Target Expression field, enter ‘N7:0=’ClientSystem,’.”
- Click “OK” on the Readout Template Properties window and save the page.
- Double click on the Rectangular Button and make the following changes:
  
  General tab:
  - In the Break Label field, enter “Exit”.
  - Use the pull down arrow to change the Break Action field to select the ActionExit action.
- Click “OK” on the Readout Template Properties window and save the page. Exit the OI Page Editor (not the Project Explorer!).
4. Create your configuration by linking pages to it.
   • Create a new Configuration and give it a name.
   • In the Home Page field on the General tab, use the pull down arrow to select the page you created as your home page.
   • Save these changes. (Click OK)

5. Create your unit by linking your clients and configuration to it.
   • Create a new Unit and give it a name.
   • On the General tab, Default Client Name field, use the pull down arrow to select the Client created in Step 2.
   • On the Destination tab, set the fields in Line 1 as follows:
     • Transfer .ucf – Yes if you wish to send the file to an ePro hardware unit.
     • .ucf Name – Click the Ellipsis button at the end of the field and use the dialog window to select the location and name of your .ucf file. (Must be done even if you’re not saving the file to your PC.)
     • Transfer Runtime – Yes (if you have not loaded the runtime to this ePro.) You will normally only need to download the runtime to your ePro ONE time. If you have already done this step, you may leave the option set to No.
     • Runtime – Use the Pull down arrow at the end of the field to select the correct runtime for your hardware unit. (Currently, there is only one choice.)
     • Transfer Driver(s) – Yes if you have not yet downloaded the correct driver to this ePro. This will send not only the KepWare driver, but the .opf file as well. You will normally only need to perform this step ONE time. If you have already performed this step, you may leave the option set to No.
     • Driver – Use the Pull down arrow at the end of the field to select the correct driver for your hardware unit. (Currently, there is only one choice.)
     • .opf Name – Use the Ellipsis button to select the .opf file that you wish to use on your hardware unit.

   NOTE: in order to Transfer Driver(s) to the ePro unit successfully, you will need to select the correct KEPWare configuration file (.opf) to send to the unit. The correct file must be stored on the machine that you are using to send the files to the ePro. Additionally, the .opf file must have been saved on your PC from within your KEPServer_ePro software. When a save from within that software is done, a secondary file is created that has an extension of “.wcefiles”. This secondary file and the .opf file must be in the same directory for the ePro’s Send to file… function to work properly.
     • Destination Path or IP Address – Enter either the IP Address of the ePro unit to which you will send the files, or the Drive Letter of the compact flash reader on your system.

   • On the Destination tab, set the fields in Line 2 as follows:
     • Transfer .ucf – Yes if you wish to save the file to a location on your PC.
     • .ucf Name – click the Ellipsis button at the end of the field and use the dialog window to select the location and name of your .ucf file.
     • Click OK when you have completed data entry on these fields.

   NOTE: If you are only saving the file to your PC, you only need to set the properties for Line 2.
   • Be sure that the Unit you created is highlighted.
   • Drag ClientSystem from the project components pane to the component data pane and drop it on the icon of your unit.
     • Repeat for all OPC Clients.
• Drag your configuration to the component data pane and drop it on the icon of your unit.
  • The page you created has already taken its place as a subordinate to your configuration.
• Drag the ActionSystem Action Library to the component data pane and drop it on the icon of your configuration.
• Drag the MediaSystem Media Library to the component data pane and drop it on the icon of your configuration.
• When all components have been moved to the component data pane, right click on the icon of your unit and select Check for errors...
• Click the Check button and the Canvas software will scan your Unit Configuration File (.ucf) for errors. If errors are found, scroll to the highlighted error(s) and double-click on the error to bring you to the dialog box necessary to correct the error. Fix error and repeat until all errors are gone.

6. Once the errors are corrected, use the send to unit function to send the unit (compiled application) to the PanelMate ePro unit.
• Right click on the icon of the unit you created and select Send to file...
• Click the Send button at the bottom of the window.
• Canvas will automatically perform a check for errors on the application and – as long as that passes – will perform all selected options in the Destinations tab.

See Transfer Issues for help troubleshooting errors.

Notice that the media and action libraries are not involved because they are not necessary to create a unit. While these simple steps will create a functional unit. You’ll want to make sure you take advantage of creating components for the libraries so that future units will be even easier to create.

Component Templates
Component Templates are project components that have been saved as templates for reuse within the project. Component Templates may be created by the developer to reduce development time and provide a consistent look or style to a configuration. Any project component can be saved as a template by right-clicking on the component and selecting Create Component Template and any single page component can be saved as a template by right-clicking on it and selecting Create Template as illustrated below.
When a component is saved as a template all configured properties of that component are saved. To create a new project component from a saved template right-click on the component group, i.e. Unit, Client, Configuration, Page, etc., and highlighting Create From Template, then choosing the desired template from the resulting list of Component Templates as illustrated below.
In the Page Editor you can use saved page components by clicking on the Component Template category in the controls bar. New components created from a component template will have all initial properties set to that of the saved template. This can speed up development by allowing the user to establish the default settings of new components added to the project rather than accepting the editor defaults and having to change each new components properties to match the desired standards of the developer. Because page controls can also be saved as Component Templates the developer can take standard Canvas controls and customize them once and then use the customized controls to reduce development time and create a consistent look and feel to the project’s pages.

Some Component Templates are included in the default Project Profile to speed up initial development. They are shown below:
Because Component Templates are saved with a project just like any other project components they will not automatically be added with a New blank project or New prepackaged project. However, like all other project components they may be copied from an existing project to a new project by opening both projects in separate windows and using copy and paste, or drag and drop, to copy between the two projects.

Changing the Default Prepackaged Project

**Changing the Default Prepackaged Project**

The default prepackaged project that is created when the ePro Canvas editor is started from the start menu and which is also created when choosing New prepackaged project from the File menu or from the Project’s toolbar icon , is an XML file named ProjectProfileCanvasPro.xml (for the ePro Canvas Professional Editor) and ProjectProfileCanvas.xml (for the ePro Canvas Editor). That file is located in the Configuration directory of the ePro Canvas installation directory (default location is C:\Program Files\Cutler-Hammer\ePro Software Suite\Configuration).

If you want to change the prepackaged project to include components and Component Templates that you have created or customized, simply export the desired project as an XML file, name it the same as the default prepackaged project XML file, and place it in the ePro Canvas installation’s Configuration directory. You can export a project as an XML file with the File>Export selection from the ePro Canvas Project Explorer editor as shown below.
Licensing

Canvas Editor Licensing

The Version 2.XX install for the ePro Software Suite gives the user two selections, ePro Canvas and ePro Canvas Professional.

Note: Site licenses and Global licenses are also available.

ePro Canvas

The license activation dialog is generated by a utility that can be called from the Start menu or from the "Help > Registration ..." selection in the software. The license registration code is in the form of "ES-XXXXX". Go to the Eaton Electrical website and register or call/FAX Tech Support with the registration information and registration code. Tech Support will verify that the user supplies all required information, plus a valid serial number and that the serial number is for the correct version and that the serial number hasn't already been used for license activation.

ePro Canvas Professional

The license activation dialog is generated by a utility that can be called from the Start menu or from the "Help > Registration ..." selection in the software. The license registration code is in the form of "PRO-XXXXX". Go to the Eaton Electrical website and register or call/FAX Tech Support with the registration information and registration code. Tech Support will verify that the user supplies all required information, plus a valid serial number and that the serial number is for the correct version and that the serial number hasn't already been used for license activation.

After installation of ePro Canvas Professional, the software will behave exactly like ePro Canvas until the product is activated. This means that the registration reminder window will pop up at the launch of the software and all Professional features will be disabled until the registration is completed successfully.
Runtime Unit Licensing

Demo Mode

The ePro Canvas Professional Version 2.0 includes installation of the Runtime software on the development PC. This allows the user to run "Demo Mode" on the development PC for testing of the runtime application and KEPServer_ePro (also in "Demo Mode"). Demo Mode for the runtime software will behave as follows:

1. When the runtime application (.UCF file) is launched, a dialog box will appear as it loads indicating that it is in Demo Mode and the software will stop running after 60 minutes. The "OK" button closes the dialog box. The dialog box will reappear every 15 minutes indicating the amount of time left for demo mode and again the "OK" button will close the dialog box.

2. If the user closes the runtime application or if the demo period times out and the user re-launches the runtime application, it will start in the same manner and the demo timer will be reset to 60 minutes.

3. If the 60-minute time runs out before the user closes the application, the application will stop updating and a dialog box will open indicating that the demo period has expired. When the user clicks the "OK" button of the dialog box the box will disappear and the application will close.

Activation

The Canvas Pro Runtime software may also be activated similarly to ePro Canvas and ePro Canvas Professional licensing. The same registration utility (used for all license activations when run from the Start menu) allows the user to register Canvas Pro runtime. If the user supplies the required information and valid serial number for Canvas Pro runtime then tech support will return an activation code that will allow the user to run in full runtime mode on the PC with no timeout counter.

Additional Feature Runtime Licensing

Recipes and DataArchive Features

The ePro PS license manager is loaded on each ePro PS machine. The runtime license for Recipe Management and the Data Archive functionality, are optional components which must be purchased in order to use these features on an ePro PS unit. The Registration process is identical to that of registering ePro Canvas or ePro Canvas Professional software. First, the ePro License utility must be started on the ePro PS unit from the start menu. Using Recipes for an example, the ePro Recipes line must be selected from the Software Registration dialog as shown below. If the Recipe Management feature is already licensed it will show a state of "Registered-License Active", and the Activation key will show the key that was generated during the activation process. If unlicensed then only the Registration code field will show. To register and receive an Activation Key, follow the directions shown in the Software Registration dialog box. Be sure to have the serial number of the purchased Recipe Management license handy because that will be a required field in the online form. Once you receive the Activation Key following the online registration you may enter that key and click on the Apply Activation Key button. Once you have applied the activation key a dialog box will appear to indicate that the registration process was successful. If there was an error in entering the Activation Key you will be prompted to recheck the value and enter the key correctly.
Once successful, OK the success dialog box, exit the Software Registration utility and perform a Protect Mode Save on the ePro PS to ensure that the registration is made permanent on the ePro unit.

Alternately, you may initiate the activation process before receiving the Activation Key by selecting the ePro Recipes line in the Software Registration dialog and hitting the Initiate License Activation key. Then exit the dialog box and run the Protect Mode Save function. This will give you a 10 day grace period during which you may run the Recipe Management features in full functional mode. Once you receive the Activation Key you will then need to re-open the ePro License utility to complete the activation process by entering the Activation Key and performing a Protect Mode Save function.

Eaton Electrical Support Services

The goal of Eaton Electrical is to ensure your greatest possible satisfaction with the operation of our products. We are dedicated to providing fast, friendly and accurate assistance. That is why we offer you so many ways to get the support you need. Whether it’s by phone, fax or email, you can access Eaton Electrical support information 24 hours a day, seven days a week. Our wide range of services are listed below.

You should contact your local distributor for product pricing, availability, ordering, expediting and repairs.

Website Address  www.eatonelectrical.com

Use the Eaton Electrical website to find product information. You can also find information on local distributors or Cutler-Hammer sales offices.

e-COM Support Center  VOICE: 800-356-1243 (8AM-6PM EST)  FAX: 800-752-8602  AFTER-HOURS EMERGENCY: 800-543-7038 (6PM-8AM EST)
Call the e-COM Support Center if you need assistance with placing an order, stock availability or proof of shipment, expediting an existing order, emergency shipments, product price information, returns other than warranty returns, and information on local distributors or sales offices.

<table>
<thead>
<tr>
<th>e-TRC Technical Resource Center (support for OI, PLC &amp; IPC)</th>
<th>VOICE:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- 800-809-2772, selection 5 (8AM-5PM EST)</td>
</tr>
<tr>
<td></td>
<td>- 414-449-7100, selection 5 (8AM-5PM EST)</td>
</tr>
<tr>
<td></td>
<td>FAX: 614-882-0417</td>
</tr>
<tr>
<td></td>
<td>EMAIL: <a href="mailto:CHATechSupport@eaton.com">CHATechSupport@eaton.com</a></td>
</tr>
<tr>
<td></td>
<td>AFTER-HOURS EMERGENCY (PLANT DOWN ONLY):</td>
</tr>
<tr>
<td></td>
<td>- 800-809-2772, selection 5 (5PM-8AM EST)</td>
</tr>
<tr>
<td></td>
<td>- 414-449-7100, selection 5 (5PM-8AM EST)</td>
</tr>
</tbody>
</table>

If you are in the US or Canada, and have OI/PLC/IPC questions, you can take advantage of our toll-free line for technical assistance with hardware and software product selection, system design and installation, and system debugging and diagnostics. Technical support engineers are available for calls during regular business hours.

<table>
<thead>
<tr>
<th>European PanelMate Support Center</th>
<th>VOICE: +41 1 806 64 44 (9AM-5PM CET)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMAIL: <a href="mailto:CHSupport@bfa.ch">CHSupport@bfa.ch</a></td>
<td></td>
</tr>
</tbody>
</table>

This center, located in Zurich, Switzerland, provides high-level quality support and product repair services for your PanelMate products. You will receive real-time technical and application support.

<table>
<thead>
<tr>
<th>Repair and Upgrade Service (support for OI &amp; IPC)</th>
<th>VOICE:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- 800-809-2772, selection 5, 4 (8AM-5PM EST)</td>
</tr>
<tr>
<td></td>
<td>- 414-449-7100, selection 5, 4 (8AM-5PM EST)</td>
</tr>
<tr>
<td></td>
<td>FAX: 614-882-3414</td>
</tr>
<tr>
<td></td>
<td>EMAIL: <a href="mailto:RepairCHA@eaton.com">RepairCHA@eaton.com</a></td>
</tr>
</tbody>
</table>

If you have questions regarding the repair or upgrade of an OI/IPC, contact your local distributor. Additional support is also available from our well-equipped Repair and Upgrade Service department.

**Product Comparisons**

**ePro Canvas Professional vs. ePro Canvas Components**

The following list describes the additional features that are only available in the ePro Canvas Professional development software.

1. Ethernet Transfer to PanelMate ePro PS
2. DVT vision system support (Client Adapter)
3. Cognex vision system support (Client Adapter)
4. Arc Control
5. PanelMate Power Pro Template support
   - Bar and Variable Size Bar
   - Indicator and Variable Size Indicator
   - Display and Variable Size Display
   - Readout and Variable Size Readout
   - Bar Trend and Line Trend
   - Table
   - Variable Size Graphic
   - Variable Size Control Button
6. PanelMate Power Pro .pps file import
7. Action List
8. Start Action
9. Recipes (Runtime requires catalog # 76RM)
10. Data Archiving (Runtime requires catalog # 76DA)
11. Email Action
12. Sound Action
13. PanelMate ES/PS Runtime demo mode on PC
14. Required registration for license activation

**ePro PS vs. ePro ES Components**

The following list describes the features that are supported by the PanelMate ePro PS and are not supported by the ePro ES.

1. DVT vision system support
2. Cognex vision system support
3. Arc Control
4. Support for screen resolutions greater than 320x240
5. Alphanumeric Entry – QWERTY pop-up
6. Alphanumeric Entry – cell phone keypad pop-up
7. .jpg, .wmf and .emf images
8. PanelMate Power Pro Template support
   - Bar and Variable Size Bar
   - Indicator and Variable Size Indicator
   - Display and Variable Size Display
   - Readout and Variable Size Readout
   - Bar Trend and Line Trend
   - Table
   - Variable Size Graphic
   - Variable Size Control Button
9. Action List
10. Start Action
11. Recipes (Runtime requires catalog # 76RM)
12. Data Archiving (Runtime requires catalog # 76DA)
13. Email Action
14. Sound Action
15. Document Viewer (.htm, .pdf, .txt files)
16. Advanced Event Banner functions such as color control of alarm state and alarm criticality, filtering functions, and navigation functions
17. Support for imported PanelMate Power Pro .pps files

When developing displays for the PanelMate ePro ES the use of Color Libraries and Media Libraries should be kept to a minimum in order to maintain reasonable responsiveness. Also, due to the lower resolution of the PanelMate ePro ES 6” display, the amount of data displayed in the Event Viewer should be kept to a minimum in order to keep the display meaningful and useful.
Project Components

Projects

A project is where you store and manage all of the components that you create. Project components are contained in any of the following component folders.

- Units
- Clients
- Configurations
- Pages
- Libraries

These are part of the project. Examples of project components which have similar associations include the following.

- The same customer's units
- All the presses in a press room
- An entire line in an assembly plant
- Facility Management
- All waste water pump stations

A project's name appears as the name of top folder in the project components view and also appears in the title bar of the software.

Importing a PanelMate PowerPro (.pps) configuration

Creating a new project

A new project is created every time ePro Canvas is started. Other ways to create a new project are:

- **File** menu, select **New**
- **Left-click** the New icon in the toolbar
- **Use the short cut keys** Ctrl+N

When a new project is created it's default name is Project. It can be renamed later. The project's saved name will change to untitled, and will appear in the title bar.

Naming a project

You can change the name of a project at any time, to do this;

- From the **Toolbar**, select 
- Using the **Menu** Bar drop down list, select **Properties**.
- **Double-click** the project name change the **Name** field, press OK.
- **Right-click** on the project name, select **properties**, change the **Name** field, press OK.
- **Select** the project name, press Alt+Enter or press F2, change the **Name** field, press OK.
Saving a project

Saving a project is just like saving a file from any other windows program. Save projects by:

- **File** menu, select **Save** or **Save As** (to change its current name)
- **Left-click** the **Save** icon in the toolbar
- Use the short cut keys **Ctrl+S** (save) or **Ctrl+A** (save as)

The project will be saved with the extension .chp. When a project is saved all of its current settings (window size, icon size, views) are saved as well.

Opening a project

To open an existing project (.chp file), choose one of the three methods below.

- **File** menu, select **Open**, navigate to the drive/folder where the .chp file is located.
- **Left-click** the **Open** icon in the toolbar
- Use the short cut keys **Ctrl+O**

**Tip:** The last ten opened projects are listed at the bottom of the File menu for quick access.

Sharing components from multiple projects

ePro Canvas can edit one project at a time. If there is a need to share components between projects, start a second ePro Canvas program. Move components between the two projects using Cut, Copy, and Paste.

Search and Replace

See Search and Replace

Units

To add, delete, or rename units visit Project Components.

Creating a unit and linking components to it is the only way to send the components you create to a device like a PanelMate ePro product. Once the Minimum Required Components are linked to a unit, the unit can be checked for errors, and then sent to the destination unit.

Alarm and Event Runtime Settings and Example

Unit properties

General tab

- **Name** property - When naming your unit, use a name that represents either the machine that the unit will go on or geographic area where the unit will be placed will help you organize your units by using meaningful names. Provide a unique name for your unit.
- **Description** property - Add a meaningful note about the unit.
- **Type** property - Select the type of hardware platform that the unit will send its file to. Select either:
  - **ePro ES Family** - If you are sending the unit to a PanelMate ePro ES hardware platform.
- **ePro PS Family** - If you are sending the unit to a PanelMate ePro PS hardware platform.
- **DataBroker Family** - Not currently available.
- **Configuration Name** property - This is where a configuration is linked to a unit. You can either type the name of the configuration or select it using the drop down list. If the configuration doesn't exist yet, you can still enter the name of the configuration and add the configuration to configurations folder later, but make sure the names are identical.
- **Default Connection Name** property - Using a default connection name will make programming easier by not having to address a PLC name and register when the unit is connected to multiple PLCs. If you have multiple PLCs on your network, you will need to provide a PLC address and a register address in order to read or write data with the PLC. If you specify a default Connection name for the one device that you will communicate the most with then you only need to provide a register or tag reference to read or write data with the PLC because ePro Canvas will automatically place the default connection name in front of any register address it sees. When only one PLC is being communicated to, by setting the PLC as the default connection you would only need to read and write register or tag information with the PLC.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

### Clients tab

This is where a client connection is linked to a unit. You can either type the name of the client or select it using the drop down list. If the client doesn't exist yet, you can still enter the name of the client and add the client to the clients folder later, but make sure the names are identical.

Learn more about editing rows

### Destinations tab

You must establish how your unit files (ucf, opf, fonts, or executive) will be sent to a unit or units. Each row of this tab represents a single ePro hardware unit. Add more rows to send the same files to more units. There are several ways you can send files to units. You can send files to your ePro hardware platforms by sending the files over ethernet or by sending them to a compact flash drive, then placing the compact flash in the ePro unit.

- **Destination** column - This column is for reference only can not be edited.
- **Transfer .UCF** property - Select Yes or No. Yes will send the files. No will not send the files. Use this selection when you are sending files to multiple units and want some of the units to receive the files but others not to.
- **.UCF name** property - This field is required. Create the name of the UCF file here.
- **Transfer Runtime** property - Select Yes or No. The runtime could also be called the executive. Choose yes If you need to upgrade the runtime on your unit. Selecting no will not send the runtime files to the unit when the send to unit is executed.

**Note:** If you are using your ePro hardware unit for the first time you should select yes to make sure a proper updated runtime is installed.

- **Runtime** property - This field is required if "Transfer Runtime" is set to YES. Use the drop down list button to select the runtime for the selected ePro ES or PS unit.
- **Transfer driver(s)** property - Select Yes or No. Select yes to send the driver files. Select no will not send the driver files to the unit when the send to file is executed. If you are changing drivers, have updated the one that is already installed on the unit, or setting up the unit for the first time you will need to select yes. If you have not made any changes to the driver but have updated something else then you can select no since the driver will not need to be transferred.
- **Driver** property - If you selected yes for transfer driver then you will need to select the driver here. Select KEPServer_ePro for the units processor type.
• **.opf name** property - If you selected yes for transfer driver then you will need to select the .opf file name here. When using the KEPServer_ePro OPC server anytime you save your work it will be saved as an .opf file. Use the ellipsis button to select the .opf file that will be transferred to the unit.

Note: When an .opf was selected you will need to make sure that an associated file is in the same directory. When you save an .opf file, KEPServer_ePro will also save an associated file of the same file name but with the extension .wcefiles. If you have not moved the .opf file after KEPServer_ePro saved it then there is no need to do anything. If you have moved the .opf file you should either also move the .wcefiles file to the same directory, or use KEPServer_ePro to save the .opf to the new directory which will also automatically save the .wcefiles.

• **Destination Path or IP address** property - If your unit is connected to an Ethernet network you can enter the unit’s IP address in the form of xxx.xxx.xxx.xxx and all of the necessary files will be sent to over the network to the unit.

  • For ePro ES Units - When using Ethernet transfer, make sure the compact flash card is installed in the unit before sending to unit. If the unit is not on a network you can send all of the required files to a compact flash card attached to your computer. Once the file are loaded onto the compact flash, place the compact flash into your ePro unit and it will run as if you loaded the files over a network. To send the files to a compact flash enter the destination path of the compact flash. i.e. x:\ in the field. Where x is the drive letter assigned to the compact flash by your computer. Make sure you deleted all files on the compact flash before you do this so there is enough room for the new files.

**Event manager tab**

This event manager performs the exact same function as setting up the event manager tab of a configuration except using this tab allows you to override the configurations event manager. You would probably want to do this when you have used the configuration in multiple units and each of those units must use the event manager the way it was set up in the configuration. Now, you may want to use the same configuration in a new unit but do not want the unit to use the event manager settings of the configuration. By using the override selection of this tab, this new unit will be able to create new event manager settings without affecting the configurations event manager settings.

See event manager properties

**Event banner tab**

This event banner performs the exact same function as setting up the event banner tab of a configuration except using this tab allows you to override the configurations event banner. You would probably want to do this when you have used the configuration in multiple units and each of those units must use the event banner the way it was set up in the configuration. Now, you may want to use the same configuration in a new unit but do not want the unit to use the event banner settings of the configuration. By using the override selection of this tab, this new unit will be able to create new event banner settings without affecting the configurations event banner settings.

See event banner properties

**Fonts to transfer tab**

Fonts used in the configuration are automatically sent to the hardware unit (unless it is a default font already on the unit). ePro Canvas places all the transferred fonts on this tab. This is for information only - the list should not be altered.

**Notes:**

Fonts consume memory on the hardware unit, which means less room to run a configuration... so use fonts wisely and sparingly.
If the **font on the Runtime unit is different** from the configuration: It is possible that the font was transferred to the unit, however there was not enough memory to load it, so a default font was used instead. Change the font in the configuration to match one already used.

When transferring a new configuration to a Runtime unit - all existing fonts are deleted from the unit before the new ones are transferred.

**Check for errors**

Check for errors is for when you are ready to test you work. Check for errors will test a unit and all of it’s links for any errors with out sending the files to a unit. This way you can work out any errors before sending the files to a unit. When you **right-click** on a unit, one option that will appear in the menu is **Check for errors**... Selecting check for errors... will display a window similar the one below.

Pressing the check button will start the check for errors process. Check for errors will go through the unit item by item and display the results of item being on a separate row in the right hand pane. If no errors are found the last row of the right hand pane will display the (0) errors message.

In the example, check for errors has found a missing reference. There is (1) Error, but 2 red messages are displayed since there are 2 locations in which the problem can be fixed. The missing reference could be missing because the wrong connection was defined in the unit, or the wrong value was placed in the control on the page. Double-clicking on the red error message will call the corresponding property dialog box to correct the problem, as shown below. In this case the wrong client, PLC2, was given before the tag. The client can be corrected and check for errors can be run again.
Note: Check for Errors is also done at the beginning of a Send to File as described in the next section.

**Send to file**

When you **right-click** on a unit, one option that will appear in the menu is **Send to file**... Selecting send to file... will display a window similar the one below.

Selecting the Send button will first perform a check for errors. Then if no errors were found, send to file will proceed to send the selected files (from the destinations tab) to their selected destinations (also from the destinations tab). Send to file will start with the top row of the destinations tab and perform the selected options for that specific row. When those files are sent, send to file will proceed to the next row and perform those selected option. This will continue until all of the rows have been processed. If an error occurs while processing a row. The current row and any rows below the current row will not be processed. Any rows that were processed prior to the error are not affected since the files have already been sent.

An error may occur if you selected to send the files via ethernet and did not provide a valid IP address for the hardware unit. Or the ethernet cable was not attached, etc.

After the send button is pressed, the right hand pane of the example below will display the status of the check for errors and the send to file status of each row of the destination tab. Looking at the example below, the right hand pane displays a status line for each item checked, then the result indicates any Errors. In this example, the send to file simply saved the file to the desktop. If the files are selected to be sent to the unit, there will be a continuation with status of the of the transfer activity. During check for errors and transferring the files, both the send and the Done button will be grayed out meaning they cannot be used at the moment. When they become usable again (not grayed out) the operation is complete. Press the done button to close the window or launch button to test the ucf file on the development PC. If there was an error during the transfer process an error message directing your attention the problem would be displayed.
Note: during the send to file, a Cancel button appears at the bottom of the window. The operation can be cancelled until the files start transferring to a Runtime unit. This is to ensure consistency of files on the Runtime unit.

Firewall Friendly option

If files cannot be transferred due to a firewall block, there is an option in the Canvas Tools Menu/Dialog to use a firewall friendly method when a Send To File is performed.
Firewall Friendly changes the operation of the transfer so that all data connections are originated by Canvas. (This is required with some firewall software. Firewall software will often restrict incoming connections to a corporate computer, but will allow outgoing connections. By default, FTP clients contact the server to establish a "control" connection and the server calls the client back to establish the "data" connection. By selecting Firewall Friendly, the ftp client will originate both connections.)

Clients

To add, delete, or rename clients visit Project Components.

This is where you create client connections for your project. PanelMate ePro products are OPC clients and require a link to an OPC server in order to be able to send and receive data between PanelMate ePro and the device its connected to. The client connection allows you to set up the required fields the server will need in order to properly communicate. The required properties are listed below and an identical field will also need to be set up in the OPC server. This is how the client and server know how to send and receive data with each other. The required properties are:

- Server Name
- Access Path
- Tag Name (you don't truly need a tag, you can provide a direct register address instead)

While this section details the link to the OPC server, you will need to set up the server separately by starting the OPC server and configuring the access path and tags. When configuring the OPC server the terms for the server may be different as in this example:

<table>
<thead>
<tr>
<th>Client Term</th>
<th>Server Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>Server Name</td>
</tr>
<tr>
<td>Access Path</td>
<td>Channel.Device</td>
</tr>
<tr>
<td>Tag Name</td>
<td>Tag Name</td>
</tr>
</tbody>
</table>

You can create as many client connections to the same OPC server as the server will allow.

OPC client adapter component properties

General tab

- **Name** property - Provide a unique name for your client. ePro Canvas will not allow you to have duplicate names. Names are case sensitive so the name "EthernetIP" and "ethernetIP" are two different names and ePro Canvas would accept them. Some suggestions are:
  - DH485 on Comm 1
  - DF1 on Comm 2
  - EthernetIP
  - SNP on Comm 3

- **Server Name** property - Select the name of the OPC server that you will be using in your project. If the server was installed on your PC when ePro Canvas was installed you will be able to use the drop down list button to select your server. Currently the only OPC server supported is KEPServer_ePro OPC/DDE Server.
Project Components

- **Access Path** property - An access path is a name that you define to help organize data inside the server. Each access path is set up inside the server software and could organized as all recipe data, alarm data, or broken into parts of machinery. You can have as many different access paths as you need to organize your project.

**See example**

The table below displays the how multiple access path can be set up for the same server.

Assume a server name is KEPServer_ePro. We will set up five access paths for five different PLCs we want to send and receive data with. In the table below we will only show one tag name for each access path but you can have as many tags as you want. Notice that under the server the channel and device are set up separately, but under the client set up the channel and device are combined to form a single text string in the access path. While the channel and device are combined in the access path they are still are separated by a . between them. When setting up the OPC server, the channel and device are set up separately. The channel usually defines the network you will be using while the device defines the type of device (typically a PLC) and device address.

<table>
<thead>
<tr>
<th>Client Set Up</th>
<th>Server Set Up</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server Name</strong></td>
<td><strong>Access Path</strong></td>
</tr>
<tr>
<td>KEPServer_ePro</td>
<td>EthernetIP.PLC1</td>
</tr>
<tr>
<td>KEPServer_ePro</td>
<td>EthernetIP.PLC2</td>
</tr>
<tr>
<td>KEPServer_ePro</td>
<td>EthernetIP.PLC3</td>
</tr>
<tr>
<td>KEPServer_ePro</td>
<td>EthernetIP.PLC4</td>
</tr>
<tr>
<td>KEPServer_ePro</td>
<td>EthernetIP.PLC5</td>
</tr>
</tbody>
</table>

- **Import From Server** property - By clicking this property value area, the tags for the configured Server are obtained and populate the client tree. See OPC Tag Import below.

- **Remove Imported Tags** property - This will remove the tags previously imported from the given Access Path. Tags should be removed before importing.

- **Tag Library Name** property - This property is optional. If you would like to use a tag library, you can use the drop down list button to select your tag library if it was previously installed. If the tag library has not been installed you can still enter a tag library name and enter the tag library later but make sure the names are identical.

- **Category** - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**Scans tab**

You can set a client for two different scan time modes. Continuous scans tell the runtime how often (in milliseconds) to scan conditional actions which are scanned continuously regardless of what page the unit is currently displayed. Page scan is separate from a continuous scan in that it is the scan time (in milliseconds) to update to controls of the currently displayed page.

- **Continuous Scan (ms)** property - Set the time you want the runtime to continuously scan the conditional actions. A setting lower than 250ms may result in poor system performance.

- **Page Scan (ms)** property - Set the time you want the runtime to update the controls on the currently displayed page. A setting lower than 250ms may result in poor system performance.

**Items tab**

This tab includes Item Number and Item Name headings. The items are blank unless "Import From Server" from the General Tab is used, which results in populating the items with imported tags.
**ConnectionSystem adapter component properties**

The ConnectionSystem client adapter is how your configuration will use the system functions like pop-up numeric keypad. If your configuration will be using the numeric keypad you must link this client to your unit.

**General tab**

- **Name** property - Provide a unique name for your client. ePro Canvas will not allow you to have duplicate names. Names are case sensitive so the name "System" and "system" are two different names and ePro Canvas would accept them.

- **Tag Library Name** property - This property is optional. If you would like to use a tag library, you can use the drop down list button to select your tag library if it was previously installed. If the tag library has not been installed you can still enter a tag library name and enter the tag library later but make sure the names are identical.

- **Category** - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**OPC Tag Import**

A simple way of accessing OPC server data is to read the OPC data directly from the server, then later browse for tags as needed.

**Import Tags**

In the OPC Client properties dialog box, the Import From Server property provides a live connection to the OPC server allowing direct tag import from the configured server. All tags from the server are obtained and automatically added to the client connection. This is initiated in the Client Properties dialog box as follows.

- Enter Server Name
- Enter Access Path
• Click the Import from Server property

When importing from an OPC server, all Tag Group Levels are imported. This is also referred to as a Deep Import since all sublevels will be obtained (for instance Channel.Device.SubgroupLevel1.SubgroupLevel2.Item).

Note: _hints can be eliminated from imported client tags by editing Tools/Options in KEPServer_ePro and disabling the property as shown below, then importing the tags.

![Options Dialog Box]

Use/Browse Tags

Once the tags are imported, they are added to the client tree, and can be browsed under the configured client adapter. In properties which use tags, a pull down list allows "drilling down" through the list of clients and tags. Thus, tag libraries are not necessary.

Vision Interface Clients

• Cognex Client
• DVT Client

Note: Changing a client adapter’s name will automatically change the name of the client everywhere it is used in the project. This makes it easy to update all your units that might be using the client adapter. Any units where you do not want this change to happen will need to be edited manually.

Configurations

To add, delete, or rename configurations visit Project Components.

This is where you add pages, libraries, actions, and events to your configuration. To create a valid configuration, you must have at least one page linked to your the configuration.
**Configuration properties**

**General tab**

- **Name** property - When naming your configuration, use a name that represents the machine that the configuration will go on, geographic area where the unit will be placed will help you organize your configuration by using meaningful names. Provide a unique name for your configuration.

- **Description** property - Add a meaningful note about the configuration.

- **Home Page** property - This is the page that is displayed every time the unit starts. You can either type the name of the page or select it using the drop down list. If the page doesn't exist yet, you can still enter the name of the page and add the page in the pages folder later, but make sure the names are identical. Adding a home page will also add the page to the pages tab. You should not use any visibility expressions on the page selected as a home page.

- **Active Language Expression** property - Used for multi-language configurations, blank otherwise. This property is used if you want the unit to determine which language should be switched to during runtime. All country languages have numeric values assigned them by the operating system, see the help files that came with the operating system you have for more information about operating system languages. If an expression is used for this property, whatever value the expression equate to will change the language setting to its numeric equivalent. i.e. If the expression equals 009 (decimal), then the active language would be English. If the expression equals 012 (decimal), then the active language would be French. If left blank then neutral (000 decimal)is assumed. Neutral can be used as a constant when using multi-language. More about this topic can be found under the media library help.

- **Category** property - Create a new category by typing the a new category name or use the drop down list button to select one already defined.

**Pages tab**

This is where pages are linked to a unit. You can either type the name of the page or select it using the drop down list. If the page doesn't exist yet, you can still enter the name of the page and add the page to pages folder later, but make sure the names are identical. There are no limits to the number of pages that can be added to a configuration.

Learn more about editing rows

**Libraries tab**

If you created and used libraries in the making of pages then you will need to link those libraries to the configuration so that the configuration link the page controls to the libraries used. If you used libraries in the creation of a page and do not link the library to the configuration you will receive an error when you check for errors. To link a library, first select the drop down list button under the type column heading to select the type of library to link. Then you can either type the name of the library or select it using the drop down list. If the library doesn't exist yet, you can still enter the name of the library and add the library later, but make sure the names are identical.

Learn more about editing rows

**Actions tab**

- Linking actions under the action tab is different then linking action libraries under the libraries tab. When placing an action under the action tab you are linking an action to the configuration which has no visual attributes. Let's say you wanted to record an event every time the unit was started. First you would create the event using the event action, then you would link the action to the configuration here. Since this action is not tied to any page controls i.e. Buttons, graphs, etc. it must be added here. These actions will be continuously scanned so it is important to add an expression that will allow the action to perform when you want it to perform but not any other time.

- You can either type the name of the action or select it using the drop down list and drill down through the action libraries until you get to the desired action. If the action doesn't exist yet, you
can still enter the name of the action and add the action to action libraries later, but make sure the names are identical. There are no limits to the number of actions that can be added to a configuration.

Learn more about editing rows

Event manager tab

Event banner tab

Document Viewer

Document Viewer Content

Note: Changing a configuration's name will automatically change the name of the configuration everywhere it is used in the project. This makes it easy to update all your units that might be using the configuration. Any units where you do not want this change to happen will need to be edited manually.

Pages

To add, delete, or rename pages visit Project Components.

Create and edit pages in the pages folder. Once you have added a page to the folder you can open the page editor to place controls on the page.

If any pages have controls placed on them you will be able to edit, add, or delete any of these controls without opening the page editor by double-clicking on the control while it is in the component data view.

Example

In the figure below page 1 is highlighted displaying the controls on the page. Assume the rectangular button has been configured as a goto main menu button and that we want the button on all of the pages. Right-click the rectangular button, select copy, then right-click each of the pages in the pages folder, right-click and select paste. The rectangular button will be copied to each of the pages that you selected. You could have copied multiple controls and performed the same operation.

The Page Editor

Page component properties

When the property editor opens, the window on the left will display a tree view of any controls that are on the page. The controls can be edited by drilling down to the one you want to edit. When the selected control is highlighted it properties will be displayed on the right side. Select which property you want to edit and proceed.

With the page selected you will be able to edit the properties below.
### General tab

- **Name** property - Provide a unique name for your unit.
- **Description** property - Add a meaningful note about the unit.
- **Standard Navigation** property - Not available on PanelMate ePro ES models.
- **Page Enabled Expression** property - This is an expression that allows you to select when this page is visible or not. Any expression that evaluates to a 1 or true will allow the page to be visible. The default value is 1. You can create any expression to perform any function you need. *i.e.* create a visibility expression to make the page visible only when in maintenance mode. When a page is set as a home page, visibility expressions should not be used.
- **Screen Size** property - Use the drop down list button to select the screen resolution for the page you created. This can be changes at any time and it can also be changed while using the page editor.
- **Background Color** property - Use the ellipses to select an existing color or create a custom color.
- **Watermark** property - Choose an image to be a background image. The easiest way is to have the desired image in the image library then you would be able to select it by drilling down into the image library. You also can type the file name and path directly into the field. If you use this method make sure you place " before and after" the text.
- **Display** property - This property will only have any effect if you have chosen to use a watermark. User the drop down list button to choose stretch or tile.
  - **Tile** - will repeat the watermark image both horizontally and vertically across the screen.
  - **Stretch** - will stretch the watermark image horizontally and vertically to fit the screen size.
- **Intensity** property - This property will only have any effect if you have chosen to use a watermark. User the drop down list button to choose the desired background intensity level of light, normal, or dark.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

### Master Page

**Page editor reference libraries tab**

Page editor reference libraries property - Set up these libraries in the same manner as you would under the configurations - libraries tab. The difference is that by placing libraries here you will be able to debug certain controls from within the page editor. Link the libraries that you will use to create the page you are working on. More is discussed under the page editor help. Linking a library here will not automatically link the library to a configuration, you will need to link them in the configuration.

**Note:** Changing a page’s name will automatically change the name of the page everywhere it is used in the project. This makes it easy to update all your units that might be using the page. Any units where you do not want this change to happen will need to be edited manually.

### Libraries

### Tags
To add, delete, or rename tag libraries visit Project Components.
A tag is a way of assigning specific address within the destination device with a name that represents the function of the address. It is usually easier to program by using names than it is using direct addresses. ePro Canvas allows you to use either tag names or direct addressing.

Local variables can be created for use within the configuration, using User Defined System Tags.

**Tag library properties**

**General tab**

- **Name** property - Provide a unique name for your library.
- **Description** property - Add a meaningful note about the library.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**Tags tab**

- **Name** property - Enter the name of the tag which must be unique.
- **Definition** property - Enter the definition of the tag here. Usually this is the register address you want the tag name assigned to. i.e. N7:0 or 401025, etc.
- **Data Type** property - Use the drop down list button to select the type data that will be received from the address.
  - **Interface Supplied** - type used when you imported a tag file. Some devices, when they create a csv file provide the data type. If you are using Kepware OPC server to create the csv file that you will import it does provide the interface type automatically.
  - **Logical** - provides a true/false condition to the project. False if the value is zero (0), true if the value is non-zero
  - **Signed 8 Bit** - valid range is -128 to 127 (decimal)
  - **Signed 16 Bit** - valid range is -32,768 to 32,767 (decimal)
  - **Signed 32 Bit** - valid range is -2,147,483,648 to 2,147,483,647 (decimal)
  - **Unsigned 8 Bit** - valid range is 0 to 255 (decimal)
  - **Unsigned 16 Bit** - valid range is 0 to 65,535 (decimal)
  - **Unsigned 32 Bit** - valid range is 0 to 4,294,967,295 (decimal)
  - **Floating Point 32 Bit** - valid range is $\pm 10^{-44.85}$ to $10^{38.53}$ (decimal)

Learn more about editing rows

**Importing tags**

ePro Canvas will import .CSV (comma separated variable) files to receive tags that might have been created for the destination device. Most destination devices can usually export their tags in a csv format. Once tags are in a csv format ePro Canvas can import them by:

- **File** menu, select **Import**, select **Tag Library**. This will create a new tag library each time you do this.

  You will see a window similar to the one displayed in the figure below. Use the to find your csv file, then select **Open**. The window will populate to look something like the figure below.

  Using the drop down list button under the **Tag Name Column**, select the which column holds the tag names. In the figure below it is column 1.
Then, using the drop down list button under the **Reference Column**, select the which column holds the device address. In the figure below is column 2. If the csv file was generated by an OPC server then this column can also point to the tag name since the OPC server already has a tag name and reference definition completed inside the OPC server. In this case you would only need the tag name to communicate to the OPC server because the OPC server will translate the tag into a reference designation.

Next you must select which row to start importing tags. In the figure below there is a check mark indicated on the first row of the bottom pane. This check mark indicates ePro Canvas will start importing with the first row. However the first row is only a title row. The check mark must be moved to the second row to properly import the tags and not the title row. Move the check mark by selecting the second row with your mouse.

Select **Import**, the tags will be imported and the newly created tag library will be displayed. All of the imported tags will display in the left window, At this point you can name the library or view or edit any of the tags by highlighting them and editing their properties. When finished, select **OK**.

Create or add tags

You do not need to import tags to have them available for you projects, you can create them when ever you need.

- **Open** the tag library property editor of the library which you want to add a tag to or create a new tag library.

- Select **tags tab**, **double-click** on the gray bar to add a line, Insert the tag name in the Name column, insert the definition of the tag in the Definition (address reference) column, and select the data type from the drop down list in the Data Type column. Repeat this process to keep adding tags.

Learn more about editing rows

Deleting tags

- **Open** the tag library property editor of the library which you want to delete a tag.

- Select **tags tab**, **right-click** on any field (name, definition, or data type) of the row you want to delete. Select **Delete Row(s)** to delete the tag.
Copy tags from one library to another

The tags that are displayed in the components data pane are from the tag library named Common Tags. Four of the tags are highlighted and have been dragged over the New Tags library. When the tags are dropped a copy of the highlighted tags will be placed in the New Tags library.

- Select the library containing the source tags so the tags are displayed in the components data pane.
- Highlight the tags you want to copy (see selecting multiple components), with the cursor over one of the highlighted tags, left-click and hold the mouse, move the cursor over the destination tag library in the project components pane, release the button, the tags will be added.

Note: Changing a tag library name will automatically change the name of the tag library everywhere it is used in the project. This makes it easy to update all your units that might be using the tag library. Any units where you do not want this change to happen will need to be edited manually.

Media Library

Media Libraries

To add, delete, or rename a media library visit Project Components.

Media libraries are where text, images, and sounds are stored so they can be used in many places of a project without retyping them in places they are to be used. Media libraries are not required to successfully create a unit. But if you find yourself typing the same text more than once, you'll want to use a media library. By storing media in these libraries you will be able to reference any of the media you place here by a tag that you create to represent a specific media entry. Any control can simply reference
the tag to insert the desired media saving you from entering the same media in multiple places. If you edit any of the media entries, the change will be accepted wherever the tag has been used simplifying any editing process. Only one media library can be linked to a unit.

To reference a media library entry by ID, visit Referencing Media Library by ID Number.

Adding media entries

Once a library has been created, media entries can be added in two ways.

- **Right-click** on the library where the new entry will be added, select **New**, click on the type of medium to add.
- **Open** the library property editor for the library where the new entry will be added, **select** the tab of the medium type to add, add rows if required to make room for the medium. Follow the instructions below for adding the various media types.

Media library properties

The Media Library properties are displayed below.

**General tab**

- **Name** property - Provide a unique name for your library.
- **Description** property - Add a meaningful note about the library.
- **Active Language** property - Select which language will be displayed when editing entries in the Text, Image, or Sounds tabs. If you are not using multi-language in your projects use neutral. For more detail see the multi-language help topic.
- **Add or Remove Language** - Click to add or remove a language. This selection tops the following window.

![AddRemove Language](image)

- **Auto Add Language Enabled** - Add media library entries for languages as determined by the Auto Language Tab settings.

  **Note:** When Auto Add Language Enable is set to Yes, all existing Media Library entries will be scanned and entries will be added as needed for the appropriate languages. In addition, all new entries will have corresponding entries added.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.
Project Components

Text tab

- **Entry** Column - This column is for reference only and cannot be edited.

- **Name** column property - This is where you assign a tag name to the text string. The tag name is then inserted into any control field that accepts media. The text string will be displayed when the control is running. Using a tag will allow you to make changes to the text string in a single place without having to edit every control that would reference the text string.

- **Language** column property - By default, this column will display the language that was selected on the general tab. Set the language to the desired language if it has not been done already. If not using multi-language then neutral should be used. Text for the selected language can be entered into the text column. After you have entered the text for the desired language, you can change to a different language and add new text for the new language setting.

- **Text** column property - This is where you enter the text string that will be displayed in the desired controls. All text must start with " (double tick) and end with ". Surrounding the text by these marks informs the runtime system that the information should be handled as ASCII characters. Text strings can be as long as you desire. Make sure the any controls that use the text must be able to accommodate the length and font size of the text. If the control can’t accommodate the amount of text, during runtime the control will display where you expect the text to be displayed.

Image tab

- **Entry** Column - This column is for reference only and cannot be edited.

- **Name** column property - This is where you assign a tag name to an image file. The tag name is then inserted into any control field that accepts media. The image will be displayed when the control is running. Using a tag will allow you to change the image file in a single place without having to edit every control that would reference the image.

- **Language** column property - By default, this column will display the language that was selected on the general tab. Set the language to the desired language if it has not been done already. If not using multi-language then neutral should be used. An image file for the selected language can be entered into the image column. After you have entered the image file for the desired language, you can change to a different language and add new image file for the new language setting.

- **Path** column property - Type in the path and file name of the image to be displayed for the selected language. Or press the to select the file by standard operating system navigation.

Sound media

- **Entry** Column - This column is for reference only and cannot be edited.

- **Name** column property - This is where you assign a tag name to a sound file. The tag name is then inserted into any control field that accepts media. The sound will be played when the control is running. Using a tag will allow you to change the sound file in a single place without having to edit every control that would reference the sound.

- **Language** column property - By default, this column will display the language that was selected on the general tab. Set the language to the desired language if it has not been done already. If not using multi-language then neutral should be used. A sound file for the selected language can be entered into the sound column. After you have entered the sound file for the desired language, you can change to a different language and add new sound file for the new language setting.

- **Path** column property - Type in the path and file name of the sound to be played for the selected language. Or press the to select the file by standard operating system navigation.

Auto Language
When a Media Library entry is created, a placeholder can be made for any number of languages. These settings are pre-determined in the Media Library properties Auto Language tab. As shown below, each type of media library entry (Text, Image, Sound) can be set to automatically create an entry in any language. As in the example below, when a text entry is created, there will be an additional entry created for French and German, however, there will not be image or sound entries created for those languages.

![Project - Media Library - Media Library 1](image)

Note: When the appropriate language are selected as above, the **Auto Add Language Enable** must be set to Yes to enable the entries to be created.

**Media Entry Properties...**

**General tab**

When any **media entry** below the library name is highlighted in the left side box the following properties are displayed:

- **Name** property - Will display the name of the media entry selected. You can modify the name by providing a unique name for the media entry.
- **Active Language** property- Indicates the active language which was selected from the general tab when the media library name is highlighted. This field can be modified when the media library name is highlighted in the left side box.
- **Active Language Entry** property- Displays the current media entry assigned to the selected active language.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**Language List tab (if the media is text)**

- **Entry** Column - This column is for reference only can not be edited.
**Language** column property - This column will display the different languages that have been used in the current media library. The current active language may not be displayed if there have not been any entries for the active language.

**Text** column property - This column will display all text entries for each of the languages used in the library.

**Language List tab (if the media is an image)**

- **Entry** Column - This column is for reference only and cannot be edited.
- **Language** column property - This column will display the different languages that have been used in the current media library. The current active language may not be displayed if there have not been any entries for the active language.
- **Image Path** column property - This column will display all image files for each of the languages used in the library.

**Language List media (if the media is a sound)**

- **Entry** Column - This column is for reference only and cannot be edited.
- **Language** column property - This column will display the different languages that have been used in the current media library. The current active language may not be displayed if there have not been any entries for the active language.
- **Sound Path** column property - This column will display all sound files for each of the languages used in the library.

**Using neutral language**

If you are not or do not plan to use multi-language then you should default to entering all your media (text, images, and sound) on the neutral language setting. If you develop your non multi-language projects using the neutral language, then your media will not change even if the language selection is changed.

If you plan on creating multi-language projects you can use the neutral language setting to act as a constant for media. If you have a media that is the same in more than one language you can enter the media into the neutral language and leave blank the media columns for the languages that are the same. For any media tag name there is an order in how the media will be displayed. During runtime, if there is media entered for the current language, then that media will be displayed. If media does not exist, then, if there is media entered into the neutral language for the same tag name, then that media will be displayed. If media for neutral language does not exist then nothing will be displayed.

**Creating a Multi-Language Project**

**Creating a Multi-Language Project**

Switching between different languages is performed by placing the a numeric value in a storage location specified by you, or by using an expression that you create. The unit will switch to a different language if the value in the specified location or the expression matches one of the language values listed in the language table below.

**Language table**

<table>
<thead>
<tr>
<th>LANGUAGE</th>
<th>LANGUAGE VALUE (Decimal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFRIKAANS</td>
<td>54</td>
</tr>
<tr>
<td>Language</td>
<td>Code</td>
</tr>
<tr>
<td>--------------</td>
<td>------</td>
</tr>
<tr>
<td>ALBANIAN</td>
<td>28</td>
</tr>
<tr>
<td>ARABIC</td>
<td>01</td>
</tr>
<tr>
<td>ARMENIAN</td>
<td>43</td>
</tr>
<tr>
<td>ASSAMESE</td>
<td>77</td>
</tr>
<tr>
<td>AZERI</td>
<td>44</td>
</tr>
<tr>
<td>BASQUE</td>
<td>45</td>
</tr>
<tr>
<td>BELARUSIAN</td>
<td>35</td>
</tr>
<tr>
<td>BENGALI</td>
<td>69</td>
</tr>
<tr>
<td>BULGARIAN</td>
<td>02</td>
</tr>
<tr>
<td>CATALAN</td>
<td>03</td>
</tr>
<tr>
<td>CHINESE</td>
<td>04</td>
</tr>
<tr>
<td>CROATIAN</td>
<td>26</td>
</tr>
<tr>
<td>CZECH</td>
<td>05</td>
</tr>
<tr>
<td>DANISH</td>
<td>06</td>
</tr>
<tr>
<td>DIVEHI</td>
<td>101</td>
</tr>
<tr>
<td>DUTCH</td>
<td>19</td>
</tr>
<tr>
<td>ENGLISH</td>
<td>09</td>
</tr>
<tr>
<td>ESTONIAN</td>
<td>37</td>
</tr>
<tr>
<td>FAEROESE</td>
<td>56</td>
</tr>
<tr>
<td>Farsi</td>
<td>41</td>
</tr>
<tr>
<td>FINNISH</td>
<td>11</td>
</tr>
<tr>
<td>FRENCH</td>
<td>12</td>
</tr>
<tr>
<td>GALICIAN</td>
<td>86</td>
</tr>
<tr>
<td>GEORGIAN</td>
<td>55</td>
</tr>
<tr>
<td>GERMAN</td>
<td>07</td>
</tr>
<tr>
<td>GREEK</td>
<td>08</td>
</tr>
<tr>
<td>GUJARATI</td>
<td>71</td>
</tr>
<tr>
<td>HEBREW</td>
<td>13</td>
</tr>
<tr>
<td>HINDI</td>
<td>57</td>
</tr>
<tr>
<td>HUNGARIAN</td>
<td>14</td>
</tr>
<tr>
<td>ICELANDIC</td>
<td>15</td>
</tr>
<tr>
<td>INDONESIAN</td>
<td>33</td>
</tr>
<tr>
<td>ITALIAN</td>
<td>16</td>
</tr>
<tr>
<td>JAPANESE</td>
<td>17</td>
</tr>
<tr>
<td>KANNADA</td>
<td>75</td>
</tr>
<tr>
<td>KASHMIRI</td>
<td>96</td>
</tr>
<tr>
<td>KAZAK</td>
<td>63</td>
</tr>
<tr>
<td>Language</td>
<td>Code</td>
</tr>
<tr>
<td>--------------</td>
<td>------</td>
</tr>
<tr>
<td>KONKANI</td>
<td>87</td>
</tr>
<tr>
<td>KOREAN</td>
<td>18</td>
</tr>
<tr>
<td>KYRGYZ</td>
<td>64</td>
</tr>
<tr>
<td>LATVIAN</td>
<td>38</td>
</tr>
<tr>
<td>LITHUANIAN</td>
<td>39</td>
</tr>
<tr>
<td>MACEDONIAN</td>
<td>47</td>
</tr>
<tr>
<td>MALAY</td>
<td>62</td>
</tr>
<tr>
<td>MALAYALAM</td>
<td>76</td>
</tr>
<tr>
<td>MANIPURI</td>
<td>88</td>
</tr>
<tr>
<td>MARATHI</td>
<td>78</td>
</tr>
<tr>
<td>MONGOLIAN</td>
<td>80</td>
</tr>
<tr>
<td>NEPALI</td>
<td>97</td>
</tr>
<tr>
<td>NEUTRAL</td>
<td>00</td>
</tr>
<tr>
<td>NORWEGIAN</td>
<td>20</td>
</tr>
<tr>
<td>ORiya</td>
<td>72</td>
</tr>
<tr>
<td>POLISH</td>
<td>21</td>
</tr>
<tr>
<td>PORTUGUESE</td>
<td>22</td>
</tr>
<tr>
<td>PUNJABI</td>
<td>70</td>
</tr>
<tr>
<td>ROMANIAN</td>
<td>24</td>
</tr>
<tr>
<td>RUSSIAN</td>
<td>25</td>
</tr>
<tr>
<td>SANSKRIT</td>
<td>79</td>
</tr>
<tr>
<td>SERBIAN</td>
<td>26</td>
</tr>
<tr>
<td>SINDHI</td>
<td>89</td>
</tr>
<tr>
<td>SLOVAK</td>
<td>27</td>
</tr>
<tr>
<td>SLOVENIAN</td>
<td>36</td>
</tr>
<tr>
<td>SPANISH</td>
<td>10</td>
</tr>
<tr>
<td>SWAHILI</td>
<td>65</td>
</tr>
<tr>
<td>SWEDISH</td>
<td>29</td>
</tr>
<tr>
<td>SYRIAC</td>
<td>90</td>
</tr>
<tr>
<td>TAMIL</td>
<td>73</td>
</tr>
<tr>
<td>TATAR</td>
<td>68</td>
</tr>
<tr>
<td>TELUGU</td>
<td>74</td>
</tr>
<tr>
<td>THAI</td>
<td>30</td>
</tr>
<tr>
<td>TURKISH</td>
<td>31</td>
</tr>
<tr>
<td>UKRAINIAN</td>
<td>34</td>
</tr>
<tr>
<td>URDU</td>
<td>32</td>
</tr>
<tr>
<td>UZBEK</td>
<td>67</td>
</tr>
</tbody>
</table>
Multi-Language Example

The following steps describe the multi-language set up. These steps are only one example of how this can be accomplished.

Set up media library
Set up the library for each of the different language that will be used.

Create a tag to store the language value
The storage location of your choice, any device that has registers, *i.e.* PLC, Drive, etc.

Set up the Active Language Expression
The active language expression is found on the general tab of the configuration. This field is must be filled in if you intend on using Multi-language. Place the tag (from above) in this field. Use the drop down button to select the tag.

You’re done
The only thing left to do is determine how you will change the languages. You can change them manually by pressing buttons on the runtime screen. Or you can have the destination device change language using criteria set up on that device. Below are examples of notes about each method.

Changing Language manually
- Create an action assignment for each language. The assignment should place the language value in the tag. *i.e.* ‘Tag’ = 9 (9 is English language). Use the numeric value that corresponds to the language you want to change to.
- Place a button for each language on a screen. Label each button accordingly for the languages. Insert the appropriate action into one of the action filed of the button.

Let the destination device change language
- Using the logic of the destination device, place into the tag the numeric value that corresponds to the language you want to change to.

Referencing Media Library by ID Number

The Id Number of a media library entry can be used to reference that entry in a text field in the ePro Canvas editor. For example if the Id Number of a media library text entry was set to 47 as shown below:
And a text control was placed on a page with the id number expression attribute set to:
‘clientname,tagname’
Where clientname represents the name of the OPC client adapter (PLC) and tagname is a tag or address in that client. When the value of tagname is equal to 47 then the contents of that media library entry will be displayed online. The text property box would look like the following:

**Color Libraries**

Color libraries allow colors to be created and stored so they can be used in many places of a project without re-configuring them each place they are to be used.

*Note: Color libraries are not required to successfully create a unit or configuration. However, if you find yourself using a special color more than once, you’ll want to use a color library.*
By adding color entries to the library (with a tag name), you can reference that color anywhere a color reference is used. Any control can simply reference the color's tag to insert the color - saving you from remembering the exact color in multiple places. If you edit any of the color entries, the change will be made everywhere the tag is used, simplifying the editing process.

For example: If you are using a warning color on multiple pages or in multiple controls... Define a color with tag name Warning in the color library, then configure the color property of the desired controls with 'Warning'. If the warning property needs to be changed from yellow to orange or flashing yellow/orange, it can be changed in all locations by simply changing the color in the color library.

**Adding color entries**

To add, delete, or rename a color library visit Project Components.

Once a library has been created, color entries can be added by **Right-clicking** on the library, then select **New Color Library Entry**.

**Color library entry properties**

Color properties are displayed and defined as follows.

**General tab**

- **Name** - Tag name to be used in component’s color properties
- **Blink** - No = color is solid; Yes = color will blink as defined on Blink States tab
- **Static Color** - Assigned color when No blink is assigned
- **Blink Rate** - How fast each color on the Blink States list appears
  - **Slow** - 2 seconds each, ie: 4 blink states has an 8 second cycle
  - **Medium** - 1 second each, ie: 4 blink states has a 4 second cycle
  - **Fast** - 1/2 second each, ie: 4 blink states has a 2 second cycle
- **Category** - How the colors are arranged

**Blink States tab**
• State - number assigned to the color, not used elsewhere

• Blink Color - Up to 16 colors can be defined, each takes up a time slice of the overall color. In the window above, the color library entry, Warning, is a single color which blinks yellow, orange, red, orange as indicated by the colors above (state 1, 2, 3, 4). If the Blink Rate was set at Slow, each state would appear for 2 seconds, and the overall color (Warning) would repeat its cycle every 8 seconds.

Action Libraries

System Actions

Several Actions are automatically provided to handle tasks such as changing pages. The following System Actions can be accessed by assigning them to buttons.

":ActionEventBanner:" - call the Alarm and Event window.
":ActionExit:" - Exit Runtime and return to Windows operating system.
":ActionGetPage:" - Call a different page by name or using a menu with listed pages. Destination Page = ":ViewPageNames:".
":ActionHomePage:" - Go to Home page. Destination Page = ":HomePage:".
":ActionPageDown:" - Go down to next page in the list. The list is the same order as the menu shown in ActionGetPage. Destination Page = ":PageDown:".
":ActionPageUp:" - Go up to next page in the list. The list is the same order as the menu shown in ActionGetPage. Destination Page = ":PageUp:".
":ActionPreviousPage:" - Return to the last page that was called. Destination Page = ":LastPage:".

Action Library

To add, delete, or rename a action library visit Project Components.

Actions allow you to expand the abilities of your unit by incorporating special features called actions. Actions will perform functions like:

- Change pages
- Send data to another destination
- Exit the unit's runtime
- Log events/alarms
- View events/alarm log
- View, acknowledge events and alarms
- Adding system security
- Start application programs
- View documents: pdf files, html pages, web pages, etc.
- Add multiple actions together to simplify tasks

To define and add action library entries to an action library, create an action library, right-click the action library and select New, select the desired action.

Actions can be executed two ways:

- **Unconditional** (Visual actions)
Unconditional actions will execute when ever they are called. They can be called by placing them in make or break action fields (General tab) a buttons or touch areas. Actions can also be called by all other controls, but they would need to have their Operator Input Type (General tab of the control) set to Button. actions can then be inserted into the buttons tabs.

- **Conditional** (Non-visual actions)

Conditional actions use expressions to govern when they execute. The action will execute when the expression equates to a true condition. Conditional actions do not need to be placed in controls since they know when they will execute. Instead these actions are placed in the actions tab of the configuration property editor. These actions are continually monitored by the runtime and execute the action when it's expression equates to true. Unconditional actions should not be used here since they will execute indefinitely.

**Note: the table below explains when actions are started, based on the property settings**

<table>
<thead>
<tr>
<th>Trigger Type</th>
<th>Trigger Expression</th>
<th>Trigger Expression (Activated by Trigger Expression)</th>
<th>Trigger Expression (Activated when Action executed, i.e: by button)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditional</td>
<td>1</td>
<td>Action is executed ONCE at Runtime initialization</td>
<td>Action NOT started - to start the Action at Runtime, add it to the Configuration Properties/Actions tab</td>
</tr>
<tr>
<td>Conditional</td>
<td>'tag'</td>
<td>Action is executed ONCE when 'tag' is TRUE, 'tag' must be set to FALSE then TRUE to execute again</td>
<td>Action NOT started - to start the Action with a 'tag', add it to the Configuration Properties/Actions tab</td>
</tr>
<tr>
<td>Unconditional</td>
<td>N/A</td>
<td>Action NOT started - to start the Action at Runtime, use Conditional and Expression of 1, to start by button do not add it to Configuration Properties/Actions tab</td>
<td>Action executed when button executes action</td>
</tr>
</tbody>
</table>

**Action library property editor**

**General tab**

- Name property - Provide a unique name for your library.
- Description property - Add a meaningful note about the library.
- Category property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**Action List**

An action list is where you can combine multiple actions into a single action. i.e. You want to execute an assignment action to set a new recipe and at the same time you want to write an event to the event log to signal when the recipe was started. You can list as many actions in the action list as you would like but you should not use a page change actions in the same action list.

**Action list properties**

**General tab**
- **Name** property - Provide a unique name for your action list.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute the list of actions.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**List of actions tab**

- **Action** Column - This column is for reference only can not be edited.
- **Action library entry name** property - Add in the actions you want in the list by selecting the action using the drop down list button.

Note: Parameters can be passed to an Action List similarly to Passing Parameters in a single action. Note that all parameters in each action in the list must be supplied in the order indicated in each individual action. For example, if the first action was an assignment action, that passed 2 parameters, #1, #2 and the second action was a goto page action, passing a single parameter - it would have to be labelled #3.

**Assignment Action**

Assignment actions are general purpose ways to write values to a location. They can be used to send setpoint or recipe values to a destination device. Transfer data from one destination device to another destination device.

**Assignment action properties**

**General tab**

- **Name** property - Provide a unique name for your assignment action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Condition Type** property - Only available if the trigger type is set to conditional. Select either:
  - **Pass Thru** - If you want to send data from one destination device to another. This selection does not require an expression since the runtime will continually send the data.
  - **Expression** - Use expression when you only want the action to execute when the expression is true.
- **Trigger Expression** property - Only available if condition type is set to expression. Place your expression here. When the expression equates to true the action will execute.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**Assignments tab**

- **Assignment** column - This column is for reference only can not be edited.
- **Expression** property - Add as many assignments as you want. Add more rows as needed.
Close Action

A close action will stop and exit the runtime. Displaying the desktop of the unit. Once at the desktop you calibrate the touchscreen, modify display setting, or anything else. To return to runtime reset the unit.

Close action properties

General tab

- **Name** property - Provide a unique name for your close action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

Data Archive Action

The Data Archive Action allows configuration of a list of entries which can be archived when the action is executed.

Data Archive Properties

General tab

- **Name** property - Provide a unique name for your action.
- **Trigger Type** property - Select Conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.

**Note:** the table below explains when archiving is started, based on the property settings.

<table>
<thead>
<tr>
<th>Trigger Type</th>
<th>Trigger Expression</th>
<th>Action in Configuration Properties/Actions tab (Activated by Trigger Expression)</th>
<th>Action NOT in Configuration Properties/Actions tab (Activated when Action executed, ie: by button)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditional</td>
<td>1</td>
<td>Archiving starts with Runtime</td>
<td>Archive NOT started - to start the Archive at Runtime, add it to the Configuration Properties/Actions tab</td>
</tr>
<tr>
<td>Conditional</td>
<td>'tag'</td>
<td>Archiving starts when 'tag' is TRUE, stops when 'tag' is FALSE</td>
<td>Archive NOT started - to start the Archive with a 'tag', add it to the Configuration Properties/Actions tab</td>
</tr>
<tr>
<td>Unconditional</td>
<td>N/A</td>
<td>Archiving NOT started - to start the Archive at Runtime, use Conditional and Expression of 1, to start by button do not add it to Configuration</td>
<td>Archiving starts when button executes action</td>
</tr>
</tbody>
</table>
Project Components

Properties/Actions tab

- **Archive** - Name of Archive Library Entry which defines time rates of the archive.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

Data tab

- **Item** column - This column is for reference only can not be edited.
- **Name** column - Strings to be associated with the expression in the archive file.
- **Expression** column - Expression to be evaluated and saved in the archive file.

See Data Archive Notes for more information.

Email Action

General tab

- **Name** property - Provide a unique name for your action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.
- **From** - Email address of sender.
- **To** - Email address of receiver.
- **Subject** - Subject to appear on email.
- **Message** - Message, body of email. Note: CTRL-Enter allows multiple lines.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.
Goto Page Action

Goto page actions allow you to change from one page to another. See Changing Pages Online for additional Page change information.

Goto page properties

General tab

- **Name** property - Provide a unique name for your goto page action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.
- **Destination Page** property - Use the drop down list button to select the page to switch to.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

Built in page actions

Use the drop down list button (Destination Page field) and select system pages to select one of the follow built in page actions.

- **Home page** - This action will switch to the home page specified in the configuration general tab.
- **Last page viewed** - This action will change to the last page that was viewed. i.e. If you just changed pages from page 2 to page 4, selecting this action will change to page 2, selecting this action again will change to page 4.
- **Previous page** - This action follows the page column of the pages tab of a configuration by cycling to the a lower row number. Using the example below, if your current page viewed is page 2, selecting this action will change to page 1, selecting the action again will change to page 5, repeating the process will continue to cycle through, page 4, page 3, etc.

- **Next page** - This action follows the page column of the pages tab of a configuration by cycling to the a higher row number. Using the example below, if your current page viewed is page 4, selecting this action will change to page 5, selecting the action again will change to page 1, repeating the process will continue to cycle through, page 2, page 3, etc.

- **Page Directory** - This action will display a list of pages for your configuration, see the figure below. From the figure, there are 5 pages in the configuration and you are current on page 1 (noted by the check mark). Touch which page you want to change to, completing the action.

### Log Event Action

Alarms are also events.

See events & alarms - big picture

An event is anything you want to record, a button depressed, a page changed, a start command, a stop command, etc. Many of these events only need to be recorded for viewing later. Some events however need more immediate attention and may need to be acknowledged to assure that the event has been satisfied. Events and alarms are all set up the same way, so we will just call them all events. The only difference between them is if you decide that you want to acknowledge an event. To acknowledge an event, open the event viewer either manually or based on the trigger that created the event. You can then find the event, usually it will be the top event viewed unless another event has been recorded. When you locate the event, touch the record to acknowledge the event, close the event viewer and you're done.
There are several ways to log events.

- **Unconditional** - Use this method if you want to add an event to page change action to monitor how many times pages are changed. If creating user IDs, record which is ID is logged in or when it is logged out. Do these by creating an unconditional action and place it in any control that calls actions.

- **Conditional**
  - Bits - Create an unconditional action to monitor a register of any length 1, 8, 16, 32, etc. Conditional actions should be placed in the actions tab of the configuration properties editor. This way the bits will be monitored constantly during runtime and add entries to the event log as needed.
  - Expression - Instead of using bits you can create any number of expressions to create a entry into the event log. Conditional actions should be placed in the actions tab of the configuration properties editor. This way the expression will be monitored constantly during runtime and add entries to the event log as needed.

There are two event logs.

- **Non-O/S event log** - Non-operating system event log. This log is always written to regardless of the hardware platform you choose as your unit. All log event actions will write to this log. This log will not save any events upon leaving the runtime.

- **O/S system event log** - Optionally you can save the events in the operating systems event log. This can only be done on Windows 2000 or Windows XP systems which have event logs. Windows CE systems do not have events logs. If you choose to save events in the O/S system they will still be saved in the non-O/S event log making a second copy. The big difference is if you exit the runtime any events that you saved to the O/S system log will be saved.

Log event action properties

**General tab**

- **Name** property - Provide a unique name for your log event action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Condition Type** property - Only available if the trigger type is set to conditional. Select either:
  - **Bit** - If you want to log events based on bits. Enter the bit source in the bit source field and enter the description of each bit in the events tabs. When the bit is true (1) an entry will be placed in the event log. A second entry will be entered when the bit is cleared (0).
  - **Expression** - If you want to log events based on expressions. Switch to the events tab and you can start entering different expressions for each entry into the event log. When any of the expressions equate to true an entry will be written to the event log. When the expression returns to false a second entry will be written to show the event as cleared.
- **Bit Source** property - Only available if condition type is set to bit. This is where you place the address of the source of the bit information. Use the drop down list button to select the tag.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**Events tab**

- **Event** Column - This column is for reference only can not be edited.
**Project Components**

- **Bit or Expression** property - Enter either the bit or the expression that will be monitored to write the events.
- **Type property** - Select one of the six types to help categorize your events. What you select for type will be written to the event log when the bit or expression is true.
- **Level property** - Select one of the five level to help categorize your events. Levels could be considered a sub-type providing you with 30 different ways to categorize your events. What you select for level will be written to the event log when the bit or expression is true.
- **Description** property - This is text you can enter to describe the event. If you have a lot of events that your recording you will want to use this field to help keep track of multiple events.

**Recipe Management Action**

The Recipe Management Action allows configuration of a recipe settings which are activated when the action is executed.

*Note: This action is only needed if it is desired to have customized recipe functions (for instance, a stand alone Load button). The functions necessary to operate and control a recipe are built into the Recipe control.*

**Recipe Action Properties**

**General tab**

- **Name** property - Provide a unique name for your action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.
- **Function** - The task that this action will perform
  - **Load** - Send recipe values of the highlighted Recipe Name to PLC.
  - **Compare** - Compare values of the highlighted Recipe Name to those currently in the PLC.

  *Note: the Compare function takes longer than a Load function, and is more noticeable for larger recipes (ie: a recipe with 1000 ingredients takes approximately 5 min to compare). The busy LED gives indication as the compare is taking place. Additionally, the Active Indication tag as defined below can be used to provide this busy feedback to the operator.*

  - **Save** - Get the current PLC values for the last loaded recipe and save them to the same recipe that was last loaded.

  *Note: the Save function is only available during Runtime if the last loaded recipe is highlighted.*

- **File Name** - Name of the XML file which contains the recipe data. Note: when the XML file is opened in Excel (from Office XP, 2003 or newer) recipe names are synonymous with sheet names.

- **Recipe Name** - The name of the recipe (ie: sheet) to Load/Save/Compare.

- **Active Indication** - (not required) Tag which is set to 1 when Load/Save/Compare operation is being carried out, set to 0 when complete. This can be used to provide indication to operators that the system is busy.

- **Ingredient Mismatch** - Tag for Compare function which is set to 0 if comparison (of PLC values and Recipe Name) is identical, or otherwise is set to the number of recipe items which have different values.

- **Log Event** -
  - **Yes** - Write a message to the Alarm/Event log to indicate the recipe action has occurred.
  - **No** - Do not write to the Alarm/Event log.

  **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

See **Recipe Development Notes** for more information.

### Security Action

#### Security Action Properties
# General tab

- **Name** property - Provide a unique name for your action.
- **Function** -
  - **Logon** - enable security clearance.
  - **Logoff** - disable security clearance.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

## Sound Action

**Sound Action Properties**
**General tab**

- **Name** property - Provide a unique name for your action.
- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute.
- **Sound** - The name of the .wav file to play
- **Id Number Expression** - Id of the Sound in the Media Library.
- **Play** -
  - **Once** - Play the .wav file once.
  - **Continuous** - Play the .wav file over and over.
- **Stop Expression** - For continuous only - Expression which when evaluated to TRUE will stop the sound.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

**View Action**

A view action will display either the event viewer or an HTML file. ePro ES units will only display event viewer. In addition to reviewing the material below also see the event banner tab of the configuration and the event banner tab of the unit to configure what fields of the event viewer will be displayed.

**See events & alarms - big picture**

- **Event viewer** - The event viewer is a window that will appear on the page when it is initiated. The event viewer is where you can display any events that have been written to the event log or acknowledge events that have happened. The event viewer will display on any page you desire.
Project Components

- **Unconditional** - It can be initiated manually by placing the action in a button. Manually will allow you to control when you want the event viewer to appear.

- **Conditional** - The event viewer can be displayed based on an expression. Creating a conditional view action and placing the action in the actions tab of the configuration property editor will allow the runtime to monitor the action continually. If the expression is true the event viewer will display regardless of the page you are currently on. This method would be a good way to present an event to someone that you would like acknowledged. When the event viewer appears have the person touch event requiring acknowledgement, then the event viewer can be closed by pressing the close button at the bottom of the event viewer window, or by pressing the X button at the top right of the window.

- **HTML files** - Not available at this time.

View action properties

**General tab**

- **Name** property - Provide a unique name for your view event action.

- **Trigger Type** property - Select conditional or Unconditional depending on the type of action you need.

- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute and display the event viewer window.

- **View State** property - you can provide a visibility expression to also provide more flexibility when the event viewer can display. Say you are using user IDs and you only want certain ID types to be able to have access to the event viewer. This is where you would set up the expression for this kind of visibility. Property settings are:
  - Close - Get rid of window.
  - Open - Bring up the window.
  - Open Full Screen - Window will consume the whole screen.
  - Roll Up - Shrink the window.
  - Roll Down - Un-shrink the window.

- **Viewer type** property - Property settings are:
  - Event/Alarm Viewer - Select to show event viewer
  - Document Viewer - Select to show HTML file given in File property below.

- **File** property - Name of file to show. Only available when Viewer Type is set to Document Viewer.

- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

To control displayed documents and allowable files and web pages, see Configurations or Document Viewer and Document Viewer Content.

**Start Application Action**

A Start Application action allows running an executable file during Runtime.

**Start Application Action properties**
General tab

- **Name** property - Provide a unique name for your action.
- **Trigger Type** property - Select Conditional or Unconditional depending on the type of action you need.
  - Conditional - will execute when Action is called and Trigger Expression assigned below is true.
  - Unconditional - will execute when Action is called.
- **Trigger Expression** property - Only available if trigger type is set to conditional. Place your expression here. When the expression equates to true the action will execute the list of actions.
- **Start Application** – Name/Path of file to be executed
- **Auto Close**
  - Yes - Close when ePro closes.
  - No - Stay open when ePro closes.
- **Minimize Application Expression** - when true, minimizes window.
- **Maximize Application Expression** - when true, maximizes window.
- **Restore Application Expression** - when true, restores window size.
- **Top Application Expression** - when true, brings window to the top.
- **Bottom Application Expression** - when true, brings window to the bottom.
- **Close Application Expression** - when true, closes application.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

Parameter Passing

Parameters can be passed to Actions. This minimizes the number of Actions that are necessary by allowing re-use for similar instances. Two examples of this are shown below.

Page Change Example (Goto Page Action)

A good example of parameter passing is an Action file that is set up to call a page by passing a parameter (ie: the Page Name) from a Button on the page. Without parameter passing, an Action would need to be created for each page that will be called.

The following is an outline of how to create a re-usable GoToPage Action:

- Create 2 Pages, PageX and PageY.
- Create a **Goto Page Action** called GoToPage and set its **Destination Page** to #1. The #1 is a placeholder for the first parameter passed with this Action. The passed value (PageX or PageY) will replace the #1.
- Create a **Rectangular Button** on PageX and assign its Break Action ‘GoToPage(PageY)’. By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the GoToPage action.
- Create a **Rectangular Button** on PageY and assign its Break Action ‘GoToPage(PageX)’

The button on PageX will call PageY and vice-versa, with a single Action entry.

Notes:
- Page changes should be a result of the **Break Action** since that would be the last operation to be performed on the calling page. If the Make Action was used, then a new page would be called, and the Break Action from the calling page would be lost.

- #1 is used in the Action entry file as a placeholder for the first passed parameter.

- By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the GoToPage action.

**Bit Write Example (Assignment Action)**

Below is an example of a single Assignment Action entry used to turn a bit ON then OFF. This example allows sharing the BitChange Action for both writes.

- Create an **Assignment Action** called BitChange and set the first **Assignment Expression** to `'Bit'=#1`. (Again, the #1 is where the first passed parameter will be placed.)

- Create a Page.

- Create a **Rectangular Button** on the Page and put `'BitChange(1)'` in the Make Action field and put `'BitChange(0)'` in the Break Action field. Again, the value in parentheses and within the single quotes is the parameter to be passed to the BitChange actions.

When this button is pressed, the command becomes `'Bit'=1`. Similarly, when the button is released, the command becomes `'Bit'=0`. This example is a momentary pushbutton.

**Notes:**

- This type of control should be used with caution. The response time (between the make/break and the corresponding bit writes) may not be accurate enough for time critical applications.

- #1 is used in the Action entry file as a placeholder for the first passed parameter.

- By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the BitChange action.

**Indexed Lists**

Index Lists allows you to substitute properties of a configuration component dynamically based on the value of an index expression. This means that a page control or action can change its indication or control function online. The purpose of index lists is to reduce the number of pages needed in a configuration by allowing a single page to represent multiple unit operations or multiple diagnostic screens without changing pages by simply changing a single value that provides an index into one or more tags or expressions in a series of Indexed Lists. Simply put, indexed lists allow page components to reference lists of addresses or tags based on the value of an Index. For example a readout value can show different PLC addresses based on a PLC register that acts as an index into a list of those PLC addresses, and an indicator template may show states of a series of devices based on that same register value. Non-dynamic properties such as template titles and text controls can also show lists of string values based on an index.

An example helps to illustrate the use of Indexed Lists. The following pictures show a process that has three different unit operations called AGI Mix tanks. All tanks are fundamentally similar in terms of process inputs, outputs, status, and control functions.
Using Indexed Lists a single page may be created in ePro Canvas that represents all three Mix Tanks. A total of 24 indexed lists supports the single page’s 10 dynamic status attributes, 7 control functions (5 pushbuttons and 2 numeric entry fields), and seven text fields, including the page title and template legends. In addition, if the scales of the bar graphs needed to be dynamic because of different pressure or temperature ranges from tank to tank, they could also be changed by Indexed Lists. The two up/down pushbuttons next to the page title increment and decrement a register that goes from 0 to 1 to 2 and is the index value for all 24 indexed lists. That register is also displayed as a readout value (‘register’ + 1) in the title area of the page to indicate the Mix Tank currently being displayed and controlled.

Another example of the use of Indexed Lists is in conjunction with Master Pages. A Master Page may be created where some of the page properties, such as page title, are driven by Indexed Lists whose index is the page ID Number property, referenced online by the System Client tag CurrentPageId.

The benefits of Indexed Lists are a reduction in the number of pages, and number of objects in the configuration, which saves memory, improves performance, and simplifies configuration management by reducing the number of copies of pages and objects with different address/tag references and expressions.

Creating and Using Indexed Lists

Indexed List entries are stored in Indexed List libraries and the library needs to be linked to the Configuration like all other Canvas libraries such as Media, Color, and Action libraries. The properties of an Indexed List are shown below:
Each Indexed List has an Indexed Expression that controls the Index List Entry value online. In the above example the tag ‘Vessnum’ in device PLC1 will be used to determine which index entry on the List tab is displayed at runtime.

The items in the List tab need to define the complete property value to be evaluated at runtime. That means that if a tag is part of an expression property, such as a conditional expression in an indicator template (Eg. ‘tag1’ & !‘tag2’), or a scaled value in a readout (Eg. ‘N7:154’ * 9.5 + 32) the entire expression must be placed in the Index List.

To use an Indexed List when editing a page control’s property dialog, simply select the Indexed List entry from the Indexed List Library in the pulldown list or from the Expression Editor window. An example is shown below for the readout template showing V1FlowRate, V2FlowRate or V3FlowRate of the previous example:
Where the Legend Title also comes from an Indexed List of text strings showing "Vessel 1 Flow Rate", "Vessel 2 Flow Rate", and "Vessel 3 Flow Rate". Virtually any parameter may come from an Indexed List including Visibility Expressions, Decimal Places, Data Entry Target Expressions, Button Entry Labels and Actions, Trend Template and Bar Template Max Min Calibrations, Indicator State Expressions, Media, and Color, as well as Action properties. Properties that do not support Indexed Lists are those that are restricted to pre-populated lists in the editor, such as Operator Input Type, Indicator State Evaluation (type), and Font.

Security

Security of an ePro configuration is designed to be as simple or as comprehensive as the developer desires. By default, anybody who has access to the PanelMate ePro unit may change pages to any page in the configuration and perform pushbutton and data entry control functions on those pages. Prior to V2.10 of ePro Canvas the only mechanism for securing the application from unwanted page or control access was through the Page Enabled Expression property and the Visibility Expression property of a page control. Both local and remote tags could be used in expression to prevent access to a page or to hide a critical control from the user. These methods are still supported but starting in V2.10 additional security functionality has been added to allow a more comprehensive approach to securing the ePro configuration.

There are many ways of implementing security in industrial control. The first level of security is physical access control. Traditional plant security, guards, gates, door locks, etc., may prevent unauthorized users entry to the machine or process area. A second level of security is at the PanelMate ePro itself. Locking cabinets and enclosures will prevent an unauthorized user from plugging in a keyboard or other device that would allow access to programs and operating system commands hidden from the touchscreen of the ePro. The third level of security is the ePro touchscreen and application and this is where ePro Canvas tools can be used to prevent unwanted use. There are three security components that constitute the ePro Canvas security model, devices, users, and groups.
Security Devices

A password is considered a Security device, but security devices may also include hardware devices, such as keys, RFID cards, biometric thumb-drives, or any such device that connects through a USB, PCMCIA, or other connection to an ePro unit that has a corresponding ePro Runtime software driver. Security Devices are contained in a Security Device Library. A password device consists of two properties, Name and User Password. Passwords are case sensitive and may contain any combination of alpha characters, numbers, and the underscore character. There is a minimum password length of one character and no maximum length.

Security Groups

Security groups define which pages may be accessed by a user who is logged on and a member of that group and if a group member may execute data entry control (pop-up entry pad or button pad control) on accessible pages. Security Groups are contained in a Security Group Library. Security groups have names and may have the All Pages Access property set to yes or no. If yes, then members of that security group have access to all pages and all control functions. If no, then the Page Permissions tab of the security group lists all pages that are accessible to group members and indicates whether or not control (data and button entry) on those pages is accessible to logged on users who are group members.
Secure Users
Secure Users are contained in Secure User Libraries. The Default User property of the library defines the secure user account that is automatically logged in when a configuration starts up and when a Security LogOff Action executes (as shown below). The Logged User property is an optional User Defined System Variable or PLC tag of string data type that the system will automatically update with the name of the user who is currently logged on.

A Secure User’s properties are:
Project Components

- **Name** of the user. This is different than the name used for log on purposes so that it may be more descriptive for documentation purposes.

- **User Name** to be entered during a **Security LogOn** Action.

- **Device Expression** that determines which passwords or other security devices are evaluated during the **LogOn** process.

- **Logoff After (Minutes)** time, in minutes after log on, after which the user will be logged off of the ePro unit. An entry of zero minutes never times out.

- **LogOn Action** to be executed upon successful user logon is completed.

- **LogOff Action** to be executed upon user logoff (manual or automatic).

- **Security Group List Tab** of which the user is a member.

- **Notification Tab** to determine if the user’s logon and logoff activity will be recorded in the ePro Event Banner and the Windows Event Viewer. Choices are **Log Events** or **None**.

Secure users are assigned one or more security devices in the Device Expression property. The device expression lets you logically “and” or “or” security devices. For example a user’s device expression could be set to Password 1 || Password 2 (or), or Password 3 && Key1 (and), or simply PWordA. The Security Group List tab is used for assigning the user to one or more security groups.

**Security User and Security Group Automatic Actions**

Both Secure Users and Secure Groups have LogOn and LogOff Action properties. When a user or group member logs on and logs off, these actions (if defined) execute automatically. An automatic action may be a simple direct assignment action or may call any action or action list from the Action Library. This gives you ultimate flexibility in designing any method necessary for indicating security status. It also gives you the ability to show or hide individual page objects and control objects, through the visibility expression property, based on which user or which groups are currently logged on. For example, if you wanted to keep track of the logon status of each security group you could create User Defined System...
tags of Boolean data type and have each group’s LogOn and LogOff Actions write ones and zeroes to their corresponding tag. The same could be done for each user.

**Runtime Security Functionality**

If a configuration has security, runtime behavior consists of the following:

- At runtime bootup, the Home page is called and the Default User is automatically logged on. For this reason the configuration’s Home Page must be accessible to the Default User account.

- Only one Secure User may be logged on at a time.

- When a user logs on or logs off an event may be written to the ePro Event Banner or the Windows Event Viewer based on the notification settings for each user.

- The active secure user’s access will be limited to those pages and controls that are defined by the security group or groups of which the user is a member. This is independent of whatever page change mechanism is employed, including a Page Change initiated through an assignment action from a PLC tag writing to the **CurrentPageID** system tag. If the user attempts to select an inaccessible page nothing will happen, the page will not change and no automatic system indication will be given as to why page access was denied. If the developer chooses to keep track of which user or which groups are currently active through the user or group automatic logon and logoff actions, they can choose to use standard indicator controls or visibility expressions to give runtime indication of security access status.

- All visible one-touch page controls (such as Rectangular Button, Button Bar, and Touch Area) are accessible on each page to which the user has access. This allows the user to change pages normally using various page change actions, and it also gives the developer flexibility to allow certain control actions and disallow other control actions on an accessible page.

- All data entry controls (two-touch controls such as Bar, Bar Template, Indicator, Indicator Template, Legend, Readout, Readout Template, Trend, and Trend Template) will only be accessible if the current user is a member of a group that has control access enabled for that page. If the user attempts to select an inaccessible control object nothing will happen, the pop-up control device will not display and no automatic system indication will be given as to why control access was denied.

- There are two ways a user can be logged off. The first method is by executing a Security LogOff action. The second method is when the current user’s automatic timeout period expires. When the current user logs off the Default User is automatically logged back on and if the current page is not accessible to the Default User, the system will automatically change pages back to the Home Page.

**Implementing Security on an ePro Configuration**

To create a configuration utilizing the built-in security features in ePro Canvas you need to go through the following steps:


2. Create a Security Device – Select the desired device library and right-click on the device or the Component Data pane and choose **New Password Device**. Give the password device a name and assign a password to the device. Repeat for all required password devices.


4. Create a Security Group - Select the desired group library and right-click on the group or the Component Data pane and choose **New Security Group Library Entry**. Give the group a name and choose Yes or No for the property **All Pages Access**. If you choose No, go to the **Pages** tab and add entries for each page to which you want to grant group member access and set the control property for each page to be Yes or No. Repeat for all required security groups.

5. Create a Security User Library - Right-click on the Security User Libraries icon in Project Explorer and select **New Secure User Library** and assign the library a Name.
6. Create a Secure User - Select the desired user library and right-click on the library or the Component Data pane and choose **New Secure User Library Entry**. Give the secure user entry a name (description), a user name (to be entered when logging on), and a device expression that chooses the password or other security device associated with that secure user. Repeat for all required secure users.

7. Assign a Default User – Select the Secure User Library’s properties and pick the Default User from the secure user entries of the library.

8. Assign the three security libraries to the configuration – If you want to implement the security features of ePro Canvas you must assign all three security libraries (User, Device, and Group) to a configuration. You can do this one of two ways. Either drag and drop each library onto the Configuration in the component data pane of Project Explorer or open the Configuration’s properties and add the three security libraries to the **Libraries** tab.

9. Configure LogOn and LogOff Actions – In the Action Library add two new Security Actions, one for log on and one for log off.

10. Configure rectangular button controls to one or more pages that are accessible to the Default User and assign your log on action to the button. Do the same for creating manual log off functions.

11. Optionally, configure User Defined System tags or client tags that will be used for tracking security activity, and create actions that will execute automatically on user or group logon and logoff events.

**Archive Library Entries**

The Archive Library Entry holds the specific parameters for data to be archived, including data save frequency and file path (not name).

- **Sample Rate**
  - Time Based (seconds) - How often data is saved to memory. This is ignored for Alarm and Event archiving, since that rate is determined by new alarms and events.
  - Event Based (expression) - When any tag in the expression changes, and the expression is true, then the sample will be taken.

- **Archive Rate**
- Time Based (seconds) - How often sample data in memory is saved to XML file.
- Event Based (tag) - When any tag in the expression changes, and the expression is true, then the sample data in memory is saved to XML file.

**Group Rollover Rate**
- Time Based (seconds) - How often the existing sheet is closed and a new sheet is created in XML file.
- Event Based (tag) - When any tag in the expression changes, and the expression is true, then the existing sheet is closed and a new sheet is created in XML file.

**File Rollover Rate**
- Time Based (seconds) - How often the existing XML file is closed and a new file created.
- Event Based (tag) - When any tag in the expression changes, and the expression is true, then the existing XML file is closed and a new file created.

**Archive Path** - The name of the folder (directory) where this data will be saved. File names are automatically generated:
- General Data Archiving Name - DataArchiveAction_mmddyyyyy_hhmm.xml
- Alarm and Event Archiving - AlarmEvent_mmddyyyyy_hhmm.xml
- Trend Archiving - TrendPens_mmddyyyyy_hhmm.xml

**Explicit Library Referencing**
Active library names can be entered alternatively, using **Explicit** references to Library Entries. Generally, this method works with library types that allow only one library per configuration. However, multiple clients are allowable in a unit, and can be accessed as shown in the table below.

The reference 'MediaLib1,Ref' can be restated as
- ':Media:,Ref'

And the reference 'ClientSystem,?' can be replaced with
- ':System:,?'

Notice how this gives flexibility since there is no tie to a specific library name, and will work with whatever the library is named in the configuration. For example, explicit references to an action library on a page allow that page to be re-used in multiple configurations, each accessing a different action library.

Here are the explicit names of each library.

<table>
<thead>
<tr>
<th>Library Type</th>
<th>Explicit Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Client</td>
<td>:System:</td>
</tr>
<tr>
<td>Unit’s 1st Client</td>
<td>:Client1:</td>
</tr>
<tr>
<td>Unit’s 2nd Client</td>
<td>:Client2:</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>Unit’s Nth Client</td>
<td>:ClientN:</td>
</tr>
<tr>
<td>Media</td>
<td>:Media:</td>
</tr>
<tr>
<td>Color</td>
<td>:Color:</td>
</tr>
<tr>
<td>Action</td>
<td>:Action:</td>
</tr>
<tr>
<td>Indexed List</td>
<td>:Indexed:</td>
</tr>
</tbody>
</table>
Property Value Formats and Syntax (single, double, or no quotes)

Throughout the ePro Canvas editors and property windows, property values of various types are entered. Depending on whether the value is Evaluated or Non-evaluated, several rules must be followed to accurately enter these values. Before the rules are applied, it must be determined whether it is an evaluated property or not.

Evaluated Properties

Properties which can vary during Runtime, require a mathematical evaluation and parsing for proper syntax. These Evaluated properties' entries can be dynamic, thus having an undefined number of values. It is possible and common for an evaluated property to contain an entry or expression that is not dynamic, but the property is still evaluated. In the editor, there is a simple way of determining if a property is evaluated. If a property has a pull-down arrow which leads to a pull-down library menu, the property is evaluated. In the figure below, the Value property has a pull-down arrow, and when the arrow is selected, a library menu is presented as shown below. This gives access to various references from various locations, all of which can dynamically change during runtime. So, the Value property of a Readout Template is one example of an Evaluated Property.

Non-evaluated Properties
Properties which contain values which cannot vary during Runtime are NOT evaluated. **Non-evaluated properties** are static and have a finite set of values. These property types can be determined by the properties’ type of entry - **when the library menu is not available, the property is non-evaluated**. For instance, fields with no pull-down arrows, Yes/No selections, and short menus are all NOT evaluated.

Below, the Orientation property is non-evaluated because it’s pull-down arrow leads to a menu with only several options (not the entire library menu).

---

**Evaluated Properties Syntax**

**Note:** Using the pull-down menus to select the entry values is the easiest way to determine syntax, because quotes are automatically added when needed.

**Text and Names**

Double quotes are required around strings which include text and names.

- **Text Strings** that are entered directly in a **Text** property or a **Media Library Entry** will be displayed exactly as entered, and requires DOUBLE quotes
  - "Template Title"
  - "rpm"
  - "This text will appear"

  **Note:** when referencing these media library entries, the strings are referenced with single quotes.

  **Note:** Legal characters in text fields (i.e. characters within double quote marks, “abcdedgg”) include all Alpha and Numeric characters, spaces and special characters except:

  \ - Backslash. To display a backslash within double quotes you need to place a second backslash in the string. Eg, "abcdedgg"
Images on a Page can be directly entered (ie: not using the media library) by browsing for the image name, which will add DOUBLE quotes and double the backslash characters

"c:\overview.bmp"

Note: Backslashes (\) are used to identify control characters embedded in a string. If a \ is needed inside a string with double quotes, it must be duplicated for distinction (ie: "c:\path\filename"). However, / can also be used without doubling (ie: "c:/path/filename").

Images can also be manually entered with single forward slashes

"c:/overview.bmp"

Note: When Images are entered into the media library, quotes are not required.

Documents entered into a View Action, Document Viewer Type, require a name in DOUBLE quotes. Again, backslashes are doubled.

"d:\\information.html"

Documents can also be manually entered with single forward slashes

"d:/information.html"

PLC or Library Entry Data can be embedded into text strings as described below under the Combinations/Expressions/Concatenations heading.

Library References

Generally, single quotes are required around library entries. A good way to enter these is by selecting the pull-down box, and drilling down through the libraries to find the entry. Single quotes will automatically be added when needed

- Properties that contain Clients and Library Entries (Tag Library Entries, Action Library Entries, Media Library Entries, etc.) are entered with SINGLE quotes

  - 'ClientPLC,400001'
  - 'Tag'
  - 'LibEntryName'
  - 'Lib,LibEntryName'

- Active library names can be entered alternatively, using Explicit references to Clients and Library Entries. These are entered with SINGLE quotes. 'MediaLib1,Ref' can be replaced with
• ':Media:,Ref'

• **Text** referenced in a text property, from **Media Library** entries will be enclosed in single quotes, even though the reference represents text strings ('StartText', 'TextLib,StartText').

Note: when text strings are created in media library entries, remember to place the strings in double quotes.

Note: Legal characters in tag names or Item Names (i.e. characters within single quote marks, 'abcdefg') include all Alpha and Numeric Characters, spaces and special characters **EXCEPT:**

<table>
<thead>
<tr>
<th>#</th>
<th>Casting operator</th>
</tr>
</thead>
<tbody>
<tr>
<td>@</td>
<td>Internal Client separator</td>
</tr>
<tr>
<td>,</td>
<td>Comma</td>
</tr>
<tr>
<td>=</td>
<td>Equal Sign</td>
</tr>
<tr>
<td>\</td>
<td>Backslash (Escape Character)</td>
</tr>
<tr>
<td>'</td>
<td>Single Quote</td>
</tr>
<tr>
<td>&quot;</td>
<td>Double Quote</td>
</tr>
</tbody>
</table>

**Literal Numbers**

Literal or hard-coded numbers used within evaluated properties, require NO quotes. These are evaluated because of their property type, yet are static since the value will not change during Runtime.

- **Evaluated Numeric Values** have NO quotes
  - 1
  - 98765
  - 2005

**Combinations/Expressions/Concatenations**

Expression properties follow the same rules in that references (tags, client tags, media entries) require single quotes, but constants and operators do not have quotes.

- **Writes**
  - 'Client,Ref' = 1

- **Comparisons**
  - 'Client,Ref' == 1

- **Scaling**
  - 'Client,Ref' / 10

- **To embed data** from the PLC in a text string, ie: to mix text and data in a text control, you must use text **concatenation**.
  - "The tank level is " + $I4('client1,tag1') + " Gallons"

If the value of tag1 is 1234, this will display ... The tank level is 1234 Gallons

When using concatenation you may embed spaces either before or after the plus character to view the sting more clearly in the editor and the spaces outside single or double quotes will be discarded at runtime.

Anywhere you can place literal text (i.e. text within double quotes) you can also place media entries or tags with data type of string. Any tag references within the parentheses of the
formatted data can use math or logic operators to create an expression. The following is the general formatted data syntax:

\[ $tw.d(expression) \]

where ...

$ = format indicator

t = type of numeric display

I - Integer
H - Hexadecimal
B - Binary
D - Floating decimal real value
O - Octal
F - Fixed decimal real value
A - Ascii

w = Total field width including decimal point, negative sign (-), and positive sign (+)
.
= Separator between width of format and the number of decimal places (used with F format)

d = Number of decimal places (used with F format)

Format type D (floating decimal point) permits the decimal point to float in the display depending on the tag’s value. This contrasts with format type F (fixed decimal point) which formats a value with a fixed decimal location.

**Formatted Data Examples:**

If ‘client,tag1’ has a value of 54321, then:

<table>
<thead>
<tr>
<th>Formatted String</th>
<th>Value Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>$I5('client1,tag1')</td>
<td>54321</td>
</tr>
<tr>
<td>$F6.2('client1,tag1' / 100)</td>
<td>543.21</td>
</tr>
<tr>
<td>$D8('client1,tag1'/100)</td>
<td>543.2100</td>
</tr>
<tr>
<td>$H4('client1,tag1')</td>
<td>D431</td>
</tr>
<tr>
<td>$O6('client1,tag1')</td>
<td>152061</td>
</tr>
<tr>
<td>$B16('client1,tag1')</td>
<td>1101010000110001</td>
</tr>
</tbody>
</table>

If ‘client,tag1’ has a value of 16706, which is 4142 hex (A=41 hex, B=42 hex), then:

<table>
<thead>
<tr>
<th>Formatted String</th>
<th>Value Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A('client1,tag1')</td>
<td>AB</td>
</tr>
</tbody>
</table>

If there is no additional literal text, media library text or PLC String data types to appear in the text control and you only wish to display the value of the tag you don’t need to use the formatted data syntax because the text control will automatically convert the value to a string.
For example, if the text property is set to 'client1,tag1' and the value is 54321 then it will display as 54321

- `:Media:,Motor 1` + " " + ':Media:,ON' + " " + $I5('client1,tag1') + " amps"

Assuming the media library has two entries named 'Motor 1' and 'ON' containing their respective strings, and the tag 'client1,tag1' is a 16 bit integer (short) data type with a value of 54321, then the preceding text property value will be displayed online as ...

Motor1   ON  54321 amps

**Non-evaluated Properties Syntax**

*If it is determine that a property is NOT Evaluated, then there are NO quotes required.* The majority of these are numbers and pull-down menu entries (but not pull-down library entries).

**Non-evaluated/No Quotes Examples**

- Non-evaluated values with a YES or NO value require no quotes.

- Non-evaluated values selected from a pull-down menu with few choices will be selected from the menu and contain NO quotes.
  - HORIZONTAL
  - VERTICAL

  **Note: this does not include the pull-down library box.**

- **Strings** that are not evaluated, such as a page added to a configuration, do NOT require quotes.
  - Page 1

- **Images** that are entered into the media library by browsing for the image path, will add a path string with NO quotes
  - c:/overview.bmp
  
  This entry can also be entered as
  - c:\\overview.bmp

- In the **Document Viewer, Home Page** and **Document Viewer Content, Document Location** properties, NO quotes are used
  - www.eaton.com
  - d:/information.html

- Non-evaluated **Numeric Values** have NO quotes

**User Defined System Tags**

User defined tags may be added manually to the System Client tag file TagSystem. These tags will all have an initial value of zero and the data type may be specified or you can select the type to be "Interface Supplied" which will default to unsigned 32-bit integer. You can add a tag to the TagSystem by opening the tag file properties dialog and selecting the "Tags" tab, and then double clicking on the line labeled "Double click here to append a row". The Name is user specified as long as it is unique in the tag file, and the Definition field should be identical to the Name. The default Data Type of Interface Supplied may be changed to any of the types shown below:
You can also add a tag by selecting the TagSystem library in the Project Components pane of Project Explorer, then right-click in the Component Data pane and select New Tag Library Entry.

User defined system tags will not change value at runtime unless the user configures a function that writes to those tags. They may be written to from a pushbutton or button bar function, from a data entry function, or from an Assignment Action. If the user configures a Conditional Passthru Assignment Action a user defined system tag can be updated from the PLC through an OPC Server client connection.

User defined system tags may be useful for a number of purposes. Their value can be toggled by a pushbutton to control conditional visibility of page objects, or a system tag may be used in place of a PLC register for storage of the configuration’s Active Language ID. A system tag may also be used as an index to one or more Indexed Lists. There are many more uses of user defined system tags and in general they can be used for local functions that will reduce the requirement of Operator Interface specific registers in the PLC. Note however that unlike PLC registers, system tags are not persisted values, which means that system tags will be set back to their default value of zero at each reboot of the ePro. This may limit some of the uses to which you would apply user defined system tags.

**Component Templates**

Component Templates are project components that have been saved as templates for reuse within the project. Component Templates may be created by the developer to reduce development time and provide a consistent look or style to a configuration. Any project component can be saved as a template by right-
clicking on the component and selecting Create Component Template and any single page component can be saved as a template by right-clicking on it and selecting Create Template as illustrated below.
When a component is saved as a template all configured properties of that component are saved. To create a new project component from a saved template right-click on the component group, i.e. Unit, Client, Configuration, Page, etc., and highlighting Create From Template, then choosing the desired template from the resulting list of Component Templates as illustrated below.
In the Page Editor you can use saved page components by clicking on the Component Template category in the controls bar. New components created from a component template will have all initial properties set to that of the saved template. This can speed up development by allowing the user to establish the default settings of new components added to the project rather than accepting the editor defaults and having to change each new components properties to match the desired standards of the developer. Because page controls can also be saved as Component Templates the developer can take standard Canvas controls and customize them once and then use the customized controls to reduce development time and create a consistent look and feel to the project’s pages.

Some Component Templates are included in the default Project Profile to speed up initial development. They are shown below:
Because Component Templates are saved with a project just like any other project components they will not automatically be added with a New blank project or New prepackaged project. However, like all other project components they may be copied from an existing project to a new project by opening both projects in separate windows and using copy and paste, or drag and drop, to copy between the two projects.

Changing the Default Prepackaged Project

**Canvas Assistance and Component Builder**

The Canvas Assistance and Component Builder features provide guidance throughout project development.

### Canvas Assistance

Canvas Assistance parses all property value entries and checks for accuracy. The following operations are carried out on the entries.

- **Text** - Double Quotes added automatically to text entries if needed.
- **Tags** - If a tag is entered that does not exist, the Component Builder menu (as described below) will be shown to allow creating the tag immediately.

### Component Builder

Component Builder allows components to be built anywhere in the Canvas Pro editor. This is helpful when editing a component and without leaving that component a completely different component can be added. The menu is called in the following ways.

- **CTRL-Right Click** opens the pulldown menu any where in the editor as shown below.
• When dynamic references are entered into an evaluated property and the dynamic reference does not exist, the menu is presented to allow adding a component.

**Note:** The dynamic reference is checked for existence against it’s expected library type first, then client/tags are checked next.

---

**Enabling and Disabling Canvas Assistance and Component Builder Features**

By default, all features are enabled. If desired they can be disabled from the Tools menu as follows.
Canvas Options

The following options allow enable/disable automatic string functions.

- Canvas Assist
  - Automatically apply string quotes when missing - add double quotes to text properties
  - Automatically apply string quotes to Media Library Text Entries - add double quotes to text entries within a Media Library

Component Builder Options

The following options enable/disable menu operations.
Project Components

Document Viewer

The Document Viewer is a window which allows displaying HTML and PDF documents and addresses.

Document Viewer tab properties

- **Home Page** - Address/location of initial document or web page to be displayed. Can be a file like c:\home.pdf or a web site like www.eaton.com. No quotes are needed.
- **Title** - Name displayed at the top of the viewer.
- **Font** - sets the viewer font.
- **Roll Up/Down Operational** - enables minimizing and maximizing the document area.
- **Exit Operational** - enables/disables exit button.
- **Mobility** - enables/disables ability to move viewer.
- **Location** - viewer position (top, bottom, left, right or center).
- **Height** - Percent - height of viewer based on display size. Default is 50, which covers half the display height.
- **Width** - Percent - width of viewer based on display size.
- **Forward/Back Button Operational** - enables/disables buttons to navigate the pages.
- **Browse Address Operational** - allows/disallows ability to browse for files.
- **Home Page Button Operational** - enables/disables button to return to the initial document or web page.
- **Open File Operational** - allows/disallows local file search.
- **Refresh Button Operational** - enables/disables button to refresh document or web page.
• **Browser Stop Button Operational** - enables/disables button to close browser.

### Document Viewer Content tab properties

• **Documentation Location** list - A list of pre-determined html and pdf file links and addresses. These appear in the address pull-down list during Runtime, for example: www.msn.com, www.eaton.com.

### Event Banner and Manager

#### Event Banner

*See events & alarms - big picture*

The event banner property tab is where you set up an event log will appear in Runtime. These properties are only for the Non-O/S event log, they do not have affect on the system event log. Viewing the event log will also give you the option to acknowledge an event.

#### Event Banner properties

- **Override Configuration** - use these Unit settings for the Event Banner instead of those assigned in the Configuration properties.

  **Note:** Override Configuration only appears on the Unit’s Event Banner property tab. It allows Unit settings to override all the settings that were configured in the Configuration’s Event Banner property tab.

- **Banner** - general settings for the Banner.
  - **Title** - Name displayed at the top of the banner.
  - **Font** - sets the event banner font.
  - **Mobility** - enables/disables ability to move banner.
  - **Location** - banner position (top, bottom, left, right or center)
  - **Height - Percent** - height of banner based on display size
  - **Width - Percent** - width of banner based on display size

- **Acknowledge-Filters** - button settings for the Alarm/Event Window.

  **Notes:**
  - **Operational** = function and corresponding button enabled for Runtime use
  - **Visible** = alarms currently in view on banner/window
  - ... **On** = text name on button when filtering is on; ... **Off** = text name on button when filtering is off
  - **Active** = in alarm state; **Inactive** = not in alarm state

  - **Acknowledge All Alarms** - name to display on the Ack All button during Runtime
  - **Acknowledge All Operational** - Yes = allow the Ack All function (ie: show the button) during Runtime; No = remove Runtime function and button.

  - **Acknowledge Visible Alarms** - name to display on the Ack Visible button during Runtime
• Acknowledge Visible Operational - Yes = allow the Ack Visible function (ie: show the button) during Runtime; No = remove Runtime function and button.

• Filter Active On - name to display on the Active filter's button (On state) during Runtime
• Filter Active Off - name to display on the Active filter's button (Off state) during Runtime
• Filter Active Operational - Yes = allow the Active On/Off filter (ie: show the button) during Runtime; No = remove Runtime function and button.

• Filter Inactive On - name to display on the Inactive filter's button (On state) during Runtime
• Filter Inactive Off - name to display on the Inactive filter's button (Off state) during Runtime
• Filter Inactive Operational - Yes = allow the Inactive On/Off filter (ie: show the button) during Runtime; No = remove Runtime function and button.

• Filter Acknowledged On - name to display on the Acknowledged filter's button (On state) during Runtime
• Filter Acknowledged Off - name to display on the Acknowledged filter's button (Off state) during Runtime
• Filter Acknowledged Operational - Yes = allow the Acknowledged On/Off filter (ie: show the button) during Runtime; No = remove Runtime function and button.

• Filter Unacknowledged On - name to display on the Unacknowledged filter's button (On state) during Runtime
• Filter Unacknowledged Off - name to display on the Unacknowledged filter's button (Off state) during Runtime
• Filter Unacknowledged Operational - Yes = allow the Unacknowledged On/Off filter (ie: show the button) during Runtime; No = remove Runtime function and button.

**Table** - settings that affect the presentation of the Alarm/Event table.
• Maximum Events - This is the maximum number of events to display.
• Grid Background - Select the default background color of the table.
• Active Acknowledged FG Color
• Active Acknowledged BG Color
• Inactive Acknowledged FG Color
• Inactive Acknowledged BG Color
• Active Unacknowledged FG Color
• Active Unacknowledged BG Color
• Inactive Unacknowledged FG Color
• Inactive Unacknowledged BG Color
• Header Height - This will adjust the table header height.
• Field Height - This will adjust the height of each row of the table.
• Selected Text Color - When you touch a row, the row becomes the selected row and you can have the text of that row change to a different color to help make the row more visible than other rows to draw better attention to the row.

• Selected Background Color - When you touch a row, the row becomes the selected row and you can have the background color of that row change to a different color to help make the row more visible than other rows to draw better attention to the row.

**Triggered Timestamp** - the time an event occurred and was written to the event log.

• Column - This will select which column you want this property to be displayed in.
• Column Width - This will adjust the column width.
• Text - This is the header text of the column.
• Header FG Color - Select the foreground color of the header field.
• Header BG Color - Select the background color of the header field.
• Header Font - Set the font to use when for the text in the header field.
• Header Alignment - Set the type of alignment to use for the header text.
• Field FG Color - Select the foreground color of the column under the header field.
• Field BG Color - Select the background color of the column under the header field.
• Field Font - Set the font to use when for the text under the header field.
• Field Alignment - Set the type of alignment to use for the text under the header field.

**Cleared Timestamp** - if the event cleared itself, this is the time it cleared.

• Column - This will select which column you want this property to be displayed in.
• Column Width - This will adjust the column width.
• Time Format - If the event clears itself this field will have the time the event cleared written to this field.
  • Absolute - This will write the current time the event cleared.
  • Elapsed - This will write the elapsed time from when the event occurred.
• Text - This is the header text of the column. The default text is "Cleared", you can change this text to any text string you want. Remember to place " before and after the text.
• Header FG Color - Select the foreground color of the header field.
• Header BG Color - Select the background color of the header field.
• Header Font - Set the font to use when for the text in the header field.
• Header Alignment - Set the type of alignment to use for the header text.
• Field FG Color - Select the foreground color of the column under the header field.
• Field BG Color - Select the background color of the column under the header field.
• Field Font - Set the font to use when for the text under the header field.
• Field Alignment - Set the type of alignment to use for the text under the header field.

**Acknowledged Timestamp** - if the event was acknowledged, this is the time it was acknowledged.
• Column - This will select which column you want this property to be displayed in.
• Column Width - This will adjust the column width.
• Time format - If the event clears itself this field will have the time the event cleared written to this field.
  • Absolute - This will write the current time the event cleared.
  • Elapsed - This will write the elapsed time from when the event occurred.
• Text - This is the header text of the column. The default text is "Acknowledged", you can change this text to any text string you want. Remember to place " before and after the text.
• Header FG Color - Select the foreground color of the header field.
• Header BG Color - Select the background color of the header field.
• Header Font - Set the font to use when for the text in the header field.
• Header Alignment - Set the type of alignment to use for the header text.
• Field FG Color -Select the foreground color of the column under the header field.
• Field BG Color - Select the background color of the column under the header field.
• Field Font - Set the font to use when for the text under the header field.
• Field Alignment - Set the type of alignment to use for the text under the header field.

Description - event description, when the event occurs, the description field from the log event action which created the event will be written here.
• Column - This will select which column you want this property to be displayed in.
• Column Width - This will adjust the column width.
• Text - This is the header text of the column. The default text is "Description", you can change this text to any text string you want. Remember to place " before and after the text.
• Header FG Color - Select the foreground color of the header field.
• Header BG Color - Select the background color of the header field.
• Header Font - Set the font to use when for the text in the header field.
• Header Alignment - Set the type of alignment to use for the header text.
• Field FG Color -Select the foreground color of the column under the header field.
• Field BG Color - Select the background color of the column under the header field.
• Field Font - Set the font to use when for the text under the header field.
• Field Alignment - Set the type of alignment to use for the text under the header field.

Criticality - when the event occurs, the criticality field from the log event action which created the event will be written here.
• Column - This will select which column you want this property to be displayed in.
• Column Width - This will adjust the column width.
• Text - This is the header text of the column. The default text is "Level", you can change this text to any text string you want. Remember to place " before and after the text.
• Header FG Color - Select the foreground color of the header field.
• Header BG Color - Select the background color of the header field.
• Header Font - Set the font to use when for the text in the header field.
• Header Alignment - Set the type of alignment to use for the header text.
• Field Critical Text - Name used to identify a critical alarm.
• Field Serious Text - Name used to identify a serious alarm.
• Field Warning Text - Name used to identify a warning alarm.
• Field Attention Text - Name used to identify an attention alarm.
• Field Informational Text - Name used to identify an informational alarm.
• Field Default FG Color - foreground Color for the "No Alarm" state.
• Field Default BG Color - background Color for the "No Alarm" state.
• Field Critical FG Color - foreground Color for the "Critical" state.
• Field Critical BG Color - background Color for the "Critical" state.
• Field Serious FG Color - foreground Color for the "Serious" state.
• Field Serious BG Color - background Color for the "Serious" state.
• Field Warning FG Color - foreground Color for the "Warning" state.
• Field Warning BG Color - background Color for the "Warning" state.
• Field Attention FG Color - foreground Color for the "Attention" state.
• Field Attention BG Color - background Color for the "Attention" state.
• Field Informational FG Color - foreground Color for the "Informational" state.
• Field Informational BG Color - background Color for the "Informational" state.
• Field Font - the font to use when for the text under the header field.
• Field Alignment - the type of alignment to use for the text under the header field.

**Group Column** - specifies the column you want this property to be displayed in.
**Group Name** - specifies the column you want this property to be displayed in.
**Source** - specifies the column you want this property to be displayed in.
**User** - specifies the column you want this property to be displayed in.
**Computer** - specifies the column you want this property to be displayed in.

**Event Manager**

See events & alarms - big picture

The event manager is used to select which types of events are logged to the operating system event log. ePro Runtime will write event to two event logs. ePro runtime will always write to its own event log, it will also write to the operating system event log.

**Two event logs**

If none of the default settings are changed in ePro Canvas, then the ePro runtime will write events to two event logs. These event logs are:
Project Components

- **Non-O/S event log** - This is an event log that ePro runtime creates and is always written to. The only setting that affects this log is how many events it should save. Hardware platforms with CE operating systems will not save this log through a reset or power off condition. All other hardware platforms will save the contents of the log through a reset and power off condition.

- **System event log** - This is the standard operating system event log that you might be familiar with. CE operating systems do not have event logs. ePro runtime will only write to this log if you select it to.

**Event manager tab properties**

- **Override Configuration** - On Unit’s Event Banner property tab only, and allows these settings to override the same settings which were configured in the Configuration's Event Banner property tab.

- **Max Number of Events to Non-O/S Log** - This property sets the number of events to record in the runtime event log. The oldest event will be deleted as a new event occurs if the number of events have reached the maximum number set here. This number does not have an affect on system event log because those parameters are established from within the system event log.

- **Save Critical Events to O/S Log** - Select yes or no to store this type of event in the system event log. A critical event type is a choice you make when creating a log event action. This event will always be written to the Non-O/S event log.

- **Save Serious Events to O/S Log** - Select yes or no to store this type of event in the system event log. A serious event type is a choice you make when creating a log event action. This event will always be written to the Non-O/S event log.

- **Save Warning Events to O/S Log** - Select yes or no to store this type of event in the system event log. A warning event type is a choice you make when creating a log event action. This event will always be written to the Non-O/S event log.

- **Save Attention Events to O/S Log** - Select yes or no to store this type of event in the system event log. An attention event type is a choice you make when creating a log event action. This event will always be written to the Non-O/S event log.

- **Save Informational Events to O/S Log** - Select yes or no to store this type of event in the system event log. An informational event type is a choice you make when creating a log event action. This event will always be written to the Non-O/S event log.

- **Archive** - Placing an Archive Library Entry reference (ie: ':Archive;AlarmandEventEntry') here, will result in Alarm and Event log archival based on the archive settings.

**Events & Alarms - Big Picture**

Several separate features of ePro Canvas need to be configured together in order for successful events to be recorded and viewed. These are the separate features and their descriptions.

- **Event Manager** - The event manager establishes how many non-O/S events to record and whether events should be recorded to the standard O/S event log. The event manager is set up on the event manager tab of a configuration.

- **Log Event Action** - This is where events are established. Write an event by a conditional, unconditional, or bit log event action. When the expression is true or the bit transitions from zero to one the corresponding event will be written to the event log(s). Log events are set up in the action library.

- **Event Banner** - The event banner establishes what will be seen when the Non-O/S event log is viewed. This is where you establish the description of each column, the color of each column, which columns are visible and what order they are displayed. The exception is the CE platforms which has fixed columns. The event banner is set up on the event banner tab of a configuration.

- **View Action** - A view action when executed will display the Non-O/S event log. This can be triggered by conditional or unconditional methods. When the event log is displayed it will be
displayed according to how the event banner was set up. View actions are set up in the action library.

- **Event Manager Override** - Since a configuration can be used in many different units, it might be desirable to have a different event manager set up than what the configuration has. If you were to change to event manager in the configuration (event manager tab of a configuration), then any units that are using the configuration will also change. Using this override method you do not need to change the configuration. If you select override event manager on the event manager tab of a unit you can change the event manager for the desired unit without changing the event manager for any other unit that would be using the same configuration.

- **Event Banner Override** - Since a configuration can be used in many different units, it might be desirable to have a different event banner set up than what the configuration has. If you were to change to event banner in the configuration (event banner tab of a configuration), then any units that are using the configuration will also change. Using this override method you do not need to change the configuration. If you select override event banner on the event banner tab of a unit you can change the event banner for the desired unit without changing the event banner for any other unit that would be using the same configuration.

- **Acknowledging Alarms** - An alarm is an event. Usually the only difference between them is alarms typically need to be acknowledged. To do this, set up the event. After the event occurs, open the event viewer and touch the row of the required event. This will write an Acknowledged timestamp on the same row as the event indicating the event has been acknowledged.
Page Editor

Navigation

Customizing the Page Editor

The Page Editor is designed with some customization capabilities. The following are intended to simplify page editing.

Move Menu Bars and Toolbars

By default, all menu bars and toolbars are displayed across the top of the window. All menu bars and toolbars are dockable, which means that they can be moved to any location in the window.

To move a menu bar or toolbar:

1. Click the move handle located at the far left of the menu bar or toolbar.
2. Press and hold the mouse button while you drag the menu bar or toolbar to a suitable location in your window.
3. Release the mouse button to drop the menu bar or toolbar to its new location. It will remain in this new place until you move it again or close it.

Customizing the Control Bar

Moving the Control Bar

The Control bar's default location is the left-hand side of the Page Editor window. You can move the Control bar by clicking the move handle at the top of the bar and dragging it to a new location.

Resizing the Control Bar

You can resize the Control bar by positioning the mouse pointer over the Control bar border until the pointer changes to a double-headed arrow. Move the double-headed arrow to the left or right to resize the Control bar.

Creating a Floating Control Bar

You can create a floating Control bar by double-clicking the move handle at the top of the Control bar. Once you do this, the Control bar becomes detached from the Page Editor window and becomes its own independent window, complete with a title bar at the top.

Tip: To dock the Control bar, double-click the floating bar’s title bar.

Viewing Small/Large Control Icons in the Control Bar

You can view either large or small icons in the Control bar. To do this, right-click in the Control bar and select Large Icons or Small Icons.

Resizing a Floating Control Bar

When you select the floating Control bar, sizing handles appear at the corners and along the edges of the window. You can resize the window by dragging its sizing handles.

Modifying Grid and Snap Settings

When you are placing or arranging objects on a page, you can use the alignment grid for more precise positioning. When the grid is turned on, objects appear to "snap to" the dotted lines of the
grid as if magnetized. You can turn this “snap to grid” feature on and off, as well as change the size of the grid cells.

In addition to defining a grid size, and whether to show or snap to the grid, a guidelines margin can be defined around the perimeter of the view, such that objects cannot be moved outside the guidelines margin.

The Grid Settings window allows you to configure grid snapping and margin/guidelines settings.

Turning the Snap to Grid On and Off

To turn the snap to grid on and off for the currently active view (in edit mode), complete one of the following actions:

- From the Layout toolbar, click the Toggle Grid button
- From the Layout menu, click the Grid Settings command

Result: The Grid Settings window appears.

Changing the Size of the Layout Grid

To change the size of the layout grid, complete the following steps:

1. From the Layout menu, click the Grid Settings command.
   Result: The Grid Settings window appears.
2. In the Spacing box, type a different width and height (in pixels) for the cells in the grid.
   Note: The default spacing for the grid is 10 pixels.
3. Click OK.

Zooming In and Out of a Page

Using the Zoom In and Out Toolbar

To zoom in and out of a page, complete the following steps:

1. Right-click the down arrow next to the Zoom In and Out toolbar.
   Result: A drop-down menu appears.
2. From the drop-down menu, click one of the following options:
   - Zoom In, to see a close-up view of the page
   - Zoom Out, to see more of the page at a reduced size
   - Zoom 1:1, to view the page at 100 percent.

Using the Zoom Menu Command

To zoom in and out of a page, complete the following:

1. From the Draw menu, right-click the down arrow next to the Zoom command and click one of the following options:
   - Zoom In, to see a close-up view of the page
   - Zoom Out, to see more of the page at a reduced size
   - Zoom 1:1, to view the page at 100 percent.

Open/close Toolbars and Component Views

By default, all toolbars are open and displayed on the window. You can open and close these toolbars whenever necessary.

To open a toolbar:

From the View menu, select a specific toolbar to open (open toolbars display a check mark on the left).

To close a toolbar:
From the View menu, select a specific toolbar to close (closed toolbars do not display a check mark on the left).

Online functions, such as screen settings and referenced libraries can be modified using Page Component Properties.

The following links provide related assistance.

The Page Editor

Working with Controls

Working with Properties

**Working with Controls**

When working with controls, the following links may be helpful.

**Which Control Do I use?**

- To view **Numeric** data:
  - Readout Template (includes Title "Legend" and Units field)
  - Readout
  - Bar Template (includes Title "Legend", Readout, Scale and Units field)
  - Bar
- To view **Status** or **States**:
  - Indicator Template (includes Title "Legend" and Units field)
  - Indicator
  - Rectangular Button and Legend allow images and/or text to be displayed dynamically.
- To **Write** or **Change "Bit" Values**:
  - Rectangular Button
  - Control Button - selected from the "Buttons" tab of any control.
- To **Write** or **Change "Word" Values**:
  - Control Data Entry - selected from the "Data Entry" tab of any control.
- To **Change Pages**:
  - Rectangular Button
- To draw **Custom Graphics**:
  - Arc
  - Ellipse
  - Image
  - Line
  - Polygon
Adding a Control to a Page

To add a control to a page, drag the control from the Control Bar frame and drop it onto the Editor frame/page. The control can be edited/configured by either:

- Double-clicking it, and modifying its attributes in the Property Editor window
- Right-clicking it, selecting Properties and modifying its attributes in the Property Editor window

Note: Controls can be edited, added, or deleted to/from a page without opening the page editor by “right clicking” the page in Project Explorer. Then the page controls appear in the right pane.

Configuring/Editing a Control

Once a control has been dragged and dropped onto the page, you can configure and/or edit it. To do this, complete the following steps:

Perform one of the following actions:

- Double-click the control
- Right-click the control and select Properties
- Click the control and from the Layout menu, select Properties
- Click the control and from the Layout toolbar, select the Property Sheet icon

Result: The Property Editor window appears, so that you can modify the control’s properties.

Viewing a Control’s Properties

You can view the properties of any control on a page. To do this, complete the following steps:

Perform one of the following actions:

- Double-click the control
- Right-click the control and select Properties
- Click the control and from the Layout menu, select Properties
- Click the control and from the Layout toolbar, select the Property Sheet icon

Result: The Property Editor window appears, so that you can modify the control’s properties.

Deleting a Control

There are several ways in which you can delete a control from a page:

- Right-click the control and select Delete
- Click the control, and from the Standard toolbar, select Delete.
- Click the control, and from the Edit menu, select Delete.

Arranging Controls/Objects on a Page

Aligning Controls/Objects

You can align two or more controls/objects relative to each other by their left, right, top, or bottom edges or by their centers (vertically) or middles (horizontally).

To align objects on a page:

1. From the Editor frame, press the Shift button on the keyboard then select the controls that you want to align.

Note: Make sure the dominant object is the last object that you select. The final position of the group of objects depends on the position of the dominant object.
2. Perform one of the following actions:
   - From the Layout toolbar, select the down arrow to the right of the **Align Edges** icon, and select a specific alignment button.
   - From the Layout menu, select **Align Objects** and then select a specific alignment menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Align Left" /></td>
<td>Align Left</td>
<td>This button/command aligns the selected objects along their left side. <strong>Note:</strong> You can also use the short cut keys Ctrl + Left Arrow.</td>
</tr>
<tr>
<td><img src="image" alt="Align Center" /></td>
<td>Align Center</td>
<td>This button/command aligns the selected objects along their horizontal center.</td>
</tr>
<tr>
<td><img src="image" alt="Align Right" /></td>
<td>Align Right</td>
<td>This button/command aligns the selected objects along their right side. <strong>Note:</strong> You can also use the short cut keys Ctrl + Right Arrow.</td>
</tr>
<tr>
<td><img src="image" alt="Align Top" /></td>
<td>Align Top</td>
<td>This button/command aligns the selected objects along their top edges. <strong>Note:</strong> You can also use the short cut keys Ctrl + Up Arrow.</td>
</tr>
<tr>
<td><img src="image" alt="Align Middle" /></td>
<td>Align Middle</td>
<td>This button/command aligns the selected objects along their vertical center.</td>
</tr>
<tr>
<td><img src="image" alt="Align Bottom" /></td>
<td>Align Bottom</td>
<td>This button/command aligns the selected objects along their bottom edges. <strong>Note:</strong> You can also use the short cut keys Ctrl + Down Arrow.</td>
</tr>
</tbody>
</table>

**Spacing Controls/Objects Evenly**

To space controls/objects evenly on a page:

1. From the Editor frame, press the Shift button on the keyboard then select the controls that you want to space evenly.
2. Perform one of the following actions:
   - From the Layout toolbar, select the down arrow to the right of the **Space** icon, and select a specific spacing button.
   - From the Layout menu, select **Space Evenly** and then select a specific spacing menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Space Across" /></td>
<td>Space Across</td>
<td>This button/command spaces objects horizontally on the page.</td>
</tr>
<tr>
<td><img src="image" alt="Space Down" /></td>
<td>Space Down</td>
<td>This button/command spaces objects vertically on the page.</td>
</tr>
</tbody>
</table>

**Centering Controls/Objects**

To center controls/objects on a page:
1. From the **Editor** frame, press the **Shift** button on the keyboard then select the controls that you want to space evenly.

2. Perform one of the following actions:
   - From the **Layout** toolbar, select the down arrow to the right of the **Center in View** icon, and select a specific centering button.
   - From the **Layout** menu, select **Center in View** and then select a specific centering menu item.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Center Vertically</td>
<td>This button/command centers objects vertically on a page.</td>
</tr>
<tr>
<td></td>
<td>Center Horizontally</td>
<td>This button/command centers objects horizontally on a page.</td>
</tr>
</tbody>
</table>

**Making Controls/Objects the Same Size**

To make controls/objects the same size:

1. From the **Editor** frame, press the **Shift** button on the keyboard then select the controls that you want to space evenly.

2. Perform one of the following actions:
   - From the **Layout** toolbar, select the down arrow to the right of the **Make Same Size** icon, and select a specific sizing button.
   - From the **Layout** menu, select **Make Same Size** and then select a specific sizing menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Make Same Width</td>
<td>This button/command sizes objects to be the same width.</td>
</tr>
<tr>
<td></td>
<td>Make Same Height</td>
<td>This button/command sizes objects to be the same height.</td>
</tr>
<tr>
<td></td>
<td>Make Same Size</td>
<td>This button/command sizes objects to be the same size.</td>
</tr>
</tbody>
</table>

**Ordering Controls/Objects**

To set the order of controls/objects on a page:

1. From the **Editor** frame, select the control that you want to order.

2. Perform one of the following actions:
   - From the **Layout** toolbar, select the down arrow to the right of the **To Front or Back** icon, and select a specific ordering button.
   - From the **Draw** menu, select **Order** and then select a specific ordering menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bring to Front</td>
<td>This button/command brings an object to the front of all other objects.</td>
</tr>
</tbody>
</table>
**Grouping Controls/Objects**

When you group controls/objects, you combine them so you can work with them as though they are a single object. You can rotate, resize, or scale all objects in a group as a single unit.

You can ungroup a group of objects at any time, and as long as the page is still active, you can easily regroup them by selecting any one of the objects that was previously grouped. If you move to another document or change views, you'll need to select each object and regroup them again.

Grouping functionality is intended to help you assemble a unique combination of controls/graphics for an application. That way, if you want to reuse the combination (either as-is or with minor modifications) in other configurations, you do not have to repeat your work.

**To group controls/objects on a page:**

1. From the Editor frame, select the Shift button on the keyboard and then click the controls that you want to group.
2. Perform one of the following actions:
   - From the Layout toolbar, select the Group, Ungroup, or Regroup icon.
   - From the Draw menu, select Group and then select a specific grouping menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>Group</td>
<td>This button/command groups a set of selected objects together.</td>
</tr>
<tr>
<td>Ungroup</td>
<td>Ungroup</td>
<td>This button/command ungroups a group of objects.</td>
</tr>
<tr>
<td>Regroup</td>
<td>Regroup</td>
<td>This button/command regroups a set of objects that was previously grouped.</td>
</tr>
</tbody>
</table>

**Rotating Controls/Objects**

**To rotate controls/objects to the left or right on a page:**

1. From the Editor frame, select the control that you want to rotate.
2. Perform one of the following actions:
   - From the Layout toolbar, select the Rotate Left or Rotate Right icon.
   - From the Draw menu, select Rotate and then select Rotate Left or Rotate Right.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free</td>
<td>Free</td>
<td>This button/command rotates the object to the degree that you specify.</td>
</tr>
</tbody>
</table>
To free rotate controls/objects on a page:
1. From the Editor frame, select the control that you want to rotate.
2. Perform one of the following actions:
   - From the Layout toolbar, select the Free Rotate icon.
   - From the Draw menu, select Rotate and then select Free Rotate.
   
   **Note:** The drag handles of the selected object turn into circles, so that you can freely rotate the object.
3. Rotate the object about its center by dragging any one of these handles.

For more details on the composition of controls, refer to the Control Example.

The following links provide related assistance.

The Page Editor

Customizing the Page Editor

Working with Properties

**Working with Properties**

The Property Editor is designed with the following adjustment capabilities:

**Resizing the Property Editor Window**

Property Editor windows can be sized to any dimension by:

- Placing the pointer at the edge of the window (until the pointer turns into a line with arrows on each end), pressing the left mouse button and dragging up, down, left or right.
- Using the Maximize and Minimize buttons located at the upper right corner of the window
- Using the scroll bars along the right side and bottom of the window

**Scrolling to Another Part of the Property Editor Window**

To scroll to another part of the window, either:

- Drag the scroll bars back and forth or up and down
- Click the arrows next to the scroll bar

**Resizing Columns in the Property Editor Window**

In addition to sizing the window, you can size the columns by dragging the sides of each column. Place the pointer at the edge of the column (until the pointer turns into a line with arrows on each end), press the left mouse button and drag left or right.
Note: When a column is smaller than the largest viewable text in that column, the text appears with "...." at the end.

Moving Between Cells in the Value Column

To move between cells in the value column (the last column on the right) click any cell or use the up/down arrow keys. When you move to a cell, the cell is highlighted and becomes active.

<table>
<thead>
<tr>
<th>If you want to move...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>One row up or down</td>
<td>Click the arrows in the vertical scroll bar</td>
</tr>
<tr>
<td>Several values up or down</td>
<td>Click above or below the scroll box in the vertical scroll bar</td>
</tr>
<tr>
<td>A large distance</td>
<td>Drag the vertical scroll box to the approximate relative position</td>
</tr>
</tbody>
</table>

Note: The size of a vertical scroll box indicates the proportional amount of the used area of the dialog that is visible. The position of a scroll box indicates the relative location of the visible area within the dialog.

Right-Click Menu

When you right-click inside of a Property Editor window, a menu appears with some or all of the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Use this command to cut a selected object(s) from the window and place the object(s) on the Windows clipboard. <strong>Tip:</strong> You can also use the shortcut keys <strong>CTRL+X</strong> to perform the same operation.</td>
</tr>
<tr>
<td>Copy</td>
<td>Use this command to copy a selected object(s) to the Windows clipboard. <strong>Tip:</strong> You can also use the shortcut keys <strong>CTRL+C</strong> to perform the same operation.</td>
</tr>
<tr>
<td>Paste</td>
<td>Use this command to paste a selected object(s) from the Windows clipboard into the window. <strong>Tip:</strong> You can also use <strong>CTRL+V</strong> to perform the same operation.</td>
</tr>
<tr>
<td>Find</td>
<td>Use this command to search for text, specific formatting, and values.</td>
</tr>
<tr>
<td>Replace</td>
<td>Use this command to search for and replace text, specific formatting, and values. You can also search for and replace all forms of a word (for example, you can replace &quot;make&quot; with &quot;build&quot; as well as &quot;made&quot; with &quot;built&quot;).</td>
</tr>
<tr>
<td>Insert Before Row</td>
<td>Use this command to insert a row before the row that you have highlighted.</td>
</tr>
<tr>
<td>Insert After Row</td>
<td>Use this command to insert a row after the row that you have highlighted.</td>
</tr>
<tr>
<td>Insert Rows...</td>
<td>Use this command to insert multiple rows after the row that you have highlighted.</td>
</tr>
<tr>
<td>Delete Row</td>
<td>Use this command to delete a selected row from the window.</td>
</tr>
<tr>
<td>Default Row Contents</td>
<td>Use this command to insert the default content values into the row, if applicable.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delete Cell</td>
<td>Use this command to delete the contents of the cell.</td>
</tr>
<tr>
<td>Contents</td>
<td></td>
</tr>
<tr>
<td>Default Cell</td>
<td>Use this command to insert the default content values into the cell,</td>
</tr>
<tr>
<td>Contents</td>
<td>if applicable.</td>
</tr>
<tr>
<td>Sort Ascending</td>
<td>Use this command to insert the default content values into the cell,</td>
</tr>
<tr>
<td>Descending</td>
<td>if applicable.</td>
</tr>
</tbody>
</table>

Static properties, such as fonts and colors are selected from the property editor and are displayed immediately in the way they will appear during Runtime. Dynamic properties are entered via expressions which indicate how the data will appear during Runtime, see the following for details:

- Expressions Discrete
- Expressions Analog
- Expressions Data Entry
- Expressions Direct Assignment

For more details on the composition of controls, refer to the Control Example.

The following links provide related assistance.

- The Page Editor
- Customizing the Page Editor
- Working with Controls

**Pages**

**The Page Editor**

**Overview**

The Page Editor allows you to create the configuration Pages to be viewed on the unit. Visual Controls can be added and property values modified to give the operator the appropriate tools to monitor and control a process.

**What is a Page?**

**Page Editor Access**

- To edit an existing page - the page is opened by double clicking on it in the Project Explorer.
• **To create and edit a new page** - right click on the Pages heading in Project Explorer, then select New Page. Provide a name for the page and click OK. Then double click the newly created page.

The Page Editor Window

The **Page Editor** window is the heart of the configuration software and is the primary window in which you will work. The Page Editor window provides you with access to the tools and operations used to add/edit/delete controls and graphics.

The **Page Editor** and its elements are shown below. Click an element title or area on the graphic to view its description.

![Page Editor Window](image)

**Customizing the Page Editor**

Online functions, such as screen settings and referenced libraries can be modified using **Page Component Properties**.

**Tip:** **Right-click on everything.** You can’t do any damage with the right mouse button because it’s designed only to show a context menu (a list of options appropriate for the selected object). One of the options is usually Properties, which gives you access to lots of settings and information.

**Tip:** **Your mouse tells you what’s happening.** Look closely at your mouse cursor while you’re moving it around - it’s not always an arrow. For example, when you’re dragging a component, ePro Canvas gives you a clue as to what’s going to happen when you drop it depending on what’s currently underneath the cursor.

**Tip:** **Double-click everywhere.** There are many functions or property windows that open to help you complete your goals. Experiment, you won’t damage anything.

**Tip:** **Drag-and-Drop items.** Try left-clicking a component, with the left button held down move the component to where you want it. The cursor will let you know if that function can be done.
Tip: Many of the functions can be performed many different ways. You can use the **Menu bar** or the **Tool bar**, or **Right-click** the mouse, or use **short cut keys**. Experiment to see which method will work best for you.

Tip: You can resize any of the windows in ePro Canvas with your mouse. Move the mouse cursor around the edges of the windows until one of these symbols appears; ⬇️, ⬆️, ⬅️, ➔, or ➒, then **left-click** and **hold** the mouse button. Drag the window to the desired size and release the left mouse button.

Press the ➘ Back button (toolbar of your browser) to return to the previous page.

Learn more about the Title Bar

**What is a Page?**

A configuration page contains visual tools or "controls" which will serve as an operator's control panel. Below are a few aspects of a page.

- **Page Development** - The Page Editor window allows you to create pages, then add and configure controls and properties.
- **Online Page** - When transferred to an online unit, the page allows an operator to monitor and/or control a process from the unit.
- **Page Contents** - Below are examples of the page controls and the devices that they replace.

<table>
<thead>
<tr>
<th>Page Control Type</th>
<th>Conventional Devices Replaced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator/Buttons</td>
<td>Lamps, pushbuttons</td>
</tr>
<tr>
<td>Readout</td>
<td>Numeric displays, Led readouts, thumbwheels</td>
</tr>
<tr>
<td>Bar</td>
<td>Dial, faceplate</td>
</tr>
<tr>
<td>Text</td>
<td>Message display</td>
</tr>
</tbody>
</table>

**Title Bar**

The **Title Bar** is located along the top of a page window and contains the following items:

- **Application Name** - OIPageEditor.
- **Saved Page Name** - Your saved page name is displayed here. "Page 1" is the default name given to the first page created.
- **Window Control** - Minimize, Maximize/Restore Down, Close.

**Customizing the Page Editor**

Note: You can move the Page Editor window by dragging the Title bar.

Press the ➘ Back button (toolbar of your browser) to return to the previous page.
Menu Bar

The **Menu Bar** located under the title bar contains the **File, Edit, View, Layout, Draw** and **Help** menus. Each menu item displays a list of commands. Depending on the component selected in the views below the menu bar, some commands will be highlighted and others grayed out. Only highlighted commands can be executed for the selected item.

Placing the mouse cursor over any of the commands will display information in the status bar at the bottom of the screen.

**Tip:** To the right of the commands are **keyboard short cut keys.** i.e. Ctrl+C = Copy

**File**

- **Save** - save the active page to its current name and directory.
  - When you save a page for the first time, the Page Editor displays the Save As window so that you can name the page.
  - Other Access: CTRL+S; Save button on the Standard toolbar.

- **Exit** - end your Page Editor session.
  - The Page Editor prompts you to save pages with unsaved changes.
  - Other Access: ALT+F4; Close command on the application Control menu.

**Edit**

- **Undo** - reverse the last operation that you performed. For example, if you cut an object, Undo makes it re-appear.
  - There are several levels of undo (the exact number depends upon your memory resources).
  - Other Access: CTRL+Z; ALT-BACKSPACE; Undo button on the Standard toolbar.

- **Redo** - reverse the effect of the last Undo command.
  - There are several levels of redo (the exact number depends upon your memory resources).
  - Other Access: Redo button on the Standard toolbar.

- **Cut** - cut a selected object(s) from the window and place the object(s) on the Windows clipboard.
  - This command is unavailable if there is no item currently selected.
  - Cutting data to the clipboard replaces the contents previously stored there.
  - Other Access: CTRL+X; Cut button on the Standard toolbar.

- **Copy** - copy a selected object(s) to the Windows clipboard.
  - This command is unavailable if there is no item currently selected.
  - Cutting data to the clipboard replaces the contents previously stored there.
  - Other Access: CTRL+C; Copy button on the Standard toolbar.

- **Paste** - paste a selected object(s) from the Windows clipboard into the window.
• This command is unavailable if the clipboard is empty.
• Other Access: CTRL+V; Paste button on the Standard toolbar.

**Delete** - delete a selected object(s) from the window.
• This function does not place the selected object(s) in the Windows clipboard.
• Other Access: Delete button on the Standard toolbar.

**View**

**Toolbars** - show or hide the Standard and Layout toolbars.
• These toolbars include buttons for some of the most common commands found in the Page Editor, such as File/Save.
• When the Standard or Layout toolbars are visible, a check mark appears beside its menu command.

**Status Bar** - show or hide the Status bar.
• When the Status bar is visible, a check mark appears beside its menu command.

**Grid** - turn the grid on and off.
• The grid is the dotted and dashed lines which show the work area and help in aligning items on the page.
• Grid lines do not appear online.
• Upon entering a page, the grid is "on".
• Other Access: CTRL+G; Toggle Grid button on the Layout toolbar.

**Snap Points** - toggle snap points on and off.
• When "on", the snap points force the selected item to be placed in line with the grid lines.
• Upon entering the page, the snap points are "off".
• Other Access: View Snap Points button on the Layout toolbar.

**Control Bar** - show or hide the component toolbox.
• Other Access: Component Toolbox button on the Standard toolbar.

**Size** - view the page in different sizes.
• Available settings:
  • 320x240
  • 640x480
  • 800x600
  • 1024x768

**Layout**

**Align Objects** - align objects on a page in a specific fashion.
• Available options:
  • Align Left
  • Align Center
  • Align Right
• Align Top
• Align Middle
• Align Bottom
• Other Access: Align Edges button on the Layout toolbar.

**Space Evenly** - choose spacing options for the objects on a page.
• Available options:
  • Space Across
  • Space Down
• Other Access: Space button on the Layout toolbar.

**Center in View** - choose centering options for the objects on a page.
• Available options:
  • Center Vertically
  • Center Horizontally
• Other Access: Center in View button on the Layout toolbar.

**Make Same Size** - make the objects on a page the same size.
• You can select from the following options:
  • Make Same Width
  • Make Same Height
  • Make Same Size
• Other Access: Make Same Size button on the Layout toolbar.

**Properties** - view and edit an object’s properties, from the Property Editor window.
• Other Access: Property Sheet button on the Layout toolbar.

**Grid Settings** - set the specifics of the grid size and location, and snap settings.

**Draw**

**Order** - arrange the objects on a page in a specific order.
• Available options:
  • Bring to Front
  • Send to Back
  • Bring Forward
  • Send Backward
• Other Access: To Front or Back button on the Layout toolbar.

**Zoom** - magnify, or de-magnify the view of a page.
• Available options:
  • Zoom In
  • Zoom Out
  • Zoom 1:1
• Other Access: Zoom in or Out button.

**Group** - assemble objects and move them as a unit around a page, or disassemble them and move them individually around a page.

• Available options:
  • Group
  • Ungroup
  • Regroup

• Other Access: Group, Ungroup, and Regroup buttons on the Layout toolbar.

**Rotate** - rotate the objects on a page.

• Available options:
  • Free Rotate
  • Rotate Left
  • Rotate Right

• Some objects such as lines, rectangles, ellipses, and polygons can be freely rotated. Other components, such as fixed readouts, cannot be rotated.

• Other Access: Rotation field in the Property Editor; Free Rotate, Rotate Left, and Rotate Right buttons on the Layout toolbar.

**Help**

**Help Topics** - view the Page Editor online Help.

**About OI Page Editor** - display the About Page Editor window and view system information.

• Other Access: About button on the Standard toolbar.

**Customizing the Page Editor**

**Standard Toolbar**

The **Standard Toolbar** located under the menu bar contains shortcuts to common page commands. Depending on the component selected in the views below the tool bar, some commands will be highlighted and others grayed out. Only the highlighted commands can be executed on the selected item.

**Tip**: Placing the mouse cursor over any of the buttons will display information in the form of a flyover tip and information will also be displayed in the status bar at the bottom of the screen.

**Tip**: To display or hide the tool bar, select the **View** menu and select **Toolbar**.
Save

- Save the active page to its current name and directory.
  - When you save a document for the first time, the Page Editor displays the Save As window so that you can name the page.
  - Other Access: CTRL+S; Save command under the File menu.

Delete

- Delete a selected object(s) from the window.
  - This function does not place the selected object(s) in the Windows clipboard.
  - Other Access: Delete command under the Edit menu.

Cut

- Cut a selected object(s) from the window and place the object(s) on the Windows clipboard.
  - This command is unavailable if there is no data currently selected.
  - Cutting data to the clipboard replaces the contents previously stored there.
  - Other Access: CTRL+X, or the Cut command under the Edit menu.

Copy

- Copy a selected object(s) to the Windows clipboard.
  - This command is unavailable if there is no data currently selected.
  - Cutting data to the clipboard replaces the contents previously stored there.
  - Other Access: CTRL+C, or the Copy command under the Edit menu.

Paste

- Paste a selected object(s) from the Windows clipboard into the window.
  - This command is unavailable if the clipboard is empty.
  - Other Access: CTRL+V or the Paste command under the Edit menu.

Undo

- Reverse the last operation that you performed. For example, if you cut an object, Undo makes it re-appear.
  - There are several levels of undo (the exact number depends upon your memory resources).
  - Other Access: CTRL+Z or ALT-BACKSPACE or the Undo command under the Edit menu.

Redo

- Reverse the effect of the last undo command.
  - There are several levels of redo (the exact number depends upon your memory resources).
Customizing the Page Editor

NEXT> Proceed to the Layout Toolbar

Layout Toolbar

The Layout Toolbar contains buttons that provide easy access (shortcuts) to the common layout specific commands. Depending on the component selected in the views below the tool bar, some commands will be highlighted and others grayed out. Only the highlighted commands can be executed on the selected item.

Tip: Placing the mouse cursor over any of the buttons will display information in the form of a flyover tip and information will also be displayed in the status bar at the bottom of the screen.

Tip: To display or hide the tool bar, select the View menu and select Layout Bar.

Property Sheet

- View and edit the properties for the component that you have selected.
  - Other Access: Properties command under the Layout menu.

Toggle Grid

- Turn the grid on and off.
  - Other Access: CTRL+G; Grid command under the View menu.

View Snap Points

- Toggle to snap points on and off.
• Other Access: Snap Points command under the View menu.

**Zoom In or Out**

• Magnify, or de-magnify the view of a page.

  • Available options:
    • Zoom In
    • Zoom Out
    • Zoom 1:1

• Other Access: Zoom command under the Draw menu.

**Free Rotate**

• Rotate an object on a page to a degree of angle that you specify.
  
  • A popup box displays when you rotate an object, specifying the angle of the rotation.
  
  • Some objects such as lines, rectangles, ellipses, and polygons can be freely rotated. Other components, such as fixed readouts, cannot be rotated.
  
• Other Access: Rotation field in the Property Editor; Rotate/Free Rotate command under the Draw menu.

**Rotate Left**

• Rotate an object counter-clockwise 90 degrees.

• Other Access: Rotation field in the Property Editor; Rotate/Rotate Left command under the Draw menu.

**Rotate Right**

• Rotate an object clockwise 90 degrees.

• Other Access: Rotation field in the Property Editor; Rotate/Rotate Right command under the Draw menu.

**Group**

• Assemble objects and move them as a unit around a page.

  • Other Access: Group/Group command under the Draw menu.

**Ungroup**

• Disassemble objects and move them individually around a page.

  • Other Access: Group/Ungroup command under the Draw menu.

**Regroup**

• Reassemble objects and move them as a unit around a page.

  • Other Access: Group/Regroup command under the Draw menu.
Align Edges

- Align objects on a page in a specific fashion.
  - Available options:
    - Align Left
    - Align Center
    - Align Right
    - Align Top
    - Align Middle
    - Align Bottom
  - Other Access: Align Objects command under the Layout menu.

Center in View

- Choose centering options for the objects on a page.
  - Available options:
    - Center Vertically
    - Center Horizontally
  - Other Access: Center in View command under the Layout menu.

Space

- Choose spacing options for the objects on a page.
  - Available options:
    - Space Across
    - Space Down
  - Other Access: Space Evenly command under the Layout menu.

Make Same Size

- Make the objects on a page the same size.
  - Available options:
    - Make Same Width
    - Make Same Height
    - Make Same Size
  - Other Access: Make Same Size command under on the Layout menu.

To Front or Back

- Arrange the objects on a page in a specific order. You can select from the following options:
  - Available options:
Customizing the Page Editor

NEXT> Proceed to the Control Bar

Control Bar

The **Control Bar** provides the ability to easily add controls to a page. The controls are sorted alphabetically and are represented by a specific icon.

Controls can be added to the project by either double-clicking the control's icon or by "**drag-and-drop**". Double-clicking the control will generate a new control in the upper left corner of the Page Frame. When you use "drag-and-drop" the control can be placed anywhere within the page frame boundaries.

Drag-and-drop functionality provides shortcut methods for performing common tasks.

**To drag and drop:**
1. Select (highlight) the item that you want to drag and drop. (To select an item, point and click on it.)
2. Press and hold the left mouse button while you drag the item to its destination.
3. Release the mouse button to drop the item in place.

Polygons: Adding a Polygon is an exception. A Polygon is placed on the page by using the drag-and-drop method *only*, and the position at which it is dropped becomes the first point. Successive points are placed by moving to another location and clicking. Double-clicking or placing a point exactly over the first point (i.e. closing the polygon) will complete the polygon creation.
When you drag a control around in an area of the window in which the component cannot be dropped, the mouse pointer looks like this. Continue moving the mouse until the pointer changes to an arrow, which indicates the control is able to be dropped.

**Tip:** To display or hide the Control bar, select the **View** menu and select **Control bar**.

**Tip:** To change the Control bar icons from large to small by "right clicking" in the **Control bar**, and selecting **Small Icons**

**Note:** Depending on the software package that you have purchased, you may have all of the controls that appear above in the Control Bar, or a subset of those control styles.

More information on Controls

**Customizing the Page Editor**

**Page Frame**

The **Page Frame** is the development area and contains the configuration's visual controls. In the Page frame, you can add, edit, and delete controls, as well as arrange the controls on the page.

While editing the page, the following may be useful.

**What is a Page?**

Planning your Page
Page Properties
Customizing the Page Editor
What are Controls?
Working with Controls
Control Example

More information on Controls

**Creating a new page**

A new page, "Page 1" is created for you when you start the Canvas software. Other ways to create a new page are:

- **File** menu, select **New**
- **Left-click** the ☐ New icon in the toolbar
- Use the short cut keys **Ctrl+N**

When a new page is created it's default name is Page X, where X is the next available page number. It can be renamed anytime later.

The page's saved name will appear in the title bar.
Renaming a page

You can change the name of a page at any time, to do this;

In the Page Editor:

- **From the Toolbar**, select ![Name](image), change the **Name** field, press **OK**.
- Using the **Layout Menu** drop down list, select **Properties**, change the **Name** field, press **OK**.
- **Right-click** on the Page Frame, select **Properties**, change the **Name** field, press **OK**.

In Project Explorer:

- **Right-click** on the Page Name, select **Properties**, change the **Name** field, press **OK**.
- **Select** the page name, press **Alt+Enter** or press **F2**, change the **Name** field, press **OK**.

Saving a page

Save a page by:

- **File menu**, select **Save**
- **Left-click** the ![Save](image) Save icon in the toolbar
- Use the short cut keys **Ctrl+S** (save)

The page will be saved to the project.

**Note:** There is not a "Save As" option for saving the page. To rename a page, follow the "Renaming a page" link.

Opening a page

To open an existing page:

- **Double-click** the page name in the **Project Explorer** window.

Managing multiple pages

ePro Canvas allows editing more than one page at a time. Two pages can be open so that controls can be cut, copied, and pasted between the two pages. As you move controls back and forth watch the title bar because it will help keep you on track since each title bar contains its own page name.

NEXT> Proceed to the Status Bar view.

**Status Bar**

The **Status Bar** is located at the bottom of the window and displays messages and information about the current status of the application.
The left area of the status bar displays useful actions of menu items when you use the arrow keys or mouse to navigate through menus and toolbars. The right area of the status bar indicates the zoom level currently selected for the page.

- **Progress information** - This information is displayed on the left side of the status bar when you are loading, saving, and pasting an item.

- **Zoom Level** - The zoom information for the window is displayed on the right side of the status bar. Possible settings are:
  - 50%
  - 100%
  - 200%
  - 300%
  - 400%

  Tip: To zoom in or out, select Draw from the menu, then Zoom In (to increase the size of objects) or Zoom Out (to decrease the size of objects).

Note: To display or hide the status bar, click the View menu, then click Status bar.

**Customizing the Page Editor**

**NEXT> Return to the Page Editor Overview**

**Customizing the Page Editor**

The Page Editor is designed with some customization capabilities. The following are intended to simplify page editing.

**Move Menu Bars and Toolbars**

By default, all menu bars and toolbars are displayed across the top of the window. All menu bars and toolbars are dockable, which means that they can be moved to any location in the window.

**To move a menu bar or toolbar:**

1. Click the move handle located at the far left of the menu bar or toolbar.
2. Press and hold the mouse button while you drag the menu bar or toolbar to a suitable location in your window.
3. Release the mouse button to drop the menu bar or toolbar to its new location. It will remain in this new place until you move it again or close it.

**Customizing the Control Bar**

**Moving the Control Bar**

The Control bar's default location is the left-hand side of the Page Editor window. You can move the Control bar by clicking the move handle at the top of the bar and dragging it to a new location.

**Resizing the Control Bar**

You can resize the Control bar by positioning the mouse pointer over the Control bar border until the pointer changes to a double-headed arrow. Move the double-headed arrow to the left or right to resize the Control bar.

**Creating a Floating Control Bar**
You can create a floating Control bar by double-clicking the move handle at the top of the Control bar. Once you do this, the Control bar becomes detached from the Page Editor window and becomes its own independent window, complete with a title bar at the top.

**Tip:** To dock the Control bar, double-click the floating bar’s title bar.

**Viewing Small/Large Control Icons in the Control Bar**
You can view either large or small icons in the Control bar. To do this, right-click in the Control bar and select Large Icons or Small Icons.

**Resizing a Floating Control Bar**
When you select the floating Control bar, sizing handles appear at the corners and along the edges of the window. You can resize the window by dragging its sizing handles.

**Modifying Grid and Snap Settings**
When you are placing or arranging objects on a page, you can use the alignment grid for more precise positioning. When the grid is turned on, objects appear to "snap to" the dotted lines of the grid as if magnetized. You can turn this "snap to grid" feature on and off, as well as change the size of the grid cells.

In addition to defining a grid size, and whether to show or snap to the grid, a guidelines margin can be defined around the perimeter of the view, such that objects cannot be moved outside the guidelines margin.

The Grid Settings window allows you to configure grid snapping and margin/guidelines settings.

**Turning the Snap to Grid On and Off**
To turn the snap to grid on and off for the currently active view (in edit mode), complete one of the following actions:

- From the Layout toolbar, click the Toggle Grid button
- From the Layout menu, click the Grid Settings command

**Result:** The Grid Settings window appears.

**Changing the Size of the Layout Grid**
To change to size of the layout grid, complete the following steps:

1. From the Layout menu, click the Grid Settings command.
   **Result:** The Grid Settings window appears.
2. In the Spacing box, type a different width and height (in pixels) for the cells in the grid.
   **Note:** The default spacing for the grid is 10 pixels.
3. Click OK.

**Zooming In and Out of a Page**

**Using the Zoom In and Out Toolbar**
To zoom in and out of a page, complete the following steps:

1. Right-click the down arrow next to the Zoom In and Out toolbar.
   **Result:** A drop-down menu appears.
2. From the drop-down menu, click one of the following options:
   - **Zoom In**, to see a close-up view of the page
   - **Zoom Out**, to see more of the page at a reduced size
   - **Zoom 1:1**, to view the page at 100 percent.
Using the Zoom Menu Command

To zoom in and out of a page, complete the following:

1. From the Draw menu, right-click the down arrow next to the Zoom command and click one of the following options:
   - Zoom In, to see a close-up view of the page
   - Zoom Out, to see more of the page at a reduced size
   - Zoom 1:1, to view the page at 100 percent.

Open/close Toolbars and Component Views

By default, all toolbars are open and displayed on the window. You can open and close these toolbars whenever necessary.

To open a toolbar:

From the View menu, select a specific toolbar to open (open toolbars display a check mark on the left).

To close a toolbar:

From the View menu, select a specific toolbar to close (closed toolbars do not display a check mark on the left).

Online functions, such as screen settings and referenced libraries can be modified using Page Component Properties.

The following links provide related assistance.

The Page Editor

Working with Controls

Working with Properties

Page Component Properties

Similar to all components, Pages contain properties. Page properties can be modified by:

- right-clicking the name of the page in the Project Explorer, then selecting Properties
- right-clicking the background of an open page, then selecting Properties.

When the property editor opens, the controls can be edited by selecting the Property from the Tab. Page properties are listed below.

General tab

- Name property - Provide a unique name for your page.
- Description property - Add a meaningful note about the page (optional).
- Standard Navigation property - Select a location for the page selection menu.
- Page Enabled Expression property - This is an expression that allows you to select when this page is visible or not. Any expression that evaluates to a 1 or true will allow the page to be visible. The default value is 1. You can create any expression to perform any function you need.  
  i.e. create a visibility expression to make the page visible only when in maintenance mode.
- **Category** property - Create a new category by typing a new category name or use the drop down list button to select one already defined.

- **Screen Size** property - Use the drop down list button to select the screen resolution for the page you created. This can be changed at any time and it can also be changed while using the page editor.

- **Background Color** property - Use the ellipses to select an existing color or create a custom color.

- **Watermark** property - Choose an image to be a background image. The easiest way is to have the desired image in the image library then you would be able to select it by drilling down into the image library. You also can type the file name and path directly into the field. If you use this method make sure you place " before and after" the text.

- **Display** property - This property will only have any effect if you have chosen to use a watermark. Use the drop down list button to choose stretch or tile.
  - Tile - will repeat the watermark image both horizontally and vertically across the screen.
  - Stretch - will stretch the watermark image horizontally and vertically to fit the screen size.

- **Intensity** property - This property will only have any effect if you have chosen to use a watermark. Use the drop down list button to choose the desired background intensity level of light, normal, or dark.

**Master Pages Properties Tab**

**Note:** This tab contains a table which allows multiple entries

- **Page** property - The name of the Master page(s) to be displayed concurrently with the current page being edited.

- **Draw Order**
  - Front - will place the Master page on top of the current page.
  - Back - will place the Master page behind the current page.

For more details, see [Master Page](#).

**Page editor reference libraries tab**

- Page editor reference libraries property - Set up these libraries in the same manner as you would under the configurations - libraries tab. The difference is that by placing libraries here you will be able to debug certain controls from within the page editor. Link the libraries that you will use to create the page you are working on. More is discussed under the page editor help.

**Note:** Changing a client adapter’s name will automatically change the name of the client everywhere it is used in the project. This makes it easy to update all your units that might be using the client adapter. Any units where you do not want this change to happen will need to be edited manually.

**Planning your Page**

When creating a page and/or configuration, it will be helpful to keep the following in mind:

- **What size of a unit display will the page and configuration be transferred to?** The smaller unit, the fewer controls can be placed on each page, so a well planned page access scheme should be followed to reduce clutter.

- **How should pages be accessed?** Possible layouts:
  - Buttons on each page to access all other pages. This is most feasible when there are few pages, since there will need to be a button to access every page from each page.
  - A menu with buttons to access all pages, or groupings of pages. A button will be needed to access the menu page from each page. This may be convenient for configurations with many pages.
The control system can automatically call a page when the operator needs to act on that page's functions.

- Color schemes. The following should be considered when assigning colors.
  - Industry requirements for colors (ie: Red=Fault, Yellow=Caution)
  - Plant conventions (ie: Red=Off, Green=Running)
  - Color blind operators.

- Importance of page response time. The more controls that are on a page, the slower it will update. In speed critical applications it may be necessary to limit the controls on certain pages.

- Will multiple languages be utilized?
- Will the same configuration be used for different projects. If so, planning at the beginning will save future time, by considering "re-usability" of pages and libraries.
- If some of the pages have the same controls in the same locations (titles, buttons, etc.) a Master Page should be utilized.
- If the layout of some pages contain the same controls, but different data, Indexed Lists should be considered.

Online functions, such as screen settings and referenced libraries can be modified using Page Component Properties.

**Controls**

A configuration page contains visual tools or Controls that allow an operator to monitor and/or control a specific event or set of events from a unit. The page is defined by adding, modifying and deleting properties via its Property Editor window.

**What are Controls?**

**Working With Controls**

**Control Example**

A page will consist of controls from the list below.

**Note:** Depending on the software package that you have purchased, you may have all of the controls shown below, or a subset of those controls.

- **Arc**
- **Indicator Template**
- **Readout Template**
- **Bar**
- **Led**
- **Rectangle**
- **Bar Template**
- **Legend**
- **Rectangular Button**
- **Clock**
- **Line**
- **Scale**
The following “Classic” controls resemble functions/templates from earlier product versions.

<table>
<thead>
<tr>
<th>VS Bar</th>
<th>VS Control Button</th>
<th>VS Graphic</th>
</tr>
</thead>
<tbody>
<tr>
<td>VS Indicator</td>
<td>VS Message</td>
<td>VS Readout</td>
</tr>
<tr>
<td>Fixed Bar</td>
<td>Fixed Bar Trend</td>
<td>Fixed Indicator</td>
</tr>
<tr>
<td>Fixed Line Trend</td>
<td>Fixed Message</td>
<td>Fixed Readout</td>
</tr>
</tbody>
</table>

Note: You can also edit Page Controls and Properties from the Project Explorer Window (ie: without opening the Page editor). See below.

In the figure below, Page 1 is highlighted, displaying the controls on that page. Assume the rectangular button has been configured as a goto main menu button and that we want the button on all of the pages. Right-click the rectangular button, select copy, then right-click each of the pages in the pages folder, right-click and select paste. The rectangular button will be copied to each of the pages that you selected. You could have copied multiple controls and performed the same operation.

Tip: To edit control properties from this view, right-click the control and select Properties.
Component Templates

Component Templates are project components that have been saved as templates for reuse within the project. Component Templates may be created by the developer to reduce development time and provide a consistent look or style to a configuration. Any project component can be saved as a template by right-clicking on the component and selecting Create Component Template and any single page component can be saved as a template by right-clicking on it and selecting Create Template as illustrated below.
When a component is saved as a template all configured properties of that component are saved. To create a new project component from a saved template right-click on the component group, i.e. Unit, Client, Configuration, Page, etc., and highlighting Create From Template, then choosing the desired template from the resulting list of Component Templates as illustrated below.
In the Page Editor you can use saved page components by clicking on the Component Template category in the controls bar. New components created from a component template will have all initial properties set to that of the saved template. This can speed up development by allowing the user to establish the default settings of new components added to the project rather than accepting the editor defaults and having to change each new components properties to match the desired standards of the developer. Because page controls can also be saved as Component Templates the developer can take standard Canvas controls and customize them once and then use the customized controls to reduce development time and create a consistent look and feel to the project’s pages.

Some Component Templates are included in the default Project Profile to speed up initial development. They are shown below:
Because Component Templates are saved with a project just like any other project components they will not automatically be added with a New blank project or New prepackaged project. However, like all other project components they may be copied from an existing project to a new project by opening both projects in separate windows and using copy and paste, or drag and drop, to copy between the two projects.

Changing the Default Prepackaged Project

Master Page

The purpose of Master Pages is to allow you to create one or more sets of objects that can be used on multiple pages of a configuration. This enables you to more easily develop a common look and feel to a configuration, create a consistent page change methodology, and manage information and control functions that are common to many, if not all pages. The result is that there are fewer total objects in a configuration since objects that appear on Master Pages are only defined once in the editor and online. This results in .UCF files that are smaller and utilize less system memory online. It also makes it simpler for you to make changes to common page controls, since you only need to change it once on a Master Page being utilized by other pages.

Master Pages are defined in the Page Properties of every page. You can designate either no Master Page or up to three Master Pages for each page. Since there is no difference between a Master Page and a normal page, any page can be used as a Master Page for any other page and a Master Page may contain any components that can be placed on any other page, both static and dynamic. Master Pages must be added to a Configuration’s “Pages” tab like any other page and they will be accessible just like any other page in a configuration. If you do not wish to allow an online user to be able to change pages to a Master Page you should set the Page Enabled Expression for a Master Page to zero (0).

When you assign Master Page(s) to a page you also choose the draw order of Master Page components relative to the page. Each Master page’s components can be set to draw in Front (on top) or in Back (behind) of the page objects as shown in the following example:
For example if the following page were used as a Master Page for other pages, online each page would look just like any other page but the shared components would be identical on each page. (Note: this example also uses an Indexed List to change the text in the Title bar at the top of each page based on the Page ID Number)
Master Page Example
Online Example 1
Indexed Lists

Indexed Lists allows you to substitute properties of a configuration component dynamically based on the value of an index expression. This means that a page control or action can change its indication or control function online. The purpose of index lists is to reduce the number of pages needed in a configuration by allowing a single page to represent multiple unit operations or multiple diagnostic screens without changing pages by simply changing a single value that provides an index into one or more tags or expressions in a series of Indexed Lists. Simply put, indexed lists allow page components to reference lists of addresses or tags based on the value of an Index. For example a readout value can show different PLC addresses based on a PLC register that acts as an index into a list of those PLC addresses, and an indicator template may show states of a series of devices based on that same register value. Non-dynamic properties such as template titles and text controls can also show lists of string values based on an index.

An example helps to illustrate the use of Indexed Lists. The following pictures show a process that has three different unit operations called AGI Mix tanks. All tanks are fundamentally similar in terms of process inputs, outputs, status, and control functions.
Using Indexed Lists a single page may be created in ePro Canvas that represents all three Mix Tanks. A total of 24 indexed lists supports the single page’s 10 dynamic status attributes, 7 control functions (5 pushbuttons and 2 numeric entry fields) and seven text fields, including the page title and template legends. In addition, if the scales of the bar graphs needed to be dynamic because of different pressure or temperature ranges from tank to tank, they could also be changed by Indexed Lists. The two up/down pushbuttons next to the page title increment and decrement a register that goes from 0 to 1 to 2 and is the index value for all 24 indexed lists. That register is also displayed as a readout value (‘register’ + 1) in the title area of the page to indicate the Mix Tank currently being displayed and controlled.

Another example of the use of Indexed Lists is in conjunction with Master Pages. A Master Page may be created where some of the page properties, such as page title, are driven by Indexed Lists whose index is the page ID Number property, referenced online by the System Client tag CurrentPageId.

The benefits of Indexed Lists are a reduction in the number of pages, and number of objects in the configuration, which saves memory, improves performance, and simplifies configuration management by reducing the number of copies of pages and objects with different address/tag references and expressions.

Creating and Using Indexed Lists

Indexed List entries are stored in Indexed List libraries and the library needs to be linked to the Configuration like all other Canvas libraries such as Media, Color, and Action libraries. The properties of an Indexed List are shown below:
Each Indexed List has an Indexed Expression that controls the Index List Entry value online. In the above example the tag ‘Vessnum’ in device PLC1 will be used to determine which index entry on the List tab is displayed at runtime.

The items in the List tab need to define the complete property value to be evaluated at runtime. That means that if a tag is part of an expression property, such as a conditional expression in an indicator template (Eg. ‘tag1’ & !‘tag2’), or a scaled value in a readout (Eg. ‘N7:154’ * 9.5 + 32) the entire expression must be placed in the Index List.

To use an Indexed List when editing a page control’s property dialog, simply select the Indexed List entry from the Indexed List Library in the pulldown list or from the Expression Editor window. An example is shown below for the readout template showing V1FlowRate, V2FlowRate or V3FlowRate of the previous example:
Where the Legend Title also comes from an Indexed List of text strings showing "Vessel 1 Flow Rate", "Vessel 2 Flow Rate", and "Vessel 3 Flow Rate". Virtually any parameter may come from an Indexed List including Visibility Expressions, Decimal Places, Data Entry Target Expressions, Button Entry Labels and Actions, Trend Template and Bar Template Max Min Calibrations, Indicator State Expressions, Media, and Color, as well as Action properties. Properties that do not support Indexed Lists are those that are restricted to pre-populated lists in the editor, such as Operator Input Type, Indicator State Evaluation (type), and Font.

**Changing Pages Online**

**Page Changes Using Actions**

The primary method for changing pages is through an Action. There are five Actions that are built into the default Action Library named ActionSystem that can be used to control page changes. Three of them are based on the page name and the row number as it appears in the Configuration Properties Page tab as shown below.
The action named ActionGetPage generates a selectable list of all configuration pages by name. The list appears online at the top of the current page when the action is initiated. When a user touches or clicks on a page name in the list, the system changes pages to that selected page on the release or break of the touchscreen.

The action named ActionPageUp will change pages to the page named in the next row from the current page. In the example above, if the current page is the Weld Robot Controls and the ActionPageUp executes, the system will go to the Inspection Results page. The action will wrap-around so that if the current page is the last page in the configuration, it will go to the first page.

The action named ActionPageDown will change pages to the page named in the previous row from the current page. In the example above, if the current page is the Weld Robot Controls and the ActionPageDown executes, the system will go to the Process Overview page. The action will wrap-around so that if the current page is the first page in the configuration, it will go to the last page.

The other two default page change Actions are ActionHomePage and ActionPreviousPage. The first will change pages to the page defined as the Home Page in the Configuration Properties General Tab as shown below:
In the above example the page named Menu is defined as the Home Page of the Welding Line 1 configuration. Any time ActionHomePage triggers in that configuration the system will change pages to Menu. The action named ActionPreviousPage will always change pages to the page that was displayed prior to the currently displayed page. If a button that calls the ActionPreviousPage is placed on all pages in a configuration, the user will be able to go back and forth between any two pages using that button.

**User defined Goto Page Actions**

In addition to the built-in system actions for page change, the user may create Goto Page actions that will change pages to a specific page by name when executed. The following is an example of a Goto Page action that when executed will change to the page name Process Faults:

**Changing Pages by ID Number**

Another method of changing pages online is through the Page ID Number. The page ID Number property on the Page Properties General tab allows the user to assign a number to a page as shown below:
By default all pages are assigned a Page ID number of zero. You can change this number to any number you wish. In the following example a configuration has six pages with the following Page ID number assignments:

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Id Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>0</td>
</tr>
<tr>
<td>Process Overview</td>
<td>10</td>
</tr>
<tr>
<td>Weld Robot Controls</td>
<td>15</td>
</tr>
<tr>
<td>Inspection Results</td>
<td>33</td>
</tr>
<tr>
<td>Machine Diagnostics</td>
<td>22</td>
</tr>
<tr>
<td>Process Faults</td>
<td>14</td>
</tr>
</tbody>
</table>

In the default tag library TagSystem there is a System tag CurrentPageID that is automatically updated by the online system with the ID Number of the currently displayed page. If no changes are made to the default ID Number of the pages in a configuration, it will always read zero. But in the example shown above, when the configuration is running online and the current page is Weld Robot Controls, then the value in CurrentPageID will be 15.

There are several ways to change pages by Page ID Number. The first way is by using a Rectangular Button control on a page where the Type property in the General tab is set to Page Change and the target address is either a constant or a tag containing the ID Number of the page you wish to go to. In the Rectangular Button properties example shown below, pressing the button online would change pages to the page with ID Number of 33, the Inspection Results page of our example.
Of course the same result could be obtained by creating a Goto Page action that specifies the Inspection Results page by name, and then changing the button’s Type property to Trigger Action and changing the Break Action to call the Goto Page action as shown below:

Another way to change pages by Page ID Number is to write to the system tag CurrentPageID. You could do this with a numeric entry from a page control or by creating an Assignment Action set to Conditional Passthru where a PLC tag change gets written directly to CurrentPageID. When CurrentPageID is written to the system will change pages to the page with the corresponding Page ID Number. To work properly it
is required that the user make sure that the Page ID Number is unique for all pages in a configuration. The following is an example of a numeric operator entry writing to CurrentPageID:

Next is an example of a PLC tag called ‘remote_page_change’ writing to the CurrentPageID through an assignment action with Trigger Type Conditional and Condition Type Passthru. It is important to note that in order to have this action execute online it needs to be added to the Configuration Properties Actions tab:
Warning: Do NOT use Remote Page Changes in safety critical applications. If the operator has touched a button when the remote page change occurs, the page will change, however the break action resulting from the operator's release of the button will NOT occur. To avoid this situation, an alternate method is to allow the PLC to propose a page for the operator to call. This can be done using visibility to show a flashing button when the proposed PLC page is different from the current page (e.g. the Visibility Expression for the button would be RemotePageId != CurrentPageId). When the button is then visible and pressed, an action list can be executed to call the PLC page (RemotePageId) and update the CurrentPageId.

Controls

What are Controls?

The most basic job of an online ePro unit is to replace the functions of traditional hard-wired operator unit devices such as pushbuttons, lamps and message displays. Controls are visual tools, placed on a page, which replace these hard-wired devices. These controls are developed on a configuration page, and ultimately will allow an operator to monitor and/or control a process from a unit.

Controls can have static and/or dynamic parts. A static property is one that does not change online. A non-changing title string and border rectangle are examples of static controls. Dynamic properties can change during Runtime. A numeric readout or status indication are examples of controls with dynamic properties.

Additional attributes and functionality can be assigned to a control using the various libraries within the software.

Control Composition

The controls on the Control Bar have been created with re-usability of components in mind. Complex controls are combinations of simpler controls. The characteristics of the simpler controls become part of the complex control.

For more details on the composition of controls, refer to the Control Example.
Base Controls

Starting at the fundamental level, some controls are basic building blocks, or primitives. These provide the base in which all controls are built. The following controls can be used as stand-alone objects on a page.

- Arc
- Line
- Scale
- Ellipse
- Polygon
- Text
- Image
- Rectangle
- Touch Area
- Menu

Controls within Controls

Base Controls can be combined together to form other controls. Combinations of primitives and other controls are part of more complex controls like the plate control which is built from a rectangle.

- Plate
  - Rectangle

The legend control is built from the plate and the text and image controls.

Legend...

- Plate
  - Rectangle
- Text
- Image

The following are controls are made of sub-controls.

- Bar
- Led
- Readout
- Clock
- Legend
- Rectangular Button
- Indicator
- Plate
- Recipe Menu
Templates

All previous controls can be combined to form templates. For example, the Readout Template is built from legend, plate, readout, and text controls, and their sub-controls. See below.

Readout Template...

- Legend
  - Plate
    - Rectangle
  - Text
  - Image
- Plate
  - Rectangle
- Readout
  - Text Value
- Text (units)

Template controls are shown below.

For more details on the composition of controls, refer to the Control Example.

Controls

A configuration page contains visual tools or Controls that allow an operator to monitor and/or control a specific event or set of events from a unit. The page is defined by adding, modifying and deleting properties via its Property Editor window.

What are Controls?

Working With Controls

Control Example

A page will consist of controls from the list below.

Note: Depending on the software package that you have purchased, you may have all of the controls shown below, or a subset of those controls.
The following "Classic" controls resemble functions/templates from earlier product versions.
Note: You can also edit Page Controls and Properties from the Project Explorer Window (i.e., without opening the Page editor). See below.

In the figure below, Page 1 is highlighted, displaying the controls on that page. Assume the rectangular button has been configured as a goto main menu button and that we want the button on all of the pages. **Right-click** the rectangular button, select **copy**, then **right-click** each of the pages in the pages folder, **right-click** and select **paste**. The rectangular button will be copied to each of the pages that you selected. You could have copied multiple controls and performed the same operation.

Tip: To edit control properties from this view, right-click the control and select Properties.

### Working with Controls

When working with controls, the following links may be helpful.

### Which Control Do I use?

- To view **Numeric** data:
  - **Readout Template** (includes Title "Legend" and Units field)
  - **Readout**
  - **Bar Template** (includes Title "Legend", Readout, Scale and Units field)
  - **Bar**

- To view **Status** or **States**:
  - **Indicator Template** (includes Title "Legend" and Units field)
  - **Indicator**
  - **Rectangular Button** and **Legend** allow images and/or text to be displayed dynamically.

- To **Write** or Change "Bit" **Values**:
• Rectangular Button
• Control Button - selected from the "Buttons" tab of any control.

• To Write or Change "Word" Values:
• Control Data Entry - selected from the "Data Entry" tab of any control.

• To Change Pages:
  • Rectangular Button

• To draw Custom Graphics:
  • Arc
  • Ellipse
  • Image
  • Line
  • Polygon
  • Rectangle
  • Text

Adding a Control to a Page

To add a control to a page, drag the control from the Control Bar frame and drop it onto the Editor frame/page. The control can be edited/configured by either:
  • Double-clicking it, and modifying its attributes in the Property Editor window
  • Right-clicking it, selecting Properties and modifying its attributes in the Property Editor window

Note: Controls can be edited, added, or deleted to/from a page without opening the page editor by "right clicking" the page in Project Explorer. Then the page controls appear in the right pane.

Configuring/Editing a Control

Once a control has been dragged and dropped onto the page, you can configure and/or edit it. To do this, complete the following steps:

Perform one of the following actions:
  • Double-click the control
  • Right-click the control and select Properties
  • Click the control and from the Layout menu, select Properties
  • Click the control and from the Layout toolbar, select the Property Sheet icon

Result: The Property Editor window appears, so that you can modify the control’s properties.

Viewing a Control’s Properties

You can view the properties of any control on a page. To do this, complete the following steps:

Perform one of the following actions:
  • Double-click the control
  • Right-click the control and select Properties
  • Click the control and from the Layout menu, select Properties
  • Click the control and from the Layout toolbar, select the Property Sheet icon

Result: The Property Editor window appears, so that you can modify the control’s properties.

Deleting a Control
There are several ways in which you can delete a control from a page:

- Right-click the control and select **Delete**.
- Click the control, and from the **Standard** toolbar, select **Delete**.
- Click the control, and from the **Edit** menu, select **Delete**.

**Arranging Controls/Objects on a Page**

**Aligning Controls/Objects**

You can align two or more controls/objects relative to each other by their left, right, top, or bottom edges or by their centers (vertically) or middles (horizontally).

**To align objects on a page:**

1. From the **Editor** frame, press the **Shift** button on the keyboard then select the controls that you want to align. **Note:** Make sure the dominant object is the last object that you select. The final position of the group of objects depends on the position of the dominant object.

2. Perform one of the following actions:
   - From the **Layout** toolbar, select the down arrow to the right of the **Align Edges** icon, and select a specific alignment button.
   - From the **Layout** menu, select **Align Objects** and then select a specific alignment menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Align Left" /></td>
<td>Align Left</td>
<td>This button/command aligns the selected objects along their left side. <strong>Note:</strong> You can also use the short cut keys <strong>Ctrl + Left Arrow</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Align Center" /></td>
<td>Align Center</td>
<td>This button/command aligns the selected objects along their horizontal center.</td>
</tr>
<tr>
<td><img src="image" alt="Align Right" /></td>
<td>Align Right</td>
<td>This button/command aligns the selected objects along their right side. <strong>Note:</strong> You can also use the short cut keys <strong>Ctrl + Right Arrow</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Align Top" /></td>
<td>Align Top</td>
<td>This button/command aligns the selected objects along their top edges. <strong>Note:</strong> You can also use the short cut keys <strong>Ctrl + Up Arrow</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Align Middle" /></td>
<td>Align Middle</td>
<td>This button/command aligns the selected objects along their vertical center.</td>
</tr>
<tr>
<td><img src="image" alt="Align Bottom" /></td>
<td>Align Bottom</td>
<td>This button/command aligns the selected objects along their bottom edges. <strong>Note:</strong> You can also use the short cut keys <strong>Ctrl + Down Arrow</strong>.</td>
</tr>
</tbody>
</table>

**Spacing Controls/Objects Evenly**

**To space controls/objects evenly on a page:**

1. From the **Editor** frame, press the **Shift** button on the keyboard then select the controls that you want to space evenly.

2. Perform one of the following actions:
From the **Layout** toolbar, select the down arrow to the right of the **Space** icon, and select a specific spacing button.

From the **Layout** menu, select **Space Evenly** and then select a specific spacing menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Space Across" /></td>
<td>Space Across</td>
<td>This button/command spaces objects horizontally on the page.</td>
</tr>
<tr>
<td><img src="image" alt="Space Down" /></td>
<td>Space Down</td>
<td>This button/command spaces objects vertically on the page.</td>
</tr>
</tbody>
</table>

### Centering Controls/Objects

To center controls/objects on a page:

1. From the **Editor** frame, press the **Shift** button on the keyboard then select the controls that you want to space evenly.
2. Perform one of the following actions:
   - From the **Layout** toolbar, select the down arrow to the right of the **Center in View** icon, and select a specific centering button.
   - From the **Layout** menu, select **Center in View** and then select a specific centering menu item.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Center Vertically" /></td>
<td>Center Vertically</td>
<td>This button/command centers objects vertically on a page.</td>
</tr>
<tr>
<td><img src="image" alt="Center Horizontally" /></td>
<td>Center Horizontally</td>
<td>This button/command centers objects horizontally on a page.</td>
</tr>
</tbody>
</table>

### Making Controls/Objects the Same Size

To make controls/objects the same size:

1. From the **Editor** frame, press the **Shift** button on the keyboard then select the controls that you want to space evenly.
2. Perform one of the following actions:
   - From the **Layout** toolbar, select the down arrow to the right of the **Make Same Size** icon, and select a specific sizing button.
   - From the **Layout** menu, select **Make Same Size** and then select a specific sizing menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Make Same Width" /></td>
<td>Make Same Width</td>
<td>This button/command sizes objects to be the same width.</td>
</tr>
<tr>
<td><img src="image" alt="Make Same Height" /></td>
<td>Make Same Height</td>
<td>This button/command sizes objects to be the same height.</td>
</tr>
<tr>
<td><img src="image" alt="Make Same Size" /></td>
<td>Make Same Size</td>
<td>This button/command sizes objects to be the same size.</td>
</tr>
</tbody>
</table>
Ordering Controls/Objects

To set the order of controls/objects on a page:
1. From the Editor frame, select the control that you want to order.
2. Perform one of the following actions:
   - From the Layout toolbar, select the down arrow to the right of the To Front or Back icon, and select a specific ordering button.
   - From the Draw menu, select Order and then select a specific ordering menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bring to Front</td>
<td>This button/command brings an object to the front of all other objects.</td>
</tr>
<tr>
<td></td>
<td>Send to Back</td>
<td>This button/command sends an object to the back of all other objects.</td>
</tr>
<tr>
<td></td>
<td>Bring Forward</td>
<td>This button/command brings an object to the front of the object directly in front of it.</td>
</tr>
<tr>
<td></td>
<td>Send Backward</td>
<td>This button/command sends an object to the back of the object directly in back of it.</td>
</tr>
</tbody>
</table>

Grouping Controls/Objects

When you group controls/objects, you combine them so you can work with them as though they are a single object. You can rotate, resize, or scale all objects in a group as a single unit.

You can ungroup a group of objects at any time, and as long as the page is still active, you can easily regroup them by selecting any one of the objects that was previously grouped. If you move to another document or change views, you'll need to select each object and regroup them again.

Grouping functionality is intended to help you assemble a unique combination of controls/graphics for an application. That way, if you want to reuse the combination (either as-is or with minor modifications) in other configurations, you do not have to repeat your work.

To group controls/objects on a page:
1. From the Editor frame, select the Shift button on the keyboard and then click the controls that you want to group.
2. Perform one of the following actions:
   - From the Layout toolbar, select the Group, Ungroup, or Regroup icon.
   - From the Draw menu, select Group and then select a specific grouping menu command.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Group</td>
<td>This button/command groups a set of selected objects together.</td>
</tr>
<tr>
<td></td>
<td>Ungroup</td>
<td>This button/command ungroups a group of objects.</td>
</tr>
<tr>
<td></td>
<td>Regroup</td>
<td>This button/command regroups a set of objects that was previously grouped.</td>
</tr>
</tbody>
</table>
Rotating Controls/Objects

To rotate controls/objects to the left or right on a page:
1. From the Editor frame, select the control that you want to rotate.
2. Perform one of the following actions:
   - From the Layout toolbar, select the Rotate Left or Rotate Right icon.
   - From the Draw menu, select Rotate and then select Rotate Left or Rotate Right.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Free Rotate Icon]</td>
<td>Free Rotate</td>
<td>This button/command rotates the object to the degree that you specify.</td>
</tr>
<tr>
<td>![Rotate Left Icon]</td>
<td>Rotate Left</td>
<td>This button/command rotates the object counter-clockwise by 90 degrees.</td>
</tr>
<tr>
<td>![Rotate Right Icon]</td>
<td>Rotate Right</td>
<td>This button/command rotates the object clockwise by 90 degrees.</td>
</tr>
</tbody>
</table>

To free rotate controls/objects on a page:
1. From the Editor frame, select the control that you want to rotate.
2. Perform one of the following actions:
   - From the Layout toolbar, select the Free Rotate icon.
   - From the Draw menu, select Rotate and then select Free Rotate.

Note: The drag handles of the selected object turn into circles, so that you can freely rotate the object.
3. Rotate the object about its center by dragging any one of these handles.

For more details on the composition of controls, refer to the Control Example.

The following links provide related assistance.

The Page Editor

Customizing the Page Editor

Working with Properties

Control Example: Readout Template

A Readout control displays numerical values similar to readout devices on a control panel. The following is a description of the Readout Template, but is described in terms that can be related to all controls. Due to similarity in each control's properties, this is the only detailed example given for a control as it describe how all controls function.

The Control

When a Readout Template is placed on a page, it will appear similar to below.

Note: Some properties have been adjusted as follows (details on making these changes will follow):

- Data Entry has been selected and is indicated by the miniature data entry keypad in the template's upper left corner.
- A title "Speed" has been given to the template.
- The units "RPM" has been added.

The Property Editor

The Property Editor of this control can be called by double clicking the control (or right-clicking the control and selecting Properties). These properties are shown below:

The General Properties

When the properties are displayed for the control, the General Properties (ie: the General Tab), are shown. The following is an example of a readout control's Property Editor, showing the general properties, with the most notable properties indicated.
The Property Editor Window contains the Control Outline and a list of properties and values for the Readout Template. In the graphic above:

- **Readout Template** is highlighted (shown with a blue background) in the Control Outline.
- The **General** Tab is selected on the right.
- So, the Readout Template’s General properties are shown.
- And, this top level (**Readout Template**), **General** tab contains the most common properties.
- Note how the property values are reflected visually on the graphic (and the Data Entry indicator is displayed after selecting OK).

Values are changed in this or any property window by selecting and altering the value based on the type of value field.

In the above graphics, the altered property values were changed as follows:

- Data Entry was selected by the drop box arrow next to the Operator Input Type property.
- "Speed" was assigned to the Title property.
- "RPM" was assigned to the Units property.

Controls are designed with the most common properties under the General tab to minimize editing time. Below are more instructions on accessing the remainder of the properties.

**The Control Outline**

As in the graphic below, the **Control Outline** shows the composition of the selected control with all of its controls/sub-control constituents.
The outline (which was expanded by clicking on all "+" signs) shows the controls that make a Readout
Template. The four sub-controls at the next level of the outline, under Readout Template, are indicated
with lines on the graphic above.

- Readout Template
  - Legend
  - Plate
  - Readout
  - Units

Then to drill down further into the control, the Legend is made of (ie: the level of the outline under
Legend):

- Legend
  - Plate
  - Text
  - Image

And, the plate is made of:

- Plate
  - Plate Rectangle

And, so on, until the outline is filled as in the property editor graphic above.

Note: items are expanded by clicking "+" signs; contracted with "-" signs.

Note: The item selected in the Control Outline pane has it's properties shown on the right.

**Editing Sub-Control Properties**

In the preceding Control Outline pane, Readout Template was selected. Since it is selected, it's properties
are shown on the right. Similarly, if any item in the outline is selected, it's properties will be displayed.

In general, the most used properties have been moved to the General Tab. To change less common
properties, select them at their base level. For instance, to change the border highlight color on the legend
part of the control (which is the border of the rectangle sub-control of the plate sub-control of the legend
sub-control of the Readout control), select Plate Rectangle as shown below. Then select the Attributes tab to access the desired characteristics or property.

The control will change as follows...

Tip: The highest level "General" tab contains the most common properties.
Tip: Lower level "Attributes" tab is necessary to change the less common properties.

The Rest of the Properties

The following properties under the **General** Tab are specific to the Readout Template control.

- Title
- Value
- Decimal Places
- Units

In addition to the above properties, there are **Common Properties** available for all controls.

**Other Controls**

Click **Controls** to look at the properties of all the controls.
All Controls

Arc

The Arc control allows you to draw an arc, chord, or pie-shaped object on the page.

Tip: Press the Shift key while sizing to constrain the arc to a circular shape.

Arc properties

The following properties are specific to the Arc control.

Attributes tab

- Arc Style
- Foreground Color
- Background Color
- Pen Width
- Pen Style

Position/Size tab

- Starting Angle
- Ending Angle

In addition to the above properties, there are Common Properties available for all controls.

Bar

Bar properties

The following properties are specific to the Bar control.

General tab

- Value
- Max Calibration
- Min Calibration
- Orientation

In addition to the above properties, there are Common Properties available for all controls.

Bar Template
Bar controls act as the analog meters or faceplates on a component panel and indicate a value in analog fashion, with a bar graph. The bar graph can show current value, setpoint, and high and low alarm levels. The current value is displayed as an analog bar-style meter and as a digital readout.

**Bar Template properties**

The following properties are specific to the Bar Template control.

**General tab**

- Value
- Max Cal.
- Min Cal.
- Decimal Places
- Units

In addition to the above properties, there are [Common Properties](#) available for all controls.

**Ellipse**

Ellipse components allow you to place an ellipse or circle on the page.

**Ellipse properties**

The following properties are specific to the Ellipse control.

**Attributes tab**

- Foreground Color
- Background Color
- Background Style
- Pen Width
- Pen Style
- Shadow Style

In addition to the above properties, there are [Common Properties](#) available for all controls.

**Button Bar**

A Button Bar control acts as a container for multiple button controls.

**Button Bar properties**

The following properties are specific to the Button Bar control.

**General tab**
- Orientation

**Button tab**

- Name

**Button General tab (select the name of the bar sub-control in the control outline)**

- Make Label
- Make Action
- Break Label
- Break Action

In addition to the above properties, there are Common Properties available for all controls.

---

**Clock**

This control displays date and time information on a page.

**Clock properties**

The following property is specific to the Clock control.

**General tab**

- Display

In addition to the above property, there are Common Properties available for all controls.

---

**Fixed Bar**

Fixed Bar controls act as the analog meters or faceplates on a component panel and indicate a value in analog fashion, with a bar graph. The bar graph can show current value, setpoint, and high and low alarm levels. The current value is displayed as an analog bar-style meter and as a digital readout.

**Fixed Bar properties**

The following properties are specific to the Fixed Bar control.

**General tab**

- Value1
- Value2
- Units
- Decimal Places
- Max Cal.
- Min Cal.
• Decimal Places
• Units
• Cell Height

In addition to the above properties, there are Common Properties available for all controls.

Fixed Line Trend

Fixed Line Trend controls act as multi-pen analog strip charts on a component panel and indicate one or more values, over time as an analog plot.

Fixed Line Trend properties

The following properties are specific to the Fixed Line control.

General tab

• Cell Height
• Cell Width

In addition to the above properties, there are Common Properties available for all controls.

Fixed Indicator

Fixed Indicator controls are designed to act as the lights and buttons of a control panel and are used to indicate the status of devices and to control them, for example, by turning them on or off. The status may be represented as alphanumeric, or a static or blinking color, and is obtained as a digital output from a remote device (such as a PLC) or local device (such as a local database or a local memory variable).

Fixed Indicator properties

The following properties are specific to the Fixed Indicator control.

General tab

• Title
• Cell Width

States tab (select the Indicator sub-control in the control outline)

Note: This tab contains a table which allows multiple of the following entries

• Expression
• Media
• Style
• BG Color
• FG Color
• Font
In addition to the above properties, there are **Common Properties** available for all controls.

### Fixed Line Trend

Bar controls act as the analog meters or faceplates on a component panel and indicate a value in analog fashion, with a bar graph. The bar graph can show current value, setpoint, and high and low alarm levels. The current value is displayed as an analog bar-style meter and as a digital readout.

**Fixed Line Trend properties**

The following properties are specific to the Bar Template control.

**General tab**

- Cell Height
- Cell Width

In addition to the above properties, there are **Common Properties** available for all controls.

### Fixed Message

Fixed Message controls allow you to place text on the page. They are like LED or LCD message units or displays.

**Note:** The text string must be surrounded by quotes to show exact text entered. Otherwise, the entered value will be interpreted as a tag or library entry.

**Fixed Message properties**

The following properties are specific to the Fixed Message control.

**General tab**

- Name
- Cell Width

**Expressions tab**

- Message 1 Expression
- Message 2 Expression
- Message 3 Expression

In addition to the above properties, there are **Common Properties** available for all controls.

### Fixed Readout
Fixed Readout controls act as numerical readout devices and display a numeric value.

**Fixed Readout properties**

The following properties are specific to the Fixed Readout control.

**General tab**

- Title
- Value1
- Value2
- Units
- Decimal Places
- Cell Width

In addition to the above properties, there are [Common Properties](#) available for all controls.

**Fixed Table**

Fixed Table controls allow you to place text on the page. They are like LED or LCD message units or displays.

*Note: The text string must be surrounded by quotes to show exact text entered. Otherwise, the entered value will be interpreted as a tag or library entry.*

**Fixed Table properties**

The following properties are specific to the Fixed Table control.

**General tab**

- Title
- Parameters Label
- Current Value Label
- Edit Value Label
- Unit Label
- Cell Height
- Cell Width

**Entries tab**

- Parameters
- Decimal Places
- Value Expression
- Input Value Expression
- Units

In addition to the above properties, there are [Common Properties](#) available for all controls.
Image

Image Controls allow you to place a bitmap object on the page.

Note: Bitmaps are permanently added to the page after selection from a disk file with a .bmp extension.

Image properties

The following properties are specific to the Image control.

General tab

- Image

Attributes tab

- Display
- Mirror
- Invert Colors
- Brightness
- Contrast

In addition to the above properties, there are Common Properties available for all controls.

Indicator

Indicator properties

The following properties are specific to the Indicator control.

General tab

- Title

States tab

Note: This tab contains a table which allows multiple of the following entries

- Expression
- Media
- Style
- BG Color
- FG Color
- Font

In addition to the above properties, there are Common Properties available for all controls.
**Indicator Template**

Indicator controls are designed to act as the lights and buttons of a control panel and are used to indicate the status of devices and to control them, for example, by turning them on or off. The status may be represented as alphanumeric, as a static or blinking color, or as a graphic, and is obtained as a digital output from a remote device (such as a PLC) or local device (such as a local database or a local memory variable).

**Indicator Template properties**

The following properties are specific to the Indicator Template control.

**General tab**

- Title

**States tab (select the Indicator sub-control in the control outline)**

**Note: This tab contains a table which allows multiple of the following entries**

- Expression
- Media
- Style
- BG Color
- FG Color
- Font

In addition to the above properties, there are **Common Properties** available for all controls.

**Led**

Led controls provide a circular representation of discrete data. Multiple states can be assigned for both the background color (the main color of the circle) and the foreground color (the reflection).

**Led properties**

The following properties are specific to the Ellipse control.

**General tab**

- State Evaluation
- Foreground Color (the reflection color)
- Background Color

**States tab**

**Note: This tab contains a table which allows multiple of the following entries**
- Expression
- BG Color
- FG Color

In addition to the above properties, there are **Common Properties** available for all controls.

---

**Legend**

**Legend properties**

The following properties are specific to the Legend control.

**General tab**

- Title

In addition to the above properties, there are **Common Properties** available for all controls.

---

**Line**

Line components allow you to place a line object on the page.

Tip: While using this tool, press the Shift key on your keyboard to constrain the line to a 45° angle.

**Line properties**

The following properties are specific to the Line control.

**Attributes tab**

- Arrowhead
- Arrowhead Height
- Foreground Color
- Pen Width
- Pen Style

**Position/Size tab**

- Start X
- Start Y
- End X
- End Y
- Rotation

In addition to the above properties, there are **Common Properties** available for all controls.
**Menu Device**

**Menu properties**

The following properties are specific to the Menu control.

**General tab**

- 2 Touch Select
- Index Input Location
- Index Output Location
- Text Output Location

**Attributes**

- **Alignment**
- **Font**
- **Normal Text Color** - text color of non selected items
- **Selected Text Color** - text color of selected item
- **Selected Text Highlight** - background color of activated item
- **Hover Text Highlight** - background color of item when using scroll up/down in 2 touch mode
- **Normal Outline Color** - border color of non selected item
- **Selected Outline Color** - border of activated item
- **Icon Size**

**Menu Entries tab**

This tab holds the pairs of image and text that appear in the menu. Note: the Recipe control uses the Menu control as a base, but does not use these entries.

**Note: This tab contains a table which allows multiple of the following entries**

- Image
- Text

In addition to the above properties, there are **Common Properties** available for all controls.

**Plate**

**Plate properties**

There are no specific properties for the Plate control. The **Rectangle** sub-control can be accessed to change plate properties.

In addition, there are **Common Properties** available for all controls.
**Polygon**

Polygon controls allow you to place a polyline (a jagged line) or a closed polygon (multi-sided figure) on the page.

**Note:** Drawing a polygon is accomplished by selecting the icon and dragging it to the page (while holding the left mouse button down). At release of the mouse button, the first point is positioned. Move the mouse and click to the next desired point. The polygon is complete when the polygon is closed (last point on top of first point) or by double clicking for the last point.

**Polygon properties**

The following properties are specific to the Polygon control.

**Attributes tab**

- Arrowhead
- Arrowhead Height
- Foreground Color
- Background Color
- Background Style
- Pen Width
- Pen Style
- Shadow Style

**Polygon Points tab**

**Note:** This tab contains a table which allows multiple of the following entries.

- X Points
- Y Points

In addition to the above properties, there are **Common Properties** available for all controls.

**Readout**

**Readout properties**

The following properties are specific to the Readout control.

**General tab**

- Value
- Decimal Places

In addition to the above properties, there are **Common Properties** available for all controls.
Readout Template

Readout controls act as numerical readout devices and display a numeric value.

Readout Template properties

The following properties are specific to the Readout Template control.

General tab

- Title
- Value
- Decimal Places
- Units

In addition to the above properties, there are Common Properties available for all controls.

Recipe Menu

Below is an image of the Recipe Menu control which uses the Menu Device control as its base. This device is configured to hold a list of recipes which are extracted from an XML file, and contains functions which allow it to be controlled during Runtime. The following indicators provide recipe status.

- Busy LED - Dark green when idle, bright green when a recipe is being loaded, compared or saved.
- Error LED - Dark red when idle, bright red when a recipe is not loaded or a compare fails.
- Mismatch Number - The number of mismatches reported when a compare is done (0=Recipe Loaded is the same as that selected, Number=The number of differences between loaded and selected recipes).

See Recipe Development for more details.

Recipe properties

The following properties are specific to the Recipe control.

Note: The functions necessary to operate and control a recipe are built into the Recipe control, as described below in the Buttons tab. Recipe Actions are not needed unless it is desired to have customized recipe functions (for instance, a stand alone Load button).

General tab

- File Name

Note: The XML file contains the recipe data, to view XML files in Excel, Office XP, 2003 or newer is needed.

Menu Entries tab

This tab holds the pairs of image and text that appear in the menu. Note: the Recipe control uses the Menu control as a base, but does not use it's entries.

Note: This tab contains a table which allows multiple of the following entries

- Image
- Text
Buttons tab

If Operator Input Type of Button is selected, then six buttons will be pre-populated with the following built-in functions. Buttons can have titles and colors modified and can be removed, but remember that each value represents a function. So, for instance, if load is desired, make sure to keep the button with Break Action ':SYSTEM:,ButtonControlState' = 4.

<table>
<thead>
<tr>
<th>Button's Function</th>
<th>Value of ':SYSTEM:,ButtonControlState'</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>1</td>
</tr>
<tr>
<td>Scroll Up</td>
<td>2</td>
</tr>
<tr>
<td>Scroll Down</td>
<td>3</td>
</tr>
<tr>
<td>Load</td>
<td>4</td>
</tr>
<tr>
<td>Compare</td>
<td>5</td>
</tr>
<tr>
<td>Save</td>
<td>6</td>
</tr>
</tbody>
</table>

See Recipe Management Action properties, General tab for more information on the Load, Compare and Save functions.

In addition to the above properties, there are Common Properties available for all controls.

Rectangle

Rectangle controls allow you to place a rectangle object on the page.

Tip: While using this tool, press the Shift key on your keyboard to constrain the rectangle to a square.

Rectangle properties

The following properties are specific to the Rectangle control.

Attributes tab

- Foreground Color
- Background Color
- Background Style
- Pen Width
- Pen Style
- Highlight Color
- Shadow Style

In addition to the above properties, there are Common Properties available for all controls.

Rectangular Button
Rectangular Button components are touch screen buttons designed to be used for an operator’s control. Common uses are:

- to set a bit (for example, in the PLC to start and stop machinery)
- to change pages

Notes:
Rectangular button controls can display either text or graphics.
Rectangular buttons can have actions associated with both the make (press) and break (release) of the button. **Page changes** should be a result of the **Break Action** since that would be the last operation to be performed on the calling page. If the Make Action was used, then a new page would be called, and the Break Action from the calling page would be lost.

Rectangular Button properties

The following properties are specific to the Rectangular Button control.

**General tab**

- Make Label
- Make Action
- Break Label
- Break Action

In addition to the above properties, there are **Common Properties** available for all controls.

**Scale**

Scale properties

The following properties are specific to the Scale control.

**Attributes tab**

- Scale
  - Orientation
  - Placement
  - Scale Color
  - Pen Width
- Tick Marks
  - # of Major Divisions
  - # of Minor Divisions
  - Max Calibration
  - Min Calibration
  - Decimal Places
  - Tick Placement
• **Tick Values**
  • **Major Tick Values**
  • **Value Color**
  • **Font**

In addition to the above properties, there are **Common Properties** available for all controls.

---

**Text**

Text controls allow you to place text on the page. They are like LED or LCD message units or displays.

*Note: The text string must be surrounded by quotes to show exact text entered. Otherwise, the entered value will be interpreted as a tag or library entry.*

**Text properties**

The following properties are specific to the Text control.

**General tab**

• **Text**

**Attributes tab**

• **Text**
  • **Alignment**
  • **Font**
  • **Foreground Color**
  • **Background Color, BG Color**
  • **Background Style**

• **Text Frame**
  • **Pen Width**
  • **Frame Style**
  • **Foreground Color**
  • **Highlight Color**
  • **Shadow Style**

In addition to the above properties, there are **Common Properties** available for all controls.

---

**Touch Area**

**Touch Area properties**

The following properties are specific to the Touch Area control.
General tab

- Make Action
- Break Action

In addition to the above properties, there are **Common Properties** available for all controls.

**Trend Pens and Trend Template**

The Trend Pens and Trend Template controls provide a plot of one or more tags, giving a short trend of past values. Up to 16 different values can be trended.

**Trend Template properties**

The following properties are specific to the Trend Template control.

General tab

- Title

Attributes Tab (select the Trend Pens sub-control in the control outline)

- See properties below

Entries Tab (select the Trend Pens sub-control in the control outline)

- See properties below

**Trend Pens properties**

General Tab

- Trend Type - Line or Bar

Attributes Tab

- Min Calibration
- Max Calibration
- Outline Color
- Color
- Trigger Type
  - "Interval" enables the following properties
    - Trend Interval Units
    - Sample Interval
    - Max Trend Interval
  - "Discrete" or "Change" enables the following properties
    - Number of Samples
Entries Tab

**Note:** This tab contains a table which allows multiple (one per trended value) of the following entries

- Pen Color
- Value
- Pen Style
- Pen Width

In addition to the above properties, there are **Common Properties** available for all controls.

**VS Bar**

**VS Bar properties**

The following properties are specific to the VS Bar control.

**General tab**

- Value
- Max Calibration
- Min Calibration
- Orientation

In addition to the above properties, there are **Common Properties** available for all controls.

**VS Control Button**

VS Control Button components are touch screen buttons designed to be used for an operator's control. Common uses are:

- to set a bit (for example, in the PLC to start and stop machinery)
Notes:
Rectangular button controls can display either text or graphics.
Rectangular buttons can have actions associated with both the make (press) and break (release) of the button.

**Page changes** should be a result of the Break Action since that would be the last operation to be performed on the calling page. If the Make Action was used, then a new page would be called, and the Break Action from the calling page would be lost.

### VS Control Button properties

The following properties are specific to the VS Control Button.

**General tab**

- Make Label
- Make Action
- Break Label
- Break Action

In addition to the above properties, there are **Common Properties** available for all controls.

### VS Graphic

VS Graphic controls allow you to place a bitmap object on the page.

**Note:** Bitmaps are permanently added to the page after selection from a disk file with a .bmp extension.

### VS Graphic properties

The following properties are specific to the VS Graphic control.

**General tab**

- Image

**Attributes tab**

- Display
- Mirror
- Invert Colors
- Brightness
- Contrast

In addition to the above properties, there are **Common Properties** available for all controls.
VS Indicator properties

The following properties are specific to the VS Indicator control.

General tab

- Title

States tab

Note: This tab contains a table which allows multiple of the following entries

- Expression
- Media
- Style
- BG Color
- FG Color
- Font

In addition to the above properties, there are Common Properties available for all controls.

VS Message

VS Message controls allow you to place text on the page. They are like LED or LCD message units or displays.

Note: The text string must be surrounded by quotes to show exact text entered. Otherwise, the entered value will be interpreted as a tag or library entry.

VS Message properties

The following properties are specific to the VS Message control.

General tab

- Text

Attributes tab

- Text
  - Alignment
  - Font
  - Foreground Color
  - Background Color, BG Color
  - Background Style
- Text Frame
  - Pen Width
  - Frame Style
In addition to the above properties, there are **Common Properties** available for all controls.

### VS Readout

**VS Readout properties**

The following properties are specific to the VS Readout control.

**General tab**

- **Value**
- **Decimal Places**

In addition to the above properties, there are **Common Properties** available for all controls.

### Properties

**The Property Editor**

The **Property Editor** window is accessed by double clicking a control in the Page Editor (or right clicking the control in the Project Explorer). An example of the Readout Template Property Editor is shown below.

**Note:** You can also Modify Page Controls and Properties without the Page Editor from the Project Explorer Window.

In the figure below, Page 1 is highlighted, displaying the controls on that page. Assume the rectangular button has been configured as a goto main menu button and that we want the button on all of the pages. Right-click the rectangular button, select **copy**, then right-click each of the pages in the pages folder, right-click and select **paste**. The rectangular button will be copied to each of the pages that you selected. You could have copied multiple controls and performed the same operation.

**Tip:** To edit control properties from this view, right-click the control and select Properties.

### What is a Property?
All of the parameters or characteristics associated with a control. Properties can be **static**, such as Background Color, Pen Width, Font, Alignment. Or they can be **dynamic**, such as the numeric value to display, or the color or image to display for a given state.

**Working with Properties**

**Control Example**

**Property Editor Window**

The primary areas of information on each Property Editor window are described below:

- **Control Outline** - a hierarchy of controls and sub-controls that make up the control being edited.

  *Note: items are expanded by clicking "+" signs; contracted with "-" signs.*

- **Tabs** - one or more "Tabs" of information contain additional properties that define the control

- **Property** - a list of all of the property names associated with a control. Examples of properties are:
  - Background Color
  - Pen Width
  - Font
  - Alignment

  *Note: An optional column with group names to further define properties may appear on the left of the Property column.*

  *Note: The item selected in the Control Outline pane has it’s properties shown on the right.*
Note: The highest level "General" tab contains the most common properties.
Note: Lower level "Attributes" tab is necessary to change the less common properties.
Note: A "grayed" property is not available with current settings.

- **Property Value** - a column to define/assign values for each of the properties. Different types of values (text strings, library references, check boxes, etc.) results in various entry fields. See the types of value fields.

- **Property Editor Window Buttons** - the Property Editor window may have up to three buttons at the bottom of the window. Below are the possible buttons and functions:
  - **OK** - save all of the changes that you have made and close the Property Editor window.
  - **Cancel** - close the Property Editor window without saving changes that you have made.
  - **Apply** - apply all of the changes that you have made to the Property Editor window and do not close the window. Appears when changes have been made.

**List Properties**

**Control Properties**

The relationship of Controls and Properties are the key to a page. Revisit Controls for another look at Control Properties.

Press the Back button (toolbar of your browser) to return to the previous page.

**Working with Properties**

The Property Editor is designed with the following adjustment capabilities:

**Resizing the Property Editor Window**

Property Editor windows can be sized to any dimension by:
- Placing the pointer at the edge of the window (until the pointer turns into a line with arrows on each end), pressing the left mouse button and dragging up, down, left or right.
- Using the Maximize and Minimize buttons located at the upper right corner of the window
- Using the scroll bars along the right side and bottom of the window

**Scrolling to Another Part of the Property Editor Window**

To scroll to another part of the window, either:
- Drag the scroll bars back and forth or up and down
- Click the arrows next to the scroll bar

**Resizing Columns in the Property Editor Window**

In addition to sizing the window, you can size the columns by dragging the sides of each column. Place the pointer at the edge of the column (until the pointer turns into a line with arrows on each end), press the left mouse button and drag left or right.
Note: When a column is smaller than the largest viewable text in that column, the text appears with "...." at the end.

**Moving Between Cells in the Value Column**

To move between cells in the value column (the last column on the right) click any cell or use the up/down arrow keys. When you move to a cell, the cell is highlighted and becomes active.

<table>
<thead>
<tr>
<th><strong>If you want to move...</strong></th>
<th><strong>Then...</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>One row up or down</td>
<td>Click the arrows in the vertical scroll bar</td>
</tr>
<tr>
<td>Several values up or down</td>
<td>Click above or below the scroll box in the vertical scroll bar</td>
</tr>
<tr>
<td>A large distance</td>
<td>Drag the vertical scroll box to the approximate relative position</td>
</tr>
</tbody>
</table>

Note: The size of a vertical scroll box indicates the proportional amount of the used area of the dialog that is visible. The position of a scroll box indicates the relative location of the visible area within the dialog.

**Right-Click Menu**

When you right-click inside of a Property Editor window, a menu appears with some or all of the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Use this command to cut a selected object(s) from the window and place the object(s) on the Windows clipboard.</td>
</tr>
<tr>
<td><strong>Tip:</strong> You can also use the shortcut keys <strong>CTRL+X</strong> to perform the same operation.</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Use this command to copy a selected object(s) to the Windows clipboard.</td>
</tr>
<tr>
<td><strong>Tip:</strong> You can also use the shortcut keys <strong>CTRL+C</strong> to perform the same operation.</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Use this command to paste a selected object(s) from the Windows clipboard into the window.</td>
</tr>
<tr>
<td><strong>Tip:</strong> You can also use <strong>CTRL+V</strong> to perform the same operation.</td>
<td></td>
</tr>
<tr>
<td>Find</td>
<td>Use this command to search for text, specific formatting, and values.</td>
</tr>
<tr>
<td>Replace</td>
<td>Use this command to search for and replace text, specific formatting, and values. You can also search for and replace all forms of a word (for example, you can replace &quot;make&quot; with &quot;build&quot; as well as &quot;made&quot; with &quot;built&quot;).</td>
</tr>
<tr>
<td>Insert Before Row</td>
<td>Use this command to insert a row before the row that you have highlighted.</td>
</tr>
<tr>
<td>Insert After Row</td>
<td>Use this command to insert a row after the row that you have highlighted.</td>
</tr>
<tr>
<td>Insert Rows...</td>
<td>Use this command to insert multiple rows after the row that you have highlighted.</td>
</tr>
<tr>
<td>Delete Row</td>
<td>Use this command to delete a selected row from the window.</td>
</tr>
<tr>
<td>Default Row Contents</td>
<td>Use this command to insert the default content values into the row, if applicable.</td>
</tr>
<tr>
<td>Delete Cell Contents</td>
<td>Use this command to delete the contents of the cell.</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Default Cell Contents</td>
<td>Use this command to insert the default content values into the cell, if applicable.</td>
</tr>
<tr>
<td>Sort Ascending</td>
<td>Use this command to insert the default content values into the cell, if applicable.</td>
</tr>
<tr>
<td>Sort Descending</td>
<td>Use this command to sort the rows in descending order.</td>
</tr>
</tbody>
</table>

Static properties, such as fonts and colors are selected from the property editor and are displayed immediately in the way they will appear during Runtime. Dynamic properties are entered via expressions which indicate how the data will appear during Runtime, see the following for details:

Expressions Discrete
Expressions Analog
Expressions Data Entry
Expressions Direct Assignment

For more details on the composition of controls, refer to the Control Example.

The following links provide related assistance.

The Page Editor
Customizing the Page Editor
Working with Controls

**Control Example: Readout Template**

A **Readout** control displays numerical values similar to readout devices on a control panel. The following is a description of the **Readout Template**, but is described in terms that can be related to all controls. Due to similarity in each control's properties, this is the only detailed example given for a control as it describe how all controls function.

**The Control**

When a **Readout Template** is placed on a page, it will appear similar to below.

**Note:** Some properties have been adjusted as follows (details on making these changes will follow):

- Data Entry has been selected and is indicated by the miniature data entry keypad in the template's upper left corner.
- A title "Speed" has been given to the template.
- The units "RPM" has been added.
The Property Editor

The Property Editor of this control can be called by double clicking the control (or right-clicking the control and selecting Properties). These properties are shown below:

![Screenshot of Property Editor]

The General Properties

When the properties are displayed for the control, the General Properties (ie: the General Tab), are shown. The following is an example of a readout control’s Property Editor, showing the general properties, with the most notable properties indicated.
The Property Editor Window contains the Control Outline and a list of properties and values for the Readout Template. In the graphic above:

- **Readout Template** is highlighted (shown with a blue background) in the Control Outline.
- The **General** Tab is selected on the right.
- So, the Readout Template's General properties are shown.
- And, this top level (**Readout Template**, **General** tab) contains the most common properties.
- Note how the property values are reflected visually on the graphic (and the Data Entry indicator is displayed after selecting OK).

Values are changed in this or any property window by selecting and altering the value based on the type of value field.

In the above graphics, the altered property values were changed as follows:

- Data Entry was selected by the drop box arrow next to the Operator Input Type property.
- "Speed" was assigned to the Title property.
- "RPM" was assigned to the Units property.

Controls are designed with the most common properties under the General tab to minimize editing time. Below are more instructions on accessing the remainder of the properties.

**The Control Outline**

As in the graphic below, the **Control Outline** shows the composition of the selected control with all of its controls/sub-control constituents.
The outline (which was expanded by clicking on all "+" signs) shows the controls that make a Readout Template. The four sub-controls at the next level of the outline, under Readout Template, are indicated with lines on the graphic above.

- Readout Template
  - Legend
  - Plate
  - Readout
  - Units

Then to drill down further into the control, the Legend is made of (i.e.: the level of the outline under Legend):

- Legend
  - Plate
  - Text
  - Image

And, the plate is made of:

- Plate
  - Plate Rectangle

And, so on, until the outline is filled as in the property editor graphic above.

Note: items are expanded by clicking "+" signs; contracted with "-" signs.

Note: The item selected in the Control Outline pane has its properties shown on the right.

**Editing Sub-Control Properties**

In the preceding Control Outline pane, Readout Template was selected. Since it is selected, its properties are shown on the right. Similarly, if any item in the outline is selected, its properties will be displayed.

In general, the most used properties have been moved to the General Tab. To change less common properties, select them at their base level. For instance, to change the border highlight color on the legend part of the control (which is the border of the rectangle sub-control of the plate sub-control of the legend
sub-control of the Readout control), select Plate Rectangle as shown below. Then select the Attributes tab to access the desired characteristics or property.

The control will change as follows...

Tip: The highest level "General" tab contains the most common properties.
Tip: Lower level "Attributes" tab is necessary to change the less common properties.

The Rest of the Properties

The following properties under the General Tab are specific to the Readout Template control.

- Title
- Value
- Decimal Places
- Units

In addition to the above properties, there are Common Properties available for all controls.

Other Controls

Click Controls to look at the properties of all the controls.
Property Value Entry Types

The following are graphics showing various ways in which property values are entered. See below for descriptions.

- **Check Box** - Clicking the box toggles between placing an "X" to select, or removing the "X" to deselect.

- **Ellipses** - There are more options in another window, for example selecting colors from a color palette, or a font from a font properties window.

- **Up/Down Scroll** - UP arrow will increase the property value, DOWN arrow will decrease the value.

- **String** Only - Allows string entry only.

- **Drop List** - Provides a selection menu. Can be limited selections, such as Vertical or Horizontal. Or can provide access to other resources in the system, such as Configured Clients, Tag Libraries and Math Operators.

Expressions, Discrete

An expression that will evaluate to one of two states (for example, ON/OFF or True/False).

Examples of **Discrete Expressions** include:

- Indicator States - based on a machine's state, an indicator will show one status when a bit is ON, and another when the bit is OFF.

- Visibility Expression - based on the value of a bit, a control will be shown (or not shown) on a page.

- State/Style/Action - if the expression is true, a corresponding style will appear on the control.

**Discrete Expressions** will appear as in the following examples:

- 1
When the expression is set to a numeric value of 1 (no quotes), its evaluation is ALWAYS True. This is used in expressions in which a certain state is always desired. For example to always display a specific control, set its Visibility Expression to 1.

- `b3/0`
  The above example will evaluate to True when bit b3/0 is ON.

  Note: If the Client Library is set as the Default in the Unit’s properties, then the library can be omitted from the reference. Otherwise, the reference must include the library, ie: 'Lib,LibEntry'.

- `'Bit1'`
  The above example will evaluate to True when tag Bit1 is ON.

- `!'Bit1`
  The above example will evaluate to True when Bit1 is OFF, and FALSE when Bit1 is ON.

- `'ClientLib,Bit1' == 1`
  The above example will evaluate to True when Bit1 in the ClientLib library has a value of 1. Note that the expression 'ClientLib,Bit1', without the ==1, will have an identical result.

  Tip: All Client and Tag Libraries can be accessed from the drop down box to the right of the value field. For example, to select a library entry, select the type of library, then the Library Name, then the Library Entry, and 'Library Name, Library Entry' will be placed in the formula.

- `'40001' == 200`
  The above example (Equal to) will be True if register 40001 is equal to 200. This is a relational operator used for comparison purposes.

- `'40001' = 200`
  The above example (Assign) will set the value of 40001 to 200. This is a arithmetic use for assignment purposes.

  Note: In the above examples, the == (double equal signs) is used to see if the values are equal. This is different than the = (single equal sign) which will assign the value on the right to the tag on the left. Be careful!

- `'40001' > 10`
  The above example will evaluate to True when register 40001 is greater than 10.

- `'Pressure' > 250 || 'MaintenanceMode'`
  The above example (|| is a logical OR) will evaluate to True when Pressure is greater than 250, or MaintenanceMode is True.

  Tip: All logical operators can be accessed from the drop down box to the right of the value field. For example, to select a logical "or" operator, select Operators, then Logical Operators, then Logical OR, and the "||" will be placed in the formula. Used these same steps for all operators.

- `'ControlBits' & 128`
  The above example (& is a bitwise AND) will evaluate to True when the 8th bit in ControlBits is ON, regardless of the other bits.

  Notes:
  
  - Pay attention to Property Value Formats (single, double, or no quotes)

Notes:

- The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
- Click the Ellipsis button (...) to select a tag, operator, or function which is defined in a library.
- The Order of Precedence must be considered in formulas.
Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Note:
In state evaluations (ie: Indicator and Led states), expressions are evaluated as specified by the State Evaluation property.

Expressions, Analog
An expression that can have many values. Examples of Analog Expressions include:

- Readout Values - temperature, pressure, speed, etc. can be shown numerically.
- Bar Values - temperature, pressure, speed, etc. can be shown in bar graph form.

Analog Expressions will appear as in the following examples:

- 100
  A numeric expression can be set to a numeric value (no quotes). This type of entry is used in expressions in which the value will not dynamically change. For example, an Upper Limit might be set to 100, and a Lower Limit to 0. Note however, that all expressions, including limits, can be dynamic if desired.

- 'Pressure'
  The above example will show the value of tag named Pressure.

  Note: If the Client Library is set as the Default in the Unit's properties, then the library can be omitted from the reference. Otherwise, the reference must include the library, ie: 'Lib,LibEntry'.

- $B8('Pressure')
  The above example will show the formatted value of tag named Pressure. $B8('Pressure') formats the value as an 8 digit Binary number ($Bn shows n Binary digits, $Hn shows n Hex digits, $A shows an Ascii string, ... use the drop down box to get these values from the list).

  Tip: All format operators can be accessed from the drop down box to the right of the value field. For example, to select a Binary format, select Operators, then Format/Data/Time Operators, then Binary, and the $B will be placed in the formula. Use these same steps for all format operators.

- '40001' % 100
  The above example (Modulo) will divide 40001 by 100 and show the remainder. For example, if 40001 is 1234, then the expression will be 34 (ie: the remainder of 1234/100 = 12 with Remainder 34).

  Tip: All operators can be accessed from the drop down box to the right of the value field. For example, to select Modulo, select Operators, then Arithmetic Operators, then Modulo, and the % will be placed in the formula.

- 'ClientLib, Pressure'
  The above example shows the value of 'Pressure' from the library called ClientLib.

  Tip: All Client and Tag Libraries can be accessed from the drop down box to the right of the value field. For example, to select a library entry, select the type of library, then the Library Name, then the Library Entry, and 'Library Name, Library Entry' will be placed in the formula.

- $(Time)
  The above example will show the time formatted as hour:minute:sec.

  Tip: All Time and Date expressions can be accessed from the drop down box to the right of the value field. For example, to select a Time, select Operators, then Format/Data/Time Operators, then Time hour:minute:sec, and "$(Time)" will be placed in the formula. Use these same steps for all similar expressions.

- 'Tag1' ** 'Tag2'
The preceding example (Power) takes Tag1 to the power of Tag2. If Tag1 is 4 and Tag2 is 2, the result is 16.

- abs('Tag1')

The preceding example gives the absolute value of Tag1.

Notes:
- Pay attention to Property Value Formats (single, double, or no quotes)

Notes:
- The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
- Click the Ellipsis button (...) to select a tag, operator, or function which is defined in a library.
- The Order of Precedence must be considered in formulas.
- Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Press the Back button (toolbar of your browser) to return to the previous page.

**Expressions, Data Entry Target Expressions**

An expression that, when evaluated, will result in data being sent to a target location.

Examples of **Data Entry Expressions** include:
- Send a setpoint to the PLC - a number entered by the operator can be sent to a PLC location.
- Set a local value - a number can be sent to a library entry.

**Data Entry Expressions** are constructed as follows:

'DEST' = SOURCE

- 'DEST' is the destination or target location for data to be written, like 'n7:0' or 'TagName'.
- SOURCE represents an expression whose value is written to 'DEST', and can include any of the following:
  - '?' - a placeholder for the value entered by the operator. The entered value is inserted at all occurrences of '?' in the expression. The '?' will appear in all data entry expressions.
  - 'address' - a location in a PLC
  - 'tag' - a tagname from a Tag Library
  - constant - number used for scale or offset
  - operators - numeric (+,-,*,/) or binary (|,&,^,<,>,...)

The following equations are examples of target expressions:
- 'n7:0' = 'ClientSystem,?'
  The above example will send the data entered by the user to n7:0.
  Note: TagLibrary called 'TagSystem' was configured with a Tag named "?" (without quotes), then a Client called 'ClientSystem' was configured to refer to the 'TagSystem' Library.

Note: If the Client Library is set as the Default in the Unit's properties, then the library can be omitted from the reference. Otherwise, the reference must include the library, ie: 'Lib,LibEntry'.
Tip: All Client and Tag Libraries can be accessed from the drop down box to the right of the value field. For example, to select the operator's input value, select Clients, then ClientSystem, then ?, and ‘ClientSystem,?’ will be placed in the formula.

- ‘40001’ = ‘ClientSystem,?’ * 10
  The above example will multiply the data entered by the user by 10, then send the result to 40001.

- ‘PressureSetting’=’ClientSystem,?’
  The above example will send the data entered by the user to the tag named PressureSetting.

- ‘n7:0’ = (‘ClientSystem,?’ * ‘n7:1’) * ‘b3/1’ + (‘ClientSystem,?’ * ‘n7:2’) * (‘n7:2’ > 10)
  The above example is for explanation only, the table below shows some values entered by the operator (‘?’ is shown instead of ‘ClientSystem,?’ for simplicity), calculations, and resulting values sent to the destination (‘n7:0’). Note that (‘n7:2’ > 10) evaluates to 1 if ‘n7:2’ is greater than 10, otherwise evaluates to 0.

<table>
<thead>
<tr>
<th>operator input ‘?’</th>
<th>n7:1</th>
<th>b3/1</th>
<th>n7:2</th>
<th>value sent to destination ‘n7:0’</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>1</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>1</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td>0</td>
<td>20</td>
<td>60</td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td>1</td>
<td>20</td>
<td>75</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>0</td>
<td>20</td>
<td>80</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>1</td>
<td>20</td>
<td>100</td>
</tr>
</tbody>
</table>

Notes:
- Pay attention to Property Value Formats (single, double, or no quotes)
• The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
• Click the Ellipsis button (...) to select a tag, operator, or function which is defined in a library.
• The Order of Precedence must be considered in formulas.
• Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Press the Back button (toolbar of your browser) to return to the previous page.

Expressions, Direct Assignment

An expression that, when evaluated, will result in data being sent to a target location. This assignment can be placed in a Make Action or Break Action property.

Examples of Direct Assignment Expressions include:

• Send a discrete value to the PLC - a bit value can be sent to a PLC location.
• Send an analog value to the PLC - a number can be sent to a PLC location.
• Set a local value - a number can be sent to a library entry.

Direct Assignment Expressions are constructed as follows:

'LIB,DEST' = SOURCE

• 'LIB,DEST' is the destination or target location for data to be written, like 'client,n7_0' or 'plc1,TagName'. Note: The Library name must precede the Tag.
• SOURCE represents an expression whose value is written to 'DEST', and can include any of the following:
  • 'address' - a location in a PLC
  • 'tag' - a tagname from a Tag Library
  • constant - number used for scale or offset
  • operators - numeric (+,-,*,/) or binary (|,&,^,<,>,...)

The following equations are examples of target expressions:

• 'client1,b3_0' = 1
  The above example will send 1 to client1, b3_0.
• 'plc1,40001' = 'speed' * 10
  The above example will multiply the tag speed by 10, then send the result to 40001 in plc1.

Notes:

• Pay attention to Property Value Formats (single, double, or no quotes)
• Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Operators

Below is a list of available Operators, Formats, and Functions which can be used in property values. This is displayed when the drop box for a value field is selected.

Notes:
• The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
• Click the Ellipsis button (...) to select a tag, operator, or function which is defined in a library.
• The Order of Precedence must be considered in formulas.
• Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Note: In some cases, it is simpler to use the keyboard to enter a function or operator (instead of using the drop box). For example: *, +, ), etc. are readily accessible on the keyboard.

Order of Precedence

The following table is the order in which operators are evaluated, in Order of Precedence from highest to lowest. Where several operators appear together, they have equal precedence and are evaluated according to their associativity.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Type of Operation</th>
<th>Associativity</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ] ( )</td>
<td>Expression</td>
<td>Left to right</td>
</tr>
<tr>
<td>&amp; * + - ~ !</td>
<td>Unary</td>
<td>Right to left</td>
</tr>
<tr>
<td>* / %</td>
<td>Multiplicative</td>
<td>Left to right</td>
</tr>
<tr>
<td>+ -</td>
<td>Additive</td>
<td>Left to right</td>
</tr>
<tr>
<td>&lt;&lt; &gt;&gt;</td>
<td>Bitwise shift</td>
<td>Left to right</td>
</tr>
<tr>
<td>&lt; &gt; &lt;= &gt;=</td>
<td>Relational</td>
<td>Left to right</td>
</tr>
<tr>
<td>== !=</td>
<td>Equality</td>
<td>Left to right</td>
</tr>
<tr>
<td>&amp; ^</td>
<td>Bitwise-AND</td>
<td>Left to right</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bitwise-exclusive-OR</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bitwise-inclusive-OR</td>
</tr>
<tr>
<td>&amp;&amp;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>=</td>
<td>Assignment</td>
<td>Right to left</td>
</tr>
</tbody>
</table>
Parameter Passing

Parameters can be passed to Actions. This minimizes the number of Actions that are necessary by allowing re-use for similar instances. Two examples of this are shown below.

Page Change Example (Goto Page Action)

A good example of parameter passing is an Action file that is set up to call a page by passing a parameter (i.e.: the Page Name) from a Button on the page. Without parameter passing, an Action would need to be created for each page that will be called.

The following is an outline of how to create a re-usable GoToPage Action:

- Create 2 Pages, PageX and PageY.
- Create a Goto Page Action called GoToPage and set its Destination Page to #1. The #1 is a placeholder for the first parameter passed with this Action. The passed value (PageX or PageY) will replace the #1.
- Create a Rectangular Button on PageX and assign its Break Action 'GoToPage(PageY)'. By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the GoToPage action.
- Create a Rectangular Button on PageY and assign its Break Action 'GoToPage(PageX)'

The button on PageX will call PageY and vice-versa, with a single Action entry.

Notes:

- Page changes should be a result of the Break Action since that would be the last operation to be performed on the calling page. If the Make Action was used, then a new page would be called, and the Break Action from the calling page would be lost.
- #1 is used in the Action entry file as a placeholder for the first passed parameter.
- By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the GoToPage action.

Bit Write Example (Assignment Action)

Below is an example of a single Assignment Action entry used to turn a bit ON then OFF. This example allows sharing the BitChange Action for both writes.

- Create an Assignment Action called BitChange and set the first Assignment Expression to 'Bit'=#1. (Again, the #1 is where the first passed parameter will be placed.)
- Create a Page.
- Create a Rectangular Button on the Page and put 'BitChange(1)' in the Make Action field and put 'BitChange(0)' in the Break Action field. Again, the value in parentheses and within the single quotes is the parameter to be passed to the BitChange actions.

When this button is pressed, the command becomes 'Bit'=1. Similarly, when the button is released, the command becomes 'Bit'=0. This example is a momentary pushbutton.

Notes:

- This type of control should be used with caution. The response time (between the make/break and the corresponding bit writes) may not be accurate enough for time critical applications.
• #1 is used in the Action entry file as a placeholder for the first passed parameter.
• By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the BitChange action.

List Properties

List Property Editor Window

Controls with lists of properties appear with the List Property Editor Window as shown below.

Note: Control List properties are generally attached to controls that have multiple dynamic states with several characteristics each. The above example is an Indicator, which can contain multiple states (On, Off,...) with many characteristics each (On FG Color, Off FG Color, On BG Color, Off BG color, ...)

Viewing List Properties

Sometimes List Property entries can be obscured due to the limits of column widths and screen resolution. Note the ".ucf Name" column entry is not completely visible in the example below.
Adjusting the Column Width

Column width can be adjusted by placing the cursor over the column label dividers, then click and drag to the desired width. Below, the ".ucf Name" column was widened.

Viewing a Row as a Column

Alternatively, selecting the "Single Row" tab at the bottom of the window will display the currently selected row as a column.
In many cases throughout the Canvas Professional editor, complex expressions are desired, referencing tags and values from various sources. The Expression Editor provides assistance in the construction of these expressions. It is a single editor which can be used throughout the project, to enter values into any property field. See below. The editor is topped by selecting the Expression Editor button on any property window, and can remain throughout application development or can be closed or minimized. Additionally, all properties can be edited without this editor as well, by clicking in the cell or using the component tree.

**Expression Editor**

*Note: This is only available in Canvas Professional.*
To use the Expression Editor, first select the cell of a property to be changed. Then select the Expression Editor button (if the window is not currently displayed) to show the window. Now enter property values into the scratchpad area by drilling down through clients and libraries, as well as entering values manually. Once the desired string is complete, the Apply button will send the string to the selected property.

**Note:**

- Pay attention to Property Value Formats (single, double, or no quotes)

The following options can be enabled/disabled by selecting the options icon on the title bar.

**Expression Editor Options**

- **Auto-apply Enabled**
- **Auto-roll Enabled**
- **Connecton and Tag Tree Enabled**
- **Media Tree Enabled**
- **Operator Tree Enabled**
- **Miscellaneous Tree Enabled**

**Auto-apply** - If enabled, generates an Apply, thus enters data into the selected property, when the Expression Editor loses focus (ie: another window is selected).

**Auto-roll** - If selected property is supported, show the entire window, otherwise roll up to only show the title bar.

**Connection and Tag Tree** - Client and Tag Library "pane"
**Media Tree** - Media Library

**Operator Tree** - Operators

**Miscellaneous Tree** - Actions and additional libraries

**Property Value Formats and Syntax (single, double, or no quotes)**

Throughout the ePro Canvas editors and property windows, property values of various types are entered. Depending on whether the value is **Evaluated** or **Non-evaluated**, several rules must be followed to accurately enter these values. Before the rules are applied, it must be determined whether it is an evaluated property or not.

**Evaluated Properties**

Properties which can vary during Runtime, require a mathematical evaluation and parsing for proper syntax. These **Evaluated properties** entries can be dynamic, thus having an undefined number of values. It is possible and common for an evaluated property to contain an entry or expression that is not dynamic, but the property is still evaluated. In the editor, there is a simple way of determining if a property is evaluated. If a property has a pull-down arrow (🗂️) which leads to a pull-down library menu, the property is **evaluated**. In the figure below, the Value property has a pull-down arrow, and when the arrow is selected, a library menu is presented as shown below. This gives access to various references from various locations, all of which can dynamically change during runtime. So, the Value property of a Readout Template is one example of an Evaluated Property.

**Non-evaluated Properties**

Properties which contain values which cannot vary during Runtime are **NOT** evaluated. **Non-evaluated properties** are static and have a finite set of values. These property types can be determined by the properties’ type of entry - when the library menu is **not** available, the property is **non-evaluated**. For instance, fields with no pull-down arrows, Yes/No selections, and short menus are all **NOT** evaluated.
Below, the Orientation property is non-evaluated because it's pull-down arrow leads to a menu with only several options (not the entire library menu).

Evaluated Properties Syntax

Note: Using the pull-down menus to select the entry values is the easiest way to determine syntax, because quotes are automatically added when needed.

Text and Names

Double quotes are required around strings which include text and names.

- **Text Strings** that are entered directly in a **Text** property or a **Media Library Entry** will be displayed exactly as entered, and requires DOUBLE quotes
  - "Template Title"
  - "rpm"
  - "This text will appear"

Note: when referencing these media library entries, the strings are referenced with single quotes.

Note: Legal characters in text fields (i.e. characters within double quote marks, "abcedgg") include all Alpha and Numeric characters, spaces and special characters except:

<table>
<thead>
<tr>
<th>Backslash. To display a backslash within double quotes you need to place a second backslash in the string. Eg. &quot;Start \ Stop” will display as Start \ Stop</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double Quote. To display a double quote within double quotes it needs to be preceded by a backslash and must be either the first or last character in the string. Eg. &quot;\To be or not to be&quot;&quot; will display as &quot;To be or not to be&quot;&quot;</td>
</tr>
</tbody>
</table>
be”. To place double quotes in the middle of a text string you need to use text concatenation. Eg. “This is a \"Special\" + "case" will display as This is a “Special” case

Single Quote. To display a single quote within double quotes it needs to be preceded by a backslash. Eg. “This is a \Special\ case” will display as This is a ‘Special’ case

& Ampersand. To display an ampersand within double quotes you need to place a second ampersand in the string, otherwise the ampersand character serves to underline the following character within the string. Eg. “This && That” will display as This & That. Whereas the string “&T&N&T” will display as TNT

- **Images** on a Page can be directly entered (ie: not using the media library) by browsing for the image name, which will add DOUBLE quotes and double the backslash characters
  - "c:\overview.bmp"

  Note: Backslashes (\) are used to identify control characters embedded in a string. If a \ is needed inside a string with double quotes, it must be duplicated for distinction (ie: "c:\path\filename"). However, / can also be used without doubling (ie: "c:/path/filename"). Images can also be manually entered with single forward slashes
  - "c:/overview.bmp"

  Note: When Images are entered into the media library, quotes are not required.

- **Documents** entered into a View Action, Document Viewer Type, require a name in DOUBLE quotes. Again, backslashes are doubled.
  - "d:\information.html"

  Documents can also be manually entered with single forward slashes
  - "d:/information.html"

- **PLC or Library Entry Data** can be embedded into text strings as described below under the Combinations/Expressions/Concatenations heading.

**Library References**

Generally, single quotes are required around library entries. A good way to enter these is by selecting the pull-down box, and drilling down through the libraries to find the entry. Single quotes will automatically be added when needed

- Properties that contain **Clients** and **Library Entries** (Tag Library Entries, Action Library Entries, Media Library Entries, etc.) are entered with SINGLE quotes
  - 'ClientPLC,400001'
  - 'Tag'
  - 'LibEntryName'
  - 'Lib,LibEntryName'

- Active library names can be entered alternatively, using **Explicit** references to **Clients** and **Library Entries**. These are entered with SINGLE quotes. ‘MediaLib1,Ref’ can be replaced with
  - ‘:Media:,Ref’

- **Text** referenced in a text property, from Media Library entries will be enclosed in single quotes, even though the reference represents text strings (‘StartText’, ‘TextLib,StartText’).
Note: when text strings are created in media library entries, remember to place the strings in double quotes.

Note: Legal characters in tag names or Item Names (i.e. characters within single quote marks, ‘abcdefg’) include all Alpha and Numeric Characters, spaces and special characters EXCEPT:

<table>
<thead>
<tr>
<th>#</th>
<th>Casting operator</th>
</tr>
</thead>
<tbody>
<tr>
<td>@</td>
<td>Internal Client separator</td>
</tr>
<tr>
<td>,</td>
<td>Comma</td>
</tr>
<tr>
<td>=</td>
<td>Equal Sign</td>
</tr>
<tr>
<td>\</td>
<td>Backslash (Escape Character)</td>
</tr>
<tr>
<td>'</td>
<td>Single Quote</td>
</tr>
<tr>
<td>&quot;</td>
<td>Double Quote</td>
</tr>
</tbody>
</table>

**Literal Numbers**

Literal or hard-coded numbers used within evaluated properties, require NO quotes. These are evaluated because of their property type, yet are static since the value will not change during Runtime.

- **Evaluated Numeric Values** have NO quotes
  - 1
  - 98765
  - 2005

**Combinations/Expressions/Concatenations**

Expression properties follow the same rules in that references (tags, client tags, media entries) require single quotes, but constants and operators do not have quotes.

- Writes
  - ’Client,Ref’ = 1

- Comparisons
  - ’Client,Ref’ == 1

- Scaling
  - ’Client,Ref’ / 10

- To **embed data** from the PLC in a text string, i.e. to mix text and data in a text control, you must use text **concatenation**.
  - “The tank level is ” + $I4(’client1,tag1’) + ” Gallons”

If the value of tag1 is 1234, this will display ... The tank level is 1234 Gallons

When using concatenation you may embed spaces either before or after the plus character to view the string more clearly in the editor and the spaces outside single or double quotes will be discarded at runtime.

Anywhere you can place literal text (i.e. text within double quotes) you can also place media entries or tags with data type of string. Any tag references within the parentheses of the formatted data can use math or logic operators to create an expression. The following is the general formatted data syntax:

$tw.d(expression)
where ...

$ = format indicator

t = type of numeric display

  I - Integer
  H - Hexadecimal
  B - Binary
  D - Floating decimal real value
  O - Octal
  F - Fixed decimal real value
  A - Ascii

w = Total field width including decimal point, negative sign (-), and positive sign (+)
.
 = Separator between width of format and the number of decimal places (used with F format)
d = Number of decimal places (used with F format)

Format type D (floating decimal point) permits the decimal point to float in the display depending on the tag's value. This contrasts with format type F (fixed decimal point) which formats a value with a fixed decimal location.

Formatted Data Examples:

If 'client,tag1' has a value of 54321, then:

<table>
<thead>
<tr>
<th>Formatted String</th>
<th>Value Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>$I5('client1,tag1')</td>
<td>54321</td>
</tr>
<tr>
<td>$F6.2('client1,tag1' / 100)</td>
<td>543.21</td>
</tr>
<tr>
<td>$D8('client1,tag1'/100)</td>
<td>543.2100</td>
</tr>
<tr>
<td>$H4('client1,tag1')</td>
<td>D431</td>
</tr>
<tr>
<td>$O6('client1,tag1')</td>
<td>152061</td>
</tr>
<tr>
<td>$B16('client1,tag1')</td>
<td>1101010000110001</td>
</tr>
</tbody>
</table>

If 'client,tag1' has a value of 16706, which is 4142 hex (A=41 hex, B=42 hex), then:

<table>
<thead>
<tr>
<th>Formatted String</th>
<th>Value Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A('client1,tag1')</td>
<td>AB</td>
</tr>
</tbody>
</table>

If there is no additional literal text, media library text or PLC String data types to appear in the text control and you only wish to display the value of the tag you don’t need to use the formatted data syntax because the text control will automatically convert the value to a string. For example, if the text property is set to 'client1,tag1' and the value is 54321 then it will display as 54321

• ':Media:;Motor 1' + " + ':Media:;ON' + " + $I5('client1,tag1') + " amps"

Assuming the media library has two entries named 'Motor 1' and 'ON' containing their respective strings, and the tag 'client1,tag1' is a 16 bit integer (short) data type with a
value of 54321, then the preceding text property value will be displayed online as ...
Motor1  ON  54321 amps

**Non-evaluated Properties Syntax**

If it is determine that a property is **NOT Evaluated**, then there are **NO quotes required**. The majority of these are numbers and pull-down menu entries (but not pull-down library entries).

**Non-evaluated/No Quotes Examples**

- Non-evaluated values with a YES or NO value require no quotes.
- Non-evaluated values selected from a **pull-down menu** with few choices will be selected from the menu and contain NO quotes.
  - HORIZONTAL
  - VERTICAL
  
  **Note:** this does not include the pull-down library box.

- **Strings** that are not evaluated, such as a page added to a configuration, do **NOT require quotes**.
  - Page 1
- **Images** that are entered into the media library by browsing for the image path, will add a path string with NO quotes
  - c:/overview.bmp

  This entry can also be entered as
  - c:\overview.bmp

- In the **Document Viewer, Home Page** and **Document Viewer Content, Document Location** properties, NO quotes are used
  - www.eaton.com
  - d:/information.html

  - Non-evaluated **Numeric Values** have NO quotes

**Explicit Library Referencing**

Active library names can be entered alternatively, using **Explicit** references to Library Entries. Generally, this method works with library types that allow only one library per configuration. However, multiple clients are allowable in a unit, and can be accessed as shown in the table below.

The reference ‘MediaLib1,Ref’ can be restated as

- ‘:Media;:Ref’

And the reference ‘ClientSystem,?’ can be replaced with

- ‘:System;:?’

Notice how this gives flexibility since there is no tie to a specific library name, and will work with whatever the library is named in the configuration. For example, explicit references to an action library on a page allow that page to be re-used in multiple configurations, each accessing a different action library.

Here are the explicit names of each library.

<table>
<thead>
<tr>
<th>Library Type</th>
<th>Explicit Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Client</td>
<td>:System:</td>
</tr>
<tr>
<td>Unit’s 1st</td>
<td>:Client1:</td>
</tr>
</tbody>
</table>
User Defined System Tags

User defined tags may be added manually to the System Client tag file TagSystem. These tags will all have an initial value of zero and the data type may be specified or you can select the type to be "Interface Supplied" which will default to unsigned 32-bit integer. You can add a tag to the TagSystem by opening the tag file properties dialog and selecting the "Tags" tab, and then double clicking on the line labeled "Double click here to append a row". The Name is user specified as long as it is unique in the tag file, and the Definition field should be identical to the Name. The default Data Type of Interface Supplied may be changed to any of the types shown below:

| Client | | |
|---|---|
| Unit's 2nd Client | :Client2: |
| ... | |
| Unit's Nth Client | :ClientN: |
| Media | :Media: |
| Color | :Color: |
| Action | :Action: |
| Indexed List | :Indexed: |
| Secure User | :SecureUser: |
| Security Device | :SecurityDevice: |
| Security Group | :SecurityGroup: |
| Archive | :Archive: |
You can also add a tag by selecting the TagSystem library in the Project Components pane of Project Explorer, then right-click in the Component Data pane and select New Tag Library Entry.

User defined system tags will not change value at runtime unless the user configures a function that writes to those tags. They may be written to from a pushbutton or button bar function, from a data entry function, or from an Assignment Action. If the user configures a Conditional Passthru Assignment Action a user defined system tag can be updated from the PLC through an OPC Server client connection.

User defined system tags may be useful for a number of purposes. Their value can be toggled by a pushbutton to control conditional visibility of page objects, or a system tag may be used in place of a PLC register for storage of the configuration’s Active Language ID. A system tag may also be used as an index to one or more Indexed Lists. There are many more uses of user defined system tags and in general they can be used for local functions that will reduce the requirement of Operator Interface specific registers in the PLC. Note however that unlike PLC registers, system tags are not persisted values, which means that system tags will be set back to their default value of zero at each reboot of the ePro. This may limit some of the uses to which you would apply user defined system tags.

**All Properties**

**# of Horizontal Divisions**

The number of horizontal lines displayed on the trend grid.
Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a library entry

**# of Vertical Divisions**

The number of vertical lines displayed on the trend grid.

Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a library entry

**# of Minor Divisions**

The number of minor scale tick marks on the scale. Minor divisions are indicated with shorter tick lines than major divisions, and no numeric scale value.

Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a library entry

**# of Major Divisions**

The number of major scale tick marks to appear between the max. and min. extremes on the scale. Major divisions are shown with longer tick lines (than minor divisions) and numeric scale values.

Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a combination of library entries and formulas

**2 Touch Select**

This setting allows the menu item to be activated by one or two touches.

Field Entries:
• On - 2 touch mode - this allows the Scroll Up and Scroll Down functions to be used to move through the menu items without selecting the item until the item is touched. This is handy when there are more items in the menu than are visible.

• Off - 1 touch mode - immediate activation of menu item when Scroll Up and Scroll Down or touching the item.

To change:
• Click on the On/Off value to toggle it.

**Alignment**

The horizontal text alignment for the control.

Field Entries:
• Left
• Center
• Right

To change:
• Use the drop down button and select from the drop list

**Arc Style**

The type of arc to be displayed.

Field Entries:
• Arc - part of circumference
• Chord - part of circumference, with a line connecting the start and end points
• Wedge - pie shape

To change:
• Use the drop down button and select from the drop list

**Arrowhead**

The type of line end.

Field Entries:
• {-----} None
• {-->}
• {<--}
• {<-->} Both

To change:
• Use the drop down button and select from the drop list

**Arrowhead Height**

Selects the height of the arrowhead.

Field Entries:
• Number
To change:

- Type a value
- Use the Up and Down arrow buttons to change the value by 1 point increments

**Background (BG) Color**

The background color for the control or sub-control.

Field Entries:

- Color

To change:

- Click the Ellipsis button (…) to call the Color window, then select a color (or define a custom color) for the background.

**Background Style**

The line pattern used in conjunction with the background color to fill a control or sub-control.

Field Entries:

- None
- Horizontal
- Vertical
- Forward Diagonal
- Backward Diagonal
- Cross
- Diagonal Cross

To change:

- Use the drop down button and select from the drop list

**Note:** for Text controls, the line color of the style will be the same as the Text Frame's Foreground Color. However, for all other controls, the line color of the style will be the same as the Foreground Color, which is also the color of the control's border.

**Break Action**

The text string to be displayed when the control button is released.

**Note:** Identical Names are not allowed as text strings.

Field Entries:

- Text string in double quotes (ie: "This text will appear").
- A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,TextEntry' will display the value of TextEntry from the library called MediaLibrary).

To change:

- Type an entry.
- Use the drop down button to select a library entry.

**Break Label**

The text string to be displayed when the control button is released.
Note: Identical Names are not allowed as text strings.

Field Entries:
  - Text string in double quotes (ie: "This text will appear").
  - A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,TextEntry' will display the value of TextEntry from the library called MediaLibrary).

To change:
  - Type an entry.
  - Use the drop down button to select a library entry.

Brightness

The value indicating how bright a control is. Primarily used in Image controls.

Cancel On Entry

This setting provides the status of the operator input device during Runtime.

Field Entries:
  - Yes - Remove operator input device (numeric entry, button entry) when operator keys data and presses enter.
  - No - Leave the operator input device after operator keys data and presses enter. It will be removed when somewhere on the page is touched.

To change:
  - Click on the Yes/No value to toggle it.

Cell Height

The control's vertical size, based on the following:
  - Cell Height = 1 ---> 96 pixels
  - Cell Height = 2 ---> 208 pixels
  - Cell Height = 3 ---> 320 pixels

Field Entries:
  - Number

To change:
  - Type a number
  - Use the Up and Down arrow buttons to change the position by 1 point increments

Cell Width

The control's horizontal size, based on the following:
  - Cell Width = 1 ---> 96 pixels
  - Cell Width = 2 ---> 200 pixels
  - Cell Width = 3 ---> 304 pixels
  - Cell Width = 4 ---> 408 pixels
  - Cell Width = 5 ---> 512 pixels
Field Entries:
- Number

To change:
- Type a number
- Use the Up and Down arrow buttons to change the position by 1 point increments

Common Properties

The following properties are available for all controls.

General tab

Note: In controls that are made of several base controls, the most used properties of the base controls are moved to the General tab.

- Name
- Description
- Visibility Expression
- State/Style/Action
- Operator Input Type
- Operator Input Indicator
- Entry
- Cancel On Entry

Data Entry tab

Note: The following properties are hidden unless Data Entry is selected as the Operator Input Type in the General Tab.

- Data Entry Type
- Target Expression
- Upper Limit
- Upper Limit Violation Action
- Log Upper Limit Violation
- Lower Limit
- Lower Limit Violation Action
- Log Lower Limit Violation

Buttons tab

Note: This tab contains a table which allows multiple of the following entries.

Note: The following properties are hidden unless Button is selected as the Operator Input Type in the General Tab.

- Make Label
- Make Action
- Break Label
- Break Action
• Make Font
• Make FG Color
• Make BG Color
• Make BG Style
• Break Font
• Break FG Color
• Break BG Color
• Break BG Style

Position/Size tab

Note: Few controls have other positioning and sizing properties which are described with that control.

• Position X
• Position Y
• Width
• Height
• Rotation

Note: Rotation is ONLY available in base controls (lines, ellipses, rectangles, etc.)

Contrast

The value indicating the control's contrast. Primarily used in Image controls.

Data Entry Type

The format of the entry which determines the type of entry method to be used for this control.

Field Entries:

• Alpha-Numeric - in runtime, a compact, on-screen keypad is topped, allowing entry of alpha and/or numeric values. Function keys provide access to all keys, as the keys are shared for multiple letters/numbers.
• QWERTY - in runtime, a full QWERTY style, on-screen keypad is topped, allowing a full entry of alpha and/or numeric values.
• Keyboard - in runtime, an entry field is displayed, allowing data entry from an external keyboard.
• Numeric - in runtime, an on-screen keypad is topped, allowing entry of only numeric values.
• Additional devices that are available will appear in the list also.

To change:

• Use the drop down button and select from the drop list

Decimal Places

The number of decimals to allocate and display in a numeric value.

Field Entries:

• Number
To change:
- Type a number
- Use the Up and Down arrow buttons to change the value by 1 decimal place increments

**Description**

A short (optional) description of the control.

*Note: Identical Names are not allowed as text strings.*

**Display**

The appearance of an image in an Image control.

Field Entries:
- Stretch - expand or shrink the image to fit the bounding rectangle
- Tile - show in actual size, but show multiple copies if the bounding rectangle is large enough

To change:
- Use the drop down button and select from the drop list

**Display (Clock)**

The information to appear in the Clock control.

Field Entries:
- Date Time - shows date to the left of time
- Time Date - shows time to the left of date
- Date - shows date only
- Time - shows time only

*Note: Specific formats for the date and time display are taken from the unit running the online configuration.*

To change:
- Use the drop down button and select from the drop list

**End X**

The horizontal (X coordinate) position of the endpoint of the line on the page, in pixels.

*Note: X,Y coordinates 0,0 represent the upper left corner.*

Field Entries:
- Number

To change:
- Type a number
- Use the Up and Down arrow buttons to change the position by 1 point increments

**End Y**

The vertical (Y coordinate) position of the endpoint of the line on the page, in pixels.

*Note: X,Y coordinates 0,0 represent the upper left corner.*
Field Entries:

- Number

To change:

- Type a number
- Use the Up and Down arrow buttons to change the position by 1 point increments

**Ending Angle**

The degree of an arc’s ending angle.

**Notes:**

- $0^\circ$ is to the right, $90^\circ$ is straight down, $180^\circ$ to the left, $270^\circ$ is straight up.
- Clockwise is the positive (+) direction.

To change the value in this field:

- Type a number
- Use the Up and Down arrow buttons to change the value in 1 degree increments

**Entry**

A library entry which will occur when the corresponding State/Style/Action is true.

**Note:** To enable this field, select Style Library Entry on the Operator Input Type field.

Field Entries:

- Library Entry

To change:

- Use the drop down button to select an entry from the library.

**Expression/Target Expression**

Indicates how the data will appear (or where data will be sent) online. Dynamic properties are entered via expressions - see the following for details.

Field Entries:

- Number or library entry as described in:
  - Expressions, Discrete
  - Expressions, Analog
  - Expressions, Data Entry
  - Operators

To change:

- Enter expression using single quotes around ?, tags, and library entries
- Use the drop down button to select and add a library entry

**File Name**

The name of the recipe xml file, which is used to populate the recipe menu control.

**Note:** Identical Names are not allowed as text strings.
Field Entries:

- Text string in double quotes (ie: "c:\\Recipe1.xml").
- A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,RecipeName' will get the recipe name from RecipeName in MediaLibrary).

To change:

- Type an entry.
- Use the drop down button to select a library entry.

**Font**

The font attributes for the control or sub-control.

Field Entries:

- Font Name

To change:

- Click the Ellipsis button (…) to call the Font window, then select and change attributes such as font type, font style, and font size.

**Foreground (FG) Color**

The foreground color for the control or sub-control.

Field Entries:

- Color

To change:

- Click the Ellipsis button (…) to call the Color window, then select a color (or define a custom color) for the foreground.

**Frame Style**

The frame style for the control or sub-control frame.

Field Entries:

- Normal
- 3D
- Highlight Bottom/Rt.
- Highlight Top/Left
- Rounded

To change:

- Use the drop down button and select from the drop list

**Grid Axis Color**

The color of the horizontal and vertical axes in the trend area.

Field Entries:

- Color

To change:
- Click the Ellipsis button (...) to call the Color window, then select a color (or define a custom color) for the background.

**Grid Color**

The background color of the trend area.
Field Entries:
- Color
To change:
  - Click the Ellipsis button (...) to call the Color window, then select a color (or define a custom color) for the background.

**Grid Outline Color**

The color of the border of the trend area.
Field Entries:
- Color
To change:
  - Click the Ellipsis button (...) to call the Color window, then select a color (or define a custom color) for the background.

**Grid Values**

The selection for showing or not showing the vertical grid labels (ie: scale numbers).
Field Entries:
- Yes - show the labels
- No - do not show labels
To change:
  - To toggle Yes/No, click the property entry area.

**Grid Values Color**

The color for text values (scale and time/date) around the trend area.
Field Entries:
- Color
To change:
  - Click the Ellipsis button (...) to call the Color window, then select a color (or define a custom color) for the value.

**Grid Values Font**

The font attributes for text values (scale and time/date) around the trend area.
Field Entries:
- Font Name
To change:
Click the Ellipsis button (…) to call the Font window, then select and change attributes such as font type, font style, and font size.

**Height**

The control's vertical (Y coordinate) size, in pixels.

Field Entries:
- Number

To change:
- Type a number
- Use the Up and Down arrow buttons to change the position by 1 point increments

**Highlight Color**

The highlight color for the control or sub-control.

*Note: the color is visible only when a Frame Style with a highlight is selected.*

Field Entries:
- Color

To change:
- Click the Ellipsis button (…) to call the Color window, then select a color (or define a custom color) for the highlight.

**Icon Size**

The size of the icon to be displayed in the control.

Field Entries:
- Small - 16X16 pixels
- Medium - 32X32 pixels
- Large - 48X48 pixels

To change:
- Use the drop down button and select from the drop list

**Image (Name)**

The name of the image to be displayed.

Field Entries:
- Media Library Entry
- Direct Entry (ex: "c:\\images\\image.bmp")

To change:
- Use the drop down button to select a library entry

**Index Input Location**
The index in the menu is selected by assigning a value to this reference. Setting this reference to 0 selects the top item, 1 selects the next and so forth.

Field Entries:
- Client or Tag Library entry

To change:
- Enter expression using single quotes around tags, and library entries
- Use the drop down button to select and add a library entry

**Index Output Location**

The index of the currently activated menu selection is sent to this reference. The top item is 0, the next is 1 and so forth.

Field Entries:
- Client or Tag Library entry

To change:
- Enter expression using single quotes around tags, and library entries
- Use the drop down button to select and add a library entry

**Invert Colors**

The selection for showing the reverse, or negative of the colors.

Field Entries:
- Checkbox selected - show the reverse
  - Checkbox NOT selected - show the normal image

To change:
- To invert the colors, click the checkbox; To remove inversion, click checkbox again.

**Log Lower Limit Violation**

The setting which indicates whether to log the lower limit violations or not. Violations are logged in the System Event Viewer window.

Field Entries:
- Yes - Log violations
  - No - Do Not log violations

To change:
- To toggle the setting, click the field; To toggle again, click field again.

**Log Upper Limit Violation**

The setting which indicates whether to log the upper limit violations or not. Violations are logged in the System Event Viewer window.

Field Entries:
- Yes - Log violations
  - No - Do Not log violations

To change:
• To toggle the setting, click the field; To toggle again, click field again.

**Lower Limit**

The smallest value that can be entered by the operator (and sent to the target expression's location).

Field Entries:
- Number
- Library entry as described in Expressions, Analog

To change:
- Type a value
- Use the drop down button to select a combination of library entries and formulas

**Lower Limit Violation Action**

The action to be taken when data entered by the operator is lower than the Lower Limit.

Field Entries:
- Reenter - The user is prompted to reenter a value in the data entry area.
- Apply Lower Limit - The lower limit value is applied and written to the PLC.

To change:
- Use the drop down button and select from the drop list

**Major Tick Values**

The selection to show or hide scale values.

Field Entries:
- Enabled Checked - Show scale values.
- Enabled NOT Checked - Hide scale values.

To change:
- To toggle the property, click the checkbox; To toggle again, click checkbox again.

**Make Action**

The action to occur when the user presses the control’s button.

Field Entries:
- Action Library Entry
- Entry as described in Expressions, Data Entry for direct assignment, ie: PLC writes

To change:
- Enter expression using single quotes around tags, and library entries
- Use the drop down button to select and add a library entry

**Make Label**

The text string to be displayed when the control button is pressed.

*Note: Identical Names are not allowed as text strings.*
Field Entries:

- Text string in double quotes (ie: "This text will appear").
- A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,TextEntry' will display the value of TextEntry from the library called MediaLibrary).

To change:

- Type an entry.
- Use the drop down button to select a library entry.

**Max Calibration**

The highest point displayed by the scale. This value displays on the top of the scale.

Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a combination of library entries and formulas

**Max Trend Interval**

The number of points (or updates) shown on the trend. This is the quantity of data displayed for Interval triggered trends. For instance, if this value is set at 10, the last 10 updates will span the trend area.

Field Entries:

- Number
- Library entry as described in Expressions, Analog

To change:

- Type a value
- Use the drop down button to select a combination of library entries and formulas

**Message Expression**

An expression which points to a message in the PowerPro Media Library.

**Min Calibration**

The lowest point displayed by the scale. This value displays on the bottom of the scale.

- Field Entries:
  - Number
  - Library entry as described in Expressions, Analog

- To change:
  - Type a value
  - Use the drop down button to select a combination of library entries and formulas

**Mirror**
The selection for flipping the control along the vertical axis.

Field Entries:
- Checkbox selected - show the flipped image
- Checkbox NOT selected - show the normal image

To change:
- To mirror the image, click the checkbox; To remove mirroring, click checkbox again.

**Name**

The name of the control, which is generally used as a title.

*Note: Identical Names are not allowed as text strings.*

Field Entries:
- Text string in double quotes (ie: "This text will appear").
- A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,TextEntry' will display the value of TextEntry from the library called MediaLibrary).

To change:
- Type an entry.
- Use the drop down button to select a library entry.

**Name, Button Bar**

The list of Buttons to be placed on the bar.

*Note: Identical Names are not allowed as text strings.*

To add a new button, double-click at the bottom of the Name list (on the Button tab).

To edit the buttons,

**Number of Samples**

The number of points (or updates) shown on the trend. This is the quantity of data displayed for variable triggered (Discrete or Change) trends. For instance, if this value is set at 10, the last 10 updates will span the trend area. Note: this data may not give a desired historical perspective, ie: the triggering is not based on time.

Field Entries:
- Number
- Library entry as described in Expressions, Analog

To change:
- Type a value
- Use the drop down button to select a library entry

**Operator Input Indicator**

Selection for the position of the operator input type on the control.

Field Entries:
- Top – Left
- Top – Middle
• Top – Right
• Left – Middle
• Right - Middle
• Bottom - Left
• Bottom – Middle
• Bottom - Right

To change:
• Use the drop down button and select from the drop list

**Note:** to enable this property, an Operator Input Type must be selected.

### Operator Input Type

The operator input type for the control. Selecting an operator input type enables the fields for setting up operator input (such as, write's to the PLC).

**Field Entries:**
- None - No operator input type is displayed on the component.
- Style Library Entry - Enables the Entry field on the General tab and allows selecting an Entry from the Style library.
- Data Entry - Allows setup of the Data Entry functions to allow operator input on this control. When selected, the fields on the Data Entry tab are enabled.
- Button - Allows setup of button control functions on this control. When selected, the fields on the Button Entry tab are enabled.

To change:
• Use the drop down button and select from the drop list

### Orientation

The direction of the control.

**Field Entries:**
- Vertical
- Horizontal

To change:
• Use the drop down button and select from the drop list

### Pen Style

The type of line used for the control.

**Field Entries:**
- Solid
- Dash
- Dot
- Dash-Dot
- Dash-Dot-Dot
To change:
  • Use the drop down button and select from the drop list

**Pen Width**

The thickness of the line used for the control.

Field Entries:
  • Number

To change:
  • Type a value
  • Use the Up and Down arrow buttons to change the value by 1 point increments

**Placement**

Tick mark's location on the scale.

*Note: Placement depends on whether the scale is horizontal or vertical.*

Field Entries:
  • Left/Top
  • Right/Bottom

To change:
  • Use the drop down button and select from the drop list

**Position X**

The control's horizontal (X coordinate) position on the page, in pixels.

*Note: X,Y coordinates 0,0 represent the upper left corner.*

Field Entries:
  • Number

To change:
  • Type a number
  • Use the Up and Down arrow buttons to change the position by 1 point increments

**Position Y**

The control's vertical (Y coordinate) position on the page, in pixels.

*Note: X,Y coordinates 0,0 represent the upper left corner.*

Field Entries:
  • Number

To change:
  • Type a number
  • Use the Up and Down arrow buttons to change the position by 1 point increments

**Rotation**
The rotation of the control, in degrees.

Notes:
- 0° is to the right, 90° is straight down, 180° to the left, 270° is straight up.
- Clockwise is the positive (+) direction.

To change the value in this field:
- Type a number
- Use the Up and Down arrow buttons to change the value in 1 degree increments

Sample Interval

The trend update rate. For instance, if this value is set at 3 and the Trend Interval Units is set to Hours, then the trend will update every 3 hours.

Field Entries:
- Number
- Library entry as described in Expressions, Analog

To change:
- Type a value
- Use the drop down button to select a library entry

Scale Color

The color of the scale tick marks.

Field Entries:
- Color

To change:
- Click the Ellipsis button (…) to call the Color window, then select a color (or define a custom color) for the scale.

Shadow Style

The shadow style for the control's frame.

Field Entries:
- None
- Top/Left
- Bottom/Right
- Bottom/Left
- Top/Right

To change:
- Use the drop down button and select from the drop list

Start X

The horizontal (X coordinate) starting position of a line on the page, in pixels.

Note: X,Y coordinates 0,0 represent the upper left corner.
Field Entries:

- Number

To change:

- Type a number
- Use the Up and Down arrow buttons to change the position by 1 point increments

**Start Y**

The vertical (Y coordinate) starting position of a line on the page, in pixels.

*Note: X,Y coordinates 0,0 represent the upper left corner.*

Field Entries:

- Number

To change:

- Type a number
- Use the Up and Down arrow buttons to change the position by 1 point increments

**Starting Angle**

The degree of an arc’s starting angle.

**Notes:**

- $0^\circ$ is to the right, $90^\circ$ is straight down, $180^\circ$ to the left, $270^\circ$ is straight up.
- Clockwise is the positive (+) direction.

To change the value in this field:

- Type a number
- Use the Up and Down arrow buttons to change the value in 1 degree increments

**State Evaluation**

Selection which chooses how logic will be evaluated for the given control. In cases where multiple states can be defined (i.e. Indicator and Led states), the following setting determines the criteria used to determine the true state.

Field Entries:

- Mutual Exclusion – state is determined by the last updated value which is part of a true state expression. Values are constantly updated, thus state expressions are constantly evaluated. It is possible that more than one state is true at any time. This should be avoided by using plc or state logic to ensure only one state at a time is true (i.e. this selection is intended for states that are mutually exclusive). Multiple states may be executed, however the state expression which contains the last triggered tag value will be visible.

- If..Then..ElseIf – state is determined by the first true expression, starting from the top. As soon as a state expression in the list is evaluated as true, the evaluation stops. Only the topmost true state will be shown. When any tag in any state expression changes, the list is re-evaluated form the top. States should be prioritized in the list accordingly.

*Note: If there are no defined states and only a constant 1 for the last state of an IfThenElse indicator, the colors don’t always initialize/draw correctly. A workaround is to create a tag in the PLC that is always set to a 0 with a tag name of undef, then create 3 states where state 1 is ‘Client,undef’, 2 is !’Client,undef’, and state 3 is 1 for bad data indication. Have the color*
of the first state set for the “On” color, the second the “Off” color and the third the “Bad PLC Data” color.

To change:

- Use the drop down button and select from the drop list

**State/Style/Action**

A conditional expression that, when evaluated to true, displays the characteristics (a style and/or action) as defined in the library.

Field Entries:

- Number or library entry as described in Expressions, Discrete.

To change:

- Enter expression using single quotes around tags, and library entries
- Use the drop down button to select and add a library entry

**Style**

An entry from the Style library. The selected style appears on the control when the associated State/Style/Action is true.

Field Entries:

- Action Library Entry

To change:

- Use the drop down button to select a library entry

**Text Output Location**

The name of the currently activated menu selection is sent to this reference.

Field Entries:

- Client or Tag Library entry

To change:

- Enter expression using single quotes around tags, and library entries
- Use the drop down button to select and add a library entry

**Tick Placement**

Use this field to mirror the scale ticks marks on the bar scale.

Field Entries:

- To mirror the tick marks - Click the box next to the Mirror value.
- To NOT mirror the tick marks - Do not click the box next to the Mirror value.

To change:

- To toggle the property, click the checkbox; To toggle again, click checkbox again.

**Time Values**

The selection for showing or not showing the horizontal grid labels (time and date information).

Field Entries:
• Yes - show the labels
• No - do not show labels

To change:
• To toggle Yes/No, click the property entry area.

**Title**

The name of the control, which is generally used as a title.

*Note: Identical Names are not allowed as text strings.*

Field Entries:
• Text string in double quotes (ie: "This text will appear").
• A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,TextEntry' will display the value of TextEntry from the library called MediaLibrary).

To change:
• Type an entry.
• Use the drop down button to select a library entry.

**Trend Interval Units**

The time interval used as a basis for trend updates. This is the minimum rate at which the trend will be updated. For instance, if this value is set to "Minutes", then a Sample Interval setting of 1 would result in an update every 1 minute.

Field Entries:
• Milliseconds
• Seconds
• Minutes
• Hours
• Days

To change:
• Use the drop down button and select from the drop list

**Trend Target Expression**

For "Discrete" triggers, this expression drives trend updates when the expression changes from FALSE to TRUE (no change occurs when it resets).

Field Entries:
• Discrete library entry as described in:
  • Expressions, Discrete
  • Operators

For "Change" triggers, this expression drives trend updates when the expression (or any variable within) is changed.

Field Entries:
• Expression library entry as described in:
  • Expressions, Discrete
Expressions, Analog

Operators

To change:
- Enter expression using single quotes around ?, tags, and library entries
- Use the drop down button to select and add a library entry

Trigger Type

The mechanism which causes the trend to update.

Field Entries:
- Interval - time interval for periodic updates
- Discrete - a binary variable transition to TRUE
- Change - a change to a variable in the Target Expression

To change:
- Use the drop down button and select from the drop list

Units

The units displayed on the control, such as "Deg F" or "rpm."

Note: Identical Names are not allowed as text strings.

Field Entries:
- Text string in double quotes (ie: "rpm").
- A string in single quotes will reference a value stored in a library (ie: 'MediaLibrary,TextEntry' will display the value of TextEntry from the library called MediaLibrary).

To change:
- Type an entry.
- Use the drop down button to select a library entry.

Upper Limit

The largest value that can be entered by the operator (and sent to the target expression's location).

Field Entries:
- Number
- Library entry as described in Expressions, Analog

To change:
- Type a value
- Use the drop down button to select a combination of library entries and formulas

Upper Limit Violation Action

The action to be taken when data entered by the operator exceeds the Upper Limit.

Field Entries:
- Reenter - The user is prompted to reenter a value in the data entry area.
• Apply Upper Limit - The upper limit value is applied and written to the PLC.
To change:
• Use the drop down button and select from the drop list

**Value**

The value expression for the data. The result of this expression is a value/number (generally from the PLC) that is displayed on the control.

Field Entries:
• Number or library entry as described in:
  • Expressions, Discrete
  • Expressions, Analog
  • Operators
To change:
• Enter expression using single quotes around tags, and library entries
• Use the drop down button to select and add a library entry

**Value Color and Pen Color**

The color for data values.

Field Entries:
• Color
To change:
• Click the Ellipsis button (...) to call the Color window, then select a color (or define a custom color) for the value.

**Visibility Expression**

A conditional expression that, when evaluated to true, displays the control. When false, the control does not appear on the page.

Field Entries:
• Number or library entry as described in Expressions, Discrete.
To change:
• Enter expression using single quotes around tags, and library entries
• Use the drop down button to select and add a library entry

**Width**

The control’s horizontal (X coordinate) size, in pixels.

Field Entries:
• Number
To change:
• Type a number
• Use the Up and Down arrow buttons to change the position by 1 point increments
X Points

The horizontal (X coordinate) position of the polygon's vertex on the page, in pixels.

*Note: X,Y coordinates 0,0 represent the upper left corner.*

Field Entries:
- Number

To change:
- Type a number
- Use the Up and Down arrow buttons to change the position by 1 point increments

Y Points

The vertical (Y coordinate) position of the polygon's vertex on the page, in pixels. X,Y coordinates 0,0 represent the upper left corner.

*Note: X,Y coordinates 0,0 represent the upper left corner.*

Field Entries:
- Number

To change:
- Type a number
- Use the Up and Down arrow buttons to change the position by 1 point increments
Application Notes

Alarm and Event Banner

Alarm and Event Viewer Components

Runtime View

The ePro PS Alarm and Event feature is used to monitor all system and process events in a single FIFO stack of configurable size. Individual events or alarms may be acknowledged and may transition from alarm state to an acknowledged state and to a cleared state. Regardless of the state they remain in the stack until they are pushed out when the stack fills up.

The table is displayed with the Alarm/Event Viewer window and organized (by default) based on the time each event triggers with newest events at the top of the stack. The default view may be changed through a series of filters and can be sorted based on any visible attribute (column) such as alarm level/criticality, type, or group name. The filters allow the user to view or hide based on acknowledged/ unacknowledged status, active/inactive status and origin (system events and process/user-configured events). Alarms may be acknowledged individually by touching the acknowledge column for a selected alarm or they can be acknowledged with the “Acknowledge All Alarms” or “Acknowledge Visible Alarms” buttons. The Window Banner contains controls for paging up and down, moving to the top or bottom of the alarm list, minimizing or maximizing the window, and displaying or hiding the Global-Acknowledge/Filter area.

Event Manager Settings

The following dialog box shows the various Configuration properties that control the event manager. These properties may be overridden by similar settings in the Unit properties if the unit is set to override the configuration properties for the Event Manager.
The first attribute sets the overall capacity of the Alarm/Event stack. While there is not a design limit to the size of the stack, memory and performance limitations suggest that it be set to no more than 3000 events for an ePro PS configuration. The next five attributes allow you to also write events to the Windows Application Event Viewer based on each event's level/criticality attribute. Because of the ePro PS's Protect Mode feature which prevents changes to the operating system drive (C:\) and because you cannot change the location of the Windows Event Viewer data, these events will be lost whenever the system is rebooted. In any case the Windows Event Viewer can be an auxiliary temporary storage place for alarms and events.

Banner Settings

The following dialog boxes show the various Configuration properties that control the Event Banner. These properties may also be overridden by similar settings in the Unit properties if the unit is set to override the configuration properties for the Event Banner.
The “Roll Up/Down Operational” and “Exit Operational” parameters determine if these banner controls function normally or are disabled (shown below from the right side of the banner):

The Roll Up (up arrow) shows when the Alarm Table section is currently rolled down and the Roll Down (down arrow) shows when the Alarm Table section is currently rolled up. This allows the user to leave the window open online with just the banner section displayed (rolled up) or to restore the rest of the window (roll down). Selecting the Exit button (X) closes the entire window.

The “Mobility” parameter can be Mobile or Immobile. This controls whether or not the Window may be repositioned online by dragging the Banner with a mouse or touchscreen.

The “Location”, “Height” and “Width” parameters control the position and size of the alarm/event window when it is opened with a View Action where the view state is set to “Open” instead of “Open Full Screen”.

**Acknowledge – Filter Settings**

These parameters control the functionality of the Acknowledge buttons and Filter buttons located below the window Banner section.
The “Acknowledge All Alarms” parameter sets the text of the button that will acknowledge every unacknowledged alarm in the stack if the “Acknowledge All Operational” parameter is set to “Yes” (if set to “No” the text is grayed out and the button is inactive).

The “Filter Buttons” parameter allows the user to select if the Acknowledge-Filter part of the window is “Always Visible”, “Always Invisible”, “Initially Visible” or “Initially Invisible”. If set to Initially Visible or Invisible the filter button on the banner will toggle them from being visible (arrow up) or hidden (arrow down as shown below):

The “Acknowledge Visible Alarms” parameter sets the text of the button that will acknowledge every unacknowledged alarm in the visible Alarm Table area if the “Acknowledge Visible Operational” parameter is set to “Yes” (if set to “No” the text is grayed out and the button is inactive).

The “Filter Active On” and “Filter Active Off” parameters set the text of the button that will toggle between showing or hiding alarms which are currently active. When the active alarm filter is ON only inactive
alarms will show in the Alarm Table area. The "Filter Active On" text label will appear when the filter is ON. If you wish to show the status of the filter you might set the text of the two buttons to "Active Alarm Filter ON" and "Active Alarm Filter OFF". If you want to describe what will occur when the button is pressed you might set the text of the two buttons to "View Active Alarms" and "Hide Active Alarms". The "Filter Active Operational" parameter determines whether or not the button works online. If the parameter is set to NO then the operator will not be able to filter out active alarms from the Alarm Table area and active alarms will always be displayed.

The remaining parameters in this section work the same as the "Filter Active On/Off/Operational" parameters described in the previous paragraph. They allow the user to filter out Inactive Alarms, Acknowledged Alarms, Unacknowledged Alarms, Process Alarms, and System Alarms. Inactive Alarms include all alarms that have cleared regardless of their acknowledged/unacknowledged state. Acknowledged Alarms include all alarms which have been acknowledged regardless of their active/inactive state. Unacknowledged Alarms include all alarms that have not been acknowledged regardless of their active/inactive state.

**Alarm Table Settings**

These parameters control the size of the viewable alarm stack and the foreground and background colors of the text fields in the Alarm Table area based on the state of the alarm (with the exception of the level/criticality field).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Events</td>
<td>1000</td>
<td>Maximum number of events from the Event Manager tab.</td>
</tr>
<tr>
<td>Grid Background</td>
<td></td>
<td>Color of each empty line in the Alarm Table area.</td>
</tr>
<tr>
<td>Active Acknowledged FG</td>
<td></td>
<td>Color of the entry if active and acknowledged.</td>
</tr>
<tr>
<td>Active Acknowledged BG</td>
<td></td>
<td>Color of the entry if active and unacknowledged.</td>
</tr>
<tr>
<td>Inactive Acknowledged FG</td>
<td></td>
<td>Color of the entry if inactive and acknowledged.</td>
</tr>
<tr>
<td>Inactive Acknowledged BG</td>
<td></td>
<td>Color of the entry if inactive and unacknowledged.</td>
</tr>
<tr>
<td>Active Unacknowledged FG</td>
<td></td>
<td>Color of the entry if active and not acknowledged.</td>
</tr>
<tr>
<td>Active Unacknowledged BG</td>
<td></td>
<td>Color of the entry if active and not acknowledged.</td>
</tr>
<tr>
<td>Inactive Unacknowledged FG</td>
<td></td>
<td>Color of the entry if inactive and not acknowledged.</td>
</tr>
<tr>
<td>Inactive Unacknowledged BG</td>
<td></td>
<td>Color of the entry if inactive and not acknowledged.</td>
</tr>
<tr>
<td>Header Height</td>
<td>32</td>
<td>Pixel height of the Header.</td>
</tr>
<tr>
<td>Field Height</td>
<td>48</td>
<td>Pixel height of each line in the Alarm Table.</td>
</tr>
<tr>
<td>Selected Text Color</td>
<td></td>
<td>Color of the selected field.</td>
</tr>
<tr>
<td>Selected Background Color</td>
<td></td>
<td>Color of the background of the selected field.</td>
</tr>
</tbody>
</table>

The first parameter in this field should be set to match the maximum number of events from the Event Manager tab in order to be able to see the entire alarm/event stack in the viewer window.

The "Grid Background" determines the color of each empty line in the Alarm Table area.

The next four pairs of foreground and background color parameters determine the color of each entry in the table based on its Active/Inactive and Acknowledged/ Unacknowledged states.

The "Header Height" sets the pixel height of the Header above the Alarm Table that displays the text for the definition of each column.

The "Field Height" sets the pixel height of each line in the Alarm Table.

The Selected Text and Selected Background color parameters determine the color of the field that is selected (through a touch or mouse click). The only purpose of the concept of a selected field at present is so that an operator with just a keyboard could select an alarm using the up/down cursor controls and acknowledge the selected alarm line with the Enter key. In a touchscreen application the operator only needs to touch a line in the Acknowledge column to acknowledge an alarm or event.
Alarm Table Column Settings – Triggered Timestamp

These parameters set the attributes of the Triggered Timestamp column, by default the first, or leftmost column in the Alarm Table.

The Column parameter determines in which column the triggered timestamp is placed, indicating the onset of the alarm/event.

Column Width sets the width of the column in pixels.

The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The Field FG and BF colors determine the colors of the field in the Alarm Table only if the Table settings for indicating state colors (Active/Inactive or Acknowledged/Unacknowledged) are set to “none – transparent”. Otherwise they are ignored.

The last two parameters determine the font and alignment of the triggered timestamp value in the column for all lines in the Alarm Table.

Alarm Table Column Settings – Cleared Timestamp

These parameters set the attributes of the Cleared Timestamp column, by default the second column in the Alarm Table.
The Column parameter determines the placement of the column in which the cleared timestamp is placed, indicating the time, or elapsed time since onset, that the alarm/event transitioned to the inactive state (false).

Column Width sets the width of the column in pixels.

The Time Format parameter determines whether the cleared timestamp indicates the actual time it became inactive or the elapsed time that it was in the active state before transitioning to the inactive state.

The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The Field FG and BF colors determine the colors of the field in the Alarm Table only if the Table settings for indicating state colors (Active/Inactive or Acknowledged/Unacknowledged) are set to "none – transparent". Otherwise they are ignored.

The last two parameters determine the font and alignment of the cleared timestamp value in the column for all lines in the Alarm Table.

**Alarm Table Column Settings – Acknowledged Timestamp**

These parameters set the attributes of the Acknowledged Timestamp column, by default the third column in the Alarm Table.
The Column parameter determines the placement of the column in which the acknowledged timestamp is placed, indicating the time, or elapsed time since onset, that the operator acknowledged the alarm/event.

Column Width sets the width of the column in pixels.

The Time Format parameter determines whether the acknowledged timestamp indicates the actual time it became acknowledged or the elapsed time that it was in the active state before the operator acknowledged the alarm/event.

The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The Field FG and BF colors determine the colors of the field in the Alarm Table only if the Table settings for indicating state colors (Active/Inactive or Acknowledged/Unacknowledged) are set to “none – transparent”. Otherwise they are ignored.

The last two parameters determine the font and alignment of the acknowledged timestamp value in the column for all lines in the Alarm Table.

**Alarm Table Column Settings – Description**

These parameters set the attributes of the Description column, by default the fourth column in the Alarm Table.
The Column parameter determines the placement of the column in which the description is placed, providing a detailed explanation of the nature of the alarm/event.

Column Width sets the width of the column in pixels.

The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The Field FG and BF colors determine the colors of the field in the Alarm Table only if the Table settings for indicating state colors (Active/Inactive or Acknowledged/Unacknowledged) are set to “none – transparent”. Otherwise they are ignored.

The last two parameters determine the font and alignment of the description in the column for all lines in the Alarm Table.

**Alarm Table Column Settings – Criticality**

These parameters set the attributes of the Criticality or Alarm Level column, by default the fifth column in the Alarm Table.
The Column parameter determines the placement of the column in which the Criticality attribute is placed, indicating the relative importance or urgency of the alarm/event.

Column Width sets the width of the column in pixels.

The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The next five parameters determine the text strings used to describe the five hierarchical alarm criticality levels, from highest to lowest.

The Field Default FG and BF colors determine the colors of the field in the Alarm Table only if the following criticality color settings for indicating the five urgency levels are set to “none – transparent”. Otherwise they are ignored.

The next five pairs of parameters provide the foreground and background colors of the text appearing in this column that indicate criticality or urgency level. This is the only column in the alarm table where the color or the text does not indicate the active/inactive state or acknowledged/unacknowledged state, but rather the criticality or urgency of the alarm/event.

The last two parameters determine the font and alignment of the criticality text in this column for all lines in the Alarm Table.
Alarm Table Column Settings – Group

These parameters set the attributes of the Group column, by default the sixth column in the Alarm Table.

The Column parameter determines the placement of the column in which the Group or Type attribute is placed, providing an additional indication of the classification for the alarm/event.

Column Width sets the width of the column in pixels.

The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The next sixteen parameters determine the text strings used to describe the classification of alarms/events. The following eleven classifications are used by system generated events such as communications errors and internal runtime events or alerts:

- Undefined Error
- Alarm Clear
- Communication Error
- Configuration Error
• Parser Error
• Evaluation Error
• User Input Error
• Insufficient Resources
• Invalid Resource
• Programmatic Error
• Audit Fail

The following five classifications can be assigned by the user for each configured alarm or event:

• General Error
• Alarm
• Event
• Audit
• User Defined

The Field FG and BF colors determine the colors of the field in the Alarm Table only if the Table settings for indicating state colors (Active/Inactive or Acknowledged/Unacknowledged) are set to "none – transparent". Otherwise they are ignored.

The last two parameters determine the font and alignment of the group or type text in this column for all lines in the Alarm Table.

**Alarm Table Column Settings – Group Name**

These parameters set the attributes of the Group Name column, by default the seventh column in the Alarm Table. The group name for each user configured alarm or event is defined by the user. This allows the user to add another field that can be sorted online by the operator to organize the information in the Alarm Table in a way that is meaningful for the application so that all alarms for a specific area or section of the process can be grouped together. Since the sorting is done alphabetically the user can control the order that each group name appears by naming each group with a preceding number such as "1 – Feeder Section", "2 – Converting Section", 3 – Packaging Section", "4 – Auxiliary Controls", etc.

The Column parameter determines the placement of the column in which the Group Name attribute is placed, providing an indication of the section of the process associated with the alarm/event.

Column Width sets the width of the column in pixels.
The next five parameters determine the column heading’s label, foreground and background colors, font and alignment within the column header.

The Field FG and BF colors determine the colors of the field in the Alarm Table only if the Table settings for indicating state colors (Active/Inactive or Acknowledged/Unacknowledged) are set to “none – transparent”. Otherwise they are ignored.

The last two parameters determine the font and alignment of the group or type text in this column for all lines in the Alarm Table.

**Alarm Table Column Settings – Source, Use & Computer**

For future use, not currently supported. These fields are disabled by default by setting the Column parameter to zero.

![Alarm Table Column Settings](image)

### Changing the Default Prepackaged Project

The default prepackaged project that is created when the ePro Canvas editor is started from the start menu and which is also created when choosing New prepackaged project from the File menu or from the Project’s toolbar icon, is an XML file named ProjectProfileCanvasPro.xml (for the ePro Canvas Professional Editor) and ProjectProfileCanvas.xml (for the ePro Canvas Editor). That file is located in the Configuration directory of the ePro Canvas installation directory (default location is C:\Program Files\Cutler-Hammer\ePro Software Suite\Configuration).

If you want to change the prepackaged project to include components and Component Templates that you have created or customized, simply export the desired project as an XML file, name it the same as the default prepackaged project XML file, and place it in the ePro Canvas installation’s Configuration directory. You can export a project as an XML file with the File>Export selection from the ePro Canvas Project Explorer editor as shown below.
Changing Pages Online

Page Changes Using Actions

The primary method for changing pages is through an Action. There are five Actions that are built into the default Action Library named ActionSystem that can be used to control page changes. Three of them are based on the page name and the row number as it appears in the Configuration Properties Page tab as shown below.
The action named ActionGetPage generates a selectable list of all configuration pages by name. The list appears online at the top of the current page when the action is initiated. When a user touches or clicks on a page name in the list, the system changes pages to that selected page on the release or break of the touchscreen.

The action named ActionPageUp will change pages to the page named in the next row from the current page. In the example above, if the current page is the Weld Robot Controls and the ActionPageUp executes, the system will go to the Inspection Results page. The action will wrap-around so that if the current page is the last page in the configuration, it will go to the first page.

The action named ActionPageDown will change pages to the page named in the previous row from the current page. In the example above, if the current page is the Weld Robot Controls and the ActionPageDown executes, the system will go to the Process Overview page. The action will wrap-around so that if the current page is the first page in the configuration, it will go to the last page.

The other two default page change Actions are ActionHomePage and ActionPreviousPage. The first will change pages to the page defined as the Home Page in the Configuration Properties General Tab as shown below:
In the above example the page named Menu is defined as the Home Page of the Welding Line 1 configuration. Any time ActionHomePage triggers in that configuration the system will change pages to Menu. The action named ActionPreviousPage will always change pages to the page that was displayed prior to the currently displayed page. If a button that calls the ActionPreviousPage is placed on all pages in a configuration, the user will be able to go back and forth between any two pages using that button.

**User defined Goto Page Actions**

In addition to the built-in system actions for page change, the user may create Goto Page actions that will change pages to a specific page by name when executed. The following is an example of a Goto Page action that when executed will change to the page name Process Faults:

**Changing Pages by ID Number**

Another method of changing pages online is through the Page ID Number. The page ID Number property on the Page Properties General tab allows the user to assign a number to a page as shown below:
By default all pages are assigned a Page ID number of zero. You can change this number to any number you wish. In the following example a configuration has six pages with the following Page ID number assignments:

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Id Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>0</td>
</tr>
<tr>
<td>Process Overview</td>
<td>10</td>
</tr>
<tr>
<td>Weld Robot Controls</td>
<td>15</td>
</tr>
<tr>
<td>Inspection Results</td>
<td>33</td>
</tr>
<tr>
<td>Machine Diagnostics</td>
<td>22</td>
</tr>
<tr>
<td>Process Faults</td>
<td>14</td>
</tr>
</tbody>
</table>

In the default tag library TagSystem there is a System tag CurrentPageID that is automatically updated by the online system with the ID Number of the currently displayed page. If no changes are made to the default ID Number of the pages in a configuration, it will always read zero. But in the example shown above, when the configuration is running online and the current page is Weld Robot Controls, then the value in CurrentPageID will be 15.

There are several ways to change pages by Page ID Number. The first way is by using a Rectangular Button control on a page where the Type property in the General tab is set to Page Change and the target address is either a constant or a tag containing the ID Number of the page you wish to go to. In the Rectangular Button properties example shown below, pressing the button online would change pages to the page with ID Number of 33, the Inspection Results page of our example.
Of course the same result could be obtained by creating a Goto Page action that specifies the Inspection Results page by name, and then changing the button's Type property to Trigger Action and changing the Break Action to call the Goto Page action as shown below:

Another way to change pages by Page ID Number is to write to the system tag CurrentPageID. You could do this with a numeric entry from a page control or by creating an Assignment Action set to Conditional Passthru where a PLC tag change gets written directly to CurrentPageID. When CurrentPageID is written to the system will change pages to the page with the corresponding Page ID Number. To work properly it
is required that the user make sure that the Page ID Number is unique for all pages in a configuration. The following is an example of a numeric operator entry writing to CurrentPageID:

![Image of numeric operator entry]

Next is an example of a PLC tag called ‘remote_page_change’ writing to the CurrentPageID through an assignment action with Trigger Type Conditional and Condition Type Pass thru. It is important to note that in order to have this action execute online it needs to be added to the Configuration Properties Actions tab:

![Image of PLC tag configuration]

589
Warning: Do NOT use Remote Page Changes in safety critical applications. If the operator has touched a button when the remote page change occurs, the page will change, however the break action resulting from the operator's release of the button will NOT occur. To avoid this situation, an alternate method is to allow the PLC to propose a page for the operator to call. This can be done using visibility to show a flashing button when the proposed PLC page is different from the current page (eg. the Visibility Expression for the button would be RemotePageId != CurrentPageId). When the button is then visible and pressed, an action list can be executed to call the PLC page (RemotePageId) and update the CurrentPageId.

Component Templates

Component Templates are project components that have been saved as templates for reuse within the project. Component Templates may be created by the developer to reduce development time and provide a consistent look or style to a configuration. Any project component can be saved as a template by right-clicking on the component and selecting Create Component Template and any single page component can be saved as a template by right-clicking on it and selecting Create Template as illustrated below.
When a component is saved as a template all configured properties of that component are saved. To create a new project component from a saved template right-click on the component group, i.e. Unit, Client, Configuration, Page, etc., and highlighting Create From Template, then choosing the desired template from the resulting list of Component Templates as illustrated below.
In the Page Editor you can use saved page components by clicking on the Component Template category in the controls bar. New components created from a component template will have all initial properties set to that of the saved template. This can speed up development by allowing the user to establish the default settings of new components added to the project rather than accepting the editor defaults and having to change each new components properties to match the desired standards of the developer.

Because page controls can also be saved as Component Templates the developer can take standard Canvas controls and customize them once and then use the customized controls to reduce development time and create a consistent look and feel to the project's pages.

Some Component Templates are included in the default Project Profile to speed up initial development. They are shown below:
Because Component Templates are saved with a project just like any other project components they will not automatically be added with a New blank project or New prepackaged project. However, like all other project components they may be copied from an existing project to a new project by opening both projects in separate windows and using copy and paste, or drag and drop, to copy between the two projects.

Changing the Default Prepackaged Project

Control Example: Readout Template

A Readout control displays numerical values similar to readout devices on a control panel. The following is a description of the Readout Template, but is described in terms that can be related to all controls. Due to similarity in each control’s properties, this is the only detailed example given for a control as it describe how all controls function.

The Control

When a Readout Template is placed on a page, it will appear similar to below.

Note: Some properties have been adjusted as follows (details on making these changes will follow):

- Data Entry has been selected and is indicated by the miniature data entry keypad in the template’s upper left corner.
- A title “Speed” has been given to the template.
- The units "RPM" has been added.
The Property Editor

The Property Editor of this control can be called by double clicking the control (or right-clicking the control and selecting Properties). These properties are shown below:

![Property Editor](image)

The General Properties

When the properties are displayed for the control, the General Properties (ie: the General Tab), are shown. The following is an example of a readout control's Property Editor, showing the general properties, with the most notable properties indicated.
The Property Editor Window contains the Control Outline and a list of properties and values for the Readout Template. In the graphic above:

- **Readout Template** is highlighted (shown with a blue background) in the Control Outline.
- The **General** Tab is selected on the right.
- So, the Readout Template’s General properties are shown.
- And, this top level (**Readout Template**), **General** tab contains the most common properties.
- Note how the property values are reflected visually on the graphic (and the Data Entry indicator is displayed after selecting OK).

Values are changed in this or any property window by selecting and altering the value based on the type of value field.

In the above graphics, the altered property values were changed as follows:

- Data Entry was selected by the drop box arrow next to the Operator Input Type property.
- "Speed" was assigned to the Title property.
- "RPM" was assigned to the Units property.

Controls are designed with the most common properties under the General tab to minimize editing time. Below are more instructions on accessing the remainder of the properties.

**The Control Outline**

As in the graphic below, the **Control Outline** shows the composition of the selected control with all of its controls/sub-control constituents.
The outline (which was expanded by clicking on all "+" signs) shows the controls that make a Readout Template. The four sub-controls at the next level of the outline, under Readout Template, are indicated with lines on the graphic above.

- Readout Template
  - Legend
  - Plate
  - Readout
  - Units

Then to drill down further into the control, the Legend is made of (i.e. the level of the outline under Legend):

- Legend
  - Plate
  - Text
  - Image

And, the plate is made of:

- Plate
  - Plate Rectangle

And, so on, until the outline is filled as in the property editor graphic above.

Note: items are expanded by clicking "+" signs; contracted with "-" signs.

Note: The item selected in the Control Outline pane has its properties shown on the right.

### Editing Sub-Control Properties

In the preceding Control Outline pane, Readout Template was selected. Since it is selected, its properties are shown on the right. Similarly, if any item in the outline is selected, it's properties will be displayed.

In general, the most used properties have been moved to the General Tab. To change less common properties, select them at their base level. For instance, to change the border highlight color on the legend part of the control (which is the border of the rectangle sub-control of the plate sub-control of the legend
sub-control of the Readout control), select Plate Rectangle as shown below. Then select the Attributes tab to access the desired characteristics or property.

![Rectangle - Plate Rectangle dialog box](image)

The control will change as follows...

![Rectangle - Plate Rectangle example](image)

Tip: The highest level "General" tab contains the most common properties.
Tip: Lower level "Attributes" tab is necessary to change the less common properties.

**The Rest of the Properties**

The following properties under the **General** Tab are specific to the Readout Template control.

- Title
- Value
- Decimal Places
- Units

In addition to the above properties, there are **Common Properties** available for all controls.

**Other Controls**

Click **Controls** to look at the properties of all the controls.
Creating a Multi-Language Project

Switching between different languages is performed by placing the a numeric value in a storage location specified by you, or by using an expression that you create. The unit will switch to a different language if the value in the specified location or the expression matches one of the language values listed in the language table below.

**Language table**

<table>
<thead>
<tr>
<th>LANGUAGE</th>
<th>LANGUAGE VALUE (Decimal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFRIKAANS</td>
<td>54</td>
</tr>
<tr>
<td>ALBANIAN</td>
<td>28</td>
</tr>
<tr>
<td>ARABIC</td>
<td>01</td>
</tr>
<tr>
<td>ARMENIAN</td>
<td>43</td>
</tr>
<tr>
<td>ASSAMESE</td>
<td>77</td>
</tr>
<tr>
<td>AZERI</td>
<td>44</td>
</tr>
<tr>
<td>BASQUE</td>
<td>45</td>
</tr>
<tr>
<td>BELARUSIAN</td>
<td>35</td>
</tr>
<tr>
<td>BENGALI</td>
<td>69</td>
</tr>
<tr>
<td>BULGARIAN</td>
<td>02</td>
</tr>
<tr>
<td>CATALAN</td>
<td>03</td>
</tr>
<tr>
<td>CHINESE</td>
<td>04</td>
</tr>
<tr>
<td>CROATIAN</td>
<td>26</td>
</tr>
<tr>
<td>CZECH</td>
<td>05</td>
</tr>
<tr>
<td>DANISH</td>
<td>06</td>
</tr>
<tr>
<td>DIVEHI</td>
<td>101</td>
</tr>
<tr>
<td>DUTCH</td>
<td>19</td>
</tr>
<tr>
<td>ENGLISH</td>
<td>09</td>
</tr>
<tr>
<td>ESTONIAN</td>
<td>37</td>
</tr>
<tr>
<td>FEROESE</td>
<td>56</td>
</tr>
<tr>
<td>Farsi</td>
<td>41</td>
</tr>
<tr>
<td>FINNISH</td>
<td>11</td>
</tr>
<tr>
<td>FRENCH</td>
<td>12</td>
</tr>
<tr>
<td>GALICIAN</td>
<td>86</td>
</tr>
<tr>
<td>GEORGIAN</td>
<td>55</td>
</tr>
<tr>
<td>GERMAN</td>
<td>07</td>
</tr>
<tr>
<td>GREEK</td>
<td>08</td>
</tr>
<tr>
<td>GUJARATI</td>
<td>71</td>
</tr>
<tr>
<td>HEBREW</td>
<td>13</td>
</tr>
<tr>
<td>Language</td>
<td>Code</td>
</tr>
<tr>
<td>--------------</td>
<td>------</td>
</tr>
<tr>
<td>HINDI</td>
<td>57</td>
</tr>
<tr>
<td>HUNGARIAN</td>
<td>14</td>
</tr>
<tr>
<td>ICELANDIC</td>
<td>15</td>
</tr>
<tr>
<td>INDONESIAN</td>
<td>33</td>
</tr>
<tr>
<td>ITALIAN</td>
<td>16</td>
</tr>
<tr>
<td>JAPANESE</td>
<td>17</td>
</tr>
<tr>
<td>KANNADA</td>
<td>75</td>
</tr>
<tr>
<td>KASHMIRI</td>
<td>96</td>
</tr>
<tr>
<td>KAZAK</td>
<td>63</td>
</tr>
<tr>
<td>KONKANI</td>
<td>87</td>
</tr>
<tr>
<td>KOREAN</td>
<td>18</td>
</tr>
<tr>
<td>KYRGYZ</td>
<td>64</td>
</tr>
<tr>
<td>LATVIAN</td>
<td>38</td>
</tr>
<tr>
<td>LITHUANIAN</td>
<td>39</td>
</tr>
<tr>
<td>MACEDONIAN</td>
<td>47</td>
</tr>
<tr>
<td>MALAY</td>
<td>62</td>
</tr>
<tr>
<td>MALAYALAM</td>
<td>76</td>
</tr>
<tr>
<td>MANIPURI</td>
<td>88</td>
</tr>
<tr>
<td>MARATHI</td>
<td>78</td>
</tr>
<tr>
<td>MONGOLIAN</td>
<td>80</td>
</tr>
<tr>
<td>NEPALI</td>
<td>97</td>
</tr>
<tr>
<td>NEUTRAL</td>
<td>00</td>
</tr>
<tr>
<td>NORWEGIAN</td>
<td>20</td>
</tr>
<tr>
<td>ORIYA</td>
<td>72</td>
</tr>
<tr>
<td>POLISH</td>
<td>21</td>
</tr>
<tr>
<td>PORTUGUESE</td>
<td>22</td>
</tr>
<tr>
<td>PUNJABI</td>
<td>70</td>
</tr>
<tr>
<td>ROMANIAN</td>
<td>24</td>
</tr>
<tr>
<td>RUSSIAN</td>
<td>25</td>
</tr>
<tr>
<td>SANSKRT</td>
<td>79</td>
</tr>
<tr>
<td>SERBIAN</td>
<td>26</td>
</tr>
<tr>
<td>SINDHI</td>
<td>89</td>
</tr>
<tr>
<td>SLOVAK</td>
<td>27</td>
</tr>
<tr>
<td>SLOVENIAN</td>
<td>36</td>
</tr>
<tr>
<td>SPANISH</td>
<td>10</td>
</tr>
<tr>
<td>SWAHILI</td>
<td>65</td>
</tr>
<tr>
<td>SWEDISH</td>
<td>29</td>
</tr>
</tbody>
</table>
Multi-Language Example

The following steps describe the multi-language set up. These steps are only one example of how this can be accomplished.

Set up media library

Set up the library for each of the different language that will be used.

Create a tag to store the language value

The storage location of your choice, any device that has registers, i.e. PLC, Drive, etc.

Set up the Active Language Expression

The active language expression is found on the general tab of the configuration. This field is must be filled in if you intend on using Multi-language. Place the tag (from above) in this field. Use the drop down button to select the tag.

You're done

The only thing left to do is determine how you will change the languages. You can change them manually by pressing buttons on the runtime screen. Or you can have the destination device change language using criteria set up on that device. Below are examples of notes about each method.

Changing Language manually

- Create an action assignment for each language. The assignment should place the language value in the tag. i.e. 'Tag' = 9 (9 is English language). Use the numeric value that corresponds to the language you want to change to.
- Place a button for each language on a screen. Label each button accordingly for the languages. Insert the appropriate action into one of the action filed of the button.

Let the destination device change language

- Using the logic of the destination device, place into the tag the numeric value that corresponds to the language you want to change to.

Data Archiving

The ePro PS supports data archiving in two different ways. You can choose to archive alarms and events and archive data through Data Archive actions. In each case one or more Archive Library entries must be created that control the sample rate, the archive rate, the group rollover rate and the file rollover rate. All archived data is stored in XML file format to allow for compatibility with Microsoft Excel or Access applications or any other XML compliant display or analysis tool. If you use Excel to display the data you will find that an ePro's data archive file typically has a number of sheets.
When a file is first created by a data archive action the first sheet is named by the data and time the sheet was first written to. For example, a sheet started on June 18th 2005 at 8:44:06 AM would be named "06-18-2005 084406". Data will be sampled based on the Sample Rate defined in the Archive Library Entry and that sampled data will be written to the file at the Archive Rate.

**Archive Libraries**

Archive Libraries are used to store the data sampling and file settings for all system archive functions. The library entries may be shared by multiple archive functions.

In the Archive Library Entry example shown below, data is sampled every 30 seconds, and data is written to the archive every 2 minutes. This means that the ePro buffers up sampled data until it is time to open the archive file and write the data to the file. The Group Rollover Rate determines when to create a new sheet in the archive file and the File Rollover Rate determines when a new file will be created. In this example a new sheet is created every hour (3600 seconds) and a new file is created every 8 hours (480 minutes). The rates can be triggered from time or event, see Archive Library Entry for more details.

Also see Archive Library Entry.

The Archive Path determines the path and directory where the archive files will be stored. In this example the data is stored on a removable drive on the ePro, drive letter "E" in the directory "\DataArch\Data Trends". Note the double backslash is required as a path separator because the backslash is a special character in the ePro syntax evaluator. An alternate way of showing the path would use a single forward slash character such as "E:/DataArch/Data Trends".

Note: when archiving data on any ePro PS hardware platform it is critically important to the operation of the ePro that all archived data paths be set to either a removable drive or mapped network drive. Data should never be archived to either the "C" or "D" drive of the ePro. Both these drives are located on an internal CompactFlash memory module which must be returned to the factory for service if the drive is damaged from perpetually writing to the "D" drive. The "C" drive is protected by the Windows XP Embedded operating system from change. This means that if you attempt to write archive files to that drive, Windows will intercept those attempts and place the files in volatile RAM memory. Over time those archived files will totally consume all the available RAM memory and crash the Windows OS. A system reboot will permanently cure the problem by flushing out all the archived data files from RAM, but you will have lost all your data and eventually RAM will fill up once more requiring another reboot.

Another example of an Archive Library entry set up for the Alarms/Events archival is shown below:
Since alarms are not sampled, the Sample Rate property may be left blank. If a value is placed in the Sample Rate field and the Alarms/Events archive is assigned that Archive Entry then the property will be ignored. Otherwise, alarms and events are buffered up until the Archive Rate times out and the data is written to the archive file.

It is recommended that the Archive Rate be no less than a minute and that the Sample rate for Trend Templates or Data Archive actions be set to no less than five seconds on the ePro.

**Alarms/Events Archiving**

To set up Alarm and Event Archiving go to the Event Manager tab in the Configuration properties page and select an Archive Library Entry in the Archive Property of the dialog as shown below. Note: leaving the Archive property blank will disable the alarm/event archive function.
The name of the Archive files will follow the convention: \texttt{AlarmEvent\_mmdyyyy\_hhmm.XML}

Where the month day year hours and minutes indicated the time the file was first created. The file will be created after the archive rate defined in the Archive Library entry has elapsed following ePro startup. Following this initial file a new file will be created after the file rollover rate has elapsed, and so on until the ePro configuration closes.

The format of the archive file when displayed in Microsoft Excel is:
Data Archive Action

A Data Archive Expression may be created in the Action Library and then added to the Configuration property's Actions tab to enable a general data archiving function. An example of a Data Archiving action is shown below:
In the above example five tags are being archived at the rates defined in the Archive Library entry name ‘Sample 30 Seconds arch 2 minutes’.

The name of the Archive files will follow the convention: ActionName_mmddyyyy_hhmm.XML or in the example shown above the name would be Archive Sine Data_mmddyyyy_hhmm.XML

Where the month day year hours and minutes indicated the time the file was first created. The file will be created after the archive rate defined in the Archive Library entry has elapsed following ePro startup or following the true state transition of the Trigger Expression occurs. Following this initial file a new file will be created after the file rollover rate has elapsed, and so on until the ePro configuration closes or until the Trigger Expression transitions to a false state.

The format of the archive file when displayed in Microsoft Excel is:
Explicit Library Referencing

Active library names can be entered alternatively, using Explicit references to Library Entries. Generally, this method works with library types that allow only one library per configuration. However, multiple clients are allowable in a unit, and can be accessed as shown in the table below.

The reference 'MediaLib1,Ref' can be restated as

- ':Media:,Ref'

And the reference 'ClientSystem,?' can be replaced with

- ':System,?'

Notice how this gives flexibility since there is no tie to a specific library name, and will work with whatever the library is named in the configuration. For example, explicit references to an action library on a page allow that page to be re-used in multiple configurations, each accessing a different action library.

Here are the explicit names of each library.

<table>
<thead>
<tr>
<th>Library Type</th>
<th>Explicit Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Client</td>
<td>:System:</td>
</tr>
<tr>
<td>Unit's 1st Client</td>
<td>:Client1:</td>
</tr>
<tr>
<td>Unit's 2nd Client</td>
<td>:Client2:</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
</tbody>
</table>
Expressions, Analog

An expression that can have many values. Examples of Analog Expressions include:

- Readout Values - temperature, pressure, speed, etc. can be shown numerically.
- Bar Values - temperature, pressure, speed, etc. can be shown in bar graph form.

Analog Expressions will appear as in the following examples:

- **100**
  A numeric expression can be set to a numeric value (no quotes). This type of entry is used in expressions in which the value will not dynamically change. For example, an Upper Limit might be set to 100, and a Lower Limit to 0. Note however, that all expressions, including limits, can be dynamic if desired.

- **'Pressure'**
  The above example will show the value of tag named Pressure.

  **Note:** If the Client Library is set as the Default in the Unit’s properties, then the library can be omitted from the reference. Otherwise, the reference must include the library, ie: 'Lib,LibEntry'.

- **$B8('Pressure')**
  The above example will show the formatted value of tag named Pressure. $B8('Pressure') formats the value as an 8 digit Binary number ($Bn shows n Binary digits, $Hn shows n Hex digits, $A shows an Ascii string, ... use the drop down box to get these values from the list).

  **Tip:** All format operators can be accessed from the drop down box to the right of the value field. For example, to select a Binary format, select **Operators**, then **Format/Data/Time Operators**, then **Binary**, and the $B will be placed in the formula. Use these same steps for all format operators.

- **'40001' % 100**
  The above example (Modulo) will divide 40001 by 100 and show the remainder. For example, if 40001 is 1234, then the expression will be 34 (ie: the remainder of 1234/100 = 12 with Remainder 34).

  **Tip:** All operators can be accessed from the drop down box to the right of the value field. For example, to select Modulo, select **Operators**, then **Arithmetic Operators**, then **Modulo**, and the % will be placed in the formula.

- **'ClientLib, Pressure'**
  The above example shows the value of 'Pressure' from the library called ClientLib.
Tip: All Client and Tag Libraries can be accessed from the drop down box to the right of the value field. For example, to select a library entry, select the type of library, then the Library Name, then the Library Entry, and 'Library Name, Library Entry' will be placed in the formula.

- $(Time)$
  The above example will show the time formatted as hour:minute:sec.

Tip: All Time and Date expressions can be accessed from the drop down box to the right of the value field. For example, to select a Time, select Operators, then **Format/Data/Time Operators**, then **Time hour:minute:sec**, and "$(Time)" will be placed in the formula. Use these same steps for all similar expressions.

- 'Tag1' ** 'Tag2'
  The preceding example (Power) takes Tag1 to the power of Tag2. If Tag1 is 4 and Tag2 is 2, the result is 16.

- abs('Tag1')
  The preceding example gives the absolute value of Tag1.

Notes:
- Pay attention to Property Value Formats (single, double, or no quotes)

Notes:
- The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
- Click the Ellipsis button (...) to select a tag, operator, or function which is defined in a library.
- The Order of Precedence must be considered in formulas.
- Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Press the Back button (toolbar of your browser) to return to the previous page.

**Expressions, Data Entry Target Expressions**

An expression that, when evaluated, will result in data being sent to a target location.

Examples of **Data Entry Expressions** include:

- Send a setpoint to the PLC - a number entered by the operator can be sent to a PLC location.
- Set a local value - a number can be sent to a library entry.

**Data Entry Expressions** are constructed as follows:

'DEST' = SOURCE

- 'DEST' is the destination or target location for data to be written, like 'n7:0' or 'TagName'.
- SOURCE represents an expression whose value is written to 'DEST', and can include any of the following:
  - '?' - a placeholder for the value entered by the operator. The entered value is inserted at all occurrences of '?' in the expression. The '?' will appear in all data entry expressions.
  - 'address' - a location in a PLC
  - 'tag' - a tagname from a Tag Library
  - constant - number used for scale or offset

610
• operators - numeric (+,-,*,/) or binary (|,&,^,<,>,...)

The following equations are examples of target expressions:

• 'n7:0' = 'ClientSystem,'?

The above example will send the data entered by the user to n7:0.

Note: TagLibrary called 'TagSystem' was configured with a Tag named "?" (without quotes), then a Client called 'ClientSystem' was configured to refer to the 'TagSystem' Library.

Note: If the Client Library is set as the Default in the Unit's properties, then the library can be omitted from the reference. Otherwise, the reference must include the library, ie: 'Lib,LibEntry'.

Tip: All Client and Tag Libraries can be accessed from the drop down box to the right of the value field. For example, to select the operator's input value, select Clients, then ClientSystem, then ?, and 'ClientSystem,'? will be placed in the formula.

• '40001' = 'ClientSystem,'? * 10

The above example will multiply the data entered by the user by 10, then send the result to 40001.

• 'PressureSetting'='ClientSystem,'?

The above example will send the data entered by the user to the tag named PressureSetting.

• 'n7:0' = ('(ClientSystem,'? * 'n7:1') * 'b3/1') + ('(ClientSystem,'? * 'n7:2') * ('n7:2' > 10))

The above example is for explanation only, the table below shows some values entered by the operator ('?' is shown instead of 'ClientSystem,'? for simplicity), calculations, and resulting values sent to the destination ('n7:0'). Note that ('n7:2' > 10) evaluates to 1 if 'n7:2' is greater than 10, otherwise evaluates to 0.

<table>
<thead>
<tr>
<th>operator input '?'</th>
<th>n7:1</th>
<th>b3/1</th>
<th>n7:2</th>
<th>value sent to destination 'n7:0'</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>(1 * 5) * 0 + (1 * 0) * (0 &gt; 10) = 0</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>1</td>
<td>0</td>
<td>(1 * 5) * 1 + (1 * 0) * (0 &gt; 10) = 5</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>(2 * 5) * 0 + (2 * 0) * (0 &gt; 10) = 0</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>1</td>
<td>0</td>
<td>(2 * 5) * 1 + (2 * 0) * (0 &gt; 10) = 10</td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td>0</td>
<td>20</td>
<td>(3 * 5) * 0 + (3 * 20) * (20 &gt; 10) = 60</td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td>1</td>
<td>20</td>
<td>(3 * 5) * 1 + (3 * 20) * (20 &gt; 10) = 75</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>0</td>
<td>20</td>
<td>(4 * 5) * 0 + (4 * 20) * (20 &gt; 10) = 80</td>
</tr>
</tbody>
</table>
Expressions, Direct Assignment

An expression that, when evaluated, will result in data being sent to a target location. This assignment can be placed in a Make Action or Break Action property.

Examples of Direct Assignment Expressions include:

- Send a discrete value to the PLC - a bit value can be sent to a PLC location.
- Send an analog value to the PLC - a number can be sent to a PLC location.
- Set a local value - a number can be sent to a library entry.

Direct Assignment Expressions are constructed as follows:

'LIB,DEST' = SOURCE

- 'LIB,DEST' is the destination or target location for data to be written, like 'client,n7_0' or 'plc1,TagName'. Note: The Library name must precede the Tag.
- SOURCE represents an expression whose value is written to 'DEST', and can include any of the following:
  - 'address' - a location in a PLC
  - 'tag' - a tagname from a Tag Library
  - constant - number used for scale or offset
  - operators - numeric (+,-,*,/) or binary (|,&,^,<,>,...)

The following equations are examples of target expressions:

- 'client1,b3_0' = 1
  The above example will send 1 to client1, b3_0.
- 'plc1,40001' = 'speed' * 10
  The above example will multiply the tag speed by 10, then send the result to 40001 in plc1.

Notes:

- Pay attention to Property Value Formats (single, double, or no quotes)
- The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
- Click the Ellipsis button (...) to select a tag, operator, or function which is defined in a library.
- The Order of Precedence must be considered in formulas.
- Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.
Notes:

- Pay attention to Property Value Formats (single, double, or no quotes)

Notes:

- The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
- Click the Ellipsis button (...) to select a tag, operator, or function which is defined in a library.
- The Order of Precedence must be considered in formulas.
- Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Expressions, Discrete

An expression that will evaluate to one of two states (for example, ON/OFF or True/False).

Examples of Discrete Expressions include:

- Indicator States - based on a machine's state, an indicator will show one status when a bit is ON, and another when the bit is OFF.
- Visibility Expression - based on the value of a bit, a control will be shown (or not shown) on a page.
- State/Style/Action - if the expression is true, a corresponding style will appear on the control.

Discrete Expressions will appear as in the following examples:

- 1
  When the expression is set to a numeric value of 1 (no quotes), its evaluation is ALWAYS True. This is used in expressions in which a certain state is always desired. For example to always display a specific control, set its Visibility Expression to 1.
- 'b3/0'
  The above example will evaluate to True when bit b3/0 is ON.
  **Note:** If the Client Library is set as the Default in the Unit's properties, then the library can be omitted from the reference. Otherwise, the reference must include the library, i.e.: 'Lib,LibEntry'.
- 'Bit1'
  The above example will evaluate to True when tag Bit1 is ON.
- '!Bit1'
  The above example will evaluate to True when Bit1 is OFF, and FALSE when Bit1 is ON.
- 'ClientLib,Bit1' == 1
  The above example will evaluate to True when Bit1 in the ClientLib library has a value of 1. Note that the expression 'ClientLib,Bit1', without the ==1, will have an identical result.
  **Tip:** All Client and Tag Libraries can be accessed from the drop down box to the right of the value field. For example, to select a library entry, select the type of library, then the **Library Name**, then the **Library Entry**, and 'Library Name, Library Entry' will be placed in the formula.
- '40001' == 200
  The above example (Equal to) will be True if register 40001 is equal to 200. This is a relational operator used for comparison purposes.
- '40001' = 200

613
The above example (Assign) will set the value of 40001 to 200. This is an arithmetic use for assignment purposes.

Note: In the above examples, the `==` (double equal signs) is used to see if the values are equal. This is different than the `=` (single equal sign) which will assign the value on the right to the tag on the left. Be careful!

- `'40001' > 10`
  The above example will evaluate to True when register 40001 is greater than 10.

- `'Pressure' > 250 || 'MaintenanceMode'`
  The above example (|| is a logical OR) will evaluate to True when Pressure is greater than 250, or MaintenanceMode is True.

Tip: All logical operators can be accessed from the drop down box to the right of the value field. For example, to select a logical "or" operator, select Operators, then Logical Operators, then Logical OR, and the "||" will be placed in the formula. Used these same steps for all operators.

- `'ControlBits' & 128`
  The above example (& is a bitwise AND) will evaluate to True when the 8th bit in ControlBits is ON, regardless of the other bits.

Notes:

- Pay attention to Property Value Formats (single, double, or no quotes)

Notes:

- The value expression entered can include as many PLC word or bit references and/or tags as needed, as well as mathematical operations.
- Click the Ellipsis button (...) to select a tag, operator, or function which is defined in a library.
- The Order of Precedence must be considered in formulas.
- Parentheses can be used to make an expression more understandable, and/or parentheses can be used to change the order of operations.

Note:

- In state evaluations (ie: Indicator and Led states), expressions are evaluated as specified by the State Evaluation property.

First Time User Tutorial

Project Requirements

At minimum, these project components are required to create a Unit:

- A configuration with at least one page.
- A client OPC connection.

After assigning the configuration and client to the unit then:

- Check the unit for errors.
- Send the files to the unit.

Application Creation

Follow these steps to successfully create a unit.

Note: Creating a "Unit" means creating an application to run on a unit. It is referred to as a Unit because, for most flexibility, the ePro software combines the necessary Runtime parts in a Unit component. The Unit combines a Configuration (Pages and Libraries) and a Client (eg: PLC).
1. Set up the Kepware_ePro OPC server for the destination device. Create a KEPWare configuration file (.opf) to send to the unit.

   • Open the KEPServer_ePro software.
   • Select the New icon in the KEPServer Toolbar.
   • Click as directed to add a channel in the software; give the channel a name; and choose the "Allen-Bradley Ethernet" device driver. Leave the rest of the selections as default. (The final screen in configuring the channel will give you a summary of your choices.)
   • Click as directed to add a device in the software. Give the device a name. Select "SLC 5/05 Open" for device model; and enter the proper IP address. Leave the rest of the options at defaults. (The final screen in configuring the device will give you a summary of your choices.)
   • Save the configuration file on your PC and exit KepServer_ePro.

2. Create an OPC client for each device in the Kepware_ePro server to which you wish to communicate.

   • Open ePro Canvas.
   • Right click the Clients folder and create a new OPC Client Adapter. Give the client a name.
   • Use the pull down arrow at the end of the Server Name field to choose EatonElectrical.KEPServer_ePro.
   • In the Access Path field, use the pull down arrow to select Channel1.Device1 where "Channel1" is the name of the channel you configured in Step 1 and "Device1" is the name of the device you configured in Step 1.
   • Click on the field labelled "Click here to import items".
   • Click "OK"

3. Create pages using the tags you created.

   • Click the Page bar in the component bar pane and double click the ePro ES/PS Page icon.
   • Name the Page.
   • Click “OK” and then double click on the page in either the project components pane or the component data pane. This will open the OI Page Editor.
   • Put a Readout Template on the page by either double clicking on its icon in the control bar pane or by clicking and dragging the icon from the control bar pane to the page view pane.
   • Double click on the Readout Template and make the following changes:
     General tab:
     • In the Value field, enter ‘N7:0’.
     • Use the pull down arrow to change Operator Input Type to Data Entry.
     Data Entry tab:
     • In the Target Expression field, enter ‘N7:0’="ClientSystem,?".
   • Click “OK” on the Readout Template Properties window and save the page.
   • Double click on the Rectangular Button and make the following changes:
     General tab:
     • In the Break Label field, enter "Exit".
     • Use the pull down arrow to change the Break Action field to select the ActionExit action.
   • Click “OK” on the Readout Template Properties window and save the page. Exit the OI Page Editor (not the Project Explorer!).

615
4. Create your configuration by linking pages to it.
   • Create a new Configuration and give it a name.
   • In the Home Page field on the General tab, use the pull down arrow to select the page you created as your home page.
   • Save these changes. (Click OK)

5. Create your unit by linking your clients and configuration to it.
   • Create a new Unit and give it a name.
   • On the General tab, Default Client Name field, use the pull down arrow to select the Client created in Step 2.
   • On the Destination tab, set the fields in Line 1 as follows:
     • Transfer .ucf – Yes if you wish to send the file to an ePro hardware unit.
     • .ucf Name – Click the Ellipsis button at the end of the field and use the dialog window to select the location and name of your .ucf file. (Must be done even if you’re not saving the file to your PC.)
     • Transfer Runtime – Yes (if you have not loaded the runtime to this ePro.) You will normally only need to download the runtime to your ePro ONE time. If you have already done this step, you may leave the option set to No.
     • Runtime – Use the Pull down arrow at the end of the field to select the correct runtime for your hardware unit. (Currently, there is only one choice.)
     • Transfer Driver(s) – Yes if you have not yet downloaded the correct driver to this ePro. This will send not only the KepWare driver, but the .opf file as well. You will normally only need to perform this step ONE time. If you have already performed this step, you may leave the option set to No.
     • Driver – Use the Pull down arrow at the end of the field to select the correct driver for your hardware unit. (Currently, there is only one choice.)
     • .opf Name – Use the Ellipsis button to select the .opf file that you wish to use on your hardware unit.
   • Destination Path or IP Address – Enter either the IP Address of the ePro unit to which you will send the files, or the Drive Letter of the compact flash reader on your system.
   • On the Destination tab, set the fields in Line 2 as follows:
     • Transfer .ucf – Yes if you wish to save the file to a location on your PC.
     • .ucf Name – click the Ellipsis button at the end of the field and use the dialog window to select the location and name of your .ucf file.
     • Click OK when you have completed data entry on these fields.
   • Be sure that the Unit you created is highlighted.
   • Drag ClientSystem from the project components pane to the component data pane and drop it on the icon of your unit.
     • Repeat for all OPC Clients.
• Drag your configuration to the component data pane and drop it on the icon of your unit.
  • The page you created has already taken its place as a subordinate to your configuration.
• Drag the ActionSystem Action Library to the component data pane and drop it on the icon of your configuration.
• Drag the MediaSystem Media Library to the component data pane and drop it on the icon of your configuration.
• When all components have been moved to the component data pane, right click on the icon of your unit and select Check for errors...
• Click the Check button and the Canvas software will scan your Unit Configuration File (.ucf) for errors. If errors are found, scroll to the highlighted error(s) and double-click on the error to bring you to the dialog box necessary to correct the error. Fix error and repeat until all errors are gone.

6. Once the errors are corrected, use the send to unit function to send the unit (compiled application) to the PanelMate ePro unit.
• Right click on the icon of the unit you created and select Send to file...
• Click the Send button at the bottom of the window.
• Canvas will automatically perform a check for errors on the application and – as long as that passes – will perform all selected options in the Destinations tab.

See Transfer Issues for help troubleshooting errors.

Notice that the media and action libraries are not involved because they are not necessary to create a unit. While these simple steps will create a functional unit. You'll want to make sure you take advantage of creating components for the libraries so that future units will be even easier to create.

Indexed Lists

Index Lists allows you to substitute properties of a configuration component dynamically based on the value of an index expression. This means that a page control or action can change its indication or control function online. The purpose of index lists is to reduce the number of pages needed in a configuration by allowing a single page to represent multiple unit operations or multiple diagnostic screens without changing pages by simply changing a single value that provides an index into one or more tags or expressions in a series of Indexed Lists. Simply put, indexed lists allow page components to reference lists of addresses or tags based on the value of an Index. For example a readout value can show different PLC addresses based on a PLC register that acts as an index into a list of those PLC addresses, and an indicator template may show states of a series of devices based on that same register value. Non-dynamic properties such as template titles and text controls can also show lists of string values based on an index.

An example helps to illustrate the use of Indexed Lists. The following pictures show a process that has three different unit operations called AGI Mix tanks. All tanks are fundamentally similar in terms of process inputs, outputs, status, and control functions.
Using Indexed Lists a single page may be created in ePro Canvas that represents all three Mix Tanks. A total of 24 indexed lists supports the single page’s 10 dynamic status attributes 7 control functions (5 pushbuttons and 2 numeric entry fields) and seven text fields, including the page title and template legends. In addition, if the scales of the bar graphs needed to be dynamic because of different pressure or temperature ranges from tank to tank, they could also be changed by Indexed Lists. The two up/down pushbuttons next to the page title increment and decrement a register that goes from 0 to 1 to 2 and is the index value for all 24 indexed lists. That register is also displayed as a readout value (‘register’ + 1) in the title area of the page to indicate the Mix Tank currently being displayed and controlled.

Another example of the use of Indexed Lists is in conjunction with Master Pages. A Master Page may be created where some of the page properties, such as page title, are driven by Indexed Lists whose index is the page ID Number property, referenced online by the System Client tag CurrentPageId.

The benefits of Indexed Lists are a reduction in the number of pages, and number of objects in the configuration, which saves memory, improves performance, and simplifies configuration management by reducing the number of copies of pages and objects with different address/tag references and expressions.

Creating and Using Indexed Lists

Indexed List entries are stored in Indexed List libraries and the library needs to be linked to the Configuration like all other Canvas libraries such as Media, Color, and Action libraries. The properties of an Indexed List are shown below:
Each Indexed List has an Indexed Expression that controls the Index List Entry value online. In the above example the tag ‘Vessnum’ in device PLC1 will be used to determine which index entry on the List tab is displayed at runtime.

The items in the List tab need to define the complete property value to be evaluated at runtime. That means that if a tag is part of an expression property, such as a conditional expression in an indicator template (Eg. ‘tag1’ & !'tag2’), or a scaled value in a readout (Eg. ‘N7:154’ * 9.5 + 32) the entire expression must be placed in the Index List.

To use an Indexed List when editing a page control’s property dialog, simply select the Indexed List entry from the Indexed List Library in the pulldown list or from the Expression Editor window. An example is shown below for the readout template showing V1FlowRate, V2FlowRate or V3FlowRate of the previous example:
Master Page

The purpose of Master Pages is to allow you to create one or more sets of objects that can be used on multiple pages of a configuration. This enables you to more easily develop a common look and feel to a configuration, create a consistent page change methodology, and manage information and control functions that are common to many, if not all pages. The result is that there are fewer total objects in a configuration since objects that appear on Master Pages are only defined once in the editor and online. This results in .UCF files that are smaller and utilize less system memory online. It also makes it simpler for you to make changes to common page controls, since you only need to change it once on a Master Page being utilized by other pages.

Master Pages are defined in the Page Properties of every page. You can designate either no Master Page or up to three Master Pages for each page. Since there is no difference between a Master Page and a normal page, any page can be used as a Master Page for any other page and a Master Page may contain any components that can be placed on any other page, both static and dynamic. Master Pages must be added to a Configuration’s “Pages” tab like any other page and they will be accessible just like any other page in a configuration. If you do not wish to allow an online user to be able to change pages to a Master Page you should set the Page Enabled Expression for a Master Page to zero (0).
When you assign Master Page(s) to a page you also choose the draw order of Master Page components relative to the page. Each Master page's components can be set to draw in Front (on top) or in Back (behind) of the page objects as shown in the following example:

![Project - Page - 15 Inch 3 by 5](image)

For example if the following page were used as a Master Page for other pages, online each page would look just like any other page but the shared components would be identical on each page. (Note: this example also uses an Indexed List to change the text in the Title bar at the top of each page based on the Page ID Number)
Master Page Example
Online Example 1
### PanelMate PowerPro Import

The PowerPro Import utility provides a means of upgrading prior product files to ePro Canvas. Specifically, a PanelMate .PPS configuration file can be imported.

*Note: This function is only available with the ePro Canvas "Professional" version of software.*

#### How to Import a .PPS file

1. Copy the .PPS file to the ePro Development PC.
2. Run the ePro Canvas Professional software.
3. Select File/Import/PowerPro Configuration
4. Locate the .PPS file from step 1 above.

The Project Explorer tree will be populated with Configuration, Client, Messages, Pages and etc. from the .PPS file.

#### Supported Features

Support for importing of PanelMate Power Series/Pro application features in ePro Canvas Professional falls into three categories, Fully Supported, Partially Supported, and Unsupported. It is the user’s responsibility to determine what to do about unsupported features in the new ePro Canvas solution. The following describes in detail all of the Power Pro application features and in which category each feature falls.
Fully Imported

- All PPS files will be imported and converted to Canvas Units with the name of the PPC file.
- All page components will be imported and converted to their equivalent Canvas components including text, graphic primitives and bitmaps. Bitmaps will be created in the Image folder for the configuration (default: C:\Program Files\Cutler-Hammer\ePro Software Suite\Images\PPSFILENAME) under a folder named after the imported PPS file name.
- All PLC and OPC references, conditions and expressions will be converted to their equivalent Canvas syntax and operators.
- Symbol Library – All symbols are converted to enhanced metafile format, .EMF, and placed in the Image folder for the configuration (default: C:\Program Files\Cutler-Hammer\ePro Software Suite\Images\PPSFILENAME) under a folder named after the imported PPS file name. The symbols are all contained and referenced in the new Power Pro Media Library.
- PanelMate startup page number will become the Canvas Home page
- The Default PLC Name in the PLC Name & Port Table will be converted to a client connection with the device name preceded by the PPS file name and it will be set as the Default Client Connection of the Unit. Any non-default devices will have the converted Client name appended to the reference in 'device,reference' format.

Partially Imported

- All Devices in the PLC Name & Port will be converted to OPC client connections. If the device was attached to a Native PLC driver all driver setup information is included in the Import Warnings property to assist the user in setting up the equivalent Keypware OPC Server. Any OPC devices will have the same Server Name and Access Path as referenced in the PPS file.
- All Pages will be imported and the page names will be preceded by the PPS file name followed by an underscore. The PanelMate page number will be converted to the Page ID# in Canvas. Page Password protection is not supported and Maintenance Templates are not supported.
- Colors are converted to the Windows RGB color values for all colors except blinking colors. The ColorSystem Color Library contains blinking colors entries that match each of the possible blinking colors from PanelMate Power Pro. Any blinking colors will need to be mapped by the user to the corresponding blink entries of that library.
- Text with the vertical attribute selected will be imported but displayed as Horizontal Text.
- Variable-Sized Graphic objects will import and link their indicator states to the imported symbols in the Power Pro Media Library. Override colors for foreground or background color of those symbols are not supported.
- The Message Library will be imported as a new Canvas component called Power Pro Media Library. All message text, message numbers (ID’s), fonts, colors and any embedded data references will be imported with their format strings, but time/date format will not be supported. The destination field, screen/printer/both, is not supported since all messages will only be sent to the screen. Message Library Commands – any messages preceded by the @ sign used for Passthrough functionality, re-direction of the message library to a .CSV file, or initialization of internal scratchpad variables – are not supported.

Not Imported

- Default Page Components – The four page components that are built into each PanelMate Power Pro page (optional when using Flexible Page Layout) are not imported. These include the Page Status Banner, Cancel Key, Alarm Table, and Default Buttons.
- Default System Components – All System Parameters with the exception of the startup page number are not imported.
- Alarms are not imported or converted to ePro Canvas events
- System Online Labels are not imported.
- Internal Scratchpad Variables are not imported.
- Online Comm. Error line function is not imported.
- Enable Fault Relay/Comm. Error Reset function is not imported.

**Import Suggestions and Workarounds**

**Un-imported Default Page Components**

In general the Default Page Components are ideal candidates to go on a Master Page (new in V2.10) used by all pages. For the Page Name shown in the Page Status Banner an indexed list (also new in V2.10) containing page titles indexed by the system tag CurrentPageId would work in a Master Page.

- **Page Status Banner** – Provides the Page Name and shows any pages that contain active alarms with the page number with a blinking red background. Solution/Workaround: Place a text control at the top of the page showing the page name. Since alarms aren’t associated with page components in ePro Canvas the page alarm feature does not translate into a Canvas feature. However, the internal system tag “EventsActiveUnacknowledge” can be used for indication of any active-unacknowledged alarms whenever it’s value is greater than zero and this indicator can be placed on top of the Page Name text field in the form of an LED control.

- **Cancel Key** – Provides an area labeled “Cancel” which can be touched to de-select any template and “cancel” the display of any two-touch control functions (pushbuttons & numeric entry). Also displays the real-time clock in HH:MM:SS format. Solution/Workaround: Add a text control labeled “Cancel” and a Clock control to the page where the Cancel key was.

- **Alarm Table** – Provides four lines of alarms under the Page Status Banner. Solution/Workaround: Open the alarm/event banner in the area where the Alarm Table was located.

- **Default Buttons** – Provides standard buttons to navigate page changes (by page number), view or acknowledge alarms, silence the alarm horn, and clear intermittent communications errors. Solution/Workaround: Create a vertical button bar with buttons to call the “Get Page” action, the Open Event Banner in full screen Action, and an assignment action to clear the system tag “CommErrorDetect” (for clearing communication error indication).

**Default System Components**

System parameters for the following features are not imported:

- **All Password Functions** – Includes Password A and Password B and changes or overwrites to those two passwords, Page Password Timeout, Password protection of Offline Mode or Set Date/Time. Solution/Workaround: Future releases of Canvas will include built-in password/security features. In the meantime passwords can be stored in the PLC and used to control page access through the Page Enabled expression of page properties, and object selection/control access through the template visibility attribute of individual page objects.

- **Retry Delay** – This function relates to PanelMate communications drivers (native, non-OPC drivers) and how you could configure those drivers to reduce their polling rates when communications failures were detected. Implementation of this function is the responsibility of the OPC server provider.

- **Bit Zero after Comm. Fault.** – This feature was used to reset all momentary pushbutton bits in the PLC whenever the operator pushed the ”Enable Fault Relay” button following a communication error. This was a safeguard to make sure that any missed momentary pushbutton writes to the PLC due to a communications error would place the bit back to a reset state. Solution/Workaround: Add a “heartbeat” function to the Canvas application. Set up an assignment action as a conditional-passthru assignment where the ePro would read a counter in the PLC and write the value to another register in the PLC. If the PLC increments the counter at a rate that insures the ePro should be able to read and write back the counter value in the time frame, logic in the PLC can detect this loss of communications and automatically reset any critical momentary control bits in the PLC.
• Audio Output Parameters for Operator Input and Alarms – The PanelMate Power Pro’s audio output port could be used to drive an 8 ohm speaker and it could be configured to sound the horn on alarm and when a user input function, like pushbutton make/break, occurred. Solution/Workaround: In the next ePro PS load (due in January 2005) certain USB audio devices will be supported. Using the new Actions, Start Application, and Action List, wave files can be run to produce audio feedback for new alarms and pushbuttons.

• Inactivity Period Parameters for Screen blanking and Automatic device Cancellation – These features would put the display in a “screen saver” mode after a configured time of inactivity, and would cancel any operator control selection (two-touch control buttons or numeric entry) after a minute of inactivity. Solution/Workaround: Configure the backlight dimming feature of all integrated ePro PS units (not available on the blind node) to dim the screen to increase the life of the backlight after so many seconds of operator inactivity. There is no way at present to automatically “cancel” an operator’s selection of a control device.

• Control Bit Reset Delay – This was used for delaying the bit write (reset) on the “break” of a pushbutton for those cases where a long ladder scan time might cause the PLC to miss the momentary pushbutton of the operator. This function is rarely required and no simple workaround for this exists today.

• Host Window Display Mode – This rarely used feature allowed the user to open an area of the PanelMate screen to receive serial ASCII text from a host computer and emulate a dumb terminal. Solution/Workaround: Use Windows Hyperterminal for this function and launch it and control it using the Start Application Action.

• Immediate Page Change – This setting allowed the remote page change function to change PanelMate pages even when a two-touch control was “selected”. Solution/Workaround: Using a conditional Goto Page Action based on a PLC register which ties to the Page Index will automatically work this way.

• Extended Fonts and any changes to editable characters in any of the four fonts – This feature was used because PanelMate’s limited character set make it difficult to do international applications. Solution/Workaround: Using Windows True Type fonts and Unicode support in ePro Canvas allows you to use any international characters including Hebrew, Greek, Cyrillic and the ideogram characters used in Chinese, Japanese, and Korean languages. This coupled with the multi-language support of the media library is a much more robust solution for international languages and fonts.

• Redefined Double High or Quad Fonts, are not supported by PPS import. This feature was a carryover from the DOS editor which didn’t support pixel based graphics and symbols were created by character graphics. Solution/Workaround: If an application was imported into PanelMate Power Pro from the DOS editor and these character based graphics were never converted into Power Pro’s pixel-based graphics you will now need to recreate those old symbols. With ePro Canvas support for BMP, JPG, EMF, WMF, and GIF graphics formats the user has a wide array of tools and images to create realistic pixel based graphics.

• All Remote Functions – Includes Silence Alarm Horn Bits, Alarm Acknowledge Bits, Enable Fault Relay Bits, Page Change Registers, Reset Clock Bit, Sending of Passwords to Registers, Sending of Hardware Selection Status. Solution/Workaround: Most remote functions can be accomplished in ePro Canvas using Actions. Some, like Enable Fault Relay Bits and Sending of Hardware Selection Status simply don’t apply to the new hardware. Remote Page Change to PLC can be accomplished using a Conditional Passthru Assignment action to write the system tag ‘CurrentPageNumber’ to a PLC register. A conditional Goto Page action can be used to go to the page whose index matches a PLC register value. Currently there is no provision to remotely acknowledge alarms or to set a remote bit when the operator acknowledges alarms in ePro PS Runtime.

Alarms

Alarms are not imported or converted to ePro Canvas events. Alarms in PanelMate Power Pro were tied to visual page objects and which required the user to create a visual component to build any and all alarms. In ePro Canvas alarms and events are created in the Log Event Action. All system events and alarms can be configured either in a conditional Log Event Action, type->expression or type->bit if the alarms are being packed as individual bits within words. Solution/Workaround: The import operation identifies all page components that have alarms associated with them and embeds Import Warnings into the properties of each imported item. The operation also creates a
single text file for each imported PPS that lists all import warnings for the entire configuration. The developer can then go through each page in the text file and copy and paste the alarm text as they configure the Log Event Actions for the configuration.

**System Online Labels**

PanelMate Power Pro System Online Labels gave the user the ability to modify all default system text for menus and buttons in the runtime application. It was mostly used for non-English language applications so that the user could provide translations for those default runtime functions. Solution/Workaround: All ePro Canvas runtime text is configurable by the user and these labels may reference Media Library text strings that contain multiple language translations and can change at runtime based on the Active Language Expression. Because the default text strings in the ePro PS Runtime don't match those from Power Pro there is no reason to import System Online Labels.

**Internal Scratchpad Variables**

PanelMate scratchpad variables were used to hold local operator selections and to control how certain runtime features operated. Solution/Workaround: With ePro PS’s built-in OPC server, KEPServer_ePro, the user has the ability to create a connection to local variables/tags stored in a 16-bit device attached to a channel using the Simulate driver. These variables can be of any data type and can be used to replicate any PanelMate Power Pro scratchpad functions needed by the application.

**Online Comm. Error line function**

The PanelMate Power Pro would always report PLC and OPC communication errors by displaying those errors in White on Red text at the bottom of the runtime page. Except in the PanelMate PC application these errors could not be stored for future review and in no case could they be displayed in any alternative format. Solution/Workaround: All communication errors reported by the OPC server as “bad” data quality are placed in the Alarm/Event log and the system variables ‘CommErrorDetect’ and ‘CommErrorMsg’ can be used to indicate communication errors status to the operator. The system writes a one to the ‘CommErrorDetect’ tag whenever the OPC server reports a new error. The application can use any indicator device to show the status of this tag and a button can be placed anywhere on a page to zero out the tag and clear the indication. The system also writes the text of the error into the tag ‘CommErrorMsg’ so that the user can display its contents with a standard Text object.

**Enable Fault Relay/Comm. Error Reset**

This feature in Power Pro reset the Fault Relay hardware component following a reported communication error and forced a redraw of the PanelMate page to clear the red communication error line. Since the Fault Relay function would be replaced by a PLC “heartbeat” function (described in item 2c above) the PLC will already detect when the communications is restored. And since the user controls the display of communications with the ‘CommErrorDetect’ and ‘CommErrorMsg’ tags, the pushbutton to reset these tags will clear the indication without requiring a screen redraw.

**Image Directory**

When a PPS file is imported a directory is created under "C:\Program Files\Cutler-Hammer\ePro Software Suite\Images" with the PPS file name as the directory name. In that directory a text file name ImportInfo.txt is created that summarizes all the steps taken during the import process. It encapsulates all warnings for each component viewable in the Message Pane and summarizes all object warnings per page which simplifies conversion of PanelMate Alarms to ePro Canvas Alarms/Events.

**A new Message Pane**

A new visual panel available in the Project Explorer of ePro Canvas Professional, the Message Viewer displays all Power Pro import information captured during the import step that can be used for completing the conversion of Power Pro applications into Canvas applications. It lists all features of the selected imported PPS component that were not converted by the import process. This information can then be
used to determine what additional effort is required to incorporate those features into the Canvas application.

To enable the Message Viewer select "View > Message". This will add a pane at the bottom of Project Explorer as shown below:

![Diagram of ePro Canvas with Message Viewer](image)

When a component in the Component Data pane is selected, (Unit COLMAC3.PPS shown above), the Message Viewer shows the file name and date the PPS file was imported followed by any warnings of non-imported features or parameters. The scroll bar can be used to view all of the warnings or the pane may be resized as shown below to view all of the import information and warnings.
When viewing page components as shown below, any page objects that have alarms associated with them will show in the Component Data pane with warnings. Selecting those components will display the warning details in the message pane as shown below:
An alternative view of any import warnings is shown in the General Tab or any object’s properties. The following dialog box for the imported Unit Properties is shown below. The Import Warnings field can be resized vertically to show the entire text of the field:
Parameter Passing

Parameters can be passed to Actions. This minimizes the number of Actions that are necessary by allowing re-use for similar instances. Two examples of this are shown below.

**Page Change Example (Goto Page Action)**

A good example of parameter passing is an Action file that is set up to call a page by passing a parameter (ie: the Page Name) from a Button on the page. Without parameter passing, an Action would need to be created for each page that will be called.

The following is an outline of how to create a re-usable GoToPage Action:

- Create 2 Pages, PageX and PageY.
• Create a **Goto Page Action** called GoToPage and set its **Destination Page** to #1. The #1 is a placeholder for the first parameter passed with this Action. The passed value (PageX or PageY) will replace the #1.

• Create a **Rectangular Button** on PageX and assign its Break Action ‘GoToPage(PageY)’. By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the GoToPage action.

• Create a **Rectangular Button** on PageY and assign its Break Action ‘GoToPage(PageX)’

The button on PageX will call PageY and vice-versa, with a single Action entry.

**Notes:**

• Page changes should be a result of the **Break Action** since that would be the last operation to be performed on the calling page. If the Make Action was used, then a new page would be called, and the Break Action from the calling page would be lost.

• #1 is used in the Action entry file as a placeholder for the first passed parameter.

• By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the GoToPage action.

**Bit Write Example (Assignment Action)**

Below is an example of a single Assignment Action entry used to turn a bit ON then OFF. This example allows sharing the BitChange Action for both writes.

• Create an **Assignment Action** called BitChange and set the first **Assignment Expression** to 'Bit'=#1. (Again, the #1 is where the first passed parameter will be placed.)

• Create a Page.

• Create a **Rectangular Button** on the Page and put 'BitChange(1)' in the Make Action field and 'BitChange(0)' in the Break Action field. Again, the value in parentheses and within the single quotes is the parameter to be passed to the BitChange actions.

When this button is pressed, the command becomes 'Bit'=1. Similarly, when the button is released, the command becomes 'Bit'=0. This example is a momentary pushbutton.

**Notes:**

• This type of control should be used with caution. The response time (between the make/break and the corresponding bit writes) may not be accurate enough for time critical applications.

• #1 is used in the Action entry file as a placeholder for the first passed parameter.

• By placing a value in parentheses and within the single quote, it becomes the first parameter to be passed to the BitChange action.

**Property Value Formats and Syntax (single, double, or no quotes)**

Throughout the ePro Canvas editors and property windows, property values of various types are entered. Depending on whether the value is **Evaluated** or **Non-evaluated**, several rules must be followed to accurately enter these values. Before the rules are applied, it must be determined whether it is an evaluated property or not.

**Evaluated Properties**

Properties which can vary during Runtime, require a mathematical evaluation and parsing for proper syntax. These **Evaluated properties’** entries can be dynamic, thus having an undefined number of values. It is possible and common for an evaluated property to contain an entry or expression that is not dynamic, but the property is still evaluated. In the editor, there is a simple way of determining if a property is evaluated. If a property has a pull-down arrow ( seçenek ) which leads to a pull-down library menu, the property is **evaluated**. In the figure below, the Value property has a pull-down arrow, and when the arrow is selected, a library menu is presented as shown below. This gives access to various references.
from various locations, all of which can dynamically change during runtime. So, the Value property of a Readout Template is one example of an Evaluated Property.

Non-evaluated Properties

Properties which contain values which cannot vary during Runtime are NOT evaluated. Non-evaluated properties are static and have a finite set of values. These property types can be determined by the properties’ type of entry - when the library menu is not available, the property is non-evaluated. For instance, fields with no pull-down arrows, Yes/No selections, and short menus are all NOT evaluated.

Below, the Orientation property is non-evaluated because it’s pull-down arrow leads to a menu with only several options (not the entire library menu).
Evaluated Properties Syntax

Note: Using the pull-down menus to select the entry values is the easiest way to determine syntax, because quotes are automatically added when needed.

Text and Names

Double quotes are required around strings which include text and names.

- **Text Strings** that are entered directly in a **Text** property or a **Media Library Entry** will be displayed exactly as entered, and requires DOUBLE quotes
  - "Template Title"
  - "rpm"
  - "This text will appear"

Note: when referencing these media library entries, the strings are referenced with single quotes.

Note: Legal characters in text fields (i.e. characters within double quote marks, “abcdedg” ) include all Alpha and Numeric characters, spaces and special characters except:

- Backslash. To display a backslash within double quotes you need to place a second backslash in the string. Eg. "Start \ Stop” will display as Start \ Stop
- Double Quote. To display a double quote within double quotes it needs to be preceded by a backslash and must be either the first or last character in the string. Eg. "\To be or not to be\“ will display as “To be or not to be”. To place double quotes in the middle of a text string you need to use text concatenation. Eg. “This is a “Special” + “case” will display as This is a “Special” case
Single Quote. To display a single quote within double quotes it needs to be preceded by a backslash. Eg.
"This is a "Special\" case" will display as This is a ‘Special’ case.

Ampersand. To display an ampersand within double quotes you need to place a second ampersand in the string, otherwise the ampersand character serves to underline the following character within the string. Eg.
"This && That" will display as This & That. Whereas the string "&T&N&T" will display as TNT.

• **Images on a Page** can be directly entered (ie: not using the media library) by browsing for the image name, which will add DOUBLE quotes and double the backslash characters
  
  • "c:\overview.bmp"

  Note: Backslashes (\) are used to identify control characters embedded in a string. If a \ is needed inside a string with double quotes, it must be duplicated for distinction (ie: "c:\\path\\filename"). However, / can also be used without doubling (ie: "c:/path/filename").

Images can also be manually entered with single forward slashes

  • "c:/overview.bmp"

  Note: When Images are entered into the media library, quotes are not required.

• **Documents** entered into a View Action, Document Viewer Type, require a name in DOUBLE quotes. Again, backslashes are doubled.

  • "d:\information.html"

Documents can also be manually entered with single forward slashes

  • "d:/information.html"

• **PLC or Library Entry Data** can be embedded into text strings as described below under the Combinations/Expressions/Concatenations heading.

**Library References**

Generally, single quotes are required around library entries. A good way to enter these is by selecting the pull-down box, and drilling down through the libraries to find the entry. Single quotes will automatically be added when needed

• Properties that contain **Clients** and **Library Entries** (Tag Library Entries, Action Library Entries, Media Library Entries, etc.) are entered with SINGLE quotes

  • 'ClientPLC,400001'
  
  • 'Tag'
  
  • 'LibEntryName'
  
  • 'Lib,LibEntryName'

• Active library names can be entered alternatively, using **Explicit** references to Clients and Library Entries. These are entered with SINGLE quotes. ‘MediaLib1,Ref’ can be replaced with

  • ':Media:,Ref'

• **Text** referenced in a text property, from Media Library entries will be enclosed in single quotes, even though the reference represents text strings (‘StartText’, 'TextLib,StartText').

  Note: when text strings are created in media library entries, remember to place the strings in double quotes.

  Note: Legal characters in tag names or Item Names (i.e. characters within single quote marks, ‘abcdefg’ ) include all Alpha and Numeric Characters, spaces and special characters **EXCEPT:**
# Casting operator

@ Internal Client separator

, Comma

= Equal Sign

\ Backslash (Escape Character)

' Single Quote

" Double Quote

## Literal Numbers

Literal or hard-coded numbers used within evaluated properties, require NO quotes. These are evaluated because of their property type, yet are static since the value will not change during Runtime.

- **Evaluated Numeric Values** have NO quotes
  - 1
  - 98765
  - 2005

## Combinations/Expressions/Concatenations

Expression properties follow the same rules in that references (tags, client tags, media entries) require single quotes, but constants and operators do not have quotes.

- **Writes**
  - 'Client,Ref' = 1

- **Comparisons**
  - 'Client,Ref' == 1

- **Scaling**
  - 'Client,Ref' / 10

- **To embed data** from the PLC in a text string, i.e. to mix text and data in a text control, you must use text concatenation.
  - "The tank level is " + $I4('client1,tag1') + " Gallons"

If the value of tag1 is 1234, this will display ... The tank level is 1234 Gallons

When using concatenation you may embed spaces either before or after the plus character to view the sting more clearly in the editor and the spaces outside single or double quotes will be discarded at runtime.

Anywhere you can place literal text (i.e. text within double quotes) you can also place media entries or tags with data type of string. Any tag references within the parentheses of the formatted data can use math or logic operators to create an expression. The following is the general formatted data syntax:

$tw.d(expression)

where ...

$ = format indicator

t = type of numeric display
I - Integer  
H - Hexadecimal  
B - Binary  
D - Floating decimal real value  
O - Octal  
F - Fixed decimal real value  
A - Ascii  

w = Total field width including decimal point, negative sign (-), and positive sign (+)  
. = Separator between width of format and the number of decimal places (used with F format)  
d = Number of decimal places (used with F format)  

Format type D (floating decimal point) permits the decimal point to float in the display depending on the tag's value. This contrasts with format type F (fixed decimal point) which formats a value with a fixed decimal location.

Formatted Data Examples:
If 'client,tag1' has a value of 54321, then:

<table>
<thead>
<tr>
<th>Formatted String</th>
<th>Value Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>$I5('client1,tag1')</td>
<td>54321</td>
</tr>
<tr>
<td>$F6.2('client1,tag1' / 100)</td>
<td>543.21</td>
</tr>
<tr>
<td>$D8('client1,tag1'/100)</td>
<td>543.2100</td>
</tr>
<tr>
<td>$H4('client1,tag1')</td>
<td>D431</td>
</tr>
<tr>
<td>$O6('client1,tag1')</td>
<td>152061</td>
</tr>
<tr>
<td>$B16('client1,tag1')</td>
<td>1101010000110001</td>
</tr>
</tbody>
</table>

If 'client,tag1' has a value of 16706, which is 4142 hex (A=41 hex, B=42 hex), then:

<table>
<thead>
<tr>
<th>Formatted String</th>
<th>Value Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A('client1,tag1')</td>
<td>AB</td>
</tr>
</tbody>
</table>

If there is no additional literal text, media library text or PLC String data types to appear in the text control and you only wish to display the value of the tag you don't need to use the formatted data syntax because the text control will automatically convert the value to a string. For example, if the text property is set to 'client1,tag1' and the value is 54321 then it will display as 54321.

- ':Media:,Motor 1' + '' + ':Media:,ON' + '' + $I5('client1,tag1') + '' amps''

Assuming the media library has two entries named 'Motor 1' and 'ON' containing their respective strings, and the tag 'client1,tag1' is a 16 bit integer (short) data type with a value of 54321, then the preceding text property value will be displayed online as ...

Motor1   ON  54321 amps

Non-evaluated Properties Syntax
If it is determined that a property is **NOT Evaluated**, then there are **NO quotes required**. The majority of these are numbers and pull-down menu entries (but not pull-down library entries).

**Non-evaluated/No Quotes Examples**

- Non-evaluated values with a YES or NO value require no quotes.
- Non-evaluated values selected from a **pull-down menu** with few choices will be selected from the menu and contain NO quotes.
  - HORIZONTAL
  - VERTICAL
  
  **Note:** this does not include the pull-down library box.
- **Strings** that are not evaluated, such as a page added to a configuration, do **NOT** require quotes.
  - Page 1
- **Images** that are entered into the media library by browsing for the image path, will add a path string with **NO quotes**
  - c:/overview.bmp
  This entry can also be entered as
  - c:\overview.bmp
- In the **Document Viewer, Home Page** and **Document Viewer Content, Document Location** properties, **NO quotes are used**
  - www.eaton.com
  - d:/information.html
- **Non-evaluated Numeric Values** have **NO quotes**

**Recipe Development**

The ePro Canvas Professional’s Recipe Management functionality is comprised of four separate components:

1. Recipe XML file
2. Recipe Action
3. Recipe Runtime Licensing
4. Recipe Menu Control

All except for item 4, the Recipe Control, are required components for successful Recipe Management. It should be noted that a simple form of recipe management is possible using the Assignment Action to create lists of PLC register, or tag assignments which are built into the Runtime application. The downside of this simpler approach is that changes to the “recipes” contained in the application cannot be made without editing the Assignment actions in the ePro Canvas editor. The Recipe Management functionality allows the developer to create and maintain the recipes by editing an separate XML file using standard PC tools such as Microsoft Excel or Access. Note that support for editing XML files in Excel or Access requires either Excel or Access XP or 2003 versions at a minimum.

**The Recipe XML File**

A sample recipe XML file named “SampleRecipe.xml” is installed with ePro Canvas Professional V2.20 and is located in the base ePro Software Suite installation directory. The sample recipe file contains three sheets with each sheet representing a different recipe and where the sheet name is the recipe name of each (shown below):
The general format of a recipe in the Recipe XML file is:

Row 1: A header showing the definition of each of the four columns of recipe information.

Rows 2 through N: The recipe definitions of ingredient/step identifier, destination location, value and units.

Column 1: These are the names the user chooses to supply to identify the parameter name of each recipe ingredient or step. This column is used only for reference when editing the recipe and as a convenience to the developer to help identify the content of the destination address or tag shown in Column 2.

Column 2: This is the complete reference for each parameter of the recipe. The format of each cell is DeviceName,Tag (or address). The device name must match the name of an OPC Client connection configured in the ePro Canvas configuration which uses the XML file for Recipe Management and the Tag or Address must match a reference accessible to that OPC Client connection. The examples shown above represent an OPC Client named "PLC1" and the addresses represent standard Allen Bradley PLC5 or SLC 500 integer file registers. If the OPC Server contains tag names then those tag names may be substituted for the address references. Note that the device name is required even though the OPC Client named "PLC1" may be the default client connection defined in the unit properties general tab. Also note that the addresses/tags shown in one recipe may or may not be the same as addresses/tags in another recipe contained in the same XML file. Each recipe sheet within the recipe file is totally independent of all other recipe sheets in the file.

Column 3: This column represents the value of each parameter which will be written to the corresponding address or tag shown in Column 2 when a Recipe Download Action is initiated for that recipe.

Column 4: This column is used to identify to engineering units of each parameter in the recipe. Like column 1, the Units column is included as a convenience to the recipe developer to help identify the content of the destination address or tag shown in Column 2.

Note that each cell in the four columns must be filled in as no empty cells are permitted except after the last row defining each recipe. There are no imposed limits to either the number of ingredients in a single recipe or the number of recipe sheets in a single XML file. However, there are practical limits to the number of parameters contained in a single file which dictates how long it takes the ePro PS to read in a recipe file when a Recipe Management Action or Recipe Control needs to access the file. For example, a standard ePro PS will take up to a minute to read in a Recipe XML file containing 5000 parameters. If a single file is too large to hold all required recipes it is possible to use multiple Recipe XML files and multiple Recipe Actions and controls in a single ePro Canvas application.

The Recipe Action

The Recipe Action is only available in ePro Canvas Professional.
Note: This action is only needed if it is desired to have customized recipe functions (for instance, a stand-alone Load button). The functions necessary to operate and control a recipe are built into the Recipe control.

The Recipe Action has three modes, Load, Compare and Save. These three action types are detailed as follows:

See Recipe Management Action for additional information.

**Load Recipe Function** – If the Function property of a Recipe action is set to “Load”, the action, when executed at runtime, will load values to the OPC Client connection specified by the selected Recipe Name parameter from the selected recipe file specified in the File Name parameter. An optional field, Active Indication, allows you to specify a tag or address which will be written to in order to provide a mechanism to indicate that the recipe load function is in process via an Indicator or LED control. The recipe management load function will write a value of one to the Active Indication tag at the start of the load process and will write a value of zero to the same tag when complete.

The Log Event parameter can be set to Yes or No to enable or disable automatic logging of the Recipe Load event to the alarm and event log.

**Compare Recipe Function** – If the function property of a Recipe action is set to “Compare”, the action, when executed at runtime, will compare the values read by the OPC Client connection specified by the selected Recipe Name parameter to the values contained in the selected recipe file specified in the File
Name parameter. The numeric value of the number of comparison mismatches found will be written to the tag specified by the Ingredient Mismatch parameter. An optional field, Active Indication, allows you to specify a tag or address which will be written to in order to indicate that the recipe compare function is in process. The recipe management compare function will write a value of one to the Active Indication tag at the start of the compare process and will write a value of zero to the same tag when complete.

**Save Recipe Function** – If the function property of a Recipe action is set to “Save”, the action, when executed at runtime, will save the values read by the OPC Client connection for the last loaded recipe to the values contained in the selected recipe file specified in the Destination File Name parameter. **Note the Save function is only available if the last loaded recipe is highlighted.** The Destination File Name may be the same or different from the source file specified in the File Name parameter. If the two parameters are the same, then after saving the recipe file the recipe management function will re-read the Recipe XML file to in order to clear out the previous values from the selected recipe from ePro PS memory. This is done so that if that recipe is selected again for a Recipe Load function, the newly saved values will be loaded. An optional field, Active Indication, allows you to specify a tag or address which will be written to in order to indicate that the recipe save function is in process. The recipe management save function will write a value of one to the Active Indication tag at the start of the save process and will write a value of zero to the same tag when complete.
Recipe Runtime Licensing

The ePro PS license manager is loaded on each ePro PS machine. The runtime license for Recipe Management functionality, like the Data Archive functionality, is an optional component which must be purchased in order to use these features on an ePro PS unit. The Registration process is identical to that of registering ePro Canvas or ePro Canvas Professional software. First the ePro License utility must be started on the ePro PS unit from the start menu and the ePro Recipes line must be selected from the Software Registration dialog as shown below. If the Recipe Management feature is already licensed it will show a state of "Registered-License Active", and the Activation key will show the key that was generated during the activation process. If unlicensed then only the Registration code field will show. To register and receive an Activation Key, follow the directions shown in the Software Registration dialog box. Be sure to have the serial number of the purchased Recipe Management license handy because that will be a required field in the online form. Once you receive the Activation Key following the online registration you may enter that key and click on the Apply Activation Key button. Once you have applied the activation key a dialog box will appear to indicate that the registration process was successful. If there was an error in entering the Activation Key you will be prompted to recheck the value and enter the key correctly.
Once successful, OK the success dialog box, Exit the Software Registration utility and perform a Protect Mode Save on the ePro PS to ensure that the registration is made permanent on the ePro unit.

Alternately, you may initiate the activation process before receiving the Activation Key by selecting the ePro Recipes line in the Software Registration dialog and hitting the Initiate License Activation key. Then exit the dialog box and run the Protect Mode Save function. This will give you a 10 day grace period during which you may run the Recipe Management features in full functional mode. Once you receive the Activation Key you will then need to re-open the ePro License utility to complete the activation process by entering the Activation Key and performing a Protect Mode Save function.

The Recipe Menu Control

The Recipe Menu Control is a page component that supports the Recipe Management functionality by providing an easy way to view a list of recipes and select a recipe for the Load, Compare, and Save functions. Since a Recipe Name property in a Recipe Action may be directly entered in the action, or it can be generated from other selection mechanisms that write a recipe name string value into the tag or address specified in the Recipe Name property, the Recipe Menu Control is not necessarily required to create a functioning Recipe Management application. However, you may find it a convenient way of providing easy recipe selection when online. The Recipe Menu control may be placed on any page using ePro Canvas Professional development software. The control’s default appearance is shown below:
Also see Recipe Menu Control for more details

When you go to the Recipe Menu control’s properties box, the top level properties are shown below:
The Title parameter defines the name shown in the Legend subcomponent and the File Name parameter defines the path where the ePro PS unit will find the Recipe XML file which you wish to associate with this Recipe Menu control for runtime recipe selection. If Operator Input Type of Button is selected as shown above, then six buttons will be pre-populated to for built in Home, Scroll Up, Scroll Down, Load, Compare, and Save button controls. This is one method by which you can allow the online operator to select recipes when there are more recipes in the Recipe XML file than can be shown at one time within the Recipe Menu control. Other standard ePro Canvas methods may be used to write to the Index Input Location parameter found on the "Menu Device" subcomponent (as shown below) which can serve to create a page up/down mechanism.
The Menu Device subcomponent provides four unique parameters for this control. The Index Input Location tag or address, when written to online, will automatically scroll and select the recipe sheet in the Recipe XML file corresponding to the number in the tag and will subsequently write to the next two parameters, Index Output Location and Text Output Location. The Index Output Location is used to show the selected recipe via highlight color (specified in the "Attributes" tab of the Menu Device subcomponent). The Text Output Location parameter contains the text string of the selected recipe (sheet name in the Recipe XML file). This may also be used in the Recipe Actions for loading, comparing or saving functions. The 2 Touch Select parameter when set to "On" is used to allow the Home, Scroll Up and Scroll Down buttons to also select the highlighted recipe name so that the user doesn’t have to actually "touch" or click on the Recipe Menu control to select the highlighted recipe. If the parameter is set to "Off" then these buttons don't automatically select the recipe, they just allow the user to view recipe names when the number of recipes exceed the display capacity of the control.

The Attributes tab allows you to customize the color choices for Recipe Name highlighting and selecting.
Referencing Media Library by ID Number

The Id Number of a media library entry can be used to reference that entry in a text field in the ePro Canvas editor. For example if the Id Number of a media library text entry was set to 47 as shown below:
And a text control was placed on a page with the id number expression attribute set to:
‘clientname,tagname’
Where clientname represents the name of the OPC client adapter (PLC) and tagname is a tag or address in that client. When the value of tagname is equal to 47 then the contents of that media library entry will be displayed online. The text property box would look like the following:

**Search and Replace**

This function allows string search and replacement within any component in the project or the entire project.

**Access**
Search and Replace is accessed by right-clicking on the desired component (as shown below) or selecting the component and selecting the Edit pull-down menu.

**Dialog Box**

Upon selection, the following dialog is given.
As shown above, all items that are in the tree view below the component which originated the operation will have plc replaced with plc1.

Examples...

- Invoking from Project will replace all occurrences in the entire project.
- Invoking from Clients tree heading will replace all occurrences in all clients.
- Invoking from a client component will replace only items in that client.

**Caution:** if the page editor is open, and find/replace is invoked, only that page will be modified, and the changes are not saved until the page is saved.

Find Next

Selecting Find Next from the dialog box gives ability to OK each replacement as shown below.
Replace

This button replaces only the currently found item.

Replace All

This button will replace ALL items in the current component and below.

Cancel

This will cancel the dialog box but maintain any replacements that have already been made.

Notes:

- The following property edit types are bypassed in the search: list side headers (i.e. row numbers), check boxes, radio buttons, and the non text editable versions of drop lists, spin buttons and colors.

- The search will only be performed on properties that are visible AND editable in the property editor. If you can't see it or edit it (i.e. property is grayed), it will be bypassed.

- The following characters are used as word delimiters in match whole word finds. The word must be bracketed by one of these characters to qualify as a whole word: '#@,{=!<>|&!^+-*/%*- (}[]$"

Security

Security of an ePro configuration is designed to be as simple or as comprehensive as the developer desires. By default, anybody who has access to the PanelMate ePro unit may change pages to any page in the configuration and perform pushbutton and data entry control functions on those pages. Prior to V2.10 of ePro Canvas the only mechanism for securing the application from unwanted page or control access was through the Page Enabled Expression property and the Visibility Expression property of a page control. Both local and remote tags could be used in expression to prevent access to a page or to hide a critical control from the user. These methods are still supported but starting in V2.10 additional security functionality has been added to allow a more comprehensive approach to securing the ePro configuration.

There are many ways of implementing security in industrial control. The first level of security is physical access control. Traditional plant security, guards, gates, door locks, etc., may prevent unauthorized users entry to the machine or process area. A second level of security is at the PanelMate ePro itself. Locking cabinets and enclosures will prevent an unauthorized user from plugging in a keyboard or other device that would allow access to programs and operating system commands hidden from the touchscreen of the
ePro. The third level of security is the ePro touchscreen and application and this is where ePro Canvas tools can be used to prevent unwanted use. There are three security components that constitute the ePro Canvas security model, devices, users, and groups.

**Security Devices**

A password is considered a Security device, but security devices may also include hardware devices, such as keys, RFID cards, biometric thumb-drives, or any such device that connects through a USB, PCMCIA, or other connection to an ePro unit that has a corresponding ePro Runtime software driver. Security Devices are contained in a Security Device Library. A password device consists of two properties, Name and User Password. Passwords are case sensitive and may contain any combination of alpha characters, numbers, and the underscore character. There is a minimum password length of one character and no maximum length.

![Screenshot of Security Device Library Entry - Password 1](image)

**Security Groups**

Security groups define which pages may be accessed by a user who is logged on and a member of that group and if a group member may execute data entry control (pop-up entry pad or button pad control) on accessible pages. Security Groups are contained in a Security Group Library. Security groups have names and may have the All Pages Access property set to yes or no. If yes, then members of that security group have access to all pages and all control functions. If no, then the Page Permissions tab of the security group lists all pages that are accessible to group members and indicates whether or not control (data and button entry) on those pages is accessible to logged on users who are group members.
Secure Users
Secure Users are contained in Secure User Libraries. The Default User property of the library defines the secure user account that is automatically logged in when a configuration starts up and when a Security LogOff Action executes (as shown below). The Logged User property is an optional User Defined System Variable or PLC tag of string data type that the system will automatically update with the name of the user who is currently logged on.

A Secure User’s properties are:
• **Name** of the user. This is different than the name used for log on purposes so that it may be more descriptive for documentation purposes.

• **User Name** to be entered during a **Security LogOn** Action.

• **Device Expression** that determines which passwords or other security devices are evaluated during the **LogOn** process.

• **Logoff After (Minutes)** time, in minutes after log on, after which the user will be logged off of the ePro unit. An entry of zero minutes never times out.

• **LogOn Action** to be executed upon successful user logon is completed.

• **LogOff Action** to be executed upon user logoff (manual or automatic).

• **Security Group List Tab** of which the user is a member.

• **Notification Tab** to determine if the user's logon and logoff activity will be recorded in the ePro Event Banner and the Windows Event Viewer. Choices are **Log Events** or **None**.

Secure users are assigned one or more security devices in the Device Expression property. The device expression lets you logically "and" or "or" security devices. For example a user’s device expression could be set to Password 1 || Password 2 (or), or Password 3 && Key1 (and), or simply PWordA. The Security Group List tab is used for assigning the user to one or more security groups.

**Security User and Security Group Automatic Actions**

Both Secure Users and Secure Groups have LogOn and LogOff Action properties. When a user or group member logs on and logs off, these actions (if defined) execute automatically. An automatic action may be a simple direct assignment action or may call any action or action list from the Action Library. This gives you ultimate flexibility in designing any method necessary for indicating security status. It also gives you the ability to show or hide individual page objects and control objects, through the visibility expression property, based on which user or which groups are currently logged on. For example, if you wanted to keep track of the logon status of each security group you could create User Defined System tags of Boolean data type and have each group's LogOn and LogOff Actions write ones and zeroes to their corresponding tag. The same could be done for each user.
Runtime Security Functionality

If a configuration has security, runtime behavior consists of the following:

- At runtime bootup, the Home page is called and the Default User is automatically logged on. For this reason the configuration’s Home Page must be accessible to the Default User account.
- Only one Secure User may be logged on at a time.
- When a user logs on or logs off an event may be written to the ePro Event Banner or the Windows Event Viewer based on the notification settings for each user.
- The active secure user’s access will be limited to those pages and controls that are defined by the security group or groups of which the user is a member. This is independent of whatever page change mechanism is employed, including a Page Change initiated through an assignment action from a PLC tag writing to the CurrentPageID system tag. If the user attempts to select an inaccessible page nothing will happen, the page will not change and no automatic system indication will be given as to why page access was denied. If the developer chooses to keep track of which user or which groups are currently active through the user or group automatic logon and logoff actions, they can choose to use standard indicator controls or visibility expressions to give runtime indication of security access status.
- All visible one-touch page controls (such as Rectangular Button, Button Bar, and Touch Area) are accessible on each page to which the user has access. This allows the user to change pages normally using various page change actions, and it also gives the developer flexibility to allow certain control actions and disallow other control actions on an accessible page.
- All data entry controls (two-touch controls such as Bar, Bar Template, Indicator, Indicator Template, Legend, Readout, Readout Template, Trend, and Trend Template) will only be accessible if the current user is a member of a group that has control access enabled for that page. If the user attempts to select an inaccessible control object nothing will happen, the pop-up control device will not display and no automatic system indication will be given as to why control access was denied.
- There are two ways a user can be logged off. The first method is by executing a Security LogOff action. The second method is when the current user’s automatic timeout period expires. When the current user logs off the Default User is automatically logged back on and if the current page is not accessible to the Default User, the system will automatically change pages back to the Home Page.

Implementing Security on an ePro Configuration

To create a configuration utilizing the built-in security features in ePro Canvas you need to go through the following steps:

2. Create a Security Device – Select the desired device library and right-click on the device or the Component Data pane and choose New Password Device. Give the password device a name and assign a password to the device. Repeat for all required password devices.
4. Create a Security Group - Select the desired group library and right-click on the group or the Component Data pane and choose New Security Group Library Entry. Give the group a name and choose Yes or No for the property All Pages Access. If you choose No, go to the Pages tab and add entries for each page to which you want to grant group member access and set the control property for each page to be Yes or No. Repeat for all required security groups.
6. Create a Secure User - Select the desired user library and right-click on the library or the Component Data pane and choose New Secure User Library Entry. Give the secure user entry a name (description), a user name (to be entered when logging on), and a device expression that chooses the password or other security device associated with that secure user. Repeat for all required secure users.
7. Assign a Default User – Select the Secure User Library’s properties and pick the Default User from the secure user entries of the library.

8. Assign the three security libraries to the configuration – If you want to implement the security features of ePro Canvas you must assign all three security libraries (User, Device, and Group) to a configuration. You can do this one of two ways. Either drag and drop each library onto the Configuration in the component data pane of Project Explorer or open the Configuration’s properties and add the three security libraries to the Libraries tab.

9. Configure LogOn and LogOff Actions – In the Action Library add two new Security Actions, one for log on and one for log off.

10. Configure rectangular button controls to one or more pages that are accessible to the Default User and assign your log on action to the button. Do the same for creating manual log off functions.

11. Optionally, configure User Defined System tags or client tags that will be used for tracking security activity, and create actions that will execute automatically on user or group logon and logoff events.

**ePro Canvas Tips and Best Practices**

**Preparation**

- Think how the application will work from operator and process perspective. What do you need to make available for the operator and how should it be grouped (design before you create)?

- When should pages be grouped visually by common elements of the process? When should pages be grouped visually by logical data grouping such as common PLC register ranges or meanings?

**Media Library**

- Are you going to use multi-language? If so, make sure all strings are entered and referenced in the media library so they can be translated later.

- You’re native (or first) language should be neutral. By using this practice, if your language expression should evaluate to an unknown language, the application will default to the neutral language and will always show something to the operator.

- Note the media library doesn’t have to be used only in multi-language systems. Even if you are not using multi-language, if you find that you are using the same strings repeatedly in the application, consider creating it in the media library and referencing it. This can speed up application development and ensure application consistency.

- If you use images, consider putting them in the media library. This will embed them in your .ucf file, and ensure they are available in your runtime unit.

**Re-use**

- Look for common tasks/functions and use Libraries, Index Lists, and Master Pages to reduce application size and complexity as well as ensure consistency. Applying re-use when your application is initially created will not only save time during creation but will make it much easier to make modifications later since you will only need to change items once to apply them to many locations.

- Re-use is often discovered during the development process only after its first occurrence. Try to think about it up front but don’t be afraid to apply it later when you discover an area in your application that would benefit from it.

**Master Pages**

- Use Master Pages whenever possible to avoid duplication of common elements across pages. This saves memory and application development time as well as ensures consistency for the operator. Always try to have the same or similar actions located at the same location on pages. This can be easily accomplished using Master Pages. A classic example for use of Master Pages is for a
navigation buttons (menus) for the operator as well as logos that need to be included on all pages.

Indexed Lists

- This feature is similar to indirect referencing, allowing controls to display different data based on an index into a list. Although this is a relatively advanced feature, when used properly it can be save memory and application development time. An example use would be in creating a page showing the status of a single PLC I/O card and allowing the operator to choose which card to look at by changing the index based on a user button selection.

Clients

- To minimize network bandwidth and maximize system performance, don’t make scan times any faster than they need to be.

Configuration

- Only add 1 reference per library type in your configuration.
- Select the configuration icon from the tree view to get a graphical overview of your current application content and status (note that unused libraries don’t appear.)

Unit

- On a send to unit, after the correct runtime and driver have been sent, uncheck them to minimize reload/restart time (only the .ucf will be transferred in successive transfers.)

Color Blinks

- Blink is performed by continuously redrawing the blinking image. The more blinking areas there are on a page, the more processor time is required for redrawing.
- To maximize application performance, remove blinking color entries from the color library if they are not actually being used in your application.

Pages

- For best performance, overlap dynamic elements sparingly and only when necessary. Also, avoid placing controls outside of the viewable area.
- Use component templates to standardize and simplify editing.

Actions

- Do not have a tag that triggers an action that also contains the tag as a destination of an assignment as a result of that action. This will cause an infinite loop, and make the runtime unit hang.

User Defined System Tags

User defined tags may be added manually to the System Client tag file TagSystem. These tags will all have an initial value of zero and the data type may be specified or you can select the type to be “Interface Supplied” which will default to unsigned 32-bit integer. You can add a tag to the TagSystem by opening the tag file properties dialog and selecting the “Tags” tab, and then double clicking on the line labeled “Double click here to append a row”. The Name is user specified as long as it is unique in the tag file, and the Definition field should be identical to the Name. The default Data Type of Interface Supplied may be changed to any of the types shown below:
You can also add a tag by selecting the TagSystem library in the Project Components pane of Project Explorer, then right-click in the Component Data pane and select New Tag Library Entry.

User defined system tags will not change value at runtime unless the user configures a function that writes to those tags. They may be written to from a pushbutton or button bar function, from a data entry function, or from an Assignment Action. If the user configures a Conditional Passthru Assignment Action a user defined system tag can be updated from the PLC through an OPC Server client connection.

User defined system tags may be useful for a number of purposes. Their value can be toggled by a pushbutton to control conditional visibility of page objects, or a system tag may be used in place of a PLC register for storage of the configuration’s Active Language ID. A system tag may also be used as an index to one or more Indexed Lists. There are many more uses of user defined system tags and in general they can be used for local functions that will reduce the requirement of Operator Interface specific registers in the PLC. Note however that unlike PLC registers, system tags are not persisted values, which means that system tags will be set back to their default value of zero at each reboot of the ePro. This may limit some of the uses to which you would apply user defined system tags.
Index

87, 212, 312, 425, 550, 647

About OI Page Editor ....................... 120, 459
About Page Editor window ............... 120, 459
Abs ........................................ 200, 286, 540, 623
Absolute ..................................... 102, 440
Access Path ... 18, 39, 291, 303, 358, 380, 628, 638
Ack All ........................................ 102, 440
Ack All button ................................ 102, 440
Ack Visible .................................. 102, 440
Acknowledge All Alarms .................... 102, 440
Acknowledge All Operational .......... 102, 440
Acknowledge Visible Alarms ............. 102, 440
Acknowledge Visible Operational....... 102, 440
Acknowledged Alarms ..................... 243, 583
Acknowledged-Filter ....... 102, 243, 440, 583
Acknowledging .................................. 243
Acknowledging .................................. 440
Acknowledging .................................. 445
Acknowledging .................................. 583
Action Column ....................... 62, 401
Action file ............................ 73, 206, 311, 412, 545, 646
Action Libraries 61, 87, 150, 212, 261, 312, 400, 425, 488, 550, 598, 647
Action Library Entry 87, 212, 232, 239, 312, 425, 550, 570, 577, 647
Action List ... 30, 31, 62, 303, 370, 371, 401, 638
ActionEventBanner ................... 62, 401
ActionExit .................................. 18, 62, 291, 358, 399, 628
ActionHomePage ............. 62, 150, 261, 399, 488, 598
ActionPageDown .......... 62, 150, 261, 399, 488, 598
ActionPageUp ........... 62, 150, 261, 399, 488, 598
Action Previous Page 62, 150, 261, 399, 488, 598
Actions ..... 1, 14, 62, 64, 65, 69, 70, 71, 73, 74, 147, 150, 206, 210, 261, 294, 303, 311, 318, 338, 342, 354, 399, 403, 407, 409, 410, 411, 412, 413, 485, 488, 545, 548, 598, 631, 638, 646, 653, 673
Action System ..................... 150, 261, 488, 598
Activation key ....................... 28, 318, 368, 653
Active ............................................... 102, 440
Active Acknowledged BG Color ....... 102, 440
Active Acknowledged FG Color ..... 102, 440
Active Alarm Filter OFF .......... 243, 583
Active Alarm Filter ON .............. 243, 583
active indication ...................... 69, 407
Active Language ...... 49, 55, 277, 390, 394, 614
Active Language Entry ............. 49, 390
Active Language Expression ....... 43, 49, 55, 277, 303, 384, 390, 394, 614, 638
Active On/Off ..................................... 102, 440
Active page ........................ 120, 124, 459, 462
Active Unacknowledged BG Color .... 102, 440
Active Unacknowledged FG Color .... 102, 440
Active/inactive ............................ 243, 583
Active-unacknowledged .............. 303, 638
Add .8, 33, 43, 45, 46, 49, 61, 62, 63, 110, 129, 134, 160, 348, 374, 384, 386, 387, 390, 400, 401, 402, 449, 467, 472, 498
Add Language Enabled ............... 49, 390
Add/edit/delete ............................ 118, 456
Adjusting ........................................ 207, 546
Alarm Acknowledge Bits ............ 303, 638
Alarm and Event Banner ............ 243, 583
Alarm Clear ................................... 243, 583
Alarm Level .......................... 243, 583
Alarm Table ............................. 243, 583
Alarm Table Column Settings ....... 243, 583
Alarm Table Settings .................. 243, 583
Alarm/event ................................ 583
Alarm/event ................................ 638
Alarm/event transitioned ............ 243, 583
Alarm/Event Viewer window ........ 243, 583
Alarm/Event window ............ 102, 243, 440, 583
AlarmEvent_mmddyyyy_hhmm.XML ... 280, 617
AlarmEvent_mmddyyyyyyy_hhmm.xml ... 85, 280, 423, 617
Alarms
Acknowledging .......................... 107, 445
Alarms ......................................... 85
Alarms ......................................... 107
Alarms ......................................... 280
Alarms ......................................... 303
Alarms ......................................... 423
Alarms ......................................... 445
Alarms ......................................... 617
Alarms ......................................... 638
Alarms/events ......................... 243, 280, 583, 617
Align Bottom 110, 120, 126, 160, 449, 459, 464, 498
Align Center 110, 120, 126, 160, 449, 459, 464, 498
Align Edges ................................. 126, 464
Align Edges button
    Layout toolbar .......................... 120, 459
Align Edges button .................. 120
Align Edges button.................. 459
Align Left ...... 110, 120, 126, 160, 449, 459, 464, 498
Align Middle 110, 120, 126, 160, 449, 459, 464, 498
Align Objects 110, 120, 126, 160, 449, 459, 464, 498
Align Right 110, 120, 126, 160, 449, 459, 464, 498
Align Top 110, 120, 126, 160, 449, 459, 464, 498
Aligning ...................................... 110, 160, 449, 498
Alignment .............................. 179, 189, 221, 518, 528, 559
Allen-Bradley Ethernet .......... 18, 291, 358, 628
Alpha-Numeric ......................... 225, 563
Alphanumeric Entry .......................... 31, 371
Analog ......................... 1, 200, 286, 342, 540, 623
<table>
<thead>
<tr>
<th>Analog Expressions</th>
<th>87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle</td>
<td>171, 227, 238, 509, 565, 576</td>
</tr>
<tr>
<td>Apply button</td>
<td>210, 548</td>
</tr>
<tr>
<td>Apply Lower Limit</td>
<td>232, 570</td>
</tr>
<tr>
<td>Apply Upper Limit</td>
<td>242, 579</td>
</tr>
<tr>
<td>Arc</td>
<td>136, 156, 158, 171, 474, 494, 496, 509</td>
</tr>
<tr>
<td>Arc Style</td>
<td>30, 31, 370, 371</td>
</tr>
<tr>
<td>Arc Style</td>
<td>171, 221, 509, 559</td>
</tr>
<tr>
<td>Archive</td>
<td>85, 280, 423, 617</td>
</tr>
<tr>
<td>Archive Library</td>
<td>85, 280, 423, 617</td>
</tr>
<tr>
<td>Archive Path</td>
<td>85, 280, 423, 617</td>
</tr>
<tr>
<td>Archive Rate</td>
<td>85, 280, 423, 617</td>
</tr>
<tr>
<td>Archive Sine Data</td>
<td>mmddyyyy_hhmm.XML</td>
</tr>
<tr>
<td>ASCII</td>
<td>49, 87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 300, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647</td>
</tr>
<tr>
<td>Arithmetic Operators</td>
<td>87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 300, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647</td>
</tr>
<tr>
<td>Arranging</td>
<td>110, 160, 449, 498</td>
</tr>
<tr>
<td>Arrowhead</td>
<td>221, 559</td>
</tr>
<tr>
<td>Arrowhead Height</td>
<td>178, 180, 221, 517, 519, 559</td>
</tr>
<tr>
<td>ASCII</td>
<td>49, 87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 300, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 638, 647</td>
</tr>
<tr>
<td>Assignment Action</td>
<td>73, 92, 150, 206, 218, 261, 311, 341, 402, 412, 430, 488, 545, 556, 598, 646, 674</td>
</tr>
<tr>
<td>Assignment Expression</td>
<td>73, 87, 199, 200, 201, 203, 204, 205, 206, 210, 212, 286, 287, 289, 290, 311, 312, 425, 539, 540, 541, 543, 544, 545, 548, 550, 623, 624, 626, 627, 646, 647</td>
</tr>
<tr>
<td>Associativity</td>
<td>205, 544</td>
</tr>
<tr>
<td>Attributes Tab</td>
<td>185, 524</td>
</tr>
<tr>
<td>Audio Output Parameters</td>
<td>Operator Input</td>
</tr>
<tr>
<td>Audio Output Parameters</td>
<td>303</td>
</tr>
<tr>
<td>Auto Add Language Enable</td>
<td>49, 390</td>
</tr>
<tr>
<td>Auto Close</td>
<td>73, 411</td>
</tr>
<tr>
<td>Auto Language</td>
<td>49, 390</td>
</tr>
<tr>
<td>Auto Language Tab</td>
<td>49, 390</td>
</tr>
<tr>
<td>Auto-apply</td>
<td>210, 548</td>
</tr>
<tr>
<td>Automatically apply string quotes</td>
<td>98, 257, 436</td>
</tr>
<tr>
<td>Auto-roll</td>
<td>210, 548</td>
</tr>
<tr>
<td>B</td>
<td>87, 212, 312, 425, 550, 647</td>
</tr>
<tr>
<td>Background</td>
<td>222, 560</td>
</tr>
<tr>
<td>Background Color</td>
<td>.45, 134, 171, 172, 178, 180, 182, 184, 188, 189, 386, 472, 509, 510, 516, 519, 521, 523, 527, 528</td>
</tr>
<tr>
<td>Background Style</td>
<td>172, 180, 182, 184, 188, 222, 510, 519, 521, 523, 527, 560</td>
</tr>
<tr>
<td>Backlight</td>
<td>303, 638</td>
</tr>
<tr>
<td>backlash</td>
<td>87, 212, 312, 425, 550, 647</td>
</tr>
<tr>
<td>Backward Diagonal</td>
<td>222, 560</td>
</tr>
<tr>
<td>Banner</td>
<td>102, 243, 440, 583</td>
</tr>
<tr>
<td>Banner Settings</td>
<td>243, 583</td>
</tr>
<tr>
<td>Banner/window</td>
<td>102, 440</td>
</tr>
<tr>
<td>Bar</td>
<td>136, 156, 158, 171, 474, 494, 496, 509</td>
</tr>
<tr>
<td>Bar Template</td>
<td>136, 156, 158, 172, 175, 474, 494, 496, 510, 513</td>
</tr>
<tr>
<td>Bar Template Max</td>
<td>Min Calibrations 74, 147, 294, 413, 485, 631</td>
</tr>
<tr>
<td>Bar's</td>
<td>108, 132, 447, 470</td>
</tr>
<tr>
<td>Base Controls</td>
<td>156, 494</td>
</tr>
<tr>
<td>Best Practices</td>
<td>338, 673</td>
</tr>
<tr>
<td>BG</td>
<td>222, 560</td>
</tr>
<tr>
<td>BG Color</td>
<td>174, 177, 178, 184, 187, 188, 512, 515, 516, 523, 527</td>
</tr>
<tr>
<td>Bin</td>
<td>87, 212, 312, 425, 550, 647</td>
</tr>
<tr>
<td>Binary</td>
<td>87, 200, 212, 286, 312, 425, 540, 550, 623, 647</td>
</tr>
<tr>
<td>Bitmap</td>
<td>176, 187, 515, 526</td>
</tr>
<tr>
<td>Bitmaps</td>
<td>176, 187, 303, 515, 526, 638</td>
</tr>
<tr>
<td>Bit Write Example</td>
<td>73, 206, 311, 412, 545, 646</td>
</tr>
<tr>
<td>Bit Zero</td>
<td>303, 638</td>
</tr>
<tr>
<td>BitChange</td>
<td>73, 206, 311, 412, 545, 646</td>
</tr>
<tr>
<td>BitChange Action</td>
<td>73, 206, 311, 412, 545, 646</td>
</tr>
<tr>
<td>Bitmap</td>
<td>176, 187, 515, 526</td>
</tr>
<tr>
<td>Bitmaps</td>
<td>176, 187, 303, 515, 526, 638</td>
</tr>
<tr>
<td>Bits</td>
<td>67, 87, 212, 312, 406, 425, 550, 647</td>
</tr>
<tr>
<td>Bitwise</td>
<td>205, 544</td>
</tr>
<tr>
<td>Bitwise AND</td>
<td>199, 290, 539, 627</td>
</tr>
<tr>
<td>Bitwise-AND</td>
<td>205, 544</td>
</tr>
</tbody>
</table>
Index

Changing ................................................. 130
Changing ................................................. 132
Changing ................................................. 138
Changing ................................................. 150
Changing ................................................. 160
Changing ................................................. 185
Changing ................................................. 234
Changing ................................................. 240
Changing ................................................. 260
Changing ................................................. 261
Changing ................................................. 267
Changing ................................................. 277
Changing ................................................. 291
Changing ................................................. 348
Changing ................................................. 358
Changing ................................................. 361
Changing ................................................. 366
Changing ................................................. 373
Changing ................................................. 384
Changing ................................................. 390
Changing ................................................. 394
Changing ................................................. 431
Changing ................................................. 447
Changing ................................................. 449
Changing ................................................. 467
Changing ................................................. 468
Changing ................................................. 470
Changing ................................................. 476
Changing ................................................. 488
Changing ................................................. 498
Changing ................................................. 524
Changing ................................................. 572
Changing ................................................. 578
Changing ................................................. 597
Changing ................................................. 598
Changing ................................................. 604
Changing ................................................. 614
Changing ................................................. 628
Channel.Device ........................................ 39, 380
Channel1.Device1 .................. 18, 291, 358, 628
ChAppScout.exe ......................... 339
Check ................................................. 33, 374
Check Box ........................................... 198, 538
Check for errors ................................. 33, 374
Checkbox ....... 231, 232, 234, 239, 569, 570, 571, 577
Checkbox NOT ............ 231, 234, 569, 571
Chp .................................................... 32, 373
Chp file ............................................. 32, 373
Classic ........................................... 136, 158, 474, 496
Classifications ....................... 243, 583
Cleared ........................................... 102, 440
Cleared Timestamp ............... 102, 243, 440, 583
Client Adapter ................................. 30, 370
Client Library199, 200, 201, 286, 287, 290, 539, 540, 541, 623, 624, 627
Client Properties dialog ............... 39, 380
Client Set Up ................................. 39, 380
ClientLib199, 200, 286, 290, 539, 540, 623, 627
Clients .............................................. 338, 673
Clients Folder ............................... 8, 348
ClientSystem .................. 201, 287, 541, 624
Clock ... 136, 156, 158, 173, 226, 303, 474, 494, 496, 511, 564, 638
Close Action ................................. 63, 402
Close Application Expression ........... 73, 411
Cognex ............................... 30, 31, 370, 371
Color .... 86, 217, 285, 338, 424, 555, 622, 673
Color blinks .............................. 338, 673
Color Libraries ....... 1, 31, 59, 338, 342, 371, 398, 673
Color window222, 228, 229, 230, 237, 242, 560, 566, 567, 568, 575, 580
ColorSystem Color Library .............. 303, 638
Column
  Resizing .................. 115, 191, 454, 531
  setting ....................... 243, 583
Column ........................................ 102
Column ........................................ 115
Column ........................................ 191
Column ........................................ 202
Column....................................................243
Column....................................................440
Column....................................................454
Column....................................................531
Column....................................................546
Column....................................................583
Column Width.......102, 207, 243, 440, 546, 583
Combination.......... 87, 212, 312, 425, 550, 647
Combinations/Expressions ....87, 212, 312, 425, 550, 647
Combinations/Expressions/Concatenations....87, 212, 312, 425, 550, 647
CommErrorDetect ..............................303, 638
CommErrorMsg..................................303, 638
Common.............................................17, 357
Common Properties.....165, 193, 224, 272, 503, 533, 562, 609
Communication Error..........................243, 583
compare .............................................69, 407
Component Bar............. 6, 8, 10, 346, 348, 350
Component Builder....................... 98, 257, 436
Component Data... 6, 10, 12, 92, 218, 303, 341, 346, 350, 352, 430, 436, 556, 638, 674
Component folder.............................. 8, 348
Component Property Editor14, 15, 16, 354, 355, 356
Component Templates...... 21, 26, 93, 138, 260, 267, 361, 366, 431, 476, 597, 604
Component Toolbox ...........................124, 462
Component Toolbox button .................120, 459
Component Views .... 6, 108, 132, 346, 447, 470
Components 1, 6, 8, 12, 98, 126, 257, 342, 346, 348, 352, 436, 464
Concatenation ...... 87, 212, 312, 425, 550, 647
Condition Type .......... 63, 67, 402, 406
Condition Type Passthru ..... 150, 261, 488, 498
Conditional .......... 87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Conditional Expression Operators.. 87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Conditional Passthru ..... 87, 150, 199, 200, 201, 203, 204, 205, 210, 212, 261, 286, 287, 289, 290, 312, 425, 488, 539, 540, 541, 543, 544, 548, 550, 598, 623, 624, 626, 627, 647
Conditional Passthru Assignment .... 303, 638
Configuration Error ....................... 243, 583
Configuration Name ......................... 33, 374
Configuration Properties Actions .. 150, 261, 488, 598
Configuration Properties General Tab .. 150, 261, 488, 598
Configuration Properties Page150, 261, 488, 598
Configuration's Event Banner 102, 106, 440, 444
Configurations Folder .............................. 8, 348
Configuring/Editing
  Control .................................. 110, 160, 449, 498
  Configuring/Editing ................................... 110
  Configuring/Editing ................................... 160
  Configuring/Editing ................................... 449
  Configuring/Editing ................................... 498
  Connection .................. 33, 374
  Continuous Scan .................. 39, 380
  Contrast .......................... 225, 563
  Control Bit Reset Delay.............. 303, 638
  Control Button .................. 110, 160, 449, 498
  Control Composition .................. 156, 494
  Control Data Entry.. 87, 110, 160, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 449, 498, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
  Control Example ..110, 115, 130, 136, 156, 158, 160, 165, 189, 191, 193, 272, 449, 454, 468, 474, 494, 496, 498, 503, 528, 531, 533, 609
  Control List .......................... 207, 546
Control menu ........................................ 120, 459
Control Outline .................................. 165, 189, 193, 272, 503, 528, 533, 609
Control Properties .................................. 189, 528
ControlBits ......................................... 87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Controls/Object ................................. 110, 160, 149, 498
Controls/sub-control ......................... 165, 193, 272, 503, 533, 609
Convert ............................................ 303, 638
Copy ............................................... 10, 32, 124, 350, 373, 462
Copy button ...................................... 120, 459
Critical ........................................... 102, 440
Criticality ......................................... 243, 583
CSV ................................................... 46, 387
CSV file .......................................... 46, 303, 387, 638
CTRL-Right Click ............................ 98, 257, 436
Current Value Label ......................... 176, 514
CurrentPageId 74, 147, 150, 261, 294, 413, 485, 488, 598, 631
Cut ................................................... 32, 124, 373, 462
Cut button ....................................... 120, 459
D 87, 212, 312, 425, 550, 647
Data Archive ................................. 28, 85, 280, 368, 423, 617
Data Archive Action ........................... 64, 280, 403, 617
Data Archive Properties ..................... 64, 403
Data Entry Expressions .......................... 87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Data Entry Target Expressions .............. 74, 87, 147, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 631, 647
Data Entry Type .............................. 87, 199, 200, 201, 203, 204, 205, 210, 212, 224, 225, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 562, 563, 623, 624, 626, 627, 647
Data Type ......................................... 46, 87, 92, 199, 200, 201, 203, 204, 205, 210, 212, 218, 286, 287, 289, 290, 312, 341, 387, 425, 430, 539, 540, 541, 543, 544, 548, 550, 556, 623, 624, 626, 627, 647, 674
DataArchiveAction_mmddyyyyy_hhmm.xml ... 85, 280, 423, 617
Date .............................................. 200, 286, 540, 623
Date Time ........................................... 226, 564
Decimal Places ............................... 165, 193, 225, 272, 503, 533, 563, 609
Deep Import ...................................... 39, 380
Default Buttons .................................. 303, 638
Default Client Connection ................. 303, 638
Default Connection Name ..................... 33, 374
Default Page Components ................. 303, 638
Default PLC Name .............................. 303, 638
Delete ........................................... 8, 110, 160, 348, 449, 498
Delete Cell Contents ......................... 115, 191, 454, 531
Delete Row ....................................... 115, 191, 454, 531
Demo Mode ....................................... 28, 368
Description ....................................... 226, 564
DEST ........................................... 201, 203, 287, 289, 541, 543, 624, 626
Destination ....................................... 18, 291, 339, 358, 628
Direct Assignment .......................... 87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Direct Assignment Expressions ............ 87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Directory .......................................... 339
Disabling Canvas Assistance ............. 98, 257, 436
Discrete ........................................... 1, 87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Discrete Expressions .......................... 87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Display .............................................226, 564
Document Viewer 31, 43, 72, 87, 101, 212, 312, 371, 384, 410, 425, 439, 550, 647
Document Viewer Content43, 72, 101, 384, 410, 439
Documentation Location .....................101, 439
DOUBLE................ 87, 212, 312, 425, 550, 647
Double Quotes added ...................98, 257, 436
Draw Order .......................................134, 472
Drop List...........................................198, 538
DVT.......................................30, 31, 370, 371
E
Edit new component properties...... 98, 257, 436
Edit Value Label.................................176, 514
Ellipse . 136, 156, 158, 172, 178, 474, 494, 496, 510, 516
Ellipsis..............................................198, 538
Email..................................................65, 403
Email Action ........................................65, 403
Embed.................. 87, 212, 312, 425, 550, 647
Embed Data ..........87, 212, 312, 425, 550, 647
Enable/disable............................. 98, 257, 436
End X ................................178, 226, 517, 564
End Y ................................178, 226, 517, 564
Ending Angle .....................................227, 565
Entries Tab.... 87, 185, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 524, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Entry .....87, 199, 200, 201, 203, 204, 205, 210, 212, 227, 235, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Entry Column ......................................49, 390
EPro Canvas
    registering..................................28, 368
EPro Canvas Tips ................................338, 673
EPro License ..................................28, 318, 368, 653
EPro PS .............................................339
EPro unit...........................................339
EProStart.cmd ....................................339
Ethernet ...........................................33, 374
Evaluated ...... 87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Evaluated Numeric Values..... 87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Event Banner 14, 102, 106, 107, 243, 354, 440, 444, 445, 583
Event Column......................................67, 406
Event Manager .....14, 106, 107, 243, 354, 444, 445, 583
Event Manager Settings................. 243, 583
Event Runtime Settings ...................... 33, 374
Event Viewer Components .................243, 583
Event/Alarm Viewer ............................72, 410
Events.. 106, 107, 243, 280, 444, 445, 583, 617
Excel........... 53, 69, 301, 318, 407, 653
Exit Operational.................................101, 439
Explicit Library Referencing... 86, 217, 285, 424, 555, 622
Export ...............................................53, 301
Export Media Library ..........................53, 301
Expression...... 87, 212, 312, 425, 550, 647
Expression Editor...87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Expression/Target Expression 87, 199, 200, 201, 203, 204, 205, 210, 212, 227, 242, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 555, 623, 624, 626, 627, 647
Expressions .. 87, 199, 200, 201, 203, 204, 205, 210, 212, 227, 242, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Expressions Direct Assignment ..... 87, 115, 191, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 454, 531, 539, 540, 541, 543, 544, 548, 550, 555, 565, 578, 580, 623, 624, 626, 627, 647
Expressions, Data Entry...87, 115, 191, 199, 200, 201, 203, 204, 205, 210, 212, 227, 286, 287,
289, 290, 312, 425, 454, 531, 539, 540, 541, 543, 544, 548, 550, 565, 623, 624, 626, 627, 647

F

F 87, 212, 312, 425, 550, 647
Failed to copy file <c........................................ 339
FG.................................................. 228, 566
FG Color .... 174, 177, 178, 187, 207, 512, 515, 516, 527, 546
Field Alignment.................................. 102, 440
Field Attention BG Color........................ 102, 440
Field Attention FG Color........................ 102, 440
Field Attention Text................................ 102, 440
Field BG Color .................................. 102, 440
Field Critical BG Color.......................... 102, 440
Field Critical FG Color.......................... 102, 440
Field Critical Text ............................... 102, 440
Field Default BG Color.......................... 102, 440
Field Default FG Color.......................... 102, 440
Field Default FG.................................. 102, 440
Field Font.......................................... 102, 440
Field Height........................ 102, 243, 440, 583
Field Informational BG Color.................... 102, 440
Field Informational FG Color.................... 102, 440
Field Informational Text.......................... 102, 440
Field Serious BG Color.......................... 102, 440
Field Serious FG Color.......................... 102, 440
Field Serious Text ............................... 102, 440
Field Warning BG Color.......................... 102, 440
Field Warning FG Color.......................... 102, 440
Field Warning Text................................ 102, 440
File menu ................................... 26, 32, 124, 260, 366, 373, 462, 597
file name ................ 69, 181, 318, 407, 520, 653
File Rollover Rate................ 85, 280, 423, 617
File/Import menu................................. 53, 301
File/Save .......................................... 120, 459
File>Export .................................... 26, 260, 366, 597
Files.... 33, 53, 72, 73, 181, 301, 303, 374, 410, 411, 520, 638
Filter ............................................. 243, 583
Filter Acknowledged Off ....................... 102, 440
Filter Acknowledged On ........................ 102, 440
Filter Acknowledged Operational ............ 102, 440
Filter Active Off ................................ 102, 440
Filter Active On ................................ 102, 440
Filter Active Operational ..................... 102, 440
Filter Inactive Off .............................. 102, 440
Filter Inactive On ................................ 102, 440
Filter Inactive Operational ................. 102, 440
Filter Unacknowledged Off .................. 102, 440
Filter Unacknowledged On .................... 102, 440
Filter Unacknowledged Operational ......... 102, 440
Find ................................................. 328, 663
Find Next.......................................... 328, 663
Find/replace...................................... 328, 663
Firewall ............................................ 33, 374
Firewall friendly .................................. 33, 374
Fixed ............................................. 87, 212, 312, 425, 550, 647
Fixed Bar ........ 136, 158, 173, 474, 496, 511
Fixed Bar Trend...136, 158, 174, 175, 474, 496, 512, 513
Fixed Decimal..... 87, 212, 312, 425, 550, 647
Fixed Indicator .... 136, 158, 174, 474, 496, 512
Fixed Line Trend...136, 158, 174, 175, 474, 496, 512, 513
Fixed Message ...... 136, 158, 175, 474, 496, 513
Fixed Readout ...... 136, 158, 175, 474, 496, 514
Fixed Table ....... 136, 158, 176, 474, 496, 514
Float ................... 87, 212, 312, 425, 550, 647
Floating................ 87, 212, 312, 425, 550, 647
Floating Point .... 87, 212, 312, 425, 550, 647
Font ...... 74, 147, 179, 189, 228, 294, 413, 485, 518, 528, 566, 631
Foreground ....................................... 228, 566
Foreground Color. 171, 172, 178, 180, 182, 184, 188, 222, 228, 509, 510, 516, 517, 519, 521, 523, 527, 560, 566
Format/Data/Time Operators 87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
<table>
<thead>
<tr>
<th>Index</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>I4</td>
<td>87, 212, 312, 425, 550, 647</td>
</tr>
<tr>
<td>I5</td>
<td>87, 212, 312, 425, 550, 647</td>
</tr>
<tr>
<td>Icon size</td>
<td>179, 518</td>
</tr>
<tr>
<td>ID</td>
<td>49, 67, 72, 390, 406, 410</td>
</tr>
<tr>
<td>ID Number</td>
<td>49, 58, 71, 74, 147, 150, 261, 294, 327, 390, 397, 410, 413, 485, 488, 598, 631, 662</td>
</tr>
<tr>
<td>id number expression</td>
<td>71, 410</td>
</tr>
<tr>
<td>Id@</td>
<td>58, 327, 397, 662</td>
</tr>
<tr>
<td>If.Then.ElseIf</td>
<td>87, 199, 200, 201, 203, 204, 205, 210, 212, 238, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 576, 623, 624, 626, 627, 647</td>
</tr>
<tr>
<td>Image Controls</td>
<td>176, 515</td>
</tr>
<tr>
<td>Image Name</td>
<td>87, 212, 230, 312, 425, 550, 668, 647</td>
</tr>
<tr>
<td>Image Path</td>
<td>49, 87, 212, 312, 390, 425, 550, 647</td>
</tr>
<tr>
<td>Import</td>
<td>32, 39, 46, 53, 301, 303, 373, 380, 387, 638</td>
</tr>
<tr>
<td>Import from server</td>
<td>39, 380</td>
</tr>
<tr>
<td>Import Media Library</td>
<td>53, 301</td>
</tr>
<tr>
<td>Inactive</td>
<td>102, 440</td>
</tr>
<tr>
<td>Inactive Acknowledged BG Color</td>
<td>102, 440</td>
</tr>
<tr>
<td>Inactive Acknowledged FG Color</td>
<td>102, 440</td>
</tr>
<tr>
<td>Inactive Alarms</td>
<td>243, 583</td>
</tr>
<tr>
<td>Inactive On/Off</td>
<td>102, 440</td>
</tr>
<tr>
<td>Inactive UnAcknowledged BG Color</td>
<td>102, 440</td>
</tr>
<tr>
<td>Inactive UnAcknowledged FG Color</td>
<td>102, 440</td>
</tr>
<tr>
<td>Index</td>
<td>74, 147, 294, 413, 485, 631</td>
</tr>
<tr>
<td>Index Input Location</td>
<td>179, 518</td>
</tr>
<tr>
<td>Index List Entry</td>
<td>74, 147, 294, 413, 485, 631</td>
</tr>
<tr>
<td>Index Lists</td>
<td>338, 673</td>
</tr>
<tr>
<td>Index Output Location</td>
<td>179, 518</td>
</tr>
<tr>
<td>Indexed</td>
<td>86, 217, 285, 424, 544, 555, 622</td>
</tr>
<tr>
<td>Indexed Expression</td>
<td>74, 87, 147, 199, 200, 201, 203, 204, 205, 210, 212, 238, 286, 287, 289, 290, 312, 425, 485, 539, 540, 541, 543, 544, 548, 550, 576, 623, 624, 626, 627, 647</td>
</tr>
<tr>
<td>Index List</td>
<td>74, 86, 147, 217, 285, 294, 413, 424, 485, 555, 622, 631</td>
</tr>
<tr>
<td>Indexed List Library</td>
<td>74, 147, 294, 413, 485, 631</td>
</tr>
<tr>
<td>Indexed Lists</td>
<td>338, 673</td>
</tr>
<tr>
<td>Indicator</td>
<td>136, 156, 158, 174, 177, 207, 238, 474, 494, 496, 512, 515, 516, 546, 576</td>
</tr>
<tr>
<td>Indicator State Evaluation</td>
<td>74, 87, 147, 199, 200, 201, 203, 204, 205, 210, 212, 238, 286, 287, 289, 290, 312, 425, 485, 539, 540, 541, 543, 544, 548, 550, 576, 623, 624, 626, 627, 631, 647</td>
</tr>
<tr>
<td>Indicator State Expressions</td>
<td>74, 87, 147, 199, 200, 201, 203, 204, 205, 210, 212, 238, 286, 287, 289, 290, 312, 425, 485, 539, 540, 541, 543, 544, 548, 550, 576, 623, 624, 626, 627, 631, 647</td>
</tr>
<tr>
<td>Indicator States</td>
<td>74, 199, 200, 201, 203, 204, 205, 210, 212, 238, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 576, 623, 624, 626, 627, 647</td>
</tr>
<tr>
<td>Indicator Template</td>
<td>110, 136, 156, 158, 160, 177, 238, 449, 474, 494, 496, 498, 516, 576</td>
</tr>
<tr>
<td>Ingridiate Mismatch</td>
<td>69, 407</td>
</tr>
<tr>
<td>Input Value Expression</td>
<td>87, 176, 199, 200, 201, 203, 204, 205, 210, 212, 238, 286, 287, 289, 290, 312, 425, 514, 539, 540, 541, 543, 544, 548, 550, 576, 620, 624, 626, 627, 647</td>
</tr>
<tr>
<td>Interface Supplied</td>
<td>46, 92, 218, 341, 387, 430, 556, 674</td>
</tr>
<tr>
<td>Interval</td>
<td>233, 237, 571, 575</td>
</tr>
<tr>
<td>Invalid Resource</td>
<td>243, 583</td>
</tr>
<tr>
<td>Invert Colors</td>
<td>176, 187, 231, 515, 526, 569</td>
</tr>
<tr>
<td>Invisible</td>
<td>243, 583</td>
</tr>
<tr>
<td>IP</td>
<td>18, 33, 291, 339, 358, 374, 628</td>
</tr>
<tr>
<td>IP Address</td>
<td>18, 291, 339, 358, 628</td>
</tr>
<tr>
<td>Item Name</td>
<td>39, 380</td>
</tr>
<tr>
<td>Item Number</td>
<td>39, 380</td>
</tr>
</tbody>
</table>

**K**

| KepServer | 339 |
| KEPServer_ePro | 18, 28, 33, 39, 291, 303, 358, 368, 374, 380, 628, 638 |
| Kepware OPC | 46, 387 |
| Kepware OPC Server | 303, 638 |
| Kepware_ePro | 18, 291, 358, 628 |
| Kepware_ePro OPC | 18, 291, 358, 628 |

**L**

| LANGUAGE | 49, 53, 55, 277, 301, 390, 394, 614 |
| Language List | 49, 390 |
| LANGUAGE VALUE | 49, 53, 277, 390, 394, 614 |
LastPage.................................62, 399
launch ........................................33, 374
Layout Toolbar ..........................126, 464
Led .. 136, 156, 158, 178, 238, 474, 494, 496,
516, 576
Left ...........................................234, 572
Legend 110, 136, 156, 158, 160, 165, 178,
193, 272, 449, 474, 494, 496, 498, 503, 517, 533,
609
Letters/numbers .. 87, 199, 200, 201, 203, 204,
205, 210, 212, 225, 286, 287, 289, 290, 312,
425, 539, 540, 541, 543, 544, 548, 550, 563,
623, 624, 626, 627, 647
Level .......................................102, 440
Level/criticality ..........................243, 583
Library..14, 46, 55, 86, 87, 201, 203, 204,
205, 210, 212, 227, 286, 289, 312, 425, 539,
540, 541, 543, 544, 548, 550, 565, 623,
624, 626, 627, 647
Library Entry .. 87, 199, 200, 212, 227, 286,
290, 312, 425, 539, 540, 550, 565, 623, 627,
647
Library Entry Data.. 87, 212, 312, 425, 550,
647
Library Name ......199, 200, 286, 290, 539,
540, 623, 627
Library References 87, 199, 200, 201, 203,
204, 205, 210, 212, 286, 287, 289, 290, 312,
425, 539, 540, 541, 543, 544, 548, 550, 623,
624, 626, 627, 647
Licensing ...............................28, 69, 368, 407
Line18, 136, 156, 158, 178, 291, 358, 474, 494,
496, 517, 628
Line Trend.............................30, 31, 370, 371
List Action .................................62, 401
List Property ..............................1, 342
List Property Editor Window ....207, 546
Literal Numbers .. 87, 199, 200, 201, 203, 204,
205, 210, 212, 286, 287, 289, 290, 312, 425,
539, 540, 541, 543, 544, 548, 550, 623, 624,
626, 627, 647
load .......................................69, 407
Load/Save/Compare operation ....69, 407
Location ......................................243, 583
Log Event Action .... 67, 107, 303, 406, 445, 638
Log events/alarms .................61, 400
Log Lower Limit Violation ....224, 231, 562, 569
Log Upper Limit Violation ....224, 231, 562, 569
Logical AND.. 87, 199, 200, 201, 203, 204,
205, 210, 212, 286, 287, 289, 290, 312, 425, 539,
540, 541, 543, 544, 548, 550, 623, 624, 626,
627, 647
Logical Operators....87, 199, 200, 201, 203, 204,
205, 210, 212, 286, 287, 289, 290, 312, 425,
539, 540, 541, 543, 544, 548, 550, 623, 624,
626, 627, 647
Logical OR .... 87, 199, 200, 201, 203, 204, 205,
210, 212, 286, 287, 289, 290, 312, 425, 539,
540, 541, 543, 544, 548, 550, 623, 624, 626,
627, 647
Logical-AND.. 87, 199, 200, 201, 203, 204, 205,
210, 212, 286, 287, 289, 290, 312, 425, 539,
540, 541, 543, 544, 548, 550, 623, 624, 626,
627, 647
Logical-OR .... 87, 199, 200, 201, 203, 204, 205,
210, 212, 286, 287, 289, 290, 312, 425, 539,
540, 541, 543, 544, 548, 550, 623, 624, 626,
627, 647
Logoff .....................................70, 409
Logon .................................70, 409
Lower Limit..200, 224, 232, 286, 540, 562,
570, 623
Lower Limit Violation Action . 224, 232, 562, 570
M
Major Divisions............... 183, 220, 522, 558
Major Tick Values .......... 183, 232, 522, 570
Make Action .. 73, 172, 183, 185, 186, 203, 206,
224, 232, 289, 311, 412, 511, 522, 524, 526,
543, 545, 562, 570, 626, 646
Make BG Color ..........................224, 562
Make BG Style ..........................224, 562
Make FG Color ..........................224, 562
Make Font ..............................224, 562
Make Label ..172, 183, 186, 224, 232, 511, 522,
524, 526, 543, 545, 562, 570, 626, 648
Make Same Height..... 110, 120, 126, 160, 449,
459, 464, 498
Make Same Size.. 110, 120, 126, 160, 449, 459,
464, 498
Make Same Size button ...........120, 459
Make Same Size icon ...........110, 160, 449, 498
Make Same Width 110, 120, 126, 160, 449, 459,
464, 498
Make/break............73, 206, 311, 412, 545, 646
Margin/guidelines ............108, 132, 447, 470
Master ..................134, 143, 297, 472, 481, 634
Master Page .... 45, 74, 134, 135, 143, 147, 294,
297, 386, 413, 472, 474, 481, 485, 631, 634
Master Page Example .......143, 297, 481, 634
Master Pages ..................................... 338, 673
Master Pages Properties Tab 134, 143, 297, 472, 481, 634
Math Operators .................................. 87, 198, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 538, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Max Cal ................................. 172, 173, 233, 510, 511, 571
Max Calibration ............................. 171, 183, 185, 186, 233, 509, 522, 524, 525, 571
Max Number .................................... 106, 444
Max Trend Interval .......................... 185, 233, 524, 571
Maximize ............................. 115, 191, 454, 531
Maximize Application Expression ........... 73, 411
Maximum Events ............................... 102, 440
Media ........................................... 1, 49, 53, 55, 71, 74, 86, 87, 147, 212, 217, 277, 285, 294, 301, 312, 342, 390, 394, 410, 413, 424, 425, 485, 550, 555, 614, 622, 631, 647
Media Library .................................. 53, 301
Media Library Entry .................. 49, 53, 55, 301, 338, 390, 673
Menu ........................................... 136, 156, 158, 318, 474, 494, 496, 653
Menu bar ...................................... 3, 8, 14, 32, 118, 120, 343, 348, 354, 373, 456, 458, 459
Menu control .................................. 179, 181, 318, 518, 520, 653
MenuDevice Control ......................... 318, 653
message ........................................ 65, 403
Message Expression ......................... 87, 199, 200, 201, 203, 204, 205, 210, 212, 233, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 571, 623, 624, 626, 627, 647
Message Library ................................ 303, 638
Microsoft Excel ......................... 280, 318, 617, 653
Min ............................................ 220, 233, 558, 571
Min Cal ............................ 172, 173, 233, 510, 511, 571
Min Calibration .............................. 171, 183, 185, 186, 233, 509, 522, 524, 525, 571
Minimize ...................................... 115, 120, 191, 454, 458, 531
Minimize Application Expression .......... 73, 411
Minor Divisions .............................. 183, 220, 522, 558
Minutes ........................................ 240, 578
Mirror ........................................... 234, 239, 571, 577
Miscellaneous Tree ......................... 210, 548
Mobility ........................................ 101, 102, 243, 439, 440, 583
Modify Page Controls ....................... 189, 528
Modulo ........................................ 200, 286, 540, 623
Move Menu Bars.............................. 108, 132, 447, 470
Multi-language 49, 55, 277, 338, 390, 394, 614, 673
Multi-Language Example ............... 55, 277, 394, 614
Multiplicative .......................... 205, 544
Mutual Exclusion ............ 87, 199, 200, 201, 203, 204, 205, 210, 212, 238, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 576, 623, 624, 626, 627, 647
N
Name ...................................... 87, 199, 200, 201, 203, 204, 205, 210, 212, 234, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 576, 623, 624, 626, 627, 647
network ..................................... 33, 339, 374
network problems .......................... 33, 374
New Tag Library Entry ........ 92, 218, 341, 430, 556, 674
New Tags .................................. 46, 387
No Alarm ........................................ 102, 440
Non-evaluated ...................... 87, 212, 312, 425, 550, 647
Non-evaluated Numeric Values ........ 87, 212, 312, 425, 550, 647
Non-evaluated/No Quotes Examples .... 87, 212, 312, 425, 550, 647
Normal Outline Color ..................... 179, 518	normal text color ............................ 179, 518
NOT ................................ 87, 212, 239, 312, 425, 550, 577, 647
NOT Evaluated ..................... 87, 212, 312, 425, 550, 647
NUM ............................................... 131, 470
Num Lock ..................................... 131, 470
Number of Samples ...................... 234, 572
Numeric ..................... 87, 212, 312, 425, 550, 647
Numeric Characters 87, 212, 312, 425, 550, 647
Numeric Property Values 87, 199, 200, 201, 203, 204, 205, 210, 212, 227, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 565, 623, 624, 626, 627, 647
<table>
<thead>
<tr>
<th>Numeric Value</th>
<th>87, 199, 200, 201, 203, 204, 205, 210, 212, 227, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 565, 623, 624, 626, 627, 647</th>
</tr>
</thead>
<tbody>
<tr>
<td>Octic Value</td>
<td>O 87, 212, 312, 425, 550, 647</td>
</tr>
<tr>
<td>O/S Log</td>
<td>Octic Value 87, 199, 200, 201, 203, 204, 205, 210, 212, 227, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 565, 623, 624, 626, 627, 647</td>
</tr>
<tr>
<td>Octal Value</td>
<td>O 87, 212, 312, 425, 550, 647</td>
</tr>
<tr>
<td>Order Value</td>
<td>Off, Green, 135, 474</td>
</tr>
<tr>
<td>Offline Mode</td>
<td>Offline Mode 87, 199, 200, 201, 203, 204, 205, 210, 212, 227, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 565, 623, 624, 626, 627, 647</td>
</tr>
<tr>
<td>Operator Type</td>
<td>Operator Type 87, 199, 200, 201, 203, 204, 205, 210, 212, 226, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 565, 623, 624, 626, 627, 647, 647</td>
</tr>
<tr>
<td>Operators</td>
<td>Operator Tree 210, 548</td>
</tr>
<tr>
<td>Offline Mode</td>
<td>Offline Mode 87, 199, 200, 201, 203, 204, 205, 210, 212, 227, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 565, 623, 624, 626, 627, 647, 647</td>
</tr>
<tr>
<td>Orientation</td>
<td>Orientation 235, 573</td>
</tr>
<tr>
<td>Override Configuration</td>
<td>Override Configuration 102, 106, 440, 444</td>
</tr>
<tr>
<td>Page bar</td>
<td>Page bar 15, 18, 291, 355, 358, 628</td>
</tr>
<tr>
<td>Page Change</td>
<td>Page Change 150, 261, 488, 598</td>
</tr>
<tr>
<td>Page Change Example</td>
<td>Page Change Example 73, 206, 311, 412, 545, 646</td>
</tr>
<tr>
<td>Page Change Registers</td>
<td>Page Change Registers 303, 638</td>
</tr>
<tr>
<td>Page Changes Using Actions</td>
<td>Page Changes Using Actions 150, 261, 488, 598</td>
</tr>
<tr>
<td>Page Contents</td>
<td>Page Contents 120, 458</td>
</tr>
<tr>
<td>Page Controls</td>
<td>Page Controls 136, 158, 474, 496</td>
</tr>
<tr>
<td>Page Development</td>
<td>Page Development 120, 458</td>
</tr>
<tr>
<td>Page Directory</td>
<td>Page Directory 65, 404</td>
</tr>
<tr>
<td>Page Enabled Expression</td>
<td>Page Enabled Expression 134, 143, 297, 386, 472, 481, 634</td>
</tr>
<tr>
<td>Page Frame</td>
<td>Page Frame 129, 130, 467, 468</td>
</tr>
<tr>
<td>Page ID</td>
<td>Page ID 150, 261, 303, 488, 598</td>
</tr>
<tr>
<td>Page ID Number</td>
<td>Page ID Number 143, 150, 261, 297, 481, 488, 598, 634</td>
</tr>
<tr>
<td>Page Index</td>
<td>Page Index 303, 638</td>
</tr>
</tbody>
</table>
Index

Page Name ..............................................................73, 130, 150, 206, 261, 303, 311, 412, 468, 488, 545, 598, 638, 646
Page Password ..........................................................303, 638
Page Properties ......................................................130, 143, 297, 468, 481, 634
Page Properties General .............................................150, 261, 488, 598
Page Scan ...........................................................39, 380
Page Status Banner ..................................................303, 638
PageDown ............................................................62, 399
Pages 1, 87, 143, 212, 297, 312, 338, 342, 425, 481, 550, 634, 647, 673
Pages Online ......................................................150, 261, 488, 598
PageUp ............................................................62, 399
PageX ..............................................................73, 206, 311, 412, 545, 646
PageY ..............................................................73, 206, 311, 412, 545, 646
PanelMate PC application ...........................................303, 638
PanelMate Power Pro .................................................30, 31, 303, 370, 371, 638
PanelMate PowerPro Import ........................................303, 638
Parameter Passing ..................................................73, 206, 311, 412, 545, 646
Parameters Label ...................................................176, 514
Parser Error ......................................................87, 199, 200, 201, 203, 204, 205, 210, 212, 243, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 583, 623, 624, 626, 627, 647
Pass Thru ............................................................63, 402
Passing Parameters ................................................62, 401
Passwords ............................................................77, 331, 416, 666
Paste .............................................................32, 124, 373, 462
Paste button .........................................................120, 459
Path/filename .........................................................87, 212, 312, 425, 550, 647
PDF ...............................................................31, 61, 101, 371, 400, 439
Pdf file .............................................................101, 439
Pen Color ...........................................................185, 242, 524, 580
Pen Style .........................................................171, 172, 178, 180, 182, 185, 235, 509, 510, 517, 519, 521, 524, 573
Pen Width .........................................................171, 172, 178, 180, 182, 183, 184, 185, 188, 189, 236, 509, 510, 517, 519, 521, 522, 523, 524, 527, 528, 574
Placement ..........................................................236, 574
Planning Your Page .................................................135, 474
Plate .............................................................136, 156, 158, 180, 474, 494, 496, 519
Plate Rectangle .....................................................165, 193, 272, 503, 533, 609
play .................................................................71, 410
PLC Data ..........................................................87, 212, 312, 425, 550, 647
PLC String .........................................................87, 212, 312, 425, 550, 647
Polygon ............................................................129, 136, 156, 158, 180, 467, 474, 494, 496, 519
Polygon Points ....................................................180, 519
Polyline .............................................................180, 519
Position X .........................................................224, 236, 562, 574
Position Y .........................................................224, 236, 562, 574
Power Pro ..........................................................303, 638
PowerPro Import ..................................................303, 638
PowerPro Media Library ........................................233, 303, 571, 638
PPS ...............................................................31, 32, 303, 371, 373, 638
Pps file ...........................................................30, 303, 370, 638
Precedence ......................................................87, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Prepackaged Project ...........................................21, 26, 93, 138, 260, 267, 361, 366, 431, 476, 597, 604
Preparation ..........................................................338, 673
Primitive ...........................................................1, 342
Process Alarms ..................................................243, 583
Project .............................................................1, 32, 342, 373
Project Components .............................................8, 33, 39, 43, 45, 46, 49, 59, 61, 92, 218, 341, 348, 374, 380, 384, 386, 387, 390, 398, 400, 430, 556, 674
Project Explorer ..................................................1, 3, 18, 92, 110, 118, 130, 134, 160, 189, 218, 291, 303, 341, 343, 358, 430, 449, 456, 468, 472, 498, 528, 556, 628, 638, 674
Project Explorer window .....................................130, 136, 158, 189, 468, 474, 496, 528
Project Profile ....................................................21, 93, 138, 267, 361, 431, 476, 604
ProjectProfileCanvas.xml ........................................26, 260, 366, 597
ProjectProfileCanvasPro.xml ..........................26, 260, 366, 597
677
Index

Roll Up ................................72, 243, 410, 583
Roll Up/Down Operational ... 101, 102, 243, 439, 440, 583
Rotate Left .. 110, 120, 126, 160, 449, 459, 464, 498
Rotate Right 110, 120, 126, 160, 449, 459, 464, 498
Rotate Right icon ............ 110, 160, 449, 498
Rotate/Free Rotate............. 126, 464
Rotate/Rotate Left ............ 126, 464
Rotate/Rotate Right ........... 126, 464
Rotation.............................237, 574
Row ......................................207, 546
Runtime............................3, 28, 33, 73, 101, 102, 115, 156, 191, 318, 338, 343, 368, 374, 411, 439, 440, 454, 498, 531, 653, 673
Runtime license ....................28, 368
Runtime Licensing..............28, 318, 368, 653
Runtime Unit .....................1, 342
Runtime View ....................243, 583
S
Sample Interval ..................237, 575
Sample Rate ......................85, 280, 423, 617
Save ... 18, 32, 33, 69, 120, 124, 130, 291, 358, 373, 374, 407, 459, 462, 468, 628
Save As .........................32, 130, 373, 468
Save Attention Events ......... 106, 444
Save button ......................120, 459
Save Critical Events .......... 106, 444
Save Informational Events .... 106, 444
Save Serious Events .......... 106, 444
Save Warning Events ..........106, 444
Scale Color.....................183, 237, 522, 575
Scratchpad....................210, 303, 548, 638
Screen Size .....................45, 134, 386, 472
SCRL........................................131, 470
Scroll Lock......................131, 470
Search.............................328, 663
Search and Replace............328, 663
Secure Users ... 77, 86, 217, 285, 331, 416, 424, 555, 622, 666
SecureUser ............86, 217, 285, 424, 555, 622
Security......70, 77, 86, 217, 285, 331, 409, 416, 424, 555, 622, 666
Security Devices......77, 86, 217, 285, 331, 416, 424, 555, 622, 666
Security Groups......77, 86, 217, 285, 331, 416, 424, 555, 622, 666
SecurityDevice ......86, 217, 285, 424, 555, 622
SecurityGroup ......86, 217, 285, 424, 555, 622
Selected Outline Color.......179, 518
selected text color ..........179, 518
selected text highlight .......179, 518
Send 18, 33, 110, 120, 126, 160, 201, 287, 291, 303, 358, 374, 449, 459, 464, 498, 541, 624, 628, 638
Send to file ......18, 33, 291, 339, 358, 374, 628
Server..............................39, 380
Server Failed to ...............339
Server name ....................39, 380
Serverres.dll .....................339
Set Date/Time ..................303, 638
Setpoint ... 63, 87, 172, 173, 175, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 402, 425, 510, 511, 513, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647
Shadow Style ......172, 180, 182, 184, 188, 237, 510, 519, 521, 523, 527, 575
Show new component menu ... 98, 257, 436
Signed 16 Bit ..................46, 387
Signed 32 Bit ..................46, 387
Simulate .......................303, 638
SINGLE .........................87, 212, 312, 425, 550, 647
Single Quote ..................87, 212, 312, 425, 550, 647
Small Icons .................108, 129, 132, 447, 467, 470
Small/Large Control Icons.... 108, 132, 447, 470
Snap ............................108, 132, 447, 470
Snap Points .................120, 126, 459, 464
Snap Settings ...............108, 132, 447, 470
Sort Ascending ..............115, 191, 454, 531
Sort Descending ..............115, 191, 454, 531
sound............................71, 410
Sound Path ....................49, 390
Sounds.........................49, 71, 390, 410
SOURCE 87, 199, 200, 201, 203, 204, 205, 210, 212, 243, 286, 287, 289, 290, 312, 425, 539,
Unacknowledged ................................. 102, 243, 440, 583
Unacknowledged Alarms .......................... 243, 583
Unacknowledged On/Off ........................... 102, 440
Unary .................................................. 205, 544
Uncategorized ......................................... 17, 357
Unconditional ......................................... 62, 63, 65, 67, 72, 73, 401, 402, 404, 406, 410, 411
Undefined Error ...................................... 243, 583
Undo ................................................... 120, 124, 459, 462
Ungroup ................................................ 110, 120, 126, 160, 449, 459, 464, 498
Unicode .................................................. 303, 638
Unique name ........................................... 46, 67, 387, 406
Unit Configuration File .............................. 18, 291, 358, 628
Unit Label ............................................. 176, 338, 342, 673
Unit Properties ...................................... 303, 638
Units .................................................. 1, 338, 342, 673
Unit’s Event Banner .................................. 102, 440
Units Folder .............................................. 8, 348
Unsigned 16 Bit ...................................... 46, 387
Unsigned 32 Bit ...................................... 46, 387
Upper Limit ........................................... 200, 224, 241, 242, 286, 540, 562, 579, 623
Upper Limit Violation Action ....................... 224, 242, 562, 579
User Defined ........................................... 243, 583
User Defined System Tags .......................... 46, 92, 218, 341, 387, 430, 556, 674
User Input Error ...................................... 243, 583

V

Value Color ............................................. 183, 242, 522, 580
Value Column ........................................... 115, 191, 454, 531
Value Expression ................................... 87, 176, 199, 200, 201, 203, 204, 205, 210, 212, 286, 287, 289, 290, 312, 425, 514, 539, 540, 541, 543, 544, 548, 550, 623, 624, 626, 627, 647

W

Warning .................................................. 59, 102, 398, 440
Wav .......................................................... 71, 410
Wav file .................................................. 71, 410
Wcefiles .................................................. 33, 374
Width ................................................. 101, 102, 242, 243, 439, 440, 580, 583
Window Banner ........................................ 243, 583
Windows Application Event Viewer .................. 243, 583
Windows Event Viewer .................................. 243, 583
Write .................................................. 107, 110, 160, 235, 445, 449, 498, 573

X

X Points .................................................. 180, 243, 519, 581
X,Y ...................................................... 226, 236, 237, 238, 243, 564, 574, 575, 576, 581
XML .................................................. 53, 280, 301, 318, 617, 653
XML file .............................................. 26, 53, 69, 85, 260, 280, 301, 318, 366, 407, 423, 597, 617, 653

Y

Y 226, 230, 236, 238, 243, 564, 568, 574, 576, 581
Y Points ............................. 180, 243, 519, 581